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This document describes the following R&S®RTM models with firmware 05.8xx and higher:
● R&S®RTM2022: 200 MHz, 2 channels (5710.0999K22)

● R&S®RTM2024: 200 MHz, 4 channels (5710.0999K24)

● R&S®RTM2032: 350 MHz, 2 channels (5710.0999K32)

● R&S®RTM2034: 350 MHz, 4 channels (5710.0999K34)

● R&S®RTM2052: 500 MHz, 2 channels (5710.0999K52)

● R&S®RTM2054: 500 MHz, 4 channels (5710.0999K54)

● R&S®RTM2102: 1 GHz, 2channels (5710.0999K02)

● R&S®RTM2104: 1 GHz, 4 channels (5710.0999K04)

In addition to the base unit, the following options are described:

● R&S®RTM-K1 (1305.0295.02), I²C/SPI

● R&S®RTM-K2 (1305.0308.02), UART/RS232

● R&S®RTM-K3 (1317.3065.02), CAN/LIN

● R&S®RTM-K5 (5710.0882.02), I²S (audio)

● R&S®RTM-K6 (1317.6835.02), MIL.1553

● R&S®RTM-K7 (1317.6841.02), ARINC 429

● R&S®RTM-K15 (5710.0899.02), History and segmented memory

● R&S®RTM-K18 (1326.0959.02), Spectrum analysis

● R&S®RTM-K31 (1317.5745.02), Power analysis

● R&S®RTM-K32 (1326.0907.02), Digital voltmeter (DVM)

© 2016 Rohde & Schwarz GmbH & Co. KG
Mühldorfstr. 15, 81671 München, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
Email: info@rohde-schwarz.com
Internet: www.rohde-schwarz.com
Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®RTM2000 is abbreviated as R&S RTM.
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Basic Safety Instructions 

Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 

standards of our products up to date and to offer our customers the highest possible degree of safety. Our 

products and the auxiliary equipment they require are designed, built and tested in accordance with the 

safety standards that apply in each case. Compliance with these standards is continuously monitored by 

our quality assurance system. The product described here has been designed, built and tested in 

accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully 

complying with safety standards. To maintain this condition and to ensure safe operation, you must 

observe all instructions and warnings provided in this manual. If you have any questions regarding these 

safety instructions, the Rohde & Schwarz group of companies will be happy to answer them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 

for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 

not be used in any way that may cause personal injury or property damage. You are responsible if the 

product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 

instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 

and within its performance limits (see data sheet, documentation, the following safety instructions). Using 

the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 

essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 

allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 

will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 

and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 

dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 

before and when using the product. It is also absolutely essential to observe the additional safety 

instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 

these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 

Schwarz group of companies, including instruments, systems and all accessories. For product-specific 

information, see the data sheet and the product documentation. 

Safety labels on products 

The following safety labels are used on products to warn against risks and dangers. 

Symbol Meaning Symbol Meaning 

 

Notice, general danger location 

Observe product documentation 

    
ON/OFF  Power  

 

Caution when handling heavy equipment 

 

Standby indication 

 

Danger of electric shock  Direct current (DC) 
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Symbol Meaning Symbol Meaning 

 

 Caution ! Hot surface  Alternating current (AC) 

 

Protective conductor terminal  

To identify any terminal which is intended for 

connection to an external conductor for 

protection against electric shock  in case of a 

fault, or the terminal of a protective earth 

 Direct/alternating current (DC/AC) 

 

Earth (Ground) 

 
 

Class II Equipment 

to identify equipment  meeting the safety 

requirements specified for Class II equipment   

(device protected by double or reinforced 

insulation) 

 

Frame or chassis Ground terminal 

 

EU labeling for batteries and accumulators 

For additional information, see section "Waste 

disposal/Environmental protection", item 1. 

 

Be careful when handling electrostatic sensitive 

devices 

 

EU labeling for separate collection of electrical 

and electronic devices 

For additional information, see section "Waste 

disposal/Environmental protection", item 2. 

 

Warning! Laser radiation 

For additional information, see section 

"Operation", item 7. 

  

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 

and dangers. 

 

Indicates a hazardous situation which, if not avoided, will result in death or 

serious injury. 

 

Indicates a hazardous situation which, if not avoided, could result in death or 

serious injury. 

 

Indicates a hazardous situation which, if not avoided, could result in minor or 

moderate injury. 

 

Indicates information considered important, but not hazard-related, e.g. 

messages relating to property damage. 

In the product documentation, the word ATTENTION is used synonymously. 

These signal words are in accordance with the standard definition for civil applications in the European 

Economic Area. Definitions that deviate from the standard definition may also exist in other economic 

areas or military applications. It is therefore essential to make sure that the signal words described here 

are always used only in connection with the related product documentation and the related product. The 

use of signal words in connection with unrelated products or documentation can result in misinterpretation 

and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 

manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 

not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 

or national safety regulations and rules for the prevention of accidents must be observed in all work 

performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  

predefined operating position is always with the housing floor facing down, IP protection 2X, use only 

indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 

level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 

overvoltage category 2, pollution degree 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 

are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 

installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 

that is not carried out as described in the product documentation could result in personal injury or 

even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 

temperature must not exceed the maximum temperature specified in the product documentation or in 

the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 

even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 

fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 

matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power 

fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 

permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 

permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 

or connector strips are implemented, they must be checked on a regular basis to ensure that they are 

safe to use. 

4. If there is no power switch for disconnecting the product from the mains, or if the power switch is not 

suitable for this purpose, use the plug of the connecting cable to disconnect the product from the 

mains. In such cases, always ensure that the power plug is easily reachable and accessible at all 

times. For example, if the power plug is the disconnecting device, the length of the connecting cable 

must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection 

from the AC supply network. If products without power switches are integrated into racks or systems, 

the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 

ensure that they are in proper operating condition. By taking appropriate safety measures and 

carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 

hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 

fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 

socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 

shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 

measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 

taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 

computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that 

apply in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 

operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 

product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 

on site and the product's protective conductor must be made first before any other connection is 

made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 

devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 

product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 

lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 

danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 

purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 

operating positions", item 1). Therefore, the equipment must be protected against penetration by 

liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 

itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 

product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 

increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 

or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 

as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 

who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 

or material damage may occur. It is the responsibility of the employer/operator to select suitable 

personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 

(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 

skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 

product, consult a physician immediately to determine the cause and to prevent health problems or 

stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 

sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 

item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 

level of electromagnetic radiation. Considering that unborn babies require increased protection, 

pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 

exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 

where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 

potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 

cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 

protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 

can cause biological harm due to the properties of their radiation and due to their extremely 

concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 

Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 

product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22, 

EN 55032/CISPR 32) 

 Class A equipment:  

Equipment suitable for use in all environments except residential environments and environments 

that are directly connected to a low-voltage supply network that supplies residential buildings  

Note: Class A equipment is intended for use in an industrial environment. This equipment may 

cause radio disturbances in residential environments, due to possible conducted as well as 

radiated disturbances. In this case, the operator may be required to take appropriate measures to 

eliminate these disturbances. 

 Class B equipment: 

Equipment suitable for use in residential environments and environments that are directly 

connected to a low-voltage supply network that supplies residential buildings 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 

performed on the product or before the product is opened, it must be disconnected from the AC supply 

network. Otherwise, personnel will be exposed to the risk of an electric shock.  
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2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 

experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 

to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 

after parts relevant to safety have been replaced (visual inspection, protective conductor test, 

insulation resistance measurement, leakage current measurement, functional test). This helps ensure 

the continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 

extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 

injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 

lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 

Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 

drawer where they can short-circuit each other, or where they can be short-circuited by other 

conductive materials. Cells and batteries must not be removed from their original packaging until they 

are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 

contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 

can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 

parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 

and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 

national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 

the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 

back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 

therefore not permissible to use handles to fasten the product to or on transport equipment such as 

cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 

means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 

transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 

and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 

product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 

product in the vehicle to prevent injuries or other damage in the event of an accident.  
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Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 

municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 

point or via a Rohde & Schwarz customer service center. 

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 

must be collected separately. 

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 

take-back obligations and disposal obligations for manufacturers within the EU. Contact your 

Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 

beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 

may be released. For this reason, the product may only be disassembled by specially trained 

personnel. Improper disassembly may be hazardous to your health. National waste disposal 

regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 

way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 

manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 

regulations must be observed. Also observe the relevant safety instructions in the product 

documentation. The improper disposal of hazardous substances or fuels can cause health problems 

and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 

¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 

con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 

productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 

seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 

estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 

de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de seguridad. 

Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario deberá 

atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas 

Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a estas 

informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 

está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 

autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 

persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 

instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 

forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 

indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 

definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 

hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 

en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 

profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 

uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 

producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 

como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 

peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 

siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 

producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 

referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 

documentación del producto y que también son de obligado cumplimiento. En las presentes 

informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 

Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 

como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 

documentación del producto. 

Señalización de seguridad de los productos 

Las siguientes señales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros. 

Símbolo Significado Símbolo Significado 

 

Aviso: punto de peligro general 

Observar la documentación del producto 

    
Tensión de alimentación de PUESTA EN 

MARCHA / PARADA 

 

Atención en el manejo de dispositivos de peso 

elevado  

Indicación de estado de espera (standby) 

 

Peligro de choque eléctrico  Corriente continua (DC) 

 

Advertencia: superficie caliente  Corriente alterna (AC) 

 

Conexión a conductor de protección  Corriente continua / Corriente alterna (DC/AC) 

 

Conexión a tierra 

 
El aparato está protegido en su totalidad por un 

aislamiento doble (reforzado) 

 

Conexión a masa 

 

Distintivo de la UE para baterías y 

acumuladores 

Más información en la sección 

"Eliminación/protección del medio ambiente", 

punto 1. 
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Símbolo Significado Símbolo Significado 

 

Aviso: Cuidado en el manejo de dispositivos 

sensibles a la electrostática (ESD) 

 

Distintivo de la UE para la eliminación por 

separado de dispositivos eléctricos y 

electrónicos 

Más información en la sección 

"Eliminación/protección del medio ambiente", 

punto 2. 

 

Advertencia: rayo láser 

Más información en la sección 

"Funcionamiento", punto 7. 

  

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 

riesgos y peligros. 

 

Indica una situación de peligro que, si no se evita, causa lesiones 

graves o incluso la muerte. 

 

Indica una situación de peligro que, si no se evita, puede causar 

lesiones graves o incluso la muerte. 

 

Indica una situación de peligro que, si no se evita, puede causar 

lesiones leves o moderadas. 

 

Indica información que se considera importante, pero no en relación 

con situaciones de peligro; p. ej., avisos sobre posibles daños 

materiales.  

En la documentación del producto se emplea de forma sinónima el 

término CUIDADO. 

 

Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 

económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 

en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 

sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 

solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 

combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 

equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 

operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 

indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 

posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 

nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  

como posición de funcionamiento se define por principio la posición con el suelo de la caja para 

abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 

sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 

±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 

eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 

de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 

fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 

se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 

causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 

temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 

producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 

choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 

eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 

de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 

preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 

modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 

correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 

podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 

conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 

corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 

que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 

enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 

estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 

interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 

conexión se deberá considerar como un dispositivo de desconexión.  

El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 

Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 

conexión no debe superar 3 m).  

Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 

integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 

nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 

correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 

de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 

pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 

de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 

empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 

completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 

chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 

podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 

apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 

de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 

comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 

válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 

mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 

puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 

con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 

la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 

mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 

todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 

posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 

los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 

peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 

Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 

lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 

"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 

medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 

eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 

personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 

condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 

otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 

alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 

No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 

para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 

Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 

necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 

pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 

el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 

de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 

alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 

reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 

conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 

causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 

imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 

función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 

necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 

pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 

obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 

exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 

(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 

usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 

clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 

las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 

En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 

CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 

documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogía con EN 

55022 / CISPR 22, EN 55032 / CISPR 32) 

 Aparato de clase A:  

Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos 

conectados directamente a una red de distribución de baja tensión que suministra corriente a 

edificios residenciales.  

Nota: Los aparatos de clase A están destinados al uso en entornos industriales. Estos aparatos 

pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles 

perturbaciones guiadas o radiadas. En este caso, se le podrá solicitar al operador que tome  las 

medidas adecuadas para eliminar estas perturbaciones. 

 Aparato de clase B: 

Aparato adecuado para su uso en entornos residenciales, así como en aquellos conectados 

directamente a una red de distribución de baja tensión que suministra corriente a edificios 

residenciales. 
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Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 

de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 

evitar toda posibilidad de choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 

por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 

aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 

sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 

deberá realizarse un control de seguridad (control a primera vista, control del conductor de 

protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 

funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 

acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 

consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 

litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 

directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 

sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 

estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 

otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 

hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 

médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 

(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 

baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 

recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 

acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 

Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 

precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 

elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  
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2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 

personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 

como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 

productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 

daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 

elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 

responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 

ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 

vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 

debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 

residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 

efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 

cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 

sino que deben ser recogidos por separado. 

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 

plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 

desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 

al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 

funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 

pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 

personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 

para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 

residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 

deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 

cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 

sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 

necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 

eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 

daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 

Rohde & Schwarz. 
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Grundlegende Sicherheitshinweise 

Lesen und beachten Sie unbedingt die nachfolgenden Anweisungen und Sicherheitshinweise! 

Alle Werke und Standorte der Rohde & Schwarz Firmengruppe sind ständig bemüht, den 

Sicherheitsstandard unserer Produkte auf dem aktuellsten Stand zu halten und unseren Kunden ein 

höchstmögliches Maß an Sicherheit zu bieten. Unsere Produkte und die dafür erforderlichen Zusatzgeräte 

werden entsprechend der jeweils gültigen Sicherheitsvorschriften gebaut und geprüft. Die Einhaltung 

dieser Bestimmungen wird durch unser Qualitätssicherungssystem laufend überwacht. Das vorliegende 

Produkt ist gemäß beiliegender EU-Konformitätsbescheinigung gebaut und geprüft und hat das Werk in 

sicherheitstechnisch einwandfreiem Zustand verlassen. Um diesen Zustand zu erhalten und einen 

gefahrlosen Betrieb sicherzustellen, muss der Benutzer alle Hinweise, Warnhinweise und Warnvermerke 

beachten. Bei allen Fragen bezüglich vorliegender Sicherheitshinweise steht Ihnen die Rohde & Schwarz 

Firmengruppe jederzeit gerne zur Verfügung. 

Darüber hinaus liegt es in der Verantwortung des Benutzers, das Produkt in geeigneter Weise zu 

verwenden. Das Produkt ist ausschließlich für den Betrieb in Industrie und Labor bzw., wenn ausdrücklich 

zugelassen, auch für den Feldeinsatz bestimmt und darf in keiner Weise so verwendet werden, dass einer 

Person/Sache Schaden zugefügt werden kann. Die Benutzung des Produkts außerhalb des 

bestimmungsgemäßen Gebrauchs oder unter Missachtung der Anweisungen des Herstellers liegt in der 

Verantwortung des Benutzers. Der Hersteller übernimmt keine Verantwortung für die Zweckentfremdung 

des Produkts.  

Die bestimmungsgemäße Verwendung des Produkts wird angenommen, wenn das Produkt nach den 

Vorgaben der zugehörigen Produktdokumentation innerhalb seiner Leistungsgrenzen verwendet wird 

(siehe Datenblatt, Dokumentation, nachfolgende Sicherheitshinweise). Die Benutzung des Produkts 

erfordert Fachkenntnisse und zum Teil englische Sprachkenntnisse. Es ist daher zu beachten, dass das 

Produkt ausschließlich von Fachkräften oder sorgfältig eingewiesenen Personen mit entsprechenden 

Fähigkeiten bedient werden darf. Sollte für die Verwendung von Rohde & Schwarz-Produkten persönliche 

Schutzausrüstung erforderlich sein, wird in der Produktdokumentation an entsprechender Stelle darauf 

hingewiesen. Bewahren Sie die grundlegenden Sicherheitshinweise und die Produktdokumentation gut 

auf und geben Sie diese an weitere Benutzer des Produkts weiter. 

Die Einhaltung der Sicherheitshinweise dient dazu, Verletzungen oder Schäden durch Gefahren aller Art 

auszuschließen. Hierzu ist es erforderlich, dass die nachstehenden Sicherheitshinweise vor der 

Benutzung des Produkts sorgfältig gelesen und verstanden sowie bei der Benutzung des Produkts 

beachtet werden. Sämtliche weitere Sicherheitshinweise wie z.B. zum Personenschutz, die an 

entsprechender Stelle der Produktdokumentation stehen, sind ebenfalls unbedingt zu beachten. In den 

vorliegenden Sicherheitshinweisen sind sämtliche von der Rohde & Schwarz Firmengruppe vertriebenen 

Waren unter dem Begriff „Produkt“ zusammengefasst, hierzu zählen u. a. Geräte, Anlagen sowie 

sämtliches Zubehör.  
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Symbole und Sicherheitskennzeichnungen 

Symbol Bedeutung Symbol Bedeutung 

 

Achtung, allgemeine Gefahrenstelle 

Produktdokumentation beachten 

    
EIN-/AUS (Versorgung) 

 

Vorsicht beim Umgang mit Geräten mit hohem 

Gewicht  

Stand-by-Anzeige 

 

Gefahr vor elektrischem Schlag  Gleichstrom (DC) 

 

Warnung vor heißer Oberfläche  Wechselstrom (AC) 

 

Schutzleiteranschluss  Gleichstrom/Wechselstrom (DC/AC) 

 

Erdungsanschluss  

 
Gerät entspricht den Sicherheits-

anforderungen an die Schutzklasse II  

(Gerät durchgehend durch doppelte / 

verstärkte Isolierung geschützt. 

 

Masseanschluss des Gestells oder Gehäuses 

 

EU - Kennzeichnung für Batterien und 

Akkumulatoren.  

 

Das Gerät enthält eine Batterie bzw. einen 

Akkumulator. Diese dürfen nicht über 

unsortierten Siedlungsabfall entsorgt werden, 

sondern sollten getrennt gesammelt werden.  

 

Weitere Informationen siehe Seite 7. 

 

Achtung beim Umgang mit elektrostatisch 

gefährdeten Bauelementen 

 

EU - Kennzeichnung für die getrennte 

Sammlung von Elektro- und 

Elektronikgeräten. 

Elektroaltgeräte dürfen nicht über unsortierten 

Siedlungsabfall entsorgt werden, sondern 

müssen getrennt gesammelt werden.  

 

Weitere Informationen siehe Seite 7. 

 

Warnung vor Laserstrahl 

Produkte mit Laser sind je nach ihrer Laser-

Klasse mit genormten Warnhinweisen 

versehen. 

Laser können aufgrund der Eigenschaften 

ihrer Strahlung und aufgrund ihrer extrem 

konzentrierten elektromagnetischen Leistung 

biologische Schäden verursachen.  

 

Für zusätzliche Informationen siehe Kapitel 

„Betrieb“ Punkt 7. 

  

 

http://de.wikipedia.org/wiki/Laser#Laser-Klassen
http://de.wikipedia.org/wiki/Laser#Laser-Klassen
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Signalworte und ihre Bedeutung 

Die folgenden Signalworte werden in der Produktdokumentation verwendet, um vor Risiken und Gefahren 

zu warnen. 

 

kennzeichnet eine unmittelbare Gefährdung mit hohem Risiko, die Tod oder 

schwere Körperverletzung zur Folge haben wird, wenn sie nicht vermieden 

wird.  

 

kennzeichnet eine mögliche Gefährdung mit mittlerem Risiko, die Tod oder 

(schwere) Körperverletzung zur Folge haben kann, wenn sie nicht vermieden 

wird. 

 

kennzeichnet eine Gefährdung mit geringem Risiko, die leichte oder mittlere 

Körperverletzungen zur Folge haben könnte, wenn sie nicht vermieden wird. 

 

 

weist auf die Möglichkeit einer Fehlbedienung hin, bei der das Produkt 

Schaden nehmen kann. 

 

Diese Signalworte entsprechen der im europäischen Wirtschaftsraum üblichen Definition für zivile 

Anwendungen. Neben dieser Definition können in anderen Wirtschaftsräumen oder bei militärischen 

Anwendungen abweichende Definitionen existieren. Es ist daher darauf zu achten, dass die hier 

beschriebenen Signalworte stets nur in Verbindung mit der zugehörigen Produktdokumentation und nur in 

Verbindung mit dem zugehörigen Produkt verwendet werden. Die Verwendung von Signalworten in 

Zusammenhang mit nicht zugehörigen Produkten oder nicht zugehörigen Dokumentationen kann zu 

Fehlinterpretationen führen und damit zu Personen- oder Sachschäden führen. 

Betriebszustände und Betriebslagen 

Das Produkt darf nur in den vom Hersteller angegebenen Betriebszuständen und Betriebslagen ohne 

Behinderung der Belüftung betrieben werden. Werden die Herstellerangaben nicht eingehalten, kann dies 

elektrischen Schlag, Brand und/oder schwere Verletzungen von Personen, unter Umständen mit 

Todesfolge, verursachen. Bei allen Arbeiten sind die örtlichen bzw. landesspezifischen Sicherheits- und 

Unfallverhütungsvorschriften zu beachten.  

1. Sofern nicht anders vereinbart, gilt für R&S-Produkte folgendes:  

als vorgeschriebene Betriebslage grundsätzlich Gehäuseboden unten, IP-Schutzart 2X, 

Verschmutzungsgrad 2, Überspannungskategorie 2, nur in Innenräumen verwenden, Betrieb bis 

2000 m ü. NN, Transport bis 4500 m ü. NN, für die Nennspannung gilt eine Toleranz von ±10%, für 

die Nennfrequenz eine Toleranz von ±5%. 

2. Stellen Sie das Produkt nicht auf Oberflächen, Fahrzeuge, Ablagen oder Tische, die aus Gewichts- 

oder Stabilitätsgründen nicht dafür geeignet sind. Folgen Sie bei Aufbau und Befestigung des 

Produkts an Gegenständen oder Strukturen (z.B. Wände und Regale) immer den Installations-

hinweisen des Herstellers. Bei Installation abweichend von der Produktdokumentation können 

Personen verletzt, unter Umständen sogar getötet werden. 

3. Stellen Sie das Produkt nicht auf hitzeerzeugende Gerätschaften (z.B. Radiatoren und Heizlüfter). Die 

Umgebungstemperatur darf nicht die in der Produktdokumentation oder im Datenblatt spezifizierte 

Maximaltemperatur überschreiten. Eine Überhitzung des Produkts kann elektrischen Schlag, Brand 

und/oder schwere Verletzungen von Personen, unter Umständen mit Todesfolge, verursachen. 
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Elektrische Sicherheit 

Werden die Hinweise zur elektrischen Sicherheit nicht oder unzureichend beachtet, kann dies elektrischen 

Schlag, Brand und/oder schwere Verletzungen von Personen, unter Umständen mit Todesfolge, 

verursachen.  

1. Vor jedem Einschalten des Produkts ist sicherzustellen, dass die am Produkt eingestellte 

Nennspannung und die Netznennspannung des Versorgungsnetzes übereinstimmen. Ist es 

erforderlich, die Spannungseinstellung zu ändern, so muss ggf. auch die dazu gehörige 

Netzsicherung des Produkts geändert werden.  

2. Bei Produkten der Schutzklasse I mit beweglicher Netzzuleitung und Gerätesteckvorrichtung ist der 

Betrieb nur an Steckdosen mit Schutzkontakt und angeschlossenem Schutzleiter zulässig. 

3. Jegliche absichtliche Unterbrechung des Schutzleiters, sowohl in der Zuleitung als auch am Produkt 

selbst, ist unzulässig. Es kann dazu führen, dass von dem Produkt die Gefahr eines elektrischen 

Schlags ausgeht. Bei Verwendung von Verlängerungsleitungen oder Steckdosenleisten ist sicher-

zustellen, dass diese regelmäßig auf ihren sicherheitstechnischen Zustand überprüft werden. 

4. Sofern das Produkt nicht mit einem Netzschalter zur Netztrennung ausgerüstet ist, beziehungsweise 

der vorhandene Netzschalter zu Netztrennung nicht geeignet ist, so ist der Stecker des 

Anschlusskabels als Trennvorrichtung anzusehen.  

Die Trennvorrichtung muss jederzeit leicht erreichbar und gut zugänglich sein. Ist z.B. der Netzstecker 

die Trennvorrichtung, darf die Länge des Anschlusskabels 3 m nicht überschreiten.  

Funktionsschalter oder elektronische Schalter sind zur Netztrennung nicht geeignet. Werden Produkte 

ohne Netzschalter in Gestelle oder Anlagen integriert, so ist die Trennvorrichtung auf Anlagenebene 

zu verlagern. 

5. Benutzen Sie das Produkt niemals, wenn das Netzkabel beschädigt ist. Überprüfen Sie regelmäßig 

den einwandfreien Zustand der Netzkabel. Stellen Sie durch geeignete Schutzmaßnahmen und 

Verlegearten sicher, dass das Netzkabel nicht beschädigt werden kann und niemand z.B. durch 

Stolperfallen oder elektrischen Schlag zu Schaden kommen kann.  

6. Der Betrieb ist nur an TN/TT Versorgungsnetzen gestattet, die mit höchstens 16 A abgesichert sind 

(höhere Absicherung nur nach Rücksprache mit der Rohde & Schwarz Firmengruppe). 

7. Stecken Sie den Stecker nicht in verstaubte oder verschmutzte Steckdosen/-buchsen. Stecken Sie die 

Steckverbindung/-vorrichtung fest und vollständig in die dafür vorgesehenen Steckdosen/-buchsen. 

Missachtung dieser Maßnahmen kann zu Funken, Feuer und/oder Verletzungen führen. 

8. Überlasten Sie keine Steckdosen, Verlängerungskabel oder Steckdosenleisten, dies kann Feuer oder 

elektrische Schläge verursachen. 

9. Bei Messungen in Stromkreisen mit Spannungen Ueff > 30 V ist mit geeigneten Maßnahmen Vorsorge 

zu treffen, dass jegliche Gefährdung ausgeschlossen wird (z.B. geeignete Messmittel, Absicherung, 

Strombegrenzung, Schutztrennung, Isolierung usw.). 

10. Bei Verbindungen mit informationstechnischen Geräten, z.B. PC oder Industrierechner, ist darauf zu 

achten, dass diese der jeweils gültigen IEC 60950-1 / EN 60950-1 oder IEC 61010-1 / EN 61010-1 

entsprechen. 

11. Sofern nicht ausdrücklich erlaubt, darf der Deckel oder ein Teil des Gehäuses niemals entfernt 

werden, wenn das Produkt betrieben wird. Dies macht elektrische Leitungen und Komponenten 

zugänglich und kann zu Verletzungen, Feuer oder Schaden am Produkt führen. 
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12. Wird ein Produkt ortsfest angeschlossen, ist die Verbindung zwischen dem Schutzleiteranschluss vor 

Ort und dem Geräteschutzleiter vor jeglicher anderer Verbindung herzustellen. Aufstellung und 

Anschluss darf nur durch eine Elektrofachkraft erfolgen. 

13. Bei ortsfesten Geräten ohne eingebaute Sicherung, Selbstschalter oder ähnliche Schutzeinrichtung 

muss der Versorgungskreis so abgesichert sein, dass alle Personen, die Zugang zum Produkt haben, 

sowie das Produkt selbst ausreichend vor Schäden geschützt sind. 

14. Jedes Produkt muss durch geeigneten Überspannungsschutz vor Überspannung (z.B. durch 

Blitzschlag) geschützt werden. Andernfalls ist das bedienende Personal durch elektrischen Schlag 

gefährdet. 

15. Gegenstände, die nicht dafür vorgesehen sind, dürfen nicht in die Öffnungen des Gehäuses 

eingebracht werden. Dies kann Kurzschlüsse im Produkt und/oder elektrische Schläge, Feuer oder 

Verletzungen verursachen. 

16. Sofern nicht anders spezifiziert, sind Produkte nicht gegen das Eindringen von Flüssigkeiten 

geschützt, siehe auch Abschnitt "Betriebszustände und Betriebslagen", Punkt 1. Daher müssen die 

Geräte vor Eindringen von Flüssigkeiten geschützt werden. Wird dies nicht beachtet, besteht Gefahr 

durch elektrischen Schlag für den Benutzer oder Beschädigung des Produkts, was ebenfalls zur 

Gefährdung von Personen führen kann. 

17. Benutzen Sie das Produkt nicht unter Bedingungen, bei denen Kondensation in oder am Produkt 

stattfinden könnte oder ggf. bereits stattgefunden hat, z.B. wenn das Produkt von kalter in warme 

Umgebung bewegt wurde. Das Eindringen von Wasser erhöht das Risiko eines elektrischen 

Schlages. 

18. Trennen Sie das Produkt vor der Reinigung komplett von der Energieversorgung (z.B. speisendes 

Netz oder Batterie). Nehmen Sie bei Geräten die Reinigung mit einem weichen, nicht fasernden 

Staublappen vor. Verwenden Sie keinesfalls chemische Reinigungsmittel wie z.B. Alkohol, Aceton, 

Nitroverdünnung. 

Betrieb 

1. Die Benutzung des Produkts erfordert spezielle Einweisung und hohe Konzentration während der 

Benutzung. Es muss sichergestellt sein, dass Personen, die das Produkt bedienen, bezüglich ihrer 

körperlichen, geistigen und seelischen Verfassung den Anforderungen gewachsen sind, da 

andernfalls Verletzungen oder Sachschäden nicht auszuschließen sind. Es liegt in der Verantwortung 

des Arbeitsgebers/Betreibers, geeignetes Personal für die Benutzung des Produkts auszuwählen. 

2. Bevor Sie das Produkt bewegen oder transportieren, lesen und beachten Sie den Abschnitt 

"Transport". 

3. Wie bei allen industriell gefertigten Gütern kann die Verwendung von Stoffen, die Allergien 

hervorrufen - so genannte Allergene (z.B. Nickel) - nicht generell ausgeschlossen werden. Sollten 

beim Umgang mit R&S-Produkten allergische Reaktionen, z.B. Hautausschlag, häufiges Niesen, 

Bindehautrötung oder Atembeschwerden auftreten, ist umgehend ein Arzt aufzusuchen, um die 

Ursachen zu klären und Gesundheitsschäden bzw. -belastungen zu vermeiden.  

4. Vor der mechanischen und/oder thermischen Bearbeitung oder Zerlegung des Produkts beachten Sie 

unbedingt Abschnitt "Entsorgung", Punkt 1. 
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5. Bei bestimmten Produkten, z.B. HF-Funkanlagen, können funktionsbedingt erhöhte elektromag-

netische Strahlungen auftreten. Unter Berücksichtigung der erhöhten Schutzwürdigkeit des unge-

borenen Lebens müssen Schwangere durch geeignete Maßnahmen geschützt werden. Auch Träger 

von Herzschrittmachern können durch elektromagnetische Strahlungen gefährdet sein. Der 

Arbeitgeber/Betreiber ist verpflichtet, Arbeitsstätten, bei denen ein besonderes Risiko einer Strahlen-

exposition besteht, zu beurteilen und zu kennzeichnen und mögliche Gefahren abzuwenden. 

6. Im Falle eines Brandes entweichen ggf. giftige Stoffe (Gase, Flüssigkeiten etc.) aus dem Produkt, die 

Gesundheitsschäden verursachen können. Daher sind im Brandfall geeignete Maßnahmen wie z.B. 

Atemschutzmasken und Schutzkleidung zu verwenden. 

7. Falls ein Laser-Produkt in ein R&S-Produkt integriert ist (z.B. CD/DVD-Laufwerk), dürfen keine 

anderen Einstellungen oder Funktionen verwendet werden, als in der Produktdokumentation beschrie-

ben, um Personenschäden zu vermeiden (z.B. durch Laserstrahl). 

8. EMV Klassen (nach EN 55011 / CISPR 11; sinngemäß EN 55022 / CISPR 22, EN 55032 / CISPR 32) 

Gerät der Klasse A: 

Ein Gerät, das sich für den Gebrauch in allen anderen Bereichen außer dem Wohnbereich und 

solchen Bereichen eignet, die direkt an ein Niederspannungs-Versorgungsnetz angeschlossen sind, 

das Wohngebäude versorgt. 

Hinweis: Diese Einrichtung kann wegen möglicher auftretender leitungsgebundener als auch 

gestrahlten Störgrößen im Wohnbereich Funkstörungen verursachen. In diesem Fall kann vom 

Betreiber verlangt werden, angemessene Maßnahmen durchzuführen. 

Gerät der Klasse B: 

Ein Gerät, das sich für den Betrieb im Wohnbereich sowie in solchen Bereichen eignet, die direkt an 

ein Niederspannungs-Versorgungsnetz angeschlossen sind, das Wohngebäude versorgt. 

Reparatur und Service 

1. Das Produkt darf nur von dafür autorisiertem Fachpersonal geöffnet werden. Vor Arbeiten am Produkt 

oder Öffnen des Produkts ist dieses von der Versorgungsspannung zu trennen, sonst besteht das 

Risiko eines elektrischen Schlages.  

2. Abgleich, Auswechseln von Teilen, Wartung und Reparatur darf nur von R&S-autorisierten 

Elektrofachkräften ausgeführt werden. Werden sicherheitsrelevante Teile (z.B. Netzschalter, 

Netztrafos oder Sicherungen) ausgewechselt, so dürfen diese nur durch Originalteile ersetzt werden. 

Nach jedem Austausch von sicherheitsrelevanten Teilen ist eine Sicherheitsprüfung durchzuführen 

(Sichtprüfung, Schutzleitertest, Isolationswiderstand-, Ableitstrommessung, Funktionstest). Damit wird 

sichergestellt, dass die Sicherheit des Produkts erhalten bleibt.  

Batterien und Akkumulatoren/Zellen 

Werden die Hinweise zu Batterien und Akkumulatoren/Zellen nicht oder unzureichend beachtet, kann dies 

Explosion, Brand und/oder schwere Verletzungen von Personen, unter Umständen mit Todesfolge, 

verursachen. Die Handhabung von Batterien und Akkumulatoren mit alkalischen Elektrolyten (z.B. 

Lithiumzellen) muss der EN 62133 entsprechen. 

1. Zellen dürfen nicht zerlegt, geöffnet oder zerkleinert werden.  

2. Zellen oder Batterien dürfen weder Hitze noch Feuer ausgesetzt werden. Die Lagerung im direkten 

Sonnenlicht ist zu vermeiden. Zellen und Batterien sauber und trocken halten. Verschmutzte 

Anschlüsse mit einem trockenen, sauberen Tuch reinigen. 
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3. Zellen oder Batterien dürfen nicht kurzgeschlossen werden. Zellen oder Batterien dürfen nicht 

gefahrbringend in einer Schachtel oder in einem Schubfach gelagert werden, wo sie sich gegenseitig 

kurzschließen oder durch andere leitende Werkstoffe kurzgeschlossen werden können. Eine Zelle 

oder Batterie darf erst aus ihrer Originalverpackung entnommen werden, wenn sie verwendet werden 

soll. 

4. Zellen oder Batterien dürfen keinen unzulässig starken, mechanischen Stößen ausgesetzt werden. 

5. Bei Undichtheit einer Zelle darf die Flüssigkeit nicht mit der Haut in Berührung kommen oder in die 

Augen gelangen. Falls es zu einer Berührung gekommen ist, den betroffenen Bereich mit reichlich 

Wasser waschen und ärztliche Hilfe in Anspruch nehmen. 

6. Werden Zellen oder Batterien, die alkalische Elektrolyte enthalten (z.B. Lithiumzellen), unsachgemäß 

ausgewechselt oder geladen, besteht Explosionsgefahr. Zellen oder Batterien nur durch den ent-

sprechenden R&S-Typ ersetzen (siehe Ersatzteilliste), um die Sicherheit des Produkts zu erhalten.  

7. Zellen oder Batterien müssen wiederverwertet werden und dürfen nicht in den Restmüll gelangen. 

Akkumulatoren oder Batterien, die Blei, Quecksilber oder Cadmium enthalten, sind Sonderabfall. 

Beachten Sie hierzu die landesspezifischen Entsorgungs- und Recycling-Bestimmungen.  

Transport 

1. Das Produkt kann ein hohes Gewicht aufweisen. Daher muss es vorsichtig und ggf. unter 

Verwendung eines geeigneten Hebemittels (z.B. Hubwagen) bewegt bzw. transportiert werden, um 

Rückenschäden oder Verletzungen zu vermeiden.  

2. Griffe an den Produkten sind eine Handhabungshilfe, die ausschließlich für den Transport des 

Produkts durch Personen vorgesehen ist. Es ist daher nicht zulässig, Griffe zur Befestigung an bzw. 

auf Transportmitteln, z.B. Kränen, Gabelstaplern, Karren etc. zu verwenden. Es liegt in Ihrer 

Verantwortung, die Produkte sicher an bzw. auf geeigneten Transport- oder Hebemitteln zu 

befestigen. Beachten Sie die Sicherheitsvorschriften des jeweiligen Herstellers eingesetzter 

Transport- oder Hebemittel, um Personenschäden und Schäden am Produkt zu vermeiden. 

3. Falls Sie das Produkt in einem Fahrzeug benutzen, liegt es in der alleinigen Verantwortung des 

Fahrers, das Fahrzeug in sicherer und angemessener Weise zu führen. Der Hersteller übernimmt 

keine Verantwortung für Unfälle oder Kollisionen. Verwenden Sie das Produkt niemals in einem sich 

bewegenden Fahrzeug, sofern dies den Fahrzeugführer ablenken könnte. Sichern Sie das Produkt im 

Fahrzeug ausreichend ab, um im Falle eines Unfalls Verletzungen oder Schäden anderer Art zu 

verhindern.  

Entsorgung 

1. Batterien bzw. Akkumulatoren, die nicht mit dem Hausmüll entsorgt werden dürfen, darf nach Ende 

der Lebensdauer nur über eine geeignete Sammelstelle oder eine Rohde & Schwarz-

Kundendienststelle entsorgt werden. 

2. Am Ende der Lebensdauer des Produktes darf dieses Produkt nicht über den normalen Hausmüll 

entsorgt werden, sondern muss getrennt gesammelt werden.  

Rohde & Schwarz GmbH & Co.KG ein Entsorgungskonzept entwickelt und übernimmt die Pflichten 

der Rücknahme- und Entsorgung für Hersteller innerhalb der EU in vollem Umfang. Wenden Sie sich 

bitte an Ihre Rohde & Schwarz-Kundendienststelle, um das Produkt umweltgerecht zu entsorgen. 
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3. Werden Produkte oder ihre Bestandteile über den bestimmungsgemäßen Betrieb hinaus mechanisch 

und/oder thermisch bearbeitet, können ggf. gefährliche Stoffe (schwermetallhaltiger Staub wie z.B. 

Blei, Beryllium, Nickel) freigesetzt werden. Die Zerlegung des Produkts darf daher nur von speziell 

geschultem Fachpersonal erfolgen. Unsachgemäßes Zerlegen kann Gesundheitsschäden 

hervorrufen. Die nationalen Vorschriften zur Entsorgung sind zu beachten. 

4. Falls beim Umgang mit dem Produkt Gefahren- oder Betriebsstoffe entstehen, die speziell zu 

entsorgen sind, z.B. regelmäßig zu wechselnde Kühlmittel oder Motorenöle, sind die 

Sicherheitshinweise des Herstellers dieser Gefahren- oder Betriebsstoffe und die regional gültigen 

Entsorgungsvorschriften einzuhalten. Beachten Sie ggf. auch die zugehörigen speziellen 

Sicherheitshinweise in der Produktdokumentation. Die unsachgemäße Entsorgung von Gefahren- 

oder Betriebsstoffen kann zu Gesundheitsschäden von Personen und Umweltschäden führen. 

Weitere Informationen zu Umweltschutz finden Sie auf der Rohde & Schwarz Home Page. 
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Consignes de sécurité fondamentales 

Lisez et respectez impérativement les instructions et consignes de sécurité suivantes 

Les usines et sites du groupe Rohde & Schwarz veillent à la conformité des produits du groupe avec les 

normes de sécurité en vigueur dans un souci constant de garantir aux clients le plus haut niveau de 

sécurité possible. Nos produits ainsi que les accessoires nécessaires sont fabriqués et testés 

conformément aux règles de sécurité en vigueur. Le respect de ces règles est vérifié régulièrement par 

notre système d’assurance qualité. Le présent produit a été fabriqué et contrôlé conformément au 

certificat de conformité CE ci-joint et a quitté l’usine dans un parfait état de sécurité. Pour le maintenir 

dans cet état et en garantir une utilisation sans danger, l’utilisateur doit respecter l’ensemble des 

consignes, remarques de sécurité et avertissements qui se trouvent dans ce manuel. Le groupe 

Rohde & Schwarz se tient à votre disposition pour toutes questions relatives aux présentes consignes de 

sécurité. 

Il incombe à l’utilisateur d’employer ce produit de manière appropriée. Le produit est exclusivement 

destiné à l’utilisation en industrie et en laboratoire et/ou, si cela a été expressément autorisé, également 

aux travaux extérieurs ; il ne peut en aucun cas être utilisé à des fins pouvant causer des dommages 

corporels ou matériels. L’exploitation du produit en dehors de son utilisation prévue ou le non-respect des 

consignes du fabricant se font sous la responsabilité de l’utilisateur. Le fabricant décline toute 

responsabilité en cas d’utilisation non conforme du produit.  

Le produit est présumé faire l’objet d’une utilisation conforme lorsqu’il est utilisé conformément aux 

consignes de la documentation produit correspondante et dans la limite de ses performances (voir fiche 

technique, documentation, consignes de sécurité ci-après). L’utilisation du produit exige des compétences 

en la matière et des connaissances de base de l’anglais. Par conséquent, le produit ne devra être utilisé 

que par un personnel qualifié ou des personnes formées de manière approfondie et possédant les 

compétences requises. Si, pour l’utilisation des produits Rohde & Schwarz, l’emploi d’un équipement 

personnel de protection s’avère nécessaire, il en est fait mention dans la documentation produit à 

l’emplacement correspondant. Conservez les consignes de sécurité fondamentales et la documentation 

produit dans un lieu sûr et transmettez ces documents aux autres utilisateurs du produit. 

La stricte observation des consignes de sécurité a pour but d’exclure des blessures ou dommages causés 

par des dangers de toutes sortes. A cet effet, il est nécessaire de lire avec soin et de bien comprendre les 

consignes de sécurité ci-dessous avant l’utilisation du produit et de les respecter lors de l’utilisation du 

produit. Toutes les autres consignes de sécurité présentées à l’emplacement correspondant de la 

documentation produit, par exemple, celles concernant la protection des personnes, doivent également 

être impérativement respectées. Dans les présentes consignes de sécurité, toutes les marchandises 

commercialisées par le groupe Rohde & Schwarz, notamment les appareils, les systèmes ainsi que les 

accessoires, sont dénommés « produit ». 
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Symboles et marquages de sécurité 
 

Symbole Signification Symbole Signification 

 

Avis, source générale de danger 

Se référer à la documentation produit 

    
MARCHE / ARRET (tension d’alimentation)  

 

Attention lors de la manipulation d’appareils 

ayant un poids élevé  

Indicateur de veille 

 

Risque de choc électrique  Courant continu (CC) 

 

Avertissement, surface chaude  Courant alternatif (CA) 

 

Borne de conducteur de protection  Courant continu/alternatif (CC/CA) 

 

Borne de mise à la terre 

 
L’appareil est conforme aux exigences de 

sécurité du degré de protection II 

(appareil entièrement protégé par isolation 

double/renforcée). 

 

Borne de mise à la masse du bâti ou du boîtier 

 

Marquage UE pour batteries et accumulateurs. 

L’appareil contient une batterie ou un 

accumulateur. Ces pièces ne peuvent pas être 

éliminées avec les déchets urbains non triés, 

mais doivent faire l’objet d’une collecte 

séparée. 

Pour plus d’informations, voir la page 7. 

 

Avis : prudence lors de la manipulation de 

composants sensibles aux décharges 

électrostatiques 

 

Marquage UE pour la collecte séparée 

d’équipements électriques et électroniques. 

Les déchets d’équipements électriques et 

électroniques ne peuvent pas être éliminés 

avec les déchets urbains non triés, mais 

doivent faire l’objet d’une collecte séparée. 

Pour plus d’informations, voir la page 7. 

 

Avertissement, rayon laser 

Les produits laser sont munis d’avertissements 

normalisés d’après leur catégorie laser. 

En raison des caractéristiques de leur 

rayonnement ainsi que de leur puissance 

électromagnétique extrêmement concentrée, 

les lasers peuvent causer des dommages 

biologiques. 

Pour plus d’informations, voir le chapitre 

« Fonctionnement »", point 7. 
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Mots d’alerte et significations 

Les mots d’alerte suivants sont utilisés dans la documentation produit pour avertir des risques et dangers. 

 

Indique une situation dangereuse immédiate qui, si elle n’est pas 

évitée, comporte un risque élevé de blessures graves ou 

mortelles. 

 

Indique une situation dangereuse possible qui, si elle n’est pas 

évitée, comporte un risque modéré de blessures (graves) ou 

mortelles. 

 

Indique une situation dangereuse qui, si elle n’est pas évitée, 

comporte un risque faible de blessures mineures ou modérées. 

 

Indique la possibilité d’une fausse manœuvre susceptible 

d’endommager le produit. 

Ces mots d’alerte correspondent à la définition habituelle utilisée pour des applications civiles dans 

l’espace économique européen. Des définitions divergentes peuvent cependant exister dans d’autres 

espaces économiques ou dans le cadre d’applications militaires. Il faut donc veiller à ce que les mots 

d’alerte décrits ici ne soient utilisés qu’en relation avec la documentation produit correspondante et 

seulement avec le produit correspondant. L’utilisation des mots d’alerte en relation avec des produits ou 

des documentations non correspondants peut conduire à des erreurs d’interprétation et par conséquent à 

des dommages corporels ou matériels. 

États et positions de fonctionnement 

L’appareil ne doit être utilisé que dans les états et positions de fonctionnement indiqués par le fabricant. 

Tout obstacle à la ventilation doit être empêché. Le non-respect des indications du fabricant peut 

provoquer des chocs électriques, des incendies et/ou des blessures graves pouvant éventuellement 

entraîner la mort. Pour tous les travaux, les règles locales et/ou nationales de sécurité et de prévention 

des accidents doivent être respectées.  

1. Sauf stipulations contraires, les produits Rohde & Schwarz répondent aux exigences ci-après :  

faire fonctionner le produit avec le fond du boîtier toujours en bas, degré de protection IP 2X, degré de 

pollution 2, catégorie de surtension 2, utilisation uniquement à l’intérieur, fonctionnement à une 

altitude max. de 2000 m au-dessus du niveau de la mer, transport à une altitude max. de 4500 m au-

dessus du niveau de la mer, tolérance de ±10 % pour la tension nominale et de ±5 % pour la 

fréquence nominale. 

2. Ne jamais placer le produit sur des surfaces, véhicules, dépôts ou tables non appropriés pour raisons 

de stabilité ou de poids. Suivre toujours strictement les indications d’installation du fabricant pour le 

montage et la fixation du produit sur des objets ou des structures (par exemple parois et étagères). En 

cas d’installation non conforme à la documentation produit, il y a risque de blessures, voire de mort. 

3. Ne jamais placer le produit sur des dispositifs générant de la chaleur (par exemple radiateurs et 

appareils de chauffage soufflants). La température ambiante ne doit pas dépasser la température 

maximale spécifiée dans la documentation produit ou dans la fiche technique. Une surchauffe du 

produit peut provoquer des chocs électriques, des incendies et/ou des blessures graves pouvant 

éventuellement entraîner la mort. 
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Sécurité électrique 

Si les consignes relatives à la sécurité électrique ne sont pas ou sont insuffisamment respectées, il peut 

s’ensuivre des chocs électriques, des incendies et/ou des blessures graves pouvant éventuellement 

entraîner la mort.  

1. Avant chaque mise sous tension du produit, il faut s’assurer que la tension nominale réglée sur le 

produit correspond à la tension nominale du réseau électrique. S’il est nécessaire de modifier le 

réglage de la tension, il faut remplacer le fusible du produit, le cas échéant.  

2. L’utilisation des produits du degré de protection I pourvus d’un câble d’alimentation mobile et d’un 

connecteur n’est autorisée qu’avec des prises munies d’un contact de protection et d’un conducteur 

de protection raccordé. 

3. Toute déconnexion intentionnelle du conducteur de protection, dans le câble ou dans le produit lui-

même, est interdite. Elle entraîne un risque de choc électrique au niveau du produit. En cas 

d’utilisation de câbles prolongateurs ou de multiprises, ceux-ci doivent être examinés régulièrement 

quant à leur état de sécurité technique. 

4. Si le produit n’est pas doté d’un interrupteur d’alimentation pour le couper du réseau électrique ou si 

l’interrupteur d’alimentation disponible n’est pas approprié pour couper le produit du réseau électrique, 

le connecteur mâle du câble de raccordement est à considérer comme dispositif de séparation. 

Le dispositif de séparation doit être à tout moment facilement accessible. Si, par exemple, le 

connecteur d’alimentation sert de dispositif de séparation, la longueur du câble de raccordement ne 

doit pas dépasser 3 m. 

Les commutateurs fonctionnels ou électroniques ne sont pas appropriés pour couper l’appareil du 

réseau électrique. Si des produits sans interrupteur d’alimentation sont intégrés dans des bâtis ou 

systèmes, le dispositif de séparation doit être reporté au niveau du système. 

5. Ne jamais utiliser le produit si le câble d’alimentation est endommagé. Vérifier régulièrement le parfait 

état du câble d’alimentation. Prendre les mesures préventives appropriées et opter pour des types de 

pose tels que le câble d’alimentation ne puisse pas être endommagé et que personne ne puisse subir 

de préjudice, par exemple en trébuchant sur le câble ou par des chocs électriques.  

6. L’utilisation des produits est uniquement autorisée sur des réseaux d’alimentation de type TN/TT 

protégés par des fusibles d’une intensité max. de 16 A (pour toute intensité supérieure, consulter le 

groupe Rohde & Schwarz). 

7. Ne pas brancher le connecteur dans des prises d’alimentation sales ou poussiéreuses. Enfoncer 

fermement le connecteur jusqu’au bout de la prise. Le non-respect de cette mesure peut provoquer 

des étincelles, incendies et/ou blessures. 

8. Ne pas surcharger les prises, les câbles prolongateurs ou les multiprises, cela pouvant provoquer des 

incendies ou chocs électriques. 

9. En cas de mesures sur les circuits électriques d’une tension efficace > 30 V, prendre les précautions 

nécessaires pour éviter tout risque (par exemple équipement de mesure approprié, fusibles, limitation 

de courant, coupe-circuit, isolation, etc.). 

10. En cas d’interconnexion avec des équipements informatiques comme par exemple un PC ou un 

ordinateur industriel, veiller à ce que ces derniers soient conformes aux normes IEC 60950-1 / 

EN 60950-1 ou IEC 61010-1 / EN 61010-1 en vigueur. 

11. Sauf autorisation expresse, il est interdit de retirer le couvercle ou toute autre pièce du boîtier lorsque 

le produit est en cours de service. Les câbles et composants électriques seraient ainsi accessibles, ce 

qui peut entraîner des blessures, des incendies ou des dégâts sur le produit. 
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12. Si un produit est connecté de façon stationnaire, établir avant toute autre connexion le raccordement 

du conducteur de protection local et du conducteur de protection du produit. L’installation et le 

raccordement ne peuvent être effectués que par un électricien ou électronicien qualifié. 

13. Sur les appareils stationnaires sans fusible ni disjoncteur automatique ou dispositif de protection 

similaire intégrés, le circuit d’alimentation doit être sécurisé de sorte que toutes les personnes ayant 

accès au produit et le produit lui-même soient suffisamment protégés contre tout dommage. 

14. Chaque produit doit être protégé de manière appropriée contre les éventuelles surtensions (par 

exemple dues à un coup de foudre). Sinon, les utilisateurs sont exposés à des risques de choc 

électrique. 

15. Ne jamais introduire d’objets non prévus à cet effet dans les ouvertures du boîtier, étant donné que 

cela peut entraîner des courts-circuits dans le produit et/ou des chocs électriques, incendies ou 

blessures. 

16. Sauf spécification contraire, les produits ne sont pas protégés contre l’infiltration de liquides, voir aussi 

la section « États et positions de fonctionnement », point 1. Il faut donc protéger les produits contre 

l’infiltration de liquides. La non-observation de cette consigne entraîne le risque de choc électrique 

pour l’utilisateur ou d’endommagement du produit, ce qui peut également mettre les personnes en 

danger. 

17. Ne pas utiliser le produit dans des conditions pouvant occasionner ou ayant déjà occasionné, le cas 

échéant, des condensations dans ou sur le produit, par exemple lorsque celui-ci est déplacé d’un 

environnement froid dans un environnement chaud. L’infiltration d’eau augmente le risque de choc 

électrique. 

18. Avant le nettoyage, débrancher le produit de l’alimentation (par exemple réseau électrique ou 

batterie). Pour le nettoyage des appareils, utiliser un chiffon doux non pelucheux. N’utiliser en aucun 

cas de produit de nettoyage chimique, tel que de l’alcool, de l’acétone ou un diluant nitrocellulosique. 

Fonctionnement 

1. L’utilisation du produit exige une formation spécifique ainsi qu’une grande concentration. Il est 

impératif que les personnes qui utilisent le produit présent les aptitudes physiques, mentales et 

psychiques requises, vu qu’autrement des dommages corporels ou matériels ne peuvent pas être 

exclus. Le choix du personnel qualifié pour l’utilisation du produit est sous la responsabilité de 

l’employeur/l’exploitant. 

2. Avant de déplacer ou de transporter le produit, lire et respecter la section « Transport ». 

3. Comme pour tous les biens produits de façon industrielle, l’utilisation de matériaux pouvant causer 

des allergies (allergènes, comme par exemple le nickel) ne peut être totalement exclue. Si, lors de 

l’utilisation de produits Rohde & Schwarz, des réactions allergiques surviennent, telles qu’éruption 

cutanée, éternuements fréquents, rougeur de la conjonctive ou difficultés respiratoires, il faut 

immédiatement consulter un médecin pour en clarifier la cause et éviter toute atteinte à la santé.  

4. Avant le traitement mécanique et/ou thermique ou le démontage du produit, il faut impérativement 

observer la section « Élimination des déchets », point 1. 
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5. Selon les fonctions, certains produits, tels que des systèmes de radiocommunication RF, peuvent 

produire des niveaux élevés de rayonnement électromagnétique. Étant donné la vulnérabilité de 

l’enfant à naître, les femmes enceintes doivent être protégées par des mesures appropriées. Les 

porteurs de stimulateurs cardiaques peuvent également être menacés par les rayonnements 

électromagnétiques. L’employeur/l’exploitant est tenu d’évaluer et de repérer les lieux de travail 

soumis à un risque particulier d’exposition aux rayonnements et de prévenir les dangers éventuels. 

6. En cas d’incendie, il se peut que le produit dégage des matières toxiques (gaz, liquides, etc.) 

susceptibles de nuire à la santé. Il faut donc, en cas d’incendie, prendre des mesures adéquates 

comme par exemple le port de masques respiratoires et de vêtements de protection. 

7. Si un produit laser est intégré dans un produit Rohde & Schwarz (par exemple lecteur CD/DVD), il ne 

faut pas utiliser de réglages ou fonctions autres que ceux décrits dans la documentation produit pour 

éviter tout dommage corporel (par exemple causé par rayon laser). 

8. Classes CEM (selon EN 55011 / CISPR 11 ; selon EN 55022 / CISPR 22, EN 55032 / CISPR 32 par 

analogie) 

 Appareil de la classe A :  

Appareil approprié à un usage dans tous les environnements autres que l’environnement 

résidentiel et les environnements raccordés directement à un réseau d’alimentation basse tension 

qui alimente des bâtiments résidentiels.  

Remarque : ces appareils peuvent provoquer des perturbations radioélectriques dans 

l’environnement résidentiel en raison de perturbations conduites ou rayonnées. Dans ce cas, on 

peut exiger que l’exploitant mette en œuvre de mesures appropriées pour éliminer ces 

perturbations. 

 Appareil de la classe B : 

Appareil approprié à un usage dans l’environnement résidentiel ainsi que dans les 

environnements raccordés directement à un réseau d’alimentation basse tension qui alimente des 

bâtiments résidentiels. 

Réparation et service après-vente 

1. Le produit ne doit être ouvert que par un personnel qualifié et autorisé. Avant de travailler sur le 

produit ou de l’ouvrir, il faut le couper de la tension d’alimentation ; sinon il y a risque de choc 

électrique.  

2. Les travaux d’ajustement, le remplacement des pièces, la maintenance et la réparation ne doivent 

être effectués que par des électroniciens qualifiés et autorisés par Rohde & Schwarz. En cas de 

remplacement de pièces concernant la sécurité (notamment interrupteur d’alimentation, 

transformateur d’alimentation réseau ou fusibles), celles-ci ne doivent être remplacées que par des 

pièces d’origine. Après chaque remplacement de pièces concernant la sécurité, une vérification de 

sécurité doit être effectuée (contrôle visuel, vérification du conducteur de protection, mesure de la 

résistance d’isolement et du courant de fuite, essai de fonctionnement). Cela permet d’assurer le 

maintien de la sécurité du produit.  

Batteries et accumulateurs/cellules 

Si les instructions concernant les batteries et accumulateurs/cellules ne sont pas ou sont insuffisamment 

respectées, cela peut provoquer des explosions, des incendies et/ou des blessures graves pouvant 

entraîner la mort. La manipulation de batteries et accumulateurs contenant des électrolytes alcalins (par 

exemple cellules de lithium) doit être conforme à la norme EN 62133. 
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1. Les cellules ne doivent être ni démontées, ni ouvertes, ni réduites en morceaux.  

2. Ne jamais exposer les cellules ou batteries à la chaleur ou au feu. Ne pas les stocker dans un endroit 

où elles sont exposées au rayonnement direct du soleil. Tenir les cellules et batteries au sec. Nettoyer 

les raccords sales avec un chiffon sec et propre. 

3. Ne jamais court-circuiter les cellules ou batteries. Les cellules ou batteries ne doivent pas être 

gardées dans une boîte ou un tiroir où elles peuvent se court-circuiter mutuellement ou être court-

circuitées par d’autres matériaux conducteurs. Une cellule ou batterie ne doit être retirée de son 

emballage d’origine que lorsqu’on l’utilise. 

4. Les cellules ou batteries ne doivent pas être exposées à des chocs mécaniques de force non 

admissible. 

5. En cas de manque d’étanchéité d’une cellule, le liquide ne doit pas entrer en contact avec la peau ou 

les yeux. S’il y a contact, rincer abondamment à l’eau l’endroit concerné et consulter un médecin. 

6. Il y a danger d’explosion en cas de remplacement ou chargement incorrect des cellules ou batteries 

qui contiennent des électrolytes alcalins (par exemple cellules de lithium). Remplacer les cellules ou 

batteries uniquement par le type Rohde & Schwarz correspondant (voir la liste des pièces de 

rechange) pour maintenir la sécurité du produit.  

7. Il faut recycler les cellules ou batteries et il est interdit de les éliminer comme déchets normaux. Les 

accumulateurs ou batteries qui contiennent du plomb, du mercure ou du cadmium sont des déchets 

spéciaux. Observer les règles nationales d’élimination et de recyclage.  

Transport 

1. Le produit peut avoir un poids élevé. Il faut donc le déplacer ou le transporter avec précaution et en 

utilisant le cas échéant un moyen de levage approprié (par exemple, chariot élévateur) pour éviter des 

dommages au dos ou des blessures.  

2. Les poignées des produits sont une aide de manipulation exclusivement réservée au transport du 

produit par des personnes. Il est donc proscrit d’utiliser ces poignées pour attacher le produit à ou sur 

des moyens de transport, tels que grues, chariots et chariots élévateurs, etc. Vous êtes responsable 

de la fixation sûre des produits à ou sur des moyens de transport et de levage appropriés. Observer 

les consignes de sécurité du fabricant des moyens de transport ou de levage utilisés pour éviter des 

dommages corporels et des dégâts sur le produit. 

3. L’utilisation du produit dans un véhicule se fait sous l’unique responsabilité du conducteur qui doit 

piloter le véhicule de manière sûre et appropriée. Le fabricant décline toute responsabilité en cas 

d’accidents ou de collisions. Ne jamais utiliser le produit dans un véhicule en mouvement si cela 

pouvait détourner l’attention du conducteur. Sécuriser suffisamment le produit dans le véhicule pour 

empêcher des blessures ou dommages de tout type en cas d’accident.  

Élimination des déchets 

1. Au terme de leur durée de vie, les batteries ou accumulateurs qui ne peuvent pas être éliminés avec 

les déchets ménagers peuvent uniquement être éliminés par des points de collecte appropriés ou par 

un centre de service après-vente Rohde & Schwarz. 
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2. Au terme de sa durée de vie, un produit ne peut pas être éliminé avec les déchets ménagers 

normaux, mais doit être collecté séparément. 

Rohde & Schwarz GmbH & Co. KG a développé un concept d’élimination des déchets et assume 

toutes les obligations en matière de reprise et d’élimination, valables pour les fabricants au sein de 

l’UE. Veuillez vous adresser à votre centre de service après-vente Rohde & Schwarz pour éliminer le 

produit de manière écologique.  

3. Si les produits ou leurs composants sont travaillés mécaniquement et/ou thermiquement au-delà de 

l’utilisation prévue, ils peuvent, le cas échéant, libérer des substances dangereuses (poussières 

contenant des métaux lourds comme par exemple du plomb, du béryllium ou du nickel). Le 

démontage du produit ne doit donc être effectué que par un personnel qualifié et spécialement formé. 

Le démontage inadéquat peut nuire à la santé. Les règles nationales concernant l’élimination des 

déchets doivent être observées. 

4. Si, lors de l’utilisation du produit, des substances dangereuses ou combustibles exigeant une 

élimination spéciale sont dégagées, comme par exemple liquides de refroidissement ou huiles 

moteurs qui sont à changer régulièrement, les consignes de sécurité du fabricant de ces substances 

dangereuses ou combustibles ainsi que les règles sur l’élimination en vigueur au niveau régional 

doivent être respectées. Les consignes de sécurité spéciales correspondantes dans la documentation 

produit doivent également être respectées, le cas échéant. L’élimination non conforme des 

substances dangereuses ou combustibles peut provoquer des atteintes à la santé et des dommages 

écologiques. 

Pour plus d’informations concernant la protection de l’environnement, voir la page d’accueil de 

Rohde & Schwarz. 
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Preface

1.1 Documentation Overview

The user documentation for the R&S RTM consists of the following parts:

● Help system on the instrument
● "Getting Started" printed manual in English
● Documentation CD-ROM with:

– Getting Started
– User manual
– Service manual
– Data sheet
– Open source acknowledgments
– Certificates
– Links to useful sites on the Rohde & Schwarz Internet

Instrument Help

The instrument help is embedded in the instrument's firmware, and it is installed
together with the firmware. It offers quick, context-sensitive access to the complete
information needed for operation and programming. Firmware updates are available on
the Rohde & Schwarz product website in the "Downloads" > "Firmware" section.

Getting Started

The Getting Started manual provides the information needed to set up and start work-
ing with the instrument, and describes basic operations and typical measurement
examples. The manual also includes safety information. The English edition of this
manual is delivered with the instrument in printed form and on the Documentation CD-
ROM. The newest English version and translations to other languages (if available) are
provided in PDF format on the product website.

User Manual

The user manual describes all instrument functions in detail. It also provides an intro-
duction to remote control and a complete description of the remote control commands
with programming examples.

The user manual is available in PDF format on the Documentation CD-ROM. The new-
est version of the manual is provided on the product website in PDF format for down-
load and as online manual (HTML) for immediate display (no download required).

Service Manual

The Service Manual is available in PDF format on the Documentation CD-ROM. It
describes how to check compliance with rated specifications, instrument function,
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repair, troubleshooting, and fault elimination. It contains all information required for
repairing the instrument by replacing modules.

Documentation updates

You can download the newest version of all manuals here: www.rohde-schwarz.com/
product/rtm.html > "Downloads > Manuals".

1.2 Conventions Used in the Documentation

This chapter describes the conventions used throughout this documentation.

1.2.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.
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2 Acquisition and Waveform Setup
The chapter describes the horizontal and vertical basic settings including the acquisi-
tion and probe settings.

2.1 Basics

This chapter provides background information on the essential settings in the vertical
and horizontal systems, on acquisition setup and probing.

2.1.1 Vertical System

The controls and parameters of the vertical system are used to scale and position the
waveform vertically.

2.1.1.1 Input Coupling

The input coupling influences the signal path between input connector and the follow-
ing internal signal stage. The coupling can be set to DC, AC, or ground.
● DC coupling shows all of an input signal. DC coupling is available with 1 MΩ input

impedance to connect standard passive probes. DC coupling is the default for 50 Ω
input impedance.

● AC coupling is useful if the DC component of a signal is of no interest. AC coupling
blocks the DC component of the signal so that the waveform is centered around
zero volts.

2.1.1.2 Vertical Scale and Position

Vertical scale and vertical position directly affect the resolution of the waveform ampli-
tude. The vertical scale corresponds to the ADC input range. To get the full resolution
of the ADC, set up the waveforms to cover most of the height of the diagram.
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Figure 2-1: Input range and resolution of the ADC

2.1.1.3 Bandwidth

For analog applications, the highest signal frequency determines the required oscillo-
scope bandwidth. As a general rule , the oscilloscope bandwidth should be 3 times
higher than the maximum frequency included in the analog test signal to measure the
amplitude with high accuracy.

Most test signals are more complex than a simple sine wave and include several spec-
tral components. A digital signal, for example, is built up of several odd harmonics. As
a general rule, for digital signals the oscilloscope bandwidth should be 5 times higher
than the clock frequency to be measured.

The oscilloscope is not a stand-alone system. You need a probe to measure the signal
of interest, and the probe has a limited bandwidth, too. The combination of oscillo-
scope and probe creates a system bandwidth. To reduce the effect of the probe on the
system bandwidth, the probe bandwidth must exceed the bandwidth of the oscillo-
scope, the recommended factor is 1.5 x oscilloscope bandwidth.

See also: Chapter 2.1.4.1, "Voltage Probes", on page 22

2.1.2 Sampling and Acquisition

The vertical system of a digital oscilloscope conditions the test signal in a way that the
following A/D Converter (ADC) can transform the measured voltage into digital data.
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2.1.2.1 Sampling and Processing

The A/D converter samples the continuous signal under test at specific points in time
and delivers digital values called ADC samples. The rate at which the converter is
working is the ADC sample rate, a constant value specified in GHz:     fADC = 1 / TI

The digital ADC samples are processed according to the acquisition settings. The
result is a waveform record that contains waveform samples and is stored in the
waveform memory. The waveform samples are displayed on the screen and build up
the waveform.

The number of waveform samples in one waveform record is called record length.
The rate of recording waveform samples - the number of waveform samples per sec-
ond - is the sample rate. The higher the sample rate, the better is the resolution and
the more details of the waveform are visible.

A sufficient resolution is essential for correct reconstruction of the waveform. If the sig-
nal is undersampled, aliasing occurs - a false waveform is displayed. To avoid aliasing
and accurately reconstruct a signal, Nyquist theorem postulates that the sample rate
must be at least twice as fast as the highest frequency component of the signal. How-
ever, the theorem assumes ideal conditions, so the Nyquist sample rate is usually not
sufficient.
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Figure 2-2: Waveforms acquired with different sample rates

To avoid aliasing, the sample rate must be set to a value 3 to 5 times the fastest fre-
quency component of the signal. A higher sample rate increases signal fidelity, increa-
ses the chance to capture glitches and other signal anomalies, and improves the
zoom-in capabilities.

2.1.2.2 Acquisition Settings

The resulting sample rate can be the same as the constant ADC sample rate, or
higher, or lower.

By default, the real time sample mode is used. With fast timebase settings, the sam-
ple rate becomes higher than the ADC sample rate. The missing waveform samples
are added to the ADC samples with sin(x)/x interpolation automatically.

When measuring high-frequency, repetitive signals whose frequency components are
even higher than the ADC sample rate, equivalent-time sampling is used to capture
the waveform. This sample mode captures ADC samples over a number of subsequent
repetitions at different points in time, and creates one waveform with higher sample
rate from this data.

At lower timebase settings, the required sample rate is lower than the ADC sample
rate. To reduce the sample rate, decimation methods are used: sample and peak
detect.

As digital waveform data is stored in the memory, and the memory can save many
waveform records, further waveform arithmetic processing is possible: average and
envelope waveforms are resulting waveforms, created from a composite of sample
points taken from multiple acquisitions. Another function called smoothing calculates
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a mean value of several adjacent sample points of the same waveform and displays it.
The result is a moving average that uses the full data and can be used for non-periodic
signals.

2.1.2.3 Acquisition Control

You can run the R&S RTM in two ways:
● RUN CONT: the instrument acquires data until you stop it manually.
● RUN N× SINGLE: the instrument samples and processes a specified number of

acquisitions.

The determining point of an acquisition is the trigger. The instrument acquires continu-
ously and keeps the sample points to fill the pre-trigger part of the waveform record.
When the trigger occurs, the instrument continues acquisition until the post-trigger part
of the waveform record is filled. Then it stops acquiring and waits for the next trigger.
When a trigger is recognized, the instrument does not accept another trigger until the
acquisition is complete.

The trigger modes define how the instrument triggers:
● Normal: The instrument acquires a waveform only if a real trigger occurs, that is, if

all trigger conditions are fulfilled.
● Auto: The instrument triggers repeatedly after a fixed time interval if the trigger con-

ditions are not fulfilled. If a real trigger occurs, it takes precedence. If the real trig-
ger is faster than the auto trigger, both modes are virtually the same.

In practice, both trigger modes are useful: The auto mode lets you see the signal with
little adjustment, while the normal mode selects the interesting part of the waveform. If
you want to acquire a specified number of waveforms, make sure to select the normal
trigger mode. Thus you get only the required number of interesting acquisitions.

See also: Chapter 3, "Triggers", on page 54

2.1.3 Horizontal System

As described before in Chapter 2.1.2.3, "Acquisition Control", on page 21, the trigger is
the determining point of the waveform record.

Two parameters set the position of the horizontal acquisition window in relation to the
trigger point: time reference and trigger offset. Using these parameters, you choose
the part of the waveform you want to see: around the trigger, before, or after the trig-
ger.
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2.1.4 Probes

A probe connects the signal source (DUT) to the oscilloscope, and delivers the signal
to be measured. It is the essential first link in the measurement chain.

An ideal probe fulfills the following requirements:
● Safe and reliable contacts
● Infinite bandwidth
● The probe should not load the signal source and thus impact the circuit operation.
● The connection should not introduce or suppress signal components (hum, noise,

filter) and thus degrade or distort the transferred signal.

In reality, the probe can never be an ideal one, it always affects the signal transmission
and the signal source, and thus the measured signal. It depends on the frequency to
be measured and on the signal source to determine the acceptable loading, and to
determine which kind of probe delivers good results.

The solution depends on the quantity to be measured with respect to:
● Signal type: voltage, current, power, pressure, optical, etc.
● Signal amplitude: The oscilloscope itself can only display voltages in a limited

range. Most probes can adjust the dynamic range to amplitudes from a few mV to
10 V. Smaller or much larger signals require specialized equipment.

● Signal frequency: High frequencies require advanced equipment in order to get
correct results.

● Source characteristic: The source impedance is the decisive factor when choosing
the suitable connection.

2.1.4.1 Voltage Probes

The following table provides an overview on common voltage probes and their usage.
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Table 2-1: Voltage probes overview

Probe type Attenuation Typical bandwidth
range

Oscilloscope
input

Usage

Passive, high impe-
dance

1:1 10 MHz 1 MΩ Low speed, low level
signals

Passive, high impe-
dance

10:1 500 MHz 1 MΩ General purpose

Passive, low impe-
dance

10:1 up to 10 GHz 50 Ω High frequency

Active, single-ended 10:1 up to 10 GHz 50 Ω High speed

Active, differential 10:1  50 Ω Floating

For a list of recommended probes refer to the R&S RTM product brochure.

Besides the possible input voltage range, two factors are important when selecting a
voltage probe: Bandwidth and impedance over frequency.
● Bandwidth:

The combination of probe and oscilloscope builds up a system. The resulting sys-
tem bandwidth is approximately determined with:

22
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scopeprobesystem BWBWBW

To measure the signal with low measurement error, the system bandwidth should
be higher than the highest frequency component of the signal. The probe band-
width must be even higher than the system bandwidth.

● Impedance:
A minimum impedance is required to keep the circuit loading low. Over frequency,
the impedance decreases, in particular with passive probes. The probe impedance
should be approximately 10 times the impedance of the circuit test point at the
highest signal frequency.

Passive voltage probes

Passive probes have the following qualities:
● No active components inside
● BNC connector for universal use
● Compensate the probe when it is connected to a scope input: LF compensation

matches the probe (mainly cable) capacitance to the oscilloscope input capaci-
tance.
High frequency adjustment is an option for higher measurement frequencies in the
MHz range.

● With high impedance probes, the impedance varies significantly over frequency.
● With low impedance probes, the impedance variation over frequency is low, but the

load on the source is high.
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If you use passive probes, remember some recommendations:
● Use a probe recommended for your oscilloscope model.
● Use a ground lead as short as possible to minimize the effect of ground lead induc-

tance. The resonance frequency can be much lower than the system bandwidth
and thus can affect the measurement results, in particular, if you measure steep
edge rise times.

● Select a probe that has a bandwidth of 5 to 10 times the highest frequency being
measured. This preserves the harmonics and thus the waveform integrity.

Active voltage probes - General

Active probes require operating power from the instrument and have a proprietary
interface to the instrument. Their main qualities are:
● Low loading on signal source
● The probe is automatically recognized by the instrument, no adjustment is

required.
● Adjustable DC offset at probe tip allows for high resolution on small AC signals

which are superimposed on DC levels.
● Connections should be as short as possible to keep the usable bandwidth high.
● Observe the operating voltage range.
● The probe impedance depends on the signal frequency.

RT-ZS single-ended active probes and RT-ZD differential active probes provide special
features for easier use and precise measurements. These special features are not
available on RT-ZSxxE probes.

● The micro button on the probe head remotely controls important functions on the
instrument, like running and stopping the acquisition, autoset, AutoZero and setting
the offset to mean value.

● The R&S ProbeMeter measures DC voltages between the probe tip and the
ground connection with very high precision. The result is displayed on the instru-
ment's screen. So you can check DC voltages with different levels without having
to adjust the measurement range of the oscilloscope. The R&S ProbeMeter also
measures the zero error of the probe to optimize measurement results at small sig-
nal levels.

When you connect an R&S RT-ZSxx active probe to a channel input of the R&S RTM,
the oscilloscope recognizes the probe. It reads the identification and calibration data
from the probe box and shows the result in the "Setup" and "Probe Attributes" tabs.
This data together with the deskew time for a given channel is stored and processed
by the R&S RTM. If you connect the probe the next time to the same channel, the
information is fetched and used.

Differential Active Probes

Differential active probes are designed to measure signals that are referenced against
each other, and voltages that are not references to ground, for example twisted-pair
signal lines. The R&S RT-ZD probes are differential probes with high input impedance,
they can be used to measure voltages between any two test points.
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Compared with two-channel measurement setup with single-ended probes, the mea-
surement with differential probes is symmetric due to the same amplification and cable
length on both paths. It is also immune to interference and noise and occupies only
one input channel.

A differential probe has three sockets: the positive signal socket (+), the negative sig-
nal socket (-), and the ground socket.

Multiple input voltages can be defined for a differential probe:
● Differential mode input voltage (Vin, Vdm)

Voltage between the positive and negative signal sockets
● Positive single-ended input voltage (Vp)

Voltage between the positive signal socket and the ground socket
● Negative single-ended input voltage (Vn)

Voltage between the negative signal socket and the ground socket
● Common mode input voltage (Vcm)

Mean voltage of positive and negative signal sockets referred to the ground socket,
respectively

Two of these voltages are independent values, the other two can be calculated:

2
np

cm

npin

VV
V

VVV






R&S RT-ZD probes detect only differential input voltages and provide it to the oscillo-
scope. Common mode signals are suppressed by the probe. This characteristic is
described by the Common Mode Rejection Ratio (CMRR):

GainCommonMode
alGainDifferentiCMRR 

In addition, the R&S ProbeMeter of R&S RT-ZD differential probes can measure differ-
ential and common mode DC voltages. The measurement result is displayed on the
oscilloscope's screen. The common mode measurement of the R&S ProbeMeter
allows you to check the input voltage relative to ground. Thus, the CM measurement is
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a convenient way to detect breaches of the operating voltage window, and the reason
of unwanted clippings.

2.2 Setting up the Waveform

This chapter contains the fundamental procedures for setting up the acquisition and
adjusting the channel waveforms.

Passive probes
Passive probes require compensation for exact signal display and measurement. The
compensation procedure is described in the "Getting Started" manual.

2.2.1 Setting Up the Signal Input with Autoset

Autoset is the solution for the major part of routine test-setup. It is also a good start if
you need to use more complex trigger settings. Autoset finds appropriate horizontal
and vertical scales and trigger conditions to present a stable waveform.

1. Connect the probe to the input connector CH N.

The instrument recognizes the probe and turns the channel on.

2. Press the AUTOSET button on the left of the display.

2.2.2 Adjusting the Signal Input Manually

The settings mentioned here are described in detail in:
● Chapter 2.3.1, "HORIZONTAL Controls", on page 28
● Chapter 2.3.3.2, "Channel Menu", on page 36
● Chapter 2.3.3.1, "VERTICAL Controls", on page 34

1. Connect the probe to the input connector CH N.

The instrument recognizes the probe and turns the channel on.

2. Use the SCALE rotary knob in the HORIZONTAL area of the front panel to set up
the time base.

3. Use the POSITION rotary knob to set up the trigger position. Press the knob to
reset the trigger offset to 0 s.

4. Press the channel key corresponding to the input channel. It is lighted with the
color of the channel waveform.

5. In the softkey menu, press the "Coupling" softkey repeatedly to select the correct
coupling.
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6. Select the "Bandwidth" limit.

7. If you use a passive probe, adjust the probe settings:

a) Select the "Termination" (input impedance).
b) Select "More" to switch the menu page.
c) Press the "Probe" softkey and select the attenuation.

8. Use the SCALE rotary knob in the VERTICAL area of the front panel to adjust the
vertical scale of the waveform. Press the knob to toggle between fine and rough
adjustment.

9. Use the POSITION rotary knob to adjust the vertical position of the waveform. Ver-
tical position is defined by the position of the waveform's zero line and the offset
between the zero line and the waveform axis. Pressing the knob toggles between
these parameters.
By default, offset is disabled. Press the "Offset" softkey in the "Channel" menu to
enable the offset. Use the NAVIGATION knob or the POSITION / OFFSET knob to
adjust. Turn clockwise to move the waveform down.

10. Proceed with: Chapter 2.2.3, "Setting the Acquisition", on page 27.

2.2.3 Setting the Acquisition

Prerequisites:
● Probes are connected.
● Vertical and horizontal settings are adjusted.

For details on acquisition settings, see Chapter 2.3.2.1, "Acquisition Menu",
on page 30.

1. Press the ACQUISITION key in the HORIZONTAL area of the front panel.

2. Select the "Sample Mode" - Real time or Equivalent time.
This defines the behavior of the oscilloscope if the sample rate is higher than the
ADC sample rate.
Use Equivalent time to capture fast repetitive signals whose frequency components
may be much higher than the sample rate of the ADC.

3. Select the "Decimation Mode" - for example, Peak detect.
This defines the behavior of the instrument if the oscilloscope captures more sam-
ples than the waveform memory can save.

4. Select the "Wavef. Arithmetic" - for example, Average or Envelope.
This defines how the resulting waveform is built from several consecutive acquisi-
tions of the signal.

5. If "Average" is selected, enter the "Number of Averages", that is the number of
waveforms used for average calculation.

6. Select the "Waveform Rate".
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2.2.4 Starting and Stopping Acquisition

You can control the acquisition in two ways:
● Running continuous acquisition until you stop it
● Running one acquisition or a given number of acquisitions

Prerequisites:
● Probes are connected.
● Vertical and horizontal settings are adjusted.
● Triggering is set.
● Channels to be acquired are turned on.

To start and stop continuous acquisition

1. Check if the trigger mode is set to "Normal". The trigger mode is shown in the top
information bar.
If not, press the MODE key on the front panel to toggle the setting.

2. Press the RUN CONT key to start acquisition.

The acquisition starts if a trigger occurs.

3. To stop, press the RUN CONT key again.

The acquisition stops immediately.

To acquire a limited number of acquisitions

1. Press the ACQUISITION key in the HORIZONTAL area of the front panel.

2. Select "Nx Single" and enter the number of acquisitions.

3. Press the RUN N× SINGLE key on the front panel.
You can stop the acquisition before it is finished by pressing the key again.

2.3 Reference for Waveform Setup

2.3.1 HORIZONTAL Controls

Time base settings adjust the display in horizontal direction. Use the rotary knobs in
the HORIZONTAL functional block for setting.
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POSITION..................................................................................................................... 29
SCALE.......................................................................................................................... 29

POSITION
The rotary knob changes the trigger offset. This is the horizontal position of the trigger
point in relation to the reference point - the zero point of the grid. Thus, you can set the
trigger point even outside the diagram and analyze the signal some time before or after
the trigger.

The reference point is set with SETUP >"Time Reference".

Turn clockwise to move the trigger point to the right. At zero-crossing, the knob shortly
snaps in and the setting is kept constant to simplify the zero-setting. The current trigger
position is shown in the top information bar, denoted by "T". Press the knob to reset
the trigger offset to 0.

Note: If a zoom or FFT window is displayed, the knob can adjust other values depend-
ing on the selection of the SCALE rotary knob.
See also: "Time Reference" on page 386

Remote command: 
TIMebase:POSition on page 416

SCALE
The rotary knob adjusts the time scale of the horizontal axis for all signals, also known
as time base. The current scale value is shown in the top information bar, denoted by
"TB". Turn clockwise to stretch the waveforms - the scale value time/div decreases.

If a Zoom or FFT window is displayed, press the knob to switch between the settings,
then turn to adjust the selected value.

Remote command: 
TIMebase:SCALe on page 414

2.3.2 Acquisition Settings

The ACQUISITION key in the HORIZONTAL functional block opens the "Acquisition"
menu, where you select the the settings for data processing - how the waveform is built
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from the captured ADC samples. The current acquisition mode is shown in the top
information bar, the second value from right.

The settings are placed in the "Acquisition" menu and in the "Acquisition Control"
menu.

2.3.2.1 Acquisition Menu

Access: ACQUISITION key

Decimation Mode.......................................................................................................... 30
Wfm. Arithmetic.............................................................................................................31
No. of Averages............................................................................................................ 31
Limit Freq...................................................................................................................... 31
Acquisition Control........................................................................................................ 31
Sample Mode................................................................................................................ 32
Interpolation.................................................................................................................. 32
Roll................................................................................................................................ 32

Decimation Mode
Decimation reduces the data stream of the ADC to a stream of waveform points with
lower sample rate and a less precise resolution if the oscilloscope captures more sam-
ples than the waveform memory can save.

"Sample" The oscilloscope acquires the input data with a sample rate which is
aligned to the time base (horizontal scale) and the memory depth.
Usually, most signals are displayed optimally with this acquisition
mode if all trigger conditions are met.

"Peak Detect" The minimum and the maximum of n samples are recorded as wave-
form points, the other samples are discarded. Thus the instrument
can detect fast signal peaks at slow time scale settings that would be
missed with other acquisition modes.

"High Resolu-
tion"

The average of n captured sample points is recorded as one wave-
form sample. Averaging reduces the noise, the result is a more pre-
cise waveform with higher vertical resolution. The resulting resolution
is indicated in the upper right corner of the window.

Remote command: 
CHANnel<m>:TYPE on page 419
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Wfm. Arithmetic
Waveform arithmetic builds the resulting waveform from several consecutive acquisi-
tions of the signal (envelope and average) or by other operations on the captured data.
The arithmetic works with all sample modes and decimated waveforms.

"Off" No arithmetic is applied.

"Envelope" The minimum and maximum values are saved in addition to the nor-
mal waveform samples. The resulting diagram shows two envelope
waveforms below and above the normal waveform: the minimums
(floor) and maximums (roof) representing the borders in which the
signal occurs. The envelope is refreshed with each acquisition and it
is reset each time the waveform parameters are changed.

"Average" The average is calculated from the data of the current acquisition and
a number of acquisitions before. The method reduces random noise
and other heterodyne signals. It requires a stable, triggered and
repetitive signal.
The number of acquisitions for average calculation is defined with No.
of Averages. The resulting resolution is indicated in the upper right
corner of the window.

"Smooth" Smoothing calculates a mean value of several adjacent sample
points and displays it. The result is a smoothed waveform. Thus,
smoothing is a moving average that uses the full data and can be
used for non-periodic signals. It works like a low-pass, and increases
the vertical resolution at the expense of bandwidth reduction.

"Filter" Filter is a low-pass with 3 db attenuation at a configurable limit fre-
quency set with "Limit Freq.". The filter removes higher frequencies
from the channel signals.

Remote command: 
CHANnel<m>:ARIThmetics on page 419

No. of Averages
Defines the number of waveforms used to calculate the average waveform with "Wfm.
Arithmetic" = "Average". Only numbers from the 2n progression are available. The
higher the number, the better the noise is reduced.

Remote command: 
ACQuire:AVERage:COUNt on page 417

Limit Freq.
Sets the limit frequency for "Wfm. Arithmetic" = "Filter". The low pass filter has 3 dB
attenuation at the given limit frequency.

Remote command: 
ACQuire:FILTer:FREQuency on page 420

Acquisition Control
Opens the "Acquisition Control" menu to set the waveform rate.

If option R&S RTM-K15 is installed, the segmentation is defined in the menu.

See also:
● Chapter 2.3.2.2, "Acquisition Control Menu", on page 33
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● Chapter 2.4.2, "Segmentation Settings", on page 45

Sample Mode
Defines how the waveform is created from the sample points which are acquired by the
ADC.

The setting is only available for instruments with < 1 GHz bandwidth. Instruments with
1 GHz bandwidth support only real time sampling.

"Real Time" At slow time base settings the oscilloscope can acquire enough
points to create an accurate waveform, so the sampled points of the
input signal are used directly to build the waveform.
With fast time base settings, the sample rate is higher than the ADC
sample rate. Waveform samples are added to the ADC samples
according to the selected interpolation method.
See also: "Interpolation" on page 32
Real-time sampling is used to capture fast, single-shot, transient sig-
nals.

"Equivalent
Time"

Random equivalent-time sampling: This mode requires repetitive, sta-
ble signals. It is used to capture fast signals whose frequency compo-
nents may be much higher than the sample rate of the ADC. The
waveform points are taken from several acquisitions at a different
time in relation to the trigger point. The time difference between the
sample and the trigger is random. Then, all the sampled points are
put together into one composite waveform.

Remote command: 
ACQuire:MODE on page 417

Interpolation
Selects the interpolation method if the real time sample mode needs interpolation.

"Sin (x)/x" Two adjacent ADC sample points are connected by a sin(x)/x curve,
and also the adjoining sample points are considered by this curve.
The interpolated points are located on the resulting curve. This inter-
polation method is the default method. It is very precise and shows
the best signal curve.

"Linear" Two adjacent ADC sample points are connected by a straight line,
the interpolated points are located on the line. You see a polygonal
waveform similar to the real signal, and also the ADC sample points
as vertexes.

"Sample &
Hold"

The ADC sample points are displayed like a histogram. For each
sample interval, the voltage is taken from the sample point and con-
sidered as constant, and the intervals are connected with vertical
lines. Thus, you see the discrete values of the ADC.

Remote command: 
ACQuire:INTerpolate on page 417

Roll
Enables the roll mode.
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The roll mode moves the captured input data on the display from the right to the left.
The instrument shows the waveform immediately, without waiting for the complete
acquisition of the waveform record. The roll mode displays the untriggered signal. Use
the roll mode for slow, non-repetitive signals with 200 kHz or slower.

In roll mode, you can the following functionality:
● Quick measurements
● XY-diagram
● In stop mode:

– FFT
– Zoom
– Waveform export

The roll mode has the following restrictions:
● RUN N× SINGLE captures the waveform until the display is filled. Multiple acquis-

tions are not possible, "N× Single" = 1.
● Segmentation and history are not available
● "Wfm. Arithmetic" is not available
● Sample mode is alway real time.
● Serial and parallel buses, logic analysis, power measurements and mask testing

are not available

Remote command: 
TIMebase:ROLL:ENABle on page 420

2.3.2.2 Acquisition Control Menu

Access: ACQUISITION key > "Acquisition Control"

If option R&S RTM-K15 is installed, the menu provides additional settings. See Chap-
ter 2.4.2, "Segmentation Settings", on page 45.

Waveform Rate............................................................................................................. 33
Record Length...............................................................................................................34
Nx Single.......................................................................................................................34

Waveform Rate
Defines the mode to set the sample rate (samples per second saved in the memory)
and the waveform acquisition rate (waveforms per second).

"Max. Wfm.
Rate"

The instrument combines sample rate and memory depth to acquire
at maximum waveform acquisition rate. In connection with persis-
tence, the mode can display rare signal anomalies.
Note: Due to less memory depth, aliasing effects may occur.
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"Max. Sa.
Rate"

The instrument acquires the signal at maximum sample rate and uses
the full memory depth. The result is a waveform with maximum num-
ber of waveform samples, high degree of accuracy, and low risk of
aliasing. However, the waveform acquisition rate is low.

"Automatic" Default mode: To display the best waveform, the instrument selects
the optimum combination of waveform acquisition rate and sample
rate using the maximum record length.

Remote command: 
ACQuire:WRATe on page 418

Record Length
Shows the current record length, the number of recorded waveform points that build
the waveform across the acquisition time.

Remote command: 
ACQuire:POINts[:VALue] on page 418

Nx Single
Sets the number of waveforms that are acquired with RUN N× SINGLE.

Remote command: 
ACQuire:NSINgle:COUNt on page 414

2.3.3 Vertical Settings

To adjust the vertical settings, you use the keys and rotary knobs in the VERTICAL
functional block of the front panel and the channel-specific softkey menu.

2.3.3.1 VERTICAL Controls

REF functions are described in Chapter 5, "Reference Waveforms", on page 94.
MATH functions are described in Chapter 7, "Mathematics", on page 118.
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CH N............................................................................................................................. 35
SIGNAL OFF.................................................................................................................35
POSITION / OFFSET....................................................................................................35

└ POSITION.......................................................................................................35
└ OFFSET..........................................................................................................35

SCALE, Y-Scale............................................................................................................36

CH N
Each channel key turns on an analog channel, selects it, and opens the "Channel"
menu with the vertical settings of the selected channel. The key is illuminated in the
channel color, if the channel is active.

The effect of the keypress depends on state of the channel:
● If channel is off: Pressing the key turns on the channel and selects it. The rotary

knobs alongside light up in the channel color.
● If the channel is on: Pressing the key selects the channel waveform and opens its

channel setup menu.

Remote command: 
CHANnel<m>:STATe on page 421

SIGNAL OFF
Turns off the selected signal and selects the next channel, math or reference wave-
form.

The key lights up in the color of the selected signal and changes the light according to
the new selection.

Remote command: 
CHANnel<m>:STATe on page 421

POSITION / OFFSET
The rotary knob adjusts the vertical position or the DC offset (if enabled). It lights up in
the color of the selected waveform. Pressing the key toggles the parameter, the current
parameter and its value are shown in a temporary label marked with the channel color.

Note: By default, offset is disabled. Press "Offset" in the "Channel" menu to enable the
offset.

POSITION ← POSITION / OFFSET
Position changes the vertical location of the selected channel, math, or reference
waveform, or of the decoded bus signal. Turn clockwise to move the waveform up. At
zero-crossing, the knob shortly snaps in and the setting is kept constant to simplify the
zero-setting.

Remote command: 
CHANnel<m>:POSition on page 424
CALCulate:MATH<m>:POSition on page 498
BUS<b>:POSition on page 550

OFFSET ← POSITION / OFFSET
The offset voltage is added to correct an offset-affected signal. The vertical center of
the selected channel is shifted by the offset value and the signal is re-positioned within
the diagram area.
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Use the offset to measure small AC voltages that are overlaid by higher DC voltages.
Unlike AC coupling, the DC part of the signal is not lost with offset setting. The device
under test is not affected. The offset always has to be set manually, it is not included in
the autoset process.

Turn clockwise to move the waveform down. At zero-crossing, the knob shortly snaps
in and the setting is kept constant to simplify the zero-setting.

If an active probe is connected, the offset limit is defined by the probe. Refer to the
documentation of the probe for allowed values.

Remote command: 
CHANnel<m>:OFFSet on page 424
PROBe<m>:SETup:UOFFset on page 435

SCALE, Y-Scale
Sets the vertical scale in Volts per division to change the amplitude of the selected
channel, math, or reference waveform, or of the decoded bus signal. The current value
is shown in the waveform label above the grid. The knob lights up in the color of the
selected waveform.

Turn SCALE clockwise to stretch the waveform. Doing so, the scale value V/div
decreases. Press the knob to toggle between fine and rough adjustment.

To set the vertical scale for a channel waveform numerically, press the "Y-Scale" soft-
key in the channel menu and then use the NAVIGATION knob.

Remote command: 
CHANnel<m>:SCALe on page 423
CALCulate:MATH<m>:SCALe on page 497
BUS<b>:DSIZe on page 549

2.3.3.2 Channel Menu

The softkeys of the "Channel <n>" menu are placed on two menu pages. Each channel
has its own menu.

The channel label shows the basic vertical settings: vertical scale (in the figure below,
channel 1: 5 mV/div), coupling (DC), termination (50 Ω, and bandwidth (limited). The
label of the active channel is highlighted with the channel color (channel 1).
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Coupling........................................................................................................................ 37
Termination................................................................................................................... 37
Bandwidth..................................................................................................................... 37
Offset.............................................................................................................................38
Invert............................................................................................................................. 38
Y-Scale..........................................................................................................................38
Probe.............................................................................................................................38
Deskew......................................................................................................................... 38
Threshold...................................................................................................................... 38
Label............................................................................................................................. 39
Zero Offset.................................................................................................................... 39

Coupling
Selects the connection of the input signal. The current coupling of each channel is
shown in the waveform labels above the grid.

"AC" A 2 Hz high-pass filter is placed into the signal path that removes the
DC offset voltage from the input signal. AC coupling is labeled with ≈.

"DC" DC coupling passes the input signal unchanged. It is labeled with ≅.

"GND" Connects the input virtually to the ground. All channel data is set to a
constant ground value. Ground connection is labeled with .

Remote command: 
CHANnel<m>:COUPling on page 422

Termination
Adjusts the input impedance of the instrument to the impedance of the DUT. By
default, the oscilloscope has an input impedance of 1 MΩ . If an active probe is used,
the termination is read out from the probe - usually it is 50 Ω.

"50Ω" In measurement systems that are dimensioned for a characteristic
impedance of 50 Ω, reflections along the signal path are minimized by
setting the input resistor of the oscilloscope also to 50 Ω. This increa-
ses the accuracy of measurement results. 50 Ω termination is identi-
fied for each channel by the icon Ω in the waveform label.

"1 MΩ" The high input resistor minimizes the loading effect on the device
under test. This value is set automatically if a passive probe is con-
nected and cannot be changed.

Remote command: 
CHANnel<m>:COUPling on page 422

Bandwidth
Selects the bandwidth limit. The specified full bandwidth indicates the range of fre-
quencies that the instrument can acquire and display accurately with less than 3dB
attenuation. The probe has also a limited bandwidth and thus affects the resulting sys-
tem bandwidth.

See also: Chapter 2.1.1.3, "Bandwidth", on page 18
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"Full" At full bandwidth, all frequencies in the specified range are acquired
and displayed. Full bandwidth is used for most applications.

Note: Instruments with 1 GHz bandwidth: If termination is 50 Ω, the
full bandwidth of 1 GHz is available. If termination is 1 MΩ, the full
bandwith is limited to 500 MHz.

"400 MHz, 200
MHz, 20 MHz"

Frequency limit. Frequencies above the selected limit are removed to
reduce noise at different levels. These bandwidth limits are indicated
by the icon  in the waveform label.
Available values depend on the instrument's bandwidth.

Remote command: 
CHANnel<m>:BANDwidth on page 424

Offset
See "OFFSET" on page 35.

Invert
Turns the inversion of the signal amplitude on or off. To invert means to reflect the volt-
age values of all signal components against the ground level. Inversion affects only the
display of the signal but not the trigger. For example: if the oscilloscope triggers on the
rising edge, the trigger is not changed by inversion, but the actually rising edge is dis-
played as falling edge.

Inversion is indicated by a line above the channel name in the waveform label.

Remote command: 
CHANnel<m>:POLarity on page 425

Y-Scale
See "SCALE, Y-Scale" on page 36

Probe
Opens the Probe menu. The menu is different for active and passive probes.
● Chapter 2.3.3.3, "Probe Menu (Passive Probe)", on page 39
● Chapter 2.3.3.4, "Probe Menu (Active Probe)", on page 40

Deskew
Deskew compensates delay differences between channels caused by the different
length of cables, probes, and other sources. Correct deskew values are important for
accurate triggering.

Signals which are routed over lines with different lengths have a different propagation
delay. If high speed signals are measured, this delay may lead to a non-synchronous
waveform display. For example, a coax cable with a length of one meter has a propa-
gation delay of typically 5.3 ns.

Remote command: 
CHANnel<m>:SKEW on page 426

Threshold
Access: CH N > "More" (page 2) > "Threshold"
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Threshold value for digitization of analog signals. If the signal value is higher than the
threshold, the signal state is high (1 or true for the boolean logic). Otherwise, the signal
state is considered low (0 or false) if the signal value is below the threshold.

You can:
● Select one of the default values for TTL (1,4 V), ECL (-1,3 V), or CMOS (2,5 V).
● Set the "User" value individually
● Let the instrument analyze the signal and find an appropriate level
The threshold is applied to the selected channel.

To avoid the change of signal states due to noise, set the hysteresis. If the signal jitters
inside this range and crosses the threshold thereby, no state transition occurs.

Threshold

Logic 0                        Logic 1  Logic 0

Hysteresis

Remote command: 
CHANnel<m>:THReshold on page 426
CHANnel<m>:THReshold:HYSTeresis on page 426

Label
Opens the "Label" menu to define an additional name label for the selected waveform.

See: Chapter 2.3.3.5, "Label Menu", on page 43

Zero Offset
Differences in DUT and oscilloscope ground levels may cause larger zero errors affect-
ing the waveform. If the DUT is ground-referenced, the "Zero Offset" corrects the zero
error and sets the probe to the zero level.

You can assess the zero error by measuring the mean value of a signal that should
return zero.

Remote command: 
CHANnel<m>:ZOFFset[:VALue] on page 427

2.3.3.3 Probe Menu (Passive Probe)

In the probe menu for passive probes, the probe attenuation for the selected channel is
set. If the probe is known to the instrument, the attenuation factor is set automatically.
For unknown probes, you can select a default factor or enter a user-defined value.
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Access: CH N > "More > Probe"

x1, x10, x100, x1000: attenuation factor
The keys select a default attenuation factor of the connected probe. The vertical scal-
ing and measured values are multiplied by this factor so that the displayed values are
equal to the undivided measured signal values.

To set an arbitrary attenuation factor, press the "User" softkey.

User: user-defined attenuation factor
You can enter an arbitrary attenuation factor in the range between x0.001 and x1000.
The vertical scaling and measured values are multiplied by this factor so that the dis-
played values are equal to the undivided measured signal values.

Remote command: 
PROBe<m>:SETup:ATTenuation:MANual on page 432

Unit
Selects the unit that the probe can measure.
● V - for voltage measurements
● A - for current measurements

Remote command: 
PROBe<m>:SETup:ATTenuation:UNIT on page 432

2.3.3.4 Probe Menu (Active Probe)

Active probes with R&S probe interface (probe head) are detected by the R&S RTM.
The instrument reads out the probe-specific parameters, for example, bandwidth, ter-
mination and attenuation. These parameters do not need any adjustment.

Other parameters, like the offset value for the selected channel, the micro button action
and other probe-specific settings are defined in the probe menu for active probes.

Access: CH N > "More > Probe"

The menu displays the settings for the recognized probe.

Figure 2-3: Probe menu for single-ended probe R&S RT-ZS30
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Figure 2-4: Probe menu for differential probe R&S RT-ZD10

Figure 2-5: Probe menu for current probe R&S RT-ZC20B

Offset
See "OFFSET" on page 35.

ProbeMeter
Activates the integrated R&S ProbeMeter of active R&S probes and selects the probe
type. This voltmeter measures DC voltages between the probe tip and ground connec-
tion with very high precision and enables ground-referenced measurements of vol-
tages. The DC measurement is performed continuously and in parallel to the measure-
ments of the oscilloscope. If activated, the DC offset measured on the probe tip is
shown in a colored label below the channel label.

"Inactive" ProbeMeter is disabled.

"Single Ended" ProbeMeter of a single-ended active probe is enabled.

Remote command: 
PROBe<m>:SETup:OFFSwitch on page 434
PROBe<m>:SETup:DCOFfset? on page 433

Micro Button
Active R&S probes have a configurable micro button on the probe head. Pressing this
button, you can perform an action on the instrument directly from the probe. During
internal automatic processes the button is disabled, for example, during self alignment,
autoset, and find level.

Select the action that you want to start from the probe.

"Continuous" Pressing the Micro Button starts continuous acquisition like the RUN
key. The acquisition is running as long as you press the Micro Button
again.

"Single" Starts one acquisition.

"Autoset" Starts the autoset procedure.

"None" Select this option to prevent unwanted actions due to unintended
usage of the Micro Button.

Remote command: 
PROBe<m>:SETup:MODE  on page 434
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Info
Shows general information on the connected probe, for example, type, serial number,
and production date, as well as electrical characteristics like bandwidth, attenuation,
input capacitance and impedance, voltage and DC offset range.

Com. Mode Offset
Sets the common-mode offset to compensate for a common DC voltage applied to
both input sockets (referenced to the ground socket). This is particularly helpful for
measurements on differential signals with high common mode levels, for example, cur-
rent measurements using a shunt resistor. You can measure the common mode input
voltage using the R&S ProbeMeter.

The setting is only available for Rohde & Schwarz differential probes.

Remote command: 
PROBe<m>:SETup:CMOFfset on page 435

Attenuator
If you use the external attenuator R&S RT-ZA15 together with one of the differential
active probes R&S RT-ZD10/20/30, enable "Attenuator" to include the external attenu-
ation in the measurements.

Zero Adjust
Sets the waveform to zero position. After demagnetizing, always carry out a zero
adjustment.

The setting is only available for current probes R&S RT-ZCxxB.

Save Zero Adjust
Saves the "Zero Adjust" value in the probe box. If you connect the probe to another
channel or to another R&S RTx oscilloscope, the value is read out again.

The setting is only available for current probes R&S RT-ZCxxB.
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Degauss
Demagnetizes the core if it has been magnetized by switching the power on and off, or
by an excessive input. Always carry out demagnetizing before measurement. The
demagnetizing process takes about one second. During demagnetizing, a demagnetiz-
ing waveform is present at the output.

The setting is only available for current probes R&S RT-ZCxxB.

2.3.3.5 Label Menu

Access: CH N > "More > Label"

In the "Label" menu, you can define an additional name label for the selected wave-
form.

Label
Shows or hides the channel name. The name label is shown at the vertical center of
the channel on the right edge of the display.

Remote command: 
CHANnel<m>:LABel:STATe on page 427

Library
Selects a predefined label text and assigns it. The text can be edited with "Edit Label".

Edit Label
Opens on-screen keyboard to enter a label text. If you previously have selected a text
from the library, it is already written in the entry line, and you can modify it.

The maximum name length is 8 characters, and only ASCII characters provided on the
on-screen keyboard can be used.

Remote command: 
CHANnel<m>:LABel on page 426

2.4 History and Segmented Memory (Option R&S RTM-
K15)

The option R&S RTM-K15, History and Segmented Memory, provides access to prior
waveforms and allows you to look at a signal sequence to find the cause of an error in
the signal. Using this option, you can analyze signals that occur in short bursts with
long idle times, packet communication on serial buses, radar pulses, and laser pulses.
The option uses the segmented memory to store the waveforms and provides a history
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viewer to analyze the stored waveforms. It provides also the ultra segmentation mode
to reduce the blind time of the acquisition.

2.4.1 Segmented Memory

If an acquisition runs, the instrument stores the captured data in the memory, pro-
cesses the data and displays the waveform. The segmented memory can keep not
only the data of the displayed waveform but also data of the waveforms that have been
captured before. Each stored waveform is called a segment. The record length of the
segments can be defined. The number of segments depends on the record length. The
shorter the record length, the more segments can be saved.

t3 t4 t5 t6 t7 t8 t9 t10 t11 t12
t1 t2

Segmented 
memory at 
time = t5

-3 -2 -1 0

t1 t2 t3 t4

4 waveforms acquired      4 segments

Total memory     10 segments

Discarded 
earlier 

waveforms

t13

t5
12 waveforms acquired      10 segments

Segmented 
memory at 
time = t13

-3 -2 -1 0-6 -5 -4-9 -8 -7

Figure 2-6: Segmented memory. In this example, the memory can store 10 waveforms (segments).

Each segment has a time stamp time to identify when the events took place. Time
stamps are relative, the zero time point is the end of the latest segment.

The history can access the stored segments and display them. When you start a new
acquisition, the memory is cleared and written anew.

History

The history is always active. When you press the HISTORY key, the acquisition stops
and the history viewer opens to display the waveform segments that are stored in the
memory. It can show all segments in sequence, a selected range, or a single segment.

The history viewer shows the segments of the currently active channels. You can cap-
ture several channels at once, and display them individually using the history viewer.

You can work with history waveforms in the same way as with the waveform of the lat-
est acquisition. All R&S RTM measurement and analysis tools are availbale: zoom,
cursor measurements, quick and automatic measurements, create math waveforms,
perform mask testing, serial protocol decode, mixed-signal functions and so on.

History data can be saved to file using FILE > "Waveforms". You can select to save all
segments, or a range of subsequent segments.

 

History and Segmented Memory (Option R&S RTM-K15)



Acquisition and Waveform SetupR&S®RTM2000

45User Manual 1317.4726.02 ─ 10

Ultra Segmentation

During usual acquisitions, only a short time of the acquisition cycle is used for sam-
pling; processing and display take most of the time. The processing and display time is
blind time causing a gap in the recorded signal. Usual acquisitions may miss very
short-time and infrequent events occurring during the dead time.

To reduce the dead time and thus the probability of missed events, ultra segmentation
is provided.

With Ultra Segmentation, a number of triggered acquisitions is captured very fast, with
hardly any dead time between the acquisitions. After the acquisition of all segments
has been completed, the data is processed and the latest waveform is displayed.
Using the history viewer, you can view and analyze all stored waveform segments.

2.4.2 Segmentation Settings

Access: ACQUISITION > "Acquisition Control"

Waveform Rate............................................................................................................. 45
Record Length...............................................................................................................45
No. of Segments........................................................................................................... 46
Ultra Segmentation....................................................................................................... 46
Nx Single.......................................................................................................................46
Nx Single Maximum...................................................................................................... 46

Waveform Rate
In addition to the basic settings, option R&S RTM-K15 provides the possibility to set
the record length of the segments using "Set Rec. Length".

The instrument acquires the signals at a sample rate that fills up a user-defined record
length, which is set using "Record Length".

For information on basic waveform rate settings, see "Waveform Rate" on page 33

Remote command: 
ACQuire:WRATe on page 418

Record Length
The value can be defined if "Waveform Rate" is set to "Set Rec. Length". It sets the
number of recorded waveform points in a segment.

Remote command: 
ACQuire:POINts[:VALue] on page 418
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No. of Segments
Shows the number of available segments in the memory. It is the maximum number of
segments that can be captured with the current configuration.

Remote command: 
ACQuire:COUNt? on page 437

Ultra Segmentation
Enables the ultra segmentation mode. The acquisitions are performed very fast without
processing and displaying the waveforms. When acquisition has been stopped, the
data is processes and the latest waveform is displayed, the older segments are stored
in segments. You can display and analyze the segments using the HISTORY.

Remote command: 
ACQuire:SEGMented:STATe on page 438

Nx Single
See "Nx Single" on page 34.

Nx Single Maximum
Sets "Nx Single" to the number of available segments. Thus, all segments of the mem-
ory are captured with a RUN Nx SINGLE acquisition.

Remote command: 
ACQuire:NSINgle:MAXimum on page 438

2.4.3 History Viewer

Access: HISTORY key

The HISTORY key stops the running acquisition and opens the history viewer.

You can display the stored segments in various ways:
● One particular segment: set "Current Acquisition"
● All segments: set "Play All" and start "Play"
● A range of subsequent segments: set "Start Acquisition" and "Stop Acquisition",

and start "Play".

Current Acquisition........................................................................................................47
Acquisition Table...........................................................................................................47

└ Save................................................................................................................48
Play | Stop.....................................................................................................................49
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Play All.......................................................................................................................... 49
Range............................................................................................................................49

└ Start Acquisition / Stop Acquisition................................................................. 49
Speed............................................................................................................................50
Repeat...........................................................................................................................50

Current Acquisition
Accesses a particular history segment in the memory to display it, or to save it. The
newest acquisition segment has always the index "0". Older segments have a negative
index. If the history is playing, the field shows the number of the currently shown seg-
ment.

Remote command: 
CHANnel<m>:HISTory:CURRent on page 439
CALCulate:MATH<m>:HISTory:CURRent on page 439
DIGital<m>:HISTory:CURRent on page 439
SPECtrum:HISTory:CURRent on page 439
BUS<b>:HISTory:CURRent on page 439

Acquisition Table
The acquisition table shows the index numbers of the acquired segments together with
their time stamps. The time stamps include the relative time - the time difference to the
end of the latest segment - and the time difference to the previous segment.

The currently shown segment is highlighted, and its absolute time is shown in the table
footer. Using the NAVIGATION knob, you can scroll through the history segments.

To save the acquisition table, press "Save".

Remote command: 
Channel waveforms:
BUS<b>:HISTory:TSABsolute:ALL? on page 444
BUS<b>:HISTory:TSRelative:ALL? on page 443
BUS<b>:HISTory:TSDate:ALL? on page 445
CHANnel<m>:HISTory:TSABsolute? on page 444
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CHANnel<m>:HISTory:TSRelative? on page 443
CHANnel<m>:HISTory:TSDate? on page 445
Math waveforms:
CALCulate:MATH<m>:HISTory:TSABsolute:ALL? on page 444
CALCulate:MATH<m>:HISTory:TSRelative:ALL? on page 443
CALCulate:MATH<m>:HISTory:TSDate:ALL? on page 445
CALCulate:MATH<m>:HISTory:TSABsolute? on page 444
CALCulate:MATH<m>:HISTory:TSRelative? on page 443
CALCulate:MATH<m>:HISTory:TSDate? on page 444
Digital channels:
DIGital<m>:HISTory:TSABsolute:ALL? on page 444
DIGital<m>:HISTory:TSRelative:ALL? on page 443
DIGital<m>:HISTory:TSDate:ALL? on page 445
DIGital<m>:HISTory:TSABsolute? on page 444
DIGital<m>:HISTory:TSRelative? on page 443
DIGital<m>:HISTory:TSDate? on page 444
Buses:
BUS<b>:HISTory:TSABsolute:ALL? on page 444
BUS<b>:HISTory:TSRelative:ALL? on page 443
BUS<b>:HISTory:TSDate:ALL? on page 445
BUS<b>:HISTory:TSABsolute? on page 444
BUS<b>:HISTory:TSRelative? on page 443
BUS<b>:HISTory:TSDate? on page 444
Spectrum Analysis:
SPECtrum:HISTory:TSABsolute:ALL? on page 444
SPECtrum:HISTory:TSRelative:ALL? on page 443
SPECtrum:HISTory:TSDate:ALL? on page 445
SPECtrum:HISTory:TSABsolute? on page 444
SPECtrum:HISTory:TSDate? on page 445
SPECtrum:HISTory:TSRelative? on page 443

Save ← Acquisition Table
Saves the acquisition table to a CSV file. The file contains all timestamps: relative time,
time to previous, and absolute time.

To save the waveform segments, use FILE > "Waveforms", see Chapter 2.4.4, "Export
of History Segments", on page 50.
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Remote command: 
EXPort:ATABle:NAME on page 445
EXPort:ATABle:SAVE on page 446
SPECtrum:HISTory:EXPort:NAME on page 446
SPECtrum:HISTory:EXPort:SAVE on page 446

Play | Stop
Starts and stops the replay of the history segments.

Remote command: 
CHANnel<m>:HISTory:PLAYer:STATe on page 442
CALCulate:MATH<m>:HISTory:PLAYer:STATe on page 442
DIGital<m>:HISTory:PLAYer:STATe on page 442
SPECtrum:HISTory:PLAYer:STATe on page 442
BUS<b>:HISTory:PLAYer:STATe on page 442

Play All
Enables the replay of all acquired segments.

Alternatively, you can replay a range of the acquired segments using "Start Acquisi-
tion / Stop Acquisition".

Remote command: 
CHANnel<m>:HISTory:PALL on page 440
CALCulate:MATH<m>:HISTory:PALL on page 439
DIGital<m>:HISTory:PALL on page 439
SPECtrum:HISTory:PALL on page 440
BUS<b>:HISTory:PALL on page 439

Range
In the "Range" menu, you can define a range of acquired segments to be displayed in
the history viewer.

Start Acquisition / Stop Acquisition ← Range
If you want to show a range of the acquired segments, set the index of the first and the
last history segment that you want to see. The newest segment has always the index
"0". Older segments have a negative index. The number of available acquisitions is
shown under "Play all".

Alternatively, you can replay all acquired segments using "Play All".

Remote command: 
CHANnel<m>:HISTory:STARt on page 440
CHANnel<m>:HISTory:STOP on page 440
CALCulate:MATH<m>:HISTory:STARt on page 440
CALCulate:MATH<m>:HISTory:STOP on page 440
DIGital<m>:HISTory:STARt on page 440
DIGital<m>:HISTory:STOP on page 440
SPECtrum:HISTory:STARt on page 440
SPECtrum:HISTory:STOP on page 440
BUS<b>:HISTory:STARt on page 440
BUS<b>:HISTory:STOP on page 440
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Speed
Sets the speed of the history replay: slow, medium, fast, or automatic.

Remote command: 
CHANnel<m>:HISTory:PLAYer:SPEed on page 441
CALCulate:MATH<m>:HISTory:PLAYer:SPEed on page 441
DIGital<m>:HISTory:PLAYer:SPEed on page 441
SPECtrum:HISTory:PLAYer:SPEed on page 441
BUS<b>:HISTory:PLAYer:SPEed on page 441

Repeat
If selected, the replay of the selected history segments repeats automatically.

Remote command: 
CHANnel<m>:HISTory:REPLay on page 441
CALCulate:MATH<m>:HISTory:REPLay on page 441
DIGital<m>:HISTory:REPLay on page 441
SPECtrum:HISTory:REPLay on page 441
BUS<b>:HISTory:REPLay on page 441

2.4.4 Export of History Segments

History segments can be saved to files on a USB flash drive if the acquisition is stop-
ped. You can select to save all segments, or a range of subsequent segments.

2.4.4.1 File Organization

Each segment is saved to a separate file, and all segment files are written to a folder
that contains only the files of saved acquisition. You can specify the name of the folder,
and the format of the segment files.

The data file names consist of the source channel and the segment index.

Figure 2-7: Content of a history waveform folder
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In addition to the data files, an index file is written. The index file delivers information
on the files and the segments. For each segment, the segment index, save date and
time, the timestamp and the filename is listed.

Figure 2-8: Content of a history index file

2.4.4.2 Save Settings

Access: FILE > "Waveforms"

Data
If "Ultra Segmentation" is on, the R&S RTM provides an additional data selection: "His-
tory Data". It allows you to save history segments to a front or rear USB storage
device.

For information on basic "Data" settings, see "Data" on page 379.

Directory Name
Name of the subdirectory that contains the segment files. For each segment, one file is
written.

Save
Opens the "Waveforms" menu, where you can select the range of segments to be
saved, start the saving, and get information on the process.

Start Acquisition / Stop Acquisition ← Save
If you want to save a range of the acquired segments, set the index of the first and of
the last history segment that you want to save. The newest segment always has the
index "0". Older segments have a negative index.

Use All Segments ← Save
Selects all history segments to be saved.
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Cur. Acquisition ← Save
Shows the index of the history segment that is currently saved.

This information is only available during the saving process.

No. of Segments ← Save
Shows the number of history segments that are not yet saved.

This information is only available during the saving process.

Save ← Save
Starts the saving process.

The instrument shows information on the currently saved segment file: the progress
in %, the remaining time, file size and number of samples.

2.4.4.3 Saving History Segments to File

1. Acquire a waveform with history segments ("Acquisition > Acquisition Control >
Ultra Segmentation = On" > RUN).

2. Stop the acquisition.

3. Press the FILE key.

4. Press "Waveforms".

5. Press "Data" and select "History Data".

6. Select the "Storage" location, the "Waveform" to be saved, and the export "For-
mat".

7. Check the "Directory Name" and change it if necessary. It names the folder to
which the segment files are written.

8. Press "Save".

9. Select the segments that you want to save:

● "Use All Segments", or
● Enter the indexes of the start and stop acquisitions.

The newest segment has always the index "0". Older segments have a nega-
tive index.

The instrument shows information on the data to be saved, and a warning if there
is not enough free space on the USB flash drive.

10. Press "Save".
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In the menu, you see the number of the segment that is currently saved, and the
number of remaining segments.
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3 Triggers

3.1 Basics of Triggering

Triggering means to capture the interesting part of the relevant waveforms. Choosing
the right trigger type and configuring all trigger settings correctly allows you to detect
various incidents in analog, digital, and logic signals.

Trigger

A trigger occurs if the complete set of trigger conditions is satisfied simultaneously. It
establishes the time-zero point in the waveform record. The instrument acquires con-
tinuously and keeps the sample points to fill the pretrigger part of the waveform record.
When the trigger occurs, the instrument continues acquisition until the posttrigger part
of the waveform record is filled. Then it stops acquiring and displays the waveform.
When a trigger is recognized, the the instrument will not accept another trigger until the
acquisition is complete.

Trigger conditions

A simple set of trigger conditions includes:
● Source of the trigger signal
● Trigger type and and its setup
● Horizontal position of the trigger: trigger position and reference point
● Trigger mode

The R&S RTM provides various trigger types for troubleshooting and signal analysis,
for example, edge trigger, width trigger, pattern trigger, and specific triggers like video
and bus triggers.

More complex trigger conditions are also available: you can setup a trigger sequence
to join two edge triggers with an optional delay time or event count. Similar setups are
also known as multi-step trigger or A/B trigger.

Furthermore, hysteresis avoids unwanted trigger events caused by noise.

Trigger event

In particular for the A/B trigger sequence, it is important to distinguish between the trig-
ger and the event. An event is the fulfillment of the event conditions, but an event may
not be the trigger. The trigger occurs only if the conditions of all events - the A event
and the B event - in a trigger sequence and all further trigger conditions are all fulfilled.

Trigger information

Information on the most important trigger settings are shown in the information bar.
The label shows:
● Trigger source and level
● Trigger coupling and filters
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● Trigger slope or other conditions specific for the selected trigger type

Figure 3-1: Trigger information: Normal trigger mode, trigger source is channel 1, width trigger to
find negative pulses shorter than a given pulse width, trigger level = 1.71 mV

Figure 3-2: Trigger information: Normal trigger mode, trigger sequence; A-event has source channel
1, edge trigger on rising edge with DC coupling and HF reject, trigger level 1.71 mV; B-
event has source channel 2, edge trigger on rising edge and trigger level 0 V; instru-
ment triggers on the second B-event

3.2 Setting Up the Trigger

This chapter provides step-by-step procedures for the important stages of trigger
setup. The settings mentioned here are described in detail in Chapter 3.3, "Reference
for Triggers", on page 57.

3.2.1 Configuring the Trigger Event

Prerequisites:
● Horizontal and vertical settings are set appropriately to the signals.
● The acquisition is running, the RUN CONT key lights green.

1. Press the SETUP key in the TRIGGER functional block.

The "Trigger" menu opens.

2. Press the "Source" softkey and select the trigger source.

3. Press "Setup" to return to the "Trigger" menu.

4. Press the "Type" softkey repeatedly until the required trigger type is selected.

5. Select "Setup".

6. Configure the settings for the selected trigger type.

For details, see:
● Chapter 3.3.2.3, "Edge", on page 61
● Chapter 3.3.2.4, "Width", on page 63
● Chapter 3.3.2.5, "Video", on page 65
● Chapter 3.3.2.6, "Pattern", on page 67
● Chapter 3.3.2.8, "Rise Time / Fall Time", on page 70
● Chapter 3.3.2.9, "Protocol", on page 71
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7. Set the "Normal" trigger mode: Press the AUTO/NORMAL key on the front panel
until "Norm" is shown in the information bar.

3.2.2 Positioning the Trigger

By positioning the trigger, you define which part of the waveform is displayed: mainly
the pretrigger part, or the posttrigger part, or the part around the trigger point. There-
fore, you set the time reference (also known as reference point) and the trigger position
in relation to the time reference.

1. To set the time reference point:

a) Press the SETUP key on the left of the display.
b) Select "Time Reference".
c) Turn the navigation knob to move the reference point.

2. To set the trigger position, turn the POSITION rotary knob in the HORIZONTAL
functional block.

3.2.3 Setting Up a Trigger Sequence

An A/B trigger sequence consists of two edge triggers connected by a time delay or
event count.

1. Press the SETUP key in the TRIGGER functional block.

2. Press the "Trigger Type" softkey and select "Edge" trigger.

3. Select "Setup", configure the A trigger and select "Back".

4. Press the "B-Trigger" softkey to enable the B-trigger.

The LEVEL knob and SLOPE key on the front panel are automatically assigned to
the B-trigger. You can change the assignment with the "Trigger Level" softkey in
the "Trigger" menu.

5. Press the "B-Setup" softkey.

6. Configure the B-trigger: Select "B-Source" and "Slope", and turn the LEVEL rotary
knob to adjust the B-trigger level.

7. Define the connection between the A and B triggers by doing one of the following:

● Press "Time" and adjust the delay time with the navigation knob.
● Press "Events" and enter the number of B-trigger events that have to be fulfil-

led until the instrument triggers.
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3.3 Reference for Triggers

The trigger settings are located in the TRIGGER functional block on the front panel and
in the "Trigger" menu.

3.3.1 TRIGGER Controls

The keys and the rotary knob in the TRIGGER functional block adjust the trigger and
start or stop acquisition.

RUN CONT
Starts and stops the continuous acquisition. A green light indicates a running acquisi-
tion. A red light shows that acquisition is stopped.

The status is shown also at the right end of the information bar: "Run" or "Complete".

Remote command: 
RUN on page 413
RUNContinous on page 413
STOP on page 414

RUN Nx SINGLE
Starts a defined number of acquisitions. Press the key again to stop running acquisi-
tions.

To set the number of acquisitions, press the ACQUISITION key and enter "Nx Single".

Remote command: 
SINGle on page 414
RUNSingle on page 414

FORCE
If the acquisition is running in normal mode and no valid trigger occurs, forcing the trig-
ger provokes an immediate single acquisition. Thus you can confirm that a signal is
available and use the waveform display to determine how to trigger on it.
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MODE
Toggles the trigger mode between Auto and Normal. The trigger mode determines the
behavior of the instrument if no trigger occurs. The current setting is shown in the infor-
mation bar.

"Auto" The instrument triggers repeatedly after a time interval if the trigger
conditions are not fulfilled. If a real trigger occurs, it takes prece-
dence. This mode helps to see the waveform even before the trigger
is set. The waveform on the screen is not synchronized, and succes-
sive waveforms are not triggered at the same point of the waveform.

"Normal" The instrument acquires a waveform only if a trigger occurs, that is, if
all trigger conditions are fulfilled. If no trigger occurs, no waveform is
acquired and the last acquired waveform is displayed. If no waveform
was captured before, nothing is displayed.

Remote command: 
TRIGger:A:MODE on page 447

LEVEL
The rotary knob changes the trigger treshold voltage. Turn clockwise to move the trig-
ger level up.

If the trigger type has one trigger leven, pressing the knob sets the level to 50% of the
signal amplitude.

If the trigger type requires two trigger levels, for example, the rise time/fall time trigger,
pressing the knob toggles between upper and lower level.

If a B-trigger is enabled, the knob can set the level for both the A- and B-trigger. To
assign the level to the A- or B-trigger, use "Trigger Level" in the "Trigger" menu.

Remote command: 
TRIGger:A:LEVel<n>[:VALue] on page 447
TRIGger:A:FINDlevel on page 448
TRIGger:B:FINDlevel on page 460

SETUP
Opens the "Trigger" menu.

SOURCE
Opens the "Trigger Source" menu for the A-trigger. Press the key repeatedly until the
required source is selected. The key lights up in the color of the selected trigger chan-
nel. The selected source is shown in the information bar.

SLOPE
If you have selected "Edge" trigger as trigger type with an analog trigger source, the
SLOPE key toggles the trigger slope. The current setting is shown by an icon in the
information bar.

If a B-trigger is enabled, the key can set the slope for both the A- and B-trigger. To
assign the slope to the A- or B-trigger, use "Trigger Level" in the "Trigger" menu.
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3.3.2 Trigger Settings

Trigger settings consist of general settings in the "Trigger" menu and the trigger type-
specific setup. For B-trigger setup, a separate menu is provided.

● Common Trigger Settings....................................................................................... 59
● Trigger Source Settings.......................................................................................... 60
● Edge........................................................................................................................61
● Width.......................................................................................................................63
● Video.......................................................................................................................65
● Pattern.....................................................................................................................67
● Runt.........................................................................................................................69
● Rise Time / Fall Time.............................................................................................. 70
● Protocol...................................................................................................................71
● B-Setup................................................................................................................... 71

3.3.2.1 Common Trigger Settings

The "Trigger" menu is general menu for all trigger types and leads to the type-specific
menus.

To set the trigger offset, use the horizontal POSITION rotary knob, see "POSITION"
on page 29.

Trigger Type..................................................................................................................59
Setup.............................................................................................................................60
Source...........................................................................................................................60
Hold Off......................................................................................................................... 60
B-Trigger....................................................................................................................... 60
B-Setup......................................................................................................................... 60
Trigger Level................................................................................................................. 60

Trigger Type
Selects the trigger type.

For details, see:
● Chapter 3.3.2.3, "Edge", on page 61
● Chapter 3.3.2.4, "Width", on page 63
● Chapter 3.3.2.5, "Video", on page 65
● Chapter 3.3.2.6, "Pattern", on page 67
● Chapter 3.3.2.8, "Rise Time / Fall Time", on page 70
● Chapter 3.3.2.9, "Protocol", on page 71

Remote command: 
TRIGger:A:TYPE on page 448
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Setup
Opens the setup menu for the selected trigger type.

Source
Opens the "Trigger Source" menu for the selected trigger type.

See: Chapter 3.3.2.2, "Trigger Source Settings", on page 60

Remote command: 
TRIGger:A:SOURce on page 448

Hold Off
Enables the hold off and defines the hold off time. The next trigger occurs only after the
hold off time has passed.

The trigger hold off defines when the next trigger after the current will be recognized.
Thus, it affects the next trigger to occur after the current one. Hold off helps to obtain
stable triggering when the oscilloscope is triggering on undesired events.

Remote command: 
TRIGger:A:HOLDoff:MODE on page 449
TRIGger:A:HOLDoff:TIME on page 449

B-Trigger
Activates or deactivates the second edge trigger event that follows a first edge trigger
event in a trigger sequence. The instrument triggers if both trigger event conditions (A
and B) are fulfilled.

If the B-trigger is activated, the LEVEL rotary knob and the SLOPE key are automati-
cally assigned to the B-event. You can toggle the assignment of these controls with the
"Trigger Level" setting in the "Trigger" menu.

Remote command: 
TRIGger:B:ENABle on page 459

B-Setup
Opens the menu for B-trigger configuration. The B-trigger is a second edge trigger
event that can be combined with a preceding edge trigger event. The trigger conditions
of this second event are considered when the conditions of the main event (A-trigger)
are met.

For a description of the menu, see Chapter 3.3.2.10, "B-Setup", on page 71.

Trigger Level
Assigns the SLOPE key and the LEVEL rotary knob on the front panel to the A- or B-
event. The function is only relevant if the B-trigger is enabled. The SOURCE key sets
always the A-trigger source.

3.3.2.2 Trigger Source Settings

Access: Trigger SETUP > "Source"

The content of the "Trigger Source" menu depends on the trigger type.
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The figure below shows the trigger source menus for the edge trigger on an 1 GHz
instrument with MSO option R&S RTM-B1 installed.

Remote Command: TRIGger:A:SOURce on page 448

Channel N
Selects one of the analog input channels as trigger source.

Logic Channels
Selects one of the digital channels as trigger source if MSO option R&S RTM-B1 is
installed.

Logic channels are available for edge and width triggers but they are not selectable if
the B-trigger is enabled.

AC Line
Selects the mains supply of the oscilloscope as trigger input for the edge trigger. The
instrument extracts the trigger signal from the power supply.

Extern
Sets the external trigger input on the rear panel as trigger source. Select the signal
type that is connected: AC or DC.

Remote command: 
TRIGger:EXTern:COUPling on page 449

Ext. Termination
Adjusts the input impedance of the external trigger input. The setting is only available
for instruments with 1 GHz bandwidth.

Remote command: 
TRIGger:EXTern:TERMination on page 449

3.3.2.3 Edge

The edge trigger is the simplest and most common trigger type. It is well-known from
analog oscilloscopes; and you can use it for analog and digital signals. The trigger
event occurs when the signal from the trigger source passes the specified threshold
voltage - the trigger level - in the specified direction (slope).

The edge trigger is also selected by the AUTOSET function.

 

Reference for Triggers



TriggersR&S®RTM2000

62User Manual 1317.4726.02 ─ 10

Slope............................................................................................................................. 62
Coupling........................................................................................................................ 62
LF Reject.......................................................................................................................62
HF Reject...................................................................................................................... 62
Low-pass.......................................................................................................................62
Hysteresis..................................................................................................................... 63

└ Hysteresis A|B................................................................................................ 63
└ Value...............................................................................................................63

Slope
Sets the edge for the trigger.

"Rising" Selects the rising edge, that is a positive voltage change.

"Falling" Selects the falling edge, that is a negative voltage change.

"Both" Selects the rising as well as the falling edge.

Remote command: 
TRIGger:A:EDGE:SLOPe on page 450

Coupling
Sets the coupling for the trigger source.

"AC" Alternating Current coupling. A 5 Hz high pass filter is connected into
the trigger path and removes the DC offset voltage from the trigger
signal.

"DC" Direct Current coupling. The trigger signal remains unchanged.

Remote command: 
TRIGger:A:EDGE:COUPling on page 450

LF Reject
Sets the trigger coupling to high frequency. A 15 kHz high-pass filter is connected into
the trigger path and removes lower frequencies from the trigger signal. Use this mode
only with very high frequency signals.

Remote command: 
TRIGger:A:EDGE:COUPling on page 450

HF Reject
Turns an additional 5 kHz low-pass filter in the trigger path on or off. This filter removes
higher frequencies and is available with AC and DC coupling.

Remote command: 
TRIGger:A:EDGE:FILTer:LPASs on page 450

Low-pass
Turns an additional 100 MHz low-pass filter in the trigger path on or off. This filter
removes higher frequencies and is available with AC and DC coupling.
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Remote command: 
TRIGger:A:EDGE:FILTer:NREJect on page 451

Hysteresis
Opens the "Hysteresis" menu (only on instruments with 1 GHz bandwidth).

Hysteresis A|B ← Hysteresis
Sets a hysteresis range around the trigger level. If the signal jitters inside this range
and crosses the trigger level thereby, no trigger event occurs. Thus, hysteresis avoids
unwanted trigger events caused by noise oscillation around the trigger level.

The automatic, small, medium, large hysteresis values depend on the vertical scale.
On instruments with 1 GHz bandwidth, you can also set the hysteresis to user-defined
values.

If the hysteresis is set to "Automatic", you can activate the hysteresis display using
"Display > Auxillary Cursors > Trigger Hyst.". For small, medium, large and user-
defined hysteresis, the line for the hysteresis area is always shown.

Hysteresis is available for the edge trigger. A-trigger and B-trigger can have different
hysteresis if the trigger source is different.

Remote command: 
TRIGger:A:HYSTeresis on page 451
TRIGger:B:HYSTeresis on page 461

Value ← Hysteresis
Sets the hysteresis value if "Mode" is set to "Manual".

The setting is only available on instruments with 1 GHz bandwidth.

Remote command: 
TRIGger:A:LEVel<n>:HYSTeresis on page 451
TRIGger:B:LEVel:HYSTeresis on page 461

3.3.2.4 Width

The width trigger compares the pulse width (duration) with a given time limit. It detects
pulses with an exact pulse width, pulses shorter or longer than a given time, as well as
pulses inside or outside the allowable time range.

The pulse width is measured at the trigger level.

Comparison...................................................................................................................64
Polarity.......................................................................................................................... 64
Time t............................................................................................................................ 64
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Variation........................................................................................................................ 64
Time t1, Time t2............................................................................................................ 64
Find level.......................................................................................................................65

Comparison
Sets how the measured pulse width is compared with the given limit(s).

"ti<t, ti>t" Triggers on pulse width shorter or longer than the reference "Time t".

"ti=t" Triggers on pulse width equal to the reference "Time t" if "Variation"
Δt = 0.
If "Variation" ≠ 0: this setting triggers on pulses within the range t±Δt.

"ti≠t" Triggers on pulses unequal to the reference "Time t", if "Variation" Δt
= 0.
If "Variation" ≠ 0: this setting triggers on pulses outside a range t±Δt.

"Inside, Out-
side"

Triggers on pulses inside or outside a range specified with "Time t1"
and "Time t2".
This method is an alternative setting to the range definition with "Time
t" and "Variation". The values are interdependent. "Variation" and
"Time t" are adjusted If you change t1 and t2, and vice versa.

Remote command: 
TRIGger:A:WIDTh:RANGe on page 452

Polarity
Sets the polarity of the pulse.

"Pos." Positive going pulse, the width is defined from the rising to the falling
slopes.

"Neg." Negative going pulse, the width is defined from the falling to the rising
slopes.

Remote command: 
TRIGger:A:WIDTh:POLarity on page 451

Time t
Sets the reference time, the nominal value for comparisons ti<t, ti>t, ti=t, ti≠t.

Remote command: 
TRIGger:A:WIDTh:WIDTh on page 452

Variation
Sets a range Δt to the reference "Time t", if comparison is set to "ti=t" or "ti≠t". The
instrument triggers on pulses inside or outside the range ti±Δt.

Remote command: 
TRIGger:A:WIDTh:DELTa on page 452

Time t1, Time t2
Set the lower and upper time limits defining the time range if "Inside" or "Outside" is set
for comparison. "Time t" and "Variation" are adjusted accordingly.
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Find level
Sets the trigger level automatically to 0.5 * (MaxPeak – MinPeak).

3.3.2.5 Video

The video or TV trigger is used to analyze analog baseband video signals. You can
trigger on baseband video signals from standard definition and high definition stand-
ards connected to an analog channel input or to the external trigger input.

The trigger level is determined and set automatically by the instrument.

First select the standard and the signal polarity, then decide to trigger on lines or fields
and enter the specific settings.

Most video signals have an output impedance of 75 Ω. The channel inputs of the
R&S RTM have an input impedance of 50 Ω or 1 MΩ. Make sure to provide the ade-
quate matching to ensure amplitude fidelity. A simple 75 Ω feed-through termination
combined with 1 MΩ oscilloscope inputs is suitable for most applications.

Standard........................................................................................................................65
Signal............................................................................................................................ 65
Trigger On..................................................................................................................... 66
Line............................................................................................................................... 66
All Lines.........................................................................................................................66
Frame............................................................................................................................66

Standard
Selects the color television standard.

You can trigger on various SDTV signals like PAL, PAL-M, SECAM, NTSC and
SDTV 576i (PAL and SECAM).

HDTV standards are indicated by the number of active lines and the scanning system
(p for progressive scanning, I for interlaced scanning.

Remote command: 
TRIGger:A:TV:STANdard on page 453

Signal
Selects the polarity of the signal. Note that the sync pulse has the opposite polarity. If
the video modulation is positive, the sync pulses are negative. If the modulation is neg-
ative, sync pulses are positive. The edges of the sync pulses are used for triggering,
therefore incorrect polarity setting causes a sporadic triggering by the video informa-
tion.
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T T

Figure 3-3: Positive video signal with negative bi-level sync pulse (SDTV, left) and negative signal
with positive tri-level sync pulse (HDTV, right)

Remote command: 
TRIGger:A:TV:POLarity on page 453

Trigger On
Toggles between triggering on line starts or frame starts.

"Line" allows you to trigger on "All Lines" or on one specified "Line".

"Frame" has different effect depending on the selected signal standard:
● For standards using progressive scanning (HDTV 720p/1080p), the instrument trig-

gers on the frame start.
● All other available standards use interlaced scanning, and the instrument triggers

on the field start. You can select the field type to be triggered on using "Frame".

Remote command: 
TRIGger:A:TV:FIELd on page 453

Line
Sets an exact line number if "Trigger on" is "Line". If the other trigger conditions are
also met, the oscilloscope triggers exactly on the beginning of the selected line in any
field.

Remote command: 
TRIGger:A:TV:LINE on page 454

All Lines
The oscilloscope triggers on the beginning of all video signal lines if "Trigger on" is
"Line".

Remote command: 
TRIGger:A:TV:FIELd on page 453

Frame
The oscilloscope triggers on the beginning of the video signal fields if the other trigger
conditions are fulfilled. The setting is available for video signals using interlaced scan-
ning.

"All" Triggers on all fields

"Odd" Triggers only on odd fields.

"Even" Triggers only on even fields.

Remote command: 
TRIGger:A:TV:FIELd on page 453
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3.3.2.6 Pattern

The Pattern trigger is a logic trigger. It provides any logical combination of the input
channels and supports you in verifying the operation of digital logic. Thus you can also
trigger on bus patterns of parallel buses.

The channel pattern is configured in the "Source" menu. Additionally, you can set a
time limitation to the pattern in the "Setup" menu.

Pattern

Channel N..................................................................................................................... 67
Combination.................................................................................................................. 67
Trigger On..................................................................................................................... 68

Channel N
Select the state for each channel. The states are:

"H" High: the signal voltage is higher than the trigger level.

"L" Low: the signal voltage is lower than the trigger level.

"X" Don't care: the channel does not affect the trigger.
If MSO option R&S RTM-B1 is installed, the digital channels D0 to
D15 are available in addition to analog channels.
If X is set for all channels, the oscilloscope triggers only in automatic
trigger mode.

Remote command: 
TRIGger:A:PATTern:SOURce on page 455

Combination
Sets the logical combination of the trigger states of the channels.

"And" The required states of all channels must appear in the input signal at
the same time.

"Or" At least one of the channels must have the required state.
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Remote command: 
TRIGger:A:PATTern:FUNCtion on page 455

Trigger On
Sets the trigger point depending on the result of the logical combination of the channel
states.

Remote command: 
TRIGger:A:PATTern:CONDition on page 455

Time Limitation

In addition to the pattern and the trigger levels, you can define a timing condition - how
long the result of the pattern condition must be true or false.

Duration
Enables or disables the time limitation to the pattern state.

Remote command: 
TRIGger:A:PATTern:MODE on page 456

Comparison
Sets how the duration time of the resulting pattern state is compared with the given
time limit(s).

"ti<t, ti>t" Triggers if the pattern state changes before or after the "Time t" has
expired.

"ti=t" Triggers if the pattern state changes exactly at "Time t" if "Variation"
Δt = 0.
If "Variation" ≠ 0: this setting triggers within the range t±Δt.

"ti≠t" Triggers on pattern state durations unequal to the "Time t", if "Varia-
tion" Δt = 0.
If "Variation" ≠ 0: this setting triggers outside a range t±Δt.

"Inside, Out-
side"

Triggers on pattern state durations inside or outside a range specified
with "Time t1" and "Time t2".
This method is an alternative setting to the range definition with "Time
t" and "Variation". The values are interdependent. "Variation" and
"Time t" are adjusted if you change t1 and t2, and vice versa.

"Timeout" Defines how long the result of the pattern condition must be true. The
instrument triggers at "Time t".

Remote command: 
TRIGger:A:PATTern:WIDTh:RANGe on page 456
TRIGger:A:PATTern:MODE on page 456
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Time t
Sets the reference time, the nominal value for comparisons ti<t, ti>t, ti=t, ti≠t and time-
out

Remote command: 
TRIGger:A:PATTern:WIDTh[:WIDTh] on page 456

Time t1, Time t2
Set the lower and upper time limits defining the time range if "Inside" or "Outside" is set
for comparison. "Time t" and "Variation" are adjusted accordingly.

Variation
Sets a range Δt to the reference "Time t", if comparison is set to "ti=t" or "ti≠t". The
instrument triggers on pulses inside or outside the range ti±Δt.

Remote command: 
TRIGger:A:PATTern:WIDTh:DELTa on page 457

3.3.2.7 Runt

A runt is a pulse lower than normal in amplitude. The amplitude crosses the first
threshold twice in succession without crossing the second one. For example, this trig-
ger can detect logic, digital, and analog signals remaining below a specified threshold
amplitude because I/O ports are in undefined state.

Polarity
Sets the polarity of a pulse, that is the direction of the first pulse slope.

"Positive" Positive going pulse, the width is defined from the rising to the falling
slopes.

"Negative" Negative going pulse, the width is defined from the falling to the rising
slopes.

Remote command: 
TRIGger:A:RUNT:POLarity on page 457

Upper Level
Sets the upper trigger level.

To set the value using the Level 50% rotary knob, press the knob to toggle upper and
lower level and then turn the knob.

Remote command: 
TRIGger:A:LEVel<n>:RUNT:UPPer on page 457

Lower Level
Sets the lower trigger level.

The value corresponds to the threshold value of the trigger channel.
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Remote command: 
TRIGger:A:LEVel<n>:RUNT:LOWer on page 457

3.3.2.8 Rise Time / Fall Time

The rise time trigger, also known as slew rate or transition trigger, can detect fast or
slow rising or falling edges selectively. It triggers on edges, if the rise or fall time from
the lower to higher voltage level (or vice versa) is shorter or longer as defined, or inside
or outside a specified time range. The trigger finds slew rates that are faster than
expected or permissible to avoid overshooting and other interfering effects. It also
detects very slow edges violating the timing in pulse series.

Polarity
Sets the edge, the transition time of which is to be analyzed:

"Rising" Rise time trigger

"Falling" Fall time trigger

Remote command: 
TRIGger:A:RISetime:SLOPe on page 458

Upper Level
Sets the upper voltage threshold. When the signal crosses this level, the slew rate
measurement starts or stops depending on the selected polarity.

To set the value using the Level 50% rotary knob, press the knob to toggle upper and
lower level and then turn the knob.

Remote command: 
TRIGger:A:LEVel<n>:RISetime:UPPer on page 458

Lower Level
Sets the lower voltage threshold. When the signal crosses this level, the slew rate
measurement starts or stops depending on the selected slope.

The value corresponds to the threshold value of the trigger channel.

Remote command: 
TRIGger:A:LEVel<n>:RISetime:LOWer on page 458

Comparison
Selects how the time limit for the slew rate is defined. The time measurement starts
when the signal crosses the first trigger level - the upper or lower level depending on
the selected slope - and stops when the signal crosses the second level.

"Greater than" Triggers on transition times longer than the given "Rise Time".

"Lower than" Triggers on transition times shorter than the given "Rise Time".
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"Equal" Triggers on transition times inside the time range Rise Time ± Varia-
tion.

"Not equal" Triggers on transition times outside the time range Rise Time ± Varia-
tion.

Remote command: 
TRIGger:A:RISetime:RANGe on page 458

Rise Time
For the comparisons "Greater than" and "Lower than", the setting defines the minimum
and maximum transition time limits, respectively.

For the comparisons "Equal" and "Not equal", the setting defines the center of a range,
which is defined by "Variation"

Remote command: 
TRIGger:A:RISetime:TIME on page 459

Variation
Defines a time range around the given "Rise Time" value.

Remote command: 
TRIGger:A:RISetime:DELTa on page 459

3.3.2.9 Protocol

The "Protocol" trigger menu contains the trigger settings for the serial bus or interface
that is configured with PROTOCOL. Protocol analysis requires additional options.

For protocol setup and trigger settings, see Chapter 11, "Protocol Analysis",
on page 192.

To trigger on parallel buses, use the pattern trigger. See: Chapter 3.3.2.6, "Pattern",
on page 67.

3.3.2.10 B-Setup

The B-trigger is a second edge trigger event that can be combined with a preceding
edge trigger event. The conditions of this second event are considered when the condi-
tions of the main event (A-trigger) are met.

B-Source....................................................................................................................... 72
Slope............................................................................................................................. 72
Level..............................................................................................................................72
Trigger On..................................................................................................................... 72
Time.............................................................................................................................. 72
Events........................................................................................................................... 72
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Hysteresis..................................................................................................................... 72
└ Hysteresis A|B................................................................................................ 73
└ Value...............................................................................................................73

B-Source
Selects one of the input channels as B-trigger source. Press the softkey repeatedly
until the required source is selected.

Remote command: 
TRIGger:B:SOURce on page 459

Slope
Sets the edge for the B-trigger event.

"Positive" Selects the rising edge, that is a positive voltage change.

"Negative" Selects the falling edge, that is a negative voltage change.

"Both" Selects the rising as well as the falling edge.

Remote command: 
TRIGger:B:EDGE:SLOPe on page 460

Level
Sets the trigger level for the B-trigger event.

Remote command: 
TRIGger:B:LEVel on page 460

Trigger On
Sets an additional delay condition for the B-event: time delay or event delay. According
to this selection, set also "Time" or "Events" to define the condition completely.

Remote command: 
TRIGger:B:MODE on page 460

Time
Sets the time the instrument waits after an A-event until it recognizes B-events.

Remote command: 
TRIGger:B:DELay on page 460

Events
Sets a number of B-trigger events that fulfill all B-trigger conditions but do not cause
the trigger. The oscilloscope triggers on the n-th event (the last of the specified number
of events).

Remote command: 
TRIGger:B:EVENt:COUNt on page 461

Hysteresis
Opens the "Hysteresis" menu (only on instruments with 1 GHz bandwidth).
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Hysteresis A|B ← Hysteresis
Sets a hysteresis range around the trigger level. If the signal jitters inside this range
and crosses the trigger level thereby, no trigger event occurs. Thus, hysteresis avoids
unwanted trigger events caused by noise oscillation around the trigger level.

The automatic, small, medium, large hysteresis values depend on the vertical scale.
On instruments with 1 GHz bandwidth, you can also set the hysteresis to user-defined
values.

If the hysteresis is set to "Automatic", you can activate the hysteresis display using
"Display > Auxillary Cursors > Trigger Hyst.". For small, medium, large and user-
defined hysteresis, the line for the hysteresis area is always shown.

Hysteresis is available for the edge trigger. A-trigger and B-trigger can have different
hysteresis if the trigger source is different.

Remote command: 
TRIGger:A:HYSTeresis on page 451
TRIGger:B:HYSTeresis on page 461

Value ← Hysteresis
Sets the hysteresis value if "Mode" is set to "Manual".

The setting is only available on instruments with 1 GHz bandwidth.

Remote command: 
TRIGger:A:LEVel<n>:HYSTeresis on page 451
TRIGger:B:LEVel:HYSTeresis on page 461

Reference for Triggers



DisplayR&S®RTM2000

74User Manual 1317.4726.02 ─ 10

4 Display
This chapter provides information on display configuration and display modes.

The default display is a waveform diagram with a time axis in x-direction and the signal
amplitudes displayed in y-direction - the Y(t) or time diagram. You can adjust the visi-
bility of diagram elements and waveform to your needs. See Chapter 4.1, "General
Display Settings", on page 74 for details.

You can also display and configure XY-diagrams to combine the voltage levels of two
waveforms in one diagram. This display mode is described in Chapter 4.2, "XY-Dia-
gram", on page 81.

Furthermore, you can zoom into waveforms to analyze the results in more detail. The
zoom display mode is described in Chapter 4.3, "Zoom", on page 86.

In a Y(t)-diagram and in zoom mode, you can set markers to mark positions of interest
in the waveform. See Chapter 4.4, "Markers", on page 91 for details.

In addition to zoom and XY-diagram modes, the following functional modes are availa-
ble:
● FFT analysis, see Chapter 8.1.2, "Configuring and Using FFT Calculations",

on page 133
● Mask testing, see Chapter 9.2, "Working with Masks", on page 166

4.1 General Display Settings

General display settings adjust the visibility of diagram elements and waveforms.

The individual diagram elements can be shown or hidden:
● Basic diagram elements: grid and crosshairs
● Point of the trigger event
● Channel cursors to mark the ground level and the DC offset

You can also adjust how the waveforms are displayed. The intensity and brightness of
the individual screen elements can influence the readability of the results. Depending
on which type of result you are interested in, e.g. frequency of occurance, time of
occurance, or amplitude of a specific value, different settings may be necessary to
highlight that aspect in the display.

The waveform display depends on the following criteria:
● Waveform style: dots or line
● Intensity: adjusts the optimal contrast of the display

Three settings can be changed to improve the contrast for the relevant display ele-
ments.
– The intensity of the waveform determines the strength of the signal in the dia-

gram.
– The intensity of the background lighting determines the contrast of the signal.
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– The intensity of the grid has an influence on the readability of the signal.
● Persistence defines how long a data point is displayed in the diagram. Each new

data point remains on the screen for the defined persistence time, or infinitely until
the persistence time is changed or the persistence is cleared.

● Signal colors or brightness depend on on the cumulative frequency of the values.
By default, values that occur frequently are displayed brighter than rare values.
Alternatively, the brightness level can be converted to a color range, i.e. the color
changes gradually with increasing cumulative occurance.
It is also possible to invert the brightness display so that rare values are brighter
than frequent values. This setting is useful in combination with persistence to
detect rare values within the waveform.

4.1.1 Configuring the Display

4.1.1.1 Configuring the Diagram Elements

To display the grid or crosshairs

1. Press "DISPLAY > Grid > Lines" to display a grid.

2. Press "DISPLAY > Grid > Reticle" to display crosshairs.

3. Press "DISPLAY > Grid > Off" to remove both the grid and the crosshairs.

To display the trigger event or the channel cursors

The marker of trigger event and the channel cursors are auxiliary cursors. By default,
both auxiliary cursors are displayed. They help to evaluate specific results more easily.

1. Press "DISPLAY > Aux. Cursor > Trigger Event" to display a trigger cursor.

A rhombus marks the point where the trigger event happened.

2. Press "DISPLAY > Aux. Cursor > Channel Cursors" to display a channel cursor.

A dashed line is displayed that marks the ground level of the displayed channel. If
a DC offset is defined, a second auxiliary line is displayed. The distance between
those two lines is the DC offset.

3. Press "DISPLAY > Aux. Cursor > Defaults" to restore the default setting (both cur-
sors displayed).

4.1.1.2 Configuring the Waveform Display

The waveform display depends on the following criteria:
● Intensities adjust the optimal contrast of the display. See "To configure intensity"

on page 76.
● Persistence defines how long a data point is displayed in the diagram. See "To

configure persistence" on page 76.
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● Brightness and signal colors depend on the cumulative frequency of the value.
See: "To configure brightness" on page 76

● Waveform as line or points: see "To set the waveform style" on page 77.

To configure intensity

For optimal contrast, you can change the intensity of the waveform, of the grid, and of
the backlight.

1. Press "DISPLAY > Intensities".

2. To set the intensity of the waveform:

a) Press "Waveform".
b) Enter a percentage between 0 (not visible) and 100% (very strong). The default

value is 50%. You can also use the "INTENSITY" knob on the left side of the
screen to adjust the waveform intensity directly.

3. To set the intensity of the grid:

a) Press "Grid".
b) Enter a percentage between 0 and 100%. The default value is 34%.

4. To set the intensity of the backlight:

a) Press "Backlight".
b) Enter a percentage between 10 and 100%. The default value is 50%.

To configure persistence

1. To display only the current signal at any time, press "DISPLAY > Intensities > Per-
sistence" until "Off" is highlighted.

2. To have the instrument define the optimal persistence automatically, press "DIS-
PLAY > Intensities > Persistence" until "Automatic" is highlighted.

3. To configure the persistence manually:

a) Press "DISPLAY > Intensities > Persistence" until "Manual" is highlighted.
b) Press "DISPLAY > Intensities > Persist. Time" to define the persistence time.
c) Enter a value between 50 ms and 9.6 s or "Infinite".

Each new data point in the diagram area remains on the screen for the defined
duration. If "Infinite" is selected, each new data point in the diagram area remains
on the screen infinitely until this setting is changed or the persistence is cleared.

4. To update the waveform, press "DISPLAY > Intensities > Clear Persist.".

To configure brightness

For better distinction of rare and frequent values, you can apply a color range to the
value frequency. With this color range, rare values are displayed in blue, while more
frequent values are red and very frequent values are displayed in yellow or white, with
various colors inbetween.
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It is also possible to invert the brightness display so that rare values are brighter than
frequent values.

1. To convert the brightness level to a color range, press "DISPLAY > Temperature
Colors".

2. To invert the brightness level of the signals, press "DISPLAY > Inverse Brightn.".

To set the waveform style

By default, the individual data points are connected by a line. Alternatively, only the
individual data points can be displayed.

You can change the strength of the line using the "INTENSITY" knob on the left side of
the screen.

► Press "DISPLAY > Dots Only" to display the data points only.

4.1.2 Display Menu

The DISPLAY key provides functions for configuring the display.

Display Mode................................................................................................................ 78
XYZ Setup.....................................................................................................................78
Intensities...................................................................................................................... 78

└ Waveform........................................................................................................78
└ Backlight......................................................................................................... 78
└ Grid................................................................................................................. 78
└ Persistence..................................................................................................... 79
└ Persist. Time...................................................................................................79
└ Clear Persist................................................................................................... 79

Dots Only...................................................................................................................... 79
Inverse Brightn.............................................................................................................. 79
Temper. Colors............................................................................................................. 79
Aux. Cursors................................................................................................................. 80

└ Trigger Event.................................................................................................. 80
└ Channel Cursors.............................................................................................80
└ Trigger Hyst.................................................................................................... 80
└ Defaults...........................................................................................................81
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Grid............................................................................................................................... 81
VirtualScreen.................................................................................................................81
Transparency................................................................................................................ 81

Display Mode
Toggles the diagram mode.

"Y(t)" Default time diagram with a time axis in x-direction and the signal
amplitudes displayed in y-direction.

"XY-diagram" XY-diagrams combine the voltage levels of two waveforms in one dia-
gram. They use the voltage level of a second waveform as the x-axis,
rather then a time base. This allows you to perform phase shift mea-
surements, for example.You can also define the intensity of the XY-
diagram according to a further signal source Z.
Together with the XY-diagram, the Y(t)-diagrams of the source sig-
nals are displayed in separate windows.
With R&S RTM1054, it is also possible to define two source signals in
y-direction for comparison.

Remote command: 
DISPlay:MODE on page 462

XYZ Setup
See Chapter 4.2.2, "XYZ Setup Menu", on page 84.

Intensities
Provides functions to define the intensity of various display elements.

Waveform ← Intensities
Waveform intensity determines the strength of the waveform lines in the diagram.
Enter a percentage between 0 (barely visible) and 100% (very strong), or press and
turn the "INTENSITY" knob on the left side of the screen to adjust the waveform inten-
sity directly. The default value is 50%.

Remote command: 
DISPlay:INTensity:WAVeform on page 465

Backlight ← Intensities
Defines the intensity of the background lighting of the display in percent. Enter a per-
centage between 10% and 100%. The default value is 50%.

Remote command: 
DISPlay:INTensity:BACKlight on page 465

Grid ← Intensities
Defines the intensity of the grid on the screen in percent. Enter a percentage between
0% and 100%. The default value is 34%.
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Remote command: 
DISPlay:INTensity:GRID on page 466

Persistence ← Intensities
Defines the persistence of the waveform on the screen.

"Off" Deactivates persistence

"Automatic" The optimal persistence time is determined automatically by the
instrument

"Manual" User-defined persistence according to "Persist. Time" setting.

Remote command: 
DISPlay:PERSistence:STATe on page 466
DISPlay:PERSistence:TIME:AUTO on page 467

Persist. Time ← Intensities
User-defined persistence time if "Manual" persistence is selected. Each new data point
remains on the screen for the duration defined here. Possible values are from 50 ms to
9.6 s or "Infinite". If "Infinite" is selected, each new data point remains on the screen
infinitely until this setting is changed or the persistence is cleared.

Remote command: 
DISPlay:PERSistence:TIME on page 466
DISPlay:PERSistence:INFinite on page 467

Clear Persist. ← Intensities
Clears the displayed persistence on the screen.

Remote command: 
DISPlay:PERSistence:CLEar on page 467

Dots Only
If activated, only the individual data points are displayed. If deactivated, the individual
data points are connected by a line. Define the strength of the line using the "INTEN-
SITY" knob on the left side of the screen.

Remote command: 
DISPlay:STYLe on page 467

Inverse Brightn.
Inverts the brightness level of the signals. Normally, values that occur frequently are
brighter than rare values. This setting inverts this behavior: Rare values are brighter
than frequent values. Use this setting in combination with persistence to detect rare
values within the waveform.

Remote command: 
DISPlay:PALette on page 463 (INVerse, IFColor)

Temper. Colors
Temperature Colors: Converts the brightness level of the displayed signals into a color
range, i.e. the color changes gradually in a wide color spectrum with increasing cumu-
lative occurance.
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By default, rare values are displayed in blue, while more frequent values are red and
very frequent values are displayed in yellow or white, with various colors inbetween.
This results in a higher contrast, which provides a better perception of details in the
waveforms.

Note: The colors change if you invert the brightness display.

Remote command: 
DISPlay:PALette on page 463 (NORMal, FColor)

Aux. Cursors
Provides functions to display auxiliary cursors. Highlighted functions are active.

Trigger Event ← Aux. Cursors
Show or hides the point of the trigger. A small rhombus markes the intersection of the
trigger level and the trigger offset T.

The offset is related to the reference point and is displayed in the header of the display.
If you change the trigger level or the trigger position, a line appears temporarily to high-
light the changed value.

If the B-trigger is activated, the trigger is the result of an A-event followed by an B-
event. The trigger point has the color of the B-trigger source.

Channel Cursors ← Aux. Cursors
Activates or deactivates the channel cursor of the active channel. A channel cursor is a
line that marks the ground level of a channel. This line is displayed temporarily if the y-
scaling is modified and fades out automatically.

If a DC offset is defined, a second auxiliary line is displayed. The distance between
those two lines is the DC offset.

Trigger Hyst. ← Aux. Cursors
Shows or hides the hysteresis range around the trigger level when the trigger level or
the hysteresis are changed. Hysteresis avoids unwanted trigger events caused by
noise oscillation around the trigger level.

The setting is only available if "Hysteresis A / B" is set to "Automatic".
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See also: "Hysteresis A|B" on page 63

Defaults ← Aux. Cursors
Restores the default cursor settings, i.e. both auxiliary cursors are displayed.

Grid
Defines how the grid is displayed.

"Lines" Displays the grid as horizontal and vertical lines.

"Reticle" Displays crosshairs instead of a grid.

"Off" Removes the grid from the display.

Remote command: 
DISPlay:GRID:STYLe on page 467

VirtualScreen
Enables or disables the virtual screen.

If enabled, the virtual screen has 20 divisions, 8 of them are displayed. To select the
divisions to be displayed, press and turn the "Intensity / Virtual screen" knob at the left
of the screen.

If disabled, only 8 divisions are available, and all divisions are displayed.

Remote command: 
DISPlay:VSCReen:ENABle on page 468
DISPlay:VSCReen:POSition on page 468

Transparency
Sets the transparency of result boxes that overlay the waveforms, for example, boxes
with statistical results or digital voltmeter results.

Remote command: 
DISPlay:DIALog:TRANsparency on page 463

4.2 XY-Diagram

XY-diagrams combine the voltage levels of two waveforms in one diagram. They use
the amplitude of a second waveform as the x-axis, rather then a time base. This allows
you to perform phase shift measurements, for example. With harmonically related sig-
nals the resulting XY-diagrams are Lissajous patterns. XY-diagrams can also be used
to display the IQ representation of a signal.

It is also possible to define two source signals in y-direction for comparison.

The intensity of the XY-waveform can be set to a defined level, or be modulated
dynamically using a further source signal. In the latter case, the amplitudes of addi-
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tional source signal determine the intensity of the displayed waveform. For details, see
Chapter 4.2.1.2, "Configuring the Intensity of an XY-Waveform", on page 83.

Together with the XY-diagram, the time diagrams of the source signals are displayed in
separate windows.

Figure 4-1: XYZ-display

4.2.1 Configuring XY-Diagrams

XY-diagrams combine the voltage levels of two waveforms in one diagram. A further
signal source can be used to determine the intensity of the XY-waveform.

4.2.1.1 Setting Up the XY-Diagram

To switch the display to XY-diagram and vice versa

► Press "DISPLAY > Display Mode" until the "XY" mode is selected.
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To configure an XY-diagram

Prerequisite: The "Display Mode" is set to "XY".

1. Select "DISPLAY > XYZ Setup > Source X" to define the signal to be used as the
x-axis source. Press "Source X" repeatedly until the required channel is highligh-
ted.

2. Select "DISPLAY > XYZ Setup > Source Y1" to define the signal to be used as the
(first) y-axis source. Press "Source Y1" repeatedly until the required channel is
highlighted.

3. Optionally, select "DISPLAY > XYZ Setup > Source Y2" to define the signal to be
used as a second y-axis source. Press "Source Y2" repeatedly until the required
channel is highlighted.

The XY-diagram is displayed in the main window, and additional windows are
opened to display the X, Y1, Y2, and Z time diagrams, if the source is defined.

4.2.1.2 Configuring the Intensity of an XY-Waveform

You can define the intensity of the XY-diagram as a constant value or according to the
amplitude of a further signal source Z.
● Constant intensity: To configure the intensity of an XY-waveform at a defined level
● The waveform intensity is modulated dynamically according to the signal source Z.

The higher the signal level Z is, the stronger the waveform is displayed: To config-
ure the intensity of an XY-waveform modulated by a signal amplitude.

● The waveform intensity is defined by a threshold value: If the Z signal value is
below the selected threshold, the corresponding x/y point is not displayed. If the Z
signal value is above the threshold, the x/y point is displayed with the defined
intensity level: To configure the intensity of an XY-waveform using a threshold
value

To configure the intensity of an XY-waveform at a defined level

Prerequisite: The "Display Mode" is set to "XY", and the XY-diagram is configured.

1. Press "DISPLAY > XYZ Setup > Z Setup".

2. Press the left "Source Z" softkey until "OFF" is highlighted to deactivate intensity
control by the Z source.

3. Press "DISPLAY > Intensities > Trace" to define the intensity level of the waveform.

4. Enter a percentage between 0 (not visible) and 100% (very strong). The default
value is 50%.

Regardless of which menu is currently displayed, you can use the "INTENSITY" knob
on the left side of the screen to adjust the waveform intensity directly.
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To configure the intensity of an XY-waveform modulated by a signal amplitude

Prerequisite: The "Display Mode" is set to "XY", and the XY-diagram is configured.

1. Press "DISPLAY > XYZ Setup > Z Setup".

2. Press the left "Source Z" softkey until "ON" is highlighted to activate intensity con-
trol by the Z source.

3. Press the second "Source Z" softkey repeatedly until the required channel for
intensity control is selected.

4. Press "Z-Intensity" until "Modulation" is highlighted to select intensity control via
modulation.

To configure the intensity of an XY-waveform using a threshold value

Prerequisite: The "Display Mode" is set to "XY", and the XY-diagram is configured.

1. Press "DISPLAY > XYZ Setup > Z Setup".

2. Press the left "Source Z" softkey until "ON" is highlighted to activate intensity con-
trol by the Z source.

3. Press the second "Source Z" softkey repeatedly until the required channel for
intensity control is selected.

4. Press "Z-Intensity" until "ON | OFF" is highlighted to select intensity control via a
threshold value.

5. Press "Threshold" and enter the required value to define the threshold value.

4.2.2 XYZ Setup Menu

The setup of XY-diagrams is a submenu of the "Display" menu.

Access: DISPLAY > "XYZ Setup"

Source X
Defines the source to be displayed in x direction in an XY-diagram, replacing the usual
time base. The source can be selected from any of the analog channels.

The function is available in R&S RTM1054.

Remote command: 
DISPlay:XY:XSOurce on page 463

Source Y1
Defines the (first) source to be displayed in y direction in an XY-diagram. The source
can be selected from any of the analog channels.
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The function is available in R&S RTM1054.

Remote command: 
DISPlay:XY:Y1Source on page 464

Source Y2
Defines an optional second source to be displayed in y direction in an XY-diagram. The
source can be selected from any of the analog channels.

The function is available in R&S RTM1054.

Remote command: 
DISPlay:XY:Y2Source on page 464

X-CH1 Y-CH2
Defines channel 1 to be displayed in x direction in an XY-diagram, replacing the usual
time base, and sets channel 2 to the y-axis.

The function is available in R&S RTM1052.

X-CH2 Y-CH1
Defines channel 2 to be displayed in x direction in an XY-diagram, replacing the usual
time base, and sets channel 1 to the y-axis.

The function is available in R&S RTM1052.

Z Setup
The intensity of the waveform displayed in an XY-diagram can be set to a defined
level, or be modulated dynamically using a further source signal Z. In the latter case,
the amplitudes of the source signal determine the intensity of the displayed waveform.

Z ← Z Setup
Activates or deactivates the intensity control of the waveform via an additional signal
source. If deactivated, the intensity is defined by the general "Intensity" setting for the
trace.

Remote command: 
DISPlay:XY:ZMODe on page 464

Source Z ← Z Setup
Defines the source to be used to determine the intensity of the waveform. The source
can be selected from any of the analog channels. Pressing the softkey repeatedly
scrolls through the list of available source channels.

Remote command: 
DISPlay:XY:ZSOurce on page 465

Z-Intensity ← Z Setup
Toggles between intensity modes.
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"Modulation" Modulated intensity; Intensity is modulated continuously according to
the selected "Source Z".

"On | Off" Intensity is determined by a "Threshold" value. If the Z signal value is
below the selected threshold, the corresponding x/y point is displayed
with lowest intensity. If the Z signal value is above the threshold, the
x/y point is displayed with the defined intensity level.

Remote command: 
DISPlay:XY:ZMODe on page 464

Threshold ← Z Setup
Defines the threshold for intensity with a two-state modulation, if "Z-Intensity" is set to
"ON | OFF".

Remote command: 
DISPlay:XY:ZTHReshold on page 465

4.3 Zoom

You can zoom into waveforms to analyze the results in more detail. The zoomed area
and its position can be configured numerically or using the rotary knobs.

Using Markers
You can use markers to quickly zoom into a place of interest in the display, see "To
zoom into a marker position" on page 92.

4.3.1 Zoom Display

When you activate zoom display, two windows are displayed: the original waveform
diagram at the top (Y(t)-window), and the zoom window at the bottom. The zoom area
defines the part of the original waveform to be zoomed. It is indicated by white lines in
the original Y(t)-window.
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The usual channel parameters are displayed in the information bar above the original
Y(t)-window (see the general display information described in the "Getting Started"
manual).

In addition, the zoom area parameters are indicated in the information bar above the
zoom window. The following information is given there:

Z Zoom Time Base, i.e. scaling for the time base in the zoom window in seconds per division;
determines the width of the zoom area that is displayed in the zoom window (10 divisions * scal-
ing per division)

TIMebase:ZOOM:SCALe?

Tz Zoom Time, i.e. the offset of the trigger point to the reference point 0s in the zoom window;
determines the position of the zoom area

TIMebase:ZOOM:TIME?

 Sample rate for zoom window

ACQuire:SRATe:ZOOM?

Pressing the horizontal SCALE rotary knob moves the focus between the Y(t)-window
(Time Control), the zoom area (Zoom Control) and the zoom window. The currently
selected screen area is highlighted and displayed in the information bar of the zoom
window. Depending on the selection, the functions of the SCALE and POSITION rotary
knobs may change.

Zoom
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Figure 4-2: Zoom area width and position

When you deactivate the zoom display, the previous display is restored.

4.3.2 Zooming for Details

The zoomed area and its position can be configured numerically or using the rotary
knobs.

To display a zoom diagram

► Press the ZOOM key.

The key lights up and two windows are displayed: the original signal vs. time at the
top, the zoom at the bottom.

To deactivate the zoom display

► Press the ZOOM key again, or press the "Zoom Off" softkey in the "Zoom" menu to
close the zoom window.

The ZOOM key is no longer illuminated and the previous display is restored.

To configure the zoom area numerically

1. Press the "Zoom Time Base" softkey to define the scaling for the time base in the
zoom diagram in seconds per division. The scaling is indicated by "Z" in the infor-
mation bar above the zoom diagram and determines the width of the zoom area
that is displayed in the zoom diagram (10 divisions * scaling per division).

2. Press the "Zoom Time" softkey to define the offset of the trigger point to the refer-
ence point 0s in the zoom diagram. The offset is indicated by "Tz" in the informa-
tion bar above the zoom window and determines the position of the zoom area.

The zoom area is indicated by white lines in the original Y(t)-window. The zoom
window displays the data in the defined zoom area from the main time base in
greater detail.
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To configure the zoom area via the rotary knobs

Pressing the horizontal SCALE rotary knob moves the focus between the Y(t)-window
(Time Control), the zoom area (Zoom Control) and the zoom window. The currently
selected screen area is highlighted and displayed in the information bar of the zoom
window. Depending on the selection, the functions of the SCALE and POSITION rotary
knobs may change.

1. Press the horizontal SCALE rotary knob to select "Zoom Control" or "Zoom Win-
dow". The functions for the rotary knobs are the same for both elements; for very
high zoom factors, however, it may be faster to scroll through with the "Zoom Win-
dow" focus.

2. Turn the horizontal SCALE rotary knob counter-clockwise to enlarge the zoom
area, or clockwise to decrease it.

The zoom diagram and the "Z" parameter (Zoom Time Base) in the information bar
above it are adapted.

3. Turn the horizontal POSITION rotary knob counter-clockwise to move the zoom
area to the left, or clockwise to move it to the right.

The zoom diagram and the "Tz" parameter (Zoom Time) in the information bar
above it are adapted.

The zoom window displays the data in the defined zoom area from the main time
base in greater detail.

To configure the original Y(t)-diagram

1. Press the horizontal SCALE rotary knob to select "Time Control", the original Y(t)-
window.

2. Press "Main Time Base" to define the scaling for the time base in the original Y(t)-
window in seconds per division. Alternatively, turn the horizontal SCALE rotary
knob.

3. Press "Trigger Offset" to define the offset of the trigger point to the reference point
for 0s in the original Y(t)-window. Alternatively, turn the horizontal POSITION rotary
knob.
Note that changing the offset in the original window also changes the offset for the
zoom window (Zoom Time).

4.3.3 Zoom Menu

The ZOOM key provides functions for configuring the zoom display.
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Main Time Base............................................................................................................ 90
Zoom Time Base...........................................................................................................90
Trigger Offset................................................................................................................ 90
Zoom Time.................................................................................................................... 90
Zoom Off....................................................................................................................... 90

Main Time Base
Defines the scaling for the time base in the (original) Y(t)-window in seconds per divi-
sion. The scaling is indicated by "TB" in the information bar above the window.

Note: If "Time Control" is selected, the main time base can be adjusted using the hori-
zontal SCALE rotary knob.

See also "SCALE" on page 29, "To configure the original Y(t)-diagram" on page 89 and
Figure 8-2.

Remote command: 
TIMebase:SCALe on page 414

Zoom Time Base
Defines the scaling for the time base in the zoom window in seconds per division. The
scaling determines the width of the zoom area that is displayed in the zoom window
(10 divisions * scaling per division).

The zoom area is indicated by white lines in the original Y(t)-window.

Remote command: 
TIMebase:ZOOM:SCALe on page 469

Trigger Offset
Defines the horizontal position of the trigger point in relation to the reference point - to
the zero point of the grid. The value is indicated by "T" in the information bar above the
window.

The reference point is set with SETUP >"Time Reference".

Note: If a zoom or FFT window is displayed and "Time Control" is selected, the trigger
offset can be adjusted using the horizontal POSITION rotary knob.
See also:
● "POSITION" on page 29
● "Time Reference" on page 386
● "To configure the original Y(t)-diagram" on page 89

Remote command: 
TIMebase:POSition on page 416

Zoom Time
Defines the offset of the trigger point to the reference point 0s in the zoom window. The
offset determines the position of the zoom area that is displayed in the zoom window.

Remote command: 
TIMebase:ZOOM:TIME on page 469

Zoom Off
Closes the zoom window and returns to the previous display.
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Remote command: 
TIMebase:ZOOM:STATe on page 468

4.4 Markers

Markers allow you to mark certain positions on the screen, e.g. a rising or falling edge,
or an unexpected signal value, or a search result. You can then use the markers to
identify areas of interest you want to zoom into, and quickly move through the data.

Two marker types are available:
● Timestamp markers can be used if no search is enabled. They can be set manually

at any position of the waveform. These markers are indicated by blue vertical lines.
You can set up to 8 timestamp markers. Timestamp markers are descibed in this
chapter.

● If a search is active, you can set search markers to selected search results. These
markers are indicated by magenta search result flags. Search result markers are
described in Chapter 10.1, "Search Conditions and Results", on page 175

4.4.1 Using Timestamp Markers

Timestamp markers are displayed as colored lines on the screen. If more markers are
available but currently not visible on the screen (e.g. in a zoomed display), this is indi-
cated by a small arrow at the right or left edge of the display.

See also: "To use markers on search results" on page 178.
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Figure 4-3: Zoomed display using markers

To set a marker

1. Turn the horizontal "Position" rotary knob and move the position to be marked to
the reference point, usually in the middle of the display.

2. Press the SET CLEAR key to insert a new marker at the reference position.

To select a marker

When you select a marker it is automatically moved to the reference point of the dis-
play.

1. Press the NEXT key to move the next (right) marker to the reference point of the
display or zoom area.

2. Press the PREV key to move the previous (left) marker to the reference point of the
display or zoom area.

To remove a marker

1. Select the marker to be deleted using the NEXT or PREV key.

2. Press the SET CLEAR key to remove the marker at the reference position.

To zoom into a marker position

1. Set a marker in the display as described above.

Markers
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2. If not yet active, activate the zoom function by pressing the ZOOM key.

The marker lines are displayed both in the original window and in the zoom win-
dow.

3. Select the marker that indicates the area you want to zoom into using the NEXT or
PREV key.

The center of the zoom area is moved to the marker (see Figure 4-3).

4. If necessary, fine-tune the position of the zoom area around the marker as descri-
bed in "To configure the zoom area via the rotary knobs" on page 89.

4.4.2 Reference for Markers

The marker keys are used for both marker types, timestamp markers and search result
markers.

For details on setting and moving markers; see
● Chapter 4.4.1, "Using Timestamp Markers", on page 91
● "To use markers on search results" on page 178

NEXT.............................................................................................................................93
PREV............................................................................................................................ 93
SET CLEAR.................................................................................................................. 93

NEXT
Moves the next (right) marker to the reference point of the display or zoom area. If a
search is enabled, the key navigates the search result markers.

Note: If another marker is available at the right, but currently not visible on the screen,
a small red arrow is displayed at the right edge of the display.

Remote command: 
TSTamp:NEXT on page 470 (for timestamp markers only)

PREV
Moves the previous (left) marker to the reference point of the display or zoom area. If a
search is enabled, the key navigates the search result markers.

Note: If another marker is available at the left, but currently not visible on the screen, a
small red arrow is displayed at the left edge of the display.

Remote command: 
TSTamp:PREVious on page 470 (for timestamp markers only)

SET CLEAR
Sets a new marker at the reference point of the display, or deletes an existing marker
at this point. Use the NEXT and PREV keys to move the markers to the reference
point.

In the display of search results, the marker is set to or removed from the search result
that is selected in the "Event Table".
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5 Reference Waveforms
Reference waveforms are waveform data stored in in the internal reference storages.
Four internal reference storages are available: RE1 - RE4. These four reference wave-
forms can be displayed.

Reference waveforms can be saved to and loaded from any storage device - internal
memory or external USB flash device. The file format is .TRF. TRF files contain binary
waveform data and the instrument settings, so you can restore also the settings when
you load a reference waveform. If the TRF file is saved to internal storage, the amount
of waveform data is limited to 256 kB (without settings and header data).

See Chapter 15.3.3.1, "Waveform File Formats", on page 376 for details on file for-
mats.

You can copy the stored references to another storage device using export/import
functions. With export/import, you can also change the target file format and convert
the data. To copy a stored reference, use FILE >"Import/Export References". See also:
Chapter 15.3.1.2, "Importing and Exporting Data", on page 369.

Furthermore, you can save waveforms directly to a USB flash drive with FILE > "Wave-
forms", without creating a reference waveform before. See: Chapter 15.3.3, "Wave-
forms", on page 375.

5.1 Using References

You can store any of the active waveforms as reference waveform - channel, math,
and other reference waveforms - or load a previously saved reference.

If MSO option R&S RTM-B1 is installed, you can store also the pods of digital channels
as references.

For each selected reference waveform, you can adjust the vertical position and scale
as usual, and, unlike for other waveform types, you can also adjust the horizontal posi-
tion and scale individually.
The current scale values are shown in the waveform label of the reference waveform.

5.1.1 Displaying a Reference Waveform

A reference waveform is displayed as soon as data is written to its storage, either from
an active waveform, or loaded from a reference file. You can hide it and display it again
by using the "Visible" key.

1. Press the REF key to display the "Reference" menu.

2. Press "Reference" and select the reference storage position.
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If a reference was already loaded to the selected reference position before, the
stored reference waveform is displayed.

3. Select the data that will be used as reference by doing one of the following:

● Press "Source" and select one of the active waveforms, then press "Update".
● Load a previously saved reference.

See also: "To load references and reference settings" on page 95.

The selected data is written to the selected reference storage and displayed.

4. Press "Visible" to hide and show the reference waveform.

5.1.2 Saving and Loading References

If you need more than four references, or you want to keep a reference for other mea-
surements, you can save it and load it back to the instrument when needed. Import and
export is also possible.

To save references

1. Press REF to display the "Reference" menu

2. Press "Save".

3. Press "Source" and select the waveform whose data you want to save as a refer-
ence. All active waveforms can be saved.

4. Press "Storage" and define the storage settings.
See: "To select the storage directory" on page 368.

5. Press "File Name" and enter the name of the target file.
See: "To define a new file or directory name" on page 368.

6. Press "Save".

To copy a stored reference, use FILE > "Import/Export References". For import/export
procedure, see Chapter 15.3.1.2, "Importing and Exporting Data", on page 369.

To load references and reference settings

1. Press REF.

2. Press "Load".

3. Press "Reference" and select the reference number you want to load the reference
to.

4. Press "Load".

A file explorer is displayed.
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5. Select the storage device and the file that contains the reference. Use the "Naviga-
tion" knob to scroll through the directories. To change the directory, scroll to the
name of the directory and press the knob, or press "Change Directory".

6. Press "Load".

The saved reference is loaded to the R&S RTM.

7. If you also want to load the settings that were used to create the reference wave-
form:

a) In the "Reference" or "Load" menu, press "Reference" and select the reference
number you want to load the settings to.

b) Press "Load Settings".
"Load Settings" is only available if the waveform was loaded to the reference
storage before, you cannot laod the setting first.

5.2 Reference for REF key

The REF key provides functions for working with reference waveforms on the instru-
ment.

For details on working with these functions, see Chapter 5.1, "Using References",
on page 94.

Reference......................................................................................................................96
Source...........................................................................................................................96
Update...........................................................................................................................97
Visible............................................................................................................................97
Save.............................................................................................................................. 97
Load.............................................................................................................................. 97

└ Reference....................................................................................................... 97
└ Load................................................................................................................97

Load Settings................................................................................................................ 97

Reference
Selects one of the four possible internal reference storages.

See also: Chapter 5.1, "Using References", on page 94.

Source
Defines the source of the reference waveform. Any active channel, math or reference
waveform can be selected.

If MSO option R&S RTM-B1 is installed, you can store also the pods of digital channels
as references.
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Remote command: 
REFCurve<m>:SOURce on page 471
REFCurve<m>:SOURce:CATalog? on page 472

Update
Stores the waveform defined as the "Source" to the selected reference waveform. The
reference waveform is kept until you update or load another waveform to the reference.

See also: Chapter 5.1.1, "Displaying a Reference Waveform", on page 94.

Remote command: 
REFCurve<m>:UPDate on page 472

Visible
Displays or hides the selected reference waveform.

Remote command: 
REFCurve<m>:STATe on page 471

Save
Opens the "Save" menu with basic functions to save the equation set.

See "Save Menu" on page 370 .

Remote command: 
REFCurve<m>:SAVE on page 472

Load
Provides functions to load reference data.

Reference ← Load
Selects one of the four possible internal reference storages.

See also: Chapter 5.1, "Using References", on page 94.

Load ← Load
Opens the "Load" menu and a file explorer to select the reference waveform file for
loading.

See "Load Menu" on page 371.

Remote command: 
REFCurve<m>:LOAD on page 472

Load Settings
Loads the device settings that were used to obtain the stored reference waveform. The
settings are only available if the file was stored to the internal storage /INT/
REFERENCE and never written to an external storage (USB stick).

Remote command: 
REFCurve<m>:LOAD:STATe on page 473

Reference for REF key
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6 Measurements
The following measurement methods are available:

● CURSOR: Cursor measurements determine specific measurement results at the
current cursor positions of an active waveform; the results are displayed in a result
table.

● QUICK MEAS: performs basic automatic measurements for the selected channel
immediately; the results are displayed directly at the waveform and in a result
table.

● MEAS: With automatic measurements, up to four amplitude and time measure-
ments or pulse counts can be configured and performed simultaneously; based on
an active channel, reference, or math waveforms. The results are displayed in a
result table, the color of the results corresponds with the source waveform color.
These measurements can be performed together with the "Quick Meas" measure-
ments.

Use the full height of the screen for waveform display to get best vertical resolution and
measurement results.

6.1 Cursor Measurements

Using the CURSOR key you can determine specific measurement results at the cur-
rent cursor positions for various waveforms. The cursors can be set to the required
position with the Navigation rotary knob, or set to typical positions on a keypress.

You can measure on any active channel, math, or reference waveform, and also on the
resulting waveform of an FFT analysis and on XY-waveforms.

If MSO option R&S RTM-B1 is installed, active digital channels are available as mea-
surement sources for time and count cursor measurements, and the bit values of the
pods can be determined.

6.1.1 Cursor Measurements Types and Results

Cursor measurements are based on automatic measurements. The cursor measure-
ment is limited to the cursor positions or the part of the waveform between the cursors
while automatic measurements considers the complete display of the waveform. Thus
you can focus the measurement to the interesting part of the waveform by using cur-
sors. The results are displayed in the right part of the result table.
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For cursor measurements on channel, math, and reference waveforms, various mea-
surement types are available, for example, Peak, RMS, Mean und Count. Cursor mea-
surement is also possible on the results of an FFT analysis. It measures the frequen-
cies and levels at the cursor positions and their differences.

If MSO option R&S RTM-B1 is installed, time and count measurements can be per-
formed on active digital channels, and the bit values of the pods can be determined.

Available cursor measurements are:

Voltage.......................................................................................................................... 99
Time............................................................................................................................ 100
Voltage & Time............................................................................................................100
Ratio X........................................................................................................................ 100
Ratio Y........................................................................................................................ 100
Count...........................................................................................................................100
Peak Values................................................................................................................ 100
RMS, Mean, σ............................................................................................................. 100
Duty Ratio................................................................................................................... 101
Burst Width..................................................................................................................101
Rise Time.................................................................................................................... 101
V-Marker..................................................................................................................... 101
Crest factor..................................................................................................................101

Voltage
Sets two horizontal cursor lines and measures the voltages at the two cursor positions
and the delta of the two values.

Cursor Measurements
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Results: V1, V2, ΔV

Time
Sets two vertical cursor lines and measures the time from the trigger point to each cur-
sor point, the time between the two cursors and the frequency calculated from that
time.

Results: t1, t2, Δt, 1/t

Voltage & Time
Combines the "Voltage" cursor and "Time" cursor measurements. Two horizontal and
two vertical cursor lines are set and the voltages and time from the trigger point are
measured at the cursor positions, as well as the delta of the voltage and time values.

Results: t1, t2, Δt, V1, V2, ΔV

Ratio X
Provides three cursors and measures the ratio of the x-values (e.g. a duty cycle)
between the first and second cursors and the first and third cursors:

(x2-x1)/(x3-x1)

The ratio is displayed as a floating value, in percent, in degrees and as a radian.

Results: abs, %, °, π

Ratio Y
Provides three cursors and measures the ratio of the y-values (e.g. overshooting)
between the first and second cursors and the first and third cursors:

(y2-y1)/(y3-y1)

The ratio is displayed as a floating value and in percent.

Results: abs, %

Count
Provides three cursors to count signal transitions. The time base is defined by the first
two cursors, the third cursor defines the threshold value. As a result, the number of ris-
ing and falling edges as well as the number of positive and negative impulses is coun-
ted.

Results: , , , 

Peak Values
Measures the positive and negative peak values between the two cursors, as well as
the absolute difference between the two peak values (peak-to-peak value):

Vpp = |(Vp+) - (Vp-)|

Results: Vp+, Vp-, Vpp

RMS, Mean, σ
Measures the root mean square (RMS), the mean value, and the standard deviation of
measurement results between the two cursors.

Results: Mean, RMS, σ

Cursor Measurements
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Duty Ratio
Measures the positive and negative duty cycles. The duty cycle is the ratio between
the duration of a positve pulse (high active) or a negative pulse (low-active) and the
period of a rectangular waveform. The measurement requires at least one complete
period of the signal between cursor 1 and cursor 2. Pulse duration and period are mea-
sured at cursor 3.

Results: Dty+, Dty- (in %)

Burst Width
Measures the duration of a burst. Two vertical cursors mark the beginning and the end
of the burst. The horizontal cursor sets the threshold value, and the time between the
first and the last edge of the burst is returned.

Result: BstW

Rise Time
Measures the rise and fall times of the left-most edge in the display between the upper
and lower reference levels. The reference levels are set in the Auto Measure menu:
MEAS > "Reference Level".

See also: Reference Level: Upper, Middle, Lower Levels.

Results: tr, tf

V-Marker
Two vertical markers are provided and the values of the waveform at the marker posi-
tions are measured. Additionally, the differences of the two values in x- and y-direction
are displayed.

Results: V1, V2, Δt, ΔV

Crest factor
The crest factor is also known as peak-to-average ratio. It is calculated from the maxi-
mum value divided by the RMS value of the waveform. The measurement value is dis-
played as "Crest" in the result table.

RMS
VCrest P

6.1.2 Performing Cursor Measurements

The cursors are activated according to the latest setting as soon as you press the
CURSOR key.

To configure cursor measurements

1. Press the CURSOR key.

The cursors are activated according to the latest setting.

2. Press "Meas. Type" to select the type of measurement to perform. The type deter-
mines which results are displayed in the result table.
See also: "Meas.Type" on page 103.
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3. Press "Source" to select the waveform for which the measurement is to be per-
formed. The source can be any active waveform depending on the selected mea-
surement type.

4. Move the cursors to obtain the required results.
See also: "To change the position of the cursors" on page 102.

The cursor measurement is performed and the results are displayed in the result
table.

To change the position of the cursors

The cursor measurement displays the results depending on the current position of the
cursors. Move the cursors to obtain the results for a specific time range or at specific
signal points.

1. Press the NAVIGATION rotary knob to select the first cursor. If a selection menu is
open, it is closed.

Tip: If the cursors have disappeared from the screen or must be moved extensively
within the screen, press "Set To Screen" in the "Cursor" menu to reset the cursors
to their default positions.

2. Turn the NAVIGATION knob to change the position of the selected cursor line.

3. Press the knob again to select the next cursor line, and turn to adjust position.

4. To simplify the cursor positioning, the following functions are helpful:
● "Track Scaling" to adjust the cursor position when the vertical or horizontal

scaling are changed
● "Coupling" to keep the distance between two cursor lines constant while one of

the cursors is moved
● "Set to Wave" to set the cursor lines to typical points of the waveform based on

automatic measurements in the background

See also: Chapter 6.1.3, "Cursor Menu", on page 102.

The results of the cursor measurement in the result table are updated.

To deactivate cursor measurements

1. Press the CURSOR key.

2. Press the "Cursor" softkey.

The "Cursor" softkey is no longer highlighted, no more measurements are per-
formed, the cursor lines disappear and the results are removed from the result
table.

6.1.3 Cursor Menu

The CURSOR key opens the "Cursor" menu to configure manual measurements.

See also: Chapter 6.1.2, "Performing Cursor Measurements", on page 101.

 

Cursor Measurements



MeasurementsR&S®RTM2000

103User Manual 1317.4726.02 ─ 10

Cursor......................................................................................................................... 103
Meas.Type.................................................................................................................. 103
Source.........................................................................................................................103
Track Scaling.............................................................................................................. 104
Coupling...................................................................................................................... 104
Set to Wave.................................................................................................................104
Set To Screen............................................................................................................. 104
Prev. peak................................................................................................................... 104
Next peak.................................................................................................................... 105
NAVIGATION.............................................................................................................. 105

Cursor
Activates or deactivates the selected cursor measurement.

Remote command: 
CURSor<m>:STATe on page 476

Meas.Type
Selects the cursor measurement type. Depending on the type, different results are dis-
played in the result table.

For a list of all cursor measurement types and their description, see Chapter 6.3.1.1,
"Measurement Types", on page 107.

Depending on the measurement type, two or three cursors are provided which can be
set to the required position using the "Navigation" rotary knob. See also: "To change
the position of the cursors" on page 102.

The measurement type setting is not available for cursor measurments on FFT analy-
sis.

Remote command: 
CURSor<m>:FUNCtion on page 477

Source
Defines the source of the cursor measurement as one of the active channel, math, or
reference waveforms.

Cursor Measurements
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If MSO option R&S RTM-B1 is installed, also digital channels D0 to D15 are available
for time, ratio X, count, duty ratio, and burst width measurements, and the pods
D0...D7 and D8...D15 are available for V-marker measurements. Available sources
depend on the selected measurement type.

The source setting is not available for cursor measurements on FFT analysis and in XY
mode.

Remote command: 
CURSor<m>:SOURce on page 476

Track Scaling
If enabled, "Track Scaling" adjusts the cursor lines if the vertical or horizontal scales
are changed. The cursor lines keep their relative position to the waveform.

If disabled, the cursor lines remain on their position on the display if the scaling is
changed.

Remote command: 
CURSor<m>:TRACking:SCALe[:STATe] on page 481

Coupling
If enabled, the cursors of a can be coupled and moved together. Press the
NAVIGATION key to select both corsors or one cursor to be moved.

If disabled, the NAVIGATION key toggles the single cursor lines.

Remote command: 
CURSor<m>:XCOupling on page 480
CURSor<m>:YCOupling on page 480

Set to Wave
Autoset for cursor lines, sets the cursor lines to typical points of the waveform depend-
ing on the selected measurement type. For example, for voltage measurement, the
cursor lines are set to the upper and lower peaks of the waveform. For time measure-
ment, the cursor lines are set to the edges of two consecutive positive or two consecu-
tive negative pulses.

Remote command: 
CURSor<m>:SWAVe on page 480

Set To Screen
Resets the cursors to their initial positions. This is helpful if the cursors have disap-
peared from the display or need to be moved for a larger distance.

Remote command: 
CURSor<m>:SSCReen on page 480

Prev. peak
For FFT analysis only: sets the selected cursor to the previous (left) level peak.

To select the cursor, press the NAVIGATION knob.

Remote command: 
CURSor<m>:SPPeak on page 480

Cursor Measurements
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Next peak
For FFT analysis only: sets the selected cursor to the next (right) level peak.

To select the cursor, press the NAVIGATION knob.

Remote command: 
CURSor<m>:SNPeak on page 480

NAVIGATION
Select cursor: Press the NAVIGATION rotary knob to select a cursor line. If a menu is
open, it is closed. Press the knob repeatedly to select the required cursor line or - if
Coupling is enabled - a pair of coupled cursor lines.

Move selected cursor: Turn the rotary knob to change the position of the selected cur-
sor line.

Remote command: 
CURSor<m>:X1Position on page 479
CURSor<m>:X2Position on page 479
CURSor<m>:X3Position on page 479
CURSor<m>:Y1Position on page 479
CURSor<m>:Y2Position on page 479
CURSor<m>:Y3Position on page 479

6.2 Quick Measurements

Quick measurement performs all currently available automatic measurements for the
selected channel. The measurements cannot be configured. The results are displayed
either directly at the waveform (WF) or in the right part of the result table (T) and are
updated continuously.

If the instrument detects a period in the signal, the quick measurement measures the
first cycle and displays the results. If no period is detected, it measures the complete
waveform.

► Press the QUICK MEAS key to activate quick measurement.
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The following measurement results are determined for the displayed section of the
waveform:

Label Description Display

Vp+ Positive peak value WF

Vp- Negative peak value WF

tr Rising time of the first rising edge WF

Mean Mean value WF

tf Falling time of the first falling edge WF

RMS RMS T

Vpp Peak to peak value T

T Period length T

f Frequency T

When you activate quick measurements, cursor measurements are automatically
deactivated, as well as the reference and math menus. Deactivate quick measure-
ments before selecting these functions. Channels other than the selected one are
switched off in quick measurement mode.

► Press the QUICK MEAS key again to deactivate the quick measurement and
remove the results.

Quick Measurements
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Remote command:
● MEASurement<m>:ALL[:STATe] on page 484
● MEASurement<m>:AON on page 484
● MEASurement<m>:AOFF on page 484
● MEASurement<m>:ARESult? on page 484

6.3 Automatic Measurements

Using the MEAS key you can configure up to four amplitude and time measurements
or pulse counts on one of the active channel, reference or math waveforms.

If MSO option R&S RTM-B1 is installed, active digital channels are available as mea-
surement sources for time and count measurements.

● Measurement Types and Results......................................................................... 107
● Configuring and Performing Automatic Measurements........................................ 113
● Auto Measure Menu (MEAS key)..........................................................................115

6.3.1 Measurement Types and Results

● Measurement Types............................................................................................. 107
● Measurement Results........................................................................................... 112
● Statistics................................................................................................................113

6.3.1.1 Measurement Types

The R&S RTM provides a varity of automatic measurements:

Mean Value................................................................................................................. 108
RMS Value.................................................................................................................. 108
Mean Cycle................................................................................................................. 108
RMS Cycle.................................................................................................................. 108
Peak Peak...................................................................................................................108
Peak +.........................................................................................................................108
Peak -..........................................................................................................................108
Frequency................................................................................................................... 108
Period..........................................................................................................................109
Amplitude.................................................................................................................... 109
Crest factor..................................................................................................................109
Top Level.................................................................................................................... 109
Base Level.................................................................................................................. 109
Pulse Width (positive pulse)........................................................................................109
Pos. Overshoot........................................................................................................... 109
Neg. Overshoot........................................................................................................... 109
Pulse Width (negative pulse)...................................................................................... 110
Duty Cycle +................................................................................................................110
Duty Cycle -.................................................................................................................110
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Rise Time.................................................................................................................... 110
Fall Time..................................................................................................................... 110
σ-Std. Dev. Wave........................................................................................................110
σ-Std. Dev. Cycle........................................................................................................ 110
Delay........................................................................................................................... 111
Phase.......................................................................................................................... 111
Burst Width..................................................................................................................111
Count positive pulses.................................................................................................. 111
Count negative pulses.................................................................................................111
Count rising edges...................................................................................................... 111
Count falling edges..................................................................................................... 111
Trigger Freq................................................................................................................ 111
Trigger Period............................................................................................................. 112
Trigger B Freq............................................................................................................. 112
Trigger B Period.......................................................................................................... 112

Mean Value
Determines the mean value of the complete displayed waveform. The measurement
value is displayed as "Mean" in the result table.

RMS Value
Measures the RMS (Root Mean Square) value of the voltage of the complete displayed
waveform. The measurement value is displayed as "RMS" in the result table.

Mean Cycle
Measures the mean value of the left-most signal period. The measurement value is
displayed as "MnCy" in the result table.

RMS Cycle
Measures the RMS (Root Mean Square) value of the voltage of the left-most signal
period. The measurement value is displayed as "RMSCy" in the result table.

Peak Peak
Measures the peak-to-peak value within the displayed section of the waveform. The
measurement value is displayed as "Vpp" in the result table.

Peak +
Measures the maximum value within the displayed section of the waveform. The mea-
sured value is displayed as "Vp+" in the result table.

Peak -
Measures the minimum value within the displayed section of the waveform. The mea-
sured value is displayed as "Vp-" in the result table.

Frequency
Measures the frequency of the signal. The result is based on the length of the left-most
signal period within the displayed section of the waveform. The measurement value is
displayed as "f" in the result table.

Automatic Measurements
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Period
Measures the length of the left-most signal period within the displayed section of the
waveform. The measurement value is displayed as "T" in the result table.

Amplitude
Measures the amplitude of a square wave. To do so, the potential difference between
high and low level ("Vbase" and "Vtop") is calculated. The measurement requires at
least one complete period of a triggered signal. The measured value is displayed as
"VAmp" in the result table.

Crest factor
The crest factor is also known as peak-to-average ratio. It is calculated from the maxi-
mum value divided by the RMS value of the waveform. The measurement value is dis-
played as "Crest" in the result table.

RMS
VCrest P

Top Level
Measures the mean value of the high level of a square wave. To do so, the mean value
of the tilt is calculated (without the overshoot). The measurement and requires at least
one complete period of a triggered signal. The measured value is displayed as "Vtop"
in the result table.

Base Level
Measures the mean value of the low level of a square wave. To do so, the mean value
of the tilt is calculated (without the overshoot). The measurement requires at least one
complete period of a triggered signal. The measured value is displayed as "Vbase" in
the result table.

Pulse Width (positive pulse)
: Measures the width of a positive pulse. A positive pulse consists of a rising edge

followed by a falling edge. The measurement and requires at least one complete
period of a triggered signal. The measured value is displayed as "t " in the result
table.

Pos. Overshoot
Positive overshoot of a square wave, calculated from measurement values Top Level,
Peak +, and Amplitude. The measured value is displayed as "+Ovr" in the result table.

%100


 

Amp

Ptop

V
VV

Ovr

Neg. Overshoot
Negative overshoot of a square wave, calculated from measurement values Min, Low,
and Amplitude. The measured value is displayed as "-Ovr" in the result table.

%100


 

Amp

Pbase

V
VVOvr
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Pulse Width (negative pulse)
: Measures the width of a negative pulse. A negative pulse consists of a falling edge

followed by a rising edge. The measurement requires at least one complete period of a
triggered signal. The measured value is displayed as "t " in the result table.

Duty Cycle +
Measures the positive duty cycle. The duty cycle is the ratio between the duration of a
positve pulse (high active) and the period of a rectangular waveform. The measure-
ment requires at least one complete period of a triggered signal.

The result is the measured value as a percentage of the signal period and is displayed
as "Dty+" in the result table.

Duty Cycle -
Measures the positive duty cycle. The duty cycle is the ratio between the duration of a
negative pulse (low active) and the period of a rectangular waveform. The measure-
ment requires at least one complete period of a triggered signal.

The result is the measured value as a percentage of the signal period and is displayed
as "Dty-" in the result table.

Rise Time
Measures the rise time of the left-most rising edge within the displayed section of the
waveform. The rise time is determined as the time it takes the signal to rise from the
lower reference level to the upper reference level which are set with "Upper Level" and
"Lower Level" in the "Reference Level" menu. The measurement result is displayed as
"tr" in the result table.

See also: "Reference Level: Upper, Middle, Lower Levels" on page 116.

Fall Time
Measures the falling time of the left-most falling edge within the displayed section of
the waveform. The fall time is determined as the time it takes the signal to fall from the
upper reference level to the lower reference level which are set with "Upper Level" and
"Lower Level" in the "Reference Level" menu. The measurement result is displayed as
"tf" in the result table.

σ-Std. Dev. Wave
Measures the standard deviation of the complete waveform.
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XMean = Mean Value
X(i) = Value of the measured waveform sample
NEval = Number of waveform samples

σ-Std. Dev. Cycle
Measures the standard deviation of one cycle, usually of the first, left-most signal
period.
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Delay
Measures the time difference on the middle reference level between two slopes of the
same or different waveforms. The measurement value is displayed as "Delay" in the
result table.

Select the sources and slopes in the Delay Setup menu.

Set the middle reference level in the Reference Level menu.

Phase
Phase difference between two waveforms (time difference/period * 360) on the middle
reference level. The measurement value is displayed as "Phase" in the result table.

Select the waveforms in the Phase Setup menu.

Set the middle reference level in the Reference Level menu.

Burst Width
Duration of one burst, measured from the first edge to the last edge that cross the mid-
dle reference level. The measurement value is displayed as "Bst" in the result table.

Set the middle reference level in the Reference Level menu.

Count positive pulses
Count : Counts positive pulses within the displayed section of the waveform. A posi-
tive pulse consists of a rising edge followed by a falling edge. The mean value of the
signal is determined. If the signal passes the mean value, an edge is counted. The
pulse is counted if a rising edge and a falling edge are detected. The number of posi-
tive pulses is displayed as "Cnt " in the result table.

Count negative pulses
Count : Counts negative pulses within the displayed section of the waveform. A neg-
ative pulse consists of a falling edge followed by a rising edge. The mean value of the
signal is determined. If the signal passes the mean value, an edge is counted. The
pulse is counted if a falling edge and a rising edge are detected. The number of nega-
tive pulses is displayed as "Cnt " in the result table.

Count rising edges
Count : Counts transitions of the signal from low level to high level within the dis-
played section of the waveform. To do so, the mean value of the signal is determined.
If the signal passes the mean value, a rising edge is counted. The number of rising
edges is displayed as "Cnt " in the result table.

Count falling edges
Count : Counts transitions of the signal from high level to low level within the dis-
played section of the waveform. To do so, the mean value of the signal is determined.
If the signal passes the mean value, a falling edge is counted. The number of falling
edges is displayed as "Cnt " in the result table.

Trigger Freq.
Measures the frequency of the A-trigger signal based on the length of its period. The
measurement value is displayed as "f(Tr)" in the result table.
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Trigger Period
Measures the length of the A-trigger signal periods (hardware counter). The measure-
ment value is displayed as "T(Tr)" in the result table.

Trigger B Freq.
Measures the frequency of the B-trigger signal based on the length of its period. The
measurement value is displayed as "f(TrB)" in the result table.

Trigger B Period
Measures the length of the B-trigger signal periods. The measurement value is dis-
played as "T(TrB)" in the result table.

6.3.1.2 Measurement Results

The results of an automatic measurement are displayed in the result table below the
diagram. The color of the results in the left part of the result table corresponds with the
source waveform color. If the result for the selected measurement type cannot be
determined, e.g. because a complete period of a signal is required but not available, a
"?" is displayed.

Remote command:

MEASurement<m>:RESult[:ACTual]? on page 489
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6.3.1.3 Statistics

For each active measurement, you can enable a statistic evaluation of the measure-
ment results. It returns the current, minimum and maximum measurement values, the
average and standard deviation, and the number of measured waveforms.

For configuration settings, see "Statistic" on page 116.

Remote commands:
● MEASurement<m>:RESult[:ACTual]? on page 489
● MEASurement<m>:RESult:AVG? on page 491
● MEASurement<m>:RESult:STDDev? on page 491
● MEASurement<m>:RESult:NPEak? on page 492
● MEASurement<m>:RESult:PPEak? on page 492
● MEASurement<m>:RESult:WFMCount? on page 492
● MEASurement<m>:STATistics:VALue:ALL? on page 492
● MEASurement<m>:STATistics:VALue<n>? on page 493

Remote commands for export of statistical results:
● EXPort:MEASurement<m>:STATistics:NAME on page 493
● EXPort:MEASurement<m>:STATistics:SAVE on page 493
● EXPort:MEASurement<m>:STATistics:ALL:NAME on page 494
● EXPort:MEASurement<m>:STATistics:ALL:SAVE on page 494

6.3.2 Configuring and Performing Automatic Measurements

To configure and activate automatic measurements

1. Press the MEAS key.

2. Press "Meas. Place" to select one of the four measurement positions.

3. Press "Meas. Type" to select the type of measurement to perform. The type deter-
mines which results are displayed in the result table.
See also: "Meas. Type" on page 115.
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4. Press "Source" to select the waveform for which the measurement is to be per-
formed. The source can be any active waveform depending on the selected mea-
surement type.

5. For rise time, fall time, delay and phase measurements, press "Reference Level"
and set the reference levels as percentages of the high signal level.
See also: "Reference Level: Upper, Middle, Lower Levels" on page 116

6. Press "Measure 1-4" until "On" is highlighted to activate the measurement.

The selected measurement is activated and the results are displayed in the result
table.

To activate configured automatic measurements

1. Press the MEAS key.

2. Press "Meas. Place" to select one of the four measurement positions.

3. Press "Measure 1-4" until "On" is highlighted.

To deactivate automatic measurements

1. Press the MEAS key.

2. Press "Meas. Place" to select the measurement you want to deactivate.

3. Press "Measure 1-4" until "Off" is highlighted.

4. If you want to reset and deactivate all automatic measurements at once, press
"Clear All" in the "Auto measure" menu.

No more measurements are performed, the results are removed from the result
table.

To use statistics

1. Press the MEAS key.

2. Configure at least one mesurement as described in "To configure and activate
automatic measurements" on page 113.

3. Press "Statistic".

4. Press "Meas. Place" to select the measurement for which you need statistical
results.

5. Press "Statistic" until "On" is highlighted.

6. Press Average No. and enter the number of measured waveforms to be used for
calculation of average and standard deviation.
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6.3.3 Auto Measure Menu (MEAS key)

The MEAS key opens the "Auto Measure" menu to configure automatic measure-
ments.

For details, see Chapter 6.3, "Automatic Measurements", on page 107.

Meas. Place................................................................................................................ 115
Measure 1-4................................................................................................................ 115
Meas. Type................................................................................................................. 115
Source.........................................................................................................................116
Statistic........................................................................................................................116

└ Meas. Place.................................................................................................. 116
└ Statistic......................................................................................................... 116
└ No. of Averages............................................................................................ 116
└ Reset, Reset All............................................................................................ 116
└ Clear All........................................................................................................ 116

Reference Level: Upper, Middle, Lower Levels.......................................................... 116
Clear All.......................................................................................................................117
Delay Setup.................................................................................................................117
Phase Setup................................................................................................................117

Meas. Place
Selects one of the four available measurements to be configured or activated.

Measure 1-4
Activates or deactivates the selected measurement (1-4).

Remote command: 
MEASurement<m>[:ENABle] on page 485

Meas. Type
Defines the measurement type to be performed on the selected source. Depending on
the type, different results are displayed in the result table.

For a list of all automatic measurement types and their description, see Chapter 6.3.1,
"Measurement Types and Results", on page 107.
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Remote command: 
MEASurement<m>:MAIN on page 485
MEASurement<m>:RESult[:ACTual]? on page 489

Source
Selects one of the active signal, reference or math waveforms as the source of the
selected measurement. Available sources depend on the selected measurement type.

If MSO option R&S RTM-B1 is installed, active digital channels are available as mea-
surement sources for time and count measurements.

Remote command: 
MEASurement<m>:SOURce on page 487

Statistic
Opens a submenu to enable and configure up to four statistics.

Meas. Place ← Statistic
Selects the measurement for which statistical evaluation is configured.

Statistic ← Statistic
Activates or deactivates the statistical evaluation for the selected measurement (1-4).

Remote command: 
MEASurement<m>:STATistics[:ENABle] on page 490

No. of Averages ← Statistic
Sets the number of measured waveforms used for calculation of average and standard
deviation. The maximum number is 1000.

Remote command: 
MEASurement<m>:STATistics:WEIGht on page 490

Reset, Reset All ← Statistic
Deletes the statistical results for the current measurement or all measurements,
respectivley, and starts a new statistical evaluation if the acquisition is running.

Remote command: 
MEASurement<m>:STATistics:RESet on page 491

Clear All ← Statistic
Resets and deactivates all active statistic measurements.

Reference Level: Upper, Middle, Lower Levels
Set the lower and upper reference levels for rise and fall time mesurements (cursor
and automatic mesurements) as well as the middle reference level used for phase and
delay measurements. The levels are defined as percentages of the high signal level.
The settings are valid for all measurement places.
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Remote command: 
REFLevel:RELative:MODE on page 496
REFLevel:RELative:LOWer on page 496
REFLevel:RELative:MIDDle on page 496
REFLevel:RELative:UPPer on page 496

Clear All
Resets and deactivates all four measurements.

Remote command: 
MEASurement<m>:AOFF on page 484

Delay Setup
Configures the delay measurement that measures the time difference between two
edges of the same or different waveforms.

"Source 1,
Source 2"

Select one of the active channel, math or reference waveforms for
each measurement source.

"Slope" Select the rising or falling slope for each measurement source.

Remote command: 
MEASurement<m>:SOURce on page 487
MEASurement<m>:DELay:SLOPe on page 489

Phase Setup
Configures the phase measurement that measures the pahse difference between two
waveforms.

"Source 1,
Source 2"

Select one of the active channel, math or reference waveforms for
each measurement source.

Remote command: 
MEASurement<m>:SOURce on page 487
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7 Mathematics
Mathematical (math) waveforms are calculated data. Each math waveform is defined
by an equation. You can configure and save up to five equations (MA1 – MA5), four of
these equation can be displayed.

Each equation consists of one or two operands and a operator. An operand can be an
input channel, a constant value, or a math waveform with lower number than the oper-
and's number. For example, the MA3 equation can use the results of MA2 and MA1 as
operands.

Each equation and also the set of all defined equations can get a label.

An equation set can be saved to and loaded from any storage device - internal memory
or external USB flash device. The file format is always .FML, and the file size is 526
Byte. It is also possible to copy the stored equation sets to another storage device with
FILE > "Import/Export Equation Sets". See also: Chapter 15.3.1.2, "Importing and
Exporting Data", on page 369.

7.1 Configuring and Using Math Waveforms

Math waveforms are configured using the "Equation Set Editor". Each equation for a
math waveform is configured and displayed individually, and you can save and load
the configuration of all five math waveforms as an "Equation Set".

7.1.1 Displaying Mathematical Waveforms

For each of the math waveforms MA1 - MA5 you can define whether it is displayed or
not and which equation is performed in each one. .

1. Press MATH to display the "Mathematics" menu.

2. Press "Equation" and select the mathematical waveform that contains the equation
you want to display.
To check which equation is configured for which channel:

a) Press "Edit Equations". The "Equation Set Editor" is displayed, where you can
see the configuration for each math waveform. Currently displayed waveforms
are indicated by the  symbol.

b) Press "Back" to exit the editor.

3. Press "Visible" until "On" is highlighted.

The selected equation is calculated and the results are displayed as an additional
(mathematical) waveform on the screen. If necessary, change the vertical scaling
of the math waveform to improve the display using the vertical SCALE rotary knob.

 

 

 

Configuring and Using Math Waveforms



MathematicsR&S®RTM2000

119User Manual 1317.4726.02 ─ 10

If the required equation is not included, edit the current equation set, or load an appro-
priate equation set that was saved before. See also: "To configure an equation"
on page 119 and "To load an equation set" on page 121.

7.1.2 Editing Equations and Equation Sets

To each math waveform an equation is assigned. The mathematical operation is
defined by the operator and is performed on the operands. Operands are one or two of
the active channel or math waveforms, or a constant value.

All five math waveforms together build an equation set that can be stored and loaded.

To configure an equation

1. Press "MATH > Edit Equations" to display the "Equation Set Editor" with the cur-
rent equation set configuration.

2. Press "Equation" and select the equation to be configured.

3. Press "Operator" to select the operator of the equation.
See also: "Operator" on page 123.

4. Press "Operand1".
See also: "Operand 1" on page 128.

5. If the equation requires a second operand, press "Operand2" and define the sec-
ond operand.

6. If one of the operands is defined as a constant, define its value:

a) Press "Operand1" or "Operand2" to select the constant for the corresponding
operand.

b) Press "Edit Constant" to define its value.
c) Press "Constant" and select either a pre-defined constant, or one of 10 availa-

ble user-defined constants.
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d) If you selected a user-defined constant, define its value:

● Press "Value" and enter the numeric value.
● Press "Decimal Point" to move the decimal point within the numeric value.
● Press "Prefix" to define an SI-prefix to the unit. See also: "Prefix"

on page 129.
● Press "Unit" to define the unit of the value. See also: "Unit" on page 129.

e) Press "Save" to store the user-defined constant.

7. Press "Unit" to define the unit of the equation results. See also: "Unit"
on page 122.

8. Optionally, press "Equation Label" to define a name for the equation. This label is
displayed on the "Equation" softkey and in the "Equation Set Editor".

To edit an equation set

1. Press "MATH > Edit Equations" to display the "Equation Set Editor".

2. Press "Equation" to select the first equation to be configured. This equation is
assigned to the first math waveform (MA1).

3. Configure the equation.
See: "To configure an equation" on page 119.

4. Repeat steps 3 and 4 to configure all 5 equations in the equation set.

5. Press "Back" to exit the editor and return to the main "Mathematics" menu.

6. For each equation MA1 to MA4, define whether it is to be displayed or not:

a) Press "Equation" to select the equation.
b) Press "Visible" to switch the display of the math waveform on or off.

7. Optionally, press "Eq. Set Label" to define a name for the equation set. This label is
displayed in the "Equation Set Editor".

7.1.3 Saving and Loading Equation Sets

If you want to keep math configurations for specific measurement purposes for later
use, you can save equations sets in the instrument or on external storage device.

To copy a stored equation sets to another storage device, use FILE > "Equation Sets".
For import/export procedure, see Chapter 15.3.1.2, "Importing and Exporting Data",
on page 369.

To save the current equation set

1. Press MATH to display the "Mathematics" menu.

2. Press "Save".
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3. Define the storage location using the "Storage" softkey, and the file name using the
"File name" softkey.
See: Chapter 15.3.1.1, "Configuring Storage Locations", on page 368.

4. Optionally, define a comment to be added to the equation set using the "Comment"
softkey.

5. Press "Save".

The equation set is saved as configured.

To load an equation set

1. Press "MATH > Load".

A file explorer is displayed.

2. If necessary, switch to the storage location that contains the file by pressing "Stor-
age".

3. Select the file that contains the equation set. Use the "Navigation" knob to scroll
through the directories. To change the directory, scroll to the name of the directory
and press the knob, or press "Change dir.".

4. Press "Load".

The equation set is loaded to the R&S RTM.

7.2 Reference for Mathematics

The MATH key provides functions to configure and display calculated data.

For details on working with these functions, see Chapter 7.1, "Configuring and Using
Math Waveforms", on page 118.

Equation...................................................................................................................... 122
Visible..........................................................................................................................122
Unit..............................................................................................................................122
Edit Equations............................................................................................................. 123

└ Equation........................................................................................................123
└ Operator........................................................................................................123
└ Operand 1.....................................................................................................128
└ Operand 2.....................................................................................................128
└ Edit Constant................................................................................................ 128

└ Constant............................................................................................. 129
└ Value...................................................................................................129
└ Decimal Point......................................................................................129
└ Prefix...................................................................................................129
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└ Unit..................................................................................................... 129
└ Save....................................................................................................130

└ Equation Label..............................................................................................130
Eq. Set Label...............................................................................................................130
Save............................................................................................................................ 130
Load............................................................................................................................ 130

Equation
Selects one of five possible mathematical channels.

Visible
Defines whether the selected mathematical waveform is displayed on the display or
not.

Note: MA5 cannot be displayed, it is always invisible.

Remote command: 
CALCulate:MATH<m>:STATe on page 497

Unit
Defines the unit of the equation results. The selected unit only has an effect on the dis-
played unit, not on the size of the values.

The following units are available:
● V (Volts)
● A (Amperes)
● Ω (Ohms)
● S (Siemens)
● V/A (Volts per Ampere)
● W (Watts, active power)
● VA (Voltamps, apparent power)
● VAr (Voltamps, reactive power)
● Vs (Volt-seconds = Weber, unit of magnetic flux)
● V/s (Volts per second)
● dB (decibels)
● dBm (dB referred to 1 mW)
● dBV (dB referred to 1 V)
● dBμV (dB referred to 1 μV)
● s (Second)
● 1/s, Hz (Hertz)
● s/DIV
● F (Farad)
● H (Henry)
● % (Percent)
● ° (Degree)
● π (Pi)
● Pa (Pascal)
● m (Meter)
● g (Acceleration)
● °C (Degrees Celsius)
● K (Kelvin)
● °F (Degrees Fahrenheit)
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● N (Newton)
● J (Joule)
● C (Coulomb)
● Wb (Weber)
● T (Tesla)
● (dez) (dezimal)
● (bin) (binary)
● (hex) (hexadezimal)
● (oct) (octal)
● DIV (Division, graticule)
● px (pixel)
● Bit
● Bit/s
● Byte
● Bd (Baud)
● Sa (Samples)
● Sa/sec. (Samples per second)
● cyc (cycles)
● Trc. (Traces)
● Sa/X
●  Rising edge
●  Falling edge
●  Positive impulse
●  Negative impulse
● Ev. (Events)
● Symb. (symbols)
● Sy./s (symbols per second)
● Wfm. (waveforms)

Edit Equations
Provides functions to configure the calculations for the mathematical channels.

Remote command: 
CALCulate:MATH<m>[:EXPRession][:DEFine] on page 498

Equation ← Edit Equations
Selects one of five possible mathematical channels.

Operator ← Edit Equations
Defines the operation to be performed on the specified operands in the mathematical
channel.
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"Addition" Op1 + Op2
Adds the two operands.

"Subtraction" Op1 - Op2
Subtracts the second operand from the first operand.

"Multiplication" Op1 * Op2
Multiplies the two operands.

"Division" Op1 / Op2
Divides the first operand by the second operand.
For small amplitudes of the second operand, the result increases
quickly. If the second operand crosses zero, the result would be a
range of +∞ to -∞. In this case, instead of 0V, the calculation function
uses the value that the Least Significant Bit (LSB) of the second oper-
and represents. (For an 8-bit value, for example, 1/256).
You can limit the zero-crossings of the operand by using the "Maxi-
mum" operator. This limitation results in a smaller result range and a
finer resolution.

"Maximum" Maximum (Op1, Op2)
Compares the amplitudes of both operands and displays the maxi-
mum amplitude. The sign of the result is taken from Operand1. Use
this operation in combination with the "Reciprocal" or "Division" oper-
ation to limit the minimal amplitudes of an operand.
Example: Operand1 is a homopolar sine signal with Vpp=3V. Oper-
and2 is a constant value of 1V. The result is always larger than 1V or
smaller than -1V.
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"Minimum" Minimum (Op1, Op2)
Compares the amplitudes of both operands and displays the mini-
mum amplitude. The sign of the result is taken from Operand1. Use
this operation in combination with the "Reciprocal" or "Division" oper-
ation to limit the maximal amplitudes of an operand.
Example: Operand1 is a MATH waveform within the range of +/-10V.
Operand2 is a constant value of 1V. The result is always smaller than
1V or larger than -1V.

"Square" Op1 * Op1
Squares the operand. If the operand contains negative values that
have been clipped, then the result contains positive clipping.

"Square Root" Square Root (Op1)
Calculates the square root of the operand. Note that the square root
of a negative number is undefined and the result is clipped.

"Abs. Value" |Op1|
Calculates the absolute value of the operand. All negative values are
inverted to positive values. The positive values remain unmodified. If
the operand has negative values that have been clipped, the result
contains positive clipping.

"Pos. Wave" Max (Op1, 0)
Extracts the positive data points from the operand. For all negative
values the result is zero. The positive values remain unmodified.
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"Neg. Wave" Min (Op1, 0)
Extracts the negative data points from the operand. For all positive
values the result is zero. The negative values remain unmodified.

"Reciprocal" 1V / Op1
Divides 1V by the operand values.
For small operand amplitudes the result increases quickly. If the oper-
and crosses zero, the result would be a range of +∞ to -∞. In this
case, instead of 0V, the calculation function uses the value that the
Least Significant Bit (LSB) of the operand represents. (For an 8-bit
value, for example, 1/256).
You can limit the zero-crossings of the operand by using the "Maxi-
mum" operator. This limitation results in a smaller result range and a
finer resolution.

"Inverse" Inverts all voltage values of the operand, i.e. all values are mirrored at
the ground level. Thus, a positive voltage offset becomes negative. If
the amplitude of the operand is clipped, the result is the inverted limi-
tation.

"Common
Log."

log (Op1)
Calculates the logarithm to the basis 10 of the operand. Note that the
logarithm of a negative number is undefined and the result is clipped.

"Natural Log." ln (Op1)
Calculates the logarithm to the basis e (Euler number) of the oper-
and. Note that the logarithm of a negative number is undefined and
the result is clipped.
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"Integral" Calculates the definite integral of the operand.
The calculation is displayed in the illustration. The integration starts at
point "a" and adds the area beneath the waveform. Point "b" indicates
the currently calculated value. At the end of the positive alternation,
the integral function reaches its maximum. Due to the homopolar
operand used in this example, the waveform of the area reaches zero
after the negative alternation.
Use a V-Marker to measure the area for an extract of the waveform.
See also: "Meas.Type" on page 103.

"Derivative" f'(Op1)
The derivative corresponds to the rise of the tangent through a func-
tion point and indicates the dimension of the change in quantity of the
operand in time. The larger the quantity change of the operand per
time becomes, the larger the result of the derivative is.
The calculation is approximated using the secant based on the cur-
rent calculated value and a value with a distance of 0.1 DIV. Due to
this, the time axis has a finitely small resolution. Therefore, scale the
input signal to display the required area appropriately.

"Period" Creates a track of all period values of one waveform and displays it in
time-correlation to the waveform.

"Frequency" Creates a track of all frequency values of one waveform and displays
it in time-correlation to the waveform.
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"Duty Cycle
+/-"

Creates a track of all positive or negative duty cycle results of one
waveform and displays it in time-correlation to the waveform.

"Pulse Width
+/-"

Creates a track of all positive or negative pulse width values of one
waveform and displays it in time-correlation to the waveform.

"IIR low pass" IIR  (Op1,fg=Op2)
Calculates a low-pass filtered waveform of "Operand 1". The cut-off
frequency is set with constant "Operand 2". Signal components with
frequencies higher than the cut-off frequency are attenuated signifi-
cantly.

"IIR high pass" IIR  (Op1,fg=Op2)
Calculates a high-pass filtered waveform of "Operand 1". The cut-off
frequency is set with constant "Operand 2". Signal components with
frequencies below the cut-off frequency are attenuated significantly.

Remote command: 
CALCulate:MATH<m>[:EXPRession][:DEFine] on page 498

Operand 1 ← Edit Equations
Defines the first operand for the mathematical operation. The source can be any active
channel signal, a constant value, or a mathematical waveform with lower number than
the one to be defined.

"CH1 | CH2 |
CH3 | CH4"

An active channel waveform

"Const." A constant value

"MA1 | MA2 |
MA3 | MA4"

A mathematical waveform. Only math waveforms with lower number
are available.

Operand 2 ← Edit Equations
Defines the second operand for the mathematical operation, if required. The source
can be any active channel signal, a constant value, or a mathematical waveform with
lower number than the one to be defined.

"CH1 | CH2 |
CH3 | CH4"

An active channel waveform

"Const." A constant value

"MA1 | MA2 |
MA3 | MA4"

A mathematical waveform. Only math waveforms with lower number
are available.

Edit Constant ← Edit Equations
Provides functions to define a constant value to be used in a mathematical operation.
In addition to the value, a decimal point, the unit and an SI-prefix can be defined.

This softkey is only available if "Constant" is selected as one of the operands.
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Constant ← Edit Constant ← Edit Equations
Specifies a pre-defined constant or a user-defined constant for a mathematical opera-
tion. Either one of the following pre-defined constants can be selected, or one of 10
user-defined constants.
● Pi
● 2*Pi
● 1/2*Pi
● e

Value ← Edit Constant ← Edit Equations
Specifies the value for a user-defined constant. This function is only available if one of
the user-defined constants is selected by the "Constant" softkey.

Decimal Point ← Edit Constant ← Edit Equations
Moves the decimal point within the user-defined constant value.

Prefix ← Edit Constant ← Edit Equations
Defines an SI-prefix for the unit of a user-defined constant value. The following prefixes
are available:
● None
● m (Milli, 10-3)
● μ (Mikro, 10-6)
● n (Nano, 10-9)
● p (Piko, 10-12)
● f (Femto, 10-15)
● a (Atto, 10-18)
● z (Zepto, 10-21)
● y (Yokto, 10-24)
● K (Kilo, 103)
● M (Mega, 106)
● G (Giga, 109)
● T (Tera, 1012)
● P (Peta, 1015)
● E (Exa, 1018)
● Z (Zetta, 1021)
● Y (Yotta, 1024)

Unit ← Edit Constant ← Edit Equations
Defines the unit of the user-defined constant value. The selected unit only has an
effect on the displayed unit, not on the size of the values.

For a list of available units, see "Unit" on page 122.
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Save ← Edit Constant ← Edit Equations
Saves the defined constant to the equation of the math waveform.

Equation Label ← Edit Equations
Defines a label for the current equation.

Eq. Set Label
Defines a label for the equation set.

Save
Opens the "Save" menu with basic functions to save the equation set.

See "Save Menu" on page 370.

Load
Displays the "Load" menu and a file explorer to select an equation set file.

See "Load Menu" on page 371.
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8 Spectrum Analysis
The R&S RTM provides two ways of spectrum analysis:
● Basic FFT calculation, which is included in the firmware
● Spectrum analysis option R&S RTM-K18, which is hardware-supported and pro-

vides a wide range of analysis possibilities, for example, spectogram, markers, ref-
erence markers, cursor and automatic measurements.

8.1 Basic FFT

In addition to signal vs. time and signal vs. signal displays, the frequencies of a signal
as determined by FFT analysis can be displayed. FFT analysis is configured and acti-
vated using the FFT key. Analysis is always performed on the signal channel that was
most recently activated, however you can change the channel source.

Various parameters concerning the time base, scaling and the waveform arithmetic
can be configured for the FFT display. You can configure FFT either numerically using
the softkeys, or graphically using the rotary knobs.

On the FFT display, you can perform frequency and level measurements by means of
a cursor measurement. Automatic measurements are not available.

8.1.1 FFT Display

When you activate FFT display, two windows are displayed: the signal vs. time at the
top, the result of the FFT analysis at the bottom.
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The display can be restricted to the results for a certain time base extract and to a
specified frequency range. The time range is indicated by white lines in the Y(t)-dia-
gram (see also Figure 8-1).

Move the focus between the Y(t)-window (Time Control), the FFT time base extract
(Time Section) and the FFT frequency range (FFT Control) by pressing the horizontal
SCALE rotary knob. The currently selected screen element is highlighted and dis-
played in the information bar. Depending on the selection, the functions of the SCALE
and POSITION rotary knobs may change.

The usual channel parameters are displayed in the information bar above the Y(t)-win-
dow (see the general display information described in the "Getting Started" manual).

In addition, FFT-specific parameters are indicated in the information bar above the FFT
window. The following information is given there:

 Description Setting

1 Width of the time base extract for which FFT is calculated YT-Window

2 Position of time base extract Position

3 Width of the displayed frequency range Span

4 Center of the displayed frequency range Center

5 Sample rate for FFT calculation  
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 Description Setting

6 FFT result mode Waveform Arithmetic

7 Signal source and vertical scaling factor per division CH1...CH4 / Y-Scale / Y-Scaling

8 Focus of the horizontal SCALE knob Press SCALE

8.1.2 Configuring and Using FFT Calculations

● Setting Up the FFT Analysis................................................................................. 133
● Configuring the Diagrams..................................................................................... 134
● Measuring on FFT.................................................................................................136

8.1.2.1 Setting Up the FFT Analysis

To display an FFT diagram

► Press the FFT key.

The key lights up and two windows are displayed: the signal vs. time at the top, the
result of the FFT analysis at the bottom.

To deactivate the FFT display

► There are two ways to deactivate the FFT display:

● If the main "FFT" menu is open, press the FFT key once.
If the "FFT Setup" menu or the "Y(t) Setup" menu is open, press the the FFT
key twice.

● Press "FFT off" in the "FFT" main menu.

The FFT key is no longer illuminated and the time domain is displayed.

To configure the general FFT display

1. Press the FFT key to activate the FFT display and open the "FFT" menu.

2. If necessary, press one of the CH1...CH4 keys to change the signal source of the
FFT calculation.

3. Press "Waveform Arithmetic" to define the mode for FFT calculation and display.
The waveform arithmetic defines whether the values are updated regularly, or
whether values from previous spectra are included in the calculation and display.
For details see "Wfm. Arithmetic" on page 138.

4. If "Average" mode is selected, press "No. of Averages" to define how many spectra
are considered for the calculation.

5. Press "Window" to define which type of function is laid over the input values. If the
input values are to be used unaltered, use the "Rectangle" window. To reduce
noise, use a bell-shaped window.
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For details see "Window" on page 139.

6. Press "Y-Scaling" to select logarithmic or linear scaling of the y-axis in the FFT win-
dow (see "Y-Scaling" on page 140).

7. Define the settings for the FFT window as described in "To configure the FFT dia-
gram numerically" on page 134.

8. Define the settings of the signal vs. time window as described in "To configure the
Y(t)-window numerically" on page 135. These settings are identical to the general
trigger and scaling settings defined for the channel (see also Chapter 2.2.2,
"Adjusting the Signal Input Manually", on page 26).

8.1.2.2 Configuring the Diagrams

To configure the FFT diagram numerically

Alternatively to configuring the FFT window numerically via the softkeys, you can use
the rotary knobs to change the settings graphically, see "To configure the FFT diagram
graphically" on page 135.

1. Press "FFT-Setup" in the "FFT" menu.

2. Define the time base extract for which the FFT is to be calculated and displayed.
The extract is defined by its width and position (see Figure 8-1).

a) Press "YT-Window" to define the width of the time base extract.
b) Press "Position" to define the position of the time base extract. The position is

defined as an offset of the center of the extract range to the 0s reference point.

The time base extract is indicated by a white frame in the Y(t)-window. The width
(W) and position (P) are indicated in the information bar beneath the Y(t)-window.

Figure 8-1: Width and position of the time base extract for FFT calculation

3. Press "Y-Scale" to define the scaling of the FFT amplitudes.

4. Define the frequency range to be displayed in the FFT window. The range is
defined as (Center - Span/2) to (Center + Span/2). For details see "Span"
on page 140 and "Center" on page 140.

a) Press "Span" to define the width of the frequency range.
b) Press "Center" to define the center frequency of the range.
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To configure the FFT diagram graphically

1. Define the time base extract for which the FFT is to be calculated and displayed.
The extract is defined by its width and position (see Figure 8-1).

a) Press the horizontal SCALE rotary knob to select the FFT time base extract
("W"/"P" settings are highlighted).

b) Turn the horizontal SCALE rotary knob to define the width of the time base
extract. Turn the knob counter-clockwise to enlarge the extract, or clockwise to
decrease it.

c) Turn the horizontal POSITION rotary knob to define the position of the time
base extract. Turn the knob counter-clockwise to move the extract to the left, or
clockwise to move it to the right.

2. Define the frequency range to be displayed in the FFT diagram. The range is
defined as (Center - Span/2) to (Center + Span/2). For details see "Span"
on page 140 and "Center" on page 140.

a) Press the horizontal SCALE rotary knob to select the FFT frequency range
("Span"/"Center" settings are highlighted).

b) Turn the horizontal SCALE rotary knob to define the span of the frequency
range. Turn the knob counter-clockwise to enlarge the span, or clockwise to
decrease it.

c) Turn the horizontal POSITION rotary knob to define the center of the frequency
range. Turn the knob counter-clockwise to move the center to the left, or clock-
wise to move it to the right.

d) Turn the vertical SCALE rotary knob to define the scaling of the FFT ampli-
tudes. Turn the knob counter-clockwise to decrease the amplitudes, or clock-
wise to enlarge them.

To configure the Y(t)-window numerically

Alternatively to configuring the Y(t)-window numerically via the softkeys, you can use
the rotary knobs to change the settings graphically, see "To configure the Y(t)-window
graphically" on page 136.

1. Press "Y(t)-Setup" in the "FFT" menu.

2. Press "Y-Scale" to define the scaling of the signal amplitudes in the Y(t)-window.

3. Press "Y-Position" to define the vertical position of the time axis in the Y(t)-window,
in divisions.

4. Press "Main Time Base" to define the scaling for the time base in the Y(t)-window
in seconds per division.
Note that when you change the scaling for the main time base, the width of the
FFT time base extract is also changed.

5. Press "Trigger Offset" to define the offset of the trigger point to the reference point
for 0s.
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Note that when you change the trigger offset, the position of the FFT time base
extract is also changed.

The scaling factor for the time base (TB) and the trigger offset (T) are indicated in
the information bar above the Y(t)-window.

Figure 8-2: Time base (per division) and trigger offset in Y(t)-window

To configure the Y(t)-window graphically

1. Press the horizontal SCALE rotary knob to select the Y(t)-window ("TB"/"T" settings
are highlighted).

2. Turn the vertical SCALE rotary knob to define the scaling of the signal amplitudes
in the Y(t)-window. Turn the knob counter-clockwise to decrease the amplitudes, or
clockwise to enlarge them.

3. Turn the vertical POSITION rotary knob to define the vertical position of the time
axis in the Y(t)-window. Turn the knob counter-clockwise to move the time axis
down, or clockwise to move it up.

4. Turn the horizontal SCALE rotary knob to define the scaling for the time base in the
Y(t)-window. Turn the knob counter-clockwise to increase the scaling, or clockwise
to decrease it (and thus spread the waveform).
Note that when you change the scaling for the main time base, the width of the
FFT time base extract is also changed.

5. Turn the horizontal POSITION rotary knob to define the offset of the trigger point to
the reference point for 0s. Turn the knob counter-clockwise to move the trigger
point to the left, or clockwise to move it to the right.
Note that when you change the trigger offset, the position of the FFT time base
extract is also changed.

8.1.2.3 Measuring on FFT

You can perform cursor measurements in FFT mode. Automatic measurements are
not available.

1. Press FFT, then set up and configure the FFT diagram.

2. Press CURSOR.
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3. In the "Cursor" menu, set the cursor lines to the required positions:

● Use "Prev. Peak" and "Next Peak" to set the selected cursor line to the level
peaks.
See also: Chapter 6.1.3, "Cursor Menu", on page 102.

● Turn the NAVIGATION knob to move the cursor line.
● Press the NAVIGATION knob to switch the cursor line.

The frequency and level results are shown in the results table.

8.1.3 Reference for FFT key

The FFT key enables the FFT mode and opens the FFT menu.

See also:
● Chapter 8.1.2, "Configuring and Using FFT Calculations", on page 133
● Chapter 8.1.1, "FFT Display", on page 131

FFT..............................................................................................................................138
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└ Trigger Offset................................................................................................142
└ Show Channels.............................................................................................143

FFT Off........................................................................................................................143

FFT
The FFT key activates and deactivates the spectrum analyses functions:
● If option R&S RTM-K18 is installed, the FFT key enables the spectrum analysis

mode.
● Without the option, the FFT key enables the basic Fast Fourier Transformation

(FFT) calculation for the most recently selected channel.
If activated, the FFT key lights up.

To deactivate spectrum analysis, press the FFT key until the time domain waveform is
displayed.

Remote command: 
CALC:MATH:EXPR "FFTMAG(CHx)"; see also CALCulate:MATH<m>[:
EXPRession][:DEFine] on page 498.

Wfm. Arithmetic
Defines the arithmetic mode for FFT calculation and display.

"None" The FFT is performed without any additional weighting or postpro-
cessing of the acquired data. The new input data is acquired and dis-
played, and thus overwrites the previously saved and displayed data.

"Envelope" In addition to the normal spectrum, the maximal oscillations are
saved separately and updated for each new spectrum. The maximum
values are displayed together with the newly acquired values and
form an envelope. This envelope indicates the range of all FFT trace
values that occurred.
If any signal parameters are changed, the envelope is reset.

"Average" The average of several spectrums is calculated. The number of spec-
trums used for the averaging is defined using the knob or the "No. of
Averages" softkey. This mode is useful for noise rejection.

Remote command: 
CALCulate:MATH<m>:ARIThmetics on page 501

No. of Averages
Defines the number of spectrums used for averaging.

This function is only available if "Average" mode is selected.
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Remote command: 
CALCulate:MATH<m>:FFT:AVERage:COUNt on page 502

Window
Window functions are multiplied with the input values and thus can improve the dis-
play.

If discontinuities occur at the borders of the measurement interval, the algorithm inter-
prets such discontinuities as a sudden edge, which can distort the result. For bell-sha-
ped functions, the border values are multiplied with smaller values and thus have less
influence on the result.

Remote command: 
FFT: CALCulate:MATH<m>:FFT:WINDow:TYPE on page 501
Spectrum analysis: SPECtrum:FREQuency:WINDow:TYPE on page 510

Hanning ← Window
The Hanning window is bell shaped. Unlike the Hamming window, its value is zero at
the borders of the measuring interval. Thus, the noise level within the spectrum is
reduced and the width of the spectral lines enlarges. Use this window to measure
amplitudes of a periodical signal precisely.

Hamming ← Window
The Hamming window is bell shaped. Its value is not zero at the borders of the mea-
suring interval. Thus, the noise level inside the spectrum is higher than Hanning or
Blackman, but smaller than the rectangular window. The width of the spectral lines is
thinner than the other bell-shaped functions. Use this window to measure amplitudes of
a periodical signal precisely.

Blackman ← Window
The Blackman window is bell shaped and has the steepest fall in its wave shape of all
other available functions. Its value is zero at both borders of the measuring interval. In
the Blackman window the amplitudes can be measured very precisely. However, deter-
mining the frequency is more difficult. Use this window to measure amplitudes of a
periodical signal precisely.

Flat top ← Window
The flat top window has low amplitude measurement errors but a poor frequency reso-
lution. Use this window for accurate single-tone measurements and for measurement
of amplitudes of sinusoidal frequency components.
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Rectangle ← Window
The rectangular window multiplies all points by one. The result is a high frequency
accuracy with thin spectral lines, but also with increased noise. Use this function pref-
erably with pulse response tests where start and end values are zero.

Y-Scaling
Defines the scaling unit for the y-axis. The display values are valid for 50Ω termination
impendance. To achieve this, the existing internal terminating resistor can be used, or
an external terminating resistor can be connected parallel to the high impedance input.

"dBm" logarithmic scaling; related to 1 mW

"dBV" logarithmic scaling; related to 1 Veff

"Veff" linear scaling; displays the RMS value of the voltage

Remote command: 
FFT: CALCulate:MATH<m>:FFT:MAGNitude:SCALe on page 503
Spectrum analysis: SPECtrum:FREQuency:MAGNitude:SCALe on page 509

FFT-Setup
Defines the settings for the FFT window. The display can be restricted to the results for
a certain time base extract and to a specified frequency range.

Span ← FFT-Setup
The span is specified in Hertz and defines the width of the displayed frequency range,
which is (Center - Span/2) to (Center + Span/2). The position of the span is defined
using the "Center" function.

Note: If the FFT frequency range is selected ("Span"/"Center" is highlighted), the width
of the span can be adjusted using the horizontal SCALE rotary knob.

Remote command: 
CALCulate:MATH<m>:FFT:SPAN on page 504
CALCulate:MATH<m>:FFT:FULLspan on page 504
CALCulate:MATH<m>:FFT:STARt on page 504
CALCulate:MATH<m>:FFT:STOP on page 505

Center ← FFT-Setup
Defines the position of the displayed frequency domain, which is (Center - Span/2) to
(Center + Span/2). The width of the domain is defined using the "Span" function.
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Note: If the FFT frequency range is selected ("Span"/"Center" is highlighted), the width
of the span can be adjusted using the horizontal POSITION rotary knob.

Remote command: 
CALCulate:MATH<m>:FFT:CFRequency on page 504
CALCulate:MATH<m>:FFT:STARt on page 504
CALCulate:MATH<m>:FFT:STOP on page 505

Y-Scale ← FFT-Setup
Changes the vertical scaling of the FFT display (in V/dBm) per division.

Note: If the FFT frequency range is selected ("Span"/"Center" is highlighted), the Y-
Scale can be defined using the vertical SCALE rotary knob.

See also "SCALE, Y-Scale" on page 36.

Remote command: 
CALCulate:MATH<m>:SCALe on page 497

YT-Window ← FFT-Setup
Defines the width of the time base extract from the Y(t)-window for which the FFT is
calculated. The extract is indicated by white lines in the Y(t)-window. The value is indi-
cated by "W" in the information bar above the FFT window.

Note: If the FFT time base extract is selected ("W"/"P" is highlighted), the width can be
adjusted using the horizontal SCALE rotary knob.

See also Figure 8-1.

Remote command: 
CALCulate:MATH<m>:FFT:TIME:RANGe on page 505

Position ← FFT-Setup
Defines the position of the time base extract in the Y(t)-window for which the FFT is
calculated. The value is indicated by "P" in the information bar above the FFT window.

Note: If the FFT time base extract is selected ("W"/"P" is highlighted), the position can
be adjusted using the horizontal POSITION rotary knob.

See also Figure 8-1.

Remote command: 
CALCulate:MATH<m>:FFT:TIME:POSition on page 505

Points ← FFT-Setup
Defines how many samples are used for FFT calculation

The value is changed in 2n steps from 2048 (211) to 65536 (216).

Remote command: 
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio on page 503
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Y(t)-Setup
Defines the settings for the signal vs. time window.

Y-Scale ← Y(t)-Setup
Changes the vertical scaling of the Y(t)-window (channel scaling).

Note: If the Y(t)-window is selected (indicated by a white border), the Y-Scale can be
adjusted using the vertical SCALE rotary knob.

See "SCALE, Y-Scale" on page 36.

Remote command: 
FFT:CHANnel<m>:SCALe on page 423
Spectrum analysis: SPECtrum:FREQuency:SCALe on page 510

Y-Position ← Y(t)-Setup
Defines the vertical position of the time axis in the Y(t)-window, in divisions.

Note: If the Y(t)-window is selected (indicated by a white border), the Y-Position can
be adjusted using the vertical POSITION rotary knob.

Remote command: 
CHANnel<m>:POSition on page 424

Main Time Base ← Y(t)-Setup
Defines the scaling for the time base in the (original) Y(t)-window in seconds per divi-
sion. The scaling is indicated by "TB" in the information bar above the window.

Note: If "Time Control" is selected, the main time base can be adjusted using the hori-
zontal SCALE rotary knob.

See also "SCALE" on page 29, "To configure the original Y(t)-diagram" on page 89 and
Figure 8-2.

Remote command: 
TIMebase:SCALe on page 414

Trigger Offset ← Y(t)-Setup
Defines the horizontal position of the trigger point in relation to the reference point - to
the zero point of the grid. The value is indicated by "T" in the information bar above the
window.

The reference point is set with SETUP >"Time Reference".

Note: If a zoom or FFT window is displayed and "Time Control" is selected, the trigger
offset can be adjusted using the horizontal POSITION rotary knob.
See also:
● "POSITION" on page 29
● "Time Reference" on page 386
● "To configure the original Y(t)-diagram" on page 89

Remote command: 
TIMebase:POSition on page 416
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Show Channels ← Y(t)-Setup
Displays all active channels in the Y(t)-window. By default, only the selected channel is
visible, the channel used for FFT calculation.

FFT Off
Closes the FFT display and returns to the previous display.

8.2 Spectrum Analysis (Option R&S RTM-K18)

The spectrum analysis settings are available if option R&S RTM-K18 is installed. Using
the spectrum analysis option, you can analyze frequency-dependent events and dis-
play a spectrogram that shows the changes of the spectrum over time.

Additionally you can define various criteria for peak search and display the results on
the frequency domain diagram.

8.2.1 Spectrum Analysis Display

When you activate spectrum analysis display, three windows are displayed: the signal
vs. time at the top, the spectrogram in the middle and the result of the frequency analy-
sis at the bottom.

The spectrogram displays the frequency over time. The oldest spectrum is on the top,
while the current spectrum is the bottom line. The magnitude can be color-coded for
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easy interpretation. By default, rainbow colors are used, and the noise floor is dis-
played in blue. Highest magnitudes are shown in red color. If the history and segmen-
ted memory option R&S RTM-K15 is installed, you can browse the spectrums. The
spectrogram marker shows the time of the acquisition and makes it possible to load the
corresponding time and frequency waveforms onto the screen. The displayed spec-
trum is marked by a white line in the spectrogram. All analysis functions of the
R&S RTM are available to evaluate the loaded frequency waveforms.

Unlike basic FFT, you can select the source waveform of the spectrum analysis, and
you can also analyze reference and math waveforms.

You can enable and disable the display of each diagram separately by selecting it with
the "Diagram" softkey and enabling/disabling it by pressing the NAVIGATION rotary
knob.

The spectrum analysis can be restricted to the results for a certain time base extract
and to a specified frequency range. The time range is indicated by white lines in the
time domain diagram.

Move the focus between the time domain, the spectogram, the FFT time base extract
(time section) and the FFT frequency range (FFT Control) by pressing the horizontal
SCALE rotary knob. The currently selected screen element is highlighted and dis-
played in the information bar. Depending on the selection, the functions of the SCALE
and POSITION rotary knobs may change.

The usual channel parameters are displayed in the information bar above the Y(t)-win-
dow (see the general display information described in the "Getting Started" manual).

In addition, spectrum-specific parameters are indicated in the information bar above
the spectrum window. The following information is given there:

 Description Setting

1 Width of the time base extract for which FFT is calculated YT-Window

2 Position of time base extract Position

3 Width of the displayed frequency range Span

4 Center of the displayed frequency range Center

5 Resolution bandwidth RBW

6 Minimum level of the selected color scale Display > Minimum

7 The color-level mapping for the selected color scale Display > Spectr. Color /
Freq.Dom.Color

8 Maximum level of the selected color scale Display > Maximum

9 Focus of the horizontal SCALE knob Press SCALE
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8.2.2 Displaying and Configuring Spectrum Analysis

To display the spectrum analysis diagrams

► Press the FFT key or press the TOOLS key and then select "Spectrum Analysis".

The FFT key lights up and three windows are displayed: the signal vs. time at the
top, the spectogram in the middle and the frequency waveform at the bottom.

To deactivate the spectrum analysis display

► If the main "Spectrum Analysis" menu is open, press the FFT key once.
If a submenu is open, for example the "Marker" menu, press the the FFT key twice.

The FFT key is no longer illuminated and time domain waveform is displayed.

To enable/disable the display of a diagram

1. Press "Diagram" and select the diagram you want to enable/disable. The selection
is indicated by a green check mark nexto to the diagram name.

2. Press the NAVIGATION rotary knob to enable/disable the display of the selected
diagram window.

To configure the spectrum analysis window numerically

Alternatively to configuring the spectrum analysis window numerically via the softkeys,
you can use the rotary knobs to change the settings graphically, see "To configure the
spectrum analysis diagram graphically" on page 146.

1. In the "Spectrum Analysis" menu, press "More 1|2" and then "Freq. Domain".

2. Define the time base extract for which the spectrum is to be calculated and dis-
played. The extract is defined by its width and position.

a) Press "YT-Window" to define the width of the time base extract.
b) Press "Position" to define the position of the time base extract. The position is

defined as an offset of the center of the extract range to the 0s reference point.

The time base extract is indicated by a white frame in the time domain window. The
width (W) and position (P) are indicated in the information bar beneath the time
domain window.

3. Press "Y-Scale" to define the scaling of the frequency amplitudes.

4. Define the frequency range to be displayed in the frequency domain window. The
range is defined as (Center - Span/2) to (Center + Span/2). For details see Span
and Center Frequency.
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a) Press "Span" to define the width of the frequency range.
b) Press "Center" to define the center frequency of the range.
c) Press "RBW" to define the resolution bandwidth.

To configure the spectrum analysis diagram graphically

1. Define the time base extract for which thespectrum analysis is to be calculated and
displayed. The extract is defined by its width and position .

a) Press the horizontal SCALE rotary knob to select the time base extract
("W"/"P" settings are highlighted).

b) Turn the horizontal SCALE rotary knob to define the width of the time base
extract. Turn the knob counter-clockwise to enlarge the extract, or clockwise to
decrease it.

c) Turn the horizontal POSITION rotary knob to define the position of the time
base extract. Turn the knob counter-clockwise to move the trigger time to the
left, or clockwise to move it to the right.

2. Define the frequency range to be displayed in the frequency domain diagram. The
range is defined as (Center - Span/2) to (Center + Span/2). For details see Span
and Center Frequency.

a) Press the horizontal SCALE rotary knob to select the frequency range
("Span"/"Center" settings are highlighted).

b) Turn the horizontal SCALE rotary knob to define the span of the frequency
range. Turn the knob counter-clockwise to enlarge the span, or clockwise to
decrease it.

c) Turn the horizontal POSITION rotary knob to define the center of the frequency
range. Turn the knob counter-clockwise to move the center to the left, or clock-
wise to move it to the right.

d) Turn the vertical SCALE rotary knob to define the scaling of the frequency
amplitudes. Turn the knob counter-clockwise to decrease the amplitudes, or
clockwise to enlarge them.

To configure the markers

1. Press "Marker" in the "Spectrum Analysis" menu.

2. Press "Enable" to display the markers.

3. Press "Source" and select the source waveform for the marker selection.

4. Press "Setup" and open a menu for setting up the markers.

a) Set the "Min. Level" for the marker detection.
b) If required enable the "Advanced peak setup" and set the "Excursion", "Max.

Width" and "Distance".

5. If required set a reference marker with "R-Marker".

6. Press "Marker Table" and press "View marker table" to see the results.
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To configure the diagram display

1. Press "Display" in the "Spectrum Analysis" menu.

2. Press "Spectr. Color"/ "Freq.Dom. Color" and select the desired color scale.

3. Define the level range of the selected color scale with "Minimum" and "Maximum".

To configure the diagrams with AUTOSET

A prerequisite is that a periodical signal is input.

1. Press the FFT key to activate the spectrum analysis.

2. Press the "Autoset" button on the left of the display. The following settings are
made automatically:

a) The "Time Base " is set to ~5 periods per Division
b) The "Span" is set to 20*"Trigger Frequency".
c) The "Center" is set to "Span"/2.
d) The settings of the resolution bandwidth are dependent on the selected "RBW"

mode.
If "RBW > Auto", then an automatic "Span":"RBW" ratio will be set.
If "RBW > Manual", then the Time Window will be around 80 % of the
shown"Time Range".

e) The settings of the "Y-Scaling"/"Position" depend on the selected "Y-Scaling"
settings of the spectrum.
If "Y-Scaling > dBm/dBv", the "Position" is set to 3 DIV and the scaling is set to
20dBm/DIV.
If "Y-Scaling > Veff", the "Position" is set to - 3 DIV and the scaling is set to
(channel scaling)/2.

8.2.3 Spectrum Analysis Settings

If option R&S RTM-K18 is installed, the FFT key enables the spectrum analysis mode
and opens the spectrum analysis menu.

See also:
● Chapter 8.2.1, "Spectrum Analysis Display", on page 143
● Chapter 8.2.2, "Displaying and Configuring Spectrum Analysis", on page 145
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8.2.3.1 General Settings

Diagram.......................................................................................................................148
Source.........................................................................................................................148
Window....................................................................................................................... 148

└ Hanning.........................................................................................................149
└ Hamming.......................................................................................................149
└ Blackman...................................................................................................... 149
└ Flat top..........................................................................................................149
└ Rectangle......................................................................................................149

Y-Scaling.....................................................................................................................149
Waveform....................................................................................................................150
Marker......................................................................................................................... 150
More 1|2...................................................................................................................... 150
Freq. Domain.............................................................................................................. 150
Time Domain...............................................................................................................150
Display........................................................................................................................ 150

Diagram
Selects the diagram that should be focused on. Simultaneously you can select which
diagrams you want to display on the screen by enabling/ disabling it.

The time domain diagram shows the signal vs. time. You can restrict the result to a
certain time base.

The spectrogram displays a history of the spectral changes.

The frequency domain diagram allows the display of different waveforms and can show
the results of the marker search.

Remote command: 
SPECtrum:DIAGram:FDOMain[:ENABle] on page 523
SPECtrum:DIAGram:SPECtrogram[:ENABle] on page 523
SPECtrum:DIAGram:TDOMain[:ENABle] on page 523

Source
Selects the source for the spectrum analysis.

Remote command: 
SPECtrum:SOURce on page 509

Window
Window functions are multiplied with the input values and thus can improve the dis-
play.

If discontinuities occur at the borders of the measurement interval, the algorithm inter-
prets such discontinuities as a sudden edge, which can distort the result. For bell-sha-
ped functions, the border values are multiplied with smaller values and thus have less
influence on the result.

Remote command: 
FFT: CALCulate:MATH<m>:FFT:WINDow:TYPE on page 501
Spectrum analysis: SPECtrum:FREQuency:WINDow:TYPE on page 510
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Hanning ← Window
The Hanning window is bell shaped. Unlike the Hamming window, its value is zero at
the borders of the measuring interval. Thus, the noise level within the spectrum is
reduced and the width of the spectral lines enlarges. Use this window to measure
amplitudes of a periodical signal precisely.

Hamming ← Window
The Hamming window is bell shaped. Its value is not zero at the borders of the mea-
suring interval. Thus, the noise level inside the spectrum is higher than Hanning or
Blackman, but smaller than the rectangular window. The width of the spectral lines is
thinner than the other bell-shaped functions. Use this window to measure amplitudes of
a periodical signal precisely.

Blackman ← Window
The Blackman window is bell shaped and has the steepest fall in its wave shape of all
other available functions. Its value is zero at both borders of the measuring interval. In
the Blackman window the amplitudes can be measured very precisely. However, deter-
mining the frequency is more difficult. Use this window to measure amplitudes of a
periodical signal precisely.

Flat top ← Window
The flat top window has low amplitude measurement errors but a poor frequency reso-
lution. Use this window for accurate single-tone measurements and for measurement
of amplitudes of sinusoidal frequency components.

Rectangle ← Window
The rectangular window multiplies all points by one. The result is a high frequency
accuracy with thin spectral lines, but also with increased noise. Use this function pref-
erably with pulse response tests where start and end values are zero.

Y-Scaling
Defines the scaling unit for the y-axis. The display values are valid for 50Ω termination
impendance. To achieve this, the existing internal terminating resistor can be used, or
an external terminating resistor can be connected parallel to the high impedance input.

"dBm" logarithmic scaling; related to 1 mW
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"dBV" logarithmic scaling; related to 1 Veff

"Veff" linear scaling; displays the RMS value of the voltage

Remote command: 
FFT: CALCulate:MATH<m>:FFT:MAGNitude:SCALe on page 503
Spectrum analysis: SPECtrum:FREQuency:MAGNitude:SCALe on page 509

Waveform
Opens a menu for setting the waveforms.

Marker
Opens a menu for setting the markers.

More 1|2
Switches the menu page for the spectrum analysis settings.

Freq. Domain
Opens a menu for setting the frequency domain diagram.

Time Domain
Opens a menu for setting the time domain diagram.

Display
Defines the settings for the display of the diagrams.

8.2.3.2 Marker Settings

Using the marker search, you can find up to 100 peaks in the spectrum. A detailed def-
inition of the search criteria can be done in the marker menu.

● General Marker Settings....................................................................................... 150
● Setup Settings.......................................................................................................151
● R-Marker............................................................................................................... 153
● Marker Table.........................................................................................................154

General Marker Settings

Enable......................................................................................................................... 150
Source.........................................................................................................................151
Setup...........................................................................................................................151
R-Marker..................................................................................................................... 151
R-Mark. to Center........................................................................................................151
Marker table................................................................................................................ 151

Enable
Enables the usage of markers.
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Remote command: 
SPECtrum:MARKer[:ENABle] on page 512

Source
Defines the source for the marker search function.

Remote command: 
SPECtrum:MARKer:SOURce on page 511

Setup
Opens a menu for defining the settings for the markers.

R-Marker
Defines the settings for the reference marker.

Remote command: 
SPECtrum:MARKer:RMARker? on page 515

R-Mark. to Center
Centers the display to the reference marker.

Marker table
Defines the settings for the marker table. The result values include the result number
ant the corresponding frequency and magnitude values.

Setup Settings

Min. Level....................................................................................................................151
Advanced Peak Setup.................................................................................................151
Excursion.................................................................................................................... 152
Max. Width.................................................................................................................. 152
Distance...................................................................................................................... 153
Info.............................................................................................................................. 153

Min. Level
Defines the minimum level for marker peak detection. Peaks with a level below this
value will not be listed in the "Marker Table".

Remote command: 
SPECtrum:MARKer:SETup:MLEVel on page 512

Advanced Peak Setup
Enables a more precise definition of the marker settings.

For a peak to be detected, the "Excursion", "Max width" and "Distance" have to be
within the defined limits, see Figure 8-3. If the conditions are not fulfilled, the peak is
not considered, see Figure 8-4 and Figure 8-5.
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Min. level

E
xc

ur
si

on

Max. width

Peak width Distance

Figure 8-3: Detected peak within the setting ranges

Remote command: 
SPECtrum:MARKer:SETup:MMODe on page 512

Excursion
Defines a level difference between two subsequent peaks that has to be kept, for the
peak to be detected.

Min. level

Ex
cu

rs
io

n

Max. width

Peak width Distance

Figure 8-4: Ignored peak, distance and excursion not kept

Remote command: 
SPECtrum:MARKer:SETup:EXCursion on page 512

Max. Width
Defines the maximum width, that a peak can have for it to be detected.
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Min. level
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Max. width

Peak width

Figure 8-5: Ignored peak, peak width out of setting range

Remote command: 
SPECtrum:MARKer:SETup:MWIDth on page 513

Distance
Defines a distance between two subsequent peaks that has to be kept, for the peak to
be detected.

Remote command: 
SPECtrum:MARKer:SETup:DISTance on page 512

Info
Enables the display of the marker info window. It shows information about the current
settings that are considered for the marker detection.

R-Marker

Defines the settings for the reference marker. The reference marker is displayed on the
waveform as a filled orange triangle.

R-Marker..................................................................................................................... 153
Index........................................................................................................................... 154
Frequency................................................................................................................... 154
Span............................................................................................................................154
Center to Screen......................................................................................................... 154
Center to Highest Peak............................................................................................... 154

R-Marker
Defines the mode for the selection of the reference peak.

"Off" Disables the reference marker.

"Indicated" The reference peak is set to the peak with a selected index number.
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"Range" The peak with the highest level within the selected range is set as the
reference marker.

Remote command: 
SPECtrum:MARKer:REFerence:SETup:MODE on page 513

Index
Defines the index number of the reference marker, when "R-Marker" is set to "Indica-
ted".

Remote command: 
SPECtrum:MARKer:REFerence:SETup:INDex on page 513

Frequency
Defines the center frequency for the capture range.

Remote command: 
SPECtrum:MARKer:REFerence:SETup:FREQuency on page 513

Span
Defines the span range, which is defined as the ratio of the capture range and the
width of the specified reference mode, when "R-Marker" is set to "Range".

Remote command: 
SPECtrum:MARKer:REFerence:SETup:SPAN on page 513

Center to Screen
Centers the display to the center frequency.

Center to Highest Peak
Centers the display to the highest detected peak.

Marker Table

Defines the settings for the marker table.

The result values include the result number ant the corresponding frequency and mag-
nitude. In the marker table you can select up to 10 peaks to be displayed with their val-
ues on the waveform. A green check mark next to the peak on the marker table indi-
cates which markers are selected. The marker is then indicated on the waveform by a
red triangle.
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Remote commands, result:

● SPECtrum:MARKer:RCOunt? on page 514
● SPECtrum:MARKer:RESult<n>? on page 515
● SPECtrum:MARKer:RESult<n>:ALL? on page 516
● SPECtrum:MARKer:RESult<n>:ALL:DELTa? on page 516
● SPECtrum:MARKer:RESult<n>:DELTa? on page 516
● SPECtrum:MARKer:RESult<n>:FREQuency? on page 516
● SPECtrum:MARKer:RESult<n>:FREQuency:DELTa? on page 517
● SPECtrum:MARKer:RESult<n>:LEVel? on page 517
● SPECtrum:MARKer:RESult<n>:LEVel:DELTa? on page 517

View marker table....................................................................................................... 155
Clean all Marker.......................................................................................................... 156
Reference....................................................................................................................156
Waveform marker........................................................................................................156
Position....................................................................................................................... 156

View marker table
Enables/disables the display of the marker table.
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Remote command: 
SPECtrum:MARKer:RTABle:ENABle on page 514

Clean all Marker
Deletes all results from the marker table.

Reference
Defines the mode for the displayed results in the marker table. You can select to show
the absolute frequency and level value of the markers or the delta values of the fre-
quency and level in comparison to the reference marker.

Remote command: 
SPECtrum:MARKer:RMODe on page 514

Waveform marker
Enables the display of the selected markers on the waveform diagram. You can display
the index number or the result values of the peak.

Remote command: 
SPECtrum:MARKer:DISPlay on page 511

Position
Defines the position of the table on the screen: top right, bottom right, or full screen.
With full screen setting, the table covers nearly the complete righthand half of the
screen.

8.2.3.3 Waveform Settings

In the waveform menu you can select which waveforms should be shown in the dia-
gram. You can enable all types of waveforms simultaneously.

Spectrum.....................................................................................................................156
Min Hold...................................................................................................................... 157
Max Hold..................................................................................................................... 157
Average.......................................................................................................................157
No. of Averages.......................................................................................................... 158
Reset...........................................................................................................................158

Spectrum
Displays the spectrum.

Remote command: 
SPECtrum:WAVeform:SPECtrum[:ENABle] on page 520
SPECtrum:WAVeform:SPECtrum:DATA? on page 520
SPECtrum:WAVeform:SPECtrum:DATA:HEADer? on page 520
SPECtrum:WAVeform:SPECtrum:DATA:POINts? on page 521
SPECtrum:WAVeform:SPECtrum:DATA:XINCrement? on page 521

 

Spectrum Analysis (Option R&S RTM-K18)



Spectrum AnalysisR&S®RTM2000

157User Manual 1317.4726.02 ─ 10

SPECtrum:WAVeform:SPECtrum:DATA:XORigin? on page 521
SPECtrum:WAVeform:SPECtrum:DATA:YINCrement? on page 521
SPECtrum:WAVeform:SPECtrum:DATA:YORigin? on page 522
SPECtrum:WAVeform:SPECtrum:DATA:YRESolution? on page 522

Min Hold
Displays a waveform of the minimum amplitude spectrum.

Remote command: 
SPECtrum:WAVeform:MINimum[:ENABle] on page 520
SPECtrum:WAVeform:MINimum:DATA? on page 520
SPECtrum:WAVeform:MINimum:DATA:HEADer? on page 520
SPECtrum:WAVeform:MINimum:DATA:POINts? on page 521
SPECtrum:WAVeform:MINimum:DATA:XINCrement? on page 521
SPECtrum:WAVeform:MINimum:DATA:XORigin? on page 521
SPECtrum:WAVeform:MINimum:DATA:YINCrement? on page 521
SPECtrum:WAVeform:MINimum:DATA:YORigin? on page 522
SPECtrum:WAVeform:MINimum:DATA:YRESolution? on page 522

Max Hold
Displays a waveform of the maximum amplitude spectrum.

Remote command: 
SPECtrum:WAVeform:MAXimum[:ENABle] on page 520
SPECtrum:WAVeform:MAXimum:DATA? on page 520
SPECtrum:WAVeform:MAXimum:DATA:HEADer? on page 520
SPECtrum:WAVeform:MAXimum:DATA:POINts? on page 521
SPECtrum:WAVeform:MAXimum:DATA:XINCrement? on page 521
SPECtrum:WAVeform:MAXimum:DATA:XORigin? on page 521
SPECtrum:WAVeform:MAXimum:DATA:YINCrement? on page 521
SPECtrum:WAVeform:MAXimum:DATA:YORigin? on page 521
SPECtrum:WAVeform:MAXimum:DATA:YRESolution? on page 522

Average
Displays an average waveform. It is calculated as the average of the number of spec-
trums defined with "No. of Averages".

Remote command: 
SPECtrum:WAVeform:AVERage[:ENABle] on page 520
SPECtrum:WAVeform:AVERage:DATA? on page 520
SPECtrum:WAVeform:AVERage:DATA:HEADer? on page 520
SPECtrum:WAVeform:AVERage:DATA:POINts? on page 521
SPECtrum:WAVeform:AVERage:DATA:XINCrement? on page 521
SPECtrum:WAVeform:AVERage:DATA:XORigin? on page 521
SPECtrum:WAVeform:AVERage:DATA:YINCrement? on page 521
SPECtrum:WAVeform:AVERage:DATA:YORigin? on page 521
SPECtrum:WAVeform:AVERage:DATA:YRESolution? on page 522
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No. of Averages
Defines the number of spectrums used for averaging, when the "Average" waveform is
enabled.

Reset
Resets the "Min", "Max" and "Average" to the current waveform.

8.2.3.4 Spectrogram Settings

Define the settings for the spectrogram diagram.

Cur. Acquisition........................................................................................................... 158
Zoom........................................................................................................................... 158
Reset...........................................................................................................................158

Cur. Acquisition
Defines the current acquisition that is considered for the measurement.

Zoom
Defines a zoom factor for the spectrogram.

Remote command: 
SPECtrum:SPECtrogram:SCALe on page 511

Reset
Resets the current spectrogram and starts a new recording of information.

Remote command: 
SPECtrum:SPECtrogram:RESet on page 511

8.2.3.5 Time Domain Settings

In the time domain menu you can define the settings for the time domain diagram.

Position....................................................................................................................... 158
Time Range.................................................................................................................159
Y-Scale........................................................................................................................159
Y-Position....................................................................................................................159
Main Time Base.......................................................................................................... 159
Trigger Offset.............................................................................................................. 159

Position
Defines the time position of the analyzed time range.

Remote command: 
SPECtrum:TIME:POSition on page 519
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Time Range
Defines the time range for the time domain diagram.

Remote command: 
SPECtrum:TIME:RANGe on page 519

Y-Scale
Changes the vertical scaling of the Y(t)-window (channel scaling).

Note: If the Y(t)-window is selected (indicated by a white border), the Y-Scale can be
adjusted using the vertical SCALE rotary knob.

See "SCALE, Y-Scale" on page 36.

Remote command: 
FFT:CHANnel<m>:SCALe on page 423
Spectrum analysis: SPECtrum:FREQuency:SCALe on page 510

Y-Position
Defines the vertical position of the time axis in the Y(t)-window, in divisions.

Note: If the Y(t)-window is selected (indicated by a white border), the Y-Position can
be adjusted using the vertical POSITION rotary knob.

Remote command: 
CHANnel<m>:POSition on page 424

Main Time Base
Defines the scaling for the time base in the (original) Y(t)-window in seconds per divi-
sion. The scaling is indicated by "TB" in the information bar above the window.

Note: If "Time Control" is selected, the main time base can be adjusted using the hori-
zontal SCALE rotary knob.

See also "SCALE" on page 29, "To configure the original Y(t)-diagram" on page 89 and
Figure 8-2.

Remote command: 
TIMebase:SCALe on page 414

Trigger Offset
Defines the horizontal position of the trigger point in relation to the reference point - to
the zero point of the grid. The value is indicated by "T" in the information bar above the
window.

The reference point is set with SETUP >"Time Reference".

Note: If a zoom or FFT window is displayed and "Time Control" is selected, the trigger
offset can be adjusted using the horizontal POSITION rotary knob.
See also:
● "POSITION" on page 29
● "Time Reference" on page 386
● "To configure the original Y(t)-diagram" on page 89

Remote command: 
TIMebase:POSition on page 416
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8.2.3.6 Frequency Domain Settings

In the time domain menu you can define the settings for the frequency domain dia-
gram.

Center Frequency....................................................................................................... 160
Span............................................................................................................................160
RBW............................................................................................................................161
Set Full Span...............................................................................................................161

Center Frequency
Defines the position of the displayed frequency domain, which is (Center Frequency -
Span/2) to (Center Frequency + Span/2). The width of the domain is defined using the
"Span" function.

Note: If the Spectrum analysis frequency range is selected ("Span"/"Center Fre-
quency" is highlighted), the width of the span can be adjusted using the horizontal
POSITION rotary knob.

Remote command: 
SPECtrum:FREQuency:CENTer on page 517

Span
The span is specified in Hertz and defines the width of the displayed frequency range,
which is (Center Frequency - Span/2) to (Center Frequency + Span/2). The position of
the span is defined using the "Center Frequency" function.

Note: If the spectrum analysis frequency range is selected ("Span"/"Center Frequency"
is highlighted), the width of the span can be adjusted using the horizontal SCALE
rotary knob.

Remote command: 
SPECtrum:FREQuency:SPAN on page 518
SPECtrum:FREQuency:FULLspan on page 517
SPECtrum:FREQuency:STARt on page 518
SPECtrum:FREQuency:STOP on page 518
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RBW
Sets the resolution bandwidth, the minimum frequency separation at which the individ-
ual components of a spectrum can be distinguished.

Small values result in a high precision, as the distance between two distinguishable
frequencies is small. Higher values decrease the precision, but increase measurement
speed.

In auto mode (default), the instrument sets the RBW to an appropriate value. In manual
mode, you can set the RBW value using the NAVIGATION rotary knob. Press the
"RBW" key to toggle auto and manual mode.

Remote command: 
SPECtrum:FREQuency:BANDwidth[:RESolution]:AUTO on page 518
SPECtrum:FREQuency:BANDwidth[:RESolution]:RATio on page 518
SPECtrum:FREQuency:BANDwidth[:RESolution][:VALue] on page 519

Set Full Span
Performs the spectrum analysis calculation for the full frequency span.

Remote command: 
SPECtrum:FREQuency:FULLspan on page 517

8.2.3.7 Display Settings

In the time display menu you can define the settings for the display of diagrams.

Spectr. Color / Freq.Dom.Color...................................................................................161
Magnitude Mode......................................................................................................... 162
Find Level....................................................................................................................162
Minimum......................................................................................................................162
Maximum.....................................................................................................................162

Spectr. Color / Freq.Dom.Color
Selects the color scale for the display of the waveform in the spectrogram / frequency
domain diagram. Each scale comprises a set of colors, where each color represents a
certain level/frequency of occurrence.

You can set the range of the color scale with "Minimum" and "Maximum".

"Rainbow" The waveform is displayed in the rainbow colors. Blue corresponds to
the low level values while red stands for high ones.

"Temp. Color" The waveform is displayed in the temperature colors. Blue corre-
sponds to the low level values while white stands for high ones.
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"Monochrome" The waveform is displayed in monochrome colors, which depend on
the color of the selected source channel. Black corresponds to the
low level values while the channel color stands for high ones.

Remote command: 
SPECtrum:DIAGram:COLor:SCHeme:FDOMain on page 523
SPECtrum:DIAGram:COLor:SCHeme:SPECtrogramm on page 523

Magnitude Mode
Enables the magnitude dependent coloring of the waveform. The higher the level the
higher the color in the color scale.

When the "Magnitude Mode" is disabled, then the color is depending on the frequency
of occurrence of a value.

Remote command: 
SPECtrum:DIAGram:COLor:MAGNitude:MODE on page 522

Find Level
Sets the level automatically to 0.5 * (MaxPeak – MinPeak). The MinPeak is set in the
noise floor and the MaxPeak is the highest point of the waveform.

Minimum
Defines the level used as a minimum of the color scale selected with "Spectr.
Color"/"Freq.Dom.Color". All level values lower than the minimum will be displayed with
the minimum color.

Remote command: 
SPECtrum:DIAGram:COLor:MINimum[:LEVel] on page 523

Maximum
Defines the level used as a maximum for the color scale selected with "Spectr. Color"/
"Freq.Dom.Color". All level values higher than the maximum will be displayed with the
maximum color.

Remote command: 
SPECtrum:DIAGram:COLor:MAXimum[:LEVel] on page 522
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9 Masks
Masks are used to determine whether the amplitude of a signal remains within speci-
fied limits, e.g. to detect errors or test compliance of digital signals.

9.1 About Masks

9.1.1 Masks

A mask is specified by an upper and a lower limit line. The signal must run inside these
limit lines, otherwise a mask violation occurs.

A new mask is created from an existing signal: Mask limits are created by copying the
waveform, and the limits are moved and stretched. The result is a tolerance tube
around the signal that is used as mask.

Once a mask has been defined, the copied waveform envelope is kept in the instru-
ment until the next mask is defined or loaded. The settings for stretch and move are
not kept. If you want to keep the complete mask definition, or you need more than one
mask, you can save the mask to and load from any storage device - internal memory
or external USB flash device.

It is also possible to copy the saved masks to another storage device with "Export/
Import Masks". In an export/import operation, the name of the target file can be
changed, so you can copy and rename the file in one operation. You can also change
the target file format and convert the data during export/import. To copy a mask, use
FILE >"Import/Export Masks".

See also:
● Chapter 9.1.3, "File Formats for Masks", on page 164
● Chapter 15.3.1.2, "Importing and Exporting Data", on page 369

9.1.2 Mask Testing

The mask test analyzes whether tested signal runs inside the mask. The overall test
result is shown in the results table:

left column = number of tested acquisitions and test duration
middle column = number of passed acquisitions (green) and number of failed acquisitions (red)
right column = percentage share of passed and failed acquisitions

During a mask test, various actions can be executed when mask violations occur: noti-
fication by a sound, stop of acquisition, printout or saving a screenshot, saving the
waveform data.
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Remote commands for mask test results:
● MASK:COUNt? on page 526
● MASK:VCOunt? on page 526
● MASK:RESet:COUNter on page 526

9.1.3 File Formats for Masks

Data of masks is always saved as a succession of pairs of values - lower and upper
limit - and the pairs are written as two consecutive single values. Depending on the file
format, only amplitude values are stored, or the amplitude values are stored together
with their sample index.

Amplitude values are not saved as voltage values but as division values. The minimum
value for evaluation is -5.12 DIV, the maximum is +5.12 DIV. The internal vertical
range of the instrument exceeds the visible vertical range of ±4 DIV.

With export, you can convert the MSK file to CSV, TXT, or BIN formats. Import is pos-
sible for MSK and CSV files.

MSK format

MSK is the specific binary format for masks of the R&S RTM. It contains pairs of ampli-
tude values (in divisions) , their sample indexes and current instrument settings. Thus,
the amplitude values are not related to time and voltage. The data can be loaded back
to the instrument for further use. The format is not intended for analysis outside the
R&S RTM.

CSV format

In a Comma Separated Values text file, the waveform is stored in a two-columned
table. Columns are separated by a comma, and the lines are separated by line breaks
\r\n (0x0D 0x0A).

The first column contains the sample indexes, and the second column contains the
associated amplitude values in divisions. The first line indicates the units of the values
in each column, and the name of the waveform. For each sample index, two values
(minimum and maximum) are written. The range of amplitude values is -5.12 to +5.12
divisions.

The data can be loaded back to the instrument for further use.

Example: CSV file

[Sa],MSK1[DIV]
0.000E+00,-3.273E+00
0.000E+00,-7.831E-01
1.000E+00,-3.313E+00
1.000E+00,-8.232E-01
2.000E+00,-3.273E+00
2.000E+00,-8.232E-01
3.000E+00,-3.273E+00
3.000E+00,-7.831E-01
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4.000E+00,-3.273E+00
4.000E+00,-7.831E-01
5.000E+00,-3.313E+00
5.000E+00,-8.232E-01
6.000E+00,-3.273E+00
6.000E+00,-8.232E-01
7.000E+00,-3.273E+00
7.000E+00,-7.831E-01
8.000E+00,-3.313E+00
8.000E+00,-7.831E-01
9.000E+00,-3.273E+00
9.000E+00,-7.831E-01
1.000E+01,-3.273E+00
1.000E+01,-8.232E-01
...

At export, the sample indexes are written in scientific notification.

If you create a mask manually in a CSV file, you can write the indexes simply as inter-
gers. The file should contain 1000 pairs of min-max values.

TXT format

TXT files are ASCII files that contain only amplitude values but no time values. Ampli-
tude values are separated by commas. Pairs of values are listed as two subsequent
single values, without any identification. Amplitude values are given in scientific nota-
tion. There is no comma at the end of the file.

Amplitude values are given in decimal fractions.

Example: TXT file

4.00,4.20,4.05,4.25,4.08,4.28,....., -4.05,-4.25,-4.00,-4.20

BIN format

BIN files contain only binary amplitude values but no time values. Each value has a
word size of 8, or 16, or 32 bit, the word size is the same throughout the file.

You can set the word order: BIN MSBF saves data in Big Endian order - beginning with
the MSB (Most Significant Byte) and ending with the LSB (Least Significant Byte). BIN
LSBF saves data beginning with the LSB and ending with the MSB. Pairs of values are
listed as two subsequent single values, without any identification.

FLT format

FLT files contain amplitude values in float format, where 4 successive bytes are saved
in a 32-bit float value.

You can set the word order: FLT MSBF saves data in Big Endian order - beginning
with the MSB (Most Significant Byte) and ending with the LSB (Least Significant Byte).
FLT LSBF saves data beginning with the LSB and ending with the MSB.
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9.2 Working with Masks

Masks define a frame with which you can compare the signal values. You can load
pre-configured masks or define your own masks based on existing waveforms. When
you perform a test, you can define which actions are to be taken upon violation of the
mask limits.

Masks are displayed in the color used for reference waveforms.

9.2.1 Creating New Masks

You create a new mask based on a channel waveform, then optimize it by changing its
position and proportions, and save it.

1. Select and adjust the channel waveform that will be used as basis for the mask,
and run continuous acquisition.

2. Press TOOLS.

3. Press "Masks Tests"

The selected waveform is displayed with its envelope, other waveforms are
switched off in masks mode.

4. Press "New Mask".

5. Press "Copy Channel" to create the new mask.
The mask is created from the envelope and displayed in the color used for refer-
ence waveforms.
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6. To change the width of the waveform in vertical direction, press "Width Y" and turn
the "Navigation" rotary knob.
The specified factor in divisions is added to the y-values of the upper mask limit
and subtracted from the y-values of the lower mask limit. Thus, the upper half of
the mask is pulled upwards, the lower half is pulled down.

7. Similarly, to change the width of the waveform in horizontal direction, press "Width
X" and turn the "Navigation" rotary knob.
The left half of the mask is pulled to the left, the right half is pulled to the right.
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8. To move the mask vertically on the screen, press "Y-Position" and turn the "Navi-
gation" rotary knob to change the y-position.
The current position is indicated as an offset from the center in divisions; a positive
value indicates the waveform was moved upwards; a negative value indicates the
waveform was moved down.

9. To change the scaling of the mask in y-direction, press "Stretch Y" and turn the
"Navigation" rotary knob.
Turn the knob clockwise to increase the factor, or counterclockwise to decrease
the factor. A value over 100% stretches the amplitudes; a value less than 100%
compresses the amplitudes.

10. Save the new mask:

a) Press "Save".
b) Define the storage settings as described for waveforms in Chapter 15.3.1.1,

"Configuring Storage Locations", on page 368.
c) Press "Save".
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9.2.2 Loading Masks

You can load mask data from MSK or CSV files from any storage device.

To copy a mask, use FILE >"Import/Export Masks". For import/export procedure, see
Chapter 15.3.1.2, "Importing and Exporting Data", on page 369.

1. Press TOOLS > "Masks Tests" to display the "Mask Test" menu.

2. Press "Load Mask".

The "Load" menu and a file explorer is displayed.

3. Press "Storage" and select the storage device (internal directory or USB flash drive
connected to front or rear panel).

4. Select the directory and then the file that contains the mask. Use the "Navigation"
knob to scroll through the directories. To change the directory, scroll to the name of
the directory and press the knob, or press "Change dir.".

5. Press "Load".

The selected mask is displayed on the screen.

9.2.3 Performing a Mask Test

Using a mask test you can detect limit violations of the measured signal compared to a
pre-defined mask.

To perform a mask test

1. Seet up the waveform as usual.

2. Press TOOLS > "Masks Tests" to display the "Mask Test" menu.

3. Create a mask, or load an existing mask.

See:
● Chapter 9.2.1, "Creating New Masks", on page 166
● Chapter 9.2.2, "Loading Masks", on page 169

4. Press "Actions" to define what happens when a violation occurs. Select one or
more of the available actions by pressing the corresponding softkey and define
when the action will be executed.
See: "Actions" on page 172.

5. Press "Test" to start the mask test.

The mask test is performed, i.e. the data from the active channel is compared to
the mask.
If the mask limits are exceeded, the specified action is taken. The overall result is
shown in the results table:
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6. Press "Pause" to stop testing temporarily without closing the "Masks" menu.
Press "Pause" again to continue the test.

7. Press "Masks Test Off" to turn off the mask test and exit the "Mask" menu.

9.3 Reference for MASKS key

Masks are used for error detection and compliance tests of digital signals.

You can:
● run mask tests.
● configure actions triggered by mask violation.
● configure new masks based on channel signals.

To start a mask configuration and test, press the TOOLS key and "Masks Test".

MASKS........................................................................................................................170
Test............................................................................................................................. 171
Pause.......................................................................................................................... 171
New Mask................................................................................................................... 171

└ Copy Channel............................................................................................... 171
└ Y-Position......................................................................................................171
└ Stretch Y....................................................................................................... 171
└ Width Y......................................................................................................... 172
└ Width X......................................................................................................... 172
└ Save..............................................................................................................172

Load Mask...................................................................................................................172
Actions........................................................................................................................ 172

└ Sound, Stop, Screenshot, Print, Waveform, Pulse....................................... 173
└ Polarity..........................................................................................................173
└ Pulse width....................................................................................................173

Masks Test Off............................................................................................................ 174

MASKS
Opens the "Masks" menu to perform a mask test on the selected waveform. Masks are
used for error detection and compliance tests of digital signals.

You can:
● run mask tests,
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● configure new masks besed on channel signals,
● configure actions triggered by mask violation.

Test
Performs a mask test for the selected signal, i.e. the signal's amplitudes are compared
with the specified mask. If the amplitude exceeds the limits of the mask, a violation is
detected.

Which action is to be taken when a violation is detected is defined using the Actions
softkey. See also: Chapter 9.2.3, "Performing a Mask Test", on page 169.

Remote command: 
MASK:TEST on page 524

Pause
Temporarily stops the mask test without closing the "Masks" menu. Counts are not
deleted, and the actions cannot be changed during a pause.

Remote command: 
MASK:TEST on page 524

New Mask
Opens a submenu to define a new mask for testing.

See also: Chapter 9.2.1, "Creating New Masks", on page 166

Copy Channel ← New Mask
Creates a new mask from the envelope waveform of the selected channel and stores it
in the instrument.

Remote command: 
MASK:CHCopy on page 525

Y-Position ← New Mask
Moves the mask vertically within the display. Turn the "Navigation" rotary knob to
change the y-position.

The current position is indicated as an offset from the center in divisions; a positive
value indicates the waveform was moved upwards; a negative value indicates the
waveform was moved down.

Remote command: 
MASK:YPOSition on page 525

Stretch Y ← New Mask
Changes the vertical scaling to stretch the mask in y-direction.

Turn the "Navigation" rotary knob clockwise to increase the factor, or counterclockwise
to decrease the factor. A value over 100% stretches the amplitudes; a value less than
100% compresses the amplitudes.
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Remote command: 
MASK:YSCale on page 525

Width Y ← New Mask
Changes the width of the mask in vertical direction.

The specified number of divisions is added to the y-values of the upper mask limit and
subtracted from the y-values of the lower mask limit. Thus, the upper half of the mask
is pulled upwards, the lower half is pulled down, and the overall height of the mask is
twice the "Width Y".

Remote command: 
MASK:YWIDth on page 526

Width X ← New Mask
Changes the width of the mask in horizontal direction.

The specified factor in divisions is added to the positive x-values and subtracted from
the negative x-values of the mask limits in relation to the mask center. Thus, the left
half of the mask is pulled to the left, the right half is pulled to the right.

Remote command: 
MASK:XWIDth on page 526

Save ← New Mask
Opens a menu to save the mask in an instrument-specific format. The complete mask
definition - envelope waveform with width, stretch and position settings - is stored.

See "Save Menu" on page 370.

Remote command: 
MASK:SAVE on page 525

Load Mask
Opens a file explorer to select a previously stored mask. The selected mask is loaded
and can be used for a subsequent test.

Remote command: 
MASK:LOAD on page 524

Actions
Opens a submenu to select the actions to be taken when a violation against the mask
limits occurs. For each action, you can define when and how often the action will be
executed.

"Sound" Generates a beep sound.

"Stop" Stops the waveform acquisition.

"Screenshot" Saves a screenshot according to the settings in FILE > "Screen-
shots".
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"Print" Prints a screenshot to a printer connected to the USB connector on
the front or rear panel.

"Waveform" Saves the waveform data according to the settings in FILE > "Wave-
form".

"Pulse" Creates a pulse on the TRIGGER OUTPUT connector.
You can set the Polarity and Pulse width in the "Pulse" submenu.

Remote command: 
MASK:ACTion:SOUNd:EVENt:MODE on page 527
MASK:ACTion:STOP:EVENt:MODE on page 527
MASK:ACTion:SCRSave:EVENt:MODE on page 527
MASK:ACTion:PRINt:EVENt:MODE on page 527
MASK:ACTion:WFMSave:EVENt:MODE on page 527
MASK:ACTion:PULSe:EVENt:MODE on page 527

Sound, Stop, Screenshot, Print, Waveform, Pulse ← Actions
For each action, you can define when and how often the action will be executed.

"Off" No action is executed.

"Each" The selected action is executed on each violation of the mask.

"After n / n" "Single": The selected action is executed once after the n-th violation.
"Cyclic": The selected action is executed repeatedly after each n-th
violation.
Set the execution interval with softkey "n".

Remote command: 
MASK:ACTion:SOUNd:EVENt:COUNt on page 528
MASK:ACTion:STOP:EVENt:COUNt on page 528
MASK:ACTion:SCRSave:EVENt:COUNt on page 528
MASK:ACTion:PRINt:EVENt:COUNt on page 528
MASK:ACTion:WFMSave:EVENt:COUNt on page 528
MASK:ACTion:PULSe:EVENt:COUNt on page 528

Polarity ← Actions
Sets the polarity of the trigger out pulse.

Remote command: 
MASK:ACTion:PULSe:POLarity on page 529

Pulse width ← Actions
Sets the length of the trigger out pulse.

Remote command: 
MASK:ACTion:PULSe:PLENgth on page 529
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Masks Test Off
Turns off the mask test and exits the "Mask" menu.

Remote command: 
MASK:STATe on page 524
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10 Search

10.1 Search Conditions and Results

The search functions of R&S RTM allow to find all edges, pulse widths, peaks, or other
events in an acquisition that match the search conditions. For each search type, spe-
cific settings are available. Searches can be performed on any channel, math or refer-
ence waveform.

Searches can be performed online, that is repeatedly for each new data acquisition in
a running acquisition series, or only once after the acquisition has been stopped. In an
online search, only the displayed data is searched while the search on a stopped
acquisition analyzes the contents of the memory.

The searched time base range can be restricted by defining a gate.

10.1.1 Search Results

Search results are marked in the diagram and listed in a results table with their specific
measurement values. In the table, five results are shown. To navigate the search
results, turn the NAVIGATION knob. See also: "To analyze search results"
on page 177.

Search result markers

For further analysis, for example, for cursor measurements, you can set up to 20 mark-
ers to selected search results. Search result markers are different from usual time-
stamp markers but they are set, navigated and deleted by means of the marker keys,
too. As long as a search is enabled, the search result markers are active. If search is
off, usual markers can be used.

See also:
● "To use markers on search results" on page 178
● Chapter 4.4, "Markers", on page 91
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Figure 10-1: Results of an edge search with R&S RTM

1 = Search results
2 = Marked search results
3 = Selected search result
4 = Search conditions
5 = Number of results, scope of results displayed in the results table
6 = Result values: result number, time value, optional value depending on the search type (voltage, width)

Remote commands:
● SEARch:RCOunt? on page 546
● SEARch:RESult:ALL? on page 545
● SEARch:RESult<n>? on page 546
● EXPort:SEARch:NAME on page 547
● EXPort:SEARch:SAVE on page 547
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10.2 Configuring and Performing Searches

To configure and start a search

Prerequisite: Signal acquisition, reference or math waveform is configured.

1. Press the SEARCH key.

The "Search" menu opens, and the search is enabled.

2. Press "Source" and select the waveform for analysis. All active channel, math, and
reference waveforms are available for selection.

3. Press "Search type" and select the event you want to search for: edge, width,
peaks, runts, specified rise/fall time, setup/hold time, pattern, or protocol-specific
events.

4. Press "Setup" and configure the selected search type.

Details:
● Chapter 10.3.2, "Edge Setup", on page 180
● Chapter 10.3.3, "Width Setup", on page 181
● Chapter 10.3.4, "Peak Setup", on page 182
● Chapter 10.3.5, "Rise/Fall Time Setup", on page 183
● Chapter 10.3.6, "Runt Setup", on page 184
● Chapter 10.3.7, "Data2Clock Search", on page 185
● Chapter 10.3.8, "Pattern Search", on page 187
● Chapter 11.5.5.1, "CAN Search Setup", on page 238, requires option

R&S RTM-K3
● Chapter 11.6.6.1, "LIN Search Setup", on page 249, requires option

R&S RTM-K3

5. To restrict the time base range of the source waveform to be searched, press
"Gate" and define the search area.

6. Start continuous acquisition with RUN CONT.

The online search is performed on the displayed data. Search results are updated
permanently and indicated at the top of the diagram.
Stop the acquisition to search the memory data of the latest acquisition.

To analyze search results

1. Stop the running continuous acquisition, or acquire one waveform with RUN N×
SINGLE.

2. Press "Events".

3. Press "View event table" in the "Events" menu.

The first five search results are listed in a table.

4. To select a search result, turn the NAVIGATION knob.
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The selected result is highlighted in the table and indicated in the diagram with a
magnifier symbol.

5. To see the selected event even if it is outside the display, press "Track event".

The waveform is moved on the display, and the selected result is shown at the time
reference point.

To use markers on search results

1. If the search results table is not visible, press "View event table".

2. To set markers to all results, press "Mark events". If more then 20 results are
found, the first 20 results are marked.

3. To set a marker to a selected result:

a) Select the result in the "Search Event Table" by turning the NAVIGATION
knob.

b) Press the SET CLEAR key.

4. To select a marker:
● Press the NEXT key to move to next marker to the right.
● Press the PREV key to move to previous marker to the left.

5. To delete a single marker, select it an press the SET CLEAR key.

6. To delete all markers, press "Clear all event markers".

To finish a search

1. To close the results table, press "View event table".

2. To stop the search, press "Search".

10.3 Reference for Search Menu

10.3.1 Main Search Menu

The SEARCH key opens the same-named menu where you can search various
events, for example:
● edges
● peaks
● pulses with defined pulse width
● rise time or fall time
● ... and more
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Search
Enables and disables the search mode.

Remote command: 
SEARch:STATe on page 531

Search type
Selects the event you want to search for.

"Edge" Similar to the edge trigger, an edge search result is found when the
waveform passes the given level in the specified direction.
For settings, see Chapter 10.3.2, "Edge Setup", on page 180.

"Width" Similar to the width trigger, a width search finds pulses with an exact
pulse width, or pulses shorter or longer than a given time, or pulses
inside or outside the allowable time range.
For settings, see Chapter 10.3.3, "Width Setup", on page 181

"Peak" The peak search finds pulses exceeding a given peak-to peak value.
For settings, see Chapter 10.3.4, "Peak Setup", on page 182

"Rise/Fall time" The rise or fall time search finds slopes with an exact rise or fall time,
or rise/fall times shorter or longer than a given limit, or rise/fall times
inside or outside the allowable time range.
For settings, see Chapter 10.3.5, "Rise/Fall Time Setup",
on page 183

"Runt" The runt search finds pulses lower than normal in amplitude. The
amplitude crosses the first threshold twice without crossing the sec-
ond one. In addition to the threshold amplitudes, you can define a
time limit for the runt in the same way as for width search: runts with
exact width, shorter or longer than a given time, or runts inside or out-
side the allowable time range.
For settings, see Chapter 10.3.6, "Runt Setup", on page 184

"Data2Clock" The Data2Clock search - also known as setup/hold - finds violation of
setup and hold times. It analyzes the relative timing between two sig-
nals: a data signal and the synchronous clock signal.
Many systems require, that the data signal must be steady for some
time before and after the clock edge. Setup time is the time that the
data signal is steady before clock edge. Hold time is the time that the
data signal is steady after clock edge.
For settings, see Chapter 10.3.7, "Data2Clock Search", on page 185.

"Pattern" The pattern search finds logical combinations of channel states inside
or outside a specified time range. For each channel, its state and
threshold level is defined. The states are combined logically, and the
time of true pattern results is compared with a specified time range.
For settings, see Chapter 10.3.8, "Pattern Search", on page 187.
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"Protocol" The protocol search finds various events in decoded data serial sig-
nals. The events are protocol-specific and correspond to the trigger
settings of the serial protocol.

The following protocol searches are available:
● Chapter 11.5.5, "Search on Decoded CAN Data", on page 238

(option R&S RTM-K3)
● Chapter 11.6.6, "Search on Decoded LIN Data", on page 249

(option R&S RTM-K3)
● Chapter 11.8.6, "Search on Decoded MIL-STD-1553 Data ",

on page 280 (option R&S RTM-K6)
● Chapter 11.9.6, "Search on Decoded ARINC 429 Data",

on page 295 (option R&S RTM-K7)

Remote command: 
SEARch:CONDition on page 531

Setup
Opens the "Setup" menu to define the protocol search parameters.

Source
Selects the waveform to be analyzed with edge, width, peak, rise/fall time, or runt
search. All active channel, math, and reference waveforms are available for selection.

For protocol search, select the configured bus.

Remote command: 
SEARch:SOURce on page 533

Source Setup
Opens a menu to define the source parameters for Data2Clock and Pattern search:
waveform, level, and hysteresis.

Gate
Opens a menu to restrict the time base range of the source waveform for search.

See Chapter 10.3.9, "Gate Menu", on page 189

Events
Opens a menu with functions for result display and marker usage.

See: Chapter 10.3.10, "Events Menu", on page 190

Remote command: 
SEARch:RESDiagram:SHOW on page 545

10.3.2 Edge Setup

Access: SEARCH > "Search type = Edge" > "Setup"

 

Reference for Search Menu



SearchR&S®RTM2000

181User Manual 1317.4726.02 ─ 10

Edge
Sets the slope to be found:

"Rising" Rising edge, a positive voltage change

"Falling" Falling edge, a negative voltage change

"Both" Rising edge and falling edge

Remote command: 
SEARch:TRIGger:EDGE:SLOPe on page 534

Level
Sets the voltage level for the search.

Remote command: 
SEARch:TRIGger:EDGE:LEVel on page 534

Hysteresis
Sets a hysteresis range to the search level in order to avoid unwanted search results
caused by noise oscillation around the level. For a rising edge, the hysteresis is below
the search level. Otherwise, for a falling edge the hysteresis is above the level.

Remote command: 
SEARch:TRIGger:EDGE:LEVel:DELTa on page 534

10.3.3 Width Setup

Access: SEARCH > "Search type = Width" > "Setup"

Polarity
Indicates the polarity of the pulse to be searched for.

Remote command: 
SEARch:TRIGger:WIDTh:POLarity on page 535

Level
Sets the voltage level on which the pulse width is measured.

Remote command: 
SEARch:TRIGger:WIDTh:LEVel on page 535
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Hysteresis
Sets a hysteresis range to the search level in order to avoid unwanted search results
caused by noise oscillation around the level. For a rising edge, the hysteresis is below
the search level. Otherwise, for a falling edge the hysteresis is above the level.

Remote command: 
SEARch:TRIGger:WIDTh:LEVel:DELTa on page 535

Comparison
Sets the condition how the measured pulse width is compared with the given limit(s).

"Greater than" Finds pulses longer than the given "Width".
See also: Width

"Lower than" Finds pulses shorter than the given "Width".

"Equal" Finds pulses equal to the reference "Width" if "Variation" Δt = 0.
If "Variation" ≠ 0, the setting finds pulses within the range width ± Δt.
See also: Variation

"Not equal" Finds pulses unequal to the reference "Width" if "Variation" Δt = 0.
If "Variation" ≠ 0, the setting finds pulses outside the range width ± Δt.

Remote command: 
SEARch:TRIGger:WIDTh:RANGe on page 535

Width
Sets the reference pulse width, the nominal value for comparisons.

Remote command: 
SEARch:TRIGger:WIDTh:WIDTh on page 536

Variation
Sets a range Δt to the reference "Width" if comparison is set to "Equal" or "Not equal".
The instrument finds pulses inside or outside the range width ± Δt.

Remote command: 
SEARch:TRIGger:WIDTh:DELTa on page 536

10.3.4 Peak Setup

Access: SEARCH > "Search type = Peak" > "Setup"

The peak search finds pulses exceeding a given peak-to-peak value (magnitude).

Polarity
Indicates the polarity of the pulse to be searched for.

Remote command: 
SEARch:MEASure:PEAK:POLarity on page 536
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Magnitude
Sets the peak-to-peak limit of the signal.

Remote command: 
SEARch:MEASure:LEVel:PEAK:MAGNitude on page 537

10.3.5 Rise/Fall Time Setup

Access: SEARCH > "Search type = Rise/Fall time" > "Setup"

Edge
Sets the slope to be found:
● "Rising" to search for rise time
● "Falling" to search for fall time
● "Both" to search for rise and fall time

Remote command: 
SEARch:TRIGger:RISetime:SLOPe on page 537

Upper level
Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time
measurement starts or stops depending on the selected slope.

Remote command: 
SEARch:TRIGger:LEVel:RISetime:UPPer on page 538

Lower level
Sets the lower voltage threshold. When the signal crosses this level, the rise time mea-
surement starts or stops depending on the selected slope.

Remote command: 
SEARch:TRIGger:LEVel:RISetime:LOWer on page 537

Comparison
Sets how the measured rise or fall time is compared with the given limit(s).

"Greater than" Finds rise/fall times longer than the given "Rise/Fall time".

"Lower than" Finds rise/fall times shorter than the given "Rise/Fall time".

"Equal" Finds rise/fall times equal to the reference "Rise/Fall time" if "Varia-
tion" Δt = 0.
If "Variation" ≠ 0, the setting finds rise/fall times within the range time
± Δt.
See also: Variation.

 

Reference for Search Menu



SearchR&S®RTM2000

184User Manual 1317.4726.02 ─ 10

"Not equal" Finds rise/fall times unequal to the reference value if "Variation" Δt =
0.
If "Variation" ≠ 0, the setting finds rise/fall times outside the range
time ± Δt.

Remote command: 
SEARch:TRIGger:RISetime:RANGe on page 538

Rise/Fall time
Sets the reference rise or fall time, the nominal value for comparisons.

Remote command: 
SEARch:TRIGger:RISetime:TIME on page 538

Variation
Sets a range Δt to the reference "Rise/Fall time" if comparison is set to "Equal" or "Not
equal". The instrument finds rise/fall times inside or outside the range width ± Δt.

Remote command: 
SEARch:TRIGger:RISetime:DELTa on page 538

10.3.6 Runt Setup

Access: SEARCH > "Search type = Runt" > "Setup"

Polarity
Indicates the polarity of the pulse to be searched for.

Remote command: 
SEARch:TRIGger:RUNT:POLarity on page 539

Upper level
Sets the upper voltage threshold for runt detection. A negative runt crosses the upper
level twice without crossing the lower level.

Remote command: 
SEARch:TRIGger:LEVel:RUNT:UPPer on page 539

Lower level
Sets the lower voltage threshold for runt detection. A positive runt crosses the lower
level twice without crossing the upper level.

Remote command: 
SEARch:TRIGger:LEVel:RUNT:LOWer on page 539

Comparison
Sets the condition how the measured runt width is compared with the given limit(s).

The same conditions as with width search are used, see "Comparison" on page 182.
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Remote command: 
SEARch:TRIGger:RUNT:RANGe on page 540

Width
Sets the reference runt pulse width, the nominal value for comparisons.

Remote command: 
SEARch:TRIGger:RUNT:WIDTh on page 540

Variation
Sets a range Δt to the reference "Width" if comparison is set to "Equal" or "Not equal".
The instrument finds pulses inside or outside the range width ± Δt.

Remote command: 
SEARch:TRIGger:RUNT:DELTa on page 540

10.3.7 Data2Clock Search

The settings for Data2Clock search are provided in two menus: in the "Setup" menu
you define the clock polarity, setup and hold times; and in the "Source Setup" menu
you define the waveforms to be used, and the levels and hysteresis for each source.

10.3.7.1 Data2Clock Source Setup

Access: SEARCH > "Search type = Data2Clock" > "Source Setup"

For Data2Clock search, two sources have to be defined: a clock and a data waveform.
For each waveform, the level and the hysteresis can be set individually.

Clock
Selects the input channel of the clock signal.

Remote command: 
SEARch:TRIGger:DATatoclock:CSOurce on page 541

Data
Selects the input channel of the data signal.

Remote command: 
SEARch:SOURce on page 533

Level
Set the voltage levels for clock and data signals. Clock level and clock edge define the
reference point for setup and hold time. The data lavel defines the point of data transi-
tion.
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Remote command: 
SEARch:TRIGger:DATatoclock:CLEVel on page 541
SEARch:TRIGger:DATatoclock:DLEVel on page 541

Hysteresis
Sets a hysteresis range to the search level of the selected signal in order to avoid
unwanted search results caused by noise oscillation around the level. For a rising
edge, the hysteresis is below the search level. Otherwise, for a falling edge the hyste-
resis is above the level.

Remote command: 
SEARch:TRIGger:DATatoclock:CLEVel:DELTa on page 541
SEARch:TRIGger:DATatoclock:DLEVel:DELTa on page 541

10.3.7.2 Data2Clock Setup

Access: SEARCH > "Search type = Data2Clock" > "Setup"

Polarity
Sets the edge of the clock signal to define the time reference point for the setup and
hold time.

"Rising" Only positive clock edges are considered.

"Falling" Only negative clock edges are considered.

"Either" The clock edges next to the data edge are considered regardless of
the clock slope.

Remote command: 
SEARch:TRIGger:DATatoclock:CEDGe on page 542

Setup Time
Sets the minimum time before the clock edge while the data signal must stay steady
above or below the data level. The setup time can be negative. In this case, the setup
interval starts after the clock edge, and the hold time must be positive and longer than
the absolute value of the setup time.

Remote command: 
SEARch:TRIGger:DATatoclock:STIMe on page 542
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Hold Time
Sets the minimum time after the clock edge while the data signal must stay steady
above or below the data level. The hold time can be negative. In this case, the hold
time ends before the clock edge, and the setup time must be positive and longer than
the absolute value of the hold time.

Remote command: 
SEARch:TRIGger:DATatoclock:HTIMe on page 542

10.3.8 Pattern Search

The settings for pattern search are provided in two menus: in the "Setup" menu you
define the channel states, their logical combination and the time range for keeping up
the true result of the state pattern condition; and in the "Source Setup" menu you
define the threshold levels and hysteresis for each channel.

10.3.8.1 Pattern Source Setup

Access: SEARCH > "Search type = Pattern" > "Source Setup"

For pattern search, up to four analog channels can be used as source. For each ana-
log channel, the threshold level and the hysteresis can be set individually. If MSO
option R&S RTM-B1 is installed, also digital channels can be searched.

Source
Selects the channel for which the pattern search is defined.

Level
Sets the threshold value for the selected source channel. If the signal value is higher
than the trigger level, the signal state is high (1 or true for the boolean logic). Other-
wise, the signal state is considered low (0 or false) if the signal value is below the trig-
ger level.

Remote command: 
SEARch:TRIGger:PATTern:LEVel<n> on page 543

Hysteresis
Sets a hysteresis range to the level of the selected source channel in order to avoid
unwanted search results caused by noise oscillation around the level. For a rising
edge, the hysteresis is below the search level. Otherwise, for a falling edge the hyste-
resis is above the level.

Remote command: 
SEARch:TRIGger:PATTern:LEVel<n>:DELTa on page 543
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10.3.8.2 Pattern Setup

Access: SEARCH > "Search type = Pattern" > "Setup"

For pattern search, up to four analog channels can be used as source. If MSO option
R&S RTM-B1 is installed, also digital channels can be searched. For each channel,
you define the state. The states are combined logically, and the time of true pattern
results is compared with a specified time range. Thus you can find state transitions
inside or outside this time range.

Source
Selects the channel for which the pattern search is defined.

Remote command: 
SEARch:TRIGger:PATTern:SOURce on page 542

State
Sets the state of the selected source channel. The states are:

"H" High: the signal voltage is higher than the threshold level.

"L" Low: the signal voltage is lower than the threshold level.

"X" Don't care: the channel does not affect the search.

Remote command: 
SEARch:TRIGger:PATTern:SOURce on page 542

Combination
Sets the logical combination of the channel states.

"AND" The required states of all channels must appear in the input signal at
the same time.

"Or" At least one of the channels must have the required state.

"NAND" "Not and" operator, at least one of the channels does not have the
required state.

"NOR" "Not or" operator, none of the channels has the required state.

Remote command: 
SEARch:TRIGger:PATTern:FUNCtion on page 543
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Comparison
Sets the condition how the duration of a steady pattern is compared with the given
limit(s). The three settings "Width" "Variation" and "Comparison" define the time range
for keeping up the true result of the state pattern.

The same conditions as with width search are used, see "Comparison" on page 182.

Remote command: 
SEARch:TRIGger:PATTern:WIDTh:RANGe on page 544

Width
Sets the limit time of a steady pattern, the nominal value for comparisons.

Remote command: 
SEARch:TRIGger:PATTern:WIDTh[:WIDTh] on page 544

Variation
Sets a range Δt to the reference "Width" if comparison is set to "Equal" or "Not equal".
The instrument finds true results of the state pattern inside or outside the range width ±
Δt.

Remote command: 
SEARch:TRIGger:PATTern:WIDTh:DELTa on page 544

10.3.9 Gate Menu

Access: SEARCH > "Gate"

The gate restricts the time base of the source waveform to be searched.

Gate
Defines the search area. If the search is performed on a running acquisition series, the
instrument analyzes the displayed data. The search on a stopped acquisition analyzes
the contents of the memory.

"All" Running acquisition: all waveform samples that are displayed on the
screen.
Stopped acquisition: all data samples that are stored in the memory.

"Display" Search is restricted to the time range of the display.

"User" Search is restricted to the time range defined by "Start" and "Stop"
values.

Remote command: 
SEARch:GATE:MODE on page 533
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Start
Sets the start time of the search area in relation to the trigger point.

Remote command: 
SEARch:GATE:ABSolute:START on page 533

Stop
Sets the end time of the search area in relation to the trigger point.

Remote command: 
SEARch:GATE:ABSolute:STOP on page 534

Set to screen
Sets the search gate to the six divisions in the middle of the display. The two division
on the left and on the right are outside the gate.

10.3.10 Events Menu

Access: SEARCH > "Events"

Events are the search results which are marked in the waveform diagram and listed in
the event table. See also: Chapter 10.1.1, "Search Results", on page 175.

View event table
Shows or hides the table of search results.

Remote command: 
SEARch:RESDiagram:SHOW on page 545

Mark events
Sets markers to the first search results. Up to 20 markers can be set at once.

Clear all event marks
Removes all markers from search results.

Track event
If enables, the selected result is moved to the reference point. Thus you can always
see the selected event in the diagram.

Position
Defines the position of the table on the screen: top right, bottom right, or full screen.
With full screen setting, the table covers nearly the complete righthand half of the
screen.
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Save
Opens the "Save" menu to save the search results: Storage, File name, Comment, and
Save.

For a description of these common save functions, see Chapter 15.3.1.3, "General
Storage Settings", on page 370.

Remote command: 
EXPort:SEARch:NAME on page 547
EXPort:SEARch:SAVE on page 547
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11 Protocol Analysis
With the R&S RTM and some additional options, you can analyze the following parallel
and serial protocols:
● SPI (Serial Peripheral Interface with 3 lines) and SSPI (Serial Peripheral Interface

with 2 lines) - requires option R&S RTM-K1
● I²C (Inter-Integrated circuit bus) - requires option R&S RTM-K1
● UART/RS232 (EIA-232 serial interface) - requires option R&S RTM-K2
● CAN (Controller Area Network) - requires option R&S RTM-K3
● LIN (Local Interconnect Network) - requires option R&S RTM-K3
● Audio (I2S, LJ, RJ,TDM) - requires option R&S RTM-K5
● MIL-STD-1553 - requires option R&S RTM-K6
● ARINC 429 - requires option R&S RTM-K7

11.1 Basics of Protocol Analysis

The analysis of serial data consists of three main steps:
● Protocol configuration: Select the protocol type, and configure the input line as well

as the protocol-specific settings
● Decoding: Configure the display of the decoded data and enable decoding. As a

result, the digitized signal data is displayed on the screen together with the deco-
ded content of the messages.
You can scale the signal display and zoom into it to see it in more detail.
You can create and apply label lists for easier identification of the bus nodes on the
display.

● Triggering: You can trigger on various events that are typical for the configured bus
type, for example, on start and stop of messages, on specific addresses, or on
serial patterns.

Analysis can be performed on analog input channels, and - if MSO option R&S RTM-
K1 is installed - on digital channels.

You can configure up to four protocol buses and select one of the configured buses for
analysis.

11.1.1 Configuring Common Protocol Settings

Common settings for all bus types are the logic threshold and the decoding and display
settings.

If the MSO option R&S RTM-B1 is installed, and the digital channels are used for pro-
tocol analysis, the thresholds are set in the "Logic" menu.
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To set the logic threshold for analog channels

Before you start configuration and analysis, check and set the logic thresholds for all
used channels - the voltage values for digitization of analog signals. If the signal value
is higher than the threshold, the signal state is 1. Otherwise, the signal state is consid-
ered 0 if the signal value is below the threshold.

If you want the instrument to set the thresholds based on the analysis of the signals,
press "Find level" in the protocol's "Configuration" menu.

1. Press the CH N key of the required channel.

2. Press the "More" softkey.

3. Press "Threshold" and enter the voltage value.

4. Repeat step 1 to 3 for all channels that are used for protocol analysis.

To configure decoding and data display

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press "Decode" to display the content of the messages in an easily readable and
comprehensible form.

4. Press "Display".

5. Press "Bits" to display the individual bit lines above the decoded data.

6. Press "Data format" to select the decoding format: Binary, Hexadecimal, Decimal
or ASCII.

7. To attach a descriptive label to the decoded bus, enable "Label" and select a pre-
defined text from the "Library", or enter a user-defined text using "Edit Label".

8. To adjust the position and size of decoded information on the screen, use the verti-
cal POSITION and SCALE rotary knobs.

11.1.2 Protocol - Common Settings

The common settings in the "Protocol" menu define the bus type and open further
menus to adjust the display of the decoded bus signal.

Access: PROTOCOL LOGIC > if "Logic" menu is displayed: "Protocol"
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Bus
Selects the bus to be configured.

SPI/SSPI and UART protocols occupy two bus lines (bus 1 and 2 or bus 3 and 4). If
one of these buses is configured, the number of buses is reduced. Bus 2 and/or bus 4
is not available.

Bus Type
Defines the bus or protocol type for analysis. For most types, a special option to the
instrument is required.

Remote command: 
BUS<b>:TYPE on page 548

Configuration
Opens the configuration menu for the selected bus type.

Decode
Decodes the signal according to the protocol configuration and displays the decoded
signal - the content of every message. The decoding format is set with "Display".

Remote command: 
BUS<b>:STATe on page 548

Display
Opens the "Display" menu, where you can:
● Display the bit lines
● Set the decoding format
● Define labels for the bus and its lines
See: Chapter 11.1.3, "Display Settings", on page 194

Frame Table
Opens the "Frame table" menu to configure and display the frame table with detailed
decoded data for each frame of the acquisition.

See: Chapter 11.1.5, "Frame Table: Decode Results", on page 198

11.1.3 Display Settings

Access: PROTOCOL LOGIC > if "Logic" menu is displayed: "Protocol" > "Display"

Bits
Displays the individual bit lines above the decoded bus line.

Remote command: 
BUS<b>:DSIGnals on page 548
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Data format
Sets the decoding format of the data: Binary, Hexadecimal, Decimal, Octal or ASCII.

Remote command: 
BUS<b>:FORMat on page 548

Label
Opens the "Label" menu to define an additional name label for the selected bus.

Label ← Label
Displays or hides the bus label. The bus label is shown on the the right side of the dis-
play. You can enter a label text in several ways:
● Select a predefined string from the "Library".
● Enter a user-defined text using "Edit Label".

Remote command: 
BUS<b>:LABel:STATe on page 549

Library ← Label
Selects a label text from a list of frequently used terms.

Edit Label ← Label
Opens the on-screen keyboard to enter any label text.

The maximum name length is 8 characters, and only ASCII characters provided on the
on-screen keyboard can be used.

Remote command: 
BUS<b>:LABel on page 549

Label List
Opens the "Label list" menu to load, sort, and display a name for each bus node
instead of the address or ID on the decoded results display. So it is easy to identify the
messages of the different bus nodes.

See: Chapter 11.1.4, "Label List", on page 195

11.1.4 Label List

For all protocols using ID or address identification, it is possible to create label lists
containing addresses or IDs, a symbolic name for each node (symbolic label), and
some protocol-specific information. You can load label lists, and activate its usage for
decoding. As a result, an additional "Label" column appears in the "Frame Table", con-
taining the symbolic label. The frame captions of the decoded signal show the symbolic
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label instead of the ID or address values so it is easy to identify the messages of the
different bus nodes.

● Content and Format of the PTT File......................................................................196
● Label List Menu.....................................................................................................197

11.1.4.1 Content and Format of the PTT File

Label lists are stored as PTT (protocol translation table) files. The PTT file format is an
extension of the CSV format (comma separated values). You can edit it with standard
editors, for example, with MS Excel or a text editor.

The PTT file has three types of lines:
● Comment lines begin with a hash character #. A hash character at any other posi-

tion in the line is treated like a standard character.
● Command lines begin with a commercial at character @. An @ character at any

other position in the line is treated like a standard character.
● Standard lines are the lines that not qualify as comment or command lines. They

build the core of the label list.

Command lines

Command lines define the version of the PTT file and the protocol name:
● @FILE_VERSION: must appear exactly once in the file
● @PROTOCOL_NAME: must appear at least once in the file. Thus, one file can

contain several label lists for different protocols.

# --- Start of PTT file
@FILE_VERSION  = 1.0 
@PROTOCOL_NAME = i2c
[... Label list for I2C]
@PROTOCOL_NAME = can
[... Label list for CAN]
# --- End of PTT file

Standard lines

Standard lines define the contents of the label list. The rules for standard lines follow
the csv convention, they are:
● Values are separated by commas
● Space characters following a delimiter are ignored
● Values with a special character (comma, newline, or double quote) must be

enclosed in double quotes
● Text in double quotes must be escaped by double quote characters

The format of the numeric value is indicated by a suffix. The following formats are sup-
ported:
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Format Suffix Example

Decimal <empty>

d

106, DeviceName
106d, DeviceName

Hexadecimal h 6Ah, DeviceName
or prefix: 0x6A, DeviceName

Octal o 152o, DeviceName

Binary b 01101010b, DeviceName

The maximum supported word size for (unsigned) integers is 64 bits.

# --- Start of PTT file
@FILE_VERSION  = 1.0 
@PROTOCOL_NAME = i2c
#    Following two lines are equal:
7,01h,Temperature
7,01h, Temperature
#    A comma must be enclosed in double quotes:
7,01h,"Temperature, Pressure, and Volume"
#    A double quote must also be enclosed in double quotes:
7,7Fh,"Highspeed ""Master"" 01"
#    Following lines yield the same result:
7d,0x11,Pressure
7h,11h,Pressure
0x7,17d,Pressure
7,17,Pressure

Label lists are protocol-specific. Their contents are described in the corresponding pro-
tocol chapters:
● Chapter 11.3.4, "I2C Label List", on page 217
● Chapter 11.5.3, "CAN Label List", on page 235
● Chapter 11.6.4, "LIN Label List", on page 246
● Chapter 11.8.4, "MIL-STD-1553 Label List", on page 278

11.1.4.2 Label List Menu

Access: PROTOCOL > "Bus Type" = "I2C | CAN | LIN" > "Label List"
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Apply........................................................................................................................... 198
Load............................................................................................................................ 198
Show........................................................................................................................... 198
Sort..............................................................................................................................198
Remove.......................................................................................................................198

Apply
Shows the labels from the label list in the display of decode results instead of the ID or
address.

Load
Opens a menu to select and load a PTT file from an USB flash drive. The PTT file con-
tains one or more label lists.

The function is only available if an USB flash drive is connected to the instrument.

Alternatively, you can load a label list together with the device settings, if both were
saved with FILE > "Device Settings > Save > Setup & Label".

See also: "Setup & Label" on page 375

Show
Diplays the label list for the selected protocol type. Before, the label list must be loaded
from a PTT file.

Sort
Displays the label list in alphanumerical order or sorted by protocol-specific data col-
umns.

Remove
Deletes the label list from the instrument.

11.1.5 Frame Table: Decode Results

Access: PROTOCOL > "Frame Table"

The frame table shows the detailed decoded data for each frame of the acquisition.
The table content is protocol-specific, and the display of the table can be enabled for
each individual bus type.

Decode results shown in the frame table can be saved in a CSV file.

To navigate in the frame table

1. Stop the acquisition.

2. Turn the NAVIGATION knob to select a frame.

3. Press the NAVIGATION knob to display the selected frame in the center of the
waveform display.

If a search on decoded data was performed, the search results are marked in the
frame table.
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Frame Table
Displays or hides the table of decode results.

Remote command: 
BUS<b>:RESult on page 550

Track frame
Defines the automatic synchronization of the selected frame in the frame table and the
waveform display.

The function is only available if the acquisition has been stopped.

"Off" Frame table and waveform display are not synchronized.

"Frame Index" The waveform display is connected to the frame that is selected in
the frame table. The selected frame is shown in the center of the dis-
play. If you select another frame, the waveform display is adjusted
automatically.

"Hori. Position" The frame selection in the frame table is connected to the waveform
display. The frame in the center of the display is selected in the frame
table. When you change the horizontal position of the waveform, the
selection in the frame table is adjusted automatically.

Frame time difference
If selected, the time shown in the frame table is the time difference to the previous
frame. The column is indicated with "Time diff.". If the setting is disabled, the absolute
time in releation to the trigger point is shown in the "Start time" column.

Position
Defines the position of the frame table on the screen: top right, bottom right, or full
screen. With full screen setting, the frame table covers nearly the complete righthand
half of the screen.

Save
Opens the "Save" menu to save the decoded data in a CSV file (comma-separated
list).

Remote command: 
BUS<b>:LIST? on page 550
BUS<b>:LIST:SAVE on page 551

11.1.6 Trigger Source

The instrument triggers on the decoded data of a protocol bus. You can select one of
the configured and decoded buses as trigger source and use the protocol specific trig-
ger types for further analysis.
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Access: TRIGGER SETUP > "Trigger Type" = "Protocol (SPI or SSPI)" > "Source"

A bus is only available in the "Source" menu if "Decode" is enabled in the "Protocol"
menu.

B1, B2, B3, B4
Select one of the configured and decoded buses as trigger source.

Remote command: 
TRIGger:A:SOURce on page 448

11.2 SPI/SSPI Bus (Option R&S RTM-K1)

11.2.1 The SPI Protocol

A 4-channel instrument is required for full support of the SPI protocol.

The Serial Peripheral Interface SPI is used for communication with slow peripheral
devices, in particular, for transmission of data streams.

Main characteristics of SPI are:
● Master-slave communication
● No device addressing; The slave is accessed by a chip select, or slave select line.
● No acknowledgement mechanism to confirm receipt of data
● Duplex capability

Most SPI buses have four lines, two data and two control lines:
● Clock line to all slaves (SCLK)
● Slave Select or Chip Select line (SS or CS)
● Master data output, slave data input (MOSI or SDI)
● Master data input, slave data output (MISO or SDO)

When the master generates a clock and selects a slave device, data may be transfer-
red in either or both directions simultaneously.

As SPI is very simple and efficient for single master - single slave applications, the
R&S RTM provides also an SSPI (simple SPI) configuration that does not have a chip
select line.

 

 

SPI/SSPI Bus (Option R&S RTM-K1)



Protocol AnalysisR&S®RTM2000

201User Manual 1317.4726.02 ─ 10

Figure 11-1: Simple configuration of SPI bus

The data bits of a message are grouped by following criteria:
● A word contains a number of successive bits. The word length is defined in the pro-

tocol configuration.
● A frame contains a number of successive words, at least one word.

For SPI buses, the R&S RTM provides the following trigger possibilities:
● On frame start
● On frame end
● On a specified bit in the message
● On a serial pattern at a specified position

11.2.2 SPI/SSPI Bus Configuration

● Configuring SPI Buses..........................................................................................201
● SPI/SSPI Configuration Settings...........................................................................202

11.2.2.1 Configuring SPI Buses

You define the input channels for the lines and some bit information on the message.

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press the "Bus Type" softkey and select "SPI" or "SSPI".

4. Press "Configuration".

5. Press "Source" and select "Clk".

6. Press "Clock" and select the input channel of the clock. Select the "Slope".

7. Press "Source" and select "MOSI".

8. Press "MOSI" and select the input channel. With "Active", select the active state of
the data - high or low.

9. If required, repeat steps 6 and 7 for the optional MISO line.

10. For SPI, press "Source" and select "CS". Enter the input channel with "Chip Select"
and set the "Active" state.

11. For SSPI, press "Source" and select "Time". Enter the "Idle Time".
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12. Set the "First Bit" and the "Symbol Size".

13. Press "Find level", or set the threshold manually for each channel.
See: "To set the logic threshold for analog channels" on page 193

Now you can disply the decoded signal and the frame table with results.

The display of the decoded data is described in "To configure decoding and data dis-
play" on page 193.

11.2.2.2 SPI/SSPI Configuration Settings

Access: PROTOCOL LOGIC > "Bus type" = "SPI or SSPI" "Configuration"

Source.........................................................................................................................202
Chip Select, Clock, MOSI, MISO................................................................................ 202
Active.......................................................................................................................... 203
Slope........................................................................................................................... 203
Time Out..................................................................................................................... 203
First Bit........................................................................................................................ 203
Symbol Size................................................................................................................ 203
Find Level....................................................................................................................204

Source
Toggles the lines of the SPI bus. Each line has to be configured. Select a line and
adjust the settings:
● Chip Select (SPI only): Select the input channel and the "Active" state.
● Time Out (SSPI only): Set the "Time Out" (instead if chip select).
● Clock: Select the input channel and the "Slope".
● MOSI, MISO: Select the input channel and the "Active" state for each data line.

Chip Select, Clock, MOSI, MISO
Select the input channels of the corresponding line. Make sure to select the "Source"
before you assign the channel. MISO is optional and can be set to "None".

If the MSO option R&S RTM-B1 is installed, digital channels can also be used as
source.

Remote command: 
BUS<b>:SPI:CS:SOURce on page 551
BUS<b>:SPI:CLOCk:SOURce on page 552
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BUS<b>:SPI:DATA:SOURce on page 553
BUS<b>:SPI:FRAME<n>:DATA:MOSI? on page 558
BUS<b>:SPI:FRAME<n>:DATA:MISO? on page 559
BUS<b>:SSPI:CLOCk:SOURce on page 562
BUS<b>:SSPI:DATA:SOURce on page 562
BUS<b>:SSPI:MOSI:SOURce on page 562
BUS<b>:SSPI:MISO:SOURce on page 562

Active
Selects whether transmitted data or the chip select signal is high active (high = 1) or
low active (low = 1).

For CS, the default is low active.

For data, the default is high active.

Remote command: 
BUS<b>:SPI:CS:POLarity on page 552
BUS<b>:SPI:DATA:POLarity on page 553
BUS<b>:SPI:MOSI:POLarity on page 553
BUS<b>:SPI:MISO:POLarity on page 554
BUS<b>:SSPI:DATA:POLarity on page 563
BUS<b>:SSPI:MOSI:POLarity on page 563
BUS<b>:SSPI:MISO:POLarity on page 563

Slope
Selects if data is sampled on the rising or falling slope of the clock. The clock slope
marks the begin of a new bit.

Remote command: 
BUS<b>:SPI:CLOCk:POLarity on page 552
BUS<b>:SSPI:CLOCk:POLarity on page 562

Time Out
Sets the minimum idle time between two data packets. If the time interval between the
data packets is shorter, the packets are part of the same frame. Within the time out,
the data and clock lines are low. A new frame begins when the time out has expired.

Time out is only relevant for SSPI that has no chip select.

Remote command: 
BUS<b>:SSPI:BITime on page 563

First Bit
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least
significant bit).

Remote command: 
BUS<b>:SPI:BORDer on page 554
BUS<b>:SSPI:BORDer on page 564

Symbol Size
Sets the word length, the number of bits in a message.
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Remote command: 
BUS<b>:SPI:SSIZe on page 554
BUS<b>:SSPI:SSIZe on page 564

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555

11.2.3 SPI/SSPI Trigger

● Triggering on SPI Buses....................................................................................... 204
● SPI/SSPI Trigger Settings.....................................................................................205

11.2.3.1 Triggering on SPI Buses

Prerequisites: The SPI or SSPI bus is configured. After configuration, the trigger type
"Protocol (SPI)" or "Protocol (SSPI)" is available. See: Chapter 11.2.2.1, "Configuring
SPI Buses", on page 201.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol (SPI)" or "Protocol (SSPI)"

3. Press "Setup".

4. Press the softkey of the required trigger condition:
● "Frame Start": begin of the message
● "Frame End": message end
● "Bit<x>": a specified bit inside the message
● "Ser. Pattern": a bit pattern in the message

5. If "Bit<x>" is selected, enter the bit number.

6. If "Ser. Pattern" is selected, press the softkey again and define the pattern:

a) Set the "Bit Offset", the number of bits before the pattern starts.
b) Set the "Number of Bits" contained in the pattern.
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c) Enter the pattern, either as binary input, or as hexadecimal input:
● For binary input, press "Select Bit" and enter the bit number to be set. The

bits are counted from the message start, the selected bit is highlighted in
the pattern bit line. Then enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states are defined.

● For hexadecimal input, press "Select Nibble" and select the four bits (half
byte) to be set. The selected nibble is highlighted in the lower pattern line.
Then press "Value" and turn the navigation knob to change the bits.
Repeat these settings until all nibbles are defined.

11.2.3.2 SPI/SSPI Trigger Settings

Access: TRIGGER SETUP > "Trigger Type" = "Protocol"

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

Frame Start................................................................................................................. 206
Frame End.................................................................................................................. 206
Bit<x>.......................................................................................................................... 206
Ser. Pattern................................................................................................................. 206

└ Bit Offset....................................................................................................... 206
└ Number of Bits.............................................................................................. 206
└ Select Bit.......................................................................................................207
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└ State..............................................................................................................207
└ Select Nibble.................................................................................................207
└ Value.............................................................................................................207

Frame Start
Sets the trigger to the start of the message. For SPI, the frame starts when the chip
select signal CS changes to the active state. For SSPI, the frame starts when the idle
time has expired.

Remote command: 
TRIGger:A:SPI:MODE on page 555 (BSTart)

Frame End
Sets the trigger to the end of the message. For SPI, the frame ends when the chip
select signal CS changes to the inactive state. For SSPI, the frame ends when the idle
time has expired after the last clock and no new clock appeared during that time.

Remote command: 
TRIGger:A:SPI:MODE on page 555 (BEND)

Bit<x>
Sets the trigger to the specified bit number.

Remote command: 
TRIGger:A:SPI:MODE on page 555 (NTHBit)

Ser. Pattern
Sets the trigger to a specified bit pattern that is configured in the submenu.

Remote command: 
TRIGger:A:SPI:MODE on page 555 (PATTern)
TRIGger:A:SPI:PATTern on page 556

Bit Offset ← Ser. Pattern
Sets the number of bits before the first bit of the pattern. These bits are ignored. The
first bit after CS is Bit 0.

For example, with bit offset = 2, Bit 0 and Bit 1 after CS are ignored, and the pattern
starts with Bit 2.

Remote command: 
TRIGger:A:SPI:POFFset on page 557

Number of Bits ← Ser. Pattern
Defines the length of the serial pattern in bit.

Remote command: 
TRIGger:A:SPI:PLENgth on page 556
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Select Bit ← Ser. Pattern
Selects the bit number for binary pattern setting. For the selected bit, "State" is to be
set. The bits are counted from the message start, the selected bit is highlighted in the
pattern bit line.

State ← Ser. Pattern
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Select Nibble ← Ser. Pattern
Selects four bits (half byte) for hexadecimal entry with "Value". The selected nibble is
highlighted in the lower pattern line.

Value ← Ser. Pattern
Sets the hexadecimal value for the selected nibble.

11.2.4 SPI/SSPI Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values below the waveforms in the format selected with "Display". Additionally, you
can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193
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Figure 11-2: Decoded SPI signal

C1 = Clock (Clk)
C2 = Data
C3 = Chip Select (Cs)
blue results = completely decoded words
grey brackets = start and end of complete frame
red results = Incomplete word that is not completely contained in the acquisition. Change the horizontal

scale, or move the"Time Reference" to get a longer acquisition.

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, source (line), data and state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198
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Figure 11-3: Decoded SSPI signal with frame table

Table 11-1: Content of the SPI/SSPI frame table

Column Description

Start time Time of the frame start in relation to the trigger point

Source MISO or MOSI line

Length Number of words in the frame

Data Hexadecimal values of the data words

State Overall state of the frame

Example: 
In the figure above, the first two frames have four words each, the following two frames
contain 6 words each. The fifth frame is incomplete.

Remote commands:
● BUS<b>:SPI:FCOunt? on page 557

BUS<b>:SPI:FRAME<n>:STATus? on page 557
BUS<b>:SPI:FRAME<n>:STARt? on page 558
BUS<b>:SPI:FRAME<n>:STOP? on page 558
BUS<b>:SPI:FRAME<n>:DATA:MOSI? on page 558
BUS<b>:SPI:FRAME<n>:DATA:MISO? on page 559
BUS<b>:SPI:FRAME<n>:WCOunt? on page 559
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BUS<b>:SPI:FRAME<n>:WORD<o>:STARt? on page 560
BUS<b>:SPI:FRAME<n>:WORD<o>:STOP? on page 560
BUS<b>:SPI:FRAME<n>:WORD<o>:MOSI? on page 560
BUS<b>:SPI:FRAME<n>:WORD<o>:MISO? on page 561

11.3 I²C (Option R&S RTM-K1)

The Inter-Integrated Circuit is a simple, lowbandwidth, low-speed protocol used for
communication between on-board devices, for example, in LCD and LED drivers,
RAM, EEPROM, and others.

11.3.1 The I²C Protocol

This chapter provides an overview of protocol characteristics, data format, address
types and trigger possibilities. For detailed information, read the "I2C-bus specification
and user manual" available on the NXP manuals web page at http://www.nxp.com/.

I²C characteristics

Main characteristics of I²C are:
● Two-wire design: serial clock (SCL) and serial data (SDA) lines
● Master-slave communication: the master generates the clock and addresses the

slaves. Slaves receive the address and the clock. Both master and slaves can
transmit and receive data.

● Addressing scheme: each slave device is addressable by a unique address. Multi-
ple slave devices can be linked together and can be addressed by the same mas-
ter.

● Read/write bit: specifies if the master will read (=1) or write (=0) the data.
● Acknowledge: takes place after every byte. The receiver of the address or data

sends the acknowledge bit to the transmitter.

The R&S RTM supports all operating speed modes: high-speed, fast mode plus, fast
mode, and standard mode.

Data transfer

The format of a simple I²C message (frame) with 7 bit addressing consists of the fol-
lowing parts:
● Start condition: a falling slope on SDA while SCL is high
● 7-bit address of the slave device that either will be written to or read from
● R/W bit: specifies if the data will be written to or read from the slave
● ACKnowledge bits: is issued by the receiver of the previous byte if the transfer was

successful
Exception: At read access, the master terminates the data transmission with a
NACK bit after the last byte.
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● Data: a number of data bytes with an ACK bit after every byte
● Stop condition: a rising slope on SDA while SCL is high

Figure 11-4: I2C write access with 7-bit address

Address types: 7-bit and 10-bit

Slave addresses can be 7 or 10 bits long. A 7-bit address requires one byte, 7 bits for
the address followed by the R/W bit.

A 10-bit address for write access requires two bytes: the first byte starts with the
reserved sequence 11110, followed by the two MSB of the address and the write bit.
The second byte contains the remaining 8 LSB of the address. The slave acknowl-
edges each address byte.

Figure 11-5: 10-bit address, write access

A 10-bit address for read access requires three bytes. The first two bytes are identical
to the write access address. The third byte repeats the address bits of the first byte and
sets the read bit.

Figure 11-6: 10-bit address, read access

Trigger

The R&S RTM can trigger on various parts of I²C messages. The data and clock lines
must be connected to the input channels, triggering on math and reference waveforms
is not possible.

You can trigger on:
● Start or stop condition
● Repeated start condition
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● Transfer direction (read or write)
● Bytes with missing acknowledge bit
● Specific slave address
● Specific data pattern in the message

11.3.2 I²C Configuration

11.3.2.1 Configuring I²C

The configuration of the I²C is simple - only assign the two lines to input channels.

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press the "Bus Type" softkey and select "I2C".

4. Press "Configuration".

5. Press "Clock SCL" and select the channel connected to the clock line.

6. Press "Data SDA" and select the channel connected to the data line.

7. Press "Find level", or set the threshold manually for each channel.
See: "To set the logic threshold for analog channels" on page 193

Now you can disply the decoded signal and the frame table with results.

The display of the decoded data is described in "To configure decoding and data dis-
play" on page 193.

11.3.2.2 I²C Configuration Settings

Clock SCL................................................................................................................... 212
Data SDA.................................................................................................................... 212
Find Level....................................................................................................................213

Clock SCL
Sets the input channel to which the clock line is connected.

If the MSO option R&S RTM-B1 is installed, digital channels can also be used as
source.

Remote command: 
BUS<b>:I2C:CLOCk:SOURce on page 565

Data SDA
Sets the input channel to which the data line is connected.

If the MSO option R&S RTM-B1 is installed, digital channels can also be used as
source.
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Remote command: 
BUS<b>:I2C:DATA:SOURce on page 565

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555

11.3.3 I²C Trigger

● Triggering on I²C .................................................................................................. 213
● I²C Trigger Settings...............................................................................................214

11.3.3.1 Triggering on I²C

Prerequisites: The I²C interface is configured. After configuration, the trigger type "Pro-
tocol (I2C)" is available. See: Chapter 11.3.2.1, "Configuring I²C ", on page 212.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol (I2C)".

3. Press "Setup".

4. Press the softkey of the required trigger condition:
● "Start": begin of the message
● "Stop": end of the message
● "Restart": repeated start condition
● "Acknowledge": transfer of a data byte is not acknowledged
● "Read/Write": complex trigger condition containing read or write access of the

master, slave address, or/and a bit pattern in the message

5. If "Read/Write" is selected, press the softkey again and define the condition:

a) Press "Master" and select read or write access of the master.
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b) Configure the "Address" of the slave:
● Select the "Address Length", 7 bit or 10 bit.
● Press "Slave Address" and turn the navigation knob to set the address.

If the address is not relevant for your trigger condition, set it to "0xX" (any
address).

c) Press "Data Setup" to specify data bytes of the message, and/or to a serial pat-
tern.

d) Set the "Byte Offset", the number of bytes to be ignored before the first byte of
interes.t

e) Set the "Number of Bytes" contained in the pattern.
f) Enter the pattern, either as binary input, or as hexadecimal input:

● For binary input, press "Bit" and enter the bit number to be set. The bits are
counted inside the selected bytes, the selected bit is highlighted in the pat-
tern bit line. Then enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states are defined.

● For hexadecimal input, press "Byte" and select the byte to be set. The
selected byte is highlighted in the lower pattern line. Then press "Value"
and turn the navigation knob to change the bits.
Repeat these settings until all bytes are defined.

If the data is not relevant for your trigger condition, set all data bytes to "0xXX".

11.3.3.2 I²C Trigger Settings

Access: SETUP (Trigger) > "Trigger type" = "Protocol" > "Setup"

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.
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Start.............................................................................................................................215
Stop.............................................................................................................................215
Restart.........................................................................................................................215
~Acknowledge.............................................................................................................215
Read/Write.................................................................................................................. 216

└ Master...........................................................................................................216
└ Symbolic ID...................................................................................................216
└ Address Length.............................................................................................216
└ Slave Address...............................................................................................216
└ Data Setup....................................................................................................216

└ Byte Offset..........................................................................................217
└ Number of Bytes.................................................................................217
└ Bit........................................................................................................217
└ State................................................................................................... 217
└ Byte.....................................................................................................217
└ Value...................................................................................................217

Start
Sets the trigger to the start of the message. The start condition is a falling slope on
SDA while SCL is high.

Remote command: 
TRIGger:A:I2C:PATTern on page 568 (STARt)

Stop
Sets the trigger to the end of the message. The stop condition is a rising slope on SDA
while SCL is high.

Remote command: 
TRIGger:A:I2C:PATTern on page 568 (STOP)

Restart
Sets the trigger to a repeated start - when the start condition occurs without previous
stop condition. This can happen when a master sends multiple messages without
releasing the bus.

Remote command: 
TRIGger:A:I2C:PATTern on page 568 (RESTart)

~Acknowledge
Missing acknowledge: the instrument triggers if the slave does not send the acknowl-
edge bit. Acknowledging takes place after every byte. If the transfer failed, at the
moment of the acknowledge bit the SDA line is on high level during the high period of
the clock pulse.

Remote command: 
TRIGger:A:I2C:PATTern on page 568 (MACKnowledge)
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Read/Write
Sets the trigger to a read or write access of the master, to an address, or/and to a bit
pattern in the message. The trigger condition is specified in the submenus. All sub-
menu settings together create the trigger condition. If you want to trigger on a specific
parameter, make sure to set all other settings to "any".

If a label list with node names was loaded and applied in the bus configuration, you
can select simply the "Symbolic ID" from the list instead of entering the numeric identi-
fier.

Remote command: 
TRIGger:A:I2C:PATTern on page 568 (PATTern)

Master ← Read/Write
Toggles the trigger condition between Read and Write access of the master. The R/W
bit is 8th bit of the first address byte of a frame. The selected condition is displayed in
the I2C Settings: "Trigger On".

Remote command: 
TRIGger:A:I2C:ACCess on page 567

Symbolic ID ← Read/Write
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

Address Length ← Read/Write
Toggles the lenght of the slave address: 7 bit or 10 bit.

Remote command: 
TRIGger:A:I2C:AMODe on page 567

Slave Address ← Read/Write
Sets the address of the slave device in hex. You can set a precise address, or trigger
on any address with "0xXX" (7Bit address) or "0xXXX" (10Bit address). X cannot be
assigned to a specified bit

Remote command: 
TRIGger:A:I2C:ADDRess on page 568

Data Setup ← Read/Write
Opens a submenu to set the trigger on specified data bytes of the message, and/or to
a serial pattern.
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Remote command: 
TRIGger:A:I2C:PATTern on page 568

Byte Offset ← Data Setup ← Read/Write
Sets the number of bytes before the first byte of interest, relating to the end of the
address bytes. These offset bytes are ignored.

Remote command: 
TRIGger:A:I2C:POFFset on page 569

Number of Bytes ← Data Setup ← Read/Write
Sets the number of bytes you want to trigger on. Maximum 3 bytes are possible.

Remote command: 
TRIGger:A:I2C:PLENgth on page 568

Bit ← Data Setup ← Read/Write
Selects the bit number inside the selected bytes for binary pattern input. For the
selected bit, "State" is to be set. the selected bit is highlighted in the "Data" bit line.

State ← Data Setup ← Read/Write
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Byte ← Data Setup ← Read/Write
Selects a byte for hex input with "Value". The selected byte is highlighted in the "Data"
hex line.

Value ← Data Setup ← Read/Write
Sets the hexadecimal value for the selected byte.

If the data is not relevant for your trigger condition, set all data bytes to "0xXX".

11.3.4 I2C Label List

Label lists are protocol-specific. An I2C PTT file contains three values for each
address:
● Address type, 7-bit or 10-bit long
● Hexadecimal address value
● Label, symbolic name of the address, specifiing its function in the bus network.

Example: I2C PTT file

# ---------------------------------------------------------------------------- 
@FILE_VERSION  = 1.00
@PROTOCOL_NAME = i2c
# ---------------------------------------------------------------------------
# Labels for I2C protocol
#   Column order: Identifier type, Identifier value, Label
# ---------------------------------------------------------------------------
7,0x1E,Voltage
7,0x38,Pressure
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7,0x2A,Temperature
7,0x16,Speed
7,0x76,Acceleration
7,0x07,HighSpeed_Master_0x3
7,0x51,EEPROM
10,0x3A2,DeviceSetup
10,0x1A3,GatewayStatus
10,0x06E,LeftSensor
# ---------------------------------------------------------------------------- 

Figure 11-7: Label list for I²C

For general information, see Chapter 11.1.4, "Label List", on page 195.

11.3.5 I2C Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values below the waveforms in the format selected with "Display". Additionally, you
can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, access type. ID, data and state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198
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Figure 11-8: Decoded and binary I2C signal, and frame table with decode results

gray brackets = start and end of the frame
violet = address
blue = correct data words
green = acknowledge bit, ok
red = missing acknowledge bit, or other error

Table 11-2: Content of the I2C frame table

Column Description

Start time Time of the frame start in relation to the trigger point

Type Value of the R/W bit, read or write access

ID Hexadecimal value of the address

Label Symbolic label, available if a label list was loaded and applied

Length Number of words in the frame

Data Hexadecimal values of the data words

State Overall state of the frame
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Remote commands:
● BUS<b>:I2C:FCOunt? on page 569

BUS<b>:I2C:FRAMe<n>:DATA? on page 569
BUS<b>:I2C:FRAMe<n>:STATus? on page 570
BUS<b>:I2C:FRAMe<n>:STARt? on page 570
BUS<b>:I2C:FRAMe<n>:STOP? on page 571
BUS<b>:I2C:FRAMe<n>:AACCess? on page 571
BUS<b>:I2C:FRAMe<n>:ACCess? on page 571
BUS<b>:I2C:FRAMe<n>:ACOMplete? on page 572
BUS<b>:I2C:FRAMe<n>:ADBStart? on page 572
BUS<b>:I2C:FRAMe<n>:ADDRess? on page 572
BUS<b>:I2C:FRAMe<n>:ADEVice? on page 573
BUS<b>:I2C:FRAMe<n>:AMODe? on page 573
BUS<b>:I2C:FRAMe<n>:ASTart? on page 573
BUS<b>:I2C:FRAMe<n>:BCOunt? on page 574
BUS<b>:I2C:FRAMe<n>:BYTE<o>:ACCess? on page 574
BUS<b>:I2C:FRAMe<n>:BYTE<o>:ACKStart? on page 574
BUS<b>:I2C:FRAMe<n>:BYTE<o>:COMPlete? on page 575
BUS<b>:I2C:FRAMe<n>:BYTE<o>:STARt? on page 575
BUS<b>:I2C:FRAMe<n>:BYTE<o>:VALue? on page 575

11.4 UART/RS-232 Interface (Option R&S RTM-K2)

11.4.1 The UART / RS232 Interface

The Universal Asynchronous Receiver/Transmitter UART converts a word of data into
serial data, and vice versa. It is the base of many serial protocols like of RS-232. The
UART uses only one line, or two lines for transmitter and receiver.

Data transfer

The data is transmitted in symbols, also referred to as words or characters. Each sym-
bol consists of a start bit, several data bits, an optional parity bit, and one or more stop
bits. Several symbols can form a frame, or package. The end of a frame is marked by
a pause between two symbols.

[Data8] [Parity] Stop[Data7][Data6][Data5]Data4Data3Data2Data1Data0Start

Figure 11-9: Bit order in a UART word (symbol)

● The start bit is a logic 0.
● The stop bits and the idle state are always logic 1.

The UART protocol has no clock for synchronization. The receiver synchronizes by
means of the start and stop bits, and the bit rate that must be known to the receiver.
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Trigger

The R&S RTM can trigger on specified parts of UART serial signals:
● Start bit
● Frame start
● A specified symbol
● Parity errors, and breaks
● Frame errors
● A serial pattern at any or a specified position

11.4.2 UART/RS-232 Configuration

11.4.2.1 Configuring UART/RS-232 Interfaces

To configure the UART interface, you assign the channels to the RX an (optionally) TX
lines, set the active state for each line and set some protocol-specific parameters.

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press the "Bus Type" softkey and select "UART".

4. Press "Configuration".

5. Press "RX" and select the channel connected to the receiver line.

6. Press "TX" and select the channel connected to the transmitter line.

7. Set the "Active" state, "Parity" bit and the number of "Stop Bits".

8. Press "More".

9. Enter the "Symbol size".

10. Enter the bit rate:

● For a standard bit rate, select the "Defined Bit Rate".
● For a user-defined bit rate, press "User Bit Rate" and enter the value

11. Set the "Idle Time" between two frames.

12. Press "Find level", or set the threshold manually for each channel.
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See: "To set the logic threshold for analog channels" on page 193

Now you can disply the decoded signal and the frame table with results.

The display of the decoded data is described in "To configure decoding and data dis-
play" on page 193.

11.4.2.2 UART Configuration Settings

Access: PROTOCOL > "Bus type" = "UART" "Configuration"

RX, TX.........................................................................................................................222
Active.......................................................................................................................... 222
Parity........................................................................................................................... 222
Stop Bits......................................................................................................................223
Symbol Size................................................................................................................ 223
Bit Rate....................................................................................................................... 223
Idle Time..................................................................................................................... 223
Find Level....................................................................................................................223

RX, TX
Select the input channels of the RX and TX lines.

If the MSO option R&S RTM-B1 is installed, digital channels can also be used as
source.

Remote command: 
BUS<b>:UART:DATA:SOURce on page 576
BUS<b>:UART:RX:SOURce on page 576
BUS<b>:UART:TX:SOURce on page 577

Active
Defines the logic levels of the bus. The idle state corresponds to a logic 1, and the start
bit to a logic 0. Active-high (high=1) is used, for example, for control signals, while
active-low (low=1) is defined for data lines (RS-232).

Remote command: 
BUS<b>:UART:DATA:POLarity on page 577
BUS<b>:UART:POLarity on page 577

Parity
Defines the optional parity bit that is used for error detection.

 

UART/RS-232 Interface (Option R&S RTM-K2)



Protocol AnalysisR&S®RTM2000

223User Manual 1317.4726.02 ─ 10

"None" No parity bit is used.

"Even" The parity bit is set to "1" if the number of "1"s in a given set of bits is
odd (not including the parity bit).

"Odd" The parity bit is set to "1" if the number of "1"s in a given set of bits is
even (not including the parity bit).

Remote command: 
BUS<b>:UART:PARity on page 578

Stop Bits
Sets the number of stop bits: 1; 1.5 or 2 stop bits are possible.

Remote command: 
BUS<b>:UART:SBIT on page 578

Symbol Size
Sets the number of data bits in a word (symbol) in a range from 5 to 9 bits.

Remote command: 
BUS<b>:UART:SSIZe on page 578

Bit Rate
Sets the number of transmitted bits per second.

"Defined Bit
Rate"

Select a standard bit rate value from the list.

"User Bit Rate" Enter a user defined value.

Remote command: 
BUS<b>:UART:BAUDrate on page 579

Idle Time
Sets the minimal time between two frames – between the stop bit of the last word in a
frame and the start bit of the first word in the next frame.

Remote command: 
BUS<b>:UART:BITime on page 579

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555
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11.4.3 UART/RS-232 Trigger

● Triggering on UART/RS-232 Interfaces................................................................ 224
● UART Trigger Settings..........................................................................................225

11.4.3.1 Triggering on UART/RS-232 Interfaces

Prerequisites: The UART interface is configured. After configuration, the trigger type
"Protocol (UART)" is available. See: Chapter 11.4.2.1, "Configuring UART/RS-232
Interfaces", on page 221.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol (UART)".

3. Press "Source" and select RX or TX as trigger source.

4. Press "Back".

5. Press "Setup".

6. Press the softkey of the required trigger condition:
● "Start Bit", or "Frame Start": next start bit, or first start bit after idle time
● "Symbol<n>": frame number in a data stream
● "Any Symbol": pattern of the data bits anywhere in the data stream
● "Pattern": serial pattern of one, two or three symbols at a defined position in the

data stream
● "Parity Error"
● "Frame Errror"
● "Break"

7. If "Any Symbol" is selected, press the softkey again and define the symbol pattern,
either as binary input, or as hexadecimal input:

● For hex entry, select "Value" and turn the navigation knob to change the bits.
● For binary input, press "Select Bit" and enter the data bit number to be set.

Enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states are defined.

8. If "Pattern" is selected, press the softkey again and define the pattern:

a) Set the "Symbol Offset", the number of symbols to be ignored before the pat-
tern starts.

b) Set the "Number of Symbols" contained in the pattern.
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c) Enter the pattern, either as binary input, or as hexadecimal input:
● For hexadecimal input, press "Select Symbol" repeatedly to select the sym-

bol to be set. The selected symbol is highlighted in the hex pattern line.
Then press "Value" and turn the navigation knob to change the bits.
Repeat these settings until all symbols are defined.

● For binary input, press "Select Symbol" until the required symbol is marked
in the pattern hex line. Then press "Select Bit" and enter the data bit num-
ber to be set. Enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states of all symbols are defined.

11.4.3.2 UART Trigger Settings

Access: TRIGGER SETUP > "Trigger Type" = "Protocol"

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

● UART Trigger Type Selection............................................................................... 225
● UART Pattern Setup............................................................................................. 227

UART Trigger Type Selection

Access: TRIGGER SETUP > "Trigger Type" = "Protocol" > "Setup"
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Start Bit....................................................................................................................... 226
Frame Start................................................................................................................. 226
Symbol <n>................................................................................................................. 226
Any Symbol................................................................................................................. 226
Pattern.........................................................................................................................226
Parity Error.................................................................................................................. 226
Frame Error.................................................................................................................227
Break...........................................................................................................................227

Start Bit
Triggers on a start bit. The start bit is the first logical 0 after a stop bit.

Remote command: 
TRIGger:A:UART:MODE on page 580 (SBIT)

Frame Start
Triggers on the begin of a frame. The frame start is the first start bit after the idle time.

Remote command: 
TRIGger:A:UART:MODE on page 580 (BSTart)

Symbol <n>
Sets the trigger to the specified symbol - the n-th word - in a frame (package).

Remote command: 
TRIGger:A:UART:MODE on page 580 (NTHSymbol)

Any Symbol
Opens a submenu to trigger if a pattern occurs in a symbol at any position in a frame.

You can enter the pattern in binary or hex, the functions are the same as for "Pattern"
setting:
● "Select Bit" on page 227
● "State" on page 227
● "Value" on page 227

Remote command: 
TRIGger:A:UART:MODE on page 580 (SYMBol)

Pattern
Opens a submenu to set the trigger on a serial pattern at a defined position in the
frame. The pattern can include several subsequent symbols.

Remote command: 
TRIGger:A:UART:MODE on page 580 (PATTern)
TRIGger:A:UART:PATTern on page 581

Parity Error
Triggers on a parity error indicating a transmission error.
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Remote command: 
TRIGger:A:UART:MODE on page 580 (PERRor)

Frame Error
Triggers on a frame error.

Remote command: 
TRIGger:A:UART:MODE on page 580 (FERRor)

Break
Triggers if a start bit is not followed by a stop bit, the data line remains at logic 0 for
longer than a UART word.

Remote command: 
TRIGger:A:UART:MODE on page 580 (BREak)

UART Pattern Setup

Access: TRIGGER SETUP > "Trigger Type" = "Protocol" > "Setup" > "Pattern" (2x)

The pattern menu contains the settings for the "Pattern" and "Any Symbol" trigger
types.

Symbol Offset
Sets the number of symbols to be ignored before the serial pattern.

Remote command: 
TRIGger:A:UART:POFFset on page 582

Number of Symb.
Defines the length of the pattern - how many symbols build it up.

Remote command: 
TRIGger:A:UART:PLENgth on page 581

Select Bit
Selects the bit number inside the selected symbol for binary pattern input.

State
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Select Symbol
Selects the symbol for binary or hex input.

Value
Sets the hexadecimal value for the selected symbol by turning the navigation knob.
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11.4.4 UART/RS-232 Decode Results

You can enable the decoding results in the "Protocol" main menu. "Decode" shows the
decoded values below the waveforms in the format selected with "Display". Addition-
ally, you can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, data and state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198

Figure 11-10: Decoded UART signal

C1 = Data source
blue results = completely decoded words
grey brackets = start and end of complete frames
green results = correct parity bits
red results = Errors or incomplete word that is not completely contained in the acquisition. Change the

horizontal scale, or move the"Time Reference" to get a longer acquisition.

Example: 
The figure above shows five frames of a UART signal with one source line.
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Table 11-3: Content of the UART frame table

Column Description

Start time Time of the frame start in relation to the trigger point

Data Hexadecimal values of the data words

State Overall state of the frame

Remote commands:
● BUS<b>:UART:RX:FCOunt? on page 582
● BUS<b>:UART:RX:FRAMe<n>:WCOunt? on page 582
● BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STATe? on page 583
● BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STARt? on page 583
● BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STOP? on page 584
● BUS<b>:UART:RX:FRAMe<n>:WORD<o>:VALue? on page 584

11.5 CAN (Option R&S RTM-K3)

CAN is the Controller Area Network, a bus system used within automotive network
architecture.

11.5.1 CAN Configuration

Access: PROTOCOL > "Bus type" = "CAN" > "Configuration"

Data.............................................................................................................................229
Type............................................................................................................................ 230
Sample point............................................................................................................... 230
Bit rate.........................................................................................................................230
Find Level....................................................................................................................230

Data
Sets the source of the data line. All channel waveforms can be used.

If the MSO option R&S RTM-B1 is installed, digital channels can also be used as
source.

Remote command: 
BUS<b>:CAN:DATA:SOURce on page 585
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Type
Selects the CAN-High or CAN-Low line. CAN uses both lines for differential signal
transmission.

If you measure with a differential probe, connect the probe to both CAN-H and CAN-L
lines, and select the data "Type" "CAN-H".

If you use a single-ended probe, connect the probe to either CAN_L or CAN_H, and
select the data type accordingly.

Remote command: 
BUS<b>:CAN:TYPE on page 585

Sample point
Sets the position of the sample point within the bit in percent of the nominal bit time.
The sample point divides the nominal bit period into two distinct time segments, which
are used for resynchronization of the clock.

The CAN bus interface uses an asynchronous transmission scheme. The standard
specifies a set of rules to resynchronize the local clock of a CAN node to the message.

Remote command: 
BUS<b>:CAN:SAMPlepoint on page 585

Bit rate
Sets the number of transmitted bits per second. The maximum bit rate for High Speed
CAN is 1 Mbit/s. The bit rate is uniform and fixed for a given CAN bus.

To select a bit rate from the list of predefined values, set "Bit rate" to "Defined Bit
Rate", and then select the value with "Predefined".

To set another value, set "Bit rate" to "User Bit Rate", and then enter the value with
"User".

Remote command: 
BUS<b>:CAN:BITRate on page 586

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555
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11.5.2 CAN Trigger Settings

Access: SETUP (Trigger) > "Trigger type" = "Protocol" > "Setup"

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

Start of frame.............................................................................................................. 231
End of frame................................................................................................................231
Frame <type>..............................................................................................................232

└ Error..............................................................................................................232
└ Overload....................................................................................................... 232
└ Data.............................................................................................................. 232
└ Remote......................................................................................................... 232
└ Data or remote..............................................................................................232

Error <type>................................................................................................................ 232
└ Stuff bit..........................................................................................................232
└ Form..............................................................................................................233
└ Acknowledge.................................................................................................233
└ CRC.............................................................................................................. 233

Identifier...................................................................................................................... 233
└ Frame type....................................................................................................233
└ Symbolic ID...................................................................................................233
└ Identifier Setup..............................................................................................234

└ ID type................................................................................................ 234
└ Compare.............................................................................................234
└ Bit........................................................................................................234
└ State................................................................................................... 234
└ Byte.....................................................................................................234
└ Value...................................................................................................234

Identifier and data....................................................................................................... 234
└ Data Setup....................................................................................................235

└ Data Length........................................................................................ 235

Start of frame
Triggers on the first edge of the dominant SOF bit (synchronization bit).

Remote command: 
TRIGger:A:CAN:TYPE on page 587 (STOFrame)

End of frame
Triggers on the end of the frame (7 recessive bits).
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Remote command: 
TRIGger:A:CAN:TYPE on page 587 (EOFrame)

Frame <type>
Selects the frame type to be triggered on. The selected frame type is indicated in the
softkey name.

Remote command: 
TRIGger:A:CAN:TYPE on page 587 (FTYPe)
TRIGger:A:CAN:FTYPe on page 588

Error ← Frame <type>
An error frame is sent by a node that has detected an error.

Overload ← Frame <type>
An overload frame is sent by a node that needs a delay between data and/or remote
frames.

Data ← Frame <type>
Frame for data transmission.

The identifier format is also considered, see "ID type" on page 234.

Remote ← Frame <type>
Data: Frame for data transmission.

A remote frame initiates the transmission of data by another node. The frame format is
the same as of data frames but without the data field.

The identifier format is also considered, see "ID type" on page 234.

Data or remote ← Frame <type>
Triggers on remote frames and on data frames.

The identifier format is also considered, see "ID type" on page 234.

Error <type>
Identifies various errors in the frame. You can select one or more error types as trigger
condition.

The first key press enables the "Error" trigger type, the second opens the "Error" menu.

Remote command: 
TRIGger:A:CAN:TYPE on page 587 (ERRCondition)

Stuff bit ← Error <type>
The frame segments Start Of Frame, Arbitration Field, Control Field, Data Field and
CRC Sequence are coded by the bit stuffing method. The transmitter automatically
inserts a complementary bit into the bit stream when it detects five consecutive bits of
identical value in the bit stream to be transmitted. A stuff error occurs when the 6th
consecutive equal bit level in the mentioned fields is detected.

Remote command: 
TRIGger:A:CAN:BITSterror on page 590
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Form ← Error <type>
A form error occurs when a fixed-form bit field contains one or more illegal bits.

Remote command: 
TRIGger:A:CAN:FORMerror on page 590

Acknowledge ← Error <type>
An acknowledgement error occurs when the transmitter does not receive an acknowl-
edgment - a dominant bit during the Ack Slot.

Remote command: 
TRIGger:A:CAN:ACKerror on page 590

CRC ← Error <type>
CAN uses the Cyclic Redundancy Check, which is a complex checksum calculation
method. The transmitter calculates the CRC and sends the result in the CRC
sequence. The receiver calculates the CRC in the same way. A CRC error occurs
when the calculated result differs from the received value in the CRC sequence.

Remote command: 
TRIGger:A:CAN:CRCerror on page 590

Identifier
Sets the trigger to a specific message identifier or an identifier range.

The first key press enables the "Identifier" trigger type, the second one opens the
"Identifier" menu.

If a label list with node names was loaded and applied in the bus configuration, you
can select simply the "Symbolic ID" from the list instead of entering the numeric identi-
fier.

Remote command: 
TRIGger:A:CAN:TYPE on page 587 (ID | IDDT)

Frame type ← Identifier
Data frames and remote frames contain an identifier. Select the frame type to be trig-
gered on, or select "Data and remote" if the frame type is not relevant.

Remote command: 
TRIGger:A:CAN:FTYPe on page 588

Symbolic ID ← Identifier
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.
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Identifier Setup ← Identifier
Opens the menu to set the identifier pattern. After setting the "ID type" and the "Com-
pare" condition, you can enter the value bit-by-bit by setting the state high, low, or don't
care for each single bit. Alternatively, you can enter a hexadecimal value for each byte.

Remote command: 
TRIGger:A:CAN:IDENtifier on page 589

ID type ← Identifier Setup ← Identifier
Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN
extended frames.

Remote command: 
TRIGger:A:CAN:ITYPe on page 588

Compare ← Identifier Setup ← Identifier
Sets the comparison condition: If the pattern contains at least one X (don't care), you
can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

Remote command: 
TRIGger:A:CAN:ICONdition on page 589

Bit ← Identifier Setup ← Identifier
Selects the number of the bit in the pattern for bit-by-bit input. For each selected bit,
enter the "State".

State ← Identifier Setup ← Identifier
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Byte ← Identifier Setup ← Identifier
Selects the byte for input of the pattern. For each selected byte, enter the hexadecimal
value, or set the "State" for each selected "Bit".

Value ← Identifier Setup ← Identifier
Sets the hexadecimal value for the selected byte by turning the navigation knob.

Identifier and data
Sets the trigger to a combination of identifier and data condition. The instrument trig-
gers at the end of the last byte of the specified data pattern.
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The identifier conditions are the same as for the "Identifier" trigger type, see "Identifier"
on page 233.

The first key press enables the trigger type, the second one opens the "Identifier and
data" menu.

Remote command: 
TRIGger:A:CAN:TYPE on page 587 (IDDT)

Data Setup ← Identifier and data
Opens a menu to set the data pattern to be triggered on. After setting the "Data length"
and the "Compare" condition, you can enter the value bit-by-bit by setting the state
high, low, or don't care for each single bit. Alternatively, you can enter a hexadecimal
value for each byte.

Most settings are the same as for identifier input. See:
● "Compare" on page 234
● "Bit" on page 234
● "State" on page 234
● "Byte" on page 234
● "Value" on page 234

Remote command: 
TRIGger:A:CAN:DCONdition on page 589
TRIGger:A:CAN:DATA on page 590

Data Length ← Data Setup ← Identifier and data
Defines the length of the data pattern - the number of bytes in the pattern.

Remote command: 
TRIGger:A:CAN:DLC on page 589

11.5.3 CAN Label List

Label lists are protocol-specific. A PTT file for CAN contains three values for each
identifier:
● Identifier type, 11-bit or 29-bit long
● Hexadecimal identifier value
● Label, symbolic name of the identifier, specifiing its function in the bus network.

Example: CAN PTT file

# ---------------------------------------------------------------------------- 
@FILE_VERSION  = 1.00
@PROTOCOL_NAME = can
# ---------------------------------------------------------------------------
# Labels for CAN protocol
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#   Column order: Identifier type, Identifier value, Label
# ---------------------------------------------------------------------------
11,0x064,Diag_Response
11,0x1E5,EngineData
11,0x0A2,Ignition_Info
11,0x1BC,TP_Console
11,0x333,ABSdata
11,0x313,Door_Left
11,0x314,Door_Right
29,0x01A54321,Throttle
29,0x13A00FA2,LightState
29,0x0630ABCD,Engine_Status
29,0x03B1C002,Airbag_Status
29,0x01234ABC,NM_Gateway
# ---------------------------------------------------------------------------- 

Figure 11-11: Label list for CAN

For general information, see Chapter 11.1.4, "Label List", on page 195.

11.5.4 CAN Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values below the waveforms in the format selected with "Data Format". Addition-
ally, you can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

To get data values, you can display and save a "Frame Table" containing decoded
data: frame number, start time of the frame, frame type, identifier, data length code,
data, checksum, and state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198
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Figure 11-12: Decoded CAN signal with frame table and applied label list

violet = identifier
gray = DLC, data length code
blue = data words
red = error occured, error frame

Table 11-4: Content of the CAN frame table

Column Description

Start time Time of frame start in relation to the trigger point

Type Frame type: Data, Remote, Error, or Overload

ID Identifier value, hexadecimal value

Label Symbolic label, available if a label list was loaded and applied

DLC Data length code, number of data bytes

Data Hexadecimal values of the data bytes

CRC Hexadecimal value of the Cyclic Redundance Check (checksum)

State Overall state of the frame.
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Remote commands:
● BUS<b>:CAN:FCOunt? on page 591

BUS<b>:CAN:FRAMe<n>:DATA? on page 593
BUS<b>:CAN:FRAMe<n>:STATus? on page 592
BUS<b>:CAN:FRAMe<n>:STARt? on page 592
BUS<b>:CAN:FRAMe<n>:STOP? on page 593
BUS<b>:CAN:FRAMe<n>:TYPE? on page 591
BUS<b>:CAN:FRAMe<n>:ACKState? on page 593
BUS<b>:CAN:FRAMe<n>:ACKValue? on page 594
BUS<b>:CAN:FRAMe<n>:CSSTate? on page 594
BUS<b>:CAN:FRAMe<n>:CSValue? on page 594
BUS<b>:CAN:FRAMe<n>:DLCState? on page 594
BUS<b>:CAN:FRAMe<n>:DLCValue? on page 595
BUS<b>:CAN:FRAMe<n>:IDSTate? on page 595
BUS<b>:CAN:FRAMe<n>:IDTYpe? on page 595
BUS<b>:CAN:FRAMe<n>:IDValue? on page 596
BUS<b>:CAN:FRAMe<n>:BSEPosition? on page 596
BUS<b>:CAN:FRAMe<n>:BCOunt? on page 596
BUS<b>:CAN:FRAMe<n>:BYTE<o>:STATe? on page 597
BUS<b>:CAN:FRAMe<n>:BYTE<o>:VALue? on page 597

11.5.5 Search on Decoded CAN Data

Using the search functionality, you can find various events in the decoded data, the
same events which you also can trigger on. Before you can start the search, you have
to configure the bus correctly and acquire decoded data.

To search on decoded data, use the search type "Protocol" and select the "Source" -
the bus that is configured for CAN protocol.

See also: Chapter 10, "Search", on page 175.

11.5.5.1 CAN Search Setup

Event
Sets the event or combination of events to be searched for. Depending on the selected
event, the appropriate settings in the softkey menu are activated.

Remote command: 
SEARch:PROTocol:CAN:CONDition on page 598

Frame Setup
Selects the frame type to be searched for.
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If you search for remote or data frames, the search consideres also the ID type, the
length of the identifier.

The setting is only available if "Event" = "Frame" is selected.

Remote command: 
SEARch:PROTocol:CAN:FRAMe on page 598

Error Setup
Selects the error type to be searched for. You can select one or more error types as
search condition.

The error types are the same as in the CAN trigger setup, see "Error <type>"
on page 232.

The setting is only available if "Event" = "Error" or "ID & Error" is selected.

Remote command: 
SEARch:PROTocol:CAN:ACKerror on page 599
SEARch:PROTocol:CAN:BITSterror on page 599
SEARch:PROTocol:CAN:CRCerror on page 599
SEARch:PROTocol:CAN:FORMerror on page 600

Symbolic ID
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

Frame type
Selects the frame type to be searched for, if "Event" = "Identifier" is selected. You can
search for data and or remote frames.

Remote command: 
SEARch:PROTocol:CAN:FTYPe on page 600

Identifier Setup
Opens the menu to set the identifier pattern, if "Event" = "Identifier" or "ID & Data" or
"ID & Error" is selected.

After setting the "ID type" and the "Comparison" condition, you can enter the value bit-
by-bit by setting the state high, low, or don't care for each single bit. Alternatively, you
can enter a hexadecimal value for each byte.

The settings are the same as for the setup of the identifier trigger, see "Identifier
Setup" on page 234.

Remote command: 
SEARch:PROTocol:CAN:ITYPe on page 600
SEARch:PROTocol:CAN:ICONdition on page 600
SEARch:PROTocol:CAN:IDENtifier on page 600

Data Setup
Opens the menu to set the data pattern to be searched, if "Event" = "ID & Data" is
selected.
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After setting the "Data length" and the "Comparison" condition, you can enter the value
bit-by-bit by setting the state high, low, or don't care for each single bit. Alternatively,
you can enter a hexadecimal value for each byte.

The settings are the same as for the setup of the data trigger, see "Data Setup"
on page 235.

Remote command: 
SEARch:PROTocol:CAN:DLENgth on page 601
SEARch:PROTocol:CAN:DCONdition on page 601
SEARch:PROTocol:CAN:DATA on page 601

11.5.5.2 CAN Search Results

Search results (events) are marked on the waveform and listed in the event table as
usual. Instead of the event table, you can display the frame table, where the search
results are also marked. The event flags are not saved in the csv file of the frame table.

Figure 11-13: Search for data frames with 11 bit identifier, search results are marked in frame table
and on the decoded data
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11.6 LIN (Option R&S RTM-K3)

The Local Interconnect Network (LIN) is a simple, low-cost bus system used within
automotive network architectures. LIN is usually a sub-network of a CAN bus. The pri-
mary purpose of LIN is the integration of uncritical sensors and actuators with low
bandwidth requirements. Common applications in a motor vehicle are the control of
doors, windows, wing mirrors, and wipers.

11.6.1 The LIN Protocol

This chapter provides an overview of protocol characteristics, frame format, identifiers
and trigger possibilities. For detailed information, order the LIN specification on http://
www.lin-subbus.org/ (free of charge).

LIN characteristics

Main characteristics of LIN are:
● Single-wire serial communications protocol, based on the UART byte-word inter-

face
● Single master, multiple slaves - usually up to 12 nodes
● Master-controlled communication: master coordinates communication with the LIN

schedule and sends identifier to the slaves
● Synchronization mechanism for clock recovery by slave nodes without crystal or

ceramics resonator

The R&S RTM supports several versions of the LIN standard: v1.3, v2.0, v2.1 and the
American SAE J2602.

Data transfer

Basic communication concept of LIN:
● Communication in an active LIN network is always initiated by the master.
● Master sends a message header including the synchronization break, the synchro-

nization byte, and the message identifier.
● The identified node sends the message response: one to eight data bytes and one

checksum byte.
● Header and response form the message frame.

The data is transmitted in bytes using the UART byte-word interface without the parity
bit. Each byte consists of a start bit, 8 bits and a stop bit.

Figure 11-14: Structure of a byte field

 

 

LIN (Option R&S RTM-K3)

http://www.lin-subbus.org/
http://www.lin-subbus.org/


Protocol AnalysisR&S®RTM2000

242User Manual 1317.4726.02 ─ 10

Data bytes are transmitted LSB first.

The identifier byte consists of 6 bits for the frame identifier and two parity bits. This
combination is known as protected identifier.

Trigger

The R&S RTM can trigger on various parts of LIN frames. The data line must be con-
nected to an input channel, triggering on math and reference waveforms is not possi-
ble.

You can trigger on:
● Frame start (synchronization field)
● Specific slave identifier or identifier range
● Data pattern in the message
● Wake up signal
● Checksum error (error in data), parity error (error in identifier)

11.6.2 LIN Configuration Settings

Access: PROTOCOL > "Bus type" = "LIN" "Configuration"

Data.............................................................................................................................242
Polarity........................................................................................................................ 242
Version........................................................................................................................ 242
Bit rate.........................................................................................................................243
Find Level....................................................................................................................243

Data
Sets the source of the data line. All channel waveforms can be used.

If the MSO option R&S RTM-B1 is installed, digital channels can also be used as
source.

Remote command: 
BUS<b>:LIN:DATA:SOURce on page 602

Polarity
Defines the idle state of the bus. The idle state is the rezessive state and corresponds
to a logic 1.

Remote command: 
BUS<b>:LIN:POLarity on page 602

Version
Selects the version of the LIN standard that is used in the DUT. The setting mainly
defines the checksum version used during decoding.
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The most common version is LIN 2.x. For mixed networks, or if the standard is
unknown, set the LIN standard to "Auto".

Remote command: 
BUS<b>:LIN:STANdard on page 602

Bit rate
Sets the number of transmitted bits per second. The maximum bit rate is 20 kbit/s.

To select a bit rate from the list of predefined values, set "Bit rate" to "Defined Bit
Rate", and then select the value with "Predefined".

To set another value, set "Bit rate" to "User Bit Rate", and then enter the value with
"User".

Remote command: 
BUS<b>:LIN:BITRate on page 603

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555

11.6.3 LIN Trigger Settings

Access: SETUP (Trigger) > "Trigger type" = "Protocol" "Setup"

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

Start of Frame............................................................................................................. 244
Wake Up..................................................................................................................... 244
Error <type>................................................................................................................ 244

└ Checksum.....................................................................................................244
└ Parity.............................................................................................................244
└ Synchronization............................................................................................ 244

Identifier...................................................................................................................... 245
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└ Symbolic ID...................................................................................................245
└ Compare....................................................................................................... 245
└ Bit..................................................................................................................245
└ State..............................................................................................................245
└ Byte...............................................................................................................245
└ Value.............................................................................................................245

Identifier and data....................................................................................................... 246
└ Identifier Setup..............................................................................................246
└ Data Setup....................................................................................................246

└ No. of Bytes........................................................................................ 246

Start of Frame
Triggers on the stop bit of the sync field.

Remote command: 
TRIGger:A:LIN:TYPE on page 604 (SYNC)

Wake Up
Triggers after a wakeup frame.

Remote command: 
TRIGger:A:LIN:TYPE on page 604 (WKFRame)

Error <type>
Identifies various errors in the frame. You can select one or more error types as trigger
condition.

The first key press enables the "Error" trigger type, the second opens the "Error" menu.

Remote command: 
TRIGger:A:LIN:TYPE on page 604 (ERRCondition)

Checksum ← Error <type>
Triggers on a checksum error. The checksum verifies the correct data transmission. It
is the last byte of the frame response. The checksum includes not only the data but
also the protected identifier (PID).

Remote command: 
TRIGger:A:LIN:CHKSerror on page 605

Parity ← Error <type>
Triggers on a parity error. Parity bits are the bits 6 and 7 of the identifier. They verify
the correct transmission of the identifier.

Remote command: 
TRIGger:A:LIN:IPERror on page 605

Synchronization ← Error <type>
Triggers if synchronization caused an error.

Remote command: 
TRIGger:A:LIN:SYERror on page 605
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Identifier
Sets the trigger to a specific identifier or an identifier range. Only the 6 bit identifier
without parity bits is considered, not the protected identifier.

The first key press enables the "Identifier" trigger type, the second opens the "Identi-
fier" menu.

After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low, or don't care for each single bit. Alternatively, you can enter a hexadec-
imal value for each byte.

If a label list with node names was loaded and applied in the bus configuration, you
can select simply the "Symbolic ID" from the list instead of entering the numeric identi-
fier.

Remote command: 
TRIGger:A:LIN:TYPE on page 604 (ID | IDDT)
TRIGger:A:LIN:ICONdition on page 605
TRIGger:A:LIN:IDENtifier on page 605

Symbolic ID ← Identifier
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

Compare ← Identifier
Sets the comparison condition: If the pattern contains at least one X (don't care), you
can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

Bit ← Identifier
Selects the number of the bit in the pattern for bit-by-bit input. For each selected bit,
enter the "State".

State ← Identifier
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Byte ← Identifier
Selects the byte for input of the data pattern. For each selected byte, enter the hexa-
decimal value, or set the "State" for each selected "Bit".

Value ← Identifier
Sets the hexadecimal value for the selected byte by turning the navigation knob.
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Identifier and data
Sets the trigger to a combination of identifier and data condition. The instrument trig-
gers at the end of the last byte of the specified data pattern.

The first key press enables the trigger type, the second one opens the "Identifier and
data" menu.

Identifier Setup ← Identifier and data
Opens the "Identifier" menu.

The identifier conditions are the same as for the "Identifier" trigger type, see "Identifier"
on page 245.

Data Setup ← Identifier and data
Opens a menu to set the data pattern. After setting the "No. of Bytes" and the "Com-
pare" condition, you can enter the value bit-by-bit by setting the state high, low, or don't
care for each single bit. Alternatively, you can enter a hexadecimal value for each byte.

The method is the same as for identifier input. See:
● "Compare" on page 245
● "Bit" on page 245
● "State" on page 245
● "Byte" on page 245
● "Value" on page 245

Remote command: 
TRIGger:A:LIN:TYPE on page 604 (IDDT)
TRIGger:A:LIN:DCONdition on page 606
TRIGger:A:LIN:DATA on page 606

No. of Bytes ← Data Setup ← Identifier and data
Defines the length of the data pattern - the number of bytes in the pattern.

Remote command: 
TRIGger:A:LIN:DLENgth on page 606

11.6.4 LIN Label List

Label lists are protocol-specific. A LIN PTT file contains two values for each identifier:
● "ID / Addr": hexadecimal identifier value
● "Symbolic label": symbolic name for the identifier

Example: LIN PTT file

# ---------------------------------------------------------------------------- 

@FILE_VERSION = 1.0
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@PROTOCOL_NAME = lin 
# ---------------------------------------------------------------------------- 
# Labels for LIN protocol
#   Column order: Identifier, Label
# ---------------------------------------------------------------------------- 
# Labels for standard addresses
0x06,Dashboard
0x13,Gateway
0x1C,Temperature
0x21,Mirror
0x37,Indoor lights
# Labels for reserved addresses
0x3C,Master_Request_Frame
0x3D,Slave_Response_Frame
# ---------------------------------------------------------------------------- 

Figure 11-15: Label list for CAN

For general information, see Chapter 11.1.4, "Label List", on page 195.

11.6.5 LIN Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values below the waveforms in the format selected with "Display". Additionally, you
can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, identifier, data length, data, checksum, and
state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198
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Figure 11-16: Decoded LIN signal with frame table and applied label list

gray = synchronization break, synchronization byte, correct checksum
yellow = identifier
green = parity bits
blue = data words (UART words)

Table 11-5: Content of the LIN frame table

Column Description

Start time Time of frame start in relation to the trigger point

ID Identifier value, hexadecimal value

Label Symbolic label, available if a label list was loaded and applied

Length Number of data bytes

Data Hexadecimal values of the data bytes

Chks Checksum value

State Overall state of the frame.

Remote commands:
● BUS<b>:LIN:FCOunt? on page 607
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● BUS<b>:LIN:FRAMe<n>:DATA? on page 607
● BUS<b>:LIN:FRAMe<n>:STATus? on page 607
● BUS<b>:LIN:FRAMe<n>:STARt? on page 608
● BUS<b>:LIN:FRAMe<n>:STOP? on page 608
● BUS<b>:LIN:FRAMe<n>:VERSion? on page 610
● BUS<b>:LIN:FRAMe<n>:CSSTate? on page 608
● BUS<b>:LIN:FRAMe<n>:CSValue? on page 609
● BUS<b>:LIN:FRAMe<n>:IDPValue? on page 609
● BUS<b>:LIN:FRAMe<n>:IDSTate? on page 609
● BUS<b>:LIN:FRAMe<n>:IDValue? on page 610
● BUS<b>:LIN:FRAMe<n>:SYSTate? on page 610
● BUS<b>:LIN:FRAMe<n>:SYValue? on page 610
● BUS<b>:LIN:FRAMe<n>:BCOunt? on page 611
● BUS<b>:LIN:FRAMe<n>:BYTE<o>:STATe? on page 611
● BUS<b>:LIN:FRAMe<n>:BYTE<o>:VALue? on page 612

11.6.6 Search on Decoded LIN Data

Using the search functionality, you can find various events in the decoded data, the
same events which you also can trigger on. Before you can start the search, you have
to configure the bus correctly and acquire decoded data.

To search on decoded data, use the search type "Protocol" and select the "Source" -
the bus that is configured for LIN protocol.

See also: Chapter 10, "Search", on page 175.

11.6.6.1 LIN Search Setup

Event
Sets the event or combination of events to be searched for. Depending on the selected
event, the appropriate settings in the softkey menu are activated.

Remote command: 
SEARch:PROTocol:LIN:CONDition on page 612

Frame Setup
Selects the frame type to be searched for: Start of frame or wakeup frame.

The setting is only available if "Event" = "Frame" is selected.
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Remote command: 
SEARch:PROTocol:LIN:FRAMe on page 613

Error Setup
Selects the error type to be searched for. You can select one or more error types as
search condition.

The error types are the same as in the LIN trigger setup, see "Error <type>"
on page 244.

The setting is only available if "Event" = "Error" or "ID & Error" is selected.

Remote command: 
SEARch:PROTocol:LIN:CHKSerror on page 614
SEARch:PROTocol:LIN:IPERror on page 613
SEARch:PROTocol:LIN:SYERror on page 614

Symbolic ID
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

Identifier Setup
Opens the menu to set the identifier pattern, if "Event" = "Identifier" or "ID & Data" or
"ID & Error" is selected.

The settings are the same as for the setup of the identifier trigger, see "Identifier"
on page 245.

Remote command: 
SEARch:PROTocol:LIN:ICONdition on page 614
SEARch:PROTocol:LIN:IDENtifier on page 614

Data Setup
Opens the menu to set the data pattern to be searched, if "Event" = "ID & Data" is
selected.

After setting the "No. of Bytes" and the "Comparison" condition, you can enter the
value bit-by-bit by setting the state high, low, or don't care for each single bit. Alterna-
tively, you can enter a hexadecimal value for each byte.

The settings are the same as for the setup of the data trigger, see "Data Setup"
on page 246.

Remote command: 
SEARch:PROTocol:LIN:DLENgth on page 614
SEARch:PROTocol:LIN:DCONdition on page 615
SEARch:PROTocol:LIN:DATA on page 615

11.6.6.2 LIN Search Results

Search results (events) are marked on the waveform and listed in the event table as
usual. Instead of the event table, you can display the frame table, where the search
results are also marked. The event flags are not saved in the csv file of the frame table.
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Figure 11-17: Search for data frames with 11 bit identifier, search results are marked in frame table
and on the decoded data

 

 

 

 

 

 

11.7 Audio Signals (Option R&S RTM-K5)

The R&S RTM can analyze several standard and de-facto industry standard signals:
I²S Inter-IC Sound standard audio format, left justified and right justified data formats
and Time Division Multiplexed (TDM) audio format.
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11.7.1 Audio Protocols

All audio protocols use 3 lines:
● The clock line generates the bit clock.
● The word select line (WS, also known as word clock) defines the frame start and

the maximum length of the data word.
For pulse code modulated signals (I²S standard, left and right justified data for-
mats), the level of the WS signal assigns the data words to the left and right chan-
nels.
TDM uses frame synchronization pulses on the WS line to identify the beginning of
a frame.

● The data line transmits the audio data in time-multiplexed data channels.

11.7.1.1 I²S Standard

I²S standard interfaces transmit two PCM coded audio channels. The WS line selects
the channel being transmitted - left or right channel. Usually, 32 bits are transmitted on
each channel. The data word can be shorter than the channel length, and the receiver
ignores the remaining bits. The first byte of the audio word is delayed one clock period
from the leading edge of the word select pulse. The R&S RTM can decode I²S stan-
dard signals with MSBF and LSBF bit order.

11.7.1.2 Left Justified Data Format

The left justified data format is very similar to the I²S standard, but the first byte of the
audio word is aligned with the leading edge of the word select pulse. Thus the audio
word is left justified within the frame. The data word can be shorter than the channel
length.

In addition to the standard configuration, the R&S RTM can analyze also left justified
data formats which send the data word with offset to the WS edge. The bit order can
be MSBF or LSBF.
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11.7.1.3 Right Justified Data Format

The right-justified data format is similar to the left-justified, but the last byte of the word
in the frame is aligned with the trailing edge of the word select pulse. Thus the audio
word is right-aligned within the frame.

The R&S RTM can analyze also right justified data formats if the data word ends with a
delay after the trailing edge of the WS pulse. The bit order can be MSBF or LSBF.

11.7.1.4 TDM

The Time Division Multiplexed (TDM) audio format is not standardized and provides
high flexibility for transfer of more than two audio data channels on one line. On the
word select line, it uses frame synchronization pulses to identify the beginning of a
frame. On the data line, channel blocks of a defined length are transmitted. Each block
contains an audio word that can be shorter than the channel length.

The first channel can have a delay to the word select edge. Inside the channel, the
audio word also can have an offset to the channel start.

Channel length, channel offset and word length are dependent values:

Channel length ≥ Word length + Channel offset

11.7.2 Audio Signal Configuration

Audio signal are configured for decoding in two menus. The "Configuration" menu is
common for all audio signals. The "Setup" menu contains the specific settings for the
seledcted audio signal variant.

11.7.2.1 Common Configuration

Access: PROTOCOL LOGIC > "Bus type" = "Audio" > "Configuration"
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Threshold setup
Make sure to set the thresholds for the audio lines. Press "Find level" to set the thresh-
old for all analog sources automatically, or set the thresholds manually for each chan-
nel.

If analog channels are used, set the thresholds in the "CH N" menu > "More" >
"Threshold"; see also: "To set the logic threshold for analog channels" on page 193.

If digital channels are used (MSO R&S RTM-B1), set the thresholds in the "Logic" >
"Threshold" menu, see also "Threshold" on page 356.

Remote command: 
BUS<b>:I2S:CLOCk:THReshold on page 618
BUS<b>:I2S:DATA:THReshold on page 618
BUS<b>:I2S:WSELect:THReshold on page 618

Source
Selects the audio line that you want to configure in the menu.

Word Select
Selects the source of the word select line. All analog channels of the instrument can be
used. If MSO option R&S RTM-B1 is installed, you can use also one of the digital
channels.

Remote command: 
BUS<b>:I2S:WSELect:SOURce on page 617

Polarity
For I²S, LJ and RJ signals, the polarity defines the word select values assigned to the
left and right channels.
● "Normal": 0 indicates the left channel, and 1 indicates the right channel. This is the

usual setting.
● "Inverted": 0 indicates the right channel, and 1 the left channel.
For TDM signals, the polarity defines the edge of the frame synchronization pulse that
identifies the beginning of a frame. The frame starts at the next clock edge following
the selected FSYNC edge.
● "Normal": the frame begins with a rising edge. This is the usual setting.
● "Inverted": the frame begins with a falling edge.

Remote command: 
BUS<b>:I2S:WSELect:POLarity on page 617

Clock
Selects the source of the clock line. All analog channels of the instrument can be used.
If MSO option R&S RTM-B1 is installed, you can use also one of the digital channels.

Remote command: 
BUS<b>:I2S:CLOCk:SOURce on page 616
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Slope
Sets the clock edge at which the instrument samples the data on the data line. Usually,
the rising edge is used. The R&S RTM can also analyze the converse setup.

Remote command: 
BUS<b>:I2S:CLOCk:POLarity on page 616

Data
Selects the source of the data line. All analog channels of the instrument can be used.
If MSO option R&S RTM-B1 is installed, you can use also one of the digital channels.

Remote command: 
BUS<b>:I2S:DATA:SOURce on page 617

Active
Defines the interpretation of high and low signal states.
● "Active high": HIGH (signal level above the threshold level) = 1 and LOW (signal

level below the threshold level) = 0
● "Active low": HIGH = 0 and LOW = 1

Remote command: 
BUS<b>:I2S:DATA:POLarity on page 618

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555

Variant
Selects the protocol variant of the audio signal. The configuration possibilities in
R&S RTM exceed the definitions of the standards.

See also: Chapter 11.7.1, "Audio Protocols", on page 252

"I2S Standard" Inter-IC Sound standard audio format. The first byte of the audio word
is delayed one clock period from the leading edge of the word select
pulse.

"Left justified" The left justified data format is very similar to the I²S standard. The
first byte of the audio word is aligned with the leading edge of the
word select pulse. Thus the audio word is left justified within the
frame. In R&S RTM, an additional offset of the audio word can be set.

"Right justified" In right justified data, the last byte of the word in the frame is aligned
with the trailing edge of the word select pulse. Thus the audio word is
right-aligned within the frame. In R&S RTM, an additional offset of the
audio word can be set.
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"TDM" The Time Division Multiplexed audio format can transfer of up to 8
audio data channels on one line. On the word select line, it uses
frame synchronization pulses to identify the beginning of a frame. On
the data line, channel blocks of a defined length are transmitted.
Each block contains an audio word.

Remote command: 
BUS<b>:I2S:AVARiant on page 616

11.7.2.2 Setup of Audio Variants

Access: PROTOCOL LOGIC > "Bus type" = "Audio" > "Configuration" > select "Var-
iant" > "Setup"

Depending on the selected audio variant, different settings are available in the "Setup"
menu.

I²S standard settings

● "First Channel" on page 257
● "Word Length" on page 257
● "Bit Order" on page 257

Left and right justified audio signal settings

● "First Channel" on page 257
● "Channel Offset" on page 257
● "Word Length" on page 257
● "Bit Order" on page 257

TDM signal settings

● "No. of Channels" on page 257
● "Channel Delay" on page 257
● "Channel Length" on page 257
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● "Channel Offset" on page 257
● "Word Length" on page 257
● "Bit Order" on page 257

First Channel
Defines if the left or the right channel is the first channel in the frame.

The setting is available for I²S standard, left and right justified audio signals.

Remote command: 
BUS<b>:I2S:CHANnel:ORDer on page 619

No. of Channels
Sets the number of channels transmitted on the TDM audio line.

Remote command: 
BUS<b>:I2S:CHANnel:TDMCount on page 620

Channel Delay
Sets a delay of the channel blocks after the frame start (word select edge). Thus, all
channels are shifted.

The setting is available only for TDM signals.

Remote command: 
BUS<b>:I2S:FOFFset on page 620

Channel Length
Sets the number of bits in a channel block for TDM audio signals (transmitter length).

The setting is available only for TDM signals.

Remote command: 
BUS<b>:I2S:CHANnel:LENGth on page 620

Channel Offset
Sets the number of bits between the channel start and the start of the audio word. The
setting is available for left justified data format and TDM audio signals.

For TDM, possible values depend on the channel lenght and the word length. The
maximum offset is Channel length - Word length. If you change the channel lenght or
the word length, the channel offset is adjusted automatically.

Remote command: 
BUS<b>:I2S:CHANnel:OFFSet on page 620

Word Length
Defines the number of bits in an audio data word (receiver length). The minimum
length is 1 bit, the maximum length is the channel length.

Remote command: 
BUS<b>:I2S:WLENgth on page 619

Bit Order
Sets the bit order in the audio data words. Usually, the MSB is transmitted first.
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Remote command: 
BUS<b>:I2S:BORDer on page 619

11.7.3 Audio Trigger

If the audio bus is configured and Decode is enabled, you can trigger on the audio sig-
nal. Four trigger types are available: data, window, word select, and error trigger.

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

11.7.3.1 Trigger Type Selection

Access: Trigger SETUP > "Trigger type" = "Protocol" > "Setup"

To configure the data, window, or word select trigger, press the key once to enable the
trigger type, and a second time to open its setup menu. The error trigger has no setup.

Data
Sets the trigger to a data word or a data range that occurs on a specified channel. The
instrument triggers on the last bit of the specified data pattern.

You can also trigger on an AND combination of data conditions on different channels.
The instrument triggers if all conditions are met inside one frame.

Remote command: 
TRIGger:A:I2S:TYPE on page 622 (DATA)

Window
Sets the windows trigger. The windows trigger is a data trigger with additional minimum
time limit. The instrument triggers if the data conditions are fulfilled at least for the
given number of subsequent frames.

Remote command: 
TRIGger:A:I2S:TYPE on page 622 (WINDow)

Word Select
Sets the edge of the word select signal as trigger condition. Using this trigger tpe, you
can trigger on the right or left channel of pulse code modulated signals, and on the
frame start of TDM signals. The instrument triggers on the first clock edge after the
specified edge.

Remote command: 
TRIGger:A:I2S:TYPE on page 622 (WSELect)
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Error
The oscilloscope uses the WS or FSYNC line to monitor the channel and frame length.
An error is detected when two consecutive frames have different length. The instru-
ment triggers on the first clock edge after error detection.

Remote command: 
TRIGger:A:I2S:TYPE on page 622 (ERRCondition)

11.7.3.2 Data Trigger Setup

Sets the trigger to a data word or a data range that occurs on a specified channel. The
instrument triggers on the last bit of the specified data pattern.

You can also trigger on an AND combination of data conditions on different channels.
The instrument triggers if all conditions are met inside one frame.

Channel
Selects the audio channel on which the instrument looks for the specified data condi-
tion. The setting is relevant for trigger types data and window.

Compare
Defines the operator for comparison of the decoded data word with the specified data
word.

The following operators can be set: equal, not equal, greater than, lower than, in range
and out of range.

If the data on the selected channel is not relevant for the trigger condition, select "Don't
care".

The setting is relevant for data and window trigger types.

Remote command: 
TRIGger:A:I2S:CHANnel:LEFT:CONDition on page 623
TRIGger:A:I2S:CHANnel:RIGHt:CONDition on page 623
TRIGger:A:I2S:CHANnel:TDM<n>:CONDition on page 623

Data / Data min. / Data max.
Define the data word(s) to be compared with the decoded data word. The data format
is decimal. The maximum value is limited by the word length. Consider that audio
words are signed numbers in 2's complement format. For example, an 8-bit data word
has a value range from -128 to 127.

The setting is relevant for trigger types data and window.

Remote command: 
TRIGger:A:I2S:CHANnel:LEFT:DMIN on page 623
TRIGger:A:I2S:CHANnel:LEFT:DMAX on page 623
TRIGger:A:I2S:CHANnel:RIGHt:DMIN on page 623
TRIGger:A:I2S:CHANnel:RIGHt:DMAX on page 623
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TRIGger:A:I2S:CHANnel:TDM<n>:DMIN on page 623
TRIGger:A:I2S:CHANnel:TDM<n>:DMAX on page 623

Combination
Sets the logical combination to trigger on data words on different channels. The instru-
ment triggers if all conditions are met inside one frame.

AND: the instrument triggers if the data conditions on all selected channels are fulfilled.

OR: The instrument triggers if one of the specified data conditions is fulfilled.

The setting is relevant for trigger types data and window.

Remote command: 
TRIGger:A:I2S:FUNCtion on page 624

11.7.3.3 Windows Trigger

The windows trigger is a data trigger with additional minimum time limit. The instrument
triggers if the data conditions are fulfilled at least for the given number of subsequent
frames.

Except of the window length, the windows trigger uses the same settings as the data
trigger:
● "Compare" on page 259
● "Channel" on page 259
● "Data / Data min. / Data max." on page 259
● "Combination" on page 260

Window Length
Sets the number of subsequent frames (audio samples) for which the data conditions
are fulfilled.

Remote command: 
TRIGger:A:I2S:WINDow:LENGth on page 624

11.7.3.4 Word Select Trigger

Sets the edge of the word select signal as trigger condition. Using this trigger tpe, you
can trigger on the right or left channel of pulse code modulated signals, and on the
frame start of TDM signals. The instrument triggers on the first clock edge after the
specified edge.

Positive
Sets the rising edge of the word select signal as trigger condition. Consider your WS
"Polarity" setting in the audio configuration menu.

See also: "Polarity" on page 254
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Remote command: 
TRIGger:A:I2S:WSSLope on page 624 (POS)

Negative
Sets the falling edge of the word select signal as trigger condition. Consider your WS
"Polarity" setting in the audio configuration menu.

Remote command: 
TRIGger:A:I2S:WSSLope on page 624 (NEG)

11.7.4 Display of Audio Signals

Access: PROTOCOL LOGIC > "Bus type" = "Audio" > "Display"

If the "Audio" protocol is selected, the "Display" menu contains more functions which
are specific for the audio protocol.

The following display functions are used for all protocoll types:
● "Data format" on page 195
● "Label" on page 195

The following functions are specific for the audio protocol:

Display........................................................................................................................ 261
Track Channel.............................................................................................................262
Track Setup.................................................................................................................262
Default.........................................................................................................................262

Display
Defines how the decoded bus, the bit lines of the channels, and the track waveforms
are displayed.

"Sequential" The decoded data words of the channels are shown in sequential,
horizontal order.

"Seq. + Bits" The decoded data words of the channels are shown in sequential
order, and the individual bit lines are displayed above.

"Seq. + Track" The decoded data words of the channels are shown in sequential
order, and the individual track waveforms are displayed above.
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"Parallel" The decoded data words of the channels are arranged vertically. You
see the data word like you hear the audio signal: all channels at the
same time, with the length of one frame.

"Paral. +
Track"

The decoded data words of the channels are arranged vertically with
frame length, and the individual track waveforms are displayed
above.

"Track" Only the individual track waveforms are displayed.

Remote command: 
BUS<b>:I2S:DISPlay on page 625

Track Channel
Selects the track waveform that is adjusted with the vertical Scale and Position knobs.

For TDM signals, "Track Channel" also selects the tracks that are visible on the dis-
play. Turn the Navigation knob to highlight a track waveform and press the knob to
select or deselect this track.

Remote command: 
BUS<b>:I2S:TRACk:TDM<o>:STATe on page 627

Track Setup
Opens the "Track Setup" menu where you can adjust the scale and position of the
track waveform.

See Chapter 11.7.5, "Tracking Audio Signals", on page 263

Default
Sets all selected tracks to the middle of the display and scales them to full height of the
display (8 divisions). The track waveforms overlap.

Remote command: 
BUS<b>:I2S:TRACk:SET:DEFault on page 628
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11.7.5 Tracking Audio Signals

The track is a waveform that shows data values in time-correlation to the audio signal.
It is the graphical interpretation of all data values of a single acquisition. For audio sig-
nals, the data values on the vertical axis are the decoded values of the audio channels,
the time scale is equivalent to the scale of the source waveform.

Figure 11-18: Tracks of an I²S signal

Access: PROTOCOL LOGIC > "Bus type" = "Audio" > "Display" > "Track Setup"

Figure 11-19: Track setup for I2S, LJ, and RJ audio signals

Figure 11-20: Track setup for TDM signals

Left Position / Right Position / Position
Sets the vertical positiion of the selected track waveform in divisions.
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The virtual screen is available also for tracks. Thus, 20 divisions can be used to
arrange all lines.

Remote command: 
BUS<b>:I2S:TRACk:TDM<o>:POSition on page 627
BUS<b>:I2S:TRACk:LEFT:POSition on page 625
BUS<b>:I2S:TRACk:RIGHt:POSition on page 626

Left Scale / Right Scale / Scale
Sets the zoom factor of the selected track waveform. The Navigation knob sets the
value in 2n steps.

The zoom factor depends on the word length. It is 1, if all 8 divisions of the display are
used. If the factor is >1, the track display is clipped and you can analyze details of the
track waveform.

Remote command: 
BUS<b>:I2S:TRACk:TDM<o>:SCALe on page 627

All visible / Track Channel
Selects the TDM audio channel for which you want to display the track waveform. See
also: "Track Channel" on page 262.

Set to screen
Arranges the selected tracks vertically, one above the other. The instrument adjusts
the vertical scale according to the word length and the number of displayed channels.
The track waveforms do not overlap.

Remote command: 
BUS<b>:I2S:TRACk:SET:SCReen on page 628

Default
See "Default" on page 262

11.7.6 Decode Results of Audio Signals

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values in the format selected with "Display" and "Data Format".

See also: Chapter 11.7.4, "Display of Audio Signals", on page 261

To get data values, you can display and save a "Frame Table" containing decoded
data: frame number, start time of the frame, and audio channel data.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198
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Figure 11-21: Decoded TDM signal, CH1 = Word Select. Audio channels are displayed parallel and
marked with different colors
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Figure 11-22: Decoded I²S signal with frame table

Table 11-6: Content of the audio frame table

Column Description

Frame Frame number

Start time Time of frame start in relation to the trigger point

Left, Right (I²S, LJ, RJ)

CH1, CH2,...CH8 (TDM)

Hexadecimal values of the audio words

Remote commands:
● BUS<b>:I2S:FCOunt? on page 628
● BUS<b>:I2S:FRAMe<n>:STATe? on page 628
● BUS<b>:I2S:FRAMe<n>:STARt? on page 629
● BUS<b>:I2S:FRAMe<n>:STOP? on page 629
● BUS<b>:I2S:FRAMe<n>:LEFT:STATe? on page 630
● BUS<b>:I2S:FRAMe<n>:LEFT:VALue? on page 630
● BUS<b>:I2S:FRAMe<n>:RIGHt:STATe? on page 630
● BUS<b>:I2S:FRAMe<n>:RIGHt:VALue? on page 630
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● BUS<b>:I2S:FRAMe<n>:TDM<o>:STATe? on page 630
● BUS<b>:I2S:FRAMe<n>:TDM<o>:VALue? on page 631

11.8 MIL-STD-1553 (Option R&S RTM-K6)

11.8.1 The MIL-STD-1553

The MIL-STD-1553 specification defines the characteristics of a serial data bus origi-
nally designed for use in the military avionics. Nowadays it is also used in spacecraft
on-board data handling.

The bus is a 2-wire bus that uses differential signals.

A MIL-STD-1553 system consists of the following components:

● Bus Controller (BC): initiates and coordinates the data flow in the system.
● Remote Terminal (RT): interfaces various subsystems with the data bus. A system

can consists of up to 31 RTs and each RT can have 31 subaddresses.
The subaddresses 0 and 31 refer to a mode code command.

● Bus Monitor (BM) (optional): listens to all messages and can record selected data
for real-time or off-line analysis.

The information is transmitted over the bus in defined series of words using Manches-
ter code, where each bit is transmitted as high-low for a logical 1 or a low-high for a
logical 0. There are three types of words: command, data and status.

Command Word

Figure 11-23: Structure of a command word

The format of a command word consists of the following parts (see Figure 11-23):
● Sync: an invalid Manchester waveform.
● Remote Terminal (RT) Address: the unique address of the corresponding RT.
● Transmit/Receive (T/R): indicates the action required from the RT.
● Subaddress/Mode Code: indicates the RT subaddress. The subaddresses 0 and

31 signalize the transmission of a mode code.
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● Data Word Count /Mode Code: indicates the number of words that are sent/
received by the RT. A maximum of 32 words is allowed. This field may be used for
the transmission of the mode code value.

● Parity: checks if there are bit errors during the transmission. The total number of
logic 1 bits for the word (sync bits not included) shall be odd.

Data Word

Figure 11-24: Structure of a data word

The format of a data word consists of the following parts (see Figure 11-24):
● Sync: an invalid Manchester waveform.
● Data: the transferred information (16 bit).
● Parity: checks if there are bit errors during the transmission. The total number of

logic 1 bits for the word (sync bits not included) shall be odd.

Status Word

Figure 11-25: Structure of a status word

The format of a status word consists of the following parts (see Figure 11-25):
● Sync: an invalid Manchester waveform.
● Remote Terminal (RT) Address: the unique address of the corresponding RT.
● Message error: indicates an error in the command/data word transmission from the

BC. A logic 1 indicates presence of a message error and a logic 0 indicates its
absence.
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● Instrumentation: helps to distinguish between a status word and a command word.
The logic state of this bit shall be 0.

● Service Request: indicates that the RT requires service. A logic 1 indicates a pres-
ence of a service request and logic 0 indicates its absence.

● Reserved: bits reserved for future uses.
● Broadcast Command: a logic 1 indicates that the preceding valid command word

was a broadcast command and a logic 0 that it wasn't.
● Busy: a busy state indicates that the RT or the subsystem is not able to transfer

data. A logic 1 indicates a presence of a busy condition and logic 0 indicates its
absence.

● Subsystem Flag: flags a subsystem fault. A logic 1 indicates a presence of a flag
and logic 0 indicates its absence.

● Dynamic Bus Control Acceptance: a logic 1 indicates acceptance of a dynamic bus
control and a logic 0 a rejection.

● Terminal Flag: flags an RT fault condition. A logic 1 indicates a presence of a flag
and logic 0 indicates its absence.

● Parity: checks if there are bit errors during the transmission. The total number of
logic 1 bits for the word (sync bits not included) shall be odd.

For comfortable analysis, you can load an editable label list, to interpret transferred
numeric values as meaningful text labels.

11.8.2 MIL-STD-1553 Configuration

● Configuring MIL-STD-1553................................................................................... 269
● MIL-STD-1553 Configuration Settings.................................................................. 270

11.8.2.1 Configuring MIL-STD-1553

You can define the input channel and set some standard-specific parameters.

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press the "Bus Type" softkey and select "MIL-STD-1553".

4. Press "Configuration".

5. Press "Source" and select the channel.

6. Set the "Polarity" of the signal.

7. Set the "Threshold High" and the "Threshold Low" of the signal or press "Find
level".
See: "To set the logic threshold for analog channels" on page 193

8. Press "Timing setup" and set the maximum for the response time.

Now you can display the decoded signal and the frame table with results.
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The display of the decoded data is described in Chapter 11.8.5, "MIL-STD-1553
Decode Results", on page 279.

11.8.2.2 MIL-STD-1553 Configuration Settings

Access: PROTOCOL > "Bus type" = "MIL-STD-1553"> "Configuration"

Source
Sets the channel for the signal source.

Remote command: 
BUS<b>:MILStd:SOURce on page 632

Polarity
Sets the polarity of the bus.

Remote command: 
BUS<b>:MILStd:POLarity on page 631

Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555

Threshold High
Sets the upper threshold level of the signal.

Remote command: 
BUS<b>:MILStd:THReshold:HIGH on page 632

Threshold Low
Sets the lower threshold level of the signal.

Remote command: 
BUS<b>:MILStd:THReshold:LOW on page 632

Timing Setup
Opens a submenu to set the ranges of the timeouts.
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Response Max ← Timing Setup
Sets a value for the maximum response time.

Remote command: 
BUS<b>:MILStd:RESPonsetime:MAXimum on page 632

Default Timing ← Timing Setup
Resets the response time to its default value of 14 µs.

11.8.3 MIL-STD-1553 Trigger Settings

11.8.3.1 Triggering on MIL-STD-1553 Buses

Prerequisites: The MIL-STD-1553 bus is configured. After configuration, the trigger
type "Protocol (MIL-STD-1553)" is available. See: Chapter 11.8.2, "MIL-STD-1553
Configuration ", on page 269.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol".

3. Press "Source" and select the bus as trigger source.

4. Press "Back".

5. Press "Setup".

6. Press the softkey of the required trigger condition:
● "Synchronization"
● "Word"
● "Error"
● "Command"
● "Status"
● "Cmd. and data"

7. If "Error" is selected, press the softkey again and enable the type of errors you
want to trigger on.

8. If "Command" is selected, press the softkey again and define the command word.

9. If "Status" is selected, press the softkey again and define the status word.
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10. If "Cmd. and data" is selected, press the softkey again and define the transmission
type as well as the command and data word.

11.8.3.2 MIL-STD-1553 Trigger Settings

Access: TRIGGER SETUP > "Trigger Type" = "Protocol"

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

Synchronization...........................................................................................................273
Word............................................................................................................................273
Error............................................................................................................................ 273

└ Synchronization............................................................................................ 273
└ Parity.............................................................................................................273
└ Manchester................................................................................................... 273
└ Timeout.........................................................................................................274

Command....................................................................................................................274
└ Cmd. Type.................................................................................................... 274
└ Symbolic ID...................................................................................................274
└ RT Address...................................................................................................274

└ Compare.............................................................................................274
└ Edit Minimum/Edit Maximum.............................................................. 274

└ Bit............................................................................................. 275
└ Byte.......................................................................................... 275
└ State......................................................................................... 275
└ Value........................................................................................ 275

└ Data Direction............................................................................................... 275
└ Subaddress...................................................................................................275

└ Compare.............................................................................................275
└ Edit Minimum/Edit Maximum.............................................................. 275

└ Word Count...................................................................................................276
└ Compare.............................................................................................276
└ Minimum............................................................................................. 276
└ Maximum............................................................................................ 276

└ Subaddress...................................................................................................276
└ Mode Code................................................................................................... 276
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Status.......................................................................................................................... 276
└ Status............................................................................................................276
└ State..............................................................................................................277

Cmd. and data.............................................................................................................277
└ Transmission.................................................................................................277
└ Command..................................................................................................... 277
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Synchronization
Triggers on a sync impulse. You can select to trigger on "C/S" (Commando/Status), on
"Data" or on "All" sync pulses.

Remote command: 
TRIGger:A:MILStd:SYNC on page 633

Word
Selects the word type to be triggered on. The selected word type is indicated in the
softkey name.

Remote command: 
TRIGger:A:MILStd:WORD on page 633

Error
Triggers on any combination of protocol errors. You can enable triggering on a specific
type of error in the submenu.

Synchronization ← Error
Triggers if a sync impulse doesn't fulfill the technical requirements or when the trans-
mission is not valid.

Remote command: 
TRIGger:A:MILStd:ERRor:SYNC on page 634

Parity ← Error
Checks the parity of every word and triggers if the parity is even.

Remote command: 
TRIGger:A:MILStd:ERRor:PARity on page 633

Manchester ← Error
Triggers if there is an error in the Manchester coding of the signal.
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Remote command: 
TRIGger:A:MILStd:ERRor:MANChester on page 633

Timeout ← Error
Triggers if the timeout is out of the set range. The range can be set in the "Bus type" =
"MIL-STD-1553"> "Configuration" > "Timing setup" menu.

Remote command: 
TRIGger:A:MILStd:ERRor:TIMeout on page 634

Command
Triggers on a command word that is specified in the submenu.

Cmd. Type ← Command
Selects the command type.

Symbolic ID ← Command
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

RT Address ← Command
Opens a submenu to set the RT address.

Compare ← RT Address ← Command
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:MILStd:RTADdress:CONDition on page 635

Edit Minimum/Edit Maximum ← RT Address ← Command
Opens the "Edit Minimum"/"Edit Maximum" submenu.

After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low, or don't care for each single bit. Alternatively, you can enter a hexadec-
imal value.

MIL-STD-1553 (Option R&S RTM-K6)



Protocol AnalysisR&S®RTM2000

275User Manual 1317.4726.02 ─ 10

Remote command: 
TRIGger:A:MILStd:RTADdress:MAXimum on page 635
TRIGger:A:MILStd:RTADdress:MINimum on page 635

Bit ← Edit Minimum/Edit Maximum ← RT Address ← Command
Selects the number of the bit in the pattern for bit-by-bit input. For each selected bit,
enter the "State".

Byte ← Edit Minimum/Edit Maximum ← RT Address ← Command
Selects the byte for input of the data pattern. For each selected byte, enter the hexa-
decimal value, or set the "State" for each selected "Bit".

State ← Edit Minimum/Edit Maximum ← RT Address ← Command
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Value ← Edit Minimum/Edit Maximum ← RT Address ← Command
Sets the hexadecimal value for the selected byte by turning the navigation knob.

Data Direction ← Command
Toggles the data direction of the selected command: T (transmit), R (receive), or X
(either).

Remote command: 
TRIGger:A:MILStd:TRMode on page 636

Subaddress ← Command
Opens a submenu to set the subaddress.

Compare ← Subaddress ← Command
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:MILStd:SADDress:CONDition on page 636

Edit Minimum/Edit Maximum ← Subaddress ← Command
Opens the "Edit Minimum"/"Edit Maximum" submenu.

After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low or don't care for each single bit. Alternatively, you can enter a hexadeci-
mal value.

The functions are the same as for "RT Address", see: "RT Address" on page 274.

Remote command: 
TRIGger:A:MILStd:SADDress:MAXimum on page 636
TRIGger:A:MILStd:SADDress:MINimum on page 636
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Word Count ← Command
Opens a submenu to set the word count.

Compare ← Word Count ← Command
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:MILStd:WCOunt:CONDition on page 636

Minimum ← Word Count ← Command
Sets the minimum of the word count range.

Remote command: 
TRIGger:A:MILStd:WCOunt:MINimum on page 637

Maximum ← Word Count ← Command
Sets the maximum of the word count range.

Remote command: 
TRIGger:A:MILStd:WCOunt:MAXimum on page 637

Subaddress ← Command
When "Command Type" > "Mode Code" is selected the subaddress selection is restric-
ted to "0", "31" or "0 | 31"

Remote command: 
TRIGger:A:MILStd:SADDress:MCADdress on page 636

Mode Code ← Command
Selects the type of mode code when "Command Type" > "Mode Code" is selected.

Remote command: 
TRIGger:A:MILStd:MCODe:CODE on page 634

Status
Triggers on a status word that is specified in the submenu.

The functions of the "RT Address" are the same as for the "Command" word, see: "RT
Address" on page 274.

Status ← Status
Selects a status bit. For each bit, you can select the "State" to be triggered on.

See also: "Status Word" on page 268
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Remote command: 
TRIGger:A:MILStd:STATus:BCReceived on page 637
TRIGger:A:MILStd:STATus:BUSY on page 637
TRIGger:A:MILStd:STATus:DBCaccept on page 637
TRIGger:A:MILStd:STATus:INSTrument on page 637
TRIGger:A:MILStd:STATus:MERRor on page 638
TRIGger:A:MILStd:STATus:SREQuest on page 638
TRIGger:A:MILStd:STATus:SUBSystem on page 638
TRIGger:A:MILStd:STATus:TERMinal on page 638

State ← Status
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Cmd. and data
Triggers on command and data, that are specified in the submenus.

Transmission ← Cmd. and data
Sets the transmission type: "BC-RT" (bus controller to remote terminal); "RT - BC"
(remote terminal to bus controller), "RT - RT" (remote terminal to remote terminal),
"Mode Code with data".

Remote command: 
TRIGger:A:MILStd:TTYPe on page 639

Command ← Cmd. and data
Triggers on a command, that is specified in the submenu. The available settings
depend on the selected "Transmission".

The command settings are described in: "Command" on page 274.

Data ← Cmd. and data
Triggers on a data, that is specified in the submenu.

Offset Compare ← Data ← Cmd. and data
Sets the condition how the decoded value is compared with the defined offset.

Remote command: 
TRIGger:A:MILStd:DATA:OFFSet:CONDition on page 639

Offset ← Data ← Cmd. and data
Sets a word offset.
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Remote command: 
TRIGger:A:MILStd:DATA:OFFSet on page 639

Data Words ← Data ← Cmd. and data
Sets the number of words. Up to four words can be set.

Remote command: 
TRIGger:A:MILStd:DATA:WORDs on page 639

Data Compare ← Data ← Cmd. and data
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:MILStd:DATA:CONDition on page 638

Minimum/Maximum ← Data ← Cmd. and data
Opens the "Minimum"/"Maximum" submenu.

After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low, or don't care for each single bit. Alternatively, you can enter a hexadec-
imal value for each byte.

The functions are the same as for "RT Address", see: "RT Address" on page 274.

Remote command: 
TRIGger:A:MILStd:DATA:MAXimum on page 639
TRIGger:A:MILStd:DATA:MINimum on page 639

11.8.4 MIL-STD-1553 Label List

Label lists are protocol-specific. A MIL-STD-1553 file contains three values for each
identifier:
● "Symbolic label": symbolic name of addressed device, or the label of the sub

address. The Labels are sorted in alphabetic order.
● "RT Addr.": hexadecimal remote terminal address value
● "Sub Addr": hexadecimal sub address value

Example: MIL PTT file

# ----------------------------------------------------------- 
# Labels for MIL.1553 protocol
# Column order: RT address, RT label, Subaddress, Subaddress Label
# --------------------------------------------------------------------- 
@PROTOCOL_NAME = mil1553
0Ah,Engine,01h,Thrust
03h,Main panel,07h,Altimeter
03h,Main panel,01h,Speed
0Eh,Only RTA
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11.8.5 MIL-STD-1553 Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values below the waveforms in the format selected with "Display".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, word type, RTA, data direction, subaddress,
label, word count , data, response/IMG time and state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198

Table 11-7: Content of the MIL-STD-1553 frame table

Column Description

Start time Time of word start in relation to the trigger point

Type Word Type

RTA RT address

Label Symbolic label, available if a label list was loaded and applied

T/R Data direction, transmit or receive

Sub Subaddress

Length Number of data bytes

Data Hexadecimal values of the data bytes

RT/IMG Response time/intermessage gap time

State Overall state of the word

Remote Commands
● BUS<b>:MILStd:WCOunt? on page 640
● BUS<b>:MILStd:WORD<n>:COMMand:MCODe:CODE? on page 641
● BUS<b>:MILStd:WORD<n>:COMMand:MCODe:VALue? on page 641
● BUS<b>:MILStd:WORD<n>:COMMand:RTADdress? on page 641
● BUS<b>:MILStd:WORD<n>:COMMand:SADDress? on page 641
● BUS<b>:MILStd:WORD<n>:COMMand:WCOunt? on page 642
● BUS<b>:MILStd:WORD<n>:DATA? on page 642
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● BUS<b>:MILStd:WORD<n>:IMGTime? on page 642
● BUS<b>:MILStd:WORD<n>:PARity? on page 642
● BUS<b>:MILStd:WORD<n>:RTIMe? on page 643
● BUS<b>:MILStd:WORD<n>:STARt? on page 643
● BUS<b>:MILStd:WORD<n>:STATus? on page 643
● BUS<b>:MILStd:WORD<n>:STATus:BCReceived? on page 643
● BUS<b>:MILStd:WORD<n>:STATus:BUSY? on page 644
● BUS<b>:MILStd:WORD<n>:STATus:DBCaccept? on page 644
● BUS<b>:MILStd:WORD<n>:STATus:INSTrument? on page 644
● BUS<b>:MILStd:WORD<n>:STATus:MERRor? on page 644
● BUS<b>:MILStd:WORD<n>:STATus:RTADdress? on page 645
● BUS<b>:MILStd:WORD<n>:STATus:SREQuest? on page 645
● BUS<b>:MILStd:WORD<n>:STATus:SUBSystem? on page 645
● BUS<b>:MILStd:WORD<n>:STATus:TERMinal? on page 645
● BUS<b>:MILStd:WORD<n>:STOP? on page 646
● BUS<b>:MILStd:WORD<n>:TRMode? on page 646
● BUS<b>:MILStd:WORD<n>:TYPE? on page 646

11.8.6 Search on Decoded MIL-STD-1553 Data

Using the search functionality, you can find various events in the decoded data, the
same events which you also can trigger on. Before you can start the search, you have
to configure the bus correctly and acquire decoded data.

To search on decoded data, use the search type "Protocol" and select the "Source" -
the bus that is configured for MIL-STD-1553 protocol.

See also: Chapter 10, "Search", on page 175.

11.8.6.1 MIL-STD-1553 Search Setup

Event
Sets the event or combination of events to be searched for. Depending on the selected
event, the appropriate settings in the softkey menu are activated.

Remote command: 
SEARch:PROTocol:MILStd:CONDition on page 647

Word Start
Selects the word start to be searched for.
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Remote command: 
SEARch:PROTocol:MILStd:WSTart on page 652

Error
Searches for the selected error type.

The error types are the same as in the MIL-STD-1553 trigger setup, see "Error"
on page 273.

Remote command: 
SEARch:PROTocol:MILStd:ERRor on page 648

RT Address
Opens a submenu to set the RT address to be searched for.

The settings are the same as for the setup of the RT address trigger, see "RT Address"
on page 274.

Remote command: 
SEARch:PROTocol:MILStd:RTADdress:COMPare on page 649
SEARch:PROTocol:MILStd:RTADdress:CONDition on page 649
SEARch:PROTocol:MILStd:RTADdress:MAXimum on page 649
SEARch:PROTocol:MILStd:RTADdress:MINimum on page 649

Data direction
Selects the data direction to be searched for :T (transmit), R (receive), or X (either).

Remote command: 
SEARch:PROTocol:MILStd:TRMode on page 652

Sub Address
Opens a submenu to set the sub address to be searched for.

The settings are the same as for the setup of the sub address trigger, see "Subad-
dress" on page 275 .

Remote command: 
SEARch:PROTocol:MILStd:SADDress:COMPare on page 649
SEARch:PROTocol:MILStd:SADDress:CONDition on page 650
SEARch:PROTocol:MILStd:SADDress:MAXimum on page 650
SEARch:PROTocol:MILStd:SADDress:MINimum on page 650

Word Count
Opens a submenu to set the word count to be searched for.

The settings are the same as for the setup of the word count trigger, see "Word Count"
on page 276.

Remote command: 
SEARch:PROTocol:MILStd:WCOunt:COMPare on page 652
SEARch:PROTocol:MILStd:WCOunt:CONDition on page 652
SEARch:PROTocol:MILStd:WCOunt:MAXimum on page 653
SEARch:PROTocol:MILStd:WCOunt:MINimum on page 653
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Sub Address (Mode Code)
Searches for a mode code sub address.

Remote command: 
SEARch:PROTocol:MILStd:SADDress:MCADdress on page 650

Mode Code
Sets the mode code to be searched for.

Remote command: 
SEARch:PROTocol:MILStd:MCODe on page 648

Status
Selects a status bit to be searched for. For each bit, you can select the "State" to be
searched for.

Remote command: 
SEARch:PROTocol:MILStd:STATus:BCReceived on page 650
SEARch:PROTocol:MILStd:STATus:BUSY on page 650
SEARch:PROTocol:MILStd:STATus:DBCaccept on page 651
SEARch:PROTocol:MILStd:STATus:INSTrument on page 651
SEARch:PROTocol:MILStd:STATus:MERRor on page 651
SEARch:PROTocol:MILStd:STATus:SREQuest on page 651
SEARch:PROTocol:MILStd:STATus:SUBSystem on page 651
SEARch:PROTocol:MILStd:STATus:TERMinal on page 651

State
Toggles the logic state of the with "Status" selected bit: 0 (low), 1 (high), or X (don't
care).

Data
Searches for a specified data.

Remote command: 
SEARch:PROTocol:MILStd:DATA:COMPare on page 647
SEARch:PROTocol:MILStd:DATA:CONDition on page 648
SEARch:PROTocol:MILStd:DATA:MAXimum on page 648
SEARch:PROTocol:MILStd:DATA:MINimum on page 648
SEARch:PROTocol:MILStd:DATA:OFFSet on page 648
SEARch:PROTocol:MILStd:DATA:WORDs on page 648

Transmission
Sets the transmission type to be searched for: "BC-RT" (bus controller to remote termi-
nal); "RT - BC" (remote terminal to bus controller), "RT - RT" (remote terminal to
remote terminal), "Mode Code with data".

Remote command: 
SEARch:PROTocol:MILStd:TTYPe on page 652

Command
Opens a submenu to configure the command to be searched for.
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The settings are the same as for the setup of the command trigger, see "Command"
on page 274.

11.9 ARINC 429 (Option R&S RTM-K7)

11.9.1 ARINC 429 Basics

The ARINC 429 is a specification that defines the characteristics of an avionic data bus
used on commercial and transport aircraft.

In an ARINC 429 system, a single transmitter/source is connected to 1-20 receivers/
sinks on one twisted wire pair. The bus uses differential signals. The ARINC 429 stan-
dard uses a simplex communication - data may be transmitted in only one direction.
The information is transmitted over the bus in defined series of words.

Word Format

Figure 11-26: Structure of an ARINC 429 word

An ARINC 429 word is 32-bits and consists of the following parts (see Figure 11-26):
● Parity: the most significant bit (MSB). Checks if there are bit errors during the trans-

mission. The total number of logic 1 bits for the word shall be odd.
● Sign/Status Matrix (SSM): the value of these bits depend on the data type. It may

be used to report the status of hardware equipment.
● Data:

– Binary (BNR): stores the data as a binary number.
– Binary Coded Decimal (BCD): uses 4 data field bits to represent a decimal

digit.
– Discrete data: a combination of BNR and/ or BCD or individual bits that express

specific equipment conditions.
– Maintenance data and acknowledgment
– Williamsburg / Buckhorn protocol: a bit-oriented protocol that is used for file

transfer.
● Source/Destination Identifier (SDI): indicates the intended receiver or the transmit-

ting subsystem.
● Label: gives information about the word's data type.

For comfortable analysis, you can load an editable label list, to interpret transferred
numeric values as meaningful text labels.
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11.9.2 ARINC 429 Configuration

● Configuring ARINC 429 ........................................................................................284
● ARINC 429 Configuration Settings........................................................................284
● ARINC 429 Display Settings................................................................................. 285

11.9.2.1 Configuring ARINC 429

You can define the input channel and set some standard-specific parameters.

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press the "Bus Type" softkey and select "ARINC 429".

4. Press "Configuration".

5. Press "Source" and select the channel.

6. Set the "Polarity" of the signal.

7. Set the "Threshold High" and the "Threshold Low" of the signal or press "Find
level", or set the threshold manually.
See: "To set the logic threshold for analog channels" on page 193

8. Press "Bitrate" and set the bitrate speed.

Now you can display the decoded signal and the frame table with results.

The display of the decoded data is described in Chapter 11.9.5, "ARINC 429 Decode
Results", on page 293.

11.9.2.2 ARINC 429 Configuration Settings

Access: PROTOCOL > "Bus type" = "ARINC 429"> "Configuration"

Source
Sets the channel for the signal source.

Remote command: 
BUS<b>:ARINc:SOURce on page 654

Polarity
Sets the polarity of the bus.

Remote command: 
BUS<b>:ARINc:POLarity on page 654
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Find Level
The instrument analyzes all analog channels that are configured for the selected bus
and sets the threshold for digitization for each channel. If no level can be found, the
existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: "Threshold" on page 38

"Find Level" is not relevant for digital channels (MSO R&S RTM-B1). Thresholds for
digital channels are set in the "Logic > Threshold" menu.

Remote command: 
CHANnel<m>:THReshold:FINDlevel on page 555

Threshold High
Sets the upper threshold level of the signal.

Remote command: 
BUS<b>:ARINc:THReshold:HIGH on page 654

Threshold Low
Sets the lower threshold level of the signal.

Remote command: 
BUS<b>:ARINc:THReshold:LOW on page 654

Bit Rate
Opens a submenu to set the bit rate.

"Low Speed" Sets the speed to 12.5 kBit/s

"High Speed" Sets the speed to 100 kBit/s

"User" Set a user defined speed.

Remote command: 
BUS<b>:ARINc:BRMode on page 653
BUS<b>:ARINc:BRValue on page 653

11.9.2.3 ARINC 429 Display Settings

Access: PROTOCOL LOGIC > if "Logic" menu is displayed: "Protocol" > "Display"

This chapter describes only the ARINC 429 specific display settings. For a description
of the general protocol display settings, see Chapter 11.1.3, "Display Settings",
on page 194.

Decode format
Sets the decoding data format for the ARINC 429 bus: Data, SSM+Data, SSM+Data
+SDI, Data+SDI.
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Remote command: 
BUS<b>:ARINc:DATA:FORMat on page 659

11.9.3 ARINC 429 Trigger Settings

11.9.3.1 Triggering on ARINC 429 Buses

Prerequisites: The ARINC 429 bus is configured. After configuration, the trigger type
"Protocol ( ARINC 429)" is available. See:Chapter 11.9.2, "ARINC 429 Configuration",
on page 284.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol".

3. Press "Source" and select the bus as trigger source.

4. Press "Back".

5. Press "Setup".

6. Press the softkey of the required trigger condition:
● "Word"
● "Error"
● "Label"
● "Label and Data"
● "Transmission"

7. If "Error" is selected, press the softkey again and enable the type of errors you
want to trigger on.

8. If "Label" is selected, press the softkey again and define the label range.

9. If "Label and Data" is selected, press the softkey again and define the label, trigger
format SSM/SDI and the data.

10. If "Transmission" is selected, press the softkey again and define the label, trigger
format and the timing setup.

11.9.3.2 ARINC 429 Trigger Settings

Access: TRIGGER SETUP > "Trigger Type" = "Protocol"

 

 

 

ARINC 429 (Option R&S RTM-K7)



Protocol AnalysisR&S®RTM2000

287User Manual 1317.4726.02 ─ 10

Triggers are only available if "Decode" is enabled.
Make sure to set the correct bus as trigger source: Trigger SETUP > "Trigger type" =
"Protocol" > "Source", see Chapter 11.1.6, "Trigger Source", on page 199.

Word............................................................................................................................287
Error............................................................................................................................ 288
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└ Edit Label Minimum/Edit Label Maximum.....................................................288
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└ Data Size............................................................................................ 290
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Word
Triggers on a word start or word stop.
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Remote command: 
TRIGger:A:ARINc:WORD:TYPE on page 658

Error
Triggers on any combination of protocol errors. You can enable triggering on a specific
type of error in the submenu.

Parity ← Error
Checks the parity and triggers if the parity is even.

Remote command: 
TRIGger:A:ARINc:ERRor:PARity on page 656

Gap Error ← Error
Triggers on a gap error. The gap is calculated automatically from the set sample rate.

Remote command: 
TRIGger:A:ARINc:ERRor:GAP on page 656

Coding Error ← Error
Triggers on a coding error.

Remote command: 
TRIGger:A:ARINc:ERRor:CODing on page 656

Label
Opens a submenu to set the label.

Symbolic ID ← Label
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

Compare ← Label
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:ARINc:LABel:CONDition on page 656

Edit Label Minimum/Edit Label Maximum ← Label
Opens the "Edit Minimum"/"Edit Maximum" submenu.
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After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low, or don't care for each single bit. Alternatively, you can enter a hexadec-
imal value.

Remote command: 
TRIGger:A:ARINc:LABel:MAXimum on page 657
TRIGger:A:ARINc:LABel:MINimum on page 657

Bit ← Edit Label Minimum/Edit Label Maximum ← Label
Selects the number of the bit in the pattern for bit-by-bit input. For each selected bit,
enter the "State".

Byte ← Edit Label Minimum/Edit Label Maximum ← Label
Selects the byte for input of the data pattern. For each selected byte, enter the hexa-
decimal value, or set the "State" for each selected "Bit".

State ← Edit Label Minimum/Edit Label Maximum ← Label
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Value ← Edit Label Minimum/Edit Label Maximum ← Label
Sets the hexadecimal value for the selected byte by turning the navigation knob.

Label and Data
Opens a submenu to set the label and data.

Label ← Label and Data
Opens a submenu to configure the label.

See: "Label" on page 288.

Trigger Format ← Label and Data
Selects the transmission format to be triggered on: "Data", "SSM+Data", "SSM+Data
+SDI", "Data+SDI".

Remote command: 
TRIGger:A:ARINc:FORMat on page 656

SSM ← Label and Data
Sets the values for the sign/status matrix (SSM) bits.

Remote command: 
TRIGger:A:ARINc:SSM on page 657
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Data ← Label and Data
Triggers on a data, that is specified in the submenu.

Data Offset ← Data ← Label and Data
Sets a data offset.

Remote command: 
TRIGger:A:ARINc:DATA:OFFSet on page 655

Data Size ← Data ← Label and Data
Sets the data size.

Remote command: 
TRIGger:A:ARINc:DATA:SIZE on page 656

Compare ← Data ← Label and Data
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:ARINc:DATA:CONDition on page 655

Edit Data Min/Edit Data Max ← Data ← Label and Data
After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low, or don't care for each single bit. Alternatively, you can enter a hexadec-
imal value for each byte.

The functions are the same as for "Label", see: .

Remote command: 
TRIGger:A:ARINc:DATA:MAXimum on page 655
TRIGger:A:ARINc:DATA:MINimum on page 655

SDI ← Label and Data
Sets the values for the source/destination identifier (SDI) bits.

Remote command: 
TRIGger:A:ARINc:SDI on page 657

Transmission
Opens a submenu to set the transmission
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Symbolic ID ← Transmission
If a label list with node names was loaded and applied in the bus configuration, you
can select simply the node name from the list instead of entering the numeric identifier.

The instrument triggers on the identifier of the selected node.

Label ← Transmission
Opens a submenu to configure the label.

See: "Label" on page 288.

Trigger Format ← Transmission
Selects the transmission format to be triggered on: "Data", "SSM+Data", "SSM+Data
+SDI", "Data+SDI".

Remote command: 
TRIGger:A:ARINc:FORMat on page 656

SDI ← Transmission
Sets the values for the source/destination identifier (SDI) bits.

Remote command: 
TRIGger:A:ARINc:SDI on page 657

Timing Setup ← Transmission
Opens a submenu to set a transmission time interval to be triggered on. For a refer-
ence on the real-time transmission times that a system has to fulfill refer to ARINC 429
standard.

Compare ← Timing Setup ← Transmission
Sets the condition how the decoded value is compared with the defined range.

Remote command: 
TRIGger:A:ARINc:TTIMe:CONDition on page 658

Min. Time ← Timing Setup ← Transmission
Sets the minimum of the transmission time range.

Remote command: 
TRIGger:A:ARINc:TTIMe:MINimum on page 658

Max. Time ← Timing Setup ← Transmission
Sets the maximum of the transmission time range.

Remote command: 
TRIGger:A:ARINc:TTIMe:MAXimum on page 658
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11.9.4 ARINC 429 Label List

Label lists are protocol-specific. An ARINC 429 file contains three values for each iden-
tifier:
● "Arinc Label": the Arinc 429 label value, that identifies the data type and the param-

eters associated with it.
● "Symbolic label": symbolic name of the label, specifying the device function.
● "Word Format": an optional parameter to describe the composition of the ARINC

429 word. It can be provided as integer value or mnemonic.

Word format definition

0 or DATA           = <P><         Data          ><Label>
1 or DATA_SDI       = <P><         Data     ><SDI><Label>
2 or DATA_SSM       = <P><SSM><    Data          ><Label>
3 or DATA_SDI_SSM   = <P><SSM><    Data     ><SDI><Label>
>3 or SYSTEM_DEFAULT or empty = Default format as defined in scope.

Example: ARINC 429 PTT file
# ---------------------------------------------------------------------------- 
@FILE_VERSION = 1.0
@PROTOCOL_NAME = arinc429
# ---------------------------------------------------------------------------- 
# Labels for ARINC protocol
# Column order: Numeric address (Label), Symbolic label, Word format
# ---------------------------------------------------------------------------- 
# ----Definition----
@PROTOCOL_NAME = arinc429
101o, Distance to Go, 0
102o, Time to Go, DATA_SDI
103o, Engine Discrete, DATA_SSM
104o, Latitude, 3
105o, Ground Speed, 4
106o, Magnetic heading
# ---------------------------------------------------------------------------- 
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11.9.5 ARINC 429 Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the deco-
ded values below the waveforms in the format selected with "Display". Additionally, you
can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, label, SDI, SSM, data, and state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198

Table 11-8: Content of the "Decode results" table

Column Description

Start time Time of word start in relation to the trigger point

Stop time Time of word stop in relation to the trigger point

Label name Symbolic label, available if a label list was loaded and applied

Label The value of the label bytes

SDI The state of the SDI bits

SSM The state of the SSM bits

Data The value of the data bytes

State Overall state of the frame

The number of bits in the data column depends on the SDI and/or SSM status. The
SDI and SSM fields have each 2 bits. The word format is also considered in the comb
display of the data.
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Figure 11-27: Symbolic labels and decoded data in the ARINC 429 results table

blue = The columns SDI, Data and SSM are set according to the defined word format
magenta = no word format or SYSTEM_DEFAULT is defined. The"Decode Format" setting is used.

Remote Commands:
● BUS<b>:ARINc:DATA:FORMat on page 659
● BUS<b>:ARINc:WCOunt? on page 659
● BUS<b>:ARINc:WORD<n>:DATA? on page 659
● BUS<b>:ARINc:WORD<n>:DATA[:VALue]? on page 659
● BUS<b>:ARINc:WORD<n>:FORMat? on page 659
● BUS<b>:ARINc:WORD<n>:LABel? on page 660
● BUS<b>:ARINc:WORD<n>:LABel[:VALue]? on page 660
● BUS<b>:ARINc:WORD<n>:PARity? on page 660
● BUS<b>:ARINc:WORD<n>:PATTern? on page 660
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● BUS<b>:ARINc:WORD<n>:SDI? on page 660
● BUS<b>:ARINc:WORD<n>:SSM? on page 661
● BUS<b>:ARINc:WORD<n>:STARt? on page 661
● BUS<b>:ARINc:WORD<n>:STOP? on page 661
● BUS<b>:ARINc:WORD<n>:STATus? on page 661

11.9.6 Search on Decoded ARINC 429 Data

Using the search functionality, you can find various events in the decoded data, the
same events which you also can trigger on. Before you can start the search, you have
to configure the bus correctly and acquire decoded data.

To search on decoded data, use the search type "Protocol" and select the "Source" -
the bus that is configured for ARINC 429 protocol.

See also: Chapter 10, "Search", on page 175.

11.9.6.1 ARINC 429 Search Setup

Event
Sets the event or combination of events to be searched for. Depending on the selected
event, the appropriate settings in the softkey menu are activated.

Remote command: 
SEARch:PROTocol:ARINc:CONDition on page 662

Word Start/ Word Stop
Searches for a word start or a word stop.

Remote command: 
SEARch:PROTocol:ARINc:WORD[:TYPE] on page 665

Error
Selects the error type to be searched for.

The error types are the same as in the ARINC 429 trigger setup, see "Error"
on page 288.

Remote command: 
SEARch:PROTocol:ARINc:ERRor on page 663

Label
Opens the menu to set the label to be searched for.

The settings are the same as for the setup of the label trigger, see "Label"
on page 288.
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Remote command: 
SEARch:PROTocol:ARINc:LABel:CONDition on page 664
SEARch:PROTocol:ARINc:LABel:MAXimum on page 664
SEARch:PROTocol:ARINc:LABel:MINimum on page 664

Data format
Selects the data format to be searched for.

Remote command: 
SEARch:PROTocol:ARINc:FORMat on page 663

SDI
Searches for the source/destination identifier (SDI) bits.

Remote command: 
SEARch:PROTocol:ARINc:SDI on page 664

Data
Opens the menu to set the data to be searched for.

The settings are the same as for the setup of the label trigger, see "Data" on page 290.

Remote command: 
SEARch:PROTocol:ARINc:DATA:CONDition on page 662
SEARch:PROTocol:ARINc:DATA:MAXimum on page 662
SEARch:PROTocol:ARINc:DATA:MINimum on page 663
SEARch:PROTocol:ARINc:DATA:OFFSet on page 663
SEARch:PROTocol:ARINc:DATA:SIZE on page 663

SSM
Searches for sign/status matrix (SSM) bits.

Remote command: 
SEARch:PROTocol:ARINc:SSM on page 664
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12 Power Analysis (Option R&S RTM-K31)
With the R&S RTM and option R&S RTM-K31 you can perform power analysis mea-
surements.

The following power measurements are available:
● Quality
● Consumption
● Harmonics
● Inrush Current
● Ripple
● Spectrum
● Transient Response
● Slew Rate
● Modulation
● Dynamic On Resistance
● Efficiency
● Switching Loss
● Turn ON/OFF Time
● Safe Operating Area (S.O.A.)

12.1 Probe Adjustment

12.1.1 Deskewing the Probes

Some power measurements require a current and a voltage probe. Before you start
one of these measurements, you need to deskew the probes to get correct measure-
ment results. The settings menu of the corresponding measurements contain the
"Probe" function to adjust the probes.

Required equipment:
● R&S RT-ZF20 power deskew fixture
● Rohde & Schwarz voltage probe
● Rohde & Schwarz current probe

1. Connect the voltage probe and the current probe to the oscilloscope.

2. Check and adjust the probe setup for each probe: CH N key > "More" > "Probe".

3. Press the TOOLS key.

4. Select "Power Analysis".
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5. Press "Analysis" repeatedly until the required measurement is selected.

6. Select the correct channels for "Voltage" and "Current".

7. Connect the probes to the R&S RT-ZF20 power deskew fixture.
Refer to the R&S RT-ZF20 Manual for a detailed description.

8. Press "Probe".

9. Press "Deskew".

The automatic deskew procedure aligns the waveforms of all visible channels.

12.1.2 Probe Settings for Power Measurements

The probe menu is available from the main "Power" menu if "Analysis" is switched off.
It is also available in many power measurement menus.

Deskew
Use the R&S RT-ZF20 power deskew fixture to deskew the probes.

Starts the automatic deskew procedure to align the waveforms of all visible channels. It
is necessary to deskew if a current and a voltage probe is used in the measurement.

Remote command: 
POWer:DESKew[:EXECute] on page 667

Zero Offset
Differences in DUT and oscilloscope ground levels may cause larger zero errors affect-
ing the waveform. If the DUT is ground-referenced, the "Zero Offset" corrects the zero
error of the probe to optimize measurement results at small signal levels.

Short the signal pin and the ground pin together and connect them to the ground of the
DUT. Then press "Zero Offset".

Remote command: 
POWer:ZOFFset[:EXECute] on page 667

12.2 Statistic Menu Settings

In the statistic menu you can enable and configure statistic measurements. It is availa-
ble only for some power measurements.
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Visible
Activates or deactivates the statistical evaluation of the measurement.

Average No.
Sets the number of measured waveforms used for calculation of average and standard
deviation. The maximum number is 1000.

Reset all
Deletes the statistical results for the current measurement or all measurements,
respectivley, and starts a new statistical evaluation if the acquisition is running.

Export
Opens the "Export" menu to save the measurement results to a CSV file.

See: Chapter 15.3.1.3, "General Storage Settings", on page 370.

Remote command: 
EXPort:MEASurement<m>:STATistics:NAME on page 493
EXPort:MEASurement<m>:STATistics:SAVE on page 493
EXPort:MEASurement<m>:STATistics:ALL:NAME on page 494
EXPort:MEASurement<m>:STATistics:ALL:SAVE on page 494

12.3 Result Table Settings

In the the result table menu you can set the display settings and export the results to
file. It is available only for some power measurements.

Result Table
Displays or hides the result table.

Remote command: 
POWer:RESult:TABLe on page 666

Track Frame
Defines the synchronization of the waveform display and the lines in the result table.

"Off" Result table and waveform display are not synchronized.
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"Frame Index" The waveform display is connected to the result that is selected in the
result table. The selected result is shown in the center of the display.
If you select another result, the waveform display is adjusted auto-
matically.

"Hori. Position" The result selection in the result table is connected to the waveform
display. The result in the center of the display is selected in the result
table. When you change the horizontal position of the waveform, the
selection in the result table is adjusted automatically.

Export
Opens the "Save" menu to save the measurement results.

See: "Save Menu" on page 370.

The results are saved to an Excel file.

Restart
Restarts the current measurement.

Remote command: 
POWer:HARMonics:RESult<n>:RESet on page 677
POWer:SPECtrum:RESult<n>:RESet on page 692

12.4 Report

Power measurements create various result data. To document these measurement
results, you can create reports in PDF format using th R&S Report tool.

The R&S Report tool is a separate software that is installed on a computer. To transfer
the measurement results to the computer, you export them from the R&S RTM to a
USB flash drive and copy the result file to the computer.

In the R&S Report tool, you can adapt the report to your needs in various ways:
● Select the results that will be included
● Define the layout: Paper size, font, screenshot color, and logo
● Define the content elements that will be included, for example, title page, setup

data, measurement settings, and more.

12.4.1 Export to Report

When a power measurement is finished, you can save the measurement settings and
results to a report file. The R&S Report tool uses the stored data to create measure-
ment reports.

12.4.1.1 Report Settings

The "Report" menu is available from the main "Power" menu if "Analysis" is switched
off. It is also available in all power measurement menus.
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In the "Report" menu you can describe your device under test (DUT) and the test con-
ditions. This information can be used on the title page for a report generated from the
"Power Analysis" measurements.

Report
Opens the Report menu to enter DUT and test information and start the result export.

Device under test (DUT)
Enter a name for your DUT.

Remote command: 
POWer:REPort:DUT on page 668

User
Enters a user.

Remote command: 
POWer:REPort:USER on page 668

Site
Enters a site.

Remote command: 
POWer:REPort:SITE on page 668

Temperature
Enters the temperature.

Remote command: 
POWer:REPort:TEMPerature on page 668

Description
Enters a description.

Remote command: 
POWer:REPort:DESCription on page 668

Save
Opens the "Save" menu where you set the storage settings and save the report to the
USB flash drive. The file name is assigned automatically.

See: "Save Menu" on page 370

Remote command: 
POWer:REPort:OUTPut on page 668

Report
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12.4.2 R&S Report Tool

R&S Report is a java-based software that allows you to create reports from your power
measurement analysis results. It is installed on a computer, not on the instrument.

Prerequisites:
● Installed Java Runtime Environment version 7.0

To install the R&S Report tool

1. Download the RSReportCreator_Setup.exe from www.rohde-schwarz.com/en/
software/rtm2000/.

2. On a computer with installed java runtime environment start the
RSReportCreator_Setup.exe and follow the installation procedure.

To generate a report

1. Perform a power analysis measurement on your scope and save the result on an
USB stick.

2. Transfer the measurement results from the USB to your computer.

3. On your computer start the R&S Report program.

4. Set the "Report Home Directory" and add the required reports.

5. In the "Layout" and "Contents" tabs, set the parameters according to your require-
ments.

6. To generate your report, click "Test Results > Save As" and select the name and
the directory where the report is to be stored.

12.4.2.1 Test Results

In this tab you can manage all saved measurement results.
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Filter
Enables a filter on the selected condition.

"Analysis" Shows only the results for the selected analysis.

"DUT" Shows only the results for the selected DUT.

Report Table
Shows a list of the available measurements.

"Analysis" Shows the type of power analysis measurement.

"DUT" Shows the name of the DUT, see Chapter 12.4.1.1, "Report Settings",
on page 300.

"Date & Time" Shows the date and at what time the measurement result was added
to report.

"Comment" Enters a comment.

"Add" Adds the selected measurement to the report.

Selection
Manages the selection of the result reports.

Add selection ← Selection
Adds the selected measurement to the report.

Deselect all ← Selection
Deselects all result reports.

Report
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Invert selection ← Selection
Inverts the selection of all result reports, meaning that all selected result reports are
deselected and vice versa.

Remove selected ← Selection
Removes the selected result report.

Save As
Opens the file selection dialog box and saves the data to the selected file.

12.4.2.2 Layout

In this tab you can set up a layout for your report.

Paper size
Selects the paper size.

"A4" Selects A4.

"US Letter" Selects US Letter.

Font
Sets the font for the report.

Font Family ← Font
Selects the font family from the list.
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Size ← Font
Sets the font size.

Color ← Font
Sets the font color.

Invert Screenshot Colors
Inverts the screenshot colors.

Logo
Adds a logo to the report.

Rohde & Schwarz ← Logo
Adds the Rohde & Schwarz logo. You can select "Silver" or "Cyan" as the display
color.

User ← Logo
Selects a path to an user defined logo picture file.

12.4.2.3 Content

In this tab you can select the contents of your report. For each content you can select
how often it is included in the report:

● "Always": Shows the respective contents for each measurement.
● "Never": Doesn't show the respective contents in the report.
● "Once": Shows the respective contents once at the beginning of the report.
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Title Page
Adds a title page to the report.

The contents can be set up in the "Report" menu, see Chapter 12.4.1.1, "Report Set-
tings", on page 300.

Measurement Setup
Adds a graphic of the measurement setup.

Settings
Adds the settings of the analysis.

Vertical Setup
Adds the vertical setup settings.

Trigger Setup
Adds the trigger setup settings.

Horizontal Setup
Adds the horizontal setup settings.

Measured signals
Adds a diagram of the measured signal.

Results
Adds the result box.

Report
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12.5 Input Power Measurements

Input line analysis is used to measure the characteristics of the input power as well as
the effects the power supply exudes to the input line.

● Quality...................................................................................................................307
● Consumption.........................................................................................................312
● Harmonics.............................................................................................................314
● Inrush Current....................................................................................................... 318

12.5.1 Quality

The power quality analysis measures the input voltage and current and the resulting
power. The results characterize the quality of the input AC line.

12.5.1.1 Quality Results

The results of "Quality" measurements are:
● the voltage waveform
● the current waveform
● the power waveform that is the product of the current and voltage waveforms
● numeric measurement results

Additionally, for each measurement result you can enable a statistic evaluation of the
measurement results. It returns the current, minimum and maximum measurement val-
ues, the average and standard deviation, and the number of measured waveforms.

Voltage and current results

The voltage and current results are defined as follows:

Result Description

RMS Square root of the mean of the square of the current or voltage averaged
over N cycles

Crest, crest factor Peak value / RMS value

f, frequency Frequency of the signal

Remote commands, RMS:
● POWer:QUALity:RESult:CURRent:RMS[:ACTual]? on page 672
● POWer:QUALity:RESult:CURRent:RMS:AVG? on page 672
● POWer:QUALity:RESult:CURRent:RMS:NPEak? on page 673
● POWer:QUALity:RESult:CURRent:RMS:PPEak? on page 673
● POWer:QUALity:RESult:CURRent:RMS:STDDev? on page 673
● POWer:QUALity:RESult:CURRent:RMS:WFMCount? on page 673
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Remote commands, crest factor:
● POWer:QUALity:RESult:CURRent:CREStfactor[:ACTual]? on page 672
● POWer:QUALity:RESult:CURRent:CREStfactor:AVG? on page 672
● POWer:QUALity:RESult:CURRent:CREStfactor:NPEak? on page 673
● POWer:QUALity:RESult:CURRent:CREStfactor:PPEak? on page 673
● POWer:QUALity:RESult:CURRent:CREStfactor:STDDev? on page 673
● POWer:QUALity:RESult:CURRent:CREStfactor:WFMCount? on page 674

Remote commands, frequency:
● POWer:QUALity:RESult:CURRent:FREQuency[:ACTual]? on page 672
● POWer:QUALity:RESult:CURRent:FREQuency:AVG? on page 672
● POWer:QUALity:RESult:CURRent:FREQuency:NPEak? on page 673
● POWer:QUALity:RESult:CURRent:FREQuency:PPEak? on page 673
● POWer:QUALity:RESult:CURRent:FREQuency:STDDev? on page 673
● POWer:QUALity:RESult:CURRent:FREQuency:WFMCount? on page 674

Power results

The power in a system is described by several physical quantities: real power, reactive
power, apparent power, and phase angle. In Figure 12-1 you can see how these quan-
tities are related if the voltage and the current are sinusoidal signals. ||S|| stands for the
vector norm value of the vector S.

Figure 12-1: Power diagram for sinusoidal signals

P = real power [W]
Q = reactive power [VAR]
||S|| = apparent power [VA]
φ = phase angle between the current and the voltage sine waves [°]

The power results are defined as follows (see Figure 12-1):

Input Power Measurements
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Result Name, Unit Formula Description

Apparent Apparent power

||S|| (VA)

||S||= VRMS ∙ I RMS

(averaged over N cycles)

|S| is the magnitude of the vector
sum of real and reactive power.

Active Real power

P (W)

P = VINSTANTENEOUS ∙ IINSTANTENEOUS

(averaged over N cycles)

Energy of the system that can be
used to do work.

Reactive Reactive power

Q (VAr, Volt-
Ampere reactive)

Q = ||S||sinφ Power flow that is temporarily
stored in a system because of the
inductive and capacitive ele-
ments.

Factor Power factor

PFactor

PFactor = ||P|| / ||S|| Measure of the system efficiency.
The value varies between -1 and
1.

Angle Phase angle

φ (°)

φ = acos (PFactor) Phase angle between the current
and the voltage sine waves.

Remote commands, apparent power:
● POWer:QUALity:RESult:POWer:APParent[:ACTual]? on page 674
● POWer:QUALity:RESult:POWer:APParent:AVG? on page 674
● POWer:QUALity:RESult:POWer:APParent:NPEak? on page 674
● POWer:QUALity:RESult:POWer:APParent:PPEak? on page 674
● POWer:QUALity:RESult:POWer:APParent:STDDev? on page 675
● POWer:QUALity:RESult:POWer:APParent:WFMCount? on page 675

Remote commands, real power (active):
● POWer:QUALity:RESult:POWer:REALpower[:ACTual]? on page 674
● POWer:QUALity:RESult:POWer:REALpower:AVG? on page 674
● POWer:QUALity:RESult:POWer:REALpower:NPEak? on page 674
● POWer:QUALity:RESult:POWer:REALpower:PPEak? on page 674
● POWer:QUALity:RESult:POWer:REALpower:STDDev? on page 675
● POWer:QUALity:RESult:POWer:REALpower:WFMCount? on page 675

Remote commands, reactive power:
● POWer:QUALity:RESult:POWer:REACtive[:ACTual]? on page 674
● POWer:QUALity:RESult:POWer:REALpower:AVG? on page 674
● POWer:QUALity:RESult:POWer:REALpower:NPEak? on page 674
● POWer:QUALity:RESult:POWer:REALpower:PPEak? on page 674
● POWer:QUALity:RESult:POWer:REALpower:STDDev? on page 675
● POWer:QUALity:RESult:POWer:REALpower:WFMCount? on page 675

Remote commands, power factor:
● POWer:QUALity:RESult:POWer:PFACtor[:ACTual]? on page 674
● POWer:QUALity:RESult:POWer:PFACtor:AVG? on page 674
● POWer:QUALity:RESult:POWer:PFACtor:NPEak? on page 674
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● POWer:QUALity:RESult:POWer:PFACtor:PPEak? on page 675
● POWer:QUALity:RESult:POWer:PFACtor:STDDev? on page 675
● POWer:QUALity:RESult:POWer:PFACtor:WFMCount? on page 675

Remote commands, phase:
● POWer:QUALity:RESult:POWer:PHASe[:ACTual]? on page 674
● POWer:QUALity:RESult:POWer:PHASe:AVG? on page 674
● POWer:QUALity:RESult:POWer:PHASe:NPEak? on page 674
● POWer:QUALity:RESult:POWer:PHASe:PPEak? on page 675
● POWer:QUALity:RESult:POWer:PHASe:STDDev? on page 675
● POWer:QUALity:RESult:POWer:PHASe:WFMCount? on page 675

12.5.1.2 Configuring Power Quality Measurements

For details of the configuration settings, see Chapter 12.5.1.3, "Power Quality Set-
tings", on page 311.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Quality".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential voltage probe to the
line of the AC input.

● Connect the negative (-) signal socket of the differential voltage probe to the
neutral of the AC input. Make sure that you use a common ground.

● Connect the current probe in flow direction of the current to the line of the AC
input.

10. Select the correct channels for the "Current" and the "Voltage" sources.

11. To enable statistic evaluation of the measurement results, select "Statistic" > "Visi-
ble".
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12. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveforms of the current, the voltage
and the power. Additionally, the numeric measurement results are shown in the
lower left corner. For details, see Chapter 12.5.1.1, "Quality Results", on page 307.

12.5.1.3 Power Quality Settings

Access: TOOLS > "Power" > "Analysis =Quality".

Figure 12-2: Setup of power quality analysis

Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

To get statistic results of the quality parameters, select "Statistic" > "Visible". See:
Chapter 12.2, "Statistic Menu Settings", on page 298.

Voltage
Sets the channel for the voltage source input. It is recommended that you use a high
voltage differential probe for measurements at the DUT power input.

Remote command: 
POWer:SOURce:VOLTage<n> on page 666
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Current
Sets the channel for the current source. Connect the current probe in flow direction of
the current.

Remote command: 
POWer:SOURce:CURRent<n> on page 666

12.5.2 Consumption

The consumption analysis measures the input voltage, input current, and the resulting
power. Using these values, it calculates the energy that is consumed over time. The
consumption analysis is best suited for non periodical measurements, e.g. measuring
the consumptionof a device in a stand-by mode.

12.5.2.1 Consumption Results

The results of "Consumption" measurements are:
● the voltage waveform
● the current waveform
● the power waveform that is the product of the current and voltage waveforms
● numeric measurement results

The consumption results are defined as follows:

Result Description

Duration Duration of the measurement in seconds

Energy Calculated energy

Active, real power Energy of the system that can be used to do work

Remote commands:
● POWer:CONSumption:RESult:DURation? on page 676
● POWer:CONSumption:RESult:ENERgy? on page 676
● POWer:CONSumption:RESult:REALpower? on page 676

12.5.2.2 Configuring Consumption Measurements

For details of the configuration settings, see Chapter 12.5.2.3, "Consumption Settings",
on page 313.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Consumption".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.
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4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential voltage probe to the
line of the AC input.

● Connect the negative (-) signal socket of the differential voltage probe to the
neutral of the AC input. Make sure that you use a common ground.

● Connect the current probe in flow direction of the current to the line of the AC
input.

10. Select the correct channels for the "Current" and the "Voltage" sources.

11. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

12. To enable statistic evaluation of the measurement results, select "Statistic" > "Visi-
ble".

On the screen you can see the measurement waveforms of the current, the voltage
and the power. Additionally, the numeric measurement results are shown in the
lower left corner. For details, see Chapter 12.5.1.1, "Quality Results", on page 307.

12.5.2.3 Consumption Settings

Access: TOOLS > "Power" > "Analysis = Consumption"

Figure 12-3: Setup of consumption analysis
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Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

The settings for the voltage and current sources are the same as for quality analysis,
see "Voltage" on page 311 and "Current" on page 312.

Restart
Restarts the consumption measurement.

Remote command: 
POWer:CONSumption:RESTart on page 676

12.5.3 Harmonics

Current harmonics analysis measures the amplitude of frequency components that can
be injected back into the AC lines. Therefore, FFT analysis with flat top window is per-
formed. Current harmonics analysis also performs pre-compliance testing according to
standards EN 61000-3-2 A / B / C / D.

12.5.3.1 Harmonics Results

The results of "Harmonics" measurements are:
● the voltage waveform
● the current waveform
● numeric measurement results
● a bar that displays the measured value of the harmonics related to the value

defined in the standard

Table 12-1: Harmonics results

Result Table Description

Order The harmonic order

Frequency The frequency value of the signal

Level The level of the harmonic

Minimum The minimum measured value

Maximum The maximum measured value

Average The average level of the harmonic
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Result Table Description

Limit bar chart The value defined in the standard (white bar) and the measured value of the har-
monics (green: value within the standard's defined limit; red: value out of the
standard's defined limit)

Limit The limit for the harmonic

Remote commands:
● POWer:HARMonics:AVAilable? on page 678
● POWer:HARMonics:MEASurement:DURation? on page 678
● POWer:HARMonics:MEASurement:FREQuency:AVG? on page 678
● POWer:HARMonics:MEASurement:FREQuency:NPEak? on page 679
● POWer:HARMonics:MEASurement:FREQuency:PPeak? on page 679
● POWer:HARMonics:MEASurement:FREQuency:STDDev? on page 679
● POWer:HARMonics:MEASurement:FREQuency[:ACTual]? on page 679
● POWer:HARMonics:MEASurement:REALpower[:ACTual]? on page 679
● POWer:HARMonics:MEASurement:THDistortion:AVG? on page 679
● POWer:HARMonics:MEASurement:THDistortion:NPEak? on page 680
● POWer:HARMonics:MEASurement:THDistortion:PPeak? on page 680
● POWer:HARMonics:MEASurement:THDistortion:STDDev? on page 680
● POWer:HARMonics:MEASurement:THDistortion[:ACTual]? on page 680
● POWer:HARMonics:RESult<n>:FREQency? on page 680
● POWer:HARMonics:RESult<n>:LEVel:LIMit? on page 680
● POWer:HARMonics:RESult<n>:LEVel[:VALue]? on page 681
● POWer:HARMonics:RESult<n>:MAXimum? on page 681
● POWer:HARMonics:RESult<n>:MINimum? on page 681
● POWer:HARMonics:RESult<n>:MEAN? on page 681
● POWer:HARMonics:RESult<n>:VALid? on page 682
● POWer:HARMonics:RESult<n>:VCOunt? on page 682
● POWer:HARMonics:RESult<n>:WFMCount? on page 682
● POWer:HARMonics:RESult<n>:RESet on page 677
● EXPort:POWer:NAME on page 682
● EXPort:POWer:SAVE on page 682

12.5.3.2 Configuring Harmonics Measurements

For details of the configuration settings, see Chapter 12.5.3.3, "Harmonics Settings",
on page 316.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Harmonics".
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3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. If required demagnetize the current probe. For details, see the user manual of your
current probe.

5. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential voltage probe to the
line of the AC input.

● Connect the negative (-) signal socket of the differential voltage probe to the
neutral of the AC input. Make sure that you use a common ground.

● Connect the current probe in flow direction of the current to the line of the AC
input.

6. Select the correct channels for the "Current" and the "Voltage" sources.

7. Select the "Standard".

8. Select the "Fundamental".

9. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

10. If required, change the "Span" and the "Points" for the FFT analysis. The flat top
window is automatically set.

a) Press FFT.
b) Press "FFT Setup" to open the submenu.
c) Set the "Span" to adjust the width of the displayed frequency range.
d) Set the "Points" to define how many samples are used for FFT calculation.

On the screen you can see the measurement waveforms of the current, the voltage
and the power. Additionally, the numeric measurement results are shown in the
result table. For details, see Chapter 12.5.3.1, "Harmonics Results", on page 314.

12.5.3.3 Harmonics Settings

Access: TOOLS > "Power" > "Analysis = Harmonics"
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Figure 12-4: Setup of harmonics analysis

Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

To see a result table with the harmonics parameters, select "Result Table" > "Result
Table". See: Chapter 12.3, "Result Table Settings", on page 299.

The settings for voltage and current sources are the same as for quality analysis, see
"Voltage" on page 311 and "Current" on page 312.

Standard
Selects the standard for pre-compliance testing.

"EN 61000-3-2 Class A"
Balanced 3-phase equipment, household appliances (excluding
equipment identified as class D), tools (excluding portable tools), dim-
mers for incandescent lamps, audio equipment

"EN 61000-3-2 Class B"
Portable tools, not professional arc welding equipment

"EN 61000-3-2 Class C"
Lighting equipment

"EN 61000-3-2 Class D"
PC, PC monitors, radio, or TV receivers with an input power less than
or equal to 600W
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"MIL-STD-1399"
Military shipboard user equipment

"RTCA DO-160"
Environmental tests of avionics hardware

Remote command: 
POWer:HARMonics:STANdard on page 677

Fundamental
Selects the frequency of the input signal. If "Automatic" is set, the instrument analyses
the signal and sets the fundamental frequency accordingly.

Remote command: 
POWer:HARMonics:ENFRequency on page 677
POWer:HARMonics:MIFRequency on page 677
POWer:HARMonics:DOFRequency on page 677

Result Table
Opens the result table menu where you can set the display settings and export the
results to file.

12.5.4 Inrush Current

The inrush current analysis measures the peak of the input current that is drawn by the
device, when the device is turned on.

12.5.4.1 Inrush Current Results

The results of "Inrush Current" measurements are:
● the current waveform
● numeric measurement results:

– "Peak1": the inrush current (maximum current) for the gate
– "|y(x)*x|": the area of the gate

Remote commands:
● POWer:INRushcurrent:RESult<n>:AREA? on page 684
● POWer:INRushcurrent:RESult<n>:MAXCurrent? on page 685

12.5.4.2 Configuring Inrush Current Measurements

For details of the configuration settings, see Chapter 12.5.4.3, "Inrush Current Set-
tings", on page 319.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Inrush Current".

3. Connect the current probe to the oscilloscope.
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4. Demagnetize and zero the current probe. For details, see the user manual of your
current probe.

5. Connect the current probe in flow direction of the current to the line of the AC input
of the DUT.

6. Select the correct channel for the "Current" source.

7. Set the "Gate Count".

8. If required adjust the cursors manually:

a) Press the NAVIGATION rotary knob until the correspondent cursor is selected.
b) Rotate the NAVIGATION rotary knob to change the position of the cursor.

On the screen you can see the measurement waveform of the current. Additionally,
the numeric measurement results are shown in the lower left corner. For details,
see Chapter 12.5.4.1, "Inrush Current Results", on page 318.

12.5.4.3 Inrush Current Settings

Access: TOOLS > "Power" > "Analysis = Inrush Current".

Figure 12-5: Setup of inrush current analysis

Required probes:
● Current probe

Current
Sets the channel for the current source. Connect the current probe in flow direction of
the current.
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Gate Count
Sets up to three gates.

Remote command: 
POWer:INRushcurrent:GCOunt on page 684
POWer:INRushcurrent:GATE<n>:STARt on page 684
POWer:INRushcurrent:GATE<n>:STOP on page 684

Set to Screen
Resets the cursors to their initial positions. This is helpful if the cursors have disap-
peared from the display or need to be moved for a larger distance.

12.6 Output Power Measurements

Output analysis is used to measure the characteristics of the output voltage

● Ripple....................................................................................................................320
● Spectrum...............................................................................................................324
● Transient Response..............................................................................................326

12.6.1 Ripple

The "Ripple" analysis measures the ripple of the device output. In this measurement
the peak-to peak extremes of the output DC signal are of interest. The measurement
also includes the AC-RMS of the output DC signal, that is calculated as a standard der-
ivation.

12.6.1.1 Ripple Results

The results of "Ripple" measurements are:
● the voltage waveform
● numeric measurement results

Additionally, for each measurement result you can enable a statistic evaluation of the
measurement results. It returns the current, minimum and maximum measurement val-
ues, the average and standard deviation, and the number of measured waveforms.

The numeric measurement results are defined as follows:

Table 12-2: Properties output ripple

Meas. type Sym-
bol

Description/Result

Peak + Vp+ Maximum value within the displayed section of the waveform.

Peak - Vp- Minimum value within the displayed section of the waveform.

Peak peak Vpp Peak-to-peak value of the waveform: the difference of maximum and mini-
mum values.

XAmpl = XMax - XMin
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Meas. type Sym-
bol

Description/Result

Mean Mean Mean value of the complete displayed waveform.

σ σ Standard deviation of the waveform samples.

Period T The length of the left-most signal period within the displayed section of the
waveform.

Frequency f Frequency of the signal. The result is based on the length of the left-most sig-
nal period within the displayed section of the waveform.

Pos. duty cycle Dty+ Positive duty cycle: Width of a positive pulse in relation to the period in %.
The measurement requires at least one complete period of a triggered signal.

Neg. duty cycle Dty- Negative duty cycle: Width of a negative pulse in relation to the period in %.
The measurement requires at least one complete period of a triggered signal.

Remote commands, peak+ :
● POWer:RIPPle:RESult:UPEak[:ACTual]? on page 689
● POWer:RIPPle:RESult:UPEak:AVG? on page 689
● POWer:RIPPle:RESult:UPEak:NPEak? on page 689
● POWer:RIPPle:RESult:UPEak:PPEak? on page 689
● POWer:RIPPle:RESult:UPEak:STDDev? on page 690
● POWer:RIPPle:RESult:UPEak:WFMCount? on page 690

Remote commands, peak- :
● POWer:RIPPle:RESult:LPEak[:ACTual]? on page 687
● POWer:RIPPle:RESult:LPEak:AVG? on page 687
● POWer:RIPPle:RESult:LPEak:NPEak? on page 687
● POWer:RIPPle:RESult:LPEak:PPEak? on page 687
● POWer:RIPPle:RESult:LPEak:STDDev? on page 687
● POWer:RIPPle:RESult:LPEak:WFMCount? on page 687

Remote commands, peak peak:
● POWer:RIPPle:RESult:PEAK[:ACTual]? on page 688
● POWer:RIPPle:RESult:PEAK:AVG? on page 688
● POWer:RIPPle:RESult:PEAK:NPEak? on page 688
● POWer:RIPPle:RESult:PEAK:PPEak? on page 688
● POWer:RIPPle:RESult:PEAK:STDDev? on page 688
● POWer:RIPPle:RESult:PEAK:WFMCount? on page 688

Remote commands, mean:
● POWer:RIPPle:RESult:MEAN[:ACTual]? on page 687
● POWer:RIPPle:RESult:MEAN:AVG? on page 687
● POWer:RIPPle:RESult:MEAN:NPEak? on page 687
● POWer:RIPPle:RESult:MEAN:PPEak? on page 687
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● POWer:RIPPle:RESult:MEAN:STDDev? on page 687
● POWer:RIPPle:RESult:MEAN:WFMCount? on page 687

Remote commands, standard deviation:
● POWer:RIPPle:RESult:STDDev[:ACTual]? on page 689
● POWer:RIPPle:RESult:STDDev:AVG? on page 689
● POWer:RIPPle:RESult:STDDev:NPEak? on page 689
● POWer:RIPPle:RESult:STDDev:PPEak? on page 689
● POWer:RIPPle:RESult:STDDev:STDDev? on page 689
● POWer:RIPPle:RESult:STDDev:WFMCount? on page 689

Remote commands, frequency:
● POWer:RIPPle:RESult:FREQuency[:ACTual]? on page 686
● POWer:RIPPle:RESult:FREQuency:AVG? on page 686
● POWer:RIPPle:RESult:FREQuency:NPEak? on page 686
● POWer:RIPPle:RESult:FREQuency:PPEak? on page 686
● POWer:RIPPle:RESult:FREQuency:STDDev? on page 686
● POWer:RIPPle:RESult:FREQuency:WFMCount? on page 686

Remote commands, period:
● POWer:RIPPle:RESult:PERiod[:ACTual]? on page 689
● POWer:RIPPle:RESult:PERiod:AVG? on page 689
● POWer:RIPPle:RESult:PERiod:NPEak? on page 689
● POWer:RIPPle:RESult:PERiod:PPEak? on page 689
● POWer:RIPPle:RESult:PERiod:STDDev? on page 689
● POWer:RIPPle:RESult:PERiod:WFMCount? on page 689

Remote commands, positive duty cycle:
● POWer:RIPPle:RESult:PDCYcle[:ACTual]? on page 688
● POWer:RIPPle:RESult:PDCYcle:AVG? on page 688
● POWer:RIPPle:RESult:PDCYcle:NPEak? on page 688
● POWer:RIPPle:RESult:PDCYcle:PPEak? on page 688
● POWer:RIPPle:RESult:PDCYcle:STDDev? on page 688
● POWer:RIPPle:RESult:PDCYcle:WFMCount? on page 688

Remote commands, negative duty cycle:
● POWer:RIPPle:RESult:NDCYcle[:ACTual]? on page 687
● POWer:RIPPle:RESult:NDCYcle:AVG? on page 687
● POWer:RIPPle:RESult:NDCYcle:NPEak? on page 688
● POWer:RIPPle:RESult:NDCYcle:PPEak? on page 688
● POWer:RIPPle:RESult:NDCYcle:STDDev? on page 688
● POWer:RIPPle:RESult:NDCYcle:WFMCount? on page 688
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12.6.1.2 Configuring Ripple Measurements

For details of the configuration settings, see Chapter 12.6.1.3, "Ripple Settings",
on page 323.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Ripple".

3. Connect the voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the voltage probe to the output stage of the DUT.
● Connect the current probe in flow direction of the current to the output stage of

the DUT.

10. Select the correct channel for the "Source".

11. To enable statistic evaluation of the measurement results, select "Statistic" > "Visi-
ble".

12. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveforms of the current and the
voltage. Additionally, the numeric measurement results are shown in the lower left
corner. For details, see Chapter 12.5.3.1, "Harmonics Results", on page 314.

12.6.1.3 Ripple Settings

Access: TOOLS > "Power" > "Analysis = Ripple"
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Figure 12-6: Setup of ripple analysis

Required probes:
● Voltage probe
● (Optional) Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

To get statistic results of the ripple parameters, select "Statistic" > "Visible". See:
Chapter 12.2, "Statistic Menu Settings", on page 298.

Source
Sets the channel for the source input. This can be either a current or a voltage source.

12.6.2 Spectrum

The spectrum analysis measures the spectrum of the output voltage. The results can
be applied to see typical side effect problems of the switched-mode power supply
(SMPS) application, such as switching frequency components of internal SMPS.

12.6.2.1 Spectrum Results

The results of "Spectrum" measurements are:
● Voltage waveform
● Spectrum
● Numeric measurement results
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For a detailed description of the numeric parameters, see Table 12-1.

Remote commands:
● POWer:SPECtrum:RESult<n>:FREQuency? on page 691
● POWer:SPECtrum:RESult<n>:LEVel[:VALue]? on page 691
● POWer:SPECtrum:RESult<n>:MAXimum? on page 691
● POWer:SPECtrum:RESult<n>:MEAN? on page 691
● POWer:SPECtrum:RESult<n>:MINimum? on page 691
● POWer:SPECtrum:RESult<n>:RESet on page 692
● EXPort:POWer:NAME on page 682
● EXPort:POWer:SAVE on page 682

12.6.2.2 Configuring Spectrum Measurements

For details of the configuration settings, see Chapter 12.6.2.3, "Spectrum Settings",
on page 326.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Spectrum".

3. Connect the voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. If required demagnetize the current probe. For details, see the user manual of your
current probe.

5. Connect the probes to the DUT:

● Connect the voltage probe to the output stage of the DUT.
● Connect the current probe in flow direction of the current to the output stage of

the DUT.

6. Select the correct channels for the "Current" and the "Voltage" sources.

7. Select the "Fundamental".

8. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

9. If required change the "Span" and the "Points":

a) Press FFT.
b) Press "FFT Setup" to open the submenu.
c) Set the "Span" to adjust the width of the displayed frequency range.
d) Set the "Points" to define how many samples are used for FFT calculation.

On the screen you can see the measurement waveforms of the current, the voltage
and the spectrum. Additionally, the numeric measurement results are shown in the
result table. For details, see Chapter 12.6.2.1, "Spectrum Results", on page 324.
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12.6.2.3 Spectrum Settings

Access: TOOLS > "Power" > "Analysis = Spectrum"

Figure 12-7: Setup of spectrum analysis

Required probes:
● Voltage probe
● Current probe

To see a result table with the spectrum parameters, select "Result Table" > "Result
Table". See: Chapter 12.3, "Result Table Settings", on page 299.

Source
Sets the channel for the source input. This can be either a current or a voltage source.

Fundamental
Sets the switching frequency of the device.

Remote command: 
POWer:SPECtrum:FREQuency on page 690

12.6.3 Transient Response

The transient response analysis measures the response of a system to a change from
equilibrium. This response is described by different properties like the overshoot, the
settling time, the peak time and the delay time.
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12.6.3.1 Transient Response Results

The results of "Transient Response" measurements are:
● Voltage waveform
● Numeric measurement results

The transient response results are defined as follows:

Table 12-3: Transient response

Result Symbol Description

Rise time tr The time needed for the signal to change from 10% to 90% of the speci-
fied top level.

Overshoot level Ovr The maximum swing level above the top level.

Settling time Sett. The time period between cursor 1 and cursor 2.

Peak time tPeak The time needed for the response to reach the first peak of the over-
shoot.

Peak Peak The peak value of the signal

Delay time Delay The time needed for the response to reach half of the top level value,
after the trigger event.

Remote commands:
● POWer:TRANsient:RESult:DELay? on page 694
● POWer:TRANsient:RESult:OVERshoot? on page 694
● POWer:TRANsient:RESult:PEAK:TIME? on page 694
● POWer:TRANsient:RESult:PEAK:VALue? on page 694
● POWer:TRANsient:RESult:RTIMe? on page 695
● POWer:TRANsient:RESult:SETTlingtime? on page 695

12.6.3.2 Configuring Transient Response Measurements

For details of the configuration settings, see Chapter 12.6.3.3, "Transient Response
Settings", on page 328 .

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Transient Response".

3. Connect the voltage probe to the oscilloscope.

4. Connect the voltage probe to the output stage of the DUT.

5. Select the correct channel for the "Source".

6. Set the "Top Level" and the "Base Level" of the signal.
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7. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveforms of the voltage. Addition-
ally, the numeric measurement results are shown in the result table. For details,
see Chapter 12.6.3.1, "Transient Response Results", on page 327.

12.6.3.3 Transient Response Settings

Access: TOOLS > "Power" > "Analysis =Transient Response".

Figure 12-8: Setup of transient response analysis

Required probes:
● Differential voltage probe

Source
Sets the channel for the voltage source input.

Top Level
Sets the expected top value.

Remote command: 
POWer:TRANsient:SIGHigh on page 695

Base Level
Sets the expected base value.

Remote command: 
POWer:TRANsient:SIGLow on page 695
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Set to screen
Resets the cursors to their initial positions. This is helpful if the cursors have disap-
peared from the display or need to be moved for a larger distance.

12.7 Switching and Control Loop Measurements

Switching and control loop analysis is used to measure the internal characteristics of a
switching device and the operational reliability of the components.

● Slew Rate..............................................................................................................329
● Modulation.............................................................................................................331
● Dynamic On Resistance........................................................................................334

12.7.1 Slew Rate

The slew rate analysis measures the rate of change of the voltage or current waveform
during the switching of a switching transistor.

12.7.1.1 Slew Rate Results

The results of "Slew Rate" measurements are:
● the voltage waveform or the current waveform
● a waveform of the derivative of voltage and current
● numeric measurement results

For a detailed description of the numeric results, see Table 12-2.

Additionally, for each measurement result you can enable a statistic evaluation of the
measurement results. It returns the current, minimum and maximum measurement val-
ues, the average and standard deviation, and the number of measured waveforms.

Remote commands, peak- :
● POWer:SLEWrate:RESult:LPEak[:ACTual]? on page 696
● POWer:SLEWrate:RESult:LPEak:AVG? on page 696
● POWer:SLEWrate:RESult:LPEak:NPEak? on page 696
● POWer:SLEWrate:RESult:LPEak:PPEak? on page 696
● POWer:SLEWrate:RESult:LPEak:STDDev? on page 696
● POWer:SLEWrate:RESult:LPEak:WFMCount? on page 696

Remote commands, peak+ :
● POWer:SLEWrate:RESult:UPEak[:ACTual]? on page 697
● POWer:SLEWrate:RESult:UPEak:AVG? on page 697
● POWer:SLEWrate:RESult:UPEak:NPEak? on page 697
● POWer:SLEWrate:RESult:UPEak:PPEak? on page 697
● POWer:SLEWrate:RESult:UPEak:STDDev? on page 697
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● POWer:SLEWrate:RESult:UPEak:WFMCount? on page 697

12.7.1.2 Configuring Slew Rate Measurements

For details of the configuration settings, see Chapter 12.7.1.3, "Slew Rate Settings",
on page 330.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Slew Rate".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential probe to the drain of
the transistor.

● Connect the negative (-) signal socket of the differential probe to the source of
the transistor.

● Connect the current probe to the source of the transistor.

10. Select the correct channel for the "Source".

11. Set the "Δt" value low enough.

12. To enable statistic evaluation of the measurement results, select "Statistic" > "Visi-
ble".

13. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveforms of the current, the voltage
and the derivative of voltage and current. Additionally, the numeric measurement
results are shown in the lower left corner. For details, see Chapter 12.7.1.1, "Slew
Rate Results", on page 329.

12.7.1.3 Slew Rate Settings

Access: TOOLS > "Power" > "Analysis = Slew Rate"
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Figure 12-9: Setup of slew rate

Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

To get statistic results of the slew rate parameters, select "Statistic" > "Visible". See:
Chapter 12.2, "Statistic Menu Settings", on page 298.

Source
Sets the channel for the source. This can be either a current or a voltage source.

Delta t
Sets the delta time.

Remote command: 
POWer:SLEWrate:DTIMe on page 696

12.7.2 Modulation

The modulation analysis measures the control pulse signal to a switching device.

12.7.2.1 Modulation Results

The results of "Modulation" measurements are:
● the voltage or the current waveform
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● numeric measurement results

For a detailed description of the numeric results, see Table 12-2.

Additionally, for each measurement result you can enable a statistic evaluation of the
measurement results. It returns the current, minimum and maximum measurement val-
ues, the average and standard deviation, and the number of measured waveforms.

Remote commands, peak+:
● POWer:MODulation:RESult:UPEak[:ACTual]? on page 700
● POWer:MODulation:RESult:UPEak:AVG? on page 700
● POWer:MODulation:RESult:UPEak:NPEak? on page 700
● POWer:MODulation:RESult:UPEak:PPEak? on page 700
● POWer:MODulation:RESult:UPEak:STDDev? on page 700
● POWer:MODulation:RESult:UPEakWFMCount? on page 700

Remote commands, peak-:
● POWer:MODulation:RESult:LPEak[:ACTual]? on page 698
● POWer:MODulation:RESult:LPEak:AVG? on page 698
● POWer:MODulation:RESult:LPEak:NPEak? on page 698
● POWer:MODulation:RESult:LPEak:PPEak? on page 698
● POWer:MODulation:RESult:LPEak:STDDev? on page 698
● POWer:MODulation:RESult:LPEak:WFMCount? on page 698

Remote commands, mean:
● POWer:MODulation:RESult:MEAN[:ACTual]? on page 699
● POWer:MODulation:RESult:MEAN:AVG? on page 699
● POWer:MODulation:RESult:MEAN:NPEak? on page 699
● POWer:MODulation:RESult:MEAN:PPEak? on page 699
● POWer:MODulation:RESult:MEAN:STDDev? on page 699
● POWer:MODulation:RESult:MEAN:WFMCount? on page 699

Remote commands, RMS:
● POWer:MODulation:RESult:RMS[:ACTual]? on page 699
● POWer:MODulation:RESult:RMS:AVG? on page 699
● POWer:MODulation:RESult:RMS:NPEak? on page 699
● POWer:MODulation:RESult:RMS:PPEak? on page 699
● POWer:MODulation:RESult:RMS:STDDev? on page 699
● POWer:MODulation:RESult:RMS:WFMCount? on page 699

Remote commands, standard deviation:
● POWer:MODulation:RESult:STDDev[:ACTual]? on page 700
● POWer:MODulation:RESult:STDDev:AVG? on page 700
● POWer:MODulation:RESult:STDDev:NPEak? on page 700
● POWer:MODulation:RESult:STDDev:PPEak? on page 700
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● POWer:MODulation:RESult:STDDev:STDDev? on page 700
● POWer:MODulation:RESult:STDDev:WFMCount? on page 700

12.7.2.2 Configuring Modulation Measurements

For details of the configuration settings, see Chapter 12.5.1.3, "Power Quality Set-
tings", on page 311.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Modulation".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. If required demagnetize the current probe. For details, see the user manual of your
current probe.

5. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential probe to the gate of the
transistor.

● Connect the negative (-) signal socket of the differential probe to the source of
the transistor.

● Connect the current probe to the drain of the transistor.

6. Select the correct channel for the "Source".

7. To enable statistic evaluation of the measurement results, select "Statistic" > "Visi-
ble".

8. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveforms of the current, the voltage
and the power. Additionally, the numeric measurement results are shown in the
lower left corner. For details, see Chapter 12.5.1.1, "Quality Results", on page 307.

12.7.2.3 Modulation Analysis Settings

Access: TOOLS > "Power" > "Analysis =Modulation".
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Figure 12-10: Setup of modulation analysis

Required probes:
● Differential voltage probe
● Current probe

To get statistic results of the modulation analysis parameters, select "Statistic" > "Visi-
ble". See: Chapter 12.2, "Statistic Menu Settings", on page 298.

Source
Sets the channel for the source. This can be either a current or a voltage source.

Type
Selects the modulation type. A calculation of the waveform for the selected measure-
ment type is shown on the screen. You can select between the period, frequency, the
positive/negative duty cycle and the positive/negative pulse width.

Remote command: 
POWer:MODulation:TYPE on page 698

12.7.3 Dynamic On Resistance

The dynamic On resistance analysis measures the resistance of a switching device,
during operation. Because voltage and current may vary in time, the resistance is not
constant, thus it is called dynamic On resistance. It is defined as the ratio dV/dI.
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12.7.3.1 Dynamic On Resistance Results

The results of "Dynamic On Resistance" measurements are:
● the voltage waveform
● the current waveform
● the dynamic on resistance value

Remote commands:
● POWer:DONResistance:RESult:DONResistance? on page 701
● POWer:DONResistance:GATE<n>:START on page 701
● POWer:DONResistance:GATE<n>STOP on page 701

12.7.3.2 Configuring Dynamic On Resistance Measurements

For details of the configuration settings, see Chapter 12.7.3.3, "Dynamic On Resist-
ance Settings", on page 336.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Dynamic On Resistance".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential probe to the drain of
the transistor.

● Connect the negative (-) signal socket of the differential probe to the source of
the transistor.

● Connect the current probe to the source of the transistor.

10. Select the correct channels for the "Current" and the "Voltage" sources.

11. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

12. If required adjust the cursors manually:

a) Press the NAVIGATION rotary knob until the correspondent cursor is selected.
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b) Rotate the NAVIGATION rotary knob to change the position of the cursor.

On the screen you can see the measurement waveforms of the current and the
voltage. Additionally, the numeric measurement results are shown in the lower right
corner. For details, see Chapter 12.7.3.1, "Dynamic On Resistance Results",
on page 335.

12.7.3.3 Dynamic On Resistance Settings

Access: TOOLS > "Power" > "Analysis = Dynamic ON Resistance"

Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

The settings for the voltage and current sources are the same as for quality analysis,
see "Voltage" on page 311 and "Current" on page 312.

Set to screen
Resets the cursors to their initial positions. This is helpful if the cursors have disap-
peared from the display or need to be moved for a larger distance.
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12.8 Power Path Analysis

● Efficiency...............................................................................................................337
● Switching Loss...................................................................................................... 340
● Turn ON/OFF Time............................................................................................... 343
● Safe Operating Area (S.O.A.)............................................................................... 345

12.8.1 Efficiency

The power efficiency analysis measures the input and the output power of a power
supply. The power efficiency of the power supply is then calculated as the ratio of the
output power and the input power.

12.8.1.1 Efficiency Results

The results of "Efficiency" measurements are:
● the voltage waveform
● the current waveform
● the power waveform that is the product of the current and voltage waveforms
● numeric measurement results

For a detailed description of the numeric results, see Table 12-2.

Additionally, for each measurement result you can enable a statistic evaluation of the
measurement results. It returns the current, minimum and maximum measurement val-
ues, the average and standard deviation, and the number of measured waveforms.

Remote commands, efficiency:
● POWer:EFFiciency:RESult:EFFiciency[:ACTual]? on page 702
● POWer:EFFiciency:RESult:EFFiciency:AVG? on page 702
● POWer:EFFiciency:RESult:EFFiciency:NPEak? on page 702
● POWer:EFFiciency:RESult:EFFiciency:PPEak? on page 702
● POWer:EFFiciency:RESult:EFFiciency:STDDev? on page 702
● POWer:EFFiciency:RESult:EFFiciency:WFMCount? on page 702

Remote commands, output real power:
● POWer:EFFiciency:RESult:INPut:REALpower[:ACTual]? on page 702
● POWer:EFFiciency:RESult:INPut:REALpower:AVG? on page 702
● POWer:EFFiciency:RESult:INPut:REALpower:NPEak? on page 702
● POWer:EFFiciency:RESult:INPut:REALpower:PPEak? on page 703
● POWer:EFFiciency:RESult:INPut:REALpower:STDDev? on page 703
● POWer:EFFiciency:RESult:INPut:REALpower:WFMCount? on page 703

Remote commands, input real power:
● POWer:EFFiciency:RESult:OUTPut:REALpower[:ACTual]? on page 703
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● POWer:EFFiciency:RESult:OUTPut:REALpower:AVG? on page 703
● POWer:EFFiciency:RESult:OUTPut:REALpower:NPEak? on page 703
● POWer:EFFiciency:RESult:OUTPut:REALpower:PPEak? on page 703
● POWer:EFFiciency:RESult:OUTPut:REALpower:STDDev? on page 703
● POWer:EFFiciency:RESult:OUTPut:REALpower:WFMCount? on page 703

12.8.1.2 Configuring Efficiency Measurements

For details of the configuration settings, see Chapter 12.8.1.3, "Efficiency Settings",
on page 339.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Efficiency".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probes. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the first differential probe to the line of
the AC input.

● Connect the negative (-) signal socket of the first differential probe to the neu-
tral of the AC input.

● Connect the first current probe to the line of the AC input.
● Connect the positive (+) signal socket of the second differential probe to the

input path of the load.
● Connect the negative (-) signal socket of the second differential probe to the

return path of the load.
● Connect the second current probe to the input path of the load with the direc-

tion of the arrow pointing towards the current flow.

10. Select the correct channels for the "Input Current", "Input Voltage", "Output Cur-
rent" and the "Output Voltage" sources.

11. To enable statistic evaluation of the measurement results, select "Statistic" > "Visi-
ble".
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12. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveforms of the currents and the
voltages. Additionally, the numeric measurement results are shown in the lower
right corner. For details, see Chapter 12.8.1.1, "Efficiency Results", on page 337.

If you have a two-channel scope or you don't have four probes to perform the efficiency
analysis measurement at once, you can first store your input waveform as a reference
and then measure the output waveform.

12.8.1.3 Efficiency Settings

Access: TOOLS > "Power" > "Analysis =Efficiency".

Required probes:
● Two differential voltage probes
● Two current probes

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

To get statistic results of the efficiency parameters, select "Statistic" > "Visible". See:
Chapter 12.2, "Statistic Menu Settings", on page 298.

Input, Output
Displays the softkeys for setting the input/ouput voltage and current.
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Input Voltage, Input Current
Sets the channels for the input voltage and the input current.

Output Voltage, Output Current
Sets the channels for the output voltage and the output current.

12.8.2 Switching Loss

The switching loss analysis measures the power and energy losses of a switching
device, that occur during the switching phases and the conduction phase of a switching
transistor.

12.8.2.1 Switching Loss Results

The results of "Switching Loss" measurements are:
● the voltage waveform
● the current waveform
● the power waveform that is the product of the current and voltage waveforms
● numeric measurement results

The numeric measurement results can be displayed in dependance of the power or the
energy according to the selected "Type". The switching loss results show the power/
energy values in W/J for the following switching phases:

Table 12-4: Switching loss phases

Phase Symbol Definition Points Description

Turn on On The area between "t1" and "t2" The time after switching the device,
during which the current rises until it
reaches the saturation current level.

Conduction Cond The area between "t2" and "t3" The time during which the voltage is
at the transistors saturated minimum
and the current flows.

Turn off Off The area between "t3" and "t4" The time during which after a short
delay time the voltage rises until it
reaches its final value.

Non con-
duction

No Cond The area between "t4" and "t5" The time during current doesn't flow.
The losses during this period should
be theoretically zero.

Total Total The area between "t1" and "t5" The period of one switching cycle.

Remote commands:
● POWer:SWITching:RESult:CONDuction:ENERgy? on page 706
● POWer:SWITching:RESult:CONDuction:POWer? on page 706
● POWer:SWITching:RESult:NCONduction:ENERgy? on page 706
● POWer:SWITching:RESult:NCONduction:POWer? on page 706
● POWer:SWITching:RESult:TOFF:ENERgy? on page 706
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● POWer:SWITching:RESult:TOFF:POWer? on page 706
● POWer:SWITching:RESult:TON:ENERgy? on page 707
● POWer:SWITching:RESult:TON:POWer? on page 707
● POWer:SWITching:RESult:TOTal:ENERgy? on page 707
● POWer:SWITching:RESult:TOTal:POWer? on page 707

12.8.2.2 Configuring Switching Loss Measurements

For details of the configuration settings, see Chapter 12.8.2.3, "Switching Loss Settings
", on page 342.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Switching Loss".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential probe to the drain of
the transistor.

● Connect the negative (-) signal socket of the differential probe to the source of
the transistor.

● Connect the current probe to the source of the transistor.

10. Select the correct channels for the "Current" and the "Voltage" sources.

11. Select the "Type" for the measurement.

12. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveform of the current, the voltage
and the power. Additionally, the numeric measurement results are shown in the
lower right corner. For details, see Chapter 12.8.2.1, "Switching Loss Results",
on page 340.
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12.8.2.3 Switching Loss Settings

Access: TOOLS > "Power" > "Analysis =Switching Loss".

Figure 12-11: Setup of switching loss analysis

Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

The settings for the voltage and current sources are the same as for quality analysis,
see "Voltage" on page 311 and "Current" on page 312.

Type
Selects the measurement type, power or energy, for the switching loss measurement.
The results of the measurement are displayed in W for power measurements and in J
for energy measurements.

Remote command: 
POWer:SWITching:TYPE on page 704

Set to waveform
Autoset for cursor lines, sets the cursor lines to typical points of the waveform depend-
ing on the selected measurement type
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12.8.3 Turn ON/OFF Time

The turn on/off analysis measures how long it takes a power supply to reach a certain
percentage of the steady state output level during initial turn on or turn off.

12.8.3.1 Turn ON/OFF Time Results

The results of "Turn ON/OFF Time" measurements are:
● the input voltage waveform
● the output voltage waveform
● the turn on / turn off time

Remote commands:
● POWer:ONOFf:RESult<n>:TIME? on page 708

12.8.3.2 Configuring Turn ON/OFF Time Measurements

For details of the configuration settings, see Chapter 12.8.3.3, "Turn ON/OFF Time
Settings", on page 344.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "Turn ON/OFF".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT:

● Connect the positive (+) signal socket of the differential probe to the line of the
AC input.

● Connect the negative (-) signal socket of the differential probe to the neutral of
the AC input.

● Connect the passive voltage probe to the DC output of the DUT.
● Connect the current probe to the input path of the load with the direction of the

arrow pointing towards the current flow.

10. Select the correct channels for the "Current" and the "Voltage" sources.
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11. Select the "Type" for the measurement.

12. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveform of the input and output
voltage. Additionally, the numeric measurement results are shown in the lower left
corner. For details, see Chapter 12.8.3.1, "Turn ON/OFF Time Results",
on page 343.

12.8.3.3 Turn ON/OFF Time Settings

Access: TOOLS > "Power" > "Analysis =Turn ON/OFF time".

Required probes:
● Two voltage probes
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

Type
Selects turn on or turn off time as the type of measurement.

Input Voltage
Sets the channel for the input voltage.

Output Voltage
Sets the channels for the output voltage.
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More
Displays more softkeys belonging to the same submenu.

12.8.4 Safe Operating Area (S.O.A.)

The safe operating area is defined by the voltage and current conditions over which a
power semiconductor device is expected to operate without self-damage. The "Safe
Operating Area" analysis provides a diagram of the safe operating conditions of your
device.

12.8.4.1 Safe Operating Area Results

The results of "SOA" measurements are:
● the voltage waveform
● the current waveform
● numeric measurement results

The numeric measurement results are:

Table 12-5: Results of the mask test

Result Description

Samples/ Acquisitions Number of tested points/acquisitions

Passed Number of points/acquisitions that have passed the
mask test, i.e. they are within the defined safe opea-
rating area mask

Failed Number of points/acquisitions that have failed the
mask test, i.e. they are out of the defined safe opea-
rating area mask

Fail rate Ratio of acquisition hits to the number of tested
acquisitions

Result A test has failed if the number of sample hits or
acquisition hits exceeds the limit of "Total toler-
ance"/"Acq. tolerance" hits

Remote commands:
● POWer:SOA:RESult:ACQuisition:FAILed? on page 712
● POWer:SOA:RESult:ACQuisition:FRATe? on page 712
● POWer:SOA:RESult:ACQuisition:PASSed? on page 712
● POWer:SOA:RESult:ACQuisition:POINts? on page 712
● POWer:SOA:RESult:ACQuisition:STATe? on page 712
● POWer:SOA:RESult:ACQuisition:TOLerance on page 711
● POWer:SOA:RESult:ACQuisition:VCOunt? on page 713
● POWer:SOA:RESult:ACQuisition:VIOLation<n>? on page 713
● POWer:SOA:RESult:ACQuisition:VIOLation<n>:VOLTage? on page 713
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● POWer:SOA:RESult:ACQuisition:VIOLation<n>:CURRent? on page 713
● POWer:SOA:RESult:TOTal:SAMPle:COUNt? on page 713
● POWer:SOA:RESult:TOTal:SAMPle:FAILed? on page 714
● POWer:SOA:RESult:TOTal:SAMPle:PASSed? on page 714
● POWer:SOA:RESult:TOTal:COUNt? on page 714
● POWer:SOA:RESult:TOTal:FAILed? on page 714
● POWer:SOA:RESult:TOTal:FRATe? on page 714
● POWer:SOA:RESult:TOTal:PASSed? on page 714
● POWer:SOA:RESult:TOTal:STATe? on page 715
● POWer:SOA:RESult:TOTal:TOLerance on page 711
● POWer:SOA:RESult:TOTal:VCOunt? on page 715
● POWer:SOA:RESult:TOTal:VIOLation<n>? on page 715
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent? on page 715
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA? on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:HEADer?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:XINCrement?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:XORigin?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YINCrement?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YORigin?

on page 717
● POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YRESolution?

on page 717
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage? on page 715
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA? on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:HEADer?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:XINCrement?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:XORigin?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YINCrement?

on page 716
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YORigin?

on page 717
● POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YRESolution?

on page 717

Power Path Analysis
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12.8.4.2 Configuring Safe Operating Area Measurements

For details of the configuration settings, see Chapter 12.8.4.3, "Safe Operating Area
(S.O.A.) Settings", on page 347.

1. Press the "Tools" key and select "Power".

2. Press "Analysis" and select "SOA".

3. Connect the differential voltage probe and the current probe to the oscilloscope.
It is recommended that you use a high voltage differential probe for measurements
at the DUT power input.

4. Demagnetize the current probe. For details, see the user manual of your current
probe.

5. Press "Probe".

6. Connect the probes to the R&S RT-ZF20 power deskew fixture.

7. "Deskew" the probes and adjust the "Zero Offset".

8. Disconnect the probes from the R&S RT-ZF20 power deskew fixture and press
"Back".

9. Connect the probes to the DUT.

● Connect the positive (+) signal socket of the differential probe to the drain of
the transistor.

● Connect the negative (-) signal socket of the differential probe to the source of
the transistor.

● Connect the current probe to the source of the transistor.

10. Select the correct channels for the "Current" and the "Voltage" sources.

11. Select "Mask Setup" and configure the mask to be used for the measurement.

12. Select "Test Setup" and set the "Total Tolerance", "Acq. Tolerance" and the "Win-
dow Scale".

13. Press the AUTOSET button to adjust the display scales automatically or adjust
them manually.

On the screen you can see the measurement waveform of the input and output
voltage. Additionally, the numeric measurement results are shown in the lower left
corner. For details, see Chapter 12.8.4.1, "Safe Operating Area Results",
on page 345.

12.8.4.3 Safe Operating Area (S.O.A.) Settings

Access: TOOLS > "Power" > "Analysis = SOA".
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Figure 12-12: Setup of safe operating area analysis

Required probes:
● Differential voltage probe
● Current probe

To adjust the probes, open the "Probe" menu. For details, see Chapter 12.1.2, "Probe
Settings for Power Measurements", on page 298.

The settings for the voltage and current sources are the same as for quality analysis,
see "Voltage" on page 311 and "Current" on page 312.

Restart
Restarts the SOA measurement.

Remote command: 
POWer:SOA:RESTart on page 709

Mask Setup
Opens a submenu for configuring the mask.

Edit Mask
Opens a submenu to configure a user defined mask values.

For each mask point, the voltage and minimum and maximum current are set. Thus,
the upper and the lower mask limits are defined.

Power Path Analysis
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Point ← Edit Mask
Selects the point to be defined.

Voltage ← Edit Mask
Sets the voltage for the selected point.

Remote command: 
POWer:SOA:LINear:POINt<m>:VOLTage on page 710
POWer:SOA:LOGarithmic:POINt<m>:VOLTage on page 710

Imin ← Edit Mask
Sets the minimum current for the selected point.

Remote command: 
POWer:SOA:LINear:POINt<m>:CURRent:MINimum on page 710
POWer:SOA:LOGarithmic:POINt<m>:CURRent:MINimum on page 710

Imax ← Edit Mask
Sets the maximum current for the selected point.

Remote command: 
POWer:SOA:LINear:POINt<m>:CURRent:MAXimum on page 710
POWer:SOA:LOGarithmic:POINt<m>:CURRent:MAXimum on page 710
POWer:SOA:LINear:POINt<m>:CURRent on page 709
POWer:SOA:LOGarithmic:POINt<m>:CURRent on page 709

Add ← Edit Mask
Adds a point to the safe operating area definition list.

Remote command: 
POWer:SOA:LINear:ADD on page 709
POWer:SOA:LOGarithmic:ADD on page 709
POWer:SOA:LINear:INSert on page 709
POWer:SOA:LOGarithmic:INSert on page 709

Remove ← Edit Mask
Removes the selected point from the safe operating area definition list.

Remote command: 
POWer:SOA:LINear:REMove on page 710
POWer:SOA:LOGarithmic:REMove on page 710

Save Mask
Opens a submenu to save the mask.

See: Chapter 15.3.1.3, "General Storage Settings", on page 370

New File ← Save Mask
Creates new file.

More ← Save Mask
Displays more softkeys belonging to the same submenu.

Power Path Analysis
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Load Mask
Opens a file explorer to select a previously stored mask. The selected mask is loaded
and can be used for a subsequent test.

See: Chapter 15.3.1.3, "General Storage Settings", on page 370

Mask Scale
Selects the scale for the mask, linear or logarithmic.

Remote command: 
POWer:SOA:SCALe:MASK on page 709

Test Setup
Opens a submenu to define the tolerance of the test setup as well as the window
scale.

Total Tolerance ← Test Setup
Sets the allowed total tolerance.

Remote command: 
POWer:SOA:RESult:TOTal:TOLerance on page 711

Acq. Tolerance ← Test Setup
Sets the allowed acquisition tolerance.

Remote command: 
POWer:SOA:RESult:ACQuisition:TOLerance on page 711

Window Scale ← Acq. Tolerance ← Test Setup
Selects a linear or a logarithmic scaled for the displayed results.

Remote command: 
POWer:SOA:SCALe:DISPlay on page 709

Export Violations
Opens the "Export" menu to save the measurement results to an Excel file.

See: Chapter 15.3.1.3, "General Storage Settings", on page 370.

Power Path Analysis
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13 Digital Voltmeter and Counter (DVM Option
R&S RTM-K32)
The integrated three-digit digital voltmeter simplifies measurement, in particular for ser-
vice personnel. You can perform four configurable measurements at the same time
and define the position of the measurement results.

The following DVM measurements are available:
● DC: mean value of the signal
● AC+DC RMS: RMS value of the signal
● AC RMS: RMS value of the signal's AC component
● Crest Factor: |X|max / XRMS

● Peak: Maximum - Minimum
● Peak +: Maximum value
● Peak -: Minimum value

The counter shows two basic parameters of the trigger source: frequency and period. If
both A-trigger and B-trigger are used, two counter results are displayed.

The digital voltmeter captures input data with the selected vertical sensitivity and the
basic accuracy of the ADC. It is independent from the capture settings and the post
processing. All measurements are are based on a measurement interval, which
ensures reliable results over the defined frequency range.

13.1 DVM and Counter Results

If the digital voltmeter and/or the counter are enabled in the TOOLs menu, a result box
displays the measurement results. You can define the position ot the result box.

For DVM measurements, the measurement source is indicated by the channel color,
counter results are displayed in white.

1 = Frequency of the trigger source (counter)
2 = Period of the trigger source (counter)
3 = A/B-trigger and trigger source (counter)
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4 = Measurement type (DVM)
5 = Measurement result (DVM)
6 = Clipping marker (DVM)

The clipping marker shows if the signal is clipped at the upper limit of the ADC range,
at the lower limit, or at both.

Remote commands:
● TCOunter<t>:RESult[:ACTual]:FREQuency? on page 727
● TCOunter<t>:RESult[:ACTual]:PERiod? on page 728
● DVM<m>:RESult[:ACTual]? on page 729
● DVM<m>:RESult[:ACTual]:STATus? on page 729

13.2 DVM Settings

Access: TOOLS

In the "Tools" menu, you can activate the DVM and trigger counter measurements
directly, and you can open the menu woith digital voltmeter settings.

Trig. Counter............................................................................................................... 352
Dig. Voltmeter............................................................................................................. 353

└ Voltmeter.......................................................................................................353
└ Meas. Place.................................................................................................. 353
└ Source...........................................................................................................353
└ Type..............................................................................................................353
└ Position......................................................................................................... 353

Trig. Counter
Enables and disables the trigger counter. If enabled, the frequency and period of the A-
and B-trigger sources are displayed above the DVM results. The counter provides the
same results as the automatic measurement functions "Trigger Frequency" and "Trig-
ger Period".

Remote command: 
TCOunter<t>:ENAB on page 727
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Dig. Voltmeter
Activates the digital voltmeter and opens the "Digital Voltmeter" menu, where you can
configure four independent voltmeter measurements. For each measurement, you can
define the source and the measurement type.

Voltmeter ← Dig. Voltmeter
Enables and disables all configured voltmeter measurements.

If you disable the voltmeter, the measurement setup remains.

Remote command: 
DVM<m>:ENABle on page 728

Meas. Place ← Dig. Voltmeter
Selects one of the four available measurements to be configured.

Source ← Dig. Voltmeter
Selects an analog channel as the source of the selected measurement.

Remote command: 
DVM<m>:SOURce on page 728

Type ← Dig. Voltmeter
Defines the measurement type to be performed on the selected source.

Select "Off" to disable the measurement.

The following DVM measurements are available:
● DC: mean value of the signal
● AC+DC RMS: RMS value of the signal
● AC RMS: RMS value of the signal's AC component
● Crest Factor: |X|max / XRMS

● Peak: Maximum - Minimum
● Peak +: Maximum value
● Peak -: Minimum value

Remote command: 
DVM<m>:TYPE on page 728

Position ← Dig. Voltmeter
Selects the corner of the screen in which the measurement results are displayed.

Remote command: 
DVM<m>:POSition on page 729

DVM Settings
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14 Mixed Signal Option (MSO, R&S RTM-B1)
The Mixed Signal Option R&S RTM-B1 adds logic analyzer functions to the classical
oscilloscope functions. Using the MSO option, you can analyze and debug embedded
systems with mixed-signal designs that use analog signals and correlated digital sig-
nals simultaneously.

14.1 About MSO

The Mixed Signal Option provides 16 digital channels grouped in two logic probes
(pods) with 8 channels each. The instrument ensures that analog and digital wave-
forms are timealigned and synchronized so that critical timing interactions between
analog and digital signals can be displayed and tested. The automatic alignment com-
pensates the skew between the probe connectors of the analog channels and the
probe boxes of the digital channels.

Digital channels

Each digital channel can be displayed on the screen and used as trigger source of
some trigger types. A pod of digital signals can be saved as reference waveform (REF
> "Source" > "Save", and exported to file (FILE > "Waveforms").

Digital channels are not available for mathematical operations. Search on digital chan-
nels is not possible.

Parallel buses

Digital channels may be grouped and displayed as a parallel bus. Up to 4 parallel
buses can be configured; and two bus types are supported: clocked bus and unclocked
bus. The last selected bus is the active bus that is shown on the display, other config-
ured buses are disabled.

Trigger possibilities

One of the digital channels can be used as trigger source for edge and width triggers.
However, digital channels are not selectable if the B-trigger is enabled. Using the pat-
tern trigger, you can trigger on parallel buses and logical combinations of analog and
digital channels. For all digital trigger sources, the trigger level is the logical threshold.
Additionally, you can define a trigger holdoff time for the edge and width trigger.

Cursor measurements

Cursor measurements can be performed on single digital channels and on pods. As for
all measurements, the instrument provides only sources that are active and appropri-
ate for the selected measurement type.

The sources D0 to D15 are available for time, ratio X, count, duty ratio and burst width
measurements. The pods D0...D7 and D8...D15 are available for V-marker measure-
ments, which delivers the 8-bit value of the pod lines.

 

 

About MSO



Mixed Signal Option (MSO, R&S RTM-B1)R&S®RTM2000

355User Manual 1317.4726.02 ─ 10

Automatic measurements and statistics

Automatic time and count measurements can be performed on active digital channels.
As for all measurements, the instrument provides only sources that are active and
appropriate for the selected measurement type.

The following measurement types are available for single digital channels (bits): fre-
quency, period, edge and pulse counts, phase, delay, duty cycle, burst width. Statisti-
cal evaluation of these measurements is also possible.

Quick measurements on digital channels are not available.

14.2 Digital Channels

14.2.1 Digital Channels - Activity Display

The color coded waveform label for digital channels on the top of the window shows
the current status of all logic channels regardless of the trigger settings, and even with-
out any acquisition. The states are high, low, and toggle.

Remote commands:
● DIGital<m>:CURRent:STATe:MAXimum? on page 717
● DIGital<m>:CURRent:STATe:MINimum? on page 717

14.2.2 Digital Channels - Configuration

Access: PROTOCOL LOGIC > if "Protocol" menu is displayed: "Logic"

D7-D0 / D15-D8.......................................................................................................... 356
Visible..........................................................................................................................356
Deskew....................................................................................................................... 356
Threshold.................................................................................................................... 356

└ Nibble............................................................................................................357
└ Threshold......................................................................................................357
└ Technology................................................................................................... 357
└ Hysteresis..................................................................................................... 357
└ Couple Levels............................................................................................... 357

Label........................................................................................................................... 357
└ Bit..................................................................................................................358
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└ Label............................................................................................................. 358
└ Library...........................................................................................................358
└ Edit Label......................................................................................................358

POSITION................................................................................................................... 358
SCALE........................................................................................................................ 358

D7-D0 / D15-D8
Enables or disables all digital channels of the pod at once.

Visible
Enables or disables individual digital channels.

Turn the navigation knob to select the digital channel, then press the knob to enable or
disable the channel.

Remote command: 
DIGital<m>:DISPlay on page 718

Deskew
Deskew compensates delays that are known from the circuit specifics or caused by the
different length of cables. The skew between the probe boxes of the digital channels
and the probe connectors of the analog channels is automatically aligned by the instru-
ment.

You can set the deskew for all channels of a logic probe at once, or for each logic
channel separately.

"Logic Probe" Selects the pod.

"Deskew" Enables deskewing for the selected logic probe.

"Logic Chan-
nel"

If you want to deskew single logic channels, select the channel and
set the deskew value using "Deskew".

"Value" Sets the deskew value for the selected logic channel, or for the
selected logic probe.

"Set probe to" Applies the current deskew value to all logic channels of the selected
logic probe.

Remote command: 
DIGital<m>:DESKew on page 719

Threshold
Opens the "Threshold" menu.

You can set the digital threshold in several ways:
● The same threshold and hysteresis is used for all digital channels: Enable "Couple

Levels" and set the values.
● Different thresholds and hysteresis are used for individual channel groups (nib-

bles): Disable "Couple Levels" and set the threshold and hysteresis for each nibble.

Digital Channels
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Nibble ← Threshold
Selects a group of 4 digital channels for which the threshold and the hysteresis can be
set.

Threshold ← Threshold
Sets the threshold value for the selected nibble, or for all digital channels if "Couple
Levels" is enabled.

The threshold setting is available if "Technology" is "User Level".

For each acquired sample, the instrument compares the input voltage with the thresh-
old value. If the input voltage is above the threshold, the signal state "1" is stored. Oth-
erwise, the signal state "0" is stored if the input voltage is below the threshold.

Remote command: 
DIGital<m>:THReshold on page 718

Technology ← Threshold
Selects the threshold voltage for various types of integrated circuits from a list. The
value is applied to the selected nibble, or to all digital channels if "Couple Levels" is
enabled.

Remote command: 
DIGital<m>:TECHnology on page 718

Hysteresis ← Threshold
Hysteresis avoids the change of signal states due to noise oscillation around the
threshold level. Set a small hysteresis for clean signals, and large hysteresis for noisy
signals.

Threshold

Logic 0                        Logic 1  Logic 0

Hysteresis

Remote command: 
DIGital<m>:Hysteresis on page 719

Couple Levels ← Threshold
Applies the threshold and hysteresis values of the first nibble (D0 to D3) to all digital
channels.

Remote command: 
DIGital<m>:THCoupling on page 719

Label
Opens the "Label" menu.

Digital Channels
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You can define a label for each digital channel, and display each label individually. The
labels are shown on the the right side of the display. You can enter a label text in sev-
eral ways:
● Select a predefined string from the "Library".
● Enter a user-defined text using "Edit Label".

Remote command: 
DIGital<m>:LABel on page 720

Bit ← Label
Selects the digital channel for which the label is to be defined.

Label ← Label
Displays or hides the label of the selected digital channel.

Remote command: 
DIGital<m>:LABel:STATe on page 720

Library ← Label
Selects a label text from a list of frequently used terms.

Edit Label ← Label
Opens the on-screen keyboard to enter any label text

The maximum name length is 8 characters, and only ASCII characters provided on the
on-screen keyboard can be used.

POSITION
The vertical POSITION rotary knob moves the digital channels vertically on the screen.
It affects all visible dgital channels.

Remote command: 
DIGital<m>:POSition on page 720

SCALE
The vertical SCALE rotary knob sets the size of the digital channels. The setting affects
all visible dgital channels.

Remote command: 
DIGital<m>:SIZE on page 719

14.3 Parallel Buses

The R&S RTM can display and decode up to 16 lines of a parallel bus. To trigger on
parallel buses, use the pattern trigger. See: Chapter 3.3.2.6, "Pattern", on page 67.

14.3.1 Line Configuration for Parallel Buses

Access: PROTOCOL LOGIC > if "Logic" menu is displayed: "Protocol" > "Bus Type" =
"Parallel" or "Parallel Clocked" > "Configuration "
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A parallel bus can analyze up to 16 digital channels. You can assign the digital chan-
nels to the bus bits individually. The configuration is the same for unclocked and
clocked parallel buses. The configuration remains until you press the PRESET key or
"Set to default".

Bus width
Sets the number of lines to be analyzed.

For an unclocked parallel bus, the maximum number is 16 bits.

For a clocked parallel bus, the maximum number is 15 bits, one channel is reserved for
the clock. If chip select is used in addition, the maximum number is 14 bits.

Remote command: 
BUS<b>:PARallel:WIDTh on page 723
BUS<b>:CPARallel:WIDTh on page 723

Prev. Bit / Next bit
Select the bit to which the source is assigned. The selection is marked with blue color
in the configuration list.

Source
Selects the digital channel that is assigned to the selected bit.

Remote command: 
BUS<b>:PARallel:DATA<m>:SOURce on page 723
BUS<b>:CPARallel:DATA<m>:SOURce on page 723

Set to default
Resets the data lines to the default order D0...D15.

Control Wires
Opens the "Control Wires" configuration menu to setup the clock and chip select lines
for clocked parallel buses.

See: Chapter 14.3.2, "Control Wires Configuration for Clocked Parallel Buses",
on page 360
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POSITION
The vertical POSITION rotary knob moves bus display vertically on the screen.

SCALE
The vertical SCALE rotary knob sets the size of the parallel bus.

14.3.2 Control Wires Configuration for Clocked Parallel Buses

For the clocked parallel bus, a clock line and a chip select line are defined in addition.

Access: PROTOCOL LOGIC > if "Logic" menu is displayed: "Protocol" > "Bus Type =
Parallel Clocked" > "Configuration " > "Control Wires"

Use Chip Select
Enables and disables the chip select line.

Remote command: 
BUS<b>:CPARallel:CS:ENABle on page 724

Chip Select (source)
Selects the digital channel that is used as chip select line.

Remote command: 
BUS<b>:CPARallel:CS:SOURce on page 725

Chip Select (active)
Selects wether the chip select signal is high active (high = 1) or low active (low = 1).

Remote command: 
BUS<b>:CPARallel:CS:POLarity on page 725

Clock (source)
Selects the digital channel that is used as clock line.

Remote command: 
BUS<b>:CPARallel:CLOCk:SOURce on page 724
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Clock (slope)
Selects if the data is sampled on the rising or falling slope of the clock, or on both
edges of a double data rate clock. The clock slope marks the begin of a new bit.

Remote command: 
BUS<b>:CPARallel:CLOCK:SLOPe on page 724

14.3.3 Decode Results

You can enable the decoding in the "Protocol" main menu. Select "Decode" to show
the decoded values below the waveforms in the format selected with "Display". Addi-
tionally, you can display the binary signal with "Bits".

See also: Chapter 11.1.2, "Protocol - Common Settings", on page 193

Additionally, you can display and save a "Frame Table" containing decoded data:
frame number, start time of the frame, identifier, data length, data, checksum, and
state of the frame.

See also: Chapter 11.1.5, "Frame Table: Decode Results", on page 198

Remote commands for unclocked parallel bus:
● BUS<b>:PARallel:FCOunt? on page 725
● BUS<b>:PARallel:FRAMe<n>:DATA? on page 726
● BUS<b>:PARallel:FRAMe<n>:STATe? on page 726
● BUS<b>:PARallel:FRAMe<n>:STARt? on page 726
● BUS<b>:PARallel:FRAMe<n>:STOP? on page 727

Remote commands for clocked parallel bus:
● BUS<b>:CPARallel:FCOunt? on page 725
● BUS<b>:CPARallel:FRAMe<n>:DATA? on page 726
● BUS<b>:CPARallel:FRAMe<n>:STATe? on page 726
● BUS<b>:CPARallel:FRAMe<n>:STARt? on page 726
● BUS<b>:CPARallel:FRAMe<n>:STOP? on page 727

14.3.4 Analyzing Parallel Buses

Similar to serial protocols, the parallel buses - unclocked and clocked - need configura-
tion to decode and display the signal.

To configure parallel buses

1. Press the PROTOCOL LOGIC key on the front panel.

2. If the "Logic" menu is displayed, press "Protocol".

3. Press "Bus" and select the bus to be configured.

4. Press the "Bus Type" and select "Parallel" or "Parallel Clocked".
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5. Press "Configuration".

6. To configure the "Parallel" (unclocked) bus, select the "Bus Width".

7. To configure the "Parallel Clocked" bus:

a) Select the "Bus Width".
b) Press "Chip Select" and select the digital channel connected to CS.
c) Select the "Active" state of chip select.
d) Press "Clock" and select the digital channel connected to the clock line.
e) Select the clock "Slope".

8. Make sure that the thresholds are set correctly.
See:

9. Press "Back" and configure the data display.
See: "To configure decoding and data display" on page 193

Parallel Buses



Data and File ManagementR&S®RTM2000

363User Manual 1317.4726.02 ─ 10

15 Data and File Management
This chapter describes how to print screenshots and how to manage settings, wave-
form data, references, masks, and formulas. All data management functionality is avail-
able in the "File" menu.

To open the File menu

► Press the FILE key on the left of the screen.

● Quick Access with PRINT key...............................................................................363
● Printing..................................................................................................................365
● Saving and Loading.............................................................................................. 367

15.1 Quick Access with PRINT key

The PRINT key is a shortcut key that initiates the associated action. With this key it is
easyto print screenshots to a connected printer, or to save data to a specified storage
location just by pressing a single key.

You can assign one of the following actions to the PRINT key:
● Save device settings
● Save a waveform
● Save a screenshot
● Save a screenshot and the device settings
● Print a screenshot
● Save a report for power measurements (requires option R&S RTM-K31)

Saving data
You also can save data without changing the behavior of the PRINT key by pressing
"Save" for the selected data type in the FILE menu.

15.1.1 Configuring the PRINT-Key Behavior

Assign the action that is initiated when you press the "Print Key".

1. Press FILE > "Print Key".

2. Press the softkey of the action that you want to assign to the PRINT key.

3. Configure the settings for the selected action:
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● Save device settings: FILE > "Device Settings > Save"
● Save a waveform: FILE > "Waveforms"
● Save a screenshot: FILE > "Screenshots"
● Save a screenshot and the device settings: FILE > "Screenshots" and FILE >

"Device Settings > Save"
● Print screenshots: SETUP > "More > Printer"

After this configuration the selected action is started whenever you press the
PRINT key.

15.1.2 PRINT-Key Settings

With FILE > "Print Key", you define thea ction that is executed when you press the
PRINT key.

Device Settings........................................................................................................... 364
Waveforms.................................................................................................................. 364
(Save) Screenshots.....................................................................................................364
Screen & Setup........................................................................................................... 364
(Print) Screenshots..................................................................................................... 365
Report......................................................................................................................... 365

Device Settings
If selected, the device settings are stored when you press the PRINT key. Storage set-
tings are configured with FILE > "Device Settings".

See also: Chapter 15.3.2.2, "Device Settings Menu", on page 374.

Waveforms
If selected, the current waveform is stored when you press the PRINT key. Storage
settings are configured with FILE > "Waveforms".

See also: Chapter 15.3.3.3, "Waveform Storage Settings", on page 378.

(Save) Screenshots
If selected, a screenshot of the current display is stored when you press the PRINT
key. Storage settings are configured with FILE > "Screenshots".

See also: Chapter 15.3.4.2, "Screenshot Storage Settings", on page 380.

Screen & Setup
If selected, the device settings and a screenshot of the current display are stored when
you press the PRINT key. Storage settings are configured with FILE > "Screenshots"
and FILE > "Device Settings".

See also: Chapter 15.3.4.2, "Screenshot Storage Settings", on page 380

 

Quick Access with PRINT key



Data and File ManagementR&S®RTM2000

365User Manual 1317.4726.02 ─ 10

(Print) Screenshots
If selected, a screenshot of the current display is sent to the USB printer when you
press the PRINT key. Printer settings are configured with SETUP > "Printer".

See also: Chapter 15.2, "Printing", on page 365

Report
If selected, a report of the current power measurement results is saved when you
press the PRINT key. To configure the report settings, use TOOLS > "Power Analysis"
> "Report".

The setting is only available if option R&S RTM-K31 Power Analysis is installed, and if
you have created at least one report in the "Power Analysis" menu.

See also Chapter 12.4, "Report", on page 300.

15.2 Printing

You can create a sceenshot of the current display of your waveforms and measure-
ment results and print it on a printer. To optimize the output, you can configure different
color modes. The printer has to be connected to a Type A USB port. Alternatively, you
can save screenshots to files, see also: Chapter 15.3.4, "Screenshots", on page 379.

If you want to print many screenshots, you can assign the printout function to the
PRINT key. This key is a shortcut key that initiates the assigned action at a single key-
press. Infrequent printouts can be started from the "File" menu, see also: Chap-
ter 15.2.1.3, "Quick Printing with the PRINT Key", on page 366.

15.2.1 Printing a Screenshot

Before you can print, you have to:
● Connect and configure the printer
● Configure the PRINT key if you need quick printout

Then you can start the printout from the "File" menu or with the PRINT key.

15.2.1.1 Configuring the Printer Output

For the printout, you configure the format and colors. The individual settings are descri-
bed in Chapter 15.2.2, "Printer Settings", on page 366.

1. Connect the printer to a Type A USB port on the front or rear panel of the instru-
ment.

2. Press SETUP > "Printer" to open the "Printer" menu.

3. Press "Paper Format" and select the required format using the "Navigation" knob.

4. In the "Printer" menu, press "Color Mode".
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5. Select the required color format using the "Navigation" knob.

6. Most printers support PCL (Printer Command Language). If your printer does not,
select the appropriate "Command Set".

15.2.1.2 Starting the Printout

Infrequent printouts can be started from the "File" menu.

1. Make sure that the printer is configured correctly.
See: Chapter 15.2.1.1, "Configuring the Printer Output", on page 365

2. Press the FILE key.

3. Press "Screenshots > Print".

15.2.1.3 Quick Printing with the PRINT Key

You assign the print function to the PRINT key. Thus, a screenshot is printed on the
connected printer when you press the PRINT key.

See also Chapter 15.1, "Quick Access with PRINT key", on page 363.

1. Configure the PRINT key:

a) Press FILE > "Print-Key".
b) Press  "(Print) Screenshots".

2. Make sure that the printer is configured correctly.
See: Chapter 15.2.1.1, "Configuring the Printer Output", on page 365

3. Press the PRINT key.

15.2.2 Printer Settings

Access: SETUP key > "More" (switch to page 2/3) > "Printer"

Paper Format
Defines the paper format and the orientation (portrait or landscape) for printing.

Remote command: 
HCOPy:PAGE:SIZE on page 753
HCOPy:PAGE:ORIentation on page 753

Color Mode
Defines the color mode for output on printer.
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"Grayscale" Black and white output

"Color" Color output

"Inverted" Inverts the colors of the output, i.e. a dark waveform is printed on a
white background.

Remote command: 
HCOPy:COLor:SCHeme on page 753

Command Set
Sets the printer language that is supported by the printer. The following printer lan-
guages are supported: PCL5, PCL XL, Postscript, and HP Deskjet (PCL3).

Remote command: 
SYSTem:COMMunicate:PRINter:CSET on page 754

15.3 Saving and Loading

With R&S RTM, you can save and recall your measurement data: device settings,
mask definitions, equation sets, waveform data, and screenshots. Data can be stored
in the instrument or on external device, it can be copied and converted (depending on
the available formats).

● Storage Locations................................................................................................. 367
● Device Settings..................................................................................................... 373
● Waveforms............................................................................................................375
● Screenshots.......................................................................................................... 379
● References, Masks, and Equation Sets: Import/Export........................................ 381

15.3.1 Storage Locations

The R&S RTM provides three basic storage locations to store any data. In the follow-
ing, these locations are refered to as storage devices:
● The "Internal" storage device is a flash memory in the instrument with about 8 MB

memory size.
● The "Front USB" storage device indicates a USB flash drive that is connected to

the USB connector on the front panel of the instrument.
● The "Rear USB" storage device indicates a USB flash drive that is connected to the

USB connector on the rear panel of the instrument.

On each storage device, data can be organized in folders as usual. Therefore, the
R&S RTM allows you to create folders or remove them wherever you need.

Device settings, reference waveforms, masks, and equations sets can be directly
saved to and loaded from any storage device. Waveforms and screenshots can be
saved to USB storage devices only.

To copy data from one storage device to another, the "Import/Export" functions are
used. The name of the target file can be changed, so you can copy and rename in one
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operation. For references and masks, you can also change the target file format and
convert the data during export/import.

This chapter describes the general procedures and settings to save, load, and export/
import data.

15.3.1.1 Configuring Storage Locations

You must configure the storage settings for the various data types initially: select the
storage location and the storage directory, and define the file name. For some data
types, further storage settings are available. Then you can save data simply by press-
ing the "Save" softkey in the FILE menu or, if configured accordingly, by pressing the
PRINT key on the front panel.

To select the storage directory

Whenever you want to save, copy or load data, you have to set the directory where the
data will be stored or loaded from.

1. Press "Storage" to open the storage directory menu and display the file explorer for
the currently selected storage location.
See also: "Storage Directory Menu" on page 371.

2. Press "Storage (Internal/Front/Rear)" until the required storage device is highligh-
ted.
For waveforms and screenshots, only a USB flash drive can be selected as a stor-
age location. If no USB flash drive is connected to the instrument, this function is
not available.

3. Use the "Navigation" knob to scroll through the directories. To change the direc-
tory, scroll to the name of the directory and press the knob, or press "Change dir.".

4. Press "Create dir." to create a new subdirectory under the selected directory. Enter
a name for the subdirectory as described in "To define a new file or directory
name" on page 368.

5. Press "Remove dir." to remove a directory that you no longer need.

6. Press "Accept" to confirm the selected storage directory.

To define a new file or directory name

When you create a new directory or press "File name" to define the name of the stor-
age file, a text editor is displayed in which you can enter the new name.

1. Use the "Navigate" knob to select a character.

2. Press "Character Set", if available, to display additional characters.

3. Press "Backspace" to delete the character to the left of the cursor.

4. Press the "Cursor →" and "Cursor←" softkeys to scroll through the characters of the
name.

5. Press "Default name" to restore the default name.
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6. Press "Accept" to save the defined name.

15.3.1.2 Importing and Exporting Data

To copy data from one storage device to another, the "Import/Export" functions are
used. The procedures is the same for all data types.

The name of the target file can be changed, so you can copy and rename in one oper-
ation. For references and masks, you can also change the target file format and con-
vert the data during export/import.

1. In the FILE menu, press the "Import/Export" softkey for the required data type.

2. Define the source file for the copy operation.

a) Press "Source".
A file explorer is displayed.

b) If necessary, switch to the storage location that contains the source file by
pressing "Storage (Internal/Front/Rear)".

c) Select the source file. Use the "Navigation" knob to scroll through the directo-
ries. To change the directory, scroll to the name of the directory and press the
knob, or press "Change dir.".

d) Press "Load".
The source file is selected, but not yet loaded to the R&S RTM.

3. Define the destination directory for the copy operation. The source file will be cop-
ied here.

a) Press "Destination".
A file explorer is displayed.

b) If necessary, switch to the storage location that contains the storage directory
by pressing "Storage (Internal/Front/Rear)".

c) Select the storage directory. Use the "Navigation" knob to scroll through the
directories. To change the directory, scroll to the name of the directory and
press the knob, or press "Change dir.".
Press "Create dir." to create a new subdirectory under the selected directory.
Enter a name for the subdirectory as described in "To define a new file or direc-
tory name" on page 368.

d) Press "Accept" to confirm the selection.

4. Change the "File Name" of the destination file if necessary.

Note: If a file with the same file name already exists in the destination directory, it
will be overwritten without notification.

5. If you want to change the file format for references or masks, press "Format" and
select the target format.

6. Press "Import/Export".

The source file is copied to the destination directory.
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Imported data is not loaded to the instrument automatically. You must explicitly load it
after import with the "Load" function in the relevant menu (Masks, Reference, Math
menu, or File menu for instrument settings).

15.3.1.3 General Storage Settings

This chapter describes the general settings to save, load, and export/import data.

● Save Menu............................................................................................................370
● Load Menu............................................................................................................ 371
● Storage Directory Menu........................................................................................ 371
● Import/Export Menu...............................................................................................373

Save Menu

The "Save" menu provides functions to configure how the data is saved and to start the
save process. Its main functions are displayed whenever some data has to be stored.
Depending on the data type, additional specific functions may be provided. These func-
tions are described in the relevant chapters.

Storage........................................................................................................................370
File name.................................................................................................................... 370
Comment.....................................................................................................................371
Save............................................................................................................................ 371

Storage
Opens the storage directory submenu, see "Storage Directory Menu" on page 371.
The key indicates the currently selected storage device.

File name
Opens on-screen keyboard to define a new file name to which the data is stored.

Note: If a file with the same file name already exists in the destination directory, it will
be overwritten without notification.
Turn the NAVIGATION knob to mark a character and press the knob to select it. Press
"Backspace" to delete the character to the left of the cursor. Press the "Cursor →" and
"Cursor ←" softkeys to scroll through the characters of the name. Press "Default name"
to restore the standard file name.

Press "Accept" to save the defined name.

Remote command: 
Device settings: MMEMory:NAME on page 752
Waveforms: EXPort:WAVeform:NAME on page 744
Mask Tests: MASK:ACTion:WFMSave:DESTination on page 528
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Comment
Opens an on-screen keyboard to insert a comment to the stored data. Comments are
available for all file formats that can be read by the R&S RTM: device settings, refer-
ence waveforms (trf format), masks, equation sets, search results.

Save
Saves the data to the selected storage directory. The used file name is displayed when
storage is completed.

Remote command: 
Device settings: MMEMory:STORe:STATe on page 751
Other data: MMEMory:DATA on page 750

Load Menu

The "Load" menu provides functions and a file explorer to select data files and to load
it for usage. It is displayed whenever some data has to be loaded.

Storage........................................................................................................................371
Remove File................................................................................................................ 371
Load............................................................................................................................ 371

Storage
Opens the storage directory submenu, see "Storage Directory Menu" on page 371.
The key indicates the currently selected storage device.

Remove File
Deletes the selected file.

Remote command: 
MMEMory:DELete on page 750

Load
Loads the selected file to the instrument.

During an import/export operation, this command confirms the selection of a file and
loads it temporarily. In order to actually copy the file to the selected destination, press
"Import/Export".

Remote command: 
Device settings: MMEMory:LOAD:STATe on page 751

Storage Directory Menu

The storage directory menu is opened with the "Storage" softkey that is available in all
"Save" and "Load" menus. Here you define the storage device and the directory where
the file will be saved or loaded from. If appropriate, you can also create new directories
or delete existing ones.
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Waveforms, screenshots and power measurement reports can only be stored on a
USB flash drive connected to the front or rear panel, not to an internal directory. In this
case, the softkey is only available if a USB flash drive is connected to the rear or front
panel.

See also: Chapter 15.3.1, "Storage Locations", on page 367.

Storage (Internal/Front/Rear)...................................................................................... 372
Sort Entries................................................................................................................. 372
Change Directory........................................................................................................ 372
Create Directory.......................................................................................................... 372
Remove Directory....................................................................................................... 373

Storage (Internal/Front/Rear)
Defines the storage device.

Waveforms, screenshots and power measurement reports can only be stored on a
USB flash drive connected to the front or rear panel, not to an internal directory. In this
case, the softkey is only available if a USB flash drive is connected to the rear or front
panel.

"Internal" Directly in the internal memory of the instrument

"Front" On a USB stick connected to the front panel

"Rear" On a USB stick connected to the rear panel

Remote command: 
MMEMory:MSIS on page 746

Sort Entries
Selects the sort option. You can sort the file list by file type, file name, size and saving
date, each in ascending or descending order.

Change Directory
Switches to the selected directory.

See also: "To select the storage directory" on page 368.

Remote command: 
MMEMory:CDIRectory on page 746

Create Directory
Creates a new subdirectory of the currently selected storage directory.

See also: "To define a new file or directory name" on page 368.

Remote command: 
MMEMory:MDIRectory on page 746

Saving and Loading



Data and File ManagementR&S®RTM2000

373User Manual 1317.4726.02 ─ 10

Remove Directory
Removes the currently selected directory.

Remote command: 
MMEMory:RDIRectory on page 747

Import/Export Menu

The "Import/Export" menu provides functions to copy data between the instrument and
a USB flash device.

See also: Chapter 15.3.1.2, "Importing and Exporting Data", on page 369

Source.........................................................................................................................373
Destination.................................................................................................................. 373
Import/Export...............................................................................................................373

Source
Opens the "Load" menu and a file explorer to select the source file of the import/export
operation.

See "Load Menu" on page 371.

Destination
Opens the "Storage" menu and a file explorer to select the destination of the import/
export operation.

See "Storage Directory Menu" on page 371.

Import/Export
Copies the selected source file to the specified file in the selected destination directory.

Note: If a file with the same file name already exists in the destination directory, it will
be overwritten without notification.

Remote command: 
MMEMory:COPY on page 749

15.3.2 Device Settings

In order to repeat measurements at different times or perform similar measurements
with different test data, it is useful to save the used instrument settings and load them
again later. Furthermore, it can be helpful to refer to the instrument settings of a partic-
ular measurement when analyzing the results. Therefore, functions are provided so
you can easily save the instrument settings of a measurement, with or without the cor-
responding screenshot.

The instrument settings can be saved to and loaded from any storage device - internal
memory or external USB flash device. It is also possible to copy the stored settings to

 

Saving and Loading



Data and File ManagementR&S®RTM2000

374User Manual 1317.4726.02 ─ 10

another storage device with "Export/Import". The file format is always .SET, and the
file size is about 2.76 kB.

You can exchange stored device settings between R&S RTM instruments, also
between 2-channel and 4-channel instruments.

The default instrument settings can be restored with PRESET or FILE > "Device Set-
tings > Default sett.".

15.3.2.1 Saving and Loading Device Settings

● "To save device settings" on page 374
● "To load device settings" on page 374

To save device settings

1. Press FILE > "Device Settings > Save".

2. Configure the storage location as described in "To select the storage directory"
on page 368.

3. Enter the file name as described in "To define a new file or directory name"
on page 368.

4. Optionally, press "Comment" and enter a description of the settings.

5. Press "Save".

Note: To save the device settings several times by pressing simply the PRINT key,
assign the "Device Settings" to the PRINT key as described in Chapter 15.1.1,
"Configuring the PRINT-Key Behavior", on page 363.

To load device settings

1. Press FILE > "Device Settings > Load".

A file explorer is displayed.

2. If necessary, select the storage device and directory described in "To select the
storage directory" on page 368.

3. Select the file that contains the device settings. Use the "Navigation" knob to scroll
through the files.

4. Press "Load".

The saved settings are loaded to the R&S RTM.

15.3.2.2 Device Settings Menu

With FILE > "Device Settings" you open a menu to manage instrument configuration
files.

 

 

Saving and Loading



Data and File ManagementR&S®RTM2000

375User Manual 1317.4726.02 ─ 10

Save............................................................................................................................ 375
└ Setup & Label............................................................................................... 375

Load............................................................................................................................ 375
Import/Export Device Settings.....................................................................................375
Memory Usage............................................................................................................375
Default sett.................................................................................................................. 375

Save
Opens the "Save" menu, see "Save Menu" on page 370.

In addition to the common save functions, specific functions are available.

Setup & Label ← Save
Saves the the device settings together with the label list to the selected storage direc-
tory in one file. The used file name is displayed when storage is completed.

This function is available if option R&S RTM-K1 or K3 is installed (protocols I2C, LIN,
CAN), and a label list was loaded and applied to the protocol data.

When you load a setting file with label list to an instrument, the label list is loaded
together with the instrument settings. A previously loaded label list will be overwritten.

Load
Opens the "Load" menu, see "Load Menu" on page 371.

Import/Export Device Settings
Opens the "Import/Export" menu, see "Import/Export Menu" on page 373.

Memory Usage
Displays information on the instrument and information on used and available memory
space on all available storage devices.

Default sett.
Restores the default device settings. These settings, among others, are also restored
with the PRESET key.

15.3.3 Waveforms

A waveform can be saved in several ways:
● As a reference waveform for later use with R&S RTM: REF key

See: Chapter 5, "Reference Waveforms", on page 94
● As data in various formats directly to a USB flash drive for analysis by other

means: FILE > "Waveforms".
This way is described in the current chapter.
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If you want to save many waveforms, you can assign the function to the PRINT
key. Infrequent save operations can be started from the "File" menu. See also:
Chapter 15.1, "Quick Access with PRINT key", on page 363.

● If the instrument is connected to the LAN, waveform data and instrument settings
can be saved directly to a computer using the Web interface. Downloading data
using the Web interface is much simpler, faster, and more powerful.
See: Chapter 17.2, "Remote Access using a Web Browser", on page 394

15.3.3.1 Waveform File Formats

Data of all waveforms - channel, reference, and math waveforms - is saved as a suc-
cession of values or pairs of values. Pairs of values are written as two consecutive sin-
gle values. Depending on the file format, only amplitude values are stored, or the
amplitude values are stored together with their time value, or frequency value in FFT
mode.

With export/import, you can change the target file format and convert the data.

In order to reload waveform data as a reference waveform, it must be stored in TRF or
CSV format.

CSV Format

In a Comma Separated Values text file, the waveform is stored in a two-columned
table. Columns are separated by a comma, and the lines are separated by line breaks
\r\n (0x0D 0x0A). Values are listed in scientific notation.

The first column contains the time values of the samples in relation to the trigger point,
and the second column contains the associated amplitude values. The first line indi-
cates the units of the values in each column, and the name of the waveform. Pairs of
values are listed as two single values with the same time value (minimum and maxi-
mum).

The data can be loaded back to the instrument for further use.

Example CSV1: Waveform of channel 1, single values

[s],CH1[V]
-1.1996E-02,1.000E-02
-1.1992E-02,1.000E-02
-1.1988E-02,1.000E-02
-1.1984E-02,1.000E-02

Example CSV2: Waveform of channel 1, pairs of values

[s],CH1[V]
-2.9980E+00,2.000E-05
-2.9980E+00,1.400E-04
-2.9960E+00,-1.800E-04
-2.9960E+00,1.400E-04
-2.9940E+00,-1.800E-04
-2.9940E+00,1.400E-04
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Example CSV3: FFT

[Hz],FFT[dBm]
0.000000E+00,1.03746E+01
1.525879E+02,7.49460E+00
3.051758E+02,-1.19854E+01
4.577637E+02,-1.56854E+01

Import of CSV files: If you import a CSV file as reference waveform from a USB flash
drive to the instrument, the import converts the data to TRF format. The instrument
reads the first and the last time value and calculates the total time of the waveform,
and it counts the number of values. Then all amplitude values are read one by one and
written with an equidistant time distribution to the TRF file. If the first two time values
are identical, the waveform is considered to consist of pairs of values.

TXT Format

TXT files are ASCII files that contain only amplitude values but no time values. Ampli-
tude values are separated by commas. Pairs of values are listed as two subsequent
single values, without any identification. Amplitude values are given in scientific nota-
tion. There is no comma at the end of the file.

Amplitude values are given in scientific notation.

Example: TXT file

1.000E-02,1.000E-02,1.000E-02,1.000E-02,3.000E-02

BIN Format

BIN files contain only binary amplitude values but no time values. Each value has a
word size of 8, or 16, or 32 bit, the word size is the same throughout the file.

You can set the word order: BIN MSBF saves data in Big Endian order - beginning with
the MSB (Most Significant Byte) and ending with the LSB (Least Significant Byte). BIN
LSBF saves data beginning with the LSB and ending with the MSB. Pairs of values are
listed as two subsequent single values, without any identification.

FLT Format

FLT files contain amplitude values in float format, where 4 successive bytes are saved
in a 32-bit float value.

You can set the word order: FLT MSBF saves data in Big Endian order - beginning
with the MSB (Most Significant Byte) and ending with the LSB (Least Significant Byte).
FLT LSBF saves data beginning with the LSB and ending with the MSB.

TRF Format

TRF is the specific binary format for reference waveforms of the R&S RTM. It contains
the amplitude value of each sample that is displayed on the sreen (8 bit or 16 bit long).
For peak-detect waveforms, 2 values per sample are saved. The file contains also time
information (time of the first sample and the sample interval) and current instrument
settings. The data can be loaded as reference waveform for further use on the instru-
ment. It is not intended for analysis outside the R&S RTM.
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15.3.3.2 Saving a Waveform to USB flash drive

If you want to save many waveforms, you can assign the function to the PRINT key.
Infrequent savings can be started from the "File" menu. Before you can save the wave-
form, you have to configure the storage location and file format.

1. Press FILE > "Waveforms".

2. Configure the storage location as described in "To select the storage directory"
on page 368.

3. Press "Waveform" and select the waveform to be stored. All active waveforms are
listed.

4. Enter the file name as described in "To define a new file or directory name"
on page 368.

5. Select the "Format".
For details, see Chapter 15.3.3.1, "Waveform File Formats", on page 376.

6. Press "Data" and select whether to save the displayed data or the data stored in
the memory.
For details, see "Data" on page 379.

7. Press "Save".

To save waveforms several times by pressing simply the PRINT key, assign the
"Waveforms" to the PRINT key as described in Chapter 15.1.1, "Configuring the
PRINT-Key Behavior", on page 363.

15.3.3.3 Waveform Storage Settings

With FILE > "Waveforms" you open a menu to store one of the active waveforms to a
USB flash drive.

Storage, File Name,.................................................................................................... 378
Waveform....................................................................................................................379
Format.........................................................................................................................379
Data.............................................................................................................................379
Save............................................................................................................................ 379

Storage, File Name,
For a description of the common functions "Storage" and "File Name", see Chap-
ter 15.3.1.3, "General Storage Settings", on page 370.
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Remote command: 
EXPort:WAVeform:NAME on page 744

Waveform
Selects the waveform to be stored. Turn the "Navigation" knob to select one of the
available waveforms (channel, reference, and math waveforms).

Remote command: 
EXPort:WAVeform:SOURce on page 744

Format
Defines the format of the waveform storage file: BIN, CSV, TXT, or FLT. For details,
see Chapter 15.3.3.1, "Waveform File Formats", on page 376.

Data
Selects the amount of data points to be saved in the waveform file.

"Display Data" All waveform samples that are displayed on the screen will be saved.
Exception: The "Waveform Rate" ist set to maximum sample rate,
and the acquisition is stopped. In this case, the memory can contain
more data samples than the display shows (decimation). To save the
waveform with maximum resolution, the instrument stores the sam-
ples that are saved in the memory.

"Acq. Memory" All data samples that are stored in the memory will be saved.
This setting takes effect only for stopped acquisitions and it is not
available for math waveforms. For running acquisitions, always dis-
play data is stored.

Remote command: 
CHANnel<m>:DATA:POINts on page 430

Save
Saves the data to the selected storage directory. The used path and file name are dis-
played when storage is completed.

"Save" is not possible if "Data" is set set to "Acq. Memory" or "History Data", and the
acquisition is running.

Remote command: 
Waveforms: EXPort:WAVeform:SAVE on page 745

15.3.4 Screenshots

You can create a screenshot of the current display of your waveforms and measure-
ment results and save it to a file. To optimize the output, you can configure different
color modes and file formats. Alternatively, you can print screenshots to a printer.

See also: Chapter 15.2, "Printing", on page 365.

If you want to save many screenshots - together with the instrument or the image only -
you can assign the function to the PRINT key. Infrequent save operations can be star-
ted from the "File" menu.

 

Saving and Loading



Data and File ManagementR&S®RTM2000

380User Manual 1317.4726.02 ─ 10

See also: Chapter 15.1, "Quick Access with PRINT key", on page 363.

15.3.4.1 Saving a Screenshot

Before you can save the screenshot, you have to configure the storage location and
file format.

1. Press FILE > "Screenshots".

2. Configure the storage location as described in "To select the storage directory"
on page 368.

3. Enter the file name as described in "To define a new file or directory name"
on page 368.

4. Select the "Format" and the "Color mode".
For details, see Chapter 15.3.4.2, "Screenshot Storage Settings", on page 380.

5. Press "Save".

See also: Chapter 15.1, "Quick Access with PRINT key", on page 363.

15.3.4.2 Screenshot Storage Settings

With FILE > "Screenshots" you open a menu to save or print screenshots of the current
display.

For a description of the common save functions "Storage", "File Name", and "Save",
see Chapter 15.3.1.3, "General Storage Settings", on page 370. Specific settings for
saving screenshots are described below.

Format.........................................................................................................................380
Color mode..................................................................................................................381
Print.............................................................................................................................381

Format
Defines the format of the screenshot file. The following formats are available:
● BMP

BitMaP is an uncompressed format, files are large and saving might take some
time.

● PNG
Portable Network Graphics is a graphic format with lossless data compression.

If you select "BMP" or "PNG", the complete display is saved, including the menu.

If you select"BMP (no menu)" or "PNG (no menu)", the menu is clipped off, and date
and time are shown instead of the menu name.
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Remote command: 
HCOPy:LANGuage on page 753
HCOpy:MENU[:ENABle] on page 753

Color mode
Defines the color mode for saved screenshots.

"Grayscale" Black and white output

"Color" Color output

"Inverted" Inverts the colors of the output, i.e. a dark waveform is printed on a
white background

Remote command: 
HCOPy:COLor:SCHeme on page 753

Print
Prints the screenshot on a printer connected to the USB connector on the front or rear
panel. The printer output is configured with SETUP > "Printer".

The function is only available if a printer is connected.

Remote command: 
HCOPy[:IMMediate] on page 752

15.3.5 References, Masks, and Equation Sets: Import/Export

The "File" menu provides the functions to copy mask files, equation sets, and refer-
ence waveform files from one storage device to another.

For details, refer to the relevant chapters:
● Reference waveforms: Chapter 5, "Reference Waveforms", on page 94
● Masks: Chapter 9, "Masks", on page 163
● Equation sets: Chapter 7, "Mathematics", on page 118
● Export/Import procedure: Chapter 15.3.1.2, "Importing and Exporting Data",

on page 369

 

Saving and Loading



General Instrument SetupR&S®RTM2000

382User Manual 1317.4726.02 ─ 10

16 General Instrument Setup
This chapter describes the firmware update, the activation of new options, and all soft-
keys of the "Setup" menu.

The usage of the functions except of update is described in other chapters depending
on the usage context:
● chapter "Defining General Instrument Settings" in the "Getting Started" manual:

configuring date, time, interface and help language, and sounds;
● Chapter 17.1, "Operation in a LAN", on page 392.

16.1 Firmware and Options

● Updating Firmware................................................................................................382
● Activating Options................................................................................................. 383
● Moving a Portable License....................................................................................383

16.1.1 Updating Firmware

This chapter describes how to update the instrument's firmware and the interface firm-
ware. Instrument and interface firmware are delivered in different files, which are
packed together into the firmware zip file. Instrument and interface firmware must be
updated in separate steps.

You should update the instrument and interface firmware in regular intervals to take
advantage of new functions and solve possible problems.

To update the instrument firmware

1. Download the current firmware package from the instrument's Web page: http://
www.scope-of-the-art.com/product/rtm.html under "Downloads > Firmware".

2. Extract the zip package and copy the required files to a USB flash drive.

Note: The zip package contains the interface firmware and instrument firmware:
RTM20x2.fwu / RTM20x4.fwu for R&S RTM20xx instruments, and
RTM2102.fwu / RTM2104.fwu for R&S RTM21xx.
Instruments with an upgrade to 1 GHz bandwidth always require the
RTM210x.fwu file.

3. Insert the USB flash drive in the instrument.

4. Press SETUP.

5. Press "More".

6. Press "Update > Firmware".
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The currently installed firmware version as well as all available update versions are
displayed.

7. Press "Execute" to start the firmware update.

Note: After update, the instrument reboots itself.
Do not turn off the instrument or interrupt the power during the update process. An
incomplete update leads to an undefined software state and the instrument does
not work properly.

To update the interface firmware

1. Insert a USB flash drive containing an interface update file in the instrument.

2. Press SETUP > "Update > Interface".

The currently installed firmware version as well as all available update versions are
displayed.

3. Press "Execute" to install the available updates.

Note: Do not turn off the instrument or interrupt the power during the update proc-
ess. An incomplete update leads to an undefined software state and the instrument
does not work properly.

16.1.2 Activating Options

You need the material number and serial number of your instrument to get a license
key. New R&S RTM options must be activated using the license key supplied by
Rohde & Schwarz. The license key can be read from a license file or entered manually.

A detailed description of the key activation procedure is delivered together with the
license key information.

16.1.3 Moving a Portable License

The following procedure describes how to move an active portable license to another
instrument. Each instrument is identified by its individual device ID.

The procedure involves the transfer of files between the R&S License Manager and the
instruments using a USB flash drive.

1. On the source instrument, save the portable license to a file:

a) Press SETUP > "Update" > "Licenses" > "Portable Licenses".
b) Select the portable license to be moved.
c) Press "Save to license file" and store the portable license to a USB flash drive.

2. In the R&S License Manager, identify the source and target instruments:

a) Open the R&S License Manager: https://extranet.rohde-schwarz.com/service
b) Select "Move Portable License".
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c) Enter the device identifications of the source and target instruments.
You find the IDs on the top of the "Portable Licenses" window.

3. In the R&S License Manager, identify the portable license to be moved and create
a deactivation key for the source instrument:

a) Open the portable license file that you have saved in step 1.
b) Generate and note a deactivation key. Store it on the USB flash drive.

4. On the source instrument, deactivate the license and generate a response key:

a) Press "Read keys from license file" and install the deactivation key file gener-
ated in the previous step.

b) Note the deactivation response key.

5. In the R&S License Manager, verify that the license has been deactivated and gen-
erate an activation key for the target instrument:

a) Enter the deactivation response key generated in the previous step.
As a result, a portable license file registered for the target is generated.

b) Store the license file on the USB flash drive.

6. On the target instrument, press SETUP > "Update" > "Licenses" > "Read keys from
license file" and install the activation key file generated in the previous step.

The portable license is now active on the target instrument.

16.2 Reference for Setup

The SETUP key provides functions for basic instrument settings and allows you to
update the instrument's firmware and help files:

Time Reference...........................................................................................................386
Menu Off..................................................................................................................... 386
Language.................................................................................................................... 386
Date & Time................................................................................................................ 386

└ Year/Month/Day/Hour/Minute....................................................................... 386
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Interface...................................................................................................................... 386
└ USB...............................................................................................................386
└ LAN...............................................................................................................386
└ IEEE488........................................................................................................387
└ Parameter..................................................................................................... 387

└ DHCP..................................................................................................387
└ Next.................................................................................................... 387
└ Up....................................................................................................... 387
└ Down...................................................................................................387
└ Default................................................................................................ 387
└ Save....................................................................................................387

Device Information...................................................................................................... 387
Update.........................................................................................................................387

└ Firmware.......................................................................................................388
└ Execute...............................................................................................388

└ Interface........................................................................................................388
└ Execute...............................................................................................388

└ Licenses........................................................................................................388
└ Read keys from license file.................................................................388
└ Input key manually..............................................................................388
└ Licenses..............................................................................................388
└ Portable licenses................................................................................ 389

Printer..........................................................................................................................389
Sound..........................................................................................................................389

└ Control Beep.................................................................................................389
└ Error Beep.....................................................................................................389
└ Trigger Beep................................................................................................. 389

Self Alignment............................................................................................................. 389
└ Start.............................................................................................................. 390
└ Export............................................................................................................390
└ Abort............................................................................................................. 390

Probe Adjust................................................................................................................390
└ 1kHz..............................................................................................................390
└ 1MHz.............................................................................................................390
└ Automatic......................................................................................................390

Education Mode.......................................................................................................... 390
└ Education Mode............................................................................................390
└ Set Password................................................................................................390
└ Clear Password.............................................................................................390

Secure Erase.............................................................................................................. 391
Device Name...............................................................................................................391
LED Intensity...............................................................................................................391
Trigger Output............................................................................................................. 391

└ Output........................................................................................................... 391
└ Polarity..........................................................................................................391
└ Pulse width....................................................................................................391
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Time Reference
Defines the time reference point in the diagram, i.e. the point at which the trigger is 0 s.
The reference point is defined as an offset of divisions from the center in the diagram.
By default, the reference point 0 s is displayed in the center of the window, which cor-
responds to 0 divisions.

The scaling of the waveform depends on this reference point.

Remote command: 
TIMebase:REFerence on page 416

Menu Off
Defines how long a selection menu for a softkey is displayed before it automatically
closes again.

Language
Selects the language in which the key labels, help and other screen information is dis-
played. Currently, the help is available only in English.

Remote command: 
DISPlay:LANGuage on page 755

Date & Time
Provides softkeys to set the current date and time in the instrument.

Year/Month/Day/Hour/Minute ← Date & Time
Change the date and time settings individually. Changes are only adopted by the
instrument after you press "Save and Back".

Remote command: 
SYSTem:DATE on page 757
SYSTem:TIME on page 757

Interface
Activates or deactivates additional instrument interfaces. Using these interfaces you
can communicate with the instrument, for example to read out data or automate the
measuring station. Various interfaces are available as options for the instrument and
are installed in a specific slot at the rear. Depending on the installed interface, addi-
tional parameters may be definable via the "Parameter" softkey after the interface has
been activated.

USB ← Interface
Activates the (Type B) USB interface for remote control. The USB interface provides a
simple way to connect the instrument to a PC. The USB 2.0 standard is supported.
Use a connection cable that is suitable for a "Type B" USB interface.

No settings are available for the USB interface.

Note: You cannot connect a printer via the Type B USB interface. Use one of the Type
A USB interfaces on the rear or front panel to connect a printer.

LAN ← Interface
Activates the LAN interface which allows you to connect the instrument to various other
devices. Access to the instrument is controlled via its IP address.
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By default, the instrument is set to use DHCP. If the instrument cannot find a DHCP
server, it takes about two minutes until the LAN menu is available.

The interface is configured using the Parameter softkey. See also: Chapter 17.1,
"Operation in a LAN", on page 392.

IEEE488 ← Interface
Activates the IEEE488 interface, also known as a "General Purpose Interface Bus"
(GPIB). Using this interface, up to 15 devices can be connected to the instrument.
Each device is identified by a unique number, which is defined within the device.

The interface is configured using the Parameter softkey. For details see Chapter 17.1,
"Operation in a LAN", on page 392.

Parameter ← Interface
Provides a settings dialog to configure the active additional interface. Changes are only
adopted by the instrument after you press "Save".

DHCP ← Parameter ← Interface
Activates or deactivates usage of the Dynamic Host Configuration Protocol (DHCP). If
the network supports dynamic TCP/IP configuration using DHCP, all address informa-
tion can be assigned automatically.

Next ← Parameter ← Interface
For settings that require several entries in one row, "Next" selects the next entry.

To select the next setting in the dialog, press "Down", to select the previous setting,
press "Up".

Up ← Parameter ← Interface
Selects the previous setting in the dialog.

Down ← Parameter ← Interface
Selects the next setting in the dialog.

Default ← Parameter ← Interface
Restores the default interface settings.

Save ← Parameter ← Interface
Saves the changes to the instrument and closes the dialog.

Device Information
Displays information on the instrument, such as its serial number, the installed soft-
ware version and hardware information. This information is required in case of a sup-
port request.

Update
Provides functions to update the help files or firmware of the instrument or interfaces.
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Firmware ← Update
Allows you to update the instrument firmware. The currently installed firmware version
is displayed, as well as all available update versions if a USB flash drive containing an
update is identified. The instrument is only updated when you press "Execute".

Note: You should update the instrument firmware in regular intervals to take advant-
age of new functions and solve possible problems.
The online help is not included in the firmware update package. Update the online help
separately to get the latest information.

Execute ← Firmware ← Update
The instrument firmware is updated.

Interface ← Update
Some interfaces are provided with their own instrument-independent firmware. This
interface firmware can also be updated. The currently installed firmware version is dis-
played, as well as all available update versions, if a USB flash drive containing an
update is identified. The instrument is only updated when you press "Execute".

Note: You should update the interface firmware in regular intervals to take advantage
of new functions and solve possible problems.

Execute ← Interface ← Update
The interface firmware is updated.

Licenses ← Update
Provides functions to activate options.

Read keys from license file ← Licenses ← Update
Select the storage and directory where your license file is stored, and press "Load" to
activate the options.

Input key manually ← Licenses ← Update
Opens the on-screen keyboard to enter the license key of the option.

Licenses ← Licenses ← Update
Displays a list of all licenses of the instrument: active licenses, inactive licenses, and
the response keys of deactivated licenses. The following license types are available:
● Permanent: unlimited licenses for a dedicated instrument.

Reference for Setup



General Instrument SetupR&S®RTM2000

389User Manual 1317.4726.02 ─ 10

● Portable permanent: unlimited licenses that can be transferred to another instru-
ment.

● Temporary: time-limited licenses for a dedicated instrument. The remaining validity
period is shown in the "Validity" column.

Portable licenses ← Licenses ← Update
Opens a menu to manage portable licenses. Use "License" to list the portable licenses
that are installed on the instrument. To move the selected portable license to another
instrument, use "Save to license file".

The "Portable licenses" key is only active if at least one portable license is installed.

Printer
Opens a menu to configure the output on the printer: paper format, orientation, color,
and printer language. The printer has to be connected to a (Type A) USB port.

For details, see Chapter 15.2.2, "Printer Settings", on page 366.

Sound
Defines the event types for which a sound is to be generated by the instrument. Switch
the sound for a particular event type on or off by selecting the corresponding softkey.
Active sounds are highlighted.

Control Beep ← Sound
Generates a sound for general control events, e.g. reaching the rotary encoder end or
changing the measuring mode in the "Automeasure" menu.

Remote command: 
SYSTem:BEEPer:CONTrol:STATe on page 757

Error Beep ← Sound
Generates a sound if an error occurs in the instrument, e.g. when the input exceeds 50
 Ω or a false value is entered in a dialog.

Remote command: 
SYSTem:BEEPer:ERRor:STATe on page 757

Trigger Beep ← Sound
Generates a sound when the trigger condition is fulfilled.

Remote command: 
SYSTem:BEEPer:TRIG:STATe on page 758

Self Alignment
Opens a submenu to execute an internal self-alignment of the instrument. Alignment is
only executed when you press the "Start" softkey.

When data from several input channels is displayed at the same time, it may be neces-
sary to align the data in order to synchronize the time bases, amplitudes, and posi-
tions. This is the case, for example, when strong temperature changes occur.

Remote command: 
CALibration on page 755
CALibration:STATe? on page 756
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Start ← Self Alignment
Starts the internal self-calibration of the instrument. Status information is displayed on
the screen.

Export ← Self Alignment
Opens the submenu to store the log file on USB stick.

See also: "Storage Directory Menu" on page 371.

Abort ← Self Alignment
Aborts the internal self-calibration of the instrument.

Probe Adjust
A R&S RTM allows you to adjust a probe without further devices. Two connector pins
are located on the front panel. The left pin is on ground level. The right pin supplies a
square wave signal for the adjustment. In this menu you can choose between two fre-
quencies (1 kHz, 1 MHz) or allow the detection of an automatic setting by the instru-
ment. The rise time does not differ between the settings.

1kHz ← Probe Adjust
A square wave with a frequency of f = 1 kHz is generated at the "Probe Adjust" pin.
Use this setting to adjust the LF band of the probe.

1MHz ← Probe Adjust
A square wave with a frequency of f = 1 MHz is generated at the "Probe Adjust" pin.
Use this setting to adjust the HF band of the probe.

Automatic ← Probe Adjust
A square wave is generated at the "Probe Adjust" pin. The frequency of the square
wave depends on the defined time base. If the time base becomes too small to display
the 1 kHz wave, it is automatically switched to a 1 MHz wave.

Education Mode
Opens a menu where you can disable the comfort functions Autoset, Quick Meas, and
automatic measurements for educational purpose.

Education Mode ← Education Mode
If enabled, the comfort functions Autoset, Quick Meas, and automatic measurements
are not available. This status is shown in the "Device Information".

Set Password ← Education Mode
You can enter a password to prevent unwanted deactivation of the education mode.

Clear Password ← Education Mode
Deletes the password. Then, all users can enable and disable the education mode.
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You have to enter the password before it is deleted.

If you forgot the password, you can reset it using the SYSTem:EDUCation:PRESet
remote command.

Secure Erase
Deletes current instrument configuration data and user data (for example, reference
files, equation sets, masks) from the internal storage. Calibration data remains in the
storage.

Use this function before you send the instrument to the service. If the instrument is
used in a secured environment, the function ensures that all sensitive data is removed
before the instrument leaves the secured area.

To start secure erase, select "OK". Do not turn off the instrument before the process
has been completed!

See also: document "Resolving Security Issues When Working in Secure Areas" that is
delivered on the documentation CD-ROM and on the R&S RTM internet web page.

Device Name
Enter the name of the instrument.

LED Intensity
Defines the luminosity of illuminated front panel keys and rotary knobs.

Trigger Output
Opens the "Trigger Output" menu.

Output ← Trigger Output
Enables the trigger out signal and defines when a trigger out pulse is generated: on
trigger event, or on mask violation.

Trigger output on mask violation is enabled and configured in TOOLS >"Masks Tests >
Actions > Pulse".

Remote command: 
TRIGger:OUT:MODE on page 756

Polarity ← Trigger Output
Sets the polarity of the trigger out pulse.

Remote command: 
TRIGger:OUT:POLarity on page 756

Pulse width ← Trigger Output
Defines the pulse width of the trigger out pulse.

Remote command: 
TRIGger:OUT:PLENgth on page 756

Reference for Setup
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17 Network and Remote Operation

17.1 Operation in a LAN

17.1.1 Connecting the Instrument to the LAN

The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps
Ethernet IEEE 802.3u interface.

Risk of network failure
Before connecting the instrument to the network or configuring the network, consult
your network administrator. Errors may affect the entire network.

► To establish a network connection, connect a commercial RJ-45 cable to one of
the LAN ports of the instrument and to a PC.

17.1.2 Configuring LAN Parameters

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host

Configuration Protocol (DHCP), and a DHCP server is available, all address infor-
mation can be assigned automatically.

● Otherwise, the address must be set manually. Automatic Private IP Addressing
(APIPA) is not supported.
See: "Configuring LAN parameters manually (no DHCP)" on page 393

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish a
physical connection to the LAN without any previous instrument configuration.

Risk of network errors
Connection errors can affect the entire network. If your network does not support
DHCP, or if you choose to disable dynamic TCP/IP configuration, you must assign
valid address information before connecting the instrument to the LAN. Contact your
network administrator to obtain a valid IP address.
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Configuring LAN parameters manually (no DHCP)

1. Disconnect the R&S RTM from the LAN.

2. Restart the instrument.

3. Press the SETUP key and then the "Interface" softkey.

4. Wait about two minutes until the LAN menu is available. Press the "LAN" softkey.

Note: By default, the instrument is set to use DHCP. If the instrument cannot find a
DHCP server, it takes some time until the LAN settings can be accessed.

5. Press the "Parameter" softkey.

The "LAN settings" dialog box is displayed.

Some data is displayed for information only and cannot be edited. This includes the
"MAC" (physical) address of the connector and the "Link" status information.

6. If the LAN does not support DHCP, or the instrument is directly connected with a
computer, disable DHCP: Press the "DHCP" softkey so that it is not highlighted
(off).

7. Define the IP address of the instrument by entering each of the four blocks individ-
ually.

Operation in a LAN
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a) Define the first block number using the Navigation knob.
b) Press "Next" to move to the next block and define the number.
c) When the IP address is complete, press "Down" to continue with the next set-

ting.

8. Define the "Subnetmask" and "Gateway" in the same way as the IP address.

9. Select the "IP Port" - the port number for raw socket communication.

10. Select the "HTTP Port" used by the instrument.

11. Select the "Transfer" mode. This mode can either be determined automatically
("Auto" setting), or you can select a combination of a transfer rate and half or full
duplex manually.

12. Press "Save" to save the LAN parameters on the instrument.

The "Link" status information at the bottom of the dialog box indicates whether a
LAN connection was established successfully.

Checking LAN and SCPI connection

1. Check the LAN connection using ping: ping xxx.yyy.zzz.xxx.

2. If the computer can access the instrument, enter the IP address of the R&S RTM in
the address line of the internet browser on your computer: http//:xxx.yyy.zzz.xxx.
See: Chapter 17.2.1, "Accessing the Instrument using a Web Browser",
on page 394

17.2 Remote Access using a Web Browser

The R&S RTM firmware contains a web server. If a LAN connection is established, you
can access the instrument remotely using a web browser on the control computer.

The browser access allows you to:
● Check instrument data
● Control the instrument
● Print screenshots
● Send remote commands
● Save waveform and instrument data
● Check network settings

17.2.1 Accessing the Instrument using a Web Browser

To access the R&S RTM, you need a LAN connection and the IP address of the instru-
ment.
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1. Obtain the IP address of the R&S RTM: SETUP > "Interface" > activate "LAN" >
"Parameter".

2. Open an Internet browser on the control computer.

3. Enter the IP address of the R&S RTM in the address line: http//:xxx.yyy.zzz.xxx.

The "Instrument Home" page appears.

17.2.2 Instrument Home

The "Instrument Home" page provides information on the instrument and the LAN con-
nection.

17.2.3 Sceenshot

The "Screenshot" page shows a copy of the instrument's screen. It also provides
instrument control functions and screenshot settings.

Instrument control

● "Run" and "Stop"
Start and stop continuous acquisition, see also "RUN CONT" on page 57.

● "Single"
Starts a single acquisition

● "Autoset" = AUTOSET key on the instrument
● "Preset" = PRESET key on the instrument
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Screenshots

● "Auto refresh" and "Update"
Get the current screen content from the instrument. With "Auto refresh", you can
set the interval of automatic updates.

● Format and Color:
● Set the file format and color mode of the screenshot, see also Chapter 15.3.4.2,

"Screenshot Storage Settings", on page 380.

► To save the screenshot, right-click the picture and select "Save picture as".

17.2.4 SCPI Device Control

On the "SCPI Device Control" page, you can check how the transfer of remote com-
mands is working.

You can enter a single command, for example; *IDN?, and transmit it with "Send". Do
not press the ENTER key.
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If the sent command has an error, an error message is created in the background, and
you do not get any response. You can see the error messages using "Last Error Mes-
sage" and "All Error Messages"

17.2.5 Save/Recall

On the "Save/Recall" page, you can save waveform data and instrument settings to a
file - either on the computer (local file) or on the instrument (remote device). On the
computer, the default storage directory is the download folder, but you can change the
directory using the download functions of your browser. On the instrument, the files are
saved in the internal storage.

You can also load reference waveforms and instrument settings from file to the instru-
ment.

To save data to local file

1. Select the waveform or the device settings in the "Source" list.

2. Select the file "Format".

See also:
● Chapter 15.3.3.1, "Waveform File Formats", on page 376
● Chapter 5, "Reference Waveforms", on page 94
● Chapter 15.3.2, "Device Settings", on page 373

3. For analog and digital channels, select the "Data" scope to be written.
See also: "Data" on page 379

4. Click "Save".
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17.2.6 Network Settings

On the "Network Setting" page, you can change the port settings, switch off DHCP
address and enter an IP address in a more comfortable way than directly on the instru-
ment. To take effect of the changes, "Submit" them to the instrument.

"Reset" removes all modified values that were not yet sent to the instrument.
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17.3 Remote Control Interfaces

For remote control, the LAN, USB or the GPIB interface can be used. The GPIB inter-
face (Option RTM-B10) replaces the LAN / USB type B interface module on the rear
panel.

Table 17-1: Remote control interfaces and protocols

Interface Protocols, address string Remarks

Local Area
Network
(LAN)

VXI-11 protocol:
TCPIP::<IP_address>[::inst0]::INSTR

Raw socket mode:
TCPIP::<IP_address>::<IP_port>::SO
CKET

The LAN connector is located on the rear panel of
the instrument.
See also:
● Chapter 17.1, "Operation in a LAN",

on page 392
● Chapter 17.3.1, "LAN Interface", on page 399

USB USB::<vendor_ID>::<prod-
uct_ID>::<serial_number>[::INSTR)

A USB type B connector is located on the rear
panel of the instrument.

See also: Chapter 17.3.2, "USB Interface",
on page 401

GPIB (IEC/
IEEE Bus
Interface)

GPIB::primary address[::INSTR]

(no secondary address)

An optional GPIB bus interface according to stan-
dard IEC 625.1/IEEE 488.1 can be mounted on the
rear panel of the instrument.

See also: Chapter 17.3.3, "GPIB Interface (IEC/
IEEE Bus Interface)", on page 402.

Within this interface description, the term GPIB is used as a synonym for the IEC/IEEE
bus interface.

SCPI compatibility

SCPI commands (Standard Commands for Programmable Instruments) are used for
remote control. The SCPI standard is based on standard IEEE 488.2 and aims at the
standardization of device-specific commands, error handling and the status registers.
The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2"
from John M. Pieper (R&S order number 0002.3536.00) offers detailed information on
concepts and definitions of SCPI. The instrument supports the SCPI version 1999.

SCPI-confirmed commands are explicitly marked in the command reference chapters.
Commands without SCPI label are device-specific, however, their syntax follows SCPI
rules.

17.3.1 LAN Interface

The R&S RTM is equipped with a network interface and can be connected to an Ether-
net LAN (local area network) for remote control of the instrument. The instrument
accepts remote commands via the LAN interface using the VISA library. VISA must be
installed on the control computer.
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The R&S RTM supports two ways of LAN communication:
● VXI-11 protocol: a protocol that has been specifically developed for test and mea-

surement instruments. It is the recommended protocol for remote control via LAN.
● Raw socket mode: a synchronous, streaming oriented protocol. Consequently, raw

socket communication does not support asynchronous events like Service Request
(SRQ) or Device Clear (DCL).

See also: Chapter 17.1, "Operation in a LAN", on page 392.

17.3.1.1 IP Address and VISA Resource String

Only the IP address of the instrument is required to set up the connection. It identifies
the instrument in the network and is part of the resource string used by the programs to
identify and control the instrument. Depending on the communication mode - VXI-11
protocol or raw socket mode - the resource string has different forms.

IP address and port number are listed in the "Ethernet Settings" of R&S RTM, see
also: Chapter 17.1.2, "Configuring LAN Parameters", on page 392.

If the LAN is supported by a DNS server, the host name can be used instead of the IP
address. The DNS server (Domain Name System server) translates the host name to
the IP address. To assign a host name to the R&S RTM, select SETUP > "More" >
"Device Name".

VXI-11 protocol

TCPIP::<IP address>[::inst0]::INSTR
where:
● inst0 is the LAN device name. VISA supports several devices running on the

instrument. On R&S RTM, only one device is configured, so the LAN device name
can be omitted.

● INSTR indicates that the VXI-11 protocol is used

Example: If the instrument has the IP address 192.1.2.3, the valid resource string is:
TCPIP::192.1.2.3::INSTR
With host name instead of IP address:

TCPIP::<host name>[::inst0]::INSTR
Example: If the computer name is RSRT1, the valid resource string is:
TCPIP::RSRT1::INSTR.

Raw socket mode

TCPIP::<IP_address>::<IP_port>::SOCKET
The default port number for SCPI socket communication is 5025.

Example: If the instrument has the IP address 192.1.2.3; the valid resource string is:
TCPIP::192.1.2.3::5025::SOCKET
With host name instead of IP address:
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TCPIP::<host_name>::<IP_port>::SOCKET
Example: If the host name is RSRT1; the valid resource string is: TCPIP::RSRT1::
5025::SOCKET

The end character must be set to linefeed.

17.3.1.2 VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

17.3.2 USB Interface

For remote control via the USB connection, use the USB type B interface to connect
the PC and the instrument. The USB connection requires the VISA library installed on
the PC. No separate driver installation is necessary.

Connect the instrument to the computer using the USB cable and select SETUP >
"Interface" > "USB" on the R&S RTM. VISA detects the R&S instrument automatically
and displays the address string.
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17.3.3 GPIB Interface (IEC/IEEE Bus Interface)

The GBIP interface is optional (option RTM-B10). It replaces the LAN / USB type B
interface module on the rear panel. Thus, remote control is possible either with LAN or
USB connection, or with GBIP.

To be able to control the instrument via the GPIB bus, the instrument and the controller
must be linked by a GPIB bus cable. A GPIB bus card, the card drivers and the pro-
gram libraries for the programming language must be provided in the controller. The
controller must address the instrument with the GPIB instrument address.

Characteristics

The GPIB interface is described by the following characteristics:

● Up to 15 instruments can be connected
● The total cable length is restricted to a maximum of 15 m; the cable lenth between

two instruments should not exceed 2m.
● A wired "OR"-connection is used if several instruments are connected in parallel.

GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the
GPIB address. The remote control address is factory-set to 20, but it can be changed
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in the network environment settings or in the "Setup" menu under "Interface > Parame-
ter". For remote control, addresses 0 through 30 are allowed. The GPIB address is
maintained after a reset of the instrument settings.

17.4 Switching to Remote Control

When you switch on the instrument, it is always in manual operation state ("local"
state) and can be operated via the front panel.

When you send a command from the control computer, it is received and executed by
the R&S RTM. The display remains on, manual operation via the front panel is always
possible.
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18 Remote Commands Reference
This chapter provides the description of all remote commands available for R&S RTM.
The commands are sorted according to the menu structure of the instrument. A list of
commands in alphabetical order ist given in the "List of Commands" at the end of this
documentation.

● Conventions used in Command Description.........................................................404
● Programming Examples........................................................................................405
● Common Commands............................................................................................ 409
● Acquisition and Setup........................................................................................... 413
● Trigger...................................................................................................................447
● Display.................................................................................................................. 462
● Reference Waveforms.......................................................................................... 470
● Measurements...................................................................................................... 475
● Mathematics..........................................................................................................497
● Spectrum Analysis................................................................................................ 500
● Masks....................................................................................................................524
● Search...................................................................................................................530
● Protocol Analysis...................................................................................................547
● Power Analysis (Option R&S RTM-K31)...............................................................665
● Mixed Signal Option (MSO, R&S RTM-B1)...........................................................717
● Digital Voltmeter and Counter (Option R&S RTM-K32)........................................ 727
● Data and File Management...................................................................................730
● General Instrument Setup.....................................................................................755
● Status Reporting................................................................................................... 759

18.1 Conventions used in Command Description

Note the following conventions used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitly.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S RTM follow the SCPI syntax rules.

● Asynchronous commands
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A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

● Default unit
This is the unit used for numeric values if no other unit is provided with the parame-
ter.

18.2 Programming Examples

● Data Export........................................................................................................... 405
● Search...................................................................................................................407
● Data and File Management...................................................................................408

18.2.1 Data Export

● Reading Waveform Data in Real Format.............................................................. 405
● Reading Waveform Data in Unsigned Integer Format.......................................... 406

18.2.1.1 Reading Waveform Data in Real Format

Set data format and sample range, read channel header and data.

Command description in Chapter 18.17.1, "Waveform Data Transfer", on page 730.

* Connected to: TCPIP0::192.168.1.1::inst0::INSTR
SYST:ERR?
<-- 0,"No error"
*IDN?
<-- Rohde&Schwarz,RTM1052,1305.0008K52/101489,04.502

*RST
CHAN:TYPE HRES            // Set high resolution mode (16 bit data)
ACQ:WRAT MSAM             // Set maximum waveform rate
TIM:SCAL 1E-7             // Set time base
FORM REAL                 // Set REAL data format 
FORM:BORD LSBF            // Set little endian byte order
CHAN:DATA:POIN DMAX       // Set sample range to memory data in displayed time range
SING;*OPC?                // Start single acquisition
<--  1
CHAN:DATA:HEAD?           // Read header
<--  -4.9980E-07,5.0000E-07,5000,1    // Xstart, Xstop, record length in samples
CHAN:DATA?                // Read channel data
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<--  #520000>??[>??[>??[>??[>??[>??...   // Binary block data, 
                                         // 4-byte floating point number/sample

18.2.1.2 Reading Waveform Data in Unsigned Integer Format

Read the channel header, the waveform conversion data, set the UINT binary data for-
mat and read the channel data.

Command description in: Chapter 18.17.1, "Waveform Data Transfer", on page 730.

*RST
TIM:SCAL 1E-7
CHAN:DATA:POIN DMAX       // Set data range
SING;*OPC?
<--  1
CHAN:DATA:HEAD?           // Read header
<--  -4.9980E-07,5.0000E-07,5000,1    // Xstart, Xstop, record length in samples
CHAN:DATA:YRES?           // Read vertical resolution
<--  8
CHAN:DATA:YOR?            // Read voltage value for binary value 0
<--  -2.549999943E-2
CHAN:DATA:XOR?            // Read time of the first sample
<--  -4.998000058E-7
CHAN:DATA:XINC?           // Read time between two adjacent samples                
<--  2.000000023E-10
FORM UINT,8;FORM?         // Set data format to unsigned integer, 8 bit
<--  UINT,8
CHAN:DATA:YINC?           // Read voltage value per bit
<--  1.999999949E-4
CHAN:DATA?                // Read channel data
<--  128,125,120...       // 5000 bytes total
FORM UINT,16;FORM?        // Change data format to unsigned integer, 16 bit
<--  UINT,16
CHAN:DATA:YINC?           // Read voltage value per bit
<--  7.812499803E-7
CHAN:DATA?                // Read channel data
<--  32768,32000,30720... // 10000 bytes total

Note the following correlations:
● The number of received data values matches the number of samples indicated in

the header.
● The time of the first sample (XORigin) matches the start time Xstart indicated in the

header.
● The Y-increment adjusts to the data length defined in the data format (8 or 16 bit).

Data conversion

Definition: the sample numbers start with 0 and end with record length - 1.
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Sample time

tn = n * xIncrement + xOrigin

First sample: t0 = -4.998000058E-7 (= Xstart)

Last sample: t4999 = 4999 * 2E−10 − 4.998E−7 = 5.0 E−7 (= Xstop)

Sample value

Yn = yOrigin + (yIncrement * byteValuen)

The format UINT,8 has the data range 0 to 255. The voltage value for byte value 128
is:

Yn = −2.55E-2 + (2E−4 * 128) = 0.0001

The center of the display at position 0 div always has the byte value 127.5. The corre-
sponding voltage value is:

Yn = −2.55E-2 + (2E−4 * 127.5) = 0

8-bit and 16-bit data

At the end of the above example, the 8-bit waveform is read as 16-bit data, for exam-
ple, 0xFF is read 0xFF00, or 0x1A is read 0x1A00. The yOrigin value is the same in
both cases, but the yIncrement differs.

 8-bit data 16-bit data Result

yIncrement * byteValuen

2e-4 * 128 7,8125E-7 * 32768 0,0256 V

2e-4 * 125 7,8125E-7 * 32000 0,025 V

In the reverse case, if a 16-bit waveform is read with 8-bit data format, data precision
may be reduced. Data values ar truncated, and only the more significiant bits remain.
For example, the 16-bit data 0xabcd is read 0xab in 8-bit format, and cd is lost.

18.2.2 Search

18.2.2.1 Searching for a Pulse of Specified Width

Search for positive pulses with pulse width 12 ± 10 µs (2 µs to 22 µs).

Command description in: Chapter 18.12, "Search", on page 530.

SEAR:STAT ON                // Turn on search
SEAR:COND WIDTH             // Select search condition
SEAR:SOUR CH2               // Configure search source
SEAR:TRIG:WIDT:POL POS      // Configure search parameters: Polarity
SEAR:TRIG:WIDT:RANG WITH    // Configure search parameters: Condition = within
SEAR:TRIG:WIDT:WIDT 12e-6   // Configure search parameters: Pulse width
SEAR:TRIG:WIDT:DELT 10e-6   // Configure search parameters: +/- delta
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SEAR:RESD:SHOW ON           // Show result table
SEAR:RCO?                   // Get number of search events found
<--  1.400E+01 
SEAR:RES:ALL?               // Get all search results 
<--  1,5.201200e-06,0,WIDTH,POSITIVE,1.220160e-05,2,4.120040e-05,0,WIDTH,
POSITIVE,3.076800e-06,3,4.732480e-05,0,WIDTH,POSITIVE,9.127200e-06,4,
6.499960e-05,0,WIDTH,POSITIVE,1.835160e-05,5,8.634920e-05,0,WIDTH,POSITIVE,
3.052000e-06,6,1.293984e-04,0,WIDTH,POSITIVE,9.176800e-06,7,1.477228e-04,0,
WIDTH,POSITIVE,3.052000e-06,8,1.623224e-04,0,WIDTH,POSITIVE,3.102000e-06,9,
1.684724e-04,0,WIDTH,POSITIVE,1.215160e-05,10,1.953216e-04,0,WIDTH,POSITIVE,
3.027200e-06,11,2.044716e-04,0,WIDTH,POSITIVE,6.052000e-06,12,2.252212e-04,0,
WIDTH,POSITIVE,3.052000e-06,13,2.435456e-04,0,WIDTH,POSITIVE,3.027200e-06,14,
2.496456e-04,0,WIDTH,POSITIVE,6.702000e-06

18.2.3 Data and File Management

● Saving Screenshots to File................................................................................... 408
● Saving, Copying, and Loading Setup Data........................................................... 408

18.2.3.1 Saving Screenshots to File

Save two display images in png format to the PIX folder on a USB flash drive that is
connected to the front panel. One screenshot is colored and the other is grayscaled.
Finally, the data of the gray screenshot is read for further user on the control computer.

Command description in: Chapter 18.17.4, "Screenshots", on page 751.

*RST
MMEM:CDIR "/USB_FRONT"
MMEM:MDIR "/USB_FRONT/PIX"
MMEM:CDIR "/USB_FRONT/PIX/"

HCOP:DEST "MMEM"
HCOP:LANG PNG
HCOP:COL:SCH COL
MMEM:NAME "COLORED"
HCOP:IMM
HCOP:COL:SCH GRAY
MMEM:NAME "GRAY"
HCOP:IMM

MMEM:CAT? "*.PNG"
MMEM:DATA? "GRAY.PNG"

18.2.3.2 Saving, Copying, and Loading Setup Data

Save instrument settings to a file on internal storage device, duplicate this file and save
it to a USB stick attached to the front panel. Finally, there are three setup files on the
internal storage /INT/SETTINGS, and one file on the USB flash device.
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Command description in: Chapter 18.17.3, "Instrument Settings", on page 745.

CHAN1:STAT ON                       // Turn channel 1 on
CHAN2:STAT ON                       // Turn channel 2 on
TIM:ZOOM:STAT ON                    // Show zoom diagram
MMEM:CDIR "/INT/SETTINGS"           // Set storage device and directory
MMEM:STOR:STAT 1,"ZOOM_A.SET"       // Save settings to internal storage 
MMEM:CAT? "*.SET"                   // Check
<--  332112,8633856,"ZOOM_A.SET,,2759"
MMEM:COPY "ZOOM_A.SET","ZOOM_B.SET" // Copy file
MMEM:CAT? "*.SET"                   // Check
<--  332112,8633856,"ZOOM_A.SET,,2759","ZOOM_B.SET,,2759"
MMEM:COPY "/INT/SETTINGS/ZOOM_B.SET","/USB_FRONT/ZOOM_B.SET"
                                    // Save copied file to USB stick
MMEM:CDIR "/USB_FRONT"              // Check
MMEM:CAT? "*.SET"
<--  4890624,-641765376,"ZOOM_B.SET,,2759"
MMEM:COPY "/USB_FRONT/ZOOM_B.SET","/USB_FRONT/ZOOM_USB.SET"
                                    // Duplicate file on USB stick
MMEM:CAT? "*.SET"                   // Check
<--  4890624,-641765376,"ZOOM_B.SET,,2759","ZOOM_USB.SET,,2759"
MMEM:DEL "ZOOM_B.SET"               // Delete original file
MMEM:CAT? "*.SET"                   // Check
<--  4886528,-641765376,"ZOOM_USB.SET,,2759"
MMEM:COPY "/USB_FRONT/ZOOM_USB.SET","/INT/SETTINGS/"
                                    // Copy new file to the instrument
MMEM:CDIR "/INT/SETTINGS"           // Check
MMEM:CAT? "*.SET"   
<--  332112,8633856,"ZOOM_A.SET,,2759","ZOOM_B.SET,,2759","ZOOM_USB.SET,,2759"
*RST;*OPC?
<--  1
MMEM:CDIR "/INT/SETTINGS"
MMEM:LOAD:STAT 1,"ZOOM_USB.SET"     // Load settings

18.3 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

*CAL?...........................................................................................................................410
*CLS.............................................................................................................................410
*ESE.............................................................................................................................410
*ESR?...........................................................................................................................410
*IDN?............................................................................................................................410
*OPC............................................................................................................................411
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*OPT?...........................................................................................................................411
*PSC............................................................................................................................ 411
*RST.............................................................................................................................412
*SRE............................................................................................................................ 412
*STB?...........................................................................................................................412
*TRG............................................................................................................................ 412
*TST?........................................................................................................................... 412
*WAI.............................................................................................................................413

*CAL?

Performs a self-alignment of the instrument and then generates a status response.
Return values ≠ 0 indicate an error.

Usage: Query only

*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event status read

Returns the contents of the event status register in decimal form and subsequently
sets the register to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Identification
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Returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-

sion>"

<ID> "Rohde&Schwarz,<device type>,<part number>/serial num-
ber>,<firmware version>"

Example: Rohde&Schwarz,RTM,1316.1000k14/200153,1.30.0.25
Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query form writes a "1" into
the output buffer as soon as all preceding commands have been executed. This is
used for command synchronization.

*OPT?

Option identification query

Queries the options included in the instrument. For a list of all available options and
their description refer to the data sheet.

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

*PSC <Action>

Power on status clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.
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*RST

Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

Usage: Setting only

*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

Usage: Event

*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code

Return values: 
<ErrorCode> integer > 0 (in decimal format)

An error occurred.
(For details see the Service Manual supplied with the instru-
ment).
0
No errors occurred.
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Usage: Query only

*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

18.4 Acquisition and Setup

● Starting and Stopping Acquisition......................................................................... 413
● Time Base.............................................................................................................414
● Acquisition.............................................................................................................416
● Vertical.................................................................................................................. 421
● Waveform Data..................................................................................................... 427
● Probes...................................................................................................................431
● History and Segmented Memory (Option R&S RTM-K15)....................................437
● History Viewer.......................................................................................................438
● Timestamps...........................................................................................................442
● Export....................................................................................................................445

18.4.1 Starting and Stopping Acquisition

RUN............................................................................................................................. 413
RUNContinous...............................................................................................................413
SINGle..........................................................................................................................414
RUNSingle.................................................................................................................... 414
ACQuire:NSINgle:COUNt................................................................................................414
STOP........................................................................................................................... 414

RUN

Starts the continuous acquisition.

Usage: Event
Asynchronous command

RUNContinous

Same as RUN.

Usage: Event
Asynchronous command
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SINGle

Starts a defined number of acquisitions. The number of acquisitions is set with
ACQuire:NSINgle:COUNt.

Usage: Event
Asynchronous command

RUNSingle

Same as SINGle.

Usage: Event
Asynchronous command

ACQuire:NSINgle:COUNt <NSingleCount>

Sets the number of waveforms acquired with RUNSingle.

Parameters:
<NSingleCount> Number of waveforms

*RST: 1

STOP

Stops the running acquistion.

Usage: Event
Asynchronous command

18.4.2 Time Base

TIMebase:SCALe...........................................................................................................414
TIMebase:RATime?....................................................................................................... 415
TIMebase:ACQTime.......................................................................................................415
TIMebase:RANGe..........................................................................................................415
TIMebase:DIVisions?..................................................................................................... 415
TIMebase:POSition........................................................................................................ 416
TIMebase:REFerence.....................................................................................................416

TIMebase:SCALe <TimeScale>

Sets the horizontal scale for all channel and math waveforms.
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Parameters:
<TimeScale> Range: 1e-9  to  50; lower limits are possible if zoom or

FFT is enabled.
Increment: 1, 2, 5 progression, for example, 1 ms/div, 2 ms/div,

5 ms/div, 10, 20, 50...
*RST: 100e-6
Default unit: s/DIV

TIMebase:RATime?

Queries the real acquisition time used in the hardware. If FFT analysis is performed,
the value can differ from the adjusted acquisition time (TIMebase:ACQTime).

Return values: 
<HWAcqTime> Range: Depends on various settings

Default unit: s

Usage: Query only

TIMebase:ACQTime <AcquisitionTime>

Defines the time of one acquisition, that is the time across the 10 divisions of the dia-
gram: Timebase Scale*10.

Parameters:
<AcquisitionTime> *RST: 1e-3

Default unit: s

TIMebase:RANGe <AcquisitionTime>

Defines the time of one acquisition, that is the time across the 10 divisions of the dia-
gram: Timebase Scale*10.

Parameters:
<AcquisitionTime> Range and increment depend on time base and other settings

*RST: 1e-3
Default unit: s

TIMebase:DIVisions?

Queries the number of horizontal divisions on the screen.

Return values: 
<HorizDivCount> Range: 10  to  10

Increment: 0
*RST: 10
Default unit: DIV

Usage: Query only
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TIMebase:POSition <Offset>

Defines the trigger position (trigger offset) - the time interval between trigger point and
reference point to analize the signal some time before or after the trigger event.

See also: TIMebase:REFerence on page 416

Parameters:
<Offset> Range: Depends on time base setting

*RST: 0
Default unit: s

TIMebase:REFerence <ReferencePoint>

Sets the reference point of the time scale (Time Reference) in % of the display. The
reference point defines which part of the waveform is shown. If the trigger position is
zero, the trigger point matches the reference point.

See also: TIMebase:POSition on page 416

Parameters:
<ReferencePoint> Range: 10  to  90

Increment: 10
*RST: 50
Default unit: %

18.4.3 Acquisition

AUToscale.................................................................................................................... 416
ACQuire:MODE............................................................................................................. 417
ACQuire:INTerpolate......................................................................................................417
ACQuire:AVERage:COUNt............................................................................................. 417
ACQuire:AVERage:COMPlete?....................................................................................... 417
ACQuire:WRATe............................................................................................................418
ACQuire:POINts[:VALue]................................................................................................ 418
CHANnel<m>:TYPE.......................................................................................................419
CHANnel<m>:ARIThmetics.............................................................................................419
TIMebase:ROLL:ENABle................................................................................................ 420
ACQuire:FILTer:FREQuency...........................................................................................420
ACQuire:POINts:ARATe?............................................................................................... 420
ACQuire:SRATe?...........................................................................................................421

AUToscale

Performs an autoset process: analyzes the enabled channel signals, and obtains
appropriate horizontal, vertical, and trigger settings to display stable waveforms.

Usage: Event
Asynchronous command
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ACQuire:MODE <AcquisitionMode>

Selects the method of adding waveform points to the samples of the ADC in order to fill
the record length.

Parameters:
<AcquisitionMode> RTIMe | ETIMe

RTIMe
Real Time Mode: At slow time base settings the sampled points
of the input signal are used to build the waveform, no waveform
points are added. With fast time base settings, the sample rate
is higher than the ADC sample rate. Waveform samples are
added to the ADC samples with sin(x)/x interpolation.
ETIMe
Equivalent time: The waveform points are taken from several
acquisitions of a repetive signal at a different time in relation to
the trigger point.
*RST: RTIME

ACQuire:INTerpolate <Interpolation>

Defines the interpolation mode.

See also: "Interpolation" on page 32

Parameters:
<Interpolation> SINX

LINear
Linear interpolation between two adjacent sample points.
SINX
Interpolation by means of a sin(x)/x curve.
SMHD
Sample & Hold causes a histogram-like interpolation.
*RST: SINX

ACQuire:AVERage:COUNt <AverageCount>

Defines the number of waveforms used to calculate the average waveform. The higher
the number, the better the noise is reduced.

Parameters:
<AverageCount> Only numbers from the 2n progression are permitted (2, 4, 8, ...)

Range: 2  to  1024
*RST: 2

ACQuire:AVERage:COMPlete?

Returns the state of averaging.
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Return values: 
<AverageComplete> 0 | 1

0
The number of acquired waveforms is less than the number
required for average calculation. See ACQuire:AVERage:
COUNt.

1
The instrument acquired a sufficient number of waveforms to
determine the average.

Usage: Query only

ACQuire:WRATe <WaveformRate>

Defines the mode to set the sample rate (samples per second saved in the memory)
and the waveform acquisition rate (waveforms per second).

Parameters:
<WaveformRate> AUTO | MWAVeform | MSAMples | MANual

AUTO
To display the best waveform, the instrument selects the opti-
mum combination of waveform acquisition rate and sample rate
using the full memory depth (maximum record length).
MWAVeform
Maximum waveform rate: The instrument combines sample rate
and memory depth to acquire at maximum waveform acquisition
rate. In connection with persistence, the mode can display rare
signal anomalies.
MSAMples
Maximum sample rate: The instrument acquires the signal at
maximum sample rate and uses the full memory depth. The
result is a waveform with maximum number of waveform sam-
ples, high degree of accuracy, and low risk of aliasing.
MANual
The instrument acquires the signals at a sample rate that fills up
an user-defined record length. Set the record length using
ACQuire:POINts[:VALue].
MANual is only available if the History option R&S RTM-K15 is
installed.
*RST: AUTO

ACQuire:POINts[:VALue] <RecordLength>

The query returns the record length, the number of recorded waveform points in a seg-
ment.

If option R&S RTM-K15 is installed, and ACQuire:WRATe on page 418 is set to MAN-
ual, the command can set the record length of a segment.
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Parameters:
<RecordLength> Record length in Sa

CHANnel<m>:TYPE <DecimationMode>

Selects the method to reduce the data stream of the ADC to a stream of waveform
points with lower sample rate.

Suffix: 
<m>

.
1..4
The command affects all channels regardless of the indicated
channel number. The suffix can be omitted.

Parameters:
<DecimationMode> SAMPle | PDETect | HRESolution

SAMPle
Input data is acquired with a sample rate which is aligned to the
time base (horizontal scale) and the record length.
PDETect
Peak Detect: the minimum and the maximum of n samples in a
sample interval are recorded as waveform points.
HRESolution
High resolution: The average of n sample points is recorded as
waveform point.
*RST: SAMPle

CHANnel<m>:ARIThmetics <TrArithmetic>

Selects the method to build the resulting waveform from several consecutive acquisi-
tions of the signal.

Suffix: 
<m>

.
1..4
The command affects all channels regardless of the indicated
channel number. The suffix can be omitted.
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Parameters:
<TrArithmetic> OFF | ENVelope | AVERage | SMOoth | FILTer

OFF
The data of the current acquisition is recorded according to the
decimation settings.
ENVelope
Detects the minimum and maximum values in an sample interval
over a number of acquisitions.
AVERage
Calculates the average from the data of the current acquisition
and a number of acquisitions before. The number of used
acquisitions is set with ACQuire:AVERage:COUNt.

SMOoth
Calculates a mean value of several adjacent sample points.
Thus, smoothing is a moving average that uses the full data and
can be used for non-periodic signals. It works like a low-pass,
and increases the vertical resolution at the expense of band-
width reduction.
FILTer
Sets a low-pass filter with 3 db attenuation at a configurable limit
frequency set with ACQuire:FILTer:FREQuency. The filter
removes higher frequencies from the channel signals.
*RST: OFF

TIMebase:ROLL:ENABle <Roll>

Enables the roll mode.

Parameters:
<Roll> ON | OFF

*RST: OFF

ACQuire:FILTer:FREQuency <FilterFrequency>

Sets the limit frequency for CHANnel<m>:ARIThmetics is set to FILTer.

Parameters:
<FilterFrequency> Limit frequency with 3 dB attenuation

Default unit: Hz

ACQuire:POINts:ARATe?

Retrieves the sample rate of the ADC, that is the number of points that are sampled by
the ADC in one second.
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Return values: 
<AcquisitionRate> ADC sample rate

Range: 2.5E3  to  5E9
Increment: 1E3
*RST: 5E9
Default unit: Hz

Usage: Query only

ACQuire:SRATe?

Returns the sample rate, that is the number of recorded waveform samples per sec-
ond.

Return values: 
<SampleRate> Range: 2  to  1E11

Increment: depends on time base, waveform rate, number of
active channels

*RST: 1E7
Default unit: Sa/s

Usage: Query only

18.4.4 Vertical

CHANnel<m>:STATe..................................................................................................... 421
CHANnel<m>:AOFF.......................................................................................................422
CHANnel<m>:AON........................................................................................................ 422
CHANnel<m>:COUPling.................................................................................................422
CHANnel<m>:SCALe..................................................................................................... 423
CHANnel<m>:RANGe.................................................................................................... 423
CHANnel<m>:POSition...................................................................................................424
CHANnel<m>:OFFSet.................................................................................................... 424
CHANnel<m>:BANDwidth...............................................................................................424
CHANnel<m>:POLarity...................................................................................................425
CHANnel<m>:OVERload................................................................................................ 425
CHANnel<m>:SKEW......................................................................................................426
CHANnel<m>:THReshold............................................................................................... 426
CHANnel<m>:THReshold:HYSTeresis.............................................................................426
CHANnel<m>:LABel.......................................................................................................426
CHANnel<m>:LABel:STATe............................................................................................427
CHANnel<m>:ZOFFset[:VALue]...................................................................................... 427

CHANnel<m>:STATe <State>

Switches the channel signal on or off.
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Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<State> ON | OFF

CHANnel<m>:AOFF

Switches all analog channels off.

Suffix: 
<m>

.
The suffix is irrelevant.

Usage: Event

Firmware/Software: FW 05.7xx

CHANnel<m>:AON

Switches all analog channels on.

Suffix: 
<m>

.
The suffix is irrelevant.

Usage: Event

Firmware/Software: FW 05.7xx

CHANnel<m>:COUPling <Coupling>

Selects the connection of the indicated channel signal - coupling and termination.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.
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Parameters:
<Coupling> DC | DCLimit | AC | ACLimit | GND

DC
Direct connection with 50 Ω termination.
DCLimit
Direct connection with 1 MΩ termination.
AC
Connection through DC capacitor that removes the DC offset
voltage from the input signal.
ACLimit
Connection through DC capacitor with 1 MΩ termination. The
capacitor removes the DC offset voltage from the input signal.
GND
Connection to the ground. All channel data is set to a constant
ground value.
*RST: DCLimit

CHANnel<m>:SCALe <Scale>

Sets the vertical scale for the indicated channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Scale> Scale value, given in Volts per division.

Range: 1e-3  to  10 (without probe attenuation)
*RST: 5e-3
Default unit: V/DIV

CHANnel<m>:RANGe <Range>

Sets the voltage range across the 8 vertical divisions of the diagram. Use the com-
mand alternativly instead of CHANnel<m>:SCALe.

Suffix: 
<m>

.
1..4
Selects the input channel. The maximum channel number is
instrument-dependent.

Parameters:
<Range> Voltage range value

Range: 8e-3  to  80 (without probe attenuation)
*RST: 40e-3
Default unit: V
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CHANnel<m>:POSition <Position>

Sets the vertical position of the indicated channel and its horizontal axis in the window.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Position> Position value, given in divisions.

Range: -5  to  5
*RST: 0
Default unit: DIV

CHANnel<m>:OFFSet <Offset>

The offset voltage is subtracted to correct an offset-affected signal.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Offset> Offset value

Range: Values depend on vertical scale and probe attenua-
tion.

Increment: Value depends on vertical scale and probe attenua-
tion.

Default unit: V

CHANnel<m>:BANDwidth <BandwidthLimit>

Selects the bandwidth limit for the indicated channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.
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Parameters:
<BandwidthLimit> FULL | B400 | B200 | B20

FULL
Use full bandwidth.
Instruments with 1 GHz bandwidth: If termination is 50  Ω, the
full bandwidth of 1 GHz is available. If termination is 1 MΩ, the
full bandwith is limited to 500 MHz.
B400 | B200 | B20
Limit to 400MHz, 200 MHz, or 20 MHz, respectively.
Available values depend on the instrument's bandwidth.
*RST: FULL

CHANnel<m>:POLarity <Polarity>

Turns the inversion of the signal amplitude on or off. To invert means to reflect the volt-
age values of all signal components against the ground level. Inversion affects only the
display of the signal but not the trigger.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Polarity> NORMal | INVerted

*RST: NORM

CHANnel<m>:OVERload <Overload>

Retrieves the overload status of the specified channel from the status bit. When the
overload problem is solved, the command resets the status bit.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Overload> ON | OFF

Use OFF to reset the overload status bit.
*RST: OFF

Example: CHANnel2:OVERload?
Queries the overload status of channel 2.
CHANnel2:OVERload OFF
Resets the overload status bit.
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CHANnel<m>:SKEW <Skew>

Skew or deskew compensates delay differences between channels caused by the dif-
ferent length of cables, probes, and other sources. Correct deskew values are impor-
tant for accurate triggering.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Skew> Deskew value

Default unit: s

CHANnel<m>:THReshold <Threshold>

Threshold value for digitization of analog signals. If the signal value is higher than the
threshold, the signal state is high (1 or true for the boolean logic). Otherwise, the signal
state is considered low (0 or false) if the signal value is below the threshold.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Threshold> Default values are:

TTL: 1.4 V
ECL: -1.3 V
CMOS: 2.5 V
*RST: 1.4
Default unit: V

CHANnel<m>:THReshold:HYSTeresis <ThresholdHysteresis>

Defines the size of the hysteresis to avoid the change of signal states due to noise.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<ThresholdHysteresis>SMALl | MEDium | LARGe

*RST: SMAL

CHANnel<m>:LABel <Label>

Specifies a name for the selected channel.
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Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Label> String value

String with max. 8 characters, only ASCII characters can be
used

CHANnel<m>:LABel:STATe <State>

Shows or hides the channel name.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<State> ON | OFF

*RST: OFF

CHANnel<m>:ZOFFset[:VALue] <ZeroOffset>

Sets the zero offset.

Differences in DUT and oscilloscope ground levels may cause larger zero errors affect-
ing the waveform. If the DUT is ground-referenced, the "Zero Offset" corrects the zero
error and sets the probe to the zero level.

You can assess the zero error by measuring the mean value of a signal that should
return zero.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<ZeroOffset> *RST: 0

Default unit: V

18.4.5 Waveform Data

Consider also the following commands:
● FORMat[:DATA] on page 731
● CHANnel<m>:DATA:XINCrement? on page 742
● CHANnel<m>:DATA:XORigin? on page 742
● CHANnel<m>:DATA:YINCrement? on page 743
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● CHANnel<m>:DATA:YORigin? on page 743
● CHANnel<m>:DATA:YRESolution? on page 743
● CHANnel<m>:DATA:ENVelope:XINCrement? on page 742
● CHANnel<m>:DATA:ENVelope:XORigin? on page 742
● CHANnel<m>:DATA:ENVelope:YINCrement? on page 743
● CHANnel<m>:DATA:ENVelope:YORigin? on page 743
● CHANnel<m>:DATA:ENVelope:YRESolution? on page 743

CHANnel<m>:DATA?.....................................................................................................428
CHANnel<m>:DATA:HEADer?........................................................................................ 428
CHANnel<m>:DATA:ENVelope?..................................................................................... 429
CHANnel<m>:DATA:ENVelope:HEADer?.........................................................................429
CHANnel<m>:DATA:POINts........................................................................................... 430

CHANnel<m>:DATA?

Returns the data of the analog channel waveform for transmission from the instrument
to the controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

To set the range of samples to be returned, use CHANnel<m>:DATA:POINts.

For envelope waveforms, use the CHANnel<m>:DATA:ENVelope? command.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Data> List of values according to the format settings - the voltages of

recorded waveform samples.

Example: FORM ASC
CHAN1:DATA?
-0.125000,-0.123016,-0.123016,-0.123016,
-0.123016,-0.123016,...

Example: See Chapter 18.2.1, "Data Export", on page 405

Usage: Query only

CHANnel<m>:DATA:HEADer?

Returns information on the channel waveform. For envelope waveforms, use the
CHANnel<m>:DATA:ENVelope:HEADer? command.
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Table 18-1: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

CHANnel<m>:DATA:ENVelope?

Returns the data of the envelope. The envelope consists of two waveforms. The wave-
forms data can be used in MATLAB, for example.

Use this command only for envelope waveforms. For other channel waveforms use
CHANnel<m>:DATA?.

To set the export format, use FORMat[:DATA] on page 731.

To set the range of samples to be returned, use CHANnel<m>:DATA:POINts.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Data> List of values according to the format settings - the voltages of

the envelope points. The list contains two values for each sam-
ple interval.

Usage: Query only

CHANnel<m>:DATA:ENVelope:HEADer?

Returns information on the envelope waveform.

Use this command only for envelope waveforms. for all other channel waveforms use
CHANnel<m>:DATA:HEADer?.
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Table 18-2: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Number of samples 200000

4 Number of values per sample interval. For envelope
waveforms the value is 2.

2

Suffix: 
<m>

.
1..4

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

CHANnel<m>:DATA:POINts <Points>

As a setting, the command selects a range of samples that will be returned with
CHANnel<m>:DATA? and CHANnel<m>:DATA:ENVelope?. As a query, it returns the
number of returned samples for the selected range.

If ACQuire:WRATe is set to MSAMples (maximum sample rate), the memory usually
contains more data samples than the screen can display. In this case, you can decide
which data will be saved: samples stored in the memory or only the displayed samples.

Note: The sample range can only be changed in STOP mode. If the acquisition is run-
ning, DEF is always used automatically. If the acquisition has been stopped, data can
be read from the memory, and all settings are available.

Suffix: 
<m>

.
1..4
The command affects all channels, and the suffix is irrelevant.
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Setting parameters: 
<Points> DEFault | MAXimum | DMAXimum

Sets the range for data queries.
DEFault
Waveform points that are visible on the screen. At maximum
waveform rate, the instrument stores more samples than visible
on the screen, and DEF returns less values than acquired.
MAXimum
All waveform samples that are stored in the memory. Only avail-
able if acquisition is stopped.
DMAXimum
Display maximum: Waveform samples stored in the current
waveform record but only for the displayed time range. At maxi-
mum waveform rate, the instrument stores more samples than
visible on the screen, and DMAX returns more values than DEF.
Only available if acquisition is stopped.
*RST: DEFault

Return values: 
<Points> Number of data points in the selected range.

Default unit: Samples

Example: CHAN:DATA:POIN DEF
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 10416;10416
CHAN:DATA:POIN DMAX
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 124992;124992
CHAN:DATA:POIN MAX
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 4194302;4194302

Example: See Chapter 18.2.1.1, "Reading Waveform Data in Real For-
mat", on page 405

18.4.6 Probes

PROBe<m>:SETup:ATTenuation[:AUTO]?....................................................................... 432
PROBe<m>:SETup:ATTenuation:UNIT............................................................................ 432
PROBe<m>:SETup:ATTenuation:MANual........................................................................ 432
PROBe<m>:SETup:BANDwidth?.....................................................................................433
PROBe<m>:SETup:CAPacitance?...................................................................................433
PROBe<m>:SETup:DCOFfset?.......................................................................................433
PROBe<m>:SETup:IMPedance?.....................................................................................433
PROBe<m>:SETup:MODE ............................................................................................ 434
PROBe<m>:SETup:NAME?............................................................................................434
PROBe<m>:SETup:OFFSwitch....................................................................................... 434
PROBe<m>:SETup:TYPE?.............................................................................................435
PROBe<m>:SETup:UOFFset..........................................................................................435
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PROBe<m>:SETup:CMOFfset........................................................................................ 435
PROBe<m>:ID:BUILd?...................................................................................................436
PROBe<m>:ID:PARTnumber?........................................................................................ 436
PROBe<m>:ID:PRDate?.................................................................................................436
PROBe<m>:ID:SRNumber?............................................................................................437
PROBe<m>:ID:SWVersion?............................................................................................437

PROBe<m>:SETup:ATTenuation[:AUTO]?

Returns the attenuation of an automatically detected probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<ProbeAttenuation> Range: 0.001  to  1000

Usage: Query only

PROBe<m>:SETup:ATTenuation:UNIT <Unit>

Selects the unit that the probe can measure.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Unit> V | A

Firmware/Software: FW 03.700

PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>

Sets the attenuation or gain of the probe if the probe was not detected by the instru-
ment.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<ManualAttenuation> Range: 0.001  to  10000

*RST: 1

Firmware/Software: FW 03.700
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PROBe<m>:SETup:BANDwidth?

Queries the bandwidth of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Bandwidth> Range: 10e5  to  20e8

Increment: 10
Default unit: Hz

Usage: Query only

PROBe<m>:SETup:CAPacitance?

Queries the input capacity of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<InputCapacitance> Range: 0.1e-12  to  1.0e-9

Increment: 1.0e-12
Default unit: F

Usage: Query only

PROBe<m>:SETup:DCOFfset?

Retrieves the DC voltage that is measured by the integrated voltmeter of R&S active
probes. Switch the voltmeter on before, see PROBe<m>:SETup:OFFSwitch
on page 434.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Offset> Range: -1.0e26  to  1.0e-26

Increment: 1e-3
Default unit: V

Usage: Query only

PROBe<m>:SETup:IMPedance?

Queries the termination of the probe.
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Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Termination> 50OHm | 1MOHm | UNKNown

Usage: Query only

PROBe<m>:SETup:MODE <Mode>

Select the action that is started with the probe button.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Mode> RCONtinuous | RSINgle | AUToset | NOACtion

RCONtinuous
Run continuous: The acquisition is running as long as the probe
button is pressed.
RSINgle
Run single: starts one acquisition.
AUTOSET
Starts the autoset procedure.
NOACtion
Nothing is started on pressing the micro button.
*RST: RCONtinuous

PROBe<m>:SETup:NAME?

Queries the name of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Name> string

Usage: Query only

PROBe<m>:SETup:OFFSwitch <DCOffsetOnOff>

Switches the integrated voltmeter of an R&S active probe on or off.

The command is only available if an R&S active probe with R&S ProbeMeter is used.
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Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<DCOffsetOnOff> ON | OFF

*RST: OFF

PROBe<m>:SETup:TYPE?

Queries the type of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Type> NONE | ACTive | PASSive

NONE
not detected
ACTive
active probe
PASSive
passive probe

Usage: Query only

PROBe<m>:SETup:UOFFset <UserOffset>

Sets an additional probe offset.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<UserOffset> Range: Depends on the probe characteristics.

*RST: 0
Default unit: V

PROBe<m>:SETup:CMOFfset <CommonModeOffset>

Sets the common-mode offset. The setting is only available for differential probes.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.
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Parameters:
<CommonModeOffset>*RST: 0

Default unit: V

PROBe<m>:ID:BUILd?

Queries the build number of the probe software.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<BuildNumber> 32 bit number

Range: 0  to  4294967295
Increment: 1

Usage: Query only

PROBe<m>:ID:PARTnumber?

Queries the R&S part number of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<PartNumber> string

Returns the part number in a string.

Usage: Query only

PROBe<m>:ID:PRDate?

Queries the production date of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<ProductionDate> string

Returns the date in a string.

Usage: Query only
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PROBe<m>:ID:SRNumber?

Queries the serial number of the probe.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<SerialNumber> string

Usage: Query only

PROBe<m>:ID:SWVersion?

Queries the version of the probe firmware.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<SoftwareVersion> string

Returns the version number in a string.

Usage: Query only

18.4.7 History and Segmented Memory (Option R&S RTM-K15)

This section lists the commands of option R&S RTM-K15. The following commands are
also important:

● ACQuire:WRATe on page 418
● ACQuire:POINts[:VALue] on page 418

● Ultra Segmentation Settings................................................................................. 437

18.4.7.1 Ultra Segmentation Settings

ACQuire:COUNt?...........................................................................................................437
ACQuire:SEGMented:MAXimum..................................................................................... 438
ACQuire:NSINgle:MAXimum........................................................................................... 438
ACQuire:AVAilable?....................................................................................................... 438
ACQuire:SEGMented:STATe.......................................................................................... 438

ACQuire:COUNt?

Returns the maximum number of segments that can be captured with the current con-
figuration.
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Return values: 
<NoOfSegments> Number of available segments in the memory

Usage: Query only

ACQuire:SEGMented:MAXimum <MaxAcquisitions>
ACQuire:NSINgle:MAXimum <MaxAcquisitions>

Sets the maximum possible number of segments for a RUN Nx SINGLE acquisition.
Thus, all segments of the memory are captured.

Parameters:
<MaxAcquisitions> ON | OFF

ACQuire:AVAilable?

Returns the number of segments that are currently saved in the memory. This number
is available for history viewing.

Return values: 
<Acquisitions> Number of captured segments

Usage: Query only

ACQuire:SEGMented:STATe <State>

Enables the ultra segementation mode. The acquisitions are performed very fast with-
out processing and displaying the waveforms. When acquisition has been stopped, the
latest waveform is displayed, the older ones are stored in segments.

Parameters:
<State> ON | OFF

18.4.8 History Viewer

CALCulate:MATH<m>:HISTory:CURRent........................................................................ 439
BUS<b>:HISTory:CURRent............................................................................................ 439
DIGital<m>:HISTory:CURRent........................................................................................ 439
SPECtrum:HISTory:CURRent......................................................................................... 439
CHANnel<m>:HISTory:CURRent.....................................................................................439
CALCulate:MATH<m>:HISTory:PALL.............................................................................. 439
BUS<b>:HISTory:PALL.................................................................................................. 439
DIGital<m>:HISTory:PALL.............................................................................................. 439
SPECtrum:HISTory:PALL............................................................................................... 440
CHANnel<m>:HISTory:PALL...........................................................................................440
CALCulate:MATH<m>:HISTory:STARt.............................................................................440
BUS<b>:HISTory:STARt.................................................................................................440
DIGital<m>:HISTory:STARt.............................................................................................440
SPECtrum:HISTory:STARt..............................................................................................440
CHANnel<m>:HISTory:STARt......................................................................................... 440
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CALCulate:MATH<m>:HISTory:STOP..............................................................................440
BUS<b>:HISTory:STOP..................................................................................................440
DIGital<m>:HISTory:STOP............................................................................................. 440
SPECtrum:HISTory:STOP.............................................................................................. 440
CHANnel<m>:HISTory:STOP..........................................................................................440
CALCulate:MATH<m>:HISTory:PLAYer:SPEed................................................................ 441
BUS<b>:HISTory:PLAYer:SPEed.................................................................................... 441
DIGital<m>:HISTory:PLAYer:SPEed................................................................................ 441
SPECtrum:HISTory:PLAYer:SPEed................................................................................. 441
CHANnel<m>:HISTory:PLAYer:SPEed............................................................................ 441
CALCulate:MATH<m>:HISTory:REPLay.......................................................................... 441
BUS<b>:HISTory:REPLay.............................................................................................. 441
DIGital<m>:HISTory:REPLay.......................................................................................... 441
SPECtrum:HISTory:REPLay........................................................................................... 441
CHANnel<m>:HISTory:REPLay.......................................................................................441
CALCulate:MATH<m>:HISTory:PLAYer:STATe................................................................ 442
BUS<b>:HISTory:PLAYer:STATe.................................................................................... 442
DIGital<m>:HISTory:PLAYer:STATe................................................................................ 442
SPECtrum:HISTory:PLAYer:STATe................................................................................. 442
CHANnel<m>:HISTory:PLAYer:STATe............................................................................ 442

CALCulate:MATH<m>:HISTory:CURRent <CurrentAcquisition>
BUS<b>:HISTory:CURRent <CurrentAcquisition>
DIGital<m>:HISTory:CURRent <CurrentAcquisition>
SPECtrum:HISTory:CURRent <CurrentAcquisition>
CHANnel<m>:HISTory:CURRent <CurrentAcquisition>

Accesses a particular acquisition segment in the memory to display it. The query
returns the index of the segment that is shown.

Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.

Parameters:
<CurrentAcquisition> Segment index. There are two ways to enter the index.

Negative index count: the newest segment has the index "0",
older segments have a negative index: -(n-1), .... -1 , 0
Positive index count: the oldest segment has the index 1, and
the newest segment has the index n: 1, 2,..., n
where n is the number of acquired segments.

CALCulate:MATH<m>:HISTory:PALL <PlayAll>
BUS<b>:HISTory:PALL <PlayAll>
DIGital<m>:HISTory:PALL <PlayAll>
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SPECtrum:HISTory:PALL <PlayAll>
CHANnel<m>:HISTory:PALL <PlayAll>

Enables the replay of all acquired segments.

Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.

Parameters:
<PlayAll> ON | OFF

If set to OFF, define the range of segments to be shown using
CHANnel<m>:HISTory:STARt and CHANnel<m>:HISTory:
STOP
*RST: ON

CALCulate:MATH<m>:HISTory:STARt <StartAcquisition>
BUS<b>:HISTory:STARt <StartAcquisition>
DIGital<m>:HISTory:STARt <StartAcquisition>
SPECtrum:HISTory:STARt <StartAcquisition>
CHANnel<m>:HISTory:STARt <StartAcquisition>

Sets the index of the oldest segment to be displayed.

Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.

Parameters:
<StartAcquisition> Start index. You can enter a positive or negative index, see

CHANnel<m>:HISTory:CURRent.

CALCulate:MATH<m>:HISTory:STOP <StopAcquisition>
BUS<b>:HISTory:STOP <StopAcquisition>
DIGital<m>:HISTory:STOP <StopAcquisition>
SPECtrum:HISTory:STOP <StopAcquisition>
CHANnel<m>:HISTory:STOP <StopAcquisition>

Sets the index of the latest segment to be displayed.
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Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.

Parameters:
<StopAcquisition> Stop index. You can enter a positive or negative index, see

CHANnel<m>:HISTory:CURRent.

CALCulate:MATH<m>:HISTory:PLAYer:SPEed <PlayerSpeed>
BUS<b>:HISTory:PLAYer:SPEed <PlayerSpeed>
DIGital<m>:HISTory:PLAYer:SPEed <PlayerSpeed>
SPECtrum:HISTory:PLAYer:SPEed <PlayerSpeed>
CHANnel<m>:HISTory:PLAYer:SPEed <PlayerSpeed>

Sets the speed of the history replay.

Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.

Parameters:
<PlayerSpeed> SLOW | MEDium | FAST | AUTO

*RST: AUTO

CALCulate:MATH<m>:HISTory:REPLay <Replay>
BUS<b>:HISTory:REPLay <Replay>
DIGital<m>:HISTory:REPLay <Replay>
SPECtrum:HISTory:REPLay <Replay>
CHANnel<m>:HISTory:REPLay <Replay>

If set to ON, the replay of the selected history segments repeats automatically.

Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.
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Parameters:
<Replay> ON | OFF

*RST: OFF

CALCulate:MATH<m>:HISTory:PLAYer:STATe <PlayerState>
BUS<b>:HISTory:PLAYer:STATe <PlayerState>
DIGital<m>:HISTory:PLAYer:STATe <PlayerState>
SPECtrum:HISTory:PLAYer:STATe <PlayerState>
CHANnel<m>:HISTory:PLAYer:STATe <PlayerState>

Starts and stops the replay of the history segments.

Suffix: 
<m>

.
1..4
Selects the input channel or math waveform.
0..15
Selects the digital channel.

<b> 1..4
Selects the bus.

Parameters:
<PlayerState> RUN | STOP

*RST: STOP

18.4.9 Timestamps

You can query the timestamps of history segments in two ways:

● Query for the timestamps of all history segments using ...:HISTory:...:ALL
commands.

● Query for the timestamp of a specific segment using ...:HISTory:... com-
mands. Select the segment of interest using CHANnel<m>:HISTory:CURRent

The following commands use numeric suffixes:
● CHANnel<m>: Selects the analog input channel.
● MATH<m>: Selects the math waveform, range 1..4
● DIGital<m>: Selects the digital channel, range 0..15
● BUS<b>: Selects the bus, range 1..4

CALCulate:MATH<m>:HISTory:TSRelative?.....................................................................443
BUS<b>:HISTory:TSRelative?.........................................................................................443
DIGital<m>:HISTory:TSRelative?.....................................................................................443
SPECtrum:HISTory:TSRelative?......................................................................................443
CHANnel<m>:HISTory:TSRelative?.................................................................................443
CALCulate:MATH<m>:HISTory:TSRelative:ALL?.............................................................. 443
BUS<b>:HISTory:TSRelative:ALL?.................................................................................. 443
DIGital<m>:HISTory:TSRelative:ALL?..............................................................................443
SPECtrum:HISTory:TSRelative:ALL?...............................................................................443
CHANnel<m>:HISTory:TSRelative:ALL?.......................................................................... 443
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CALCulate:MATH<m>:HISTory:TSABsolute?................................................................... 444
BUS<b>:HISTory:TSABsolute?....................................................................................... 444
DIGital<m>:HISTory:TSABsolute?................................................................................... 444
SPECtrum:HISTory:TSABsolute?.................................................................................... 444
CHANnel<m>:HISTory:TSABsolute?................................................................................444
CALCulate:MATH<m>:HISTory:TSABsolute:ALL?.............................................................444
BUS<b>:HISTory:TSABsolute:ALL?.................................................................................444
DIGital<m>:HISTory:TSABsolute:ALL?.............................................................................444
SPECtrum:HISTory:TSABsolute:ALL?..............................................................................444
CHANnel<m>:HISTory:TSABsolute:ALL?......................................................................... 444
CALCulate:MATH<m>:HISTory:TSDate?..........................................................................444
BUS<b>:HISTory:TSDate?..............................................................................................444
DIGital<m>:HISTory:TSDate?......................................................................................... 444
SPECtrum:HISTory:TSDate?.......................................................................................... 445
CHANnel<m>:HISTory:TSDate?......................................................................................445
CALCulate:MATH<m>:HISTory:TSDate:ALL?...................................................................445
BUS<b>:HISTory:TSDate:ALL?.......................................................................................445
DIGital<m>:HISTory:TSDate:ALL?...................................................................................445
SPECtrum:HISTory:TSDate:ALL?....................................................................................445
CHANnel<m>:HISTory:TSDate:ALL?............................................................................... 445

CALCulate:MATH<m>:HISTory:TSRelative?
BUS<b>:HISTory:TSRelative?
DIGital<m>:HISTory:TSRelative?
SPECtrum:HISTory:TSRelative?
CHANnel<m>:HISTory:TSRelative?
Returns the time difference of the selected segment to the newest segment. To select
a segment, use CHANnel<m>:HISTory:CURRent.

Return values: 
<Time> Time to newest acquisition

Example: CHAN:HIST:CURR -5
CHAN:HIST:TSR?
--> -1.138757760000E-02
Returns the relative time of the sixth segment. The newest seg-
ment has index 0.

Usage: Query only

CALCulate:MATH<m>:HISTory:TSRelative:ALL?
BUS<b>:HISTory:TSRelative:ALL?
DIGital<m>:HISTory:TSRelative:ALL?
SPECtrum:HISTory:TSRelative:ALL?
CHANnel<m>:HISTory:TSRelative:ALL?
Returns the time differences to the newest acquisition of all history segments.
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Return values: 
<TimeToNewestAcq> List of Values

The list starts with the oldest segment, and the newest segment
is the last one.

Example: CHANnel2:HISTory:TSRelative:ALL?
--> -4.184565632000E-01,-4.094896352000E-01,-4.005227104000E-01,
-3.915557824000E-01, ...,-8.966924800000E-03,-0.000000000000E+00 

Usage: Query only

CALCulate:MATH<m>:HISTory:TSABsolute?
BUS<b>:HISTory:TSABsolute?
DIGital<m>:HISTory:TSABsolute?
SPECtrum:HISTory:TSABsolute?
CHANnel<m>:HISTory:TSABsolute?
Returns the absolute daytime of the selected acquisition (CHANnel<m>:HISTory:
CURRent).

Return values: 
<Hour>, <Minute>,
<Seconds>

Comma-separated list

Example: CHAN:HIST:CURR -1
CHAN:HIST:TSAB?
--> 16,24,3.302100000000E+01

Usage: Query only

CALCulate:MATH<m>:HISTory:TSABsolute:ALL?
BUS<b>:HISTory:TSABsolute:ALL?
DIGital<m>:HISTory:TSABsolute:ALL?
SPECtrum:HISTory:TSABsolute:ALL?
CHANnel<m>:HISTory:TSABsolute:ALL?
Returns the absolute daytimes of all history segments.

Return values: 
<Hour>,<Minute>,
<Second>

Comma-separated list of hour, minute, and second values.
The list starts with the oldest segment, and the newest segment
is the last one.

Example: CHANnel2:HISTory:TSABsolute:ALL?
--> 14,59,4.558154343680E+01,14,59,4.559051036480E+01, 
14,59,4.559947728960E+01,...

Usage: Query only

CALCulate:MATH<m>:HISTory:TSDate?
BUS<b>:HISTory:TSDate?
DIGital<m>:HISTory:TSDate?
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SPECtrum:HISTory:TSDate?
CHANnel<m>:HISTory:TSDate?
Returns the date of the selected acquisition (CHANnel<m>:HISTory:CURRent).

Return values: 
<Year>, <Month>,
<Day>

Comma-separated list

Example: CHAN:HIST:CURR -5
CHAN:HIST:TSD?
--> 2014,7,1

Usage: Query only

CALCulate:MATH<m>:HISTory:TSDate:ALL?
BUS<b>:HISTory:TSDate:ALL?
DIGital<m>:HISTory:TSDate:ALL?
SPECtrum:HISTory:TSDate:ALL?
CHANnel<m>:HISTory:TSDate:ALL?
Returns the dates of all history segments.

Return values: 
<Year>,<Month>,
<Day>

Comma-separated list of year, month, and day values.
The list starts with the oldest segment, and the newest segment
is the last one.

Example: CHANnel2:HISTory:TSDate:ALL?
--> 2014,11,26,2014,11,26,2014,11,26,2014,11,26,...

Usage: Query only

18.4.10 Export

EXPort:ATABle:NAME....................................................................................................445
EXPort:ATABle:SAVE.....................................................................................................446
SPECtrum:HISTory:EXPort:NAME...................................................................................446
SPECtrum:HISTory:EXPort:SAVE................................................................................... 446

EXPort:ATABle:NAME <ExportPath>

Defines the path and filename of the acqisition timestamps file. The file format is CSV.
If the file already exists, it will be overwritten.

Parameters:
<ExportPath> string

String parameter

Example: EXPort:ATABle:NAME "/USB_FRONT/EXPORT/TIMES"
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EXPort:ATABle:SAVE

Saves the acquisition timestamps table to the file that is defined by the EXPort:
ATABle:NAME command.

Example: EXPort:ATABle:SAVE

The file contains the following timestamp values:

"","Date","Time"
"Start of Acquisition","2014-11-24","14:35:59"
"Last Acquisition","2014-11-24","14:36:01"
"Acquisitions","150"

"Number","Relative Time","Time to previous",
"Date","Time"
"0","-0.000000000000000E+00","1.009638400000000E-02",
"2014-11-24","14:36:01","0.0000000000E+00"
"-1","-1.009638400000000E-02","2.000568800000000E-02",
"2014-11-24","14:36:00","9.8990361600E-01"
"-2","-3.010207200000000E-02","2.000216800000000E-02",
"2014-11-24","14:36:00","9.6989792800E-01"
"-3","-5.010424000000000E-02","2.001423200000000E-02",
"2014-11-24","14:36:00","9.4989576000E-01"
"-4","-7.011847200000000E-02","2.000044000000000E-02",
"2014-11-24","14:36:00","9.2988152800E-01"
"-5","-9.011891200000001E-02","9.917412000000000E-03",
"2014-11-24","14:36:00","9.0988108800E-01"
"-6","-1.000363240000000E-01","1.009686000000000E-02",
"2014-11-24","14:36:00","8.9996367600E-01".....

Usage: Event

SPECtrum:HISTory:EXPort:NAME <ExportPath>

Defines the path and filename of the spectrum analysis timestamps file. The file format
is CSV. If the file already exists, it will be overwritten.

Parameters:
<ExportPath> string

Example: SPECtrum:HISTory:EXPort:NAME "/USB_FRONT/EXPORT/TIMES"

SPECtrum:HISTory:EXPort:SAVE

Saves the spectrum analysis timestamps table to the file that is defined by the
SPECtrum:HISTory:EXPort:NAME command.

Usage: Event

Acquisition and Setup
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18.5 Trigger

● General A Trigger Settings....................................................................................447
● Edge Trigger......................................................................................................... 450
● Width Trigger.........................................................................................................451
● Video/TV Trigger...................................................................................................453
● Pattern Trigger...................................................................................................... 454
● Runt.......................................................................................................................457
● Rise Time / Fall Time Trigger................................................................................457
● B-Trigger............................................................................................................... 459

18.5.1 General A Trigger Settings

TRIGger:A:MODE.......................................................................................................... 447
TRIGger:A:LEVel<n>[:VALue]......................................................................................... 447
TRIGger:A:FINDlevel......................................................................................................448
TRIGger:A:SOURce....................................................................................................... 448
TRIGger:A:TYPE........................................................................................................... 448
TRIGger:EXTern:COUPling.............................................................................................449
TRIGger:EXTern:TERMination........................................................................................ 449
TRIGger:EXTern:OVERload............................................................................................449
TRIGger:A:HOLDoff:MODE.............................................................................................449
TRIGger:A:HOLDoff:TIME...............................................................................................449

TRIGger:A:MODE <TriggerMode>

Sets the trigger mode. The trigger mode determines the behaviour of the instrument if
no trigger occurs.

Parameters:
<TriggerMode> AUTO | NORMal

AUTO
The instrument triggers repeatedly after a time interval if the trig-
ger conditions are not fulfilled. If a real trigger occurs, it takes
precedence.
NORMal
The instrument acquires a waveform only if a trigger occurs.
*RST: AUTO

TRIGger:A:LEVel<n>[:VALue] <Level>

Sets the trigger treshold voltage for all A trigger types that require a trigger level.

Suffix: 
<n>

.
1..5
Selects the trigger input. 1...4 select the corresponding channel,
5 is the external trigger input. The number of channels depends
on the instrument.
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Parameters:
<Level> Range: Depends on vertical scale.

Default unit: V

TRIGger:A:FINDlevel

Sets the trigger level of the A-trigger event to 50% of the signal amplitude.

Usage: Event

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.

TRIGger:A:TYPE <Type>

Sets the trigger type for the A trigger.

Parameters:
<Type> EDGE | WIDTh | TV | BUS | LOGic | RISetime | RUNT

EDGE: edge trigger
WIDTh: width trigger
TV: video trigger
BUS: requires at least one protocol option (R&S RTM-K1 to K5)
See: Chapter 11, "Protocol Analysis", on page 192
LOGic: pattern trigger, logic trigger
RIStime: rise time trigger
RUNT: runt trigger
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TRIGger:EXTern:COUPling <ExternCoupling>

Sets the coupling for the external trigger input. The command is relevant if TRIGger:
B:SOURce is set to EXTernanalog.

Parameters:
<ExternCoupling> AC | DC

*RST: AC

TRIGger:EXTern:TERMination <ExternTermination>

Adjusts the input impedance of the external trigger input.

The command is only available for instruments with 1 GHz bandwidth.

Parameters:
<ExternTermination> ON | OFF

0 = 1 MΩ
1 = 50 Ω
*RST: OFF

TRIGger:EXTern:OVERload <ExternOverload>

Retrieves the overload status of the external trigger input from the status bit. When the
overload problem is solved, use the command to reset the status bit.

The command is only available for instruments with 1 GHz bandwidth.

Parameters:
<ExternOverload> ON | OFF

Use OFF to reset the overload status bit.
*RST: OFF

Example: TRIGger:EXTern:OVERload?
Queries the overload status of the external trigger input.
TRIGger:EXTern:OVERload OFF
Resets the overload status bit.

TRIGger:A:HOLDoff:MODE <HoldOffMode>

Enables or disables the holdoff time.

Parameters:
<HoldOffMode> TIME | OFF

*RST: Off

TRIGger:A:HOLDoff:TIME <HoldOffTime>

Defines the holdoff time. The next trigger occurs only after the holdoff time has passed.
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Parameters:
<HoldOffTime> Default unit: s

18.5.2 Edge Trigger

TRIGger:A:EDGE:SLOPe............................................................................................... 450
TRIGger:A:EDGE:COUPling........................................................................................... 450
TRIGger:A:EDGE:FILTer:LPASs..................................................................................... 450
TRIGger:A:EDGE:FILTer:NREJect...................................................................................451
TRIGger:A:HYSTeresis...................................................................................................451
TRIGger:A:LEVel<n>:HYSTeresis................................................................................... 451

TRIGger:A:EDGE:SLOPe <Slope>

Sets the slope for the edge trigger (A trigger).

Parameters:
<Slope> POSitive | NEGative | EITHer

POSitive
Rising edge, a positive voltage change
NEGative
Falling edge, a negative voltage change
EITHer
Rising as well as the falling edge
*RST: POSitive

TRIGger:A:EDGE:COUPling <Coupling>

Sets the coupling for the trigger source.

Parameters:
<Coupling> DC | AC | HF

DC
Direct Current coupling. The trigger signal remains unchanged.
AC
Alternating Current coupling. A 5 Hz high pass filter removes the
DC offset voltage from the trigger signal.
HF
High frequency coupling. A 15 kHz high-pass filter removes
lower frequencies from the trigger signal. Use this mode only
with very high frequency signals.
*RST: DC

TRIGger:A:EDGE:FILTer:LPASs <State>

Turns an additional 5 kHz low-pass filter in the trigger path on or off. This filter removes
higher frequencies and is available with AC and DC coupling.
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Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:A:EDGE:FILTer:NREJect <State>

Turns an additional 100 MHz low-pass filter in the trigger path on or off. This filter
removes higher frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:A:HYSTeresis <Hysteresis>

Sets a hysteresis range around the trigger level of the A trigger event. If the signal jit-
ters inside this range and crosses the trigger level thereby, no trigger event occurs.

Hysteresis is available for edge trigger.

Parameters:
<Hysteresis> AUTO | SMALl | MEDium | LARGE | MANual

MANual
Sets the hysteresis to a user-defined value, which is defined
using TRIGger:A:LEVel<n>:HYSTeresis.
The value is only available on instruments with 1 GHz band-
width.
*RST: AUTO

TRIGger:A:LEVel<n>:HYSTeresis <LevelHysteresis>

Sets the hysteresis value if TRIGger:A:HYSTeresis is set to MANual.

The command is only available on instruments with 1 GHz bandwidth.

Parameters:
<LevelHysteresis> Default unit: DIV

18.5.3 Width Trigger

TRIGger:A:WIDTh:POLarity............................................................................................ 451
TRIGger:A:WIDTh:RANGe..............................................................................................452
TRIGger:A:WIDTh:DELTa...............................................................................................452
TRIGger:A:WIDTh:WIDTh...............................................................................................452

TRIGger:A:WIDTh:POLarity <Polarity>

Sets the polarity of the pulse.
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Parameters:
<Polarity> POSitive | NEGative

POSitive
Positive going pulse, the width is defined from the rising to the
falling slopes.
NEGative
Negative going pulse, the width is defined from the falling to the
rising slopes.
*RST: POSitive

TRIGger:A:WIDTh:RANGe <RangeMode>

Defines how the measured pulse width is compared with the given limit(s).

Parameters:
<RangeMode> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide
Triggers on pulses inside or outside a range defined by time ±
delta. The time is specified with TRIGger:A:WIDTh:WIDTh,
the range around is defined with TRIGger:A:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with
TRIGger:A:WIDTh:WIDTh.

*RST: LONGer

TRIGger:A:WIDTh:DELTa <Delta>

Defines a range around the width value specified using TRIGger:A:WIDTh:WIDTh.

Parameters:
<Delta> Range ±Δt ("Variation" softkey)

Range: Depends on the defined pulse width
(TRIG:A:WIDTH:WITDH)

TRIGger:A:WIDTh:WIDTh <Time1>

For the ranges WITHin and OUTSide (defined using TRIGger:A:WIDTh:RANGe), the
<Time1> defines the center of a range which is defined by the limits ±<Delta> (set with
TRIGger:A:WIDTh:DELTa).

For the ranges SHORter and LONGer, the width defines the maximum and minimum
pulse width, respectively.
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Parameters:
<Time1> Center value, maximum value or minimum value depending on

the defined range type.
Range: 20E-9  to  6.87194685440
Increment: Depends on the <Time1> value
*RST: 20E-9

18.5.4 Video/TV Trigger

TRIGger:A:TV:STANdard................................................................................................453
TRIGger:A:TV:POLarity.................................................................................................. 453
TRIGger:A:TV:FIELd...................................................................................................... 453
TRIGger:A:TV:LINE........................................................................................................454

TRIGger:A:TV:STANdard <Standard>

Selects the color television standard.

Parameters:
<Standard> PAL | NTSC | SECam | PALM | I576 | P720 | P1080 | I1080

PALM = PAL-M
I576 = SDTV 576i (PAL and SECAM)
P720 | P1080 = HDTV 720/1080p (progressive scanning)
I1080 = HDTV 1080i (interlaced scanning)
*RST: PAL

TRIGger:A:TV:POLarity <Polarity>

Selects the polarity of the signal. Note that the sync pulse has the opposite polarity.
The edges of the sync pulses are used for triggering,

See also: "Signal" on page 65

Parameters:
<Polarity> POSitive | NEGative

POSitive
If the video modulation is positive, the sync pulses are negative.
NEGative
If the modulation is negative, sync pulses are positive.
*RST: NEGative

TRIGger:A:TV:FIELd <Field>

Sets the trigger on the beginning of the video signal fields, or on the beginning of video
signal lines.
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Parameters:
<Field> EVEN | ODD | ALL | LINE | ALINe

EVEN | ODD
Triggers only on the field start of even or odd fields. Only availa-
ble for interlaced scanning.
ALL
All fields, triggers on the frame start (progressive scanning) or
any field start (interlaced scanning).
LINE
Triggers on the beginning of a specified line in any field. The line
number is set with TRIGger:A:TV:LINE.

ALINe
Triggers on the beginning of all video signal lines.
*RST: ALL

TRIGger:A:TV:LINE <Line>

Sets an exact line number if TRIGger:A:TV:FIELd is set to LINE.

Parameters:
<Line> Range: 1  to  525 (NTSC, PAL-M); 625 (PAL, SECAM,

SDTV I-576); 750 (HDTV P720); 1125 (HDTV
I1080, HDTV P1080)

Increment: 1
*RST: 1

18.5.5 Pattern Trigger

● Pattern Definition...................................................................................................454
● Time Limitation......................................................................................................456

18.5.5.1 Pattern Definition

TRIGger:A:PATTern:SOURce......................................................................................... 455
TRIGger:A:PATTern:FUNCtion........................................................................................455
TRIGger:A:PATTern:CONDition.......................................................................................455
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TRIGger:A:PATTern:SOURce <SourceString>

Parameters:
<SourceString> string containing 0, 1, or X for each channel

1: high, the signal voltage is higher than the trigger level.
0: low, the signal voltage is lower than the trigger level.
X: Don't care. the channel does not affect the trigger.
Without MSO option, the pattern has 4 or 2 bits, depending on
the number of channels: <ch1><ch2>[<ch3><ch4>].
With MSO option, the pattern has 18 or 20 bits:
<ch1><ch2>[<ch3><ch4>]<d0><d1><d2>...<d15>.

Example: Without MSO option R&S RTM-B1:
TRIG:A:PATT:SOUR "1X10"
CH1, CH3, and NOT CH4 are logically combined with
TRIGger:A:PATTern:FUNCtion, CH2 does not matter (don't
care).

Example: With MSO option R&S RTM-B1:
TRIG:A:PATT:SOUR "XXXX111101010011XXXX"
Analog channels CH1 to CH4 do not matter (don't care). Digital
channels D0 to D15 are logically combined with TRIGger:A:
PATTern:FUNCtion.

TRIGger:A:PATTern:FUNCtion <Function>

Sets the logical combination of the trigger states of the channels.

Parameters:
<Function> AND | OR

AND
The required states of all channels must appear in the input sig-
nal at the same time.
OR
At least one of the channels must have the required state.
*RST: AND

TRIGger:A:PATTern:CONDition <ConditionString>

Sets the trigger point depending on the result of the logical combination of the channel
states.

Parameters:
<ConditionString> "TRUE" | "FALSE"

*RST: "TRUE"
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18.5.5.2 Time Limitation

TRIGger:A:PATTern:MODE............................................................................................ 456
TRIGger:A:PATTern:WIDTh:RANGe................................................................................456
TRIGger:A:PATTern:WIDTh[:WIDTh]............................................................................... 456
TRIGger:A:PATTern:WIDTh:DELTa.................................................................................457

TRIGger:A:PATTern:MODE <PatternMode>

Disables the time limitation or sets the time comparison mode.

Parameters:
<PatternMode> OFF | TIMeout | WIDTh

OFF
Disables the time limitation.
TIMeout
Defines how long at least the result of the state pattern condition
must be true or false.
WIDTh
Defines a time range for keeping up the true result of the pattern
condition. The range is defined using TRIGger:A:PATTern:
WIDTh:RANGe.

TRIGger:A:PATTern:WIDTh:RANGe <PatternRange>

Selects how the time limit of the pattern state is defined.

The time is specified using TRIGger:A:PATTern:WIDTh[:WIDTh] on page 456,
the range around is specified using TRIGger:A:PATTern:WIDTh:DELTa
on page 457.

Parameters:
<PatternRange> WITHin | OUTSide | SHORter | LONGer

WITHin
Triggers if the pattern state remains unchanged longer than
Time - Delta and shorter than Time + Delta.
OUTSide
Triggers if the pattern state remains unchanged either shorter
than Time - Delta or longer than Time + Delta.
SHORter | LONGer
Triggers if the pattern state changes before or after the specified
time.

TRIGger:A:PATTern:WIDTh[:WIDTh] <PatternWidth>

For the ranges WITHin and OUTSide, the <PatternWidth> defines the center of a
range which is defined by the limits ±<Delta>.
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For the ranges SHORter and LONGer, the pattern width defines the maximum and
minimum values, respectively.

Parameters:
<PatternWidth> Default unit: s

TRIGger:A:PATTern:WIDTh:DELTa <PatternDelta>

Defines a range around the pattern width value specified using TRIGger:A:
PATTern:WIDTh[:WIDTh].

Parameters:
<PatternDelta> Default unit: s

18.5.6 Runt

TRIGger:A:RUNT:POLarity <Polarity>

Sets the polarity of a pulse, that is the direction of the first pulse slope.

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

TRIGger:A:LEVel<n>:RUNT:LOWer <Level>
TRIGger:A:LEVel<n>:RUNT:UPPer <Level>

Set the lower and the upper voltage threshold, respectively. The instrument triggers if
the amplitude crosses the first threshold twice in succession without crossing the sec-
ond one.

The upper level corresponds to the trigger level (TRIGger:A:LEVel<n>[:VALue]
on page 447). The lower level corresponds to the threshold value of the trigger channel
(CHANnel<m>:THReshold on page 426).

Suffix: 
<n>

.
1..5
Indicates the trigger source:
1...4 = channel 1...4
5 = not available

Parameters:
<Level> Default unit: V

18.5.7 Rise Time / Fall Time Trigger

TRIGger:A:LEVel<n>:RISetime:LOWer............................................................................ 458
TRIGger:A:LEVel<n>:RISetime:UPPer.............................................................................458
TRIGger:A:RISetime:SLOPe........................................................................................... 458
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TRIGger:A:RISetime:RANGe.......................................................................................... 458
TRIGger:A:RISetime:TIME..............................................................................................459
TRIGger:A:RISetime:DELTa............................................................................................459

TRIGger:A:LEVel<n>:RISetime:LOWer <Level>
TRIGger:A:LEVel<n>:RISetime:UPPer <Level>

Set the lower and upper voltage threshold, respectively. When the signal crosses these
levels, the slew rate measurement starts or stops depending on the selected polarity.

The upper level corresponds to the trigger level (TRIGger:A:LEVel<n>[:VALue]
on page 447). The lower level corresponds to the threshold value of the trigger channel
(CHANnel<m>:THReshold on page 426).

Suffix: 
<n>

.
1..5
Indicates the trigger source:
1...4 = channel 1...4
5 = not available

Parameters:
<Level> Default unit: V

TRIGger:A:RISetime:SLOPe <Polarity>

Sets the edge of whic the transition time is to be analyzed:

Parameters:
<Polarity> POSitive | NEGative

POSitive: rise time trigger
NEGative: Fall time trigger
*RST: POS

TRIGger:A:RISetime:RANGe <Range>

Selects how the time limit of the rise or fall time is defined.

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer | SHORter
Triggers on transition times longer or shorter than the time
TRIGger:A:RISetime:TIME.

WITHin | OUTSide
Triggers on transition times inside or outside the time range
TIMe ± DELTa. Use TRIGger:A:RISetime:TIME and
TRIGger:A:RISetime:DELTa to set the time range.

*RST: LONG
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TRIGger:A:RISetime:TIME <RiseTime>

For the ranges LONGer and SHORter, the command defines the minimum and maxi-
mum transition times, respectively.

For the ranges WITHin and OUTSide, the command defines the center of a time range
which is defined using TRIGger:A:RISetime:DELTa.

See also: TRIGger:A:RISetime:RANGe
Parameters:
<RiseTime> Default unit: s

TRIGger:A:RISetime:DELTa <Variation>

Sets a time range around the time value defined using TRIGger:A:RISetime:TIME
if TRIGger:A:RISetime:RANGe is set to WITHin | OUTSide.

Parameters:
<Variation> Default unit: s

18.5.8 B-Trigger

TRIGger:B:ENABle.........................................................................................................459
TRIGger:B:SOURce....................................................................................................... 459
TRIGger:B:EDGE:SLOPe............................................................................................... 460
TRIGger:B:LEVel........................................................................................................... 460
TRIGger:B:FINDlevel......................................................................................................460
TRIGger:B:MODE.......................................................................................................... 460
TRIGger:B:DELay.......................................................................................................... 460
TRIGger:B:EVENt:COUNt...............................................................................................461
TRIGger:B:HYSTeresis...................................................................................................461
TRIGger:B:LEVel:HYSTeresis......................................................................................... 461

TRIGger:B:ENABle <State>

Activates or deactivates the second trigger. The instrument triggers if both trigger event
conditions (A and B) are fulfilled.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:B:SOURce <Source>

Selects one of the input channels as B-trigger source. Available channels depend on
the instrument type.
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Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

TRIGger:B:EDGE:SLOPe <Slope>

Sets the edge for the B-trigger.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POSitive

TRIGger:B:LEVel <Level>

Sets the trigger level for the B-trigger event.

Parameters:
<Level> *RST: 0

Default unit: V

TRIGger:B:FINDlevel

Sets the trigger level of the B-trigger event to 50% of the signal amplitude.

Usage: Event

TRIGger:B:MODE <Mode>

Defines the delay type of the B-trigger.

Parameters:
<Mode> DELay | EVENts

DELay
Time delay, set with TRIGger:B:DELay
EVENts
Event count delay, set with TRIGger:B:EVENt:COUNt
*RST: DELay

TRIGger:B:DELay <DelayTime>

Sets the time the instrument waits after an A-event until it recognizes B-events.

Before setting the dalay time, TRIGger:B:MODE must be set to DELAy.
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Parameters:
<DelayTime> Range: 20e-9  to  6,871946854

Increment: Depends on the <DelayTime> value. The longer the
<DelayTime>, the longer is the increment value.

*RST: 20e-9
Default unit: s

TRIGger:B:EVENt:COUNt <EventCnt>

Sets a number of B-trigger events that fulfill all B-trigger conditions but do not cause
the trigger. The oscilloscope triggers on the n-th event (the last of the specified number
of events).

Before setting the event number, TRIGger:B:MODE must be set to EVENts.

Parameters:
<EventCnt> Number of B-events

Range: 1  to  65535
Increment: 1
*RST: 1

TRIGger:B:HYSTeresis <Hysteresis>

Sets a hysteresis range around the trigger level of the B trigger event. If the signal jit-
ters inside this range and crosses the trigger level thereby, no trigger event occurs.

Parameters:
<Hysteresis> AUTO | SMALl | MEDium | LARGe | MANual

MANual
Sets the hysteresis to a user-defined value, which is defined
using TRIGger:B:LEVel:HYSTeresis.
The value is only available on instruments with 1 GHz band-
width.
*RST: AUTO

TRIGger:B:LEVel:HYSTeresis <HysteresisValue>

Sets the hysteresis value if TRIGger:B:HYSTeresis is set to MANual. The com-
mand is only available on instruments with 1 GHz bandwidth.

Parameters:
<HysteresisValue> Default unit: DIV
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18.6 Display

18.6.1 Basic Display Settings

This chapter describes commands that configure the screen display.

18.6.1.1 General Display Settings

DISPlay:DIALog:CLOSe................................................................................................. 462
DISPlay:DIALog:MESSage............................................................................................. 462
DISPlay:MODE..............................................................................................................462
DISPlay:PALette............................................................................................................ 463
DISPlay:DIALog:TRANsparency......................................................................................463

DISPlay:DIALog:CLOSe

Closes an open dialog box.

Usage: Event

DISPlay:DIALog:MESSage <MessageText>

Sends a message text to the instrument and displays it in a message box.

To close the message box, use DISPlay:DIALog:CLOSe.

Setting parameters: 
<MessageText> String

String that contains the message.

Example: DISP:DIAL:MESS 'My message'
DISP:DIAL:CLOS

Usage: Setting only

DISPlay:MODE <Mode>

Sets the diagram mode.

Parameters:
<Mode> YT | XY

YT
Default time diagram with a time axis in x-direction and the sig-
nal amplitudes displayed in y-direction.
XY
XY-diagram, combines the voltage levels of two waveforms in
one diagram.
*RST: YT
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DISPlay:PALette <Palette>

Sets the color and brightness of the displayed waveform samples depending on their
cumulative occurance.

Parameters:
<Palette> NORMal | INVerse | FCOLor | IFColor

NORMal
Values that occur frequently are brighter than rare values.
INVerse
Rare values are brighter than frequent values, inverse to the
NORMal brightness.
FColor
Rare values are displayed in blue, while more frequent values
are red and very frequent values are displayed in yellow or
white, with various colors inbetween.
IFColor
Inverses the FColor setting: rare values are yellow or white while
frequent values are blue.
*RST: NORMal

DISPlay:DIALog:TRANsparency <Transparency>

Sets the transparency of result boxes that overlay the waveforms, for example, boxes
with statistical results or digital voltmeter results.

Parameters:
<Transparency> Range: 0  to  100

Increment: 1
Default unit: %

18.6.1.2 XYZ-Setup

DISPlay:XY:XSOurce..................................................................................................... 463
DISPlay:XY:Y1Source.................................................................................................... 464
DISPlay:XY:Y2Source.................................................................................................... 464
DISPlay:XY:ZMODe....................................................................................................... 464
DISPlay:XY:ZTHReshold................................................................................................ 465
DISPlay:XY:ZSOurce..................................................................................................... 465

DISPlay:XY:XSOurce <Source>

Defines the source to be displayed in x direction in an XY-diagram, replacing the usual
time base.
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Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

DISPlay:XY:Y1Source <Source>

Defines the (first) source to be displayed in y direction in an XY-diagram.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH2

DISPlay:XY:Y2Source <Source>

Defines an optional second source to be displayed in y direction in an XY-diagram. The
command is only relevant for 4-channel R&S RTM instruments.

Parameters:
<Source> NONE | CH1 | CH2 | CH3 | CH4

*RST: NONE

DISPlay:XY:ZMODe <Mode>

Activates or deactivates the intensity control of the waveform via an additional signal
source and sets the intensity mode.

Parameters:
<Mode> ANALog | DIGital | OFF

ANALog
Modulated intensity; Intensity is modulated continuously accord-
ing to the selected Source Z.
DIGital
Intensity is determined by a threshold value defined with
DISPlay:XY:ZTHReshold. If the Z signal value is below the
selected threshold, the corresponding x/y point is not displayed.
If the Z signal value is above the threshold, the x/y point is dis-
played with the defined intensity level.
OFF
Intensity control is deactivated.
*RST: OFF
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DISPlay:XY:ZTHReshold <Zthreshold>

Defines the threshold for intensity with a two-state modulation, if DISPlay:XY:ZMODe
is set to DIGital.

Parameters:
<Zthreshold> Threshold for visibility on the screen

Range: -10  to  10
Increment: depends on the scaling of the channel that is

assigned to Z
*RST: 0
Default unit: V

DISPlay:XY:ZSOurce <Source>

Defines the source to be used to determine the intensity of the xy-waveform.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

18.6.1.3 Intensities

DISPlay:INTensity:WAVeform......................................................................................... 465
DISPlay:INTensity:BACKlight.......................................................................................... 465
DISPlay:INTensity:GRID.................................................................................................466
DISPlay:PERSistence:STATe..........................................................................................466
DISPlay:PERSistence:TIME............................................................................................466
DISPlay:PERSistence:INFinite.........................................................................................467
DISPlay:PERSistence:TIME:AUTO.................................................................................. 467
DISPlay:PERSistence:CLEar.......................................................................................... 467

DISPlay:INTensity:WAVeform <Intensity>

Defines the strength of the waveform line in the diagram.

Parameters:
<Intensity> Value in percent

Range: 0  to  100
Increment: 1
*RST: not available, *RST does not change the intensity
Default unit: %

DISPlay:INTensity:BACKlight <Intensity>

Defines the intensity of the background lighting of the display.
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Parameters:
<Intensity> Value in percent

Range: 10  to  100
Increment: 1
*RST: not available, *RST does not change the intensity
Default unit: %

DISPlay:INTensity:GRID <Intensity>

Defines the intensity of the grid on the screen.

Parameters:
<Intensity> Value in percent

Range: 0  to  100
Increment: 1
*RST: not available, *RST does not change the intensity
Default unit: %

DISPlay:PERSistence:STATe <State>

Defines whether the waveform persists on the screen or whether the screen is
refreshed continuously.

Parameters:
<State> ON | OFF

ON
The waveform persists for the time defined using DISPlay:
PERSistence:TIME.

OFF
The waveform does not persist on the screen. Only the currently
measured values are displayed at any time.
*RST: OFF

DISPlay:PERSistence:TIME <Time>

Persistence time if persistence is active (see DISPlay:PERSistence:STATe
on page 466).

Each new data point in the diagram area remains on the screen for the duration
defined here. To set infinite persistence, use DISPlay:PERSistence:INFinite.

Parameters:
<Time> Range: 50E-3  to  Infinite

Increment: minimum 50E-3 s, increasing increment with
increasing persistence time

*RST: 50E-3
Default unit: s
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DISPlay:PERSistence:INFinite <InfPersistence>

Sets the persistence time to infinite if DISPlay:PERSistence:STATe is ON. each
new data point remains on the screen infinitely until this setting is changed or the per-
sistence is cleared.

Parameters:
<InfPersistence> ON | OFF

*RST: OFF

DISPlay:PERSistence:TIME:AUTO <Auto>

The optimal persistence time is determined automatically by the instrument.

Parameters:
<Auto> ON | OFF

*RST: OFF

DISPlay:PERSistence:CLEar

Removes the displayed persistent waveform from the screen.

Usage: Event

18.6.1.4 Waveform, Auxilary Cursors and Grid Settings

DISPlay:STYLe..............................................................................................................467
DISPlay:GRID:STYLe.....................................................................................................467

DISPlay:STYLe <Style>

Defines how the waveform data is displayed

Parameters:
<Style> VECTors | DOTS

VECTors
Individual data points are connected by a line.
DOTS
Only the data points are displayed.
*RST: VECT

DISPlay:GRID:STYLe <Style>

Defines how the grid is displayed.
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Parameters:
<Style> LINes | RETicle | NONE

LINes
Displays the grid as horizontal and vertical lines.
RETicle
Displays crosshairs instead of a grid.
NONE
No grid is displayed.
*RST: LIN

18.6.1.5 Virtual Screen

DISPlay:VSCReen:ENABle.............................................................................................468
DISPlay:VSCReen:POSition............................................................................................468

DISPlay:VSCReen:ENABle <Enable>

Enables or disables the virtual screen. If enabled, the virtual screen has 20 divisions, 8
of them are displayed.

Parameters:
<Enable> ON | OFF

*RST: OFF

DISPlay:VSCReen:POSition <Position>

Selects the divisions to be displayed on the virtual screen. The virtual screen has 20
divisions, 8 of them are displayed.

Parameters:
<Position> Indicated the position of the middle visible division.

Range: -6 to 6. At -6, the lower 8 divisons are visible. 0 indi-
cates the center of the virtual screen, and the div-
ions -4 to 4 are visible.

18.6.2 Zoom

TIMebase:ZOOM:STATe................................................................................................ 468
TIMebase:ZOOM:SCALe................................................................................................ 469
TIMebase:ZOOM:TIME...................................................................................................469
TIMebase:ZOOM:POSition..............................................................................................469
ACQuire:SRATe:ZOOM?................................................................................................ 469

TIMebase:ZOOM:STATe <ZoomState>

Switches the zoom window on or off.
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Parameters:
<ZoomState> ON | OFF

*RST: OFF

TIMebase:ZOOM:SCALe <ZoomScale>

Defines the time base in the zoom diagram in seconds per division.

Parameters:
<ZoomScale> Range: Depends on various other settings

Default unit: s/DIV

TIMebase:ZOOM:TIME <Time>

Defines the offset of the trigger point to the reference point of the zoom diagram.

Parameters:
<Time> *RST: 0

Default unit: s

TIMebase:ZOOM:POSition <Position>

Defines the position of the zoom reference point (the reference point of the zoom win-
dow) in relation to the reference point of original time base.

Parameters:
<Position> Range: Depends on the zoom time base, nearly 0 to 100 %

for large zoom
*RST: 50
Default unit: %

ACQuire:SRATe:ZOOM?

Returns the sample rate of the zoom window.

Return values: 
<SampleRateZoom> Range: 2  to  1E11

Increment: 1E3
*RST: 1E7
Default unit: Sa/s

Usage: Query only
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18.6.3 Markers (Timestamps)

TSTamp:SET.................................................................................................................470
TSTamp:NEXT.............................................................................................................. 470
TSTamp:PREVious........................................................................................................ 470
TSTamp:CLEar..............................................................................................................470
TSTamp:ACLear............................................................................................................470

TSTamp:SET

Sets a new marker (timestamp) at the reference point of the display, unless an existing
marker is already set there. The reference point is set with TIMebase:REFerence.

Usage: Event

TSTamp:NEXT

Usage: Event

Moves the next marker (timestamp, to the right) to the reference point of the display or
zoom area.

TSTamp:PREVious

Moves the previous marker (timestamp, to the left) to the reference point of the display
or zoom area.

Usage: Event

TSTamp:CLEar

Deletes the marker (timestamp) at the reference point. The reference point is set with
TIMebase:REFerence.

Usage: Event

TSTamp:ACLear

Deletes all markers (timestamps).

Usage: Event

18.7 Reference Waveforms

For data queries and conversion, consider also the following commands:
● FORMat[:DATA] on page 731
● REFCurve<m>:DATA:XINCrement? on page 742
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● REFCurve<m>:DATA:XORigin? on page 742
● REFCurve<m>:DATA:YINCrement? on page 743
● REFCurve<m>:DATA:YORigin? on page 743
● REFCurve<m>:DATA:YRESolution? on page 743

REFCurve<m>:STATe....................................................................................................471
REFCurve<m>:SOURce.................................................................................................471
REFCurve<m>:SOURce:CATalog?..................................................................................472
REFCurve<m>:UPDate.................................................................................................. 472
REFCurve<m>:SAVE..................................................................................................... 472
REFCurve<m>:LOAD.....................................................................................................472
REFCurve<m>:LOAD:STATe..........................................................................................473
REFCurve<m>:HORizontal:SCALe.................................................................................. 473
REFCurve<m>:HORizontal:POSition................................................................................473
REFCurve<m>:VERTical:SCALe..................................................................................... 473
REFCurve<m>:VERTical:POSition...................................................................................474
REFCurve<m>:DATA?................................................................................................... 474
REFCurve<m>:DATA:HEADer?.......................................................................................474
REFCurve<m>:DATA:POINts?........................................................................................475

REFCurve<m>:STATe <State>

Displays or hides the selected reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<State> ON | OFF

*RST: OFF

REFCurve<m>:SOURce <Source>

Defines the source of the reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | RE1 | RE2 |

RE3 | RE4 | D70 | D158
Any active channel, math, or reference waveform. Available
channels depend on the instrument type.
If MSO option R&S RTM-B1 is installed, you can use also the
pods as reference source: D70 is the pod with digital channels
D0 to D7, and D158 is the pod with D8 to D15.
*RST: CH1
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REFCurve<m>:SOURce:CATalog?

Returns the source waveform - channel, math or reference waveform.

If MSO option R&S RTM-B1 is installed, the source can also be a pod: D70 is the pod
with digital channels D0 to D7, and D158 is the pod with D8 to D15.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Return values: 
<Catalog> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | RE1 | RE2 |

RE3 | RE4 | D70 | D158

Usage: Query only

REFCurve<m>:UPDate

Updates the selected reference by the waveform defined with REFCurve<m>:SOURce.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Usage: Event

REFCurve<m>:SAVE <FileName>

Stores the reference waveform the specified file.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Setting parameters: 
<FileName> String with path and file name

Usage: Setting only

REFCurve<m>:LOAD <FileName>

Loads the waveform data from the indicated reference file to the reference storage.

To load the instrument settings, use REFCurve<m>:LOAD:STATe.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Setting parameters: 
<FileName> String with path and file name

Usage: Setting only
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REFCurve<m>:LOAD:STATe

Loads the instrument settings in addition to the reference waveform data. The wave-
form data must be loaded before the settings, see REFCurve<m>:LOAD on page 472.

The settings are only available if the file was stored to the internal storage /INT/
REFERENCE and never written to an external storage (USB stick).

Suffix: 
<m>

.
1..4
Selects the reference waveform.

Usage: Event

REFCurve<m>:HORizontal:SCALe <Scale>

Changes the horizontal scale (timebase) of the reference waveform independent of the
channel waveform settings.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Scale> *RST: 100e-6

Default unit: s/DIV

REFCurve<m>:HORizontal:POSition <Position>

Changes the horizontal position of the reference waveform independent of the channel
waveform settings.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Position> *RST: 0

Default unit: s

REFCurve<m>:VERTical:SCALe <Scale>

Changes the vertical scale of the reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Scale> *RST: 1

Default unit: V/DIV
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REFCurve<m>:VERTical:POSition <Position>

Changes the vertical position of the reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Position> *RST: 0

Default unit: DIV

REFCurve<m>:DATA?

Returns the data of the reference waveform for transmission from the instrument to the
controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Return values: 
<Data> List of values according to the format settings.

Usage: Query only

REFCurve<m>:DATA:HEADer?

Returns information on the reference waveform.

Table 18-3: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only
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REFCurve<m>:DATA:POINts?

Returns the number of data samples that are returned with REFCurve<m>:DATA?.

Suffix: 
<m>

.
1..4
Selects the reference waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

18.8 Measurements

This chapter describes functions that configure or perform cursor and automatic mea-
surements.

● Cursor Measurements...........................................................................................475
● Quick Measurements............................................................................................ 484
● Automatic Measurements..................................................................................... 485
● Automatic Measurements - Statistics....................................................................490
● Reference Level....................................................................................................495

18.8.1 Cursor Measurements

CURSor<m>:AOFF........................................................................................................ 476
CURSor<m>:STATe.......................................................................................................476
CURSor<m>:SOURce.................................................................................................... 476
CURSor<m>:FUNCtion...................................................................................................477
CURSor<m>:TRACking[:STATe]..................................................................................... 479
CURSor<m>:X1Position................................................................................................. 479
CURSor<m>:X2Position................................................................................................. 479
CURSor<m>:X3Position................................................................................................. 479
CURSor<m>:Y1Position................................................................................................. 479
CURSor<m>:Y2Position................................................................................................. 479
CURSor<m>:Y3Position................................................................................................. 479
CURSor<m>:YCOupling................................................................................................. 480
CURSor<m>:XCOupling................................................................................................. 480
CURSor<m>:SWAVe..................................................................................................... 480
CURSor<m>:SSCReen.................................................................................................. 480
CURSor<m>:SPPeak..................................................................................................... 480
CURSor<m>:SNPeak.....................................................................................................480
CURSor<m>:TRACking:SCALe[:STATe].......................................................................... 481
CURSor<m>:RESult?.....................................................................................................481
CURSor<m>:XDELta:INVerse?....................................................................................... 481
CURSor<m>:XDELta[:VALue]?....................................................................................... 481
CURSor<m>:YDELta:SLOPe?.........................................................................................482
CURSor<m>:YDELta[:VALue]?....................................................................................... 482
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CURsor<m>:XRATio:UNIT..............................................................................................482
CURSor<m>:XRATio[:VALue]?....................................................................................... 483
CURSor<m>:YRATio:UNIT............................................................................................. 483
CURSor<m>:YRATio[:VALue]?....................................................................................... 483

CURSor<m>:AOFF

Switches the cursor off.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Usage: Event

CURSor<m>:STATe <State>

Activates or deactivates the cursor measurement.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<State> ON | OFF

*RST: OFF

CURSor<m>:SOURce <Source>

Defines the source of the cursor measurement.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.
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Parameters:
<Source> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 |

MA5 | RE1 | RE2 | RE3 | RE4 | XY1 | XY2 | D0..D15 | D70 |
D158 | SPECtrum | MINHold | MAXHold | AVERage
CH1 | CH2 | CH3 | CH4
Active channel waveform 1 to 4
MA1 | MA2 | MA3 | MA4 | MA5
Active math channels 1 to 5
RE1 | RE2 | RE3 | RE4
Active reference channels 1 to 4
XY1
Active XY-waveform
D0..D15
Active igital channels D0 to D15, available if MSO option
R&S RTM-B1 is installed. The following cursor measurements
are possible: time, ratio X, count, duty ratio, burst width. Availa-
ble sources depend on the selected measurement type.
D70 | D158
Active digital pods D0...D7 and D8...D15, available if MSO
option R&S RTM-B1 is installed. The following cursor measure-
ments are possible: V-marker.
SPECtrum | MINHold | MAXHold | AVERage
Available if option R&S RTM-K18 is installed. The measurement
source is a spectrum analysis waveform.
SPECtrum: normal spectrum waveform
MINHold: waveform of the minimum amplitude spectrum
MAXHold: waveform of the maximum amplitude spectrum
AVERage: avarage amplitude spectrum
*RST: CH1

CURSor<m>:FUNCtion <Type>

Defines the cursor measurement type.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Type> HORizontal | VERTical | PAIRed | HRATio | VRATio | PPCount |

NPCount | RECount | FECount | MEAN | RMS | RTIMe | FTIMe |
PEAK | UPEakvalue | LPEakvalue | BWIDth
*RST: VERT
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Value Description Queries for results

HORizontal Sets two horizontal cursor lines and measures the vol-
tages at the two cursor positions and the delta of the
two values.

CURSor<m>:Y1Position
CURSor<m>:Y2Position
CURSor<m>:YDELta[:VALue]?
CURSor<m>:YDELta:SLOPe?

VERTical Sets two vertical cursor lines and measures the time
from the trigger point to each cursor, the time between
the two cursors and the frequency calculated from that
time.

CURSor<m>:X1Position
CURSor<m>:X2Position
CURSor<m>:XDELta[:VALue]?
CURSor<m>:XDELta:INVerse?

PAIRed V-Marker

same as CURSor<m>:TRACking[:STATe]
CURSor<m>:Y1Position
CURSor<m>:Y2Position
CURSor<m>:XDELta[:VALue]?
CURSor<m>:YDELta[:VALue]?

HRATio Sets three horizontal cursor lines. Queries return the
ratio of the y-values (e.g. overshooting) between the
first and second cursors and the first and third cursors.

CURSor<m>:YRATio:UNIT
CURSor<m>:YRATio[:VALue]?
CURSor<m>:Y1Position
CURSor<m>:Y2Position
CURSor<m>:Y3Position

VRATio Sets three vertical cursor lines. Queries return the ratio
of the x-values (e.g. a duty cycle) between the first and
second cursors and the first and third cursors.

CURsor<m>:XRATio:UNIT
CURSor<m>:XDELta[:VALue]?
CURSor<m>:X1Position
CURSor<m>:X2Position
CURSor<m>:X3Position

PPCount

NPCount

RECount

FECount

Count positive pulses

Count negative pulses

Count rising edges

Count falling edges

Sets two vertical and one horizontal cursor line. The
time base is defined by the vertical cursors, the hori-
zontal cursor defines the threshold value.

CURSor<m>:RESult?

MEAN

RMS

Mean value

Root mean square

Values are measured between two vertical cursor
lines.

CURSor<m>:RESult?

RTIMe

FTIMe

Rise time, tr

Fall time, tf

Measures the rise or fall time of the first edge after the
first vertical cursor between the upper and lower refer-
ence levels. The reference level for rise and fall time
measurement is set with REFLevel:RELative:
MODE.

CURSor<m>:RESult?
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Value Description Queries for results

PEAK

UPEakvalue

LPEakvalue

Vpp, absolute difference between the two peak values

Vp+, upper peak value

Vp-, lower peak value

Values are measured between two vertical cursor
lines.

CURSor<m>:RESult?

BWIDth Burst width, the duration of a burst. Two vertical cur-
sors mark the beginning and the end of the burst. The
horizontal cursor sets the threshold value, and the
time between the first and the last edge of the burst is
returned.

CURSor<m>:RESult?

CURSor<m>:TRACking[:STATe] <State>

If set to ON, the V-Marker cursor measurement is enabled.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<State> ON | OFF

*RST: OFF

CURSor<m>:X1Position <Xposition1>
CURSor<m>:X2Position <Xposition2>
CURSor<m>:X3Position <Xposition3>

The commands specify the x-positions of vertical cursor lines on the time axis. The
third cursor is only used for Ratio X measurement.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Position> Range: Depends on horizontal settings.

CURSor<m>:Y1Position <Yposition1>
CURSor<m>:Y2Position <Yposition2>
CURSor<m>:Y3Position <Yposition3>

The commands specify the positions of horizontal cursor lines on the y-axis. The third
cursor is only used for Ratio Y measurements.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Position> Range: Depends on various other settings.
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CURSor<m>:YCOupling <Coupling>
CURSor<m>:XCOupling <Coupling>

If enabled, the cursors of a set are coupled so that the distance between the two
remains the same if one cursor is moved.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Coupling> ON | OFF

*RST: OFF

CURSor<m>:SWAVe

Autoset for cursor lines, sets the cursor lines to typical points of the waveform depend-
ing on the selected measurement type. For example, for voltage measurement, the
cursor lines are set to the upper and lower peaks of the waveform. For time measure-
ment, the cursor lines are set to the edges of two consecutive positive or two consecu-
tive negative pulses.

Usage: Event

Firmware/Software: FW 03.700

CURSor<m>:SSCReen

Resets the cursors to their initial positions. This is helpful if the cursors have disap-
peared from the display or need to be moved for a larger distance.

Usage: Event

Firmware/Software: FW 03.700

CURSor<m>:SPPeak

For FFT analysis only: sets the selected cursor to the previous (left) level peak.

Usage: Event

Firmware/Software: FW 03.700

CURSor<m>:SNPeak

For FFT analysis only: sets the selected cursor to the next (right) level peak.

Usage: Event

Firmware/Software: FW 03.700
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CURSor<m>:TRACking:SCALe[:STATe] <State>

Enables the adjustment of cursor lines if the vertical or horizontal scales are changed.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<State> ON | OFF

ON
Cursor lines keep their relative position to the waveform.
OFF
Cursor lines remain on their position on the display if the scaling
is changed.
*RST: OFF

CURSor<m>:RESult?

Returns the measurement result for count, mean, RMS, rise and fall time, peak mea-
surements, and burst width. Make sure to set CURSor<m>:FUNCtion correctly.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<Value> Measurement result

Usage: Query only

CURSor<m>:XDELta:INVerse?

Returns the inverse time difference between the two cursors (1/Δt).

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<DeltaInverse> Range: -100e24  to  100e24

Increment: 0.1
*RST: 0
Default unit: 1/s

Usage: Query only

CURSor<m>:XDELta[:VALue]?

Returns the time difference between the two cursors (Δt).
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Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<Delta> Range: -100e24  to  100e24

Increment: 0.1
*RST: 0
Default unit: s

Usage: Query only

CURSor<m>:YDELta:SLOPe?

Returns the inverse value of the voltage difference - the reciprocal of the vertical dis-
tance of two horizontal cursor lines: 1/ΔV.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<DeltyYslope> Inverse value

Usage: Query only

CURSor<m>:YDELta[:VALue]?

Queries the delta of the values in y-direction at the two cursors.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<DeltaY> Delta value in V

Usage: Query only

CURsor<m>:XRATio:UNIT <Unit>

Sets the unit for X Ratio measurements with CURSor<m>:XRATio[:VALue]?.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.
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Parameters:
<Unit> RATio | PCT | GRD | PI

RATio - floating value
PCT - percent
GRD - degree
PI - radian
*RST: RAT

CURSor<m>:XRATio[:VALue]?

Returns the ratio of the x-values (e.g. a duty cycle) between the first and second cur-
sors and the first and third cursors: (x2-x1)/(x3-x1).

Set the unit of the result with CURsor<m>:XRATio:UNIT.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

CURSor<m>:YRATio:UNIT <Unit>

Sets the unit for Y Ratio measurements with CURSor<m>:YRATio[:VALue]?
on page 483.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Unit> RATio | PCT

RATio - floating value
PCT - percent
*RST: RAT

CURSor<m>:YRATio[:VALue]?

Returns the ratio of the y-values (e.g. overshooting) between the first and second cur-
sors and the first and third cursors: (y2-y1)/(y3-y1).

For this measurement, set the cursor measurement type CURSor<m>:FUNCtion to
HRATio.

Set the unit of the result with CURSor<m>:YRATio:UNIT.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.
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Return values: 
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

18.8.2 Quick Measurements

MEASurement<m>:ALL[:STATe]..................................................................................... 484
MEASurement<m>:AON.................................................................................................484
MEASurement<m>:AOFF............................................................................................... 484
MEASurement<m>:ARESult?..........................................................................................484

MEASurement<m>:ALL[:STATe] <State>

Starts or stops the quick measurement and sets the status bit.

Parameters:
<State> ON | OFF

*RST: OFF

Firmware/Software: FW 03.800

MEASurement<m>:AON

Starts the quick measurement.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Usage: Event

MEASurement<m>:AOFF

Stops the quick measurement.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Usage: Event

MEASurement<m>:ARESult?

Returns the results of the quick measurement.

Suffix: 
<m>

.
1..4
Selects the measurement.
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Return values: 
<QuickMeasData> List of values

Quick measurement results are listed in the following order:
PEAK, UPE, LPE, RMS, MEAN, PER, FREQ, RTIM , FTIM

Usage: Query only

18.8.3 Automatic Measurements

MEASurement<m>[:ENABle]...........................................................................................485
MEASurement<m>:MAIN................................................................................................485
MEASurement<m>:SOURce........................................................................................... 487
MEASurement<m>:DELay:SLOPe...................................................................................489
MEASurement<m>:RESult[:ACTual]?.............................................................................. 489
MEASurement<m>:CATegory?....................................................................................... 489

MEASurement<m>[:ENABle] <State>

Activates or deactivates the selected measurement (1-4). Only the results of active
measurements are displayed in the result table.

Suffix: 
<m>

.
1..4
Selects the measurement.

Parameters:
<State> ON | OFF

*RST: OFF

MEASurement<m>:MAIN <MeasType>

Defines the measurement type to be performed on the selected source. To query the
results, use MEASurement<m>:RESult[:ACTual]?.

Suffix: 
<m>

.
1..4
Selects the measurement.
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Parameters:
<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue |

PPCount | NPCount | RECount | FECount | HIGH | LOW |
AMPLitude | MEAN | RMS | RTIMe | FTIMe | PDCYcle |
NDCYcle | PPWidth | NPWidth | CYCMean | CYCRms |
STDDev | CYCStddev | TFRequency | TPERiode | DELay |
PHASe | BWIDth | POVershoot | NOVershoot | TBFRequency |
TBPeriod
For a detailed description, see "Meas. Type" on page 115.
FREQuency
Frequency of the signal. The result is based on the length of the
left-most signal period within the displayed section of the wave-
form of the selected channel.
PERiod
Length of the left-most signal period within the displayed section
of the waveform of the selected channel.
PEAK
Peak-to-peak value within the displayed section of the waveform
of the selected channel.
UPEakvalue
Maximum value within the displayed section of the waveform of
the selected channel.
LPEakvalue
Minimum value within the displayed section of the waveform of
the selected channel.
PPCount
Counts positive pulses.
NPCount
Counts negative pulses.
RECount
Counts the number of rising edges.
FECount
Counts the number of falling edges.
HIGH
Mean value of the high level of a square wave.
LOW
Mean value of the low level of a square wave.
AMPLitude
Amplitude of a square wave.
MEAN
Mean value of the complete displayed waveform of the selected
channel.
RMS
RMS (Root Mean Square) value of the voltage of the complete
displayed waveform of the selected channel.
RTIMe | FTIMe
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Rise or falling time of the left-most rising edge within the dis-
played section of the waveform of the selected channel. The ref-
erence level for this mesurement is set with REFLevel:
RELative:MODE.

PDCycle | NDCycle
Measure the positive or negative duty cycle.
PPWidth | NPWidth
Measure the width of positive or negative pulses.
CYCMean
Mean value of the left-most signal period of the waveform of the
selected channel.
CYCRms
RMS (Root Mean Square) value of the voltage of the left-most
signal period of the waveform of the selected channel.
STDDev
Measures the standard deviation of the waveform.
CYCStddev
Measures the standard deviation of one cycle, usually of the
first, left-most signal period.
TFRequency | TPERiode
Measure the frequency of the trigger signal and the length of the
its periods (hardware counter).
DELay
Time difference between two edges of the same or different
waveforms. The waveforms are selected with
MEASurement<m>:SOURce, and the edges with
MEASurement<m>:DELay:SLOPe.

PHASe
Phase difference between two waveforms (time difference/
period * 360). The waveforms are selected with
MEASurement<m>:SOURce.

BWIDth
Burst width, the duration of one burst, measured from the first
edge to the last edge that cross the middle reference level.
POVershoot | NOVershoot
Positive and negative overshoot of a square wave.
TBFRequency | TBPeriod
Measures the frequency of the B-trigger signal and the length of
the B-trigger signal periods.
*RST: NONE (measurement is off)

MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>]

Selects one of the active signal, reference or math channels as the source(s) of the
selected measurement. Available sources depend on the selected measurement type.
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Suffix: 
<m>

.
1..4
Selects the measurement place.

Parameters:
<SignalSource> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 |

MA5 | RE1 | RE2 | RE3 | RE4 TRIGger | D0..D15 | D70 | D158 |
SPECtrum | MINHold | MAXHold | AVERage | CH1 | CH2 |
CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 | RE1 | RE2 | RE3 |
RE4 | TRIGger | D0..D15 | D70 | D158 | SPECtrum | MINHold |
MAXHold | AVERage
Waveform to be measured, required for all measurement types.
CH1 | CH2 | CH3 | CH4
Active signal channels 1 to 4
MA1 | MA2 | MA3 | MA4 | MA5
Active math channels 1 to 5
RE1 | RE2 | RE3 | RE4
Active reference channels 1 to 4
TRIGger
Only return value. TRIG is returned if the measurement type is a
trigger measurement: TFRequency | TPERiode measure the A-
trigger source, TBFRequency | TBPeriod measure the B-trigger
source.
D0..D15
Active digital channels, if MSO option R&S RTM-B1 is installed.
The following automatic measurements are possible: frequency,
period, edge and pulse counts, phase, delay, duty cycle, burst
width.
D70 | D158
Active digital channels D0...D7 (pod 1) and D8...D15 (pod 2),
available if MSO option R&S RTM-B1 is installed.
SPECtrum | MINHold | MAXHold | AVERage
Available if option R&S RTM-K18 is installed. The measurement
source is a spectrum analysis waveform.
SPECtrum: normal spectrum waveform
MINHold: waveform of the minimum amplitude spectrum
MAXHold: waveform of the maximum amplitude spectrum
AVERage: avarage amplitude spectrum
*RST: CH1

<ReferenceSource> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 |
MA5 | RE1 | RE2 | RE3 | RE4 | NONE | CH1 | CH2 | CH3 | CH4 |
MA1 | MA2 | MA3 | MA4 | MA5 | RE1 | RE2 | RE3 | RE4 |
D0..D15 | D70 | D158
Second waveform, reference source that is required for delay
and phase mesurements.
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MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope>

Sets the edges to be used for delay measurement. The associated waveforms are
defined with MEASurement<m>:SOURce
Parameters:
<SignalSlope> POSitive | NEGative

Slope of source 1 ( first waveform)
*RST: POS

<ReferenceSlope> POSitive | NEGative
Slope of source 2 (second waveform)
*RST: POS

Firmware/Software: 03.400

MEASurement<m>:RESult[:ACTual]? [<MeasType>]

Returns the result of the specified measurement type.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue |

PPCount | NPCount | RECount | FECount | HIGH | LOW |
AMPLitude | MEAN | RMS | RTIMe | FTIMe | PDCYcle |
NDCYcle | PPWidth | NPWidth | CYCMean | CYCRms |
STDDev | CYCStddev | TFRequency | TPERiode | DELay |
PHASe | BWIDth | POVershoot | NOVershoot | TBFRequency |
TBPeriod
Specifies the measurement type. See MEASurement<m>:MAIN
on page 485.

Return values: 
<Value> Measurement result. If no measurement was executed, no value

(NAN) is returned.

Usage: Query only

MEASurement<m>:CATegory?

Returns the measurement category. Currently, the instrument supports only yt-mea-
surements.

Suffix: 
<m>

.
1..4
Selects the measurement.
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Return values: 
<Category> AMPTime

AMPtime: yt-measurements
*RST: AMPT

Usage: Query only

18.8.4 Automatic Measurements - Statistics

You can query the statistical results using the MEAS:STAT commands. To export stat-
istical results to a csv file, use the EXP:MEAS:STAT commands. Note that export of
statistics is possible only remotely, but not in manual operation.

MEASurement<m>:STATistics[:ENABle].......................................................................... 490
MEASurement<m>:STATistics:WEIGht............................................................................ 490
MEASurement<m>:STATistics:RESet.............................................................................. 491
MEASurement<m>:RESult:AVG?.................................................................................... 491
MEASurement<m>:RESult:STDDev?...............................................................................491
MEASurement<m>:RESult:NPEak?.................................................................................492
MEASurement<m>:RESult:PPEak?................................................................................. 492
MEASurement<m>:RESult:WFMCount?...........................................................................492
MEASurement<m>:STATistics:VALue:ALL?..................................................................... 492
MEASurement<m>:STATistics:VALue<n>?...................................................................... 493
EXPort:MEASurement<m>:STATistics:NAME...................................................................493
EXPort:MEASurement<m>:STATistics:SAVE....................................................................493
EXPort:MEASurement<m>:STATistics:ALL:NAME............................................................ 494
EXPort:MEASurement<m>:STATistics:ALL:SAVE.............................................................494

MEASurement<m>:STATistics[:ENABle] <StatisticEnable>

Activates or deactivates the statistical evaluation for the selected measurement.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Parameters:
<StatisticEnable> ON | OFF

*RST: OFF

Firmware/Software: FW 03.700

MEASurement<m>:STATistics:WEIGht <AverageCount>

Sets the number of measured waveforms used for calculation of average and standard
deviation.

Suffix: 
<m>

.
1..4
Selects the measurement place.
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Parameters:
<AverageCount> Range: 2  to  1000

Increment: 1
*RST: 1000

Firmware/Software: FW 03.700

MEASurement<m>:STATistics:RESet

Deletes the statistical results for the selected measurement, and starts a new statistical
evaluation if the acquisition is running. The waveform count is set to 0 and all measure-
ment values are set to NAN.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Usage: Event

Firmware/Software: FW 03.700

MEASurement<m>:RESult:AVG? <AverageValue>

Returns the average value of the current mesurement series.

The number of waveforms used for calculation is defined with MEASurement<m>:
STATistics:WEIGht.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<AverageValue> Statistic value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:STDDev? <StandardDeviation>

Returns the statistical standard deviation of the current mesurement series.

The number of waveforms used for calculation is defined with MEASurement<m>:
STATistics:WEIGht.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<StandardDeviation> Statistic value

Usage: Query only
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Firmware/Software: FW 03.700

MEASurement<m>:RESult:NPEak? <NegativePeak>

Returns the minimum measurement value of the current measurement series.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<NegativePeak> Minimum measurement value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:PPEak? <PositivePeak>

Returns the maximum measurement value of the current measurement series.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<PositivePeak> Maximum measurement value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:WFMCount? <WaveformCount>

Returns the current number of measured waveforms.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<WaveformCount> Number of measured waveforms

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:STATistics:VALue:ALL?

Returns all values from the statistics buffer.

Note that valid buffered values can only be read if the acquisition is stopped. As long
as the acquisition is running, the buffer contents is changing and the buffered values
are not valid for reading.
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Suffix: 
<m>

.
1..4
Selects the measurement place.

Return values: 
<ValueList> Comma-separated list of statistical values

Usage: Query only

MEASurement<m>:STATistics:VALue<n>?

Returns one statistical value from the indicated buffer place.

Note that valid buffered values can only be read if the acquisition is stopped. As long
as the acquisition is running, the buffer contents is changing and the buffered values
are not valid for reading.

Suffix: 
<m>

.
1..4
Selects the measurement place.

<n> *
Buffer place. The buffer size is limited by MEASurement<m>:
STATistics:WEIGht.

Return values: 
<StatisticValue> Statistical value

Usage: Query only

EXPort:MEASurement<m>:STATistics:NAME

Defines the path and filename of the statistics file. The file format is CSV. If the file
already exists, it will be overwritten.

Suffix: 
<m>

.
1..15
1..4: measurement places of automatic measurements
5..15: measurement places for power measurements.

Parameters:
<FileName> String parameter

EXPort:MEASurement<m>:STATistics:SAVE

Saves statistical results of the indicated measurement place to the file that is defined
by the EXPort:MEASurement<m>:STATistics:NAME command.

Suffix: 
<m>

.
1..15
1..4: measurement places of automatic measurements
5..15: measurement places for power measurements.

Usage: Event
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See also: EXPort:MEASurement<m>:STATistics:ALL:SAVE on page 494.

EXPort:MEASurement<m>:STATistics:ALL:NAME

Defines the path and filename of the statistics file. The file format is CSV. If the file
already exists, it will be overwritten.

Suffix: 
<m>

.
1..4
The suffix is irrelevant, all results are returned.

Parameters:
<FileName> String parameter

EXPort:MEASurement<m>:STATistics:ALL:SAVE

Saves statistical results of all measurement places to the file that is defined by the
EXPort:MEASurement<m>:STATistics:ALL:NAME command.

Suffix: 
<m>

.
1..4
The suffix is irrelevant, all results are returned.
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Example: The file contains general information, statistical results, long
term statistics, and the individual values that are used to calcu-
late the statistics. The number of values is "Average No."
"Vendor","Rohde&Schwarz",
"Device/Mat.-No.","RTM2022 / 5710.0999k22",
"Serial No.","900001",
"Firmware Version","Beta 05.601",
"Date","2014-11-18 / 16:40:27",

"Meas. Place",,"1",,"2",,"3",,
"Type",,"Frequency",,"Mean Value",,"Frequency",,
"Source 1",,"CH1",,"CH1",,"CH2",,
"Source 2",,,,,,,,,,
"Wave count",,42,,39,,37,,
"Current",,4.998250e+05,,5.648727e-01,,4.998250e+05,,
"Average No.",,1.000000e+03,,1.000000e+03,,1.000000e+03,,
"Minimum",,4.997501e+05,,5.633875e-01,,4.997501e+05,,
"Maximum",,4.998250e+05,,5.650349e-01,,4.998250e+05,,
"Mean",,4.998179e+05,,5.642045e-01,,4.998169e+05,,
"σ-Deviation",,2.199706e+01,,3.677224e-04,,2.326898e+01,,
"Time of first value",,,,,,,,,,
"Time of last value",,,,,,,,,,
"Long term Minimum",,4.997501e+05,,5.633875e-01,,4.997501e+05,,
"Long term Maximum",,4.998250e+05,,5.650349e-01,,4.998250e+05,,
"Long term Mittelwert",,4.998179e+05,,5.642045e-01,,4.998169e+05,,
"Long term σ-Deviation",,2.226370e+01,,3.725295e-04,,2.358995e+01,,
"Long term start time",,,,,,,,,,
"Long term end Time",,,,,,,,,,

"Index","Time Offset","Value","Time Offset","Value",
"Time Offset","Value",
1,,4.998250e+05,,5.649274e-01,,4.997501e+05,
2,,4.998250e+05,,5.649072e-01,,4.998250e+05,
3,,4.998250e+05,,5.650349e-01,,4.998250e+05,
4,,4.998250e+05,,5.641094e-01,,4.998250e+05,
5,,4.998250e+05,,5.640586e-01,,4.998250e+05,
6,,4.997501e+05,,5.642784e-01,,4.998250e+05,
7,,4.998250e+05,,5.637245e-01,,4.998250e+05,...

Usage: Event

18.8.5 Reference Level

REFLevel:RELative:MODE............................................................................................. 496
REFLevel:RELative:LOWer.............................................................................................496
REFLevel:RELative:UPPer..............................................................................................496
REFLevel:RELative:MIDDle............................................................................................ 496
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REFLevel:RELative:MODE <RelativeMode>

Sets the lower and upper reference levels for rise and fall time mesurements (cursor
and automatic mesurements) as well as the middle reference level for phase and delay
measurements. The levels are defined as percentages of the high signal level. The set-
ting is valid for all measurement places.

Parameters:
<RelativeMode> TEN | TWENty | FIVE | USER

TEN: 10, 50 and 90%
TWENty: 20, 50 and 80%
FIVE: 5, 50 and 95 %
USER: levels are defined with REFLevel:RELative:LOWer,
REFLevel:RELative:MIDDle, and REFLevel:RELative:
UPPer.

*RST: TEN

Example: REFL:REL:MODE TWENty
MEAS2:MAIN RTIM
Sets the reference levels for all measurement places and meas-
ures the rise time between these levels for measurement place
2:
lower reference level = 20% of high signal level
upper reference level = 80% of high signal level

REFLevel:RELative:LOWer <LowerLevel>
REFLevel:RELative:UPPer <UpperLevel>

Set the lower and upper reference levels for rise and fall time mesurements (cursor
and automatic mesurements) if REFLevel:RELative:MODE is set to USER. The lev-
els are defined as percentages of the high signal level. They are valid for all measure-
ment places.

Parameters:
<LowerLevel> *RST: 10

Default unit: %

<UpperLevel> *RST: 90
Default unit: %

Firmware/Software: 03.400

REFLevel:RELative:MIDDle <MiddleLevel>

Set the middle reference level used for phase and delay measurements, if REFLevel:
RELative:MODE is set to USER. The level is defined as percentages of the high signal
level. The setting is valid for all measurement places.

Parameters:
<MiddleLevel> *RST: 50

Default unit: %
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Firmware/Software: 03.400

18.9 Mathematics

This chapter describes commands that configure or perform mathematical functions.

For data queries and conversion, consider also the following commands:
● FORMat[:DATA] on page 731
● CALCulate:MATH<m>:DATA:XINCrement? on page 742
● CALCulate:MATH<m>:DATA:XORigin? on page 742
● CALCulate:MATH<m>:DATA:YINCrement? on page 743
● CALCulate:MATH<m>:DATA:YORigin? on page 743
● CALCulate:MATH<m>:DATA:YRESolution? on page 743

CALCulate:MATH<m>:STATe......................................................................................... 497
CALCulate:MATH<m>:SCALe.........................................................................................497
CALCulate:MATH<m>:POSition...................................................................................... 498
CALCulate:MATH<m>[:EXPRession][:DEFine]..................................................................498
CALCulate:MATH<m>:DATA?.........................................................................................499
CALCulate:MATH<m>:DATA:HEADer?............................................................................499
CALCulate:MATH<m>:DATA:POINts?............................................................................. 500

CALCulate:MATH<m>:STATe <State>

Defines whether the selected mathematical channel is active or not. Only if a channel
is active it is visible on the screen and can be selected as a source for analysis and
display functions.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:SCALe <Scale>

Sets the vertical scale for the specified math waveform.

In FFT mode, the command sets the vertical scale of the FFT window. The scale unit
for FFT is set with CALCulate:MATH<m>:FFT:MAGNitude:SCALe.

Suffix: 
<m>

.
1..4
Selects the math waveform.
IN FFT mode, the numeric suffix is irrelevant.
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Parameters:
<Scale> Scale value

Range: -1.0E-24  to  5.0E+25
Increment: 1, 2, 5 progression, for example, 1mV/div, 2mV/div,

5mV/div, 10, 20, 50...
*RST: 1

CALCulate:MATH<m>:POSition <Position>

Sets the vertical position of the specified math waveform in the window.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Parameters:
<Position> Position value, given in divisions.

Range: -1.880E+02  to  2.120E+02
Increment: 0.01 in reset state
*RST: 2

CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplExpr>

Defines the equation to be calculated for the selected math waveform as a regular
expression.

For details on available operators, see "Operator" on page 123.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Parameters:
<RemComplExpr> String parameter, consisting of the mathematical operation and

the source(s) written in parenthesis.

Example: CALC:MATH<2>:EXPR:DEF "CH1+CH2"

Operation Expression string Comment

Addition "ADD(CH1,CH2)" "CH1+CH2" is also possible

Subtraction "SUB(CH1,CH2)" "CH1-CH2" is also possible

Multiplication "MUL(CH1,CH2)" "CH1*CH2" is also possible

Division "DIV(CH1,CH2)" "CH1/CH2" is also possible

Maximum amplitude "MAX(CH1,CH2)"  

Minimum amplitude "MIN(CH1,CH2)"  

Square "SQR(CH1)"  

Square Root "SQRT(CH1)"  
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Operation Expression string Comment

Absolute value "ABS(CH1)"  

Positive wave "POS(CH1)"  

Negative wave "NEG(CH1)"  

Reciprocal "REC(CH1)"  

Inverse "INV(CH1)"  

Common logarithm (basis 10) "LOG(CH1)"  

Natural logarithm (basis e) "LN(CH1)"  

Derivative "DERI(CH1)"  

Integral "INT(CH1)"  

IIR low pass "IIRL(CH1,1E6)" CH1 – Source waveform

1e6 – constant value, cut-off frequency
of the low or high pass

IIR high pass "IIRH(CH1,1E6)"

FFT "FFTMAG(CH1)" FFT function of the source waveform

See also: Chapter 18.10, "Spectrum
Analysis", on page 500

CALCulate:MATH<m>:DATA?

Returns the data of the math waveform points for transmission from the instrument to
the controlling computer. The waveforms data can be used in MATHLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Data> List of values according to the format settings - voltages, or

magnitudes of a spectrum.

Usage: Query only

CALCulate:MATH<m>:DATA:HEADer?

Returns information on the math waveform.

Table 18-4: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1
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Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

CALCulate:MATH<m>:DATA:POINts?

Returns the number of data samples that are returned with CALCulate:MATH<m>:
DATA?.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

18.10 Spectrum Analysis

● Basic FFT..............................................................................................................500
● Spectrum Waveform Data.....................................................................................505
● Spectrum Analysis (Option R&S RTM-K18)..........................................................508

18.10.1 Basic FFT

To define an FFT for a channel, use CALC:MATH<m>:EXPR "FFTMAG(CHx)". You
can define this expression for any of the math waveforms 1 to 5 (suffix <m>) and use
the other commands for the math waveform that is defined as FFT.

CALCulate:MATH<m>:FFT:WINDow:TYPE...................................................................... 501
CALCulate:MATH<m>:ARIThmetics.................................................................................501
CALCulate:MATH<m>:FFT:AVERage:COUNt...................................................................502
CALCulate:MATH<m>:FFT:AVERage:COMPlete?............................................................ 502
CALCulate:MATH<m>:FFT:MAGNitude:SCALe................................................................ 503
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJusted?........................................ 503
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO...............................................503
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio...............................................503
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue]............................................ 504
CALCulate:MATH<m>:FFT:CFRequency......................................................................... 504
CALCulate:MATH<m>:FFT:FULLspan............................................................................. 504
CALCulate:MATH<m>:FFT:SPAN................................................................................... 504
CALCulate:MATH<m>:FFT:STARt...................................................................................504
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CALCulate:MATH<m>:FFT:STOP................................................................................... 505
CALCulate:MATH<m>:FFT:TIME:RANGe........................................................................ 505
CALCulate:MATH<m>:FFT:TIME:POSition.......................................................................505
CALCulate:MATH<m>:FFT:SRATe?................................................................................ 505

CALCulate:MATH<m>:FFT:WINDow:TYPE <WindowType>

Window functions are multiplied with the input values and thus can improve the FFT
display.

Parameters:
<WindowType> RECTangular | HAMMing | HANNing | BLACkmanharris |

FLATtop
RECTangular
The rectangular window has high frequency accuracy with thin
spectral lines, but with increased noise. Use this function pref-
erably with pulse response tests where start and end values are
zero.
HAMMing
The Hamming window has higher noise level inside the spec-
trum than Hann or Blackman, but smaller than the rectangular
window. The width of the spectral lines is thinner than the other
bell-shaped functions. Use this window to measure amplitudes
of a periodical signal precisely.
HANNing
The noise level within the spectrum is reduced and the width of
the spectral lines enlarges. Use this window to measure ampli-
tudes of a periodical signal precisely.
BLACkmanharris
In the Blackman window the amplitudes can be measured very
precisely. However, determining the frequency is more difficult.
Use this window to measure amplitudes of a periodical signal
precisely.
FLATtop
The flat top window has low amplitude measurement errors but
a poor frequency resolution. Use this window for accurate sin-
gle-tone measurements and for measurement of amplitudes of
sinusoidal frequency components.
*RST: HANNing

CALCulate:MATH<m>:ARIThmetics <Arithmetics>

Defines the mode for FFT calculation and display.
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Parameters:
<Arithmetics> OFF | ENVelope | AVERage

OFF
The FFT is performed without any additional weighting or post-
processing of the acquired data. The new input data is acquired
and displayed, and thus overwrites the previously saved and dis-
played data.
ENVelope
In addition to the normal spectrum, the maximal oscillations are
saved separately and updated for each new spectrum. The max-
imum values are displayed together with the newly acquired val-
ues and form an envelope. This envelope indicates the range of
all FFT trace values that occurred.
AVERage
The average of several spectrums is calculated. The number of
spectrums used for the averaging is defined using the com-
mand. This mode is useful for noise rejection.
*RST: OFF

CALCulate:MATH<m>:FFT:AVERage:COUNt <AverageCount>

Defines the number of spectrums used for averaging if CALCulate:MATH<m>:
ARIThmetics is set to AVERage.

Parameters:
<AverageCount> Integer value

Range: 2  to  512
Increment: 2^n
*RST: 2

CALCulate:MATH<m>:FFT:AVERage:COMPlete?

Returns the state of spectrum averaging.

Return values: 
<AverageComplete> 0 | 1

0
The number of acquired waveforms is less than the number
required for spectrum average calculation. See CALCulate:
MATH<m>:FFT:AVERage:COUNt.

1
The instrument acquired a sufficient number of waveforms to
determine the average.

Usage: Query only

Spectrum Analysis



Remote Commands ReferenceR&S®RTM2000

503User Manual 1317.4726.02 ─ 10

CALCulate:MATH<m>:FFT:MAGNitude:SCALe <Magnitude Scale>

Defines the scaling unit of the y-axis.

To set the scale value, use CALCulate:MATH<m>:SCALe.

Parameters:
<Magnitude Scale> LINear | DBM | DBV

LINear
linear scaling; displays the RMS value of the voltage.
DBM
logarithmic scaling; related to 1 mW
DBV
logarithmic scaling; related to 1 Veff
*RST: DBM

Example: CALC:MATH:FFT:MAGN:SCAL DBM
CALC:MATH:SCAL 20
Set the Y-scale of the FFT window to 20 dBm.

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJusted?

Queries the effective resolution bandwidth.

Return values: 
<AdjResBW> Range: Depends on various other settings.

Default unit: Hz

Usage: Query only

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBWCoupling>

Couples the frequency span to the RBW.

Parameters:
<SpanRBWCoupling> ON | OFF

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio>

Defines the ratio of span (Hz) / resolution bandwidth (Hz). The span/RBW ratio is half
the number of points used for FFT which is defined with manual operation in the menu.

Parameters:
<SpanRBWRatio> Range: The value is changed in 2^n steps from 2^10 to

2^15 (1024, 2048,4096,8192,16384, 32768).

Example: CALC:MATH:FFT:BAND:RAT 32768
Sets the number of points to 65536.
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CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW>

Defines the resolution bandwidth - the minimum frequency step at which the individual
components of a spectrum can be distinguished

Parameters:
<ResolutionBW> Range: Depends on various other settings.

Default unit: Hz

CALCulate:MATH<m>:FFT:CFRequency <CenterFreq>

Defines the position of the displayed frequency domain, which is (Center - Span/2) to
(Center + Span/2). The width of the domain is defined using the CALCulate:
MATH<m>:FFT:SPAN command.

Parameters:
<CenterFreq> Range: Limited by the first data point (minimum) and last

data point (maximum) of the FFT curve.
Increment: Depends on the span and the number of data

points (span/RBW ratio).
Default unit: Hz

CALCulate:MATH<m>:FFT:FULLspan

Performs FFT calculation for the full frequency span.

Usage: Event

CALCulate:MATH<m>:FFT:SPAN <FreqSpan>

The span is specified in Hertz and defines the width of the displayed frequency range,
which is (Center - Span/2) to (Center + Span/2). The position of the span is defined
using the CALCulate:MATH<m>:FFT:CFRequency command.

Parameters:
<FreqSpan> Range: Depends on various other settings, mainly on time

base and span/RBW ratio.
Increment: Only 1 | 2 | 5 in first digit
Default unit: Hz

CALCulate:MATH<m>:FFT:STARt <StartFreq>

Defines the start frequency of the displayed frequency domain at the left display edge:
Center - Span/2

You can set start and stop frequency instead of defining a center frequency and span.

Parameters:
<StartFreq> Range: Depends on various other settings, mainly on time

base, span/RBW ratio, and center frequency.
Default unit: Hz
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CALCulate:MATH<m>:FFT:STOP <StopFreq>

Defines the stop frequency of the displayed frequency domain at the right display
edge: Center + Span/2

You can set start and stop frequency instead of defining a center frequency and span.

Parameters:
<StopFreq> Range: Depends on various other settings, mainly on time

base, span/RBW ratio, and center frequency.
Default unit: Hz

CALCulate:MATH<m>:FFT:TIME:RANGe <WindowWidth>

Defines the width of the time base extract from the Y(t)-window for which the FFT is
calculated.

Parameters:
<WindowWidth> Range: depends on the time base

Default unit: s

Firmware/Software: FW 03.800

CALCulate:MATH<m>:FFT:TIME:POSition <WindowPosition>

Defines the position of the time base extract in the Y(t)-window for which the FFT is
calculated.

Parameters:
<WindowPosition> Range: depends on the time base and the width of the FFT

time base extract
Default unit: s

Firmware/Software: FW 03.800

CALCulate:MATH<m>:FFT:SRATe?

Returns the sample rate of data used in an FFT analysis.

Return values: 
<SampleRate> Default unit: Sa/s

Usage: Query only

18.10.2 Spectrum Waveform Data

Suffix <m>: Use the math waveform number for which you have set up FFT.

In addition to the commands described below, consider also the following commands:
● FORMat[:DATA] on page 731
● CALCulate:MATH<m>:DATA:XINCrement? on page 742
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● CALCulate:MATH<m>:DATA:XORigin? on page 742
● CALCulate:MATH<m>:DATA:YINCrement? on page 743
● CALCulate:MATH<m>:DATA:YORigin? on page 743
● CALCulate:MATH<m>:DATA:YRESolution? on page 743
● CALCulate:MATH<m>:DATA:ENVelope:XINCrement? on page 742
● CALCulate:MATH<m>:DATA:ENVelope:XORigin? on page 742
● CALCulate:MATH<m>:DATA:ENVelope:YINCrement? on page 743
● CALCulate:MATH<m>:DATA:ENVelope:YORigin? on page 743
● CALCulate:MATH<m>:DATA:ENVelope:YRESolution? on page 743

CALCulate:MATH<m>:DATA?

Returns the data of the math waveform points for transmission from the instrument to
the controlling computer. The waveforms data can be used in MATHLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Data> List of values according to the format settings - voltages, or

magnitudes of a spectrum.

Usage: Query only

CALCulate:MATH<m>:DATA:HEADer?

Returns information on the math waveform.

Table 18-5: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only
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CALCulate:MATH<m>:DATA:POINts?

Returns the number of data samples that are returned with CALCulate:MATH<m>:
DATA?.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope?

Returns the data of FFT envelope waveforms (CALCulate:MATH<m>:ARIThmetics
is set to ENV). The envelope consists of two waveforms. The data of the two wave-
forms is written into one data stream in interleaved order.

Use this command only for envelope waveforms. For other FFT and math waveforms,
use CALCulate:MATH<m>:DATA? on page 499.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Return values: 
<Data> List of values according to the format settings - the voltages of

the envelope points. The list contains two values for each sam-
ple interval.

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:HEADer?

Returns information on the envelope waveform.

Use this command only for envelope waveforms. For all other FFT waveforms, use
CALCulate:MATH<m>:DATA:HEADer?.

Table 18-6: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Number of samples 200000

4 Number of values per sample interval. For envelope
waveforms the value is 2.

2
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Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Return values: 
<Header> Comma-separated value list, string data

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:POINts?

Returns the number of data samples that are returned with CALCulate:MATH<m>:
DATA:ENVelope?.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

18.10.3 Spectrum Analysis (Option R&S RTM-K18)

● General Settings................................................................................................... 508
● Spectogram Settings.............................................................................................510
● Marker Settings.....................................................................................................511
● Frequency Domain Settings..................................................................................517
● Time Domain Settings...........................................................................................519
● Waveform Settings................................................................................................519
● Diagram Display Settings......................................................................................522

18.10.3.1 General Settings

SPECtrum[:STATe]........................................................................................................ 508
SPECtrum:SOURce....................................................................................................... 509
SPECtrum:FREQuency:AVERage:COMPlete?..................................................................509
SPECtrum:FREQuency:AVERage:COUNt........................................................................509
SPECtrum:FREQuency:MAGNitude:SCALe......................................................................509
SPECtrum:FREQuency:POSition.....................................................................................509
SPECtrum:FREQuency:RESet........................................................................................ 509
SPECtrum:FREQuency:SCALe....................................................................................... 510
SPECtrum:FREQuency:WINDow:TYPE........................................................................... 510

SPECtrum[:STATe]

Switches on the spectrum analysis.
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Parameters:
<State> ON | OFF

SPECtrum:SOURce

Selects the source for the spectrum analysis diagrams.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

SPECtrum:FREQuency:AVERage:COMPlete?

Returns the state of spectrum averaging.

Parameters:
<AverageComplete>

Usage: Query only

SPECtrum:FREQuency:AVERage:COUNt <AverageCount>

Defines the number of spectrums used for averaging.

Parameters:
<AverageCount>

SPECtrum:FREQuency:MAGNitude:SCALe <MagnitudeScale>

Defines the scaling unit of the y-axis.

Parameters:
<MagnitudeScale> LINear | DBM | DBV

LINear
linear scaling; displays the RMS value of the voltage.
DBM
logarithmic scaling; related to 1 mW
DBV
logarithmic scaling; related to 1 Veff

SPECtrum:FREQuency:POSition

Defines the position of the spectrum.

Parameters:
<Position>

SPECtrum:FREQuency:RESet

Resets the Min, Max and Average waveforms to the current waveform.
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Usage: Event

SPECtrum:FREQuency:SCALe

Sets the scaling of the spectrum analysis waveform.

Parameters:
<Scale>

SPECtrum:FREQuency:WINDow:TYPE

Window functions are multiplied with the input values and thus can improve the spec-
trum analysis display.

Parameters:
<WindowFunction> RECTangular | HAMMing | HANNing | BLACkmanharris |

FLATtop
RECTangular
The rectangular window has high frequency accuracy with thin
spectral lines, but with increased noise. Use this function pref-
erably with pulse response tests where start and end values are
zero.
HAMMing
The Hamming window has higher noise level inside the spec-
trum than Hann or Blackman, but smaller than the rectangular
window. The width of the spectral lines is thinner than the other
bell-shaped functions. Use this window to measure amplitudes
of a periodical signal precisely.
HANNing
The noise level within the spectrum is reduced and the width of
the spectral lines enlarges. Use this window to measure ampli-
tudes of a periodical signal precisely.
BLACkmanharris
In the Blackman window the amplitudes can be measured very
precisely. However, determining the frequency is more difficult.
Use this window to measure amplitudes of a periodical signal
precisely.
FLATtop
The flat top window has low amplitude measurement errors but
a poor frequency resolution. Use this window for accurate sin-
gle-tone measurements and for measurement of amplitudes of
sinusoidal frequency components.

18.10.3.2 Spectogram Settings

SPECtrum:SPECtrogram:RESet......................................................................................511
SPECtrum:SPECtrogram:SCALe.....................................................................................511
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SPECtrum:SPECtrogram:RESet

Resets the current spectogram and starts a new recording of information.

Usage: Event

SPECtrum:SPECtrogram:SCALe <LinesPerAcquisition>

Defines a zoom factor for the spectogram.

Parameters:
<LinesPerAcquisition>Range: 1  to  20

Increment: 1
*RST: 1

18.10.3.3 Marker Settings

● Marker General Settings....................................................................................... 511
● Marker Setup Settings...........................................................................................512
● Reference Marker Settings................................................................................... 513
● Marker Table.........................................................................................................514

Marker General Settings

SPECtrum:MARKer:DISPlay........................................................................................... 511
SPECtrum:MARKer:SOURce.......................................................................................... 511
SPECtrum:MARKer[:ENABle]..........................................................................................512

SPECtrum:MARKer:DISPlay <MarkerDisplay>

Enables the display of markers on the waveform diagram.

Parameters:
<MarkerDisplay> OFF | INDex | RESult

OFF
No marker display
INDex
Markers are shown with index numbers of the peaks.
RESult
Markers are shown with result values of the peaks.
*RST: OFF

SPECtrum:MARKer:SOURce

Sets the source for the marker search function.

Parameters:
<Source> SPECtrum | MINHold | MAXHold | AVERage

*RST: SPEC
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SPECtrum:MARKer[:ENABle]

Enables the usage of markers.

Parameters:
<MarkerEnable> ON | OFF

Marker Setup Settings

SPECtrum:MARKer:SETup:DISTance..............................................................................512
SPECtrum:MARKer:SETup:EXCursion.............................................................................512
SPECtrum:MARKer:SETup:MLEVel.................................................................................512
SPECtrum:MARKer:SETup:MMODe................................................................................ 512
SPECtrum:MARKer:SETup:MWIDth................................................................................ 513

SPECtrum:MARKer:SETup:DISTance

Defines a distance between two subsequent peaks that has to be kept, for the peak to
be detected.

Parameters:
<Distance>

SPECtrum:MARKer:SETup:EXCursion

Defines a level deifference between two subsequent peaks that has to be kept, for the
peak to be detected.

Parameters:
<Excursion>

SPECtrum:MARKer:SETup:MLEVel

Sets the minimum level for marker peak detection.

Parameters:
<MinimumLevel>

SPECtrum:MARKer:SETup:MMODe

Sets the mode for marker detection.

Parameters:
<MarkerMode> LONLy | ADVanced

LONLy
Level only detects a peak when a certain minimum level is
reached. You can define the minimum level with SPECtrum:
MARKer:SETup:MLEVel.

ADVanced
Enables a more precise advanced peak definition.
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SPECtrum:MARKer:SETup:MWIDth

Sets the maximum width, that a peak can have for it to be detected.

Parameters:
<MaximumWidth>

Reference Marker Settings

SPECtrum:MARKer:REFerence:SETup:FREQuency......................................................... 513
SPECtrum:MARKer:REFerence:SETup:INDex..................................................................513
SPECtrum:MARKer:REFerence:SETup:MODE................................................................. 513
SPECtrum:MARKer:REFerence:SETup:SPAN.................................................................. 513

SPECtrum:MARKer:REFerence:SETup:FREQuency

Sets the center frequency for the capture range, when
EFFT:MARKer:REFerence:SETup:MODE RANGe.

Parameters:
<ReferenceFrequency>

SPECtrum:MARKer:REFerence:SETup:INDex

Sets the reference marker to the peak with the specified index, when
EFFT:MARKer:REFerence:SETup:MODE INDicated.

Parameters:
<ReferenceIndex>

SPECtrum:MARKer:REFerence:SETup:MODE

Sets the mode for the selection of the reference peak. The peak with the highest level
within the selected settings is set as the reference marker.

Parameters:
<ReferenceMode> OFF | INDicated | RANGe

SPECtrum:MARKer:REFerence:SETup:SPAN

Sets the span range, which is defined as the ratio of the capture range and the width of
the specified reference mode, when EFFT:MARKer:REFerence:SETup:MODE
RANGe.

Parameters:
<ReferenceSpan>
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Marker Table

SPECtrum:MARKer:RCOunt?......................................................................................... 514
SPECtrum:MARKer:RMODe........................................................................................... 514
SPECtrum:MARKer:RTABle:ENABle................................................................................514
SPECtrum:MARKer:RTABle:POSition.............................................................................. 515
SPECtrum:MARKer:RMARker?....................................................................................... 515
SPECtrum:MARKer:RMARker:FREQuency?.....................................................................515
SPECtrum:MARKer:RMARker:LEVel?..............................................................................515
SPECtrum:MARKer:RESult<n>?..................................................................................... 515
SPECtrum:MARKer:RESult<n>:ALL?...............................................................................516
SPECtrum:MARKer:RESult<n>:ALL:DELTa?....................................................................516
SPECtrum:MARKer:RESult<n>:DELTa?.......................................................................... 516
SPECtrum:MARKer:RESult<n>:FREQuency?...................................................................516
SPECtrum:MARKer:RESult<n>:FREQuency:DELTa?........................................................517
SPECtrum:MARKer:RESult<n>:LEVel?............................................................................517
SPECtrum:MARKer:RESult<n>:LEVel:DELTa?.................................................................517

SPECtrum:MARKer:RCOunt?

Returns the number of detected peaks.

Parameters:
<ResultCount>

Usage: Query only

SPECtrum:MARKer:RMODe <ResultMode>

Sets the mode for the display of the results in the marker table.

Parameters:
<ResultMode> ABSolute | FREQuency | LEVel | FLEVel

ABSolute
The absolute values for both the frequency and level are dis-
played.
FREQuency
The delta between the reference freqeuncy and the correspond-
ing freqeuncy value as well as the absolute level are displayed.
LEVel
The delta between the reference level and the corresponding
level value as well as the absolute frequency are displayed.
FLEVel
The delta between the reference freqency/level and the corre-
sponding freqency/level value are displayed.

SPECtrum:MARKer:RTABle:ENABle <ResultTable>

Enables the display of the marker table.

Spectrum Analysis



Remote Commands ReferenceR&S®RTM2000

515User Manual 1317.4726.02 ─ 10

Parameters:
<ResultTable> ON | OFF

*RST: OFF

SPECtrum:MARKer:RTABle:POSition <TablePosition>

Defines the position of the marker table on the screen: top right, bottom right, or full
screen. With full screen setting, the table covers nearly the complete righthand half of
the screen.

Parameters:
<TablePosition> TOP | BOTTom | FULLscreen

*RST: OFF

SPECtrum:MARKer:RMARker?

Returns the frequency and the level values of the present reference marker.

Return values: 
<ReferenceFrequency>

<ReferenceLevel>

Usage: Query only

SPECtrum:MARKer:RMARker:FREQuency?

Queries the frequency of the reference marker.

Return values: 
<ReferenceFrequency>

Usage: Query only

SPECtrum:MARKer:RMARker:LEVel?

Queries the level of the reference marker.

Return values: 
<ReferenceLevel>

Usage: Query only

SPECtrum:MARKer:RESult<n>?

Returns the frequency and level values of the n-th marker.

Suffix: 
<n>

.
*

Return values: 
<ResultFrequency>
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<ResultLevel>

Usage: Query only

SPECtrum:MARKer:RESult<n>:ALL?

Returns a list of all marker with the corresponding frequency and level values.

Suffix: 
<n>

.
*

Return values: 
<ResultValues> List of numeric values with shape <freq>,<level>,....

Usage: Query only

SPECtrum:MARKer:RESult<n>:ALL:DELTa?

Queries the delta frequency and delta level, the difference between the freqeuncy/level
of the specified marker and the freqeuncy/level of the reference marker.

Suffix: 
<n>

.
*

Return values: 
<ResultValues> List of numeric values with shape <freq>,<level>,....

Usage: Query only

SPECtrum:MARKer:RESult<n>:DELTa?

Returns the difference in the values between the n-th marker and the reference
marker.

Suffix: 
<n>

.
*

Usage: Query only

SPECtrum:MARKer:RESult<n>:FREQuency?

Returns the frequency of the n-th marker.

Suffix: 
<n>

.
*

Return values: 
<ResultFrequency>

Usage: Query only
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SPECtrum:MARKer:RESult<n>:FREQuency:DELTa?

Queries the delta frequency, the difference between the frequency of the specified
marker and the level of the reference marker.

Suffix: 
<n>

.
*

Return values: 
<ResultFrequencyDifference>

Usage: Query only

SPECtrum:MARKer:RESult<n>:LEVel?

Returns the level of the n-th marker.

Suffix: 
<n>

.
*

Return values: 
<ResultLevel>

Usage: Query only

SPECtrum:MARKer:RESult<n>:LEVel:DELTa?

Queries the delta level, the difference between the level of the specified marker and
the level of the reference marker.

Suffix: 
<n>

.
*

Return values: 
<ResultLevelDifference>

Usage: Query only

18.10.3.4 Frequency Domain Settings

SPECtrum:FREQuency:CENTer

Defines the position of the displayed frequency domain, which is (Center - Span/2) to
(Center + Span/2). The width of the domain is defined using the command SPECtrum:
FREQuency:SPAN.

Parameters:
<CenterFrequency>

SPECtrum:FREQuency:FULLspan

Performs the spectrum analysis calculation for the full frequency span.
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Usage: Event

SPECtrum:FREQuency:SPAN

The span is specified in Hertz and defines the width of the displayed frequency range,
which is (Center - Span/2) to (Center + Span/2).

Parameters:
<Span>

SPECtrum:FREQuency:STARt

Defines the start frequency of the displayed frequency domain at the left display edge:
Center - Span/2

You can set start and stop frequency instead of defining a center frequency and span.

Parameters:
<StartFrequency> Range: Depends on various other settings, mainly on time

base, span/RBW ratio, and center frequency.

SPECtrum:FREQuency:STOP

Defines the stop frequency of the displayed frequency domain at the right display
edge: Center + Span/2

You can set start and stop frequency instead of defining a center frequency and span.

Parameters:
<StopFrequency> Range: Depends on various other settings, mainly on time

base, span/RBW ratio, and center frequency.

SPECtrum:FREQuency:BANDwidth[:RESolution]:AUTO <AutoSpanRBWratio>

Enables the auto resolution bandwidth mode. In the auto mode "Span": "RBW" ratio of
~1:100 is set.

Parameters:
<AutoSpanRBWratio>ON | OFF

*RST: ON

SPECtrum:FREQuency:BANDwidth[:RESolution]:RATio <SpanRBWratio>

Defines the ratio of span (Hz) / resolution bandwidth (Hz). The span/RBW ratio is half
the number of points used for FFT which is defined with manual operation in the menu.

Parameters:
<SpanRBWratio> Range: The value is changed in 2^n steps from 2^10 to

2^15 (1024, 2048,4096,8192,16384, 32768).
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SPECtrum:FREQuency:BANDwidth[:RESolution][:VALue] <ResolutionBandwidth>

Defines the resolution bandwidth - the minimum frequency step at which the individual
components of a spectrum can be distinguished.

Parameters:
<ResolutionBandwidth>Range: Depends on various other settings.

18.10.3.5 Time Domain Settings

SPECtrum:TIME:POSition...............................................................................................519
SPECtrum:TIME:RANGe................................................................................................ 519

SPECtrum:TIME:POSition <TimePosition>

Sets the time position of the analyzed time range.

Parameters:
<TimePosition>

SPECtrum:TIME:RANGe <TimeRange>

Sets the time range for the time domain diagram.

Parameters:
<TimeRange>

18.10.3.6 Waveform Settings

SPECtrum:WAVeform:AVERage[:ENABle]....................................................................... 520
SPECtrum:WAVeform:MAXimum[:ENABle].......................................................................520
SPECtrum:WAVeform:MINimum[:ENABle]........................................................................520
SPECtrum:WAVeform:SPECtrum[:ENABle]...................................................................... 520
SPECtrum:WAVeform:AVERage:DATA?..........................................................................520
SPECtrum:WAVeform:MAXimum:DATA?......................................................................... 520
SPECtrum:WAVeform:MINimum:DATA?.......................................................................... 520
SPECtrum:WAVeform:SPECtrum:DATA?.........................................................................520
SPECtrum:WAVeform:AVERage:DATA:HEADer?............................................................. 520
SPECtrum:WAVeform:MAXimum:DATA:HEADer?............................................................ 520
SPECtrum:WAVeform:MINimum:DATA:HEADer?..............................................................520
SPECtrum:WAVeform:SPECtrum:DATA:HEADer?............................................................ 520
SPECtrum:WAVeform:AVERage:DATA:POINts?...............................................................521
SPECtrum:WAVeform:MAXimum:DATA:POINts?..............................................................521
SPECtrum:WAVeform:MINimum:DATA:POINts?...............................................................521
SPECtrum:WAVeform:SPECtrum:DATA:POINts?..............................................................521
SPECtrum:WAVeform:AVERage:DATA:XINCrement?....................................................... 521
SPECtrum:WAVeform:MAXimum:DATA:XINCrement?...................................................... 521
SPECtrum:WAVeform:MINimum:DATA:XINCrement?........................................................521
SPECtrum:WAVeform:SPECtrum:DATA:XINCrement?...................................................... 521
SPECtrum:WAVeform:AVERage:DATA:XORigin?.............................................................521
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SPECtrum:WAVeform:MAXimum:DATA:XORigin?............................................................ 521
SPECtrum:WAVeform:MINimum:DATA:XORigin?............................................................. 521
SPECtrum:WAVeform:SPECtrum:DATA:XORigin?............................................................521
SPECtrum:WAVeform:AVERage:DATA:YINCrement?....................................................... 521
SPECtrum:WAVeform:MAXimum:DATA:YINCrement?...................................................... 521
SPECtrum:WAVeform:MINimum:DATA:YINCrement?........................................................521
SPECtrum:WAVeform:SPECtrum:DATA:YINCrement?...................................................... 521
SPECtrum:WAVeform:AVERage:DATA:YORigin?.............................................................521
SPECtrum:WAVeform:MAXimum:DATA:YORigin?............................................................ 521
SPECtrum:WAVeform:MINimum:DATA:YORigin?............................................................. 522
SPECtrum:WAVeform:SPECtrum:DATA:YORigin?............................................................522
SPECtrum:WAVeform:AVERage:DATA:YRESolution?.......................................................522
SPECtrum:WAVeform:MAXimum:DATA:YRESolution?......................................................522
SPECtrum:WAVeform:MINimum:DATA:YRESolution?....................................................... 522
SPECtrum:WAVeform:SPECtrum:DATA:YRESolution?......................................................522

SPECtrum:WAVeform:AVERage[:ENABle] <WaveformEnable>
SPECtrum:WAVeform:MAXimum[:ENABle] <WaveformEnable>
SPECtrum:WAVeform:MINimum[:ENABle] <WaveformEnable>
SPECtrum:WAVeform:SPECtrum[:ENABle] <WaveformEnable>

Enables/diables the indicated waveform.

Parameters:
<WaveformEnable> ON | OFF

*RST: ON

SPECtrum:WAVeform:AVERage:DATA?
SPECtrum:WAVeform:MAXimum:DATA?
SPECtrum:WAVeform:MINimum:DATA?
SPECtrum:WAVeform:SPECtrum:DATA?
Returns the data of the indicated waveform points for transmission from the instrument
to the controlling computer. The waveform data can be used in MATLAB, for example.

Return values: 
<Data> List of values

Usage: Query only

SPECtrum:WAVeform:AVERage:DATA:HEADer?
SPECtrum:WAVeform:MAXimum:DATA:HEADer?
SPECtrum:WAVeform:MINimum:DATA:HEADer?
SPECtrum:WAVeform:SPECtrum:DATA:HEADer?
Returns information on the indicated waveform.

Return values: 
<Header> StringData

Usage: Query only
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SPECtrum:WAVeform:AVERage:DATA:POINts?
SPECtrum:WAVeform:MAXimum:DATA:POINts?
SPECtrum:WAVeform:MINimum:DATA:POINts?
SPECtrum:WAVeform:SPECtrum:DATA:POINts?
Returns the number of data samples that are returned with
SPECtrum:WAVeform:xxx:DATA for the indicated waveform.

Return values: 
<DataPoints>

Usage: Query only

SPECtrum:WAVeform:AVERage:DATA:XINCrement?
SPECtrum:WAVeform:MAXimum:DATA:XINCrement?
SPECtrum:WAVeform:MINimum:DATA:XINCrement?
SPECtrum:WAVeform:SPECtrum:DATA:XINCrement?
Return the level difference between two adjacent samples of the indicated waveform.

Return values: 
<Xincrement>

Usage: Query only

SPECtrum:WAVeform:AVERage:DATA:XORigin?
SPECtrum:WAVeform:MAXimum:DATA:XORigin?
SPECtrum:WAVeform:MINimum:DATA:XORigin?
SPECtrum:WAVeform:SPECtrum:DATA:XORigin?
Returns the frequency of the first sample of the indicated waveform.

Return values: 
<Xorigin>

Usage: Query only

SPECtrum:WAVeform:AVERage:DATA:YINCrement?
SPECtrum:WAVeform:MAXimum:DATA:YINCrement?
SPECtrum:WAVeform:MINimum:DATA:YINCrement?
SPECtrum:WAVeform:SPECtrum:DATA:YINCrement?
Returns the voltage value per bit of the indicated waveform.

Return values: 
<Yincrement>

Usage: Query only

SPECtrum:WAVeform:AVERage:DATA:YORigin?
SPECtrum:WAVeform:MAXimum:DATA:YORigin?
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SPECtrum:WAVeform:MINimum:DATA:YORigin?
SPECtrum:WAVeform:SPECtrum:DATA:YORigin?
Returns the vertical bit resolution of the indicated waveform.

Return values: 
<Yorigin>

Usage: Query only

SPECtrum:WAVeform:AVERage:DATA:YRESolution?
SPECtrum:WAVeform:MAXimum:DATA:YRESolution?
SPECtrum:WAVeform:MINimum:DATA:YRESolution?
SPECtrum:WAVeform:SPECtrum:DATA:YRESolution?
Returns the vertical bit resolution of the indicated waveform.

Return values: 
<Yresolution>

Usage: Query only

18.10.3.7 Diagram Display Settings

SPECtrum:DIAGram:COLor:MAGNitude:MODE................................................................522
SPECtrum:DIAGram:COLor:MAXimum[:LEVel].................................................................522
SPECtrum:DIAGram:COLor:MINimum[:LEVel].................................................................. 523
SPECtrum:DIAGram:COLor:SCHeme:FDOMain............................................................... 523
SPECtrum:DIAGram:COLor:SCHeme:SPECtrogramm...................................................... 523
SPECtrum:DIAGram:FDOMain[:ENABle]..........................................................................523
SPECtrum:DIAGram:SPECtrogram[:ENABle]....................................................................523
SPECtrum:DIAGram:TDOMain[:ENABle]..........................................................................523

SPECtrum:DIAGram:COLor:MAGNitude:MODE <MagnitudeMode>

Enables the magnitude coloring of the waveform.

Parameters:
<MagnitudeMode> ON | OFF

SPECtrum:DIAGram:COLor:MAXimum[:LEVel] <MaximumLevel>

Sets the level used as a maximum for the color scale selected with SPECtrum:
DIAGram:COLor:SCHeme:FDOMain/SPECtrum:DIAGram:COLor:SCHeme:
SPECtrogramm . All level values higher than the maximum will be displayed with the
maximum color.

Parameters:
<MaximumLevel>
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SPECtrum:DIAGram:COLor:MINimum[:LEVel] <MinimumLevel>

Sets the level used as a minimum of the color scale selected with SPECtrum:
DIAGram:COLor:SCHeme:FDOMain/SPECtrum:DIAGram:COLor:SCHeme:
SPECtrogramm. All level values lower than the minimum will be displayed with the
minimum color.

Parameters:
<MinimumLevel>

SPECtrum:DIAGram:COLor:SCHeme:FDOMain <ColorScheme>

Sets the color scale for the display of the waveform in the frequency domain diagram.

Parameters:
<ColorScheme> MONochrom | TEMPerature | RAINbow

SPECtrum:DIAGram:COLor:SCHeme:SPECtrogramm <ColorScheme>

Sets the color scale for the display of the spectogram.

Parameters:
<ColorScheme> MONochrom | TEMPerature | RAINbow

SPECtrum:DIAGram:FDOMain[:ENABle] <Enable>

Enables the display of the frequency domain diagram.

Parameters:
<Enable> ON | OFF

SPECtrum:DIAGram:SPECtrogram[:ENABle] <Enable>

Enables the display of the spectrum diagram.

Parameters:
<Enable> ON | OFF

SPECtrum:DIAGram:TDOMain[:ENABle] <Enable>

Enables the display of the time domain diagram.

Parameters:
<Enable> ON | OFF

Spectrum Analysis



Remote Commands ReferenceR&S®RTM2000

524User Manual 1317.4726.02 ─ 10

18.11 Masks

18.11.1 Mask Test Setup......................................................................................................... 524

18.11.2 Actions on Violation.....................................................................................................527

18.11.3 Mask Data................................................................................................................... 529

18.11.1 Mask Test Setup

MASK:STATe................................................................................................................ 524
MASK:TEST..................................................................................................................524
MASK:LOAD................................................................................................................. 524
MASK:SAVE..................................................................................................................525
MASK:SOURce............................................................................................................. 525
MASK:CHCopy..............................................................................................................525
MASK:YPOSition........................................................................................................... 525
MASK:YSCale............................................................................................................... 525
MASK:YWIDth...............................................................................................................526
MASK:XWIDth...............................................................................................................526
MASK:COUNt?..............................................................................................................526
MASK:VCOunt?.............................................................................................................526
MASK:RESet:COUNter...................................................................................................526

MASK:STATe <State>

Turns the mask test mode on or off. When turning off, any temporarily stored new
masks are deleted.

Parameters:
<State> ON | OFF

*RST: OFF

MASK:TEST <Test>

Starts, finishes or interrupts a mask test.

Parameters:
<Test> RUN | STOP | PAUSe

*RST: STOP

MASK:LOAD <FileName>

Loads a stored mask from the specified file.

Setting parameters: 
<FileName> String parameter

Path and file name

Usage: Setting only
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MASK:SAVE <FileName>

Saves the current mask in the specified file.

Setting parameters: 
<FileName> String parameter

Path and file name

Usage: Setting only

MASK:SOURce <Source>

Defines the channel to be compared with the mask.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available on 4-channel R&S RTM mod-
els.
*RST: CH1

MASK:CHCopy

Creates a mask from the envelope waveform of the test source set with MASK:SOURce
.

Usage: Event

MASK:YPOSition <Yposition>

Moves the mask vertically within the display.

Parameters:
<Yposition> Mask offset from the vertical center

Range: -200  to  200
Increment: 0,02
*RST: 0
Default unit: DIV

MASK:YSCale <Yscale>

Changes the vertical scaling to stretch or compress the mask in y-direction.

Parameters:
<Yscale> A value over 100% stretches the amplitudes; a value less than

100% compresses the amplitudes.
Range: 10  to  1000
Increment: 1
*RST: 100
Default unit: %
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MASK:YWIDth <Yaddition>

Changes the width of the mask in vertical direction.

Parameters:
<Yaddition> The value is added to the y-values of the upper mask limit and

subtracted from the y-values of the lower mask limit.
Range: 0  to  5,12
Increment: 0,04
*RST: 0
Default unit: DIV

MASK:XWIDth <Xaddition>

Changes the width of the mask in horizontal direction.

Parameters:
<Xaddition> The value is added to the positive x-values and subtracted from

the negative x-values of the mask limits in relation to the mask
center.
Range: 0  to  10
Increment: 0,01
*RST: 0
Default unit: DIV

MASK:COUNt?

Returns the number of tested acquisitions.

Return values: 
<TotalCount> Total number of tested acquisitions

Usage: Query only

MASK:VCOunt?

Returns the number of acquistions that hit the mask.

Return values: 
<ViolationCount> Acquisition count

Usage: Query only

MASK:RESet:COUNter

Sets the counters of passed and failed acquisitions to Zero.

Usage: Event

Firmware/Software: FW 03.800
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18.11.2 Actions on Violation

MASK:ACTion:SOUNd:EVENt:MODE.............................................................................. 527
MASK:ACTion:STOP:EVENt:MODE................................................................................ 527
MASK:ACTion:SCRSave:EVENt:MODE........................................................................... 527
MASK:ACTion:PRINt:EVENt:MODE.................................................................................527
MASK:ACTion:WFMSave:EVENt:MODE.......................................................................... 527
MASK:ACTion:PULSe:EVENt:MODE...............................................................................527
MASK:ACTion:SOUNd:EVENt:COUNt............................................................................. 528
MASK:ACTion:STOP:EVENt:COUNt................................................................................528
MASK:ACTion:SCRSave:EVENt:COUNt.......................................................................... 528
MASK:ACTion:PRINt:EVENt:COUNt................................................................................528
MASK:ACTion:WFMSave:EVENt:COUNt......................................................................... 528
MASK:ACTion:PULSe:EVENt:COUNt.............................................................................. 528
MASK:ACTion:SCRSave:DESTination............................................................................. 528
MASK:ACTion:WFMSave:DESTination............................................................................ 528
MASK:ACTion:PULSe:PLENgth...................................................................................... 529
MASK:ACTion:PULSe:POLarity.......................................................................................529

MASK:ACTion:SOUNd:EVENt:MODE <EventMode>
MASK:ACTion:STOP:EVENt:MODE <EventMode>
MASK:ACTion:SCRSave:EVENt:MODE <EventMode>
MASK:ACTion:PRINt:EVENt:MODE <EventMode>
MASK:ACTion:WFMSave:EVENt:MODE <EventMode>
MASK:ACTion:PULSe:EVENt:MODE <EventMode>

Defines when and how often the action will be executed.

● SOUNd: Generates a beep sound on mask violation.
● STOP: Stops the waveform acquisition on mask violation.
● PRINt: Prints a screenshot to a printer connected to the USB connector on the

front or rear panel.
● SCRSave: Saves a screenshot on mask violation. To set path and filename of the

screenshot, use MASK:ACTion:SCRSave:DESTination.
● WFMSave: Saves the waveform data on mask violation. To set path and filename

of the data file, use MASK:ACTion:WFMSave:DESTination.
● PULSe: Creates a trigger out pulse on mask violation. To set the pulse width and

polarity of the pulse, use the commands MASK:ACTion:PULSe:PLENgth and
MASK:ACTion:PULSe:POLarity.
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Parameters:
<EventMode> OFF | EACH | SINGle | CYCLic

OFF
No action is executed.
EACH
The selected action is executed on each violation of the mask.
SINGle
The selected action is executed once after the n-th violation.
CYCLic
The selected action is executed repeatedly after each n-th viola-
tion.
The number of violations <n> is set with the relevant
MASK:ACTion:...:EVENt:COUNt command.
*RST: OFF

Firmware/Software: FW 03.800, PULSe: 05.200

MASK:ACTion:SOUNd:EVENt:COUNt <EventCount>
MASK:ACTion:STOP:EVENt:COUNt <EventCount>
MASK:ACTion:SCRSave:EVENt:COUNt <EventCount>
MASK:ACTion:PRINt:EVENt:COUNt <EventCount>
MASK:ACTion:WFMSave:EVENt:COUNt <EventCount>
MASK:ACTion:PULSe:EVENt:COUNt <EventCount>

Sets the number of mask violations after which the action is executed. The command
is only relevant if the associated MASK:ACTion:...:EVENt:MODE is set to SINGle or
CYCLic.

Parameters:
<EventCount> Integer value, number of mask violations

Firmware/Software: FW 03.800, PULSe: 05.200

MASK:ACTion:SCRSave:DESTination <File>

Defines the path and filename for a screenshot that will be saved on mask violation.
The file format is PNG, the filename is incremented automatically

Parameters:
<File> String parameter

Example: MASK:ACT:SCRS:DEST "/USB_FRONT/MASKS/VIOL"
On first violation, the screeenshot is saved to VIOL.PNG, on
second violation to VIOL01.PNG, the third to VIOL02.PNG ...

MASK:ACTion:WFMSave:DESTination <File>

Defines the path and filename for a waveform data that will be saved on mask viola-
tion. The file format is CSV, the filename is incremented automatically
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You can change the storage location, file name and/or file format manually in the FILE
> "Waveforms" menu. Remote control uses the recent settings.

Parameters:
<File> String parameter

Example: MASK:ACT:WFMS:DEST "/USB_FRONT/MASKS/VIOL"
On first violation, the waveform data is saved to VIOL.CSV, on
second violation to VIOL01.CSV, the third to VIOL02.CSV ...

MASK:ACTion:PULSe:PLENgth <PulseLength>

Sets the pulse width of the trigger out pulse that is created on mask violation.

Parameters:
<PulseLength> *RST: 1e-6

MASK:ACTion:PULSe:POLarity <Polarity>

Sets the polarity of the trigger out pulse that is created on mask violation.

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

18.11.3 Mask Data

Consider also the following commands:
● FORMat[:DATA] on page 731
● MASK:DATA:XINCrement? on page 742
● MASK:DATA:XORigin? on page 742
● MASK:DATA:YINCrement? on page 743
● MASK:DATA:YORigin? on page 743
● MASK:DATA:YRESolution? on page 743

MASK:DATA?................................................................................................................529
MASK:DATA:HEADer?...................................................................................................530
MASK:SAVE..................................................................................................................530

MASK:DATA?

Returns the data of the mask. The mask consists of two limit curves.

To set the export format, use FORMat[:DATA] on page 731.

Return values: 
<Data> List of values according to the format settings - the y-values of

the mask points. The list contains two values for each sample
interval.
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Usage: Query only

MASK:DATA:HEADer?

Returns information on the mask data that is delivered with MASK:DATA?.

Table 18-7: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Number of samples 200000

4 Number of values per sample interval. For masks
the value is 2.

2

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

MASK:SAVE <FileName>

Saves the current mask in the specified file.

Setting parameters: 
<FileName> String parameter

Path and file name

Usage: Setting only

18.12 Search

● General Search Configuration...............................................................................531
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● Search Results......................................................................................................545
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18.12.1 General Search Configuration

SEARch:STATe............................................................................................................. 531
SEARch:CONDition........................................................................................................531
SEARch:SOURce.......................................................................................................... 533
SEARch:GATE:MODE....................................................................................................533
SEARch:GATE:ABSolute:START.................................................................................... 533
SEARch:GATE:ABSolute:STOP...................................................................................... 534

SEARch:STATe <SearchState>

Enables and disables the search mode.

Parameters:
<SearchState> ON | OFF

*RST: OFF

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

SEARch:CONDition <SearchCondition>

Selects the event you want to search for.
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Parameters:
<SearchCondition> EDGE | WIDTh | PEAK | RUNT | RTIMe | DATatoclock |

PATTern | PROTocol
EDGE
An edge search result is found when the waveform passes the
given level in the specified direction.
WIDTH
A width search finds pulses with an exact pulse width, or pulses
shorter or longer than a given time, or pulses inside or outside
the allowable time range.
PEAK
The peak search finds pulses exceeding a given amplitude.
RUNT
The runt search finds pulses lower than normal in amplitude.
The amplitude crosses the first threshold twice without crossing
the second one. In addition to the threshold amplitudes, you can
define a time limit for the runt in the same way as for width
search: runts with exact width, shorter or longer than a given
time, or runts inside or outside the allowable time range.
RTIMe
The rise or fall time search finds slopes with an exact rise or fall
time, or rise/fall times shorter or longer than a given limit, or rise/
fall times inside or outside the allowable time range.
DATatoclock
The Data2Clock search - also known as setup/hold - finds viola-
tion of setup and hold times. It analyzes the relative timing
between two signals: a data signal and the synchronous clock
signal. Setup time is the time that the data signal is steady
before clock edge. Hold time is the time that the data signal is
steady after clock edge.
PATTern
The pattern search finds logical combinations of channel states
inside or outside a specified time range. For each channel, its
state and threshold level is defined. The states are combined
logically, and the time of true pattern results is compared with a
specified time range.
PROTocol
The protocol search finds various events in decoded data of
CAN or LIN signals, for example, a specified frame type, identi-
fier, data, and errors. Available search settings depend on the
configured bus type. For bus types PARallel, I2C, SPI, SSPI,
and UART no search is available.
See also: BUS<b>:TYPE on page 548

*RST: EDGE

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400
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SEARch:SOURce <SearchSource>

Selects the waveform to be analyzed.

Parameters:
<SearchSource> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | RE1 | RE2 |

RE3 | RE4 | SBUS1 | SBUS2 | SBUS3 | SBUS4
Any active channel, math, or reference waveform can be
searched.
For protocol search on CAN and LIN signals, an active serial
bus is the search source.
*RST: CH1

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

SEARch:GATE:MODE

Defines the search area. If the search is performed on a running acquisition series, the
instrument analyzes the displayed data. The search on a stopped acquisition analyzes
the contents of the memory.

Parameters:
<GateMode> OFF | DISPlay | ABSolute

OFF
Running acquisition: all waveform samples that are displayed on
the screen.
Stopped acquisition: all data samples that are stored in the
memory.
DISPlay
Search is restricted to the time range of the display.
ABSolute
Search is restricted to the time range defined by SEARch:
GATE:ABSolute:START and SEARch:GATE:ABSolute:STOP
.

SEARch:GATE:ABSolute:START <StartTime>

Sets the start time of the search area in relation to the trigger point if SEARch:GATE:
MODE on page 533 is set to ABSolute.

Parameters:
<StartTime> Default unit: s
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SEARch:GATE:ABSolute:STOP <StopTime>

Sets the end time of the search area in relation to the trigger point if SEARch:GATE:
MODE on page 533 is set to ABSolute.

Parameters:
<StopTime> Default unit: s

18.12.2 Edge Search Configuration

SEARch:TRIGger:EDGE:SLOPe..................................................................................... 534
SEARch:TRIGger:EDGE:LEVel....................................................................................... 534
SEARch:TRIGger:EDGE:LEVel:DELTa............................................................................ 534

SEARch:TRIGger:EDGE:SLOPe <Slope>

Sets the slope to be found.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.400

SEARch:TRIGger:EDGE:LEVel <Level>

Sets the voltage level for the edge search.

Parameters:
<Level> *RST: 0.6 V

Firmware/Software: FW 03.400

SEARch:TRIGger:EDGE:LEVel:DELTa <DeltaLevel>

Sets a hysteresis range above and below the search level to avoid unwanted search
results caused by noise oscillation around the level.

Parameters:
<DeltaLevel> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit
*RST: 0.2 V

Firmware/Software: FW 03.400

18.12.3 Width Search Configuration

SEARch:TRIGger:WIDTh:POLarity.................................................................................. 535
SEARch:TRIGger:WIDTh:LEVel...................................................................................... 535
SEARch:TRIGger:WIDTh:LEVel:DELTa........................................................................... 535
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SEARch:TRIGger:WIDTh:RANGe....................................................................................535
SEARch:TRIGger:WIDTh:WIDTh.....................................................................................536
SEARch:TRIGger:WIDTh:DELTa.....................................................................................536

SEARch:TRIGger:WIDTh:POLarity <Polarity>

Indicates the polarity of the pulse to be searched for.

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:LEVel <Level>

Sets the voltage level on which the pulse width is measured.

Parameters:
<Level> *RST: 500 mV

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:LEVel:DELTa <DeltaLevel>

Sets a hysteresis range above and below the search level to avoid unwanted search
results caused by noise oscillation around the level.

Parameters:
<DeltaLevel> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit
*RST: 200 mV

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:RANGe <Range>

Sets how the measured pulse width is compared with the given limit(s).

To set the width, use SEARch:TRIGger:WIDTh:WIDTh.

To set the range ± Δt, use SEARch:TRIGger:WIDTh:DELTa.
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Parameters:
<Range> WITHin | OUTSide | SHORter | LONGer

WITHin
Finds pulses inside the range width ± Δt.
OUTSide
Finds pulses outside the range width ± Δt.
SHORter
Finds pulses shorter than the given width.
LONGer
Finds pulses longer than the given width.
*RST: WITH

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:WIDTh <Width>

Sets the reference pulse width, the nominal value for comparisons.

Parameters:
<Width> Default unit: s

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:DELTa <DeltaWidth>

Sets a range Δt to the reference pulse width set with SEARch:TRIGger:WIDTh:
WIDTh if SEARch:TRIGger:WIDTh:RANGe is set to WITHin or OUTSide
Parameters:
<DeltaWidth> Range: Lower limit depends on the resolution, practically no

upper limit

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

18.12.4 Peak Search Configuration

SEARch:MEASure:PEAK:POLarity.................................................................................. 536
SEARch:MEASure:LEVel:PEAK:MAGNitude.....................................................................537

SEARch:MEASure:PEAK:POLarity <Polarity>

Indicates the polarity of a the pulse to be searched for a peak.
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Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.400

SEARch:MEASure:LEVel:PEAK:MAGNitude <Magnitude>

Sets the amplitude limit.

Parameters:
<Magnitude> Default unit: V

Firmware/Software: FW 03.400

18.12.5 Rise/Fall Time Search Configuration

SEARch:TRIGger:RISetime:SLOPe................................................................................. 537
SEARch:TRIGger:LEVel:RISetime:LOWer........................................................................537
SEARch:TRIGger:LEVel:RISetime:UPPer........................................................................ 538
SEARch:TRIGger:RISetime:RANGe................................................................................ 538
SEARch:TRIGger:RISetime:TIME....................................................................................538
SEARch:TRIGger:RISetime:DELTa................................................................................. 538

SEARch:TRIGger:RISetime:SLOPe <Polarity>

Sets the slope to be found.

Parameters:
<Polarity> POSitive | NEGative | EITHer

POSitive: to search for rise time.
NEGative to search for fall time.
EITHer: to search for rise and fall time
*RST: POS

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RISetime:LOWer <LowerLevel>

Sets the lower voltage threshold. When the signal crosses this level, the rise time mea-
surement starts or stops depending on the selected slope.

Parameters:
<LowerLevel> *RST: 400 mV

Default unit: V

Firmware/Software: FW 03.700
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SEARch:TRIGger:LEVel:RISetime:UPPer <UpperLevel>

Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time
measurement starts or stops depending on the selected slope.

Parameters:
<UpperLevel> *RST: 600 mV

Default unit: V

Firmware/Software: FW 03.700

SEARch:TRIGger:RISetime:RANGe <Range>

Sets how the measured rise or fall time is compared with the given limit(s).

To set the rise/fall time, use SEARch:TRIGger:RISetime:TIME.

To set the range ± Δt, use SEARch:TRIGger:RISetime:DELTa.

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds rise/fall times longer than the given time.
SHORter
Finds rise/fall times shorter than the given time.
WITHin
Finds rise/fall times inside the range time ± Δt.
OUTSide
Finds rise/fall times outside the range time ± Δt.
*RST: LONG

Firmware/Software: FW 03.700

SEARch:TRIGger:RISetime:TIME <Time>

Sets the reference rise or fall time, the nominal value for comparisons.

Parameters:
<Time> Range: Depends on various settings, mainly time base and

sample rate
*RST: 200e-6
Default unit: s

Firmware/Software: FW 03.700

SEARch:TRIGger:RISetime:DELTa <DeltaTime>

Sets a range Δt to the reference rise/fall time set with SEARch:TRIGger:RISetime:
TIME if SEARch:TRIGger:RISetime:RANGe on page 538 is set to Within or
Outside. The instrument finds rise/fall times inside or outside the range time ± Δt.
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Parameters:
<DeltaTime> Range: Depends on various settings, mainly time base and

sample rate
*RST: 50e-6
Default unit: s

Firmware/Software: FW 03.700

18.12.6 Runt Search Configuration

SEARch:TRIGger:RUNT:POLarity................................................................................... 539
SEARch:TRIGger:LEVel:RUNT:LOWer............................................................................ 539
SEARch:TRIGger:LEVel:RUNT:UPPer.............................................................................539
SEARch:TRIGger:RUNT:RANGe.....................................................................................540
SEARch:TRIGger:RUNT:WIDTh......................................................................................540
SEARch:TRIGger:RUNT:DELTa......................................................................................540

SEARch:TRIGger:RUNT:POLarity <Polarity>

Indicates the polarity of a the runt to be searched for.

Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RUNT:LOWer <LowerLevel>

Sets the lower voltage threshold for runt detection. A positive runt crosses the lower
level twice without crossing the upper level.

Parameters:
<LowerLevel> *RST: 400 mV

Default unit: V

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RUNT:UPPer <UpperLevel>

Sets the upper voltage threshold for runt detection. A negative runt crosses the upper
level twice without crossing the lower level.

Parameters:
<UpperLevel> *RST: 600 mV

Default unit: V

Firmware/Software: FW 03.700
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SEARch:TRIGger:RUNT:RANGe <Range>

Sets how the measured pulse width is compared with the given limit(s).

To set the width, use SEARch:TRIGger:RUNT:WIDTh.

To set the range ± Δt, use SEARch:TRIGger:RUNT:DELTa.

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds pulses longer than the given width.
SHORter
Finds pulses shorter than the given width.
WITHin
Finds pulses inside the range width ± Δt.
OUTSide
Finds pulses outside the range width ± Δt.
*RST: LONG

Firmware/Software: FW 03.700

SEARch:TRIGger:RUNT:WIDTh <Width>

Sets the reference runt pulse width, the nominal value for comparisons.

Parameters:
<Width> Range: Depends on various settings, mainly time base and

sample rate
*RST: 200e-6
Default unit: s

Firmware/Software: FW 03.700

SEARch:TRIGger:RUNT:DELTa <DeltaWidth>

Sets a range Δt to the reference pulse width set with SEARch:TRIGger:RUNT:WIDTh
if SEARch:TRIGger:RUNT:RANGe on page 540 is set to WITHin or OUTSide.

Parameters:
<DeltaWidth> Range: Depends on various settings, mainly time base and

sample rate
*RST: 50e-6
Default unit: s

Firmware/Software: FW 03.700
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18.12.7 Data2Clock Search Configuration

SEARch:TRIGger:DATatoclock:CSOurce......................................................................... 541
SEARch:TRIGger:DATatoclock:CLEVel............................................................................541
SEARch:TRIGger:DATatoclock:DLEVel............................................................................541
SEARch:TRIGger:DATatoclock:CLEVel:DELTa.................................................................541
SEARch:TRIGger:DATatoclock:DLEVel:DELTa.................................................................541
SEARch:TRIGger:DATatoclock:CEDGe........................................................................... 542
SEARch:TRIGger:DATatoclock:HTIMe.............................................................................542
SEARch:TRIGger:DATatoclock:STIMe.............................................................................542

SEARch:TRIGger:DATatoclock:CSOurce <ClockSource>

Selects the input channel of the clock signal.

Parameters:
<ClockSource> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 | RE1 |

RE2 | RE3 | RE4
*RST: CH1

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:CLEVel <ClockLevel>

Sets the voltage level for the clock signal. Clock level and clock edge define the refer-
ence point for setup and hold time.

Parameters:
<ClockLevel> Range: depends on vertical scale

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:DLEVel <DataLevel>

Sets the voltage level for the data signal. The data lavel defines the point of data tran-
sition.

Parameters:
<DataLevel> Range: depends on vertical scale

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:CLEVel:DELTa <LevelDelta>
SEARch:TRIGger:DATatoclock:DLEVel:DELTa <LevelDelta>

Set a hysteresis range to the clock and data levels in order to avoid unwanted search
results caused by noise oscillation around the level. For a rising edge, the hysteresis is
below the search level. Otherwise, for a falling edge the hysteresis is above the level.

Parameters:
<LevelDelta> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit
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Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:CEDGe <ClockEdge>

Sets the edge of the clock signal to define the time reference point for the setup and
hold time.

Parameters:
<ClockEdge> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:HTIMe <HoldTime>

Sets the minimum time after the clock edge while the data signal must stay steady
above or below the data level. The hold time can be negative. In this case, the hold
time ends before the clock edge, and the setup time must be positive and longer than
the absolute value of the hold time.

Parameters:
<HoldTime> Range: depends on time base and sample interval

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:STIMe <SetupTime>

Sets the minimum time before the clock edge while the data signal must stay steady
above or below the data level. The setup time can be negative. In this case, the setup
interval starts after the clock edge, and the hold time must be positive and longer than
the absolute value of the setup time.

Parameters:
<SetupTime> Range: depends on time base and sample interval

Firmware/Software: FW 03.800

18.12.8 Pattern Search Configuration

SEARch:TRIGger:PATTern:SOURce............................................................................... 542
SEARch:TRIGger:PATTern:FUNCtion..............................................................................543
SEARch:TRIGger:PATTern:LEVel<n>..............................................................................543
SEARch:TRIGger:PATTern:LEVel<n>:DELTa...................................................................543
SEARch:TRIGger:PATTern:WIDTh:RANGe......................................................................544
SEARch:TRIGger:PATTern:WIDTh[:WIDTh]..................................................................... 544
SEARch:TRIGger:PATTern:WIDTh:DELTa.......................................................................544

SEARch:TRIGger:PATTern:SOURce <Pattern>

Specifies the search pattern - the state for each channel.
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Parameters:
<Pattern> String parameter

String containing 0, 1, X|x for each channel. The order of chan-
nels is fixed: CH1 CH2 [CH3 CH4].

Example: SEAR:TRIG:PATT:SOUR '1X10'
CH1, CH3 are high, CH4 is low. These states are logically com-
bined with SEARch:TRIGger:PATTern:FUNCtion. CH2 does
not matter (don't care).

SEARch:TRIGger:PATTern:FUNCtion <Function>

Sets the logical combination of the channel states.

Parameters:
<Function> AND | OR | NAND | NOR

AND
The required states of all channels must appear in the input sig-
nal at the same time.
OR
At least one of the channels must have the required state.
NAND
"Not and" operator, at least one of the channels does not have
the required state.
NOR
"Not or" operator, none of the channels has the required state.
*RST: AND

SEARch:TRIGger:PATTern:LEVel<n> <ThresholdLevel>

Sets the threshold value for each specified source channel. You can set different levels
for the channels

Suffix: 
<n>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<ThresholdLevel> Range: Depends on vertical scale

SEARch:TRIGger:PATTern:LEVel<n>:DELTa <LevelDelta>

Sets a hysteresis range to the level of the specified source channel in order to avoid
unwanted search results caused by noise oscillation around the level. For a rising
edge, the hysteresis is below the search level. Otherwise, for a falling edge the hyste-
resis is above the level.
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Suffix: 
<n>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<LevelDelta> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit

SEARch:TRIGger:PATTern:WIDTh:RANGe <Range>

Sets the condition how the duration of a steady pattern is compared with the given ref-
erence time.

To set the reference value width, use SEARch:TRIGger:PATTern:WIDTh[:WIDTh]
on page 544.

To set a range Δt, use SEARch:TRIGger:PATTern:WIDTh:DELTa on page 544

Parameters:
<Range> WITHin | OUTSide | LONGer | SHORter

WITHin
Finds patterns steady for a time range width ± Δt.
OUTSide
Finds patterns outside a time range width ± Δt.
LONGer
Finds patterns steady for at least the given width.
SHORter
Finds patterns shorter than the given width.
*RST: LONG

SEARch:TRIGger:PATTern:WIDTh[:WIDTh] <Width>

Sets the reference time of a steady pattern, the nominal value for comparisons.

Parameters:
<Width> Default unit: s

SEARch:TRIGger:PATTern:WIDTh:DELTa <DeltaTime>

Sets a range Δt to the reference pattern duration set with SEARch:TRIGger:
PATTern:WIDTh[:WIDTh] if SEARch:TRIGger:PATTern:WIDTh:RANGe is set to
WITHin or OUTSide.

Parameters:
<DeltaTime> Default unit: s
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18.12.9 Search Results

SEARch:RESult:BCOunt?...............................................................................................545
SEARch:RESDiagram:SHOW......................................................................................... 545
SEARch:RESult:ALL?.....................................................................................................545
SEARch:RESult<n>?......................................................................................................546
SEARch:RCOunt?..........................................................................................................546
EXPort:SEARch:NAME...................................................................................................547
EXPort:SEARch:SAVE................................................................................................... 547

SEARch:RESult:BCOunt?

Returns the maximum number of search results which the instrument can store.

Return values: 
<BufferedCount> Number of search results

Usage: Query only

SEARch:RESDiagram:SHOW <ResultShow>

Shows or hides the table of search results.

Parameters:
<ResultShow> ON | OFF

*RST: OFF

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Firmware/Software: FW 03.400

SEARch:RESult:ALL?

Returns all result values of the search.

Return values: 
<AllResults> List of results items seperated by comma

For each result, six values are returned:
1. Result number as indicated in the search results table
2. X-position (time) of the search result
3. Y-position of the search result, currently not relevant
4. Type of the search result (Edge, Peak, ...)
5. Slope or polarity of the search result
6. For peak searches, the value contains the peak voltage. For
width searches, it contains the pulse width. For edge searches,
the value is not relevant.
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Example: SEARch:RESult:ALL?
Returns all four results of a peak search:
1,-4.7750e-04,0,PEAK,NEGATIVE,-1.530e-02,2,
-4.4630e-04,0,PEAK,NEGATIVE,-1.530e-02,3,
-4.1660e-04,0,PEAK,NEGATIVE,-1.530e-02,4,
-3.8690e-04,0,PEAK,NEGATIVE,-1.530e-02

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Usage: Query only

Firmware/Software: FW 03.400

SEARch:RESult<n>?

Returns the result values of the specified search result.

See also: SEARch:RESult:ALL?
Suffix: 
<n>

.
*
Number of the search result

Return values: 
<Result> Comma-separated value list

Meaning of the values:
Result number, time value, y-position (not relevant), search type,
slope or polarity, optional value: voltage for peak search, pulse
width for width search.

Example: SEARch:RESult3?
Returns the result values of the third search result.
3,-4.1660e-04,0,PEAK,NEGATIVE,-1.530e-02

Usage: Query only

Firmware/Software: FW 03.400

SEARch:RCOunt?

Returns the number of search results.

Return values: 
<ResultCount> *RST: 0

Example: Chapter 18.2.2.1, "Searching for a Pulse of Specified Width",
on page 407

Usage: Query only

Firmware/Software: FW 03.400
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EXPort:SEARch:NAME <FileName>

Defines the path and filename for search results that will be saved with EXPort:
SEARch:SAVE. The file format is CSV, the filename is incremented automatically

You can change the storage location and the file name manually in the SEARCH >
"Events" > "Save" menu. Remote control uses the recent settings.

Parameters:
<FileName> String parameter

Example: EXPort:SEARch:NAME "/USB_FRONT/SEARCH/RESULT"
On first save, the search results are saved to RESULT.CSV, on
second save to RESULT01.CSV, the third to RESULT02.CSV ...

EXPort:SEARch:SAVE

Usage: Setting only

18.13 Protocol Analysis

● General................................................................................................................. 547
● SPI........................................................................................................................ 551
● SSPI......................................................................................................................561
● I²C......................................................................................................................... 565
● UART.................................................................................................................... 576
● CAN.......................................................................................................................584
● LIN.........................................................................................................................601
● Audio Signals (Option R&S RTM-K5)................................................................... 615
● MIL_STD-1553 (Option R&S RTM-K6).................................................................631
● ARINC 429 (Option R&S RTM-K7)....................................................................... 653

18.13.1 General

Note: SPI/SSPI and UART protocols occupy two bus lines (bus 1 and 2 or bus 3 and
4). If one of these buses is configured, the number of buses (suffix <b>) is reduced.
Bus 2 and/or bus 4 is not available.

BUS<b>:STATe............................................................................................................. 548
BUS<b>:TYPE...............................................................................................................548
BUS<b>:FORMat...........................................................................................................548
BUS<b>:DSIGnals......................................................................................................... 548
BUS<b>:LABel.............................................................................................................. 549
BUS<b>:LABel:STATe................................................................................................... 549
BUS<b>:DSIZe..............................................................................................................549
BUS<b>:POSition.......................................................................................................... 550
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BUS<b>:RESult............................................................................................................. 550
BUS<b>:LIST?.............................................................................................................. 550
BUS<b>:LIST:SAVE.......................................................................................................551

BUS<b>:STATe <State>

Switches the protocol display on or off.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<State> ON | OFF

*RST: OFF

BUS<b>:TYPE <Type>

Defines the bus or interface type for analysis. For most types, a special option to the
instrument is required.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI, UART and I2S protocols occupy two bus lines
(bus 1 and 2 or bus 3 and 4).

Parameters:
<Type> PARallel | CPARallel | I2C | SPI | SSPI | UART | CAN | LIN |

I2S | MILStd | ARINc
*RST: PARallel

BUS<b>:FORMat <Format>

Sets the decoding format for the display on the screen.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Format> ASCii | HEXadecimal | BINary | DECimal | OCTal

*RST: HEX

BUS<b>:DSIGnals <BitsSignals>

Displays the individual bit lines above the decoded bus line.
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<BitsSignals> ON | OFF

*RST: ON

BUS<b>:LABel <Label>

Defines an additional name label for the selected bus.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Label> String value

The maximum name length is 8 characters, and only ASCII
characters provided on the on-screen keyboard can be used.

BUS<b>:LABel:STATe <State>

Displays or hides the bus label. The bus label is shown on the the right side of the dis-
play.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<State> ON | OFF

*RST: ON

BUS<b>:DSIZe <DisplaySize>

Sets the height of the decoded bus signal on the sreen.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.
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Parameters:
<DisplaySize> SMALl | MEDium | LARGe | DIV2 | DIV4

DIV2 | DIV4
2 or 4 divisions
SMALl | MEDium | LARGe
Size of indicated bus is smaller than 2 div.
*RST: MEDium

BUS<b>:POSition <Position>

Sets the vertical position of the decoded bus signal in divisions on the sreen.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Position> Range: 4  to  -4

Increment: 0.02
*RST: -3.5
Default unit: DIV

BUS<b>:RESult <ShowResultTable>

Displays or hides the table of decode results.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<ShowResultTable> ON | OFF

BUS<b>:LIST?

Returns the contents of the frame table in block data format.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Return values: 
<DataTable> Block data

Usage: Query only
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BUS<b>:LIST:SAVE <FilePath>

Saves the decoded data (frame table) to the specified CSV file (comma-separated list).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Setting parameters: 
<FilePath> String containing the storage device, path, and file name

Example: BUS:LIST:SAVE "/USB_FRONT/MYTABLE.CSV"
Saves the frame table data to the MYTABLE.CSV file on a USB
flash device connected to the front panel.

Usage: Setting only

18.13.2 SPI

The Serial Peripheral Interface SPI is used for communication with slow peripheral
devices, in particular, for transmission of data streams. A 4-channel instrument is
required for full support of the SPI protocol.

The SPI/SSPI protocol require two bus lines (bus 1 and 2 or bus 3 and 4), so the num-
ber of buses (suffix <b>) is reduced. Bus 2 and/or bus 4 is not available.

● SPI - Configuration................................................................................................551
● SPI - Trigger..........................................................................................................555
● SPI - Decode Results............................................................................................557

18.13.2.1 SPI - Configuration

BUS<b>:SPI:CS:SOURce...............................................................................................551
BUS<b>:SPI:CS:POLarity...............................................................................................552
BUS<b>:SPI:CLOCk:SOURce.........................................................................................552
BUS<b>:SPI:CLOCk:POLarity.........................................................................................552
BUS<b>:SPI:MOSI:SOURce........................................................................................... 553
BUS<b>:SPI:DATA:SOURce...........................................................................................553
BUS<b>:SPI:MISO:SOURce........................................................................................... 553
BUS<b>:SPI:MOSI:POLarity........................................................................................... 553
BUS<b>:SPI:DATA:POLarity...........................................................................................553
BUS<b>:SPI:MISO:POLarity........................................................................................... 554
BUS<b>:SPI:BORDer.....................................................................................................554
BUS<b>:SPI:SSIZe........................................................................................................554
CHANnel<m>:THReshold:FINDlevel................................................................................ 555

BUS<b>:SPI:CS:SOURce <Source>

Selects the input channel of the chip select line.
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

*RST: CH1

BUS<b>:SPI:CS:POLarity <Polarity>

Selects whether the chip select signal is high active (high = 1) or low active (low = 1).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POSitive

BUS<b>:SPI:CLOCk:SOURce <Source>

Selects the input channel of the clock line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

*RST: CH1

BUS<b>:SPI:CLOCk:POLarity <Polarity>

Selects if data is stored with the rising or falling slope of the clock. The slope marks the
begin of a new bit.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.
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Parameters:
<Polarity> POSitive | NEGative

POSitive: rising slope
NEGative: falling slope
*RST: NEGative

BUS<b>:SPI:MOSI:SOURce <Source>
BUS<b>:SPI:DATA:SOURce <Source>

Selects the input channel of the MOSI line, or of the data line if only one data line is
used.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI protocols occupy two bus lines (1 and 2 or 3 and
4).

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

D0..D15: requires MSO option R&S RTM-B1
*RST: CH1

BUS<b>:SPI:MISO:SOURce <MisoSource>

Selects the input channel of the optional MISO line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<MisoSource> CH1 | CH2 | CH3 | CH4 | NONE | D0..D15

*RST: NONE

BUS<b>:SPI:MOSI:POLarity <Polarity>
BUS<b>:SPI:DATA:POLarity <Polarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
data line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.
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Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POSitive

BUS<b>:SPI:MISO:POLarity <MisoPolarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
MISO line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<MisoPolarity> ACTLow | ACTHigh

*RST: ACTH

BUS<b>:SPI:BORDer <BitOrder>

Defines if the data of the messages starts with MSB (most significant bit) or LSB (least
significant bit).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst

BUS<b>:SPI:SSIZe <SymbolSize>

Sets the word length, the number of bits in a message.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<SymbolSize> Range: 4  to  32

Increment: 1
*RST: 8
Default unit: Bit
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CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

18.13.2.2 SPI - Trigger

TRIGger:A:SOURce....................................................................................................... 555
TRIGger:A:SPI:MODE.................................................................................................... 555
TRIGger:A:SPI:PATTern.................................................................................................556
TRIGger:A:SPI:PLENgth.................................................................................................556
TRIGger:A:SPI:POFFset.................................................................................................557

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.

TRIGger:A:SPI:MODE <Mode>

Specifies the trigger mode for SPI/SSPI protocols.
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Parameters:
<Mode> BSTart | BEND | NTHBit | PATTern

BSTart
Burst start, sets the trigger event to the start of the frame. The
frame starts when the chip select signal CS changes to the
active state.
BEND
Burst end, sets the trigger event to the end of the message.
NTHBit
Sets the trigger event to the specified bit number. To define the
bit number, use TRIGger:A:SPI:POFFset.

PATTern
Sets the trigger event to a serial pattern. To define the pattern,
use TRIGger:A:SPI:PATTern.
For a complete configuration of the pattern mode, you also have
to set TRIGger:A:SPI:PLENgth and TRIGger:A:SPI:
POFFset.

*RST: BSTart

TRIGger:A:SPI:PATTern <DataPattern>

Defines the bit pattern as trigger condition. The pattern length is adjusted to the num-
ber of bits defined in the pattern.

Parameters:
<DataPattern> String with max. 32 characters (4 byte + 8 bit) . Characters 0, 1,

and X are allowed.

Example: TRIG:A:SPI:PATT "0011XXXX0110"
Sets a 12bit pattern.

TRIGger:A:SPI:PLENgth <PatternLength>

Returns the number of bits in the previously defined bit pattern (TRIGger:A:SPI:
PATTern). The command can also be used to shorten a previously defined bit pattern.

Parameters:
<PatternLength> Range: 1  to  32

Increment: 1
*RST: 4

Example: TRIG:A:SPI:PATT "0011XXXX0110"
TRIG:A:SPI:PLEN?
12
TRIG:A:SPI:PLEN 4
TRIG:A:SPI:PATT?
"0011"

Protocol Analysis



Remote Commands ReferenceR&S®RTM2000

557User Manual 1317.4726.02 ─ 10

TRIGger:A:SPI:POFFset <PatternBitOffset>

Sets the number of bits before the first bit of the pattern.

Parameters:
<PatternBitOffset> Number of ignored bits

Range: 0  to  4095
Increment: 1
*RST: 0

18.13.2.3 SPI - Decode Results

BUS<b>:SPI:FCOunt?....................................................................................................557
BUS<b>:SPI:FRAME<n>:STATus?..................................................................................557
BUS<b>:SPI:FRAME<n>:STARt?....................................................................................558
BUS<b>:SPI:FRAME<n>:STOP?.....................................................................................558
BUS<b>:SPI:FRAME<n>:DATA:MOSI?............................................................................558
BUS<b>:SPI:FRAME<n>:DATA:MISO?............................................................................559
BUS<b>:SPI:FRAME<n>:WCOunt?.................................................................................559
BUS<b>:SPI:FRAME<n>:WORD<o>:STARt?................................................................... 560
BUS<b>:SPI:FRAME<n>:WORD<o>:STOP?....................................................................560
BUS<b>:SPI:FRAME<n>:WORD<o>:MOSI?.................................................................... 560
BUS<b>:SPI:FRAME<n>:WORD<o>:MISO?.................................................................... 561

BUS<b>:SPI:FCOunt?

Returns the number of decoded frames.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:SPI:FRAME<n>:STATus?

Returns the overall state of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.
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Return values: 
<Status> OK | INCFirst | INCLast | INSufficient

INCFirst
First frame is incomplete
INCLast
Last frame is incomplete

Usage: Query only

BUS<b>:SPI:FRAME<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:SPI:FRAME<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:SPI:FRAME<n>:DATA:MOSI?

Returns the data words of the specified frame of the MOSI line.
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

Return values: 
<DataMosi> List of decimal values of data bytes

Example: BUS:SPI:FRAM3:DATA:MOSI?
-> 94,177,171,60,242,219,100,0

Usage: Query only

BUS<b>:SPI:FRAME<n>:DATA:MISO?

Returns the data words of the specified frame of the MISO line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

Return values: 
<DataMiso> List of decimal values of data bytes

Example: BUS:SPI:FRAM3:DATA:MISO?
-> 94,177,171,60,242,219,100,0

Usage: Query only

BUS<b>:SPI:FRAME<n>:WCOunt?

Returns the number of words in the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

Return values: 
<WordCount> Number of words

Usage: Query only
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BUS<b>:SPI:FRAME<n>:WORD<o>:STARt?

Returns the start time of the specified data word.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:SPI:FRAME<n>:WORD<o>:STOP?

Returns the end time of the specified data word.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:SPI:FRAME<n>:WORD<o>:MOSI?

Returns the data value of the specified word on the MOSI line.

Use this command if only one line is defined.
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame (1...n)

<o> *
Selects the word number (1...m)

Return values: 
<Data> Decimal value of the data word

Usage: Query only

BUS<b>:SPI:FRAME<n>:WORD<o>:MISO?

Returns the data value of the specified word on the optional MISO line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame (1...n)

<o> *
Selects the word number (1...m)

Return values: 
<Data> Decimal value of the data word

Usage: Query only

18.13.3 SSPI

BUS<b>:SSPI:CLOCk:SOURce.......................................................................................562
BUS<b>:SSPI:CLOCk:POLarity.......................................................................................562
BUS<b>:SSPI:MOSI:SOURce.........................................................................................562
BUS<b>:SSPI:DATA:SOURce.........................................................................................562
BUS<b>:SSPI:MISO:SOURce.........................................................................................562
BUS<b>:SSPI:MOSI:POLarity......................................................................................... 563
BUS<b>:SSPI:DATA:POLarity.........................................................................................563
BUS<b>:SSPI:MISO:POLarity......................................................................................... 563
BUS<b>:SSPI:BITime.....................................................................................................563
BUS<b>:SSPI:BORDer...................................................................................................564
BUS<b>:SSPI:SSIZe......................................................................................................564
CHANnel<m>:THReshold:FINDlevel................................................................................ 564
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BUS<b>:SSPI:CLOCk:SOURce <Source>

Selects the input channel of the clock line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

BUS<b>:SSPI:CLOCk:POLarity <Polarity>

Selects if data is stored with the rising or falling slope of the clock. The slope marks the
begin of a new bit.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Polarity> POSitive | NEGative

POSitive: rising slope
NEGative: falling slope
*RST: POSitive

BUS<b>:SSPI:MOSI:SOURce <MosiSource>
BUS<b>:SSPI:DATA:SOURce <Source>

Selects the input channel of the data line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

BUS<b>:SSPI:MISO:SOURce <MisoSource>

Selects the input channel of the optional MISO line.
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<MisoSource> CH1 | CH2 | CH3 | CH4 | NONE | D0..D15

*RST: NONE

BUS<b>:SSPI:MOSI:POLarity <MosiPolarity>
BUS<b>:SSPI:DATA:POLarity <Polarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
data line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POSitive

BUS<b>:SSPI:MISO:POLarity <MisoPolarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
MISO line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<MisoPolarity> ACTLow | ACTHigh

*RST: ACTH

BUS<b>:SSPI:BITime <BurstIdleTime>

Within the idle time the data and clock lines are low. A new frame begins when the idle
time has expired and the clock line has been inactive during that time. If the time inter-
val between the data words is shorter than the idle time, the words are part of the
same frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.
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Parameters:
<BurstIdleTime> Range: 16e-9  to  838.832e-6

Increment: 16e-9
*RST: 100e-6
Default unit: s

BUS<b>:SSPI:BORDer <BitOrder>

Defines if the data of the messages starts with MSB (most significant bit) or LSB (least
significant bit).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst

BUS<b>:SSPI:SSIZe <SymbolSize>

Sets the word length, the number of bits in a message.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<SymbolSize> Range: 4  to  32

Increment: 1
*RST: 8
Default unit: Bit

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event
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18.13.4 I²C

The Inter-Integrated Circuit is a simple, lowbandwidth, low-speed protocol used for
communication between on-board devices, for example, in LCD and LED drivers,
RAM, EEPROM, and others.

Note: SPI/SSPI and UART protocols occupy two bus lines (bus 1 and 2 or bus 3 and
4). If one of these buses is configured, the number of buses (suffix <b>) is reduced.
Bus 2 and/or bus 4 is not available.

● I²C - Configuration.................................................................................................565
● I²C - Trigger...........................................................................................................566
● I²C - Decode Results.............................................................................................569

18.13.4.1 I²C - Configuration

BUS<b>:I2C:CLOCk:SOURce.........................................................................................565
BUS<b>:I2C:DATA:SOURce...........................................................................................565
CHANnel<m>:THReshold:FINDlevel................................................................................ 566

BUS<b>:I2C:CLOCk:SOURce <Source>

Sets the input channel to which the clock line is connected.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

BUS<b>:I2C:DATA:SOURce <Source>

Sets the input channel to which the data line is connected.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1
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CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

18.13.4.2 I²C - Trigger

TRIGger:A:SOURce....................................................................................................... 566
TRIGger:A:I2C:MODE.................................................................................................... 567
TRIGger:A:I2C:ACCess.................................................................................................. 567
TRIGger:A:I2C:AMODe.................................................................................................. 567
TRIGger:A:I2C:ADDRess................................................................................................568
TRIGger:A:I2C:PATTern.................................................................................................568
TRIGger:A:I2C:PLENgth.................................................................................................568
TRIGger:A:I2C:POFFset.................................................................................................569

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.
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TRIGger:A:I2C:MODE <Mode>

Specifies the trigger mode for I²C.

Parameters:
<Mode> STARt | RESTart | STOP | MACKnowledge | PATTern

STARt
Start of the message. The start condition is a falling slope on
SDA while SCL is high.
RESTart
Restarted message. The restart is a repeated start condition.
STOP
End of the message. The stop condition is a rising slope on SDA
while SCL is high.
MACKnowledge
Missing acknowledge. If the transfer failed, at the moment of the
acknowledge bit the SCL and the SDA lines are both on high
level.
PATTern
Triggers on a set of trigger conditions: read or write access of
the master, to an address, or/and to a bit pattern in the mes-
sage.
For a complete configuration of the pattern mode, you have to
set:
TRIGger:A:I2C:ACCess (read/write access), and
TRIGger:A:I2C:AMODe and TRIGger:A:I2C:ADDRess
(address), and/or
TRIGger:A:I2C:POFFset and TRIGger:A:I2C:PLENgth
and TRIGger:A:I2C:PATTern (pattern)

*RST: STARt

TRIGger:A:I2C:ACCess <Access>

Toggles the trigger condition between Read and Write access of the master.

Parameters:
<Access> READ | WRITe

*RST: READ

TRIGger:A:I2C:AMODe <AdrMode>

Sets the lenght of the slave address.

Parameters:
<AdrMode> NORMal | EXTended

NORMal: 7 bit address
EXTended: 10 bit address
*RST: NORMal
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TRIGger:A:I2C:ADDRess <AddressString>

Sets the address of the slave device. The address can have 7 bits or 10 bits.

Parameters:
<AddressString> String with max. 7 or 10 characters, depending on the address

length. Characters 0, 1, and X are allowed, but X cannot be
assigned to a specified bit. If at least one X occurs in the
address, the complete address is set to X.

Example: TRIG:A:I2C:AMOD NORM
TRIG:A:I2C:ADDR "1011"
TRIG:A:I2C:ADDR?
Return value (7bit address): "0001011"

Example: TRIG:A:I2C:AMOD EXT
TRIG:A:I2C:ADDR "10X1"
TRIG:A:I2C:ADDR?
Return value (10bit address): "XXXXXXXXXX"

TRIGger:A:I2C:PATTern <DataPattern>

Defines the bit pattern as trigger condition. Make sure that the correct pattern length
has been defined before with TRIGger:A:I2C:PLENgth.

Parameters:
<DataPattern> String with max. 24 characters (3 byte + 8 bit) . Characters 0, 1,

and X are allowed. X can be assigned to a specified bit. If you
define a pattern shorter than the pattern length, the missing LSB
are filled with X. If you define a pattern longer than the pattern
length, the pattern string is not valid

Example: TRIG:A:I2C:PLEN 2
TRIG:A:I2C:PATT "10X10000XXXX1111"
TRIG:A:I2C:PATT?
Return value (2 bytes): "10X10000XXXX1111"

Example: TRIG:A:I2C:PLEN 1
TRIG:A:I2C:PATT "110"
TRIG:A:I2C:PATT?
Return value (1 byte): "110XXXXX"

TRIGger:A:I2C:PLENgth <PatternLength>

Defines how many bytes are considered in the trigger condition. To set the pattern for
these bytes, use TRIGger:A:I2C:PATTern.

Parameters:
<PatternLength> Number of bytes

Range: 1  to  3
Increment: 1
*RST: 1
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TRIGger:A:I2C:POFFset <PatternByteOffset>

Sets the number of bytes before the first byte of interest, relating to the end of the
address bytes.

Parameters:
<PatternByteOffset> Number of ignored bytes

Range: 0  to  4095
Increment: 1
*RST: 0

18.13.4.3 I²C - Decode Results

BUS<b>:I2C:FCOunt?.................................................................................................... 569
BUS<b>:I2C:FRAMe<n>:DATA?..................................................................................... 569
BUS<b>:I2C:FRAMe<n>:STATus?.................................................................................. 570
BUS<b>:I2C:FRAMe<n>:STARt?.................................................................................... 570
BUS<b>:I2C:FRAMe<n>:STOP?..................................................................................... 571
BUS<b>:I2C:FRAMe<n>:AACCess?................................................................................571
BUS<b>:I2C:FRAMe<n>:ACCess?.................................................................................. 571
BUS<b>:I2C:FRAMe<n>:ACOMplete?............................................................................. 572
BUS<b>:I2C:FRAMe<n>:ADBStart?................................................................................ 572
BUS<b>:I2C:FRAMe<n>:ADDRess?................................................................................572
BUS<b>:I2C:FRAMe<n>:ADEVice?.................................................................................573
BUS<b>:I2C:FRAMe<n>:AMODe?.................................................................................. 573
BUS<b>:I2C:FRAMe<n>:ASTart?....................................................................................573
BUS<b>:I2C:FRAMe<n>:BCOunt?.................................................................................. 574
BUS<b>:I2C:FRAMe<n>:BYTE<o>:ACCess?................................................................... 574
BUS<b>:I2C:FRAMe<n>:BYTE<o>:ACKStart?................................................................. 574
BUS<b>:I2C:FRAMe<n>:BYTE<o>:COMPlete?................................................................ 575
BUS<b>:I2C:FRAMe<n>:BYTE<o>:STARt?..................................................................... 575
BUS<b>:I2C:FRAMe<n>:BYTE<o>:VALue?..................................................................... 575

BUS<b>:I2C:FCOunt?

Returns the number of received frames.

Suffix: 
<b>

.
1..4
Selects the bus.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:I2C:FRAMe<n>:DATA?

Returns the data words of the specified frame.
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Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<DataWordsInFrame>Comma-separated list of decimal values of the data bytes.

Example: BUS:I2C:FRAM2:DATA?
returns four data bytes:
-> 69,158,174,161

Usage: Query only

BUS<b>:I2C:FRAMe<n>:STATus?

Returns the overall state of the frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<State> INComplete | OK | UNEXpstop | INSufficient | ADDifferent

INComplete
The frame is not completely contained in the acquisition.

Usage: Query only

BUS<b>:I2C:FRAMe<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:I2C:FRAMe<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<EndTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:I2C:FRAMe<n>:AACCess?

Returns the address acknowledge bit value for the indicated frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<Acknowledge> INComplete | ACK | NACK | EITHer

Usage: Query only

BUS<b>:I2C:FRAMe<n>:ACCess?

Returns the transfer direction - read or write access from master to slave.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<Access> INComplete | READ | WRITE | EITHer | UNDF

INComplete
The frame is not completely contained in the acquisition.
UNDF
Access is not defined.

Usage: Query only
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BUS<b>:I2C:FRAMe<n>:ACOMplete?

Returns the state of the address.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<AddressComplete> ON | OFF

ON
Address was received completely.

Usage: Query only

BUS<b>:I2C:FRAMe<n>:ADBStart?

Returns the start time of the address acknowledge bit.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<AckStartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:I2C:FRAMe<n>:ADDRess?

Returns the decimal address value of the indicated frame including the R/W bit.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<AddressValue> Decimal value

Range: 0  to  2047
Increment: 1

Usage: Query only
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BUS<b>:I2C:FRAMe<n>:ADEVice?

Returns the decimal address value of the indicated frame without R/W bit.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<SlaveAddress> Decimal value

Range: 0  to  1023
Increment: 1

Usage: Query only

BUS<b>:I2C:FRAMe<n>:AMODe?

Returns the address length.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<AddressMode> BIT7 | BIT10

Usage: Query only

BUS<b>:I2C:FRAMe<n>:ASTart?

Returns the start time of the address for the indicated frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:I2C:FRAMe<n>:BCOunt?

Returns the number of data bytes in the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

Return values: 
<ByteCount im
Frame>

Number of words (bytes)

Example: BUS:I2C:FRAM2:BCO?
-> 4

Usage: Query only

BUS<b>:I2C:FRAMe<n>:BYTE<o>:ACCess?

Returns the acknowledge bit value of the specified data byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<Acknowledge> INComplete | ACK | NACK | EITHer

Usage: Query only

BUS<b>:I2C:FRAMe<n>:BYTE<o>:ACKStart?

Returns the start time of the acknowledge bit of the specified byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

<o> *
Selects the byte number.
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Return values: 
<AckStartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:I2C:FRAMe<n>:BYTE<o>:COMPlete?

Returns the state of the byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<ByteComplete> ON | OFF

ON
Data byte was received completely.

Usage: Query only

BUS<b>:I2C:FRAMe<n>:BYTE<o>:STARt?

Returns the start time of the specified data byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:I2C:FRAMe<n>:BYTE<o>:VALue?

Returns the decimal value of the specified byte.
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Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<ByteValue> Decimal value

Range: 0  to  255
Increment: 1

Example: BUS:I2C:FRAM2:BYTE2:VAL?
-> 158

Usage: Query only

18.13.5 UART

The Universal Asynchronous Receiver/Transmitter (UART) converts a word of data
into serial data, and vice versa.

The UART protocol requires two bus lines (bus 1 and 2 or bus 3 and 4), so the number
of buses (suffix <b>) is reduced. Bus 2 and/or bus 4 is not available.

● UART - Configuration............................................................................................576
● UART - Trigger......................................................................................................580
● UART - Decode Results........................................................................................582

18.13.5.1 UART - Configuration

BUS<b>:UART:RX:SOURce........................................................................................... 576
BUS<b>:UART:DATA:SOURce....................................................................................... 576
BUS<b>:UART:TX:SOURce............................................................................................577
BUS<b>:UART:POLarity.................................................................................................577
BUS<b>:UART:DATA:POLarity....................................................................................... 577
BUS<b>:UART:SSIZe.................................................................................................... 578
BUS<b>:UART:PARity................................................................................................... 578
BUS<b>:UART:SBIT...................................................................................................... 578
BUS<b>:UART:BAUDrate...............................................................................................579
BUS<b>:UART:BITime................................................................................................... 579
CHANnel<m>:THReshold:FINDlevel................................................................................ 579

BUS<b>:UART:RX:SOURce <RxSource>
BUS<b>:UART:DATA:SOURce <Source>

Selects the input channel of the data line.
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

BUS<b>:UART:TX:SOURce <TxSource>

Selects the input channel of the optional Tx line.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<TxSource> CH1 | CH2 | CH3 | CH4 | NONE | D0..D15

NONE
Disables the optional Tx line.
*RST: NONE

BUS<b>:UART:POLarity <IdleState>

Defines the logic levels of the bus. The idle state corresponds to a logic 1, and the start
bit to a logic 0.

Alternative command for BUS<b>:UART:DATA:POLarity
Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<IdleState> IDLLow | IDLHigh

IDLLow: idle low, low = 1
IDLHigh: idle high, high = 1
*RST: IDLH

BUS<b>:UART:DATA:POLarity <Polarity>

Defines if the transmitted data on the bus is high (high = 1) or low (low = 1) active.

Alternative command for BUS<b>:UART:POLarity .
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Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POS

BUS<b>:UART:SSIZe <SymbolSize>

Sets the number of data bits in a message.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<SymbolSize> Range: 5  to  9

Increment: 1
*RST: 8
Default unit: Bit

BUS<b>:UART:PARity <Parity>

Defines the optional parity bit that is used for error detection.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Parity> ODD | EVEN | NONE

See: "Parity" on page 222
*RST: NONE

BUS<b>:UART:SBIT <StopBitNumber>

Sets the stop bits.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.
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Parameters:
<StopBitNumber> B1 | B1_5 | B2

1; 1.5 or 2 stop bits are possible.
*RST: B1

BUS<b>:UART:BAUDrate <Baudrate>

Sets the number of transmitted bits per second.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<Baudrate> Range: 100  to  78.1E6

Increment: 100
*RST: 115200
Default unit: Bit

BUS<b>:UART:BITime <BurstIdleTime>

Sets the minimal time between two data frames (packets), that is, between the last
stop bit and the start bit of the next frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Parameters:
<BurstIdleTime> Range: Range depends on the bus configuration, mainly on

bit rate and symbol size.
Default unit: s

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event
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18.13.5.2 UART - Trigger

TRIGger:A:SOURce....................................................................................................... 580
TRIGger:A:UART:MODE................................................................................................ 580
TRIGger:A:UART:PATTern............................................................................................. 581
TRIGger:A:UART:PLENgth............................................................................................. 581
TRIGger:A:UART:POFFset............................................................................................. 582

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.

TRIGger:A:UART:MODE <Mode>

Specifies the trigger mode for UART/RS-232 interfaces.
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Parameters:
<Mode> BSTart | SBIT | NTHSymbol | SYMBol | PATTern | PRERror |

FERRor | BREak
BSTart
Burst start. Sets the trigger to the begin of a data frame. The
frame start is the first start bit after the idle time.
SBIT
Start bit. The start bit is the first low bit after a stop bit.
NTHSymbol
Sets the trigger to the n-th symbol of a burst.
SYMBol
Triggers if a pattern occurs in a symbol at any position in a burst.
PATTern
Triggers on a serial pattern at a defined position in the burst.
To define the pattern, use TRIGger:A:UART:PLENgth and
TRIGger:A:UART:PATTern.
To define the position, use TRIGger:A:UART:POFFset
on page 582.
PRERror
Parity Error: Triggers if a bit error occured in transmission.
FERRor
Triggers on frame error.
BREak
Triggers if a start bit is not followed by a stop bit within a defined
time. During the break the stop bits are at low state.
*RST: SBIT

TRIGger:A:UART:PATTern <DataPattern>

Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are

allowed.
*RST: 1 = "00000001"

TRIGger:A:UART:PLENgth <PatternLength>

Defines how many symbols build up the serial pattern.

Parameters:
<PatternLength> Number of symbols

Range: 1  to  3
Increment: 1
*RST: 1
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TRIGger:A:UART:POFFset <PatternByteOffset>

Sets the number of symbols before the first symbol of the pattern.

Parameters:
<PatternByteOffset> Number of ignored symbols

Range: 0  to  4095
Increment: 1
*RST: 0

18.13.5.3 UART - Decode Results

BUS<b>:UART:RX:FCOunt?...........................................................................................582
BUS<b>:UART:TX:FCOunt?........................................................................................... 582
BUS<b>:UART:RX:FRAMe<n>:WCOunt?........................................................................ 582
BUS<b>:UART:TX:FRAMe<n>:WCOunt?.........................................................................582
BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STATe?..........................................................583
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:STATe?.......................................................... 583
BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STARt?.......................................................... 583
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:STARt?...........................................................583
BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STOP?........................................................... 584
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:STOP?............................................................584
BUS<b>:UART:RX:FRAMe<n>:WORD<o>:VALue?.......................................................... 584
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:VALue?...........................................................584

BUS<b>:UART:RX:FCOunt?
BUS<b>:UART:TX:FCOunt?
Returns the number of decoded frames on the RX and TX lines, respectivley.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:UART:RX:FRAMe<n>:WCOunt?
BUS<b>:UART:TX:FRAMe<n>:WCOunt?
Returns the number of symbols in the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.
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<o> *

Return values: 
<WordCount> Number of words (symbols, characters)

Usage: Query only

BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STATe?
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:STATe?
Returns the status of the specified symbol (word).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

<o> *
Selects the word number.

Return values: 
<Status> OK | FRSTart | FRENd | FRMError | STERror | SPERror |

PRERror | INSufficient | BREak

Usage: Query only

BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STARt?
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:STARt?
Returns the start time of the specified symbol (word).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:UART:RX:FRAMe<n>:WORD<o>:STOP?
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:STOP?
Returns the end time of the specified symbol (word).

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:UART:RX:FRAMe<n>:WORD<o>:VALue?
BUS<b>:UART:TX:FRAMe<n>:WORD<o>:VALue?
Return the value of the specified symbol (word) on the Rx line and Tx line, respec-
tively.

Suffix: 
<b>

.
1..4
Selects the bus.
Note: SPI/SSPI and UART protocols occupy two bus lines.

<n> *
Selects the frame.

<o> *
Selects the word number.

Return values: 
<Value> Decimal value

Range: 0  to  511
Increment: 1

Usage: Query only

18.13.6 CAN

CAN is the Controller Area Network, a bus system used within automotive network
architecture.
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Note: SPI/SSPI and UART protocols occupy two bus lines (bus 1 and 2 or bus 3 and
4). If one of these buses is configured, the number of buses (suffix <b>) is reduced.
Bus 2 and/or bus 4 is not available.

● CAN - Configuration..............................................................................................585
● CAN - Trigger........................................................................................................586
● CAN - Decode Results..........................................................................................591
● CAN - Search........................................................................................................597

18.13.6.1 CAN - Configuration

BUS<b>:CAN:DATA:SOURce......................................................................................... 585
BUS<b>:CAN:TYPE.......................................................................................................585
BUS<b>:CAN:SAMPlepoint.............................................................................................585
BUS<b>:CAN:BITRate................................................................................................... 586
CHANnel<m>:THReshold:FINDlevel................................................................................ 586

BUS<b>:CAN:DATA:SOURce <Source>

Sets the source of the data line. All channel waveforms can be used.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

*RST: CH1

BUS<b>:CAN:TYPE <SignalType>

Selects the CAN-High or CAN-Low line. CAN uses both lines for differential signal
transmission.

If you measure with a differential probe, connect the probe to both CAN-H and CAN-L
lines, and set the type CANH.

If you use a single-ended probe, connect the probe to either CAN_L or CAN_H, and
select the data type accordingly.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<SignalType> CANH | CANL

*RST: CANH

BUS<b>:CAN:SAMPlepoint <SamplePoint>

Sets the position of the sample point within the bit in percent of the nominal bit time.
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See also: "Sample point" on page 230

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<SamplePoint> Range: 10  to  90

Increment: 1
*RST: 50
Default unit: %

BUS<b>:CAN:BITRate <BitRate>

Sets the number of transmitted bits per second.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<BitRate> Range: 100 to 5,04E06, depends on instrument type, ADC

clock rate
Increment: depends on the bit rate value
*RST: 50E03
Default unit: Bit/s

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

18.13.6.2 CAN - Trigger

TRIGger:A:SOURce....................................................................................................... 587
TRIGger:A:CAN:TYPE....................................................................................................587
TRIGger:A:CAN:FTYPe.................................................................................................. 588
TRIGger:A:CAN:ITYPe................................................................................................... 588
TRIGger:A:CAN:ICONdition............................................................................................ 589
TRIGger:A:CAN:IDENtifier.............................................................................................. 589
TRIGger:A:CAN:DLC......................................................................................................589
TRIGger:A:CAN:DCONdition...........................................................................................589
TRIGger:A:CAN:DATA................................................................................................... 590
TRIGger:A:CAN:ACKerror...............................................................................................590
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TRIGger:A:CAN:BITSterror............................................................................................. 590
TRIGger:A:CAN:CRCerror.............................................................................................. 590
TRIGger:A:CAN:FORMerror............................................................................................590

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.

TRIGger:A:CAN:TYPE <TriggerType>

Specifies the trigger mode for CAN.
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Parameters:
<TriggerType> STOFrame | EOFrame | ID | IDDT | FTYPe | ERRCondition

STOFrame
Start of frame
EOFrame
End of frame
ID
Sets the trigger to a specific message identifier or an identifier
range.
Specify the identifier with TRIGger:A:CAN:ITYPe, TRIGger:
A:CAN:ICONdition, and TRIGger:A:CAN:IDENtifier.

IDDT
Sets the trigger to a combination of identifier and data condition.
The instrument triggers at the end of the last byte of the speci-
fied data pattern.
Specify the identifier (see ID), and the data with TRIGger:A:
CAN:DLC, TRIGger:A:CAN:DCONdition, and TRIGger:A:
CAN:DATA.

FTYPe
Triggers on a specified frame type. Specify the frame type with
TRIGger:A:CAN:FTYPe.

ERRCondition
Identifies various errors in the frame. Specify the errors with
TRIGger:A:CAN:ACKerror, TRIGger:A:CAN:BITSterror
,TRIGger:A:CAN:CRCerror, and TRIGger:A:CAN:
FORMerror.

*RST: STOF

TRIGger:A:CAN:FTYPe <FrameType>

Specifies the frame type to be triggered on if TRIGger:A:CAN:TYPE is set to FTYPe.

Parameters:
<FrameType> DATA | REMote | ERRor | OVERload | ANY

*RST: ERR

TRIGger:A:CAN:ITYPe <IdentifierType>

Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN
extended frames.

The command is relevant if TRIGger:A:CAN:TYPE is set to ID or IDDT.

Parameters:
<IdentifierType> B11 | B29 | ANY

ANY: only available for CAN trigger type IDDT
*RST: B11
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TRIGger:A:CAN:ICONdition <IdentifierCondition>

Sets the comparison condition: If the pattern contains at least one X (don't care), you
can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

The command is relevant if TRIGger:A:CAN:TYPE is set to ID or IDDT.

Parameters:
<IdentifierCondition> EQUual | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:CAN:IDENtifier <Identifier>

Defines the identifier pattern. The pattern length is defined with TRIGger:A:CAN:
ITYPe on page 588.

The command is relevant if TRIGger:A:CAN:TYPE is set to ID or IDDT.

Parameters:
<Identifier> String containing binary pattern with max. 29 bit. Characters 0,

1, and X are allowed.

TRIGger:A:CAN:DLC <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.

The command is relevant if TRIGger:A:CAN:TYPE is set to IDDT.

Parameters:
<DataLength> Range: 0  to  8

Increment: 1
*RST: 1
Default unit: Byte

TRIGger:A:CAN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if TRIGger:A:CAN:TYPE is set to IDDT.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQ

Protocol Analysis



Remote Commands ReferenceR&S®RTM2000

590User Manual 1317.4726.02 ─ 10

TRIGger:A:CAN:DATA <Data>

Defines the data pattern. The number of bytes in the data pattern is defined with
TRIGger:A:CAN:DLC.

The command is relevant if TRIGger:A:CAN:TYPE is set to IDDT.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0,

1, and X are allowed. Make sure to enter complete bytes.

TRIGger:A:CAN:ACKerror <AcknowledgeError>

Triggers on acknowledgement errors. An acknowledgement error occurs when the
transmitter does not receive an acknowledgment - a dominant bit during the Ack Slot.

The command is relevant if TRIGger:A:CAN:TYPE is set to ERRCondition.

Parameters:
<AcknowledgeError> ON | OFF

*RST: OFF

TRIGger:A:CAN:BITSterror <BitStuffingError>

Triggers on bit stuffing errors.

See also: "Stuff bit" on page 232.

The command is relevant if TRIGger:A:CAN:TYPE is set to ERRCondition.

Parameters:
<BitStuffingError> ON | OFF

*RST: ON

TRIGger:A:CAN:CRCerror <CRCerror>

Triggers on errors in the Cyclic Redundancy Check.

The command is relevant if TRIGger:A:CAN:TYPE is set to ERRCondition.

Parameters:
<CRCerror> ON | OFF

*RST: OFF

TRIGger:A:CAN:FORMerror <FormError>

Triggers on form errors. A form error occurs when a fixed-form bit field contains one or
more illegal bits.

The command is relevant if TRIGger:A:CAN:TYPE is set to ERRCondition.
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Parameters:
<FormError> ON | OFF

*RST: OFF

18.13.6.3 CAN - Decode Results

BUS<b>:CAN:FCOunt?.................................................................................................. 591
BUS<b>:CAN:FRAMe<n>:TYPE?....................................................................................591
BUS<b>:CAN:FRAMe<n>:STATus?................................................................................ 592
BUS<b>:CAN:FRAMe<n>:STARt?...................................................................................592
BUS<b>:CAN:FRAMe<n>:STOP?................................................................................... 593
BUS<b>:CAN:FRAMe<n>:DATA?................................................................................... 593
BUS<b>:CAN:FRAMe<n>:ACKState?..............................................................................593
BUS<b>:CAN:FRAMe<n>:ACKValue?............................................................................. 594
BUS<b>:CAN:FRAMe<n>:CSSTate?...............................................................................594
BUS<b>:CAN:FRAMe<n>:CSValue?............................................................................... 594
BUS<b>:CAN:FRAMe<n>:DLCState?.............................................................................. 594
BUS<b>:CAN:FRAMe<n>:DLCValue?............................................................................. 595
BUS<b>:CAN:FRAMe<n>:IDSTate?................................................................................ 595
BUS<b>:CAN:FRAMe<n>:IDTYpe?................................................................................. 595
BUS<b>:CAN:FRAMe<n>:IDValue?.................................................................................596
BUS<b>:CAN:FRAMe<n>:BSEPosition?.......................................................................... 596
BUS<b>:CAN:FRAMe<n>:BCOunt?.................................................................................596
BUS<b>:CAN:FRAMe<n>:BYTE<o>:STATe?................................................................... 597
BUS<b>:CAN:FRAMe<n>:BYTE<o>:VALue?................................................................... 597

BUS<b>:CAN:FCOunt?

Returns the number of received frames.

Suffix: 
<b>

.
1..4
Selects the bus.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:CAN:FRAMe<n>:TYPE?

Returns the type of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).
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Return values: 
<FrameType> DATA | REMote | ERR | OVLD

Data, remote, error or overload frame

Usage: Query only

BUS<b>:CAN:FRAMe<n>:STATus?

Returns the overall state of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<FrameStatus> OK | BTST | CRCD | ACKD | CRC | EOFD | NOACk |

INSufficient
OK: frame is valid.
BTST: bit stuffing error occured
CRCD: wrong CRC delimiter occured
ACKD: Wrong ACK delimiter occured
CRC: cyclic redundancy check failed
EOFD: wrong end of frame
NOACk: acknowlegde is missing
INSufficient: frame is not completely contained in the acquisition.
The acquired part of the frame is valid.

Usage: Query only

BUS<b>:CAN:FRAMe<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:CAN:FRAMe<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:CAN:FRAMe<n>:DATA?

Returns the data words of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<FrameData> Comma-separated list of decimal values of the data bytes.

Usage: Query only

BUS<b>:CAN:FRAMe<n>:ACKState?

Returns the state of the acknowledge field.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<AcknowledgeState> OK | UNDF

UNDF: Undefined

Usage: Query only
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BUS<b>:CAN:FRAMe<n>:ACKValue?

Returns the value of the acknowledge field.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<AcknowledgeValue> Decimal value

Usage: Query only

BUS<b>:CAN:FRAMe<n>:CSSTate?

Returns the state of the checksum.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<ChecksumState> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS<b>:CAN:FRAMe<n>:CSValue?

Returns the checksum value.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<ChecksumValue> Decimal value

Usage: Query only

BUS<b>:CAN:FRAMe<n>:DLCState?

Returns the state of the data length code.
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Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<DLCState> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS<b>:CAN:FRAMe<n>:DLCValue?

Returns the number of data bytes in the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<DLCValue> non-negative integer

Usage: Query only

BUS<b>:CAN:FRAMe<n>:IDSTate?

Returns the state of the identifier.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<IdentifierState> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS<b>:CAN:FRAMe<n>:IDTYpe?

Returns the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN
extended frames.

Suffix: 
<b>

.
1..4
Selects the bus.
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<n> *
Selects the frame (1...n).

Return values: 
<IdentifierType> ANY | B11 | B29

ANY
No length specified, for example, for triggering on data only.

Usage: Query only

BUS<b>:CAN:FRAMe<n>:IDValue?

Returns the decimal address value of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<IdentifierValue> Decimal value

Usage: Query only

BUS<b>:CAN:FRAMe<n>:BSEPosition?

Returns the position of the bit stuffing error in the specified frame (if available).

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<ErrorPosition> *RST: 0

Default unit: s

Usage: Query only

BUS<b>:CAN:FRAMe<n>:BCOunt?

Returns the number of data bytes in the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).
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Return values: 
<ByteCount> Number of words (bytes)

Usage: Query only

BUS<b>:CAN:FRAMe<n>:BYTE<o>:STATe?

Returns the state of the specified data byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteStatus> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS<b>:CAN:FRAMe<n>:BYTE<o>:VALue?

Returns the decimal value of the specified byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteValue> Decimal value

Usage: Query only

18.13.6.4 CAN - Search

SEARch:PROTocol:CAN:CONDition................................................................................ 598
SEARch:PROTocol:CAN:FRAMe.....................................................................................598
SEARch:PROTocol:CAN:ACKerror.................................................................................. 599
SEARch:PROTocol:CAN:BITSterror.................................................................................599
SEARch:PROTocol:CAN:CRCerror..................................................................................599
SEARch:PROTocol:CAN:FORMerror............................................................................... 600
SEARch:PROTocol:CAN:FTYPe..................................................................................... 600
SEARch:PROTocol:CAN:ITYPe.......................................................................................600
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SEARch:PROTocol:CAN:ICONdition................................................................................600
SEARch:PROTocol:CAN:IDENtifier..................................................................................600
SEARch:PROTocol:CAN:DLENgth.................................................................................. 601
SEARch:PROTocol:CAN:DCONdition.............................................................................. 601
SEARch:PROTocol:CAN:DATA.......................................................................................601

SEARch:PROTocol:CAN:CONDition <SearchCondition>

Sets the event or combination of events to be searched for. Depending on the selected
event, further settings are required.

Parameters:
<SearchCondition> FRAMe | ERRor | IDENtifier | IDData | IDERror

FRAMe
Search for a frame type. Set the frame type with SEARch:
PROTocol:CAN:FRAMe.

ERRor
Search for errors of one or more error types. Set the error types
with SEARch:PROTocol:CAN:ACKerror, SEARch:
PROTocol:CAN:BITSterror, SEARch:PROTocol:CAN:
CRCerror, and SEARch:PROTocol:CAN:FORMerror.

IDENtifier
Search for identifier.
Specifiy the identifier with SEARch:PROTocol:CAN:FTYPe,
SEARch:PROTocol:CAN:ITYPe, SEARch:PROTocol:CAN:
ICONdition, and SEARch:PROTocol:CAN:IDENtifier.

IDData
Search for identifier and data.
Set the identifier (see IDENtifier) and the data with SEARch:
PROTocol:CAN:DLENgth, SEARch:PROTocol:CAN:
DCONdition, and SEARch:PROTocol:CAN:DATA.

IDERror
Search for errors that occur with a specified identifier.
Set the identifier (see IDENtifier) and the errors to be found (see
ERRor)
*RST: FRAM

SEARch:PROTocol:CAN:FRAMe <Frame>

Selects the frame type to be searched for.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to FRAMe.
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Parameters:
<Frame> SOF | EOF | OVERload | ERRor | DTA11 | DTA29 | REM11 |

REM29
SOF: start of frame
EOF: end of frame
OVERload: overload frame
ERRor: error frame
DTA11: data frame with 11bit identifier
DTA29: data frame with 29bit identifier
REM11: remote frame with 11bit identifier
REM29: remote frame with 29bit identifier
*RST: SOF

SEARch:PROTocol:CAN:ACKerror <AcknowledgeError>

Searches for acknowledgement errors. An acknowledgement error occurs when the
transmitter does not receive an acknowledgment - a dominant bit during the Ack Slot.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to ERRor or
IDERror.

Parameters:
<AcknowledgeError> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:BITSterror <BitStuffingError>

Searches for bit stuffing errors.

See also: "Stuff bit" on page 232.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to ERRor or
IDERror.

Parameters:
<BitStuffingError> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:CRCerror <CRCerror>

Searches for errors in the Cyclic Redundancy Check.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to ERRor or
IDERror.

Parameters:
<CRCerror> ON | OFF

*RST: OFF
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SEARch:PROTocol:CAN:FORMerror <FormError>

Searches for form errors. A form error occurs when a fixed-form bit field contains one
or more illegal bits.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to ERRor or
IDERror.

Parameters:
<FormError> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:FTYPe <FrameType>

Specifies the frame type to be searched for if SEARch:PROTocol:CAN:CONDition is
set to IDENtifier.

Parameters:
<FrameType> DATA | REMote | ANY

SEARch:PROTocol:CAN:ITYPe <IdType>

Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN
extended frames.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to
IDENtifier, IDData, or IDERror.

Parameters:
<IdType> B11 | B29

*RST: B11

SEARch:PROTocol:CAN:ICONdition <IdCondition>

Sets the comparison condition for the identifier: If the pattern contains at least one X
(don't care), you can trigger on values equal or not equal to the specified value. If the
pattern contains only 0 and 1, you can also trigger on a range greater than or lower
than the specified value.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to
IDENtifier, IDData, or IDERror.

Parameters:
<IdCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:CAN:IDENtifier <Identifier>

Defines the identifier pattern. The pattern length is defined with SEARch:PROTocol:
CAN:ITYPe.
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The command is relevant if SEARch:PROTocol:CAN:CONDition is set to
IDENtifier, IDData, or IDERror.

Parameters:
<Identifier> String containing binary pattern with max. 29 bit. Characters 0,

1, and X are allowed.

SEARch:PROTocol:CAN:DLENgth <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to IDData.

Parameters:
<DataLength> Range: 0  to  8

Increment: 1
*RST: 1
Default unit: Byte

SEARch:PROTocol:CAN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to IDData.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:CAN:DATA <Data>

Defines the data pattern. The pattern length is defined with SEARch:PROTocol:CAN:
DLENgth.

The command is relevant if SEARch:PROTocol:CAN:CONDition is set to IDData.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0,

1, and X are allowed. Make sure to enter complete bytes.

18.13.7 LIN

The Local Interconnect Network (LIN) is a simple, low-cost bus system used within
automotive network architectures.
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Note: SPI/SSPI and UART protocols occupy two bus lines (bus 1 and 2 or bus 3 and
4). If one of these buses is configured, the number of buses (suffix <b>) is reduced.
Bus 2 and/or bus 4 is not available.

● LIN - Configuration................................................................................................602
● LIN - Trigger..........................................................................................................603
● LIN - Decode Results............................................................................................606
● LIN - Search..........................................................................................................612

18.13.7.1 LIN - Configuration

BUS<b>:LIN:DATA:SOURce...........................................................................................602
BUS<b>:LIN:POLarity.....................................................................................................602
BUS<b>:LIN:STANdard.................................................................................................. 602
BUS<b>:LIN:BITRate..................................................................................................... 603
CHANnel<m>:THReshold:FINDlevel................................................................................ 603

BUS<b>:LIN:DATA:SOURce <Source>

Sets the source of the data line. All channel waveforms can be used.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | D0..D15

*RST: CH1

BUS<b>:LIN:POLarity <Polarity>

Defines the idle state of the bus. The idle state is the rezessive state and corresponds
to a logic 1.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Polarity> IDLHigh | IDLLow

IDLHigh: Low active, negative polarity
IDLLow: High active, positive polarity
*RST: IDLL

BUS<b>:LIN:STANdard <Standard>

Selects the version of the LIN standard that is used in the DUT. The setting mainly
defines the checksum version used during decoding.

The most common version is LIN 2.x. For mixed networks, or if the standard is
unknown, set the LIN standard to AUTO.
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Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Standard> V1X | V2X | J2602 | AUTO

*RST: V1X

BUS<b>:LIN:BITRate <BitRate>

Sets the number of transmitted bits per second.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<BitRate> *RST: 9,6E03

Default unit: Bit/s

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

18.13.7.2 LIN - Trigger

TRIGger:A:SOURce....................................................................................................... 603
TRIGger:A:LIN:TYPE..................................................................................................... 604
TRIGger:A:LIN:CHKSerror.............................................................................................. 605
TRIGger:A:LIN:IPERror.................................................................................................. 605
TRIGger:A:LIN:SYERror................................................................................................. 605
TRIGger:A:LIN:ICONdition.............................................................................................. 605
TRIGger:A:LIN:IDENtifier................................................................................................ 605
TRIGger:A:LIN:DATA..................................................................................................... 606
TRIGger:A:LIN:DCONdition.............................................................................................606
TRIGger:A:LIN:DLENgth.................................................................................................606

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.
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Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.

TRIGger:A:LIN:TYPE <TriggerType>

Specifies the trigger mode for LIN.

Parameters:
<TriggerType> SYNC | WKFRame | ID | IDDT | ERRCondition

SYNC
Start of frame, triggers on the stop bit of the sync field.
WKFRame
Triggers after a wakeup frame.
ID
Sets the trigger to a specific identifier or an identifier range.
Set the identifier with TRIGger:A:LIN:ICONdition and
TRIGger:A:LIN:IDENtifier.

IDDT
Set the identifier (see ID) and the data with TRIGger:A:LIN:
DLENgth, TRIGger:A:LIN:DCONdition, and TRIGger:A:
LIN:DATA.

ERRCondition
Identifies various errors in the frame. You can select one or
more error types as trigger condition.
Select the error types with TRIGger:A:LIN:CHKSerror,
TRIGger:A:LIN:IPERror, and TRIGger:A:LIN:SYERror.

*RST: SYNC

Protocol Analysis



Remote Commands ReferenceR&S®RTM2000

605User Manual 1317.4726.02 ─ 10

TRIGger:A:LIN:CHKSerror <ChecksumError>

Triggers on a checksum error. The checksum verifies the correct data transmission. It
is the last byte of the frame response. The checksum includes not only the data but
also the protected identifier (PID).

The command is relevant if TRIGger:A:LIN:TYPE is set to ERRCondition.

Parameters:
<ChecksumError> ON | OFF

*RST: ON

TRIGger:A:LIN:IPERror <IdParityError>

Triggers on a parity error. Parity bits are the bits 6 and 7 of the identifier. They verify
the correct transmission of the identifier.

The command is relevant if TRIGger:A:LIN:TYPE is set to ERRCondition.

Parameters:
<IdParityError> ON | OFF

*RST: OFF

TRIGger:A:LIN:SYERror <SyncError>

Triggers if synchronization caused an error.

The command is relevant if TRIGger:A:LIN:TYPE is set to ERRCondition.

Parameters:
<SyncError> ON | OFF

*RST: OFF

TRIGger:A:LIN:ICONdition <IdentifierCondition>

Sets the comparison condition for the identifier: If the pattern contains at least one X
(don't care), you can trigger on values equal or not equal to the specified value. If the
pattern contains only 0 and 1, you can also trigger on a range greater than or lower
than the specified value.

The command is relevant if TRIGger:A:LIN:TYPE is set to ID or IDDT.

Parameters:
<IdentifierCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:LIN:IDENtifier <Identifier>

Defines the identifier pattern.

The command is relevant if TRIGger:A:LIN:TYPE is set to ID or IDDT.
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Parameters:
<Identifier> String containing binary pattern. Characters 0, 1, and X are

allowed. Enter the 6 bit identifier without parity bits, not the pro-
tected identifier.

TRIGger:A:LIN:DATA <Data>

Defines the data pattern. The number of bytes in the data pattern is defined with
TRIGger:A:LIN:DLENgth.

The command is relevant if TRIGger:A:LIN:TYPE is set to IDDT.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0,

1, and X are allowed. Make sure to enter complete bytes.

TRIGger:A:LIN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if TRIGger:A:LIN:TYPE is set to IDDT.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:LIN:DLENgth <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.

The command is relevant if TRIGger:A:LIN:TYPE is set to IDDT.

Parameters:
<DataLength> Range: 1  to  8

Increment: 1
*RST: 1
Default unit: Byte

18.13.7.3 LIN - Decode Results

BUS<b>:LIN:FCOunt?.................................................................................................... 607
BUS<b>:LIN:FRAMe<n>:DATA?..................................................................................... 607
BUS<b>:LIN:FRAMe<n>:STATus?.................................................................................. 607
BUS<b>:LIN:FRAMe<n>:STARt?.................................................................................... 608
BUS<b>:LIN:FRAMe<n>:STOP?..................................................................................... 608
BUS<b>:LIN:FRAMe<n>:CSSTate?.................................................................................608
BUS<b>:LIN:FRAMe<n>:CSValue?................................................................................. 609
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BUS<b>:LIN:FRAMe<n>:IDPValue?................................................................................ 609
BUS<b>:LIN:FRAMe<n>:IDSTate?.................................................................................. 609
BUS<b>:LIN:FRAMe<n>:IDValue?.................................................................................. 610
BUS<b>:LIN:FRAMe<n>:SYSTate?.................................................................................610
BUS<b>:LIN:FRAMe<n>:SYValue?................................................................................. 610
BUS<b>:LIN:FRAMe<n>:VERSion?.................................................................................610
BUS<b>:LIN:FRAMe<n>:BCOunt?.................................................................................. 611
BUS<b>:LIN:FRAMe<n>:BYTE<o>:STATe?.....................................................................611
BUS<b>:LIN:FRAMe<n>:BYTE<o>:VALue?..................................................................... 612

BUS<b>:LIN:FCOunt?

Returns the number of received frames of the active LIN bus.

Suffix: 
<b>

.
1..4
Selects the bus.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:LIN:FRAMe<n>:DATA?

Returns the data bytes of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<FrameData> Comma-separated list of decimal values of the data bytes.

Usage: Query only

BUS<b>:LIN:FRAMe<n>:STATus?

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *

Return values: 
<FrameStatus> OK | UART | CHCKsum | PRERror | SYERror | WAKeup |

INSufficient | ERR | LENer

Usage: Query only
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BUS<b>:LIN:FRAMe<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:LIN:FRAMe<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:LIN:FRAMe<n>:CSSTate?

Returns the checksum state of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<ChecksumState> OK | ERR | UNDF

ERR: error
UNDF: undefined

Usage: Query only
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BUS<b>:LIN:FRAMe<n>:CSValue?

Returns the checksum value.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<ChecksumValue> Decimal value

Usage: Query only

BUS<b>:LIN:FRAMe<n>:IDPValue?

Returns the parity value.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<IdentifierParityValue>Decimal value

Usage: Query only

BUS<b>:LIN:FRAMe<n>:IDSTate?

Returns the identifier state of the selected frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<IdentifierState> OK | PRERror | UVAL | INSufficient

PRERror: parity error
UVAL: unexpected value
INSufficient: the frame is not completely contained in the acqui-
sition. The decoded part of the frame is valid.

Usage: Query only
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BUS<b>:LIN:FRAMe<n>:IDValue?

Returns the identifier value (address)

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<IdentifierValue> Decimal value

Usage: Query only

BUS<b>:LIN:FRAMe<n>:SYSTate?

Returns the state of the sync field for the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<SyncFieldState> OK | ERR | UNDF

ERR: error
UNDF: undefined

Usage: Query only

BUS<b>:LIN:FRAMe<n>:SYValue?

Returns the value of the synchronization field.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<SyncFieldValue> Decimal value

Usage: Query only

BUS<b>:LIN:FRAMe<n>:VERSion?

Returns the version of the LIN standard for the specified frame.
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Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<FrameVersion> V1X | V2X | UNK

UNK: Unknown

Usage: Query only

BUS<b>:LIN:FRAMe<n>:BCOunt?

Returns the number of data bytes in the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<ByteCount> Number of words (bytes)

Usage: Query only

BUS<b>:LIN:FRAMe<n>:BYTE<o>:STATe?

Returns the state of the specified data byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteStatus> OK | INS | UART

The byte is not completely contained in the acquisition
UART
At least one UART error occured. LIN uses UART words without
parity bit.

Usage: Query only
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BUS<b>:LIN:FRAMe<n>:BYTE<o>:VALue?

Returns the decimal value of the specified byte.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteValue> Decimal value

Usage: Query only

18.13.7.4 LIN - Search

SEARch:PROTocol:LIN:CONDition..................................................................................612
SEARch:PROTocol:LIN:FRAMe...................................................................................... 613
SEARch:PROTocol:LIN:IPERror......................................................................................613
SEARch:PROTocol:LIN:CHKSerror................................................................................. 614
SEARch:PROTocol:LIN:SYERror.....................................................................................614
SEARch:PROTocol:LIN:ICONdition................................................................................. 614
SEARch:PROTocol:LIN:IDENtifier................................................................................... 614
SEARch:PROTocol:LIN:DLENgth.................................................................................... 614
SEARch:PROTocol:LIN:DCONdition................................................................................ 615
SEARch:PROTocol:LIN:DATA.........................................................................................615

SEARch:PROTocol:LIN:CONDition <SearchCondition>

Sets the event or combination of events to be searched for. Depending on the selected
event, further settings are required.
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Parameters:
<SearchCondition> FRAMe | ERRor | IDENtifier | IDData | IDERror

FRAMe
Search for a frame type.
Set the frame type with SEARch:PROTocol:LIN:FRAMe.

ERRor
Search for errors of one or more error types.
Set the error types with SEARch:PROTocol:LIN:CHKSerror,
SEARch:PROTocol:LIN:IPERror, and SEARch:PROTocol:
LIN:SYERror.

IDENtifier
Search for identifier.
Specifiy the identifier with SEARch:PROTocol:LIN:
ICONdition and SEARch:PROTocol:LIN:IDENtifier.

IDData
Search for identifier and data.
Set the identifier (see IDENtifier) and the data with SEARch:
PROTocol:LIN:DLENgth, SEARch:PROTocol:LIN:
DCONdition, and SEARch:PROTocol:LIN:DATA.

IDERror
Search for errors that occur with a specified identifier. Set the
identifier (see IDENtifier) and the errors to be found (see
ERRor).
*RST: FRAM

SEARch:PROTocol:LIN:FRAMe <Frame>

Selects the frame type to be searched for.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to FRAMe.

Parameters:
<Frame> SOF | WAKeup

SOF: start of frame
WAKeup: Wakeup frame
*RST: SOF

SEARch:PROTocol:LIN:IPERror <IdParityError>

Searches for parity errors.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to ERRor or
IDERror.

Parameters:
<IdParityError> ON | OFF

*RST: OFF
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SEARch:PROTocol:LIN:CHKSerror <ChecksumError>

Searches for checksum errors.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to ERRor or
IDERror.

Parameters:
<ChecksumError> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:SYERror <SyncError>

Searches for synchronization errors.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to ERRor or
IDERror.

Parameters:
<SyncError> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:ICONdition <IdCondition>

Sets the comparison condition for the identifier: If the pattern contains at least one X
(don't care), you can trigger on values equal or not equal to the specified value. If the
pattern contains only 0 and 1, you can also trigger on a range greater than or lower
than the specified value.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to
IDENtifier, IDData or IDERror.

Parameters:
<IdCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:LIN:IDENtifier <Identifier>

Defines the identifier pattern.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to
IDENtifier, IDData or IDERror.

Parameters:
<Identifier> String containing binary pattern. Characters 0, 1, and X are

allowed. Enter the 6 bit identifier without parity bits, not the pro-
tected identifier.

SEARch:PROTocol:LIN:DLENgth <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.
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The command is relevant if SEARch:PROTocol:LIN:CONDition is set to IDData.

Parameters:
<DataLength> Range: 1  to  8

Increment: 1
*RST: 1
Default unit: Byte

SEARch:PROTocol:LIN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to IDData.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:LIN:DATA <Data>

Defines the data pattern. The pattern length is defined with SEARch:PROTocol:LIN:
DLENgth.

The command is relevant if SEARch:PROTocol:LIN:CONDition is set to IDData.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0,

1, and X are allowed. Make sure to enter complete bytes.

18.13.8 Audio Signals (Option R&S RTM-K5)

● Audio Signal Configuration....................................................................................615
● Audio Trigger.........................................................................................................621
● Track of Audio Signals.......................................................................................... 624
● Audio Decode Results...........................................................................................628

18.13.8.1 Audio Signal Configuration

BUS<b>:I2S:AVARiant................................................................................................... 616
BUS<b>:I2S:CLOCk:SOURce......................................................................................... 616
BUS<b>:I2S:CLOCk:POLarity......................................................................................... 616
BUS<b>:I2S:WSELect:SOURce...................................................................................... 617
BUS<b>:I2S:WSELect:POLarity...................................................................................... 617
BUS<b>:I2S:DATA:SOURce........................................................................................... 617
BUS<b>:I2S:DATA:POLarity........................................................................................... 618
BUS<b>:I2S:CLOCk:THReshold......................................................................................618
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BUS<b>:I2S:DATA:THReshold........................................................................................618
BUS<b>:I2S:WSELect:THReshold...................................................................................618
CHANnel<m>:THReshold:FINDlevel................................................................................ 618
BUS<b>:I2S:WLENgth................................................................................................... 619
BUS<b>:I2S:BORDer..................................................................................................... 619
BUS<b>:I2S:CHANnel:ORDer.........................................................................................619
BUS<b>:I2S:CHANnel:TDMCount................................................................................... 620
BUS<b>:I2S:CHANnel:LENGth....................................................................................... 620
BUS<b>:I2S:CHANnel:OFFSet........................................................................................620
BUS<b>:I2S:FOFFset.....................................................................................................620

BUS<b>:I2S:AVARiant <AudioVariant>

Selects the protocol variant of the audio signal.

See also: Chapter 11.7.1, "Audio Protocols", on page 252

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<AudioVariant> I2S | LJ | RJ | TDM | DSP

I2S: Inter-IC Sound standard audio format.
LJ: left justified data format
RJ: right justified data format
TDM: Time Division Multiplexed audio format to transfer up to 8
audio data channels on one line
*RST: I2S

BUS<b>:I2S:CLOCk:SOURce <ClockSource>

Selects the source of the clock line. All analog channels of the instrument can be used.
If MSO option R&S RTM-B1 is installed, you can use also one of the digital channels.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<ClockSource> CH1 | CH2 | CH3 | CH4 | D0..15

*RST: CH2

BUS<b>:I2S:CLOCk:POLarity <ClockSlope>

Sets the clock edge at which the instrument samples the data on the data line. Usually,
the rising edge is used. The R&S RTM can also analyze the converse setup.

Suffix: 
<b>

.
1..4
Selects the bus.
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Parameters:
<ClockSlope> RISing | FALLing

*RST: RIS

BUS<b>:I2S:WSELect:SOURce <WordSelectSource>

Selects the source of the word select line. All analog channels of the instrument can be
used. If MSO option R&S RTM-B1 is installed, you can use also one of the digital
channels.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<WordSelectSource> CH1 | CH2 | CH3 | CH4 | D0..15

*RST: CH1

BUS<b>:I2S:WSELect:POLarity <WordSelectPolarity>

For I²S, left and right justified signals, the polarity defines the word select values
assigned to the left and right channels.

For TDM) signals, the polarity defines the edge of the frame synchronization pulse that
identifies the beginning of a frame. The frame starts at the next clock edge following
the selected FSYNC edge.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<WordSelectPolarity> NORMal | INVert

NORMal
0 indicates the left channel, and 1 indicates the right channel.
This is the usual setting.
TDM: the frame begins with a rising edge. This is the usual set-
ting.
INVert
0 indicates the right channel, and 1 the left channel.
TDM: the frame begins with a falling edge.
*RST: NORM

BUS<b>:I2S:DATA:SOURce <DataSource>

Selects the source of the data line. All analog channels of the instrument can be used.
If MSO option R&S RTM-B1 is installed, you can use also one of the digital channels.
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Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<DataSource> CH1 | CH2 | CH3 | CH4 | D0..15

*RST: CH3

BUS<b>:I2S:DATA:POLarity <DataPolarity>

Defines the interpretation of high and low signal states.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<DataPolarity> ACTHigh | ACTLow

ACTHigh
Active high: HIGH (signal level above the threshold level) = 1
and LOW (signal level below the threshold level) = 0
ACTLow
Active low: HIGH = 0 and LOW = 1
*RST: ACTH

BUS<b>:I2S:CLOCk:THReshold <Threshold>
BUS<b>:I2S:DATA:THReshold <Threshold>
BUS<b>:I2S:WSELect:THReshold <Threshold>

Sets the threshold for the indicated audio line.

The commands have the same effect as CHANnel<m>:THReshold for analog chan-
nels. For digital channels, the threshold can be also set with DIGital<m>:
TECHnology or DIGital<m>:THReshold
Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<Threshold> Threshold voltage

*RST: 1.4

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all analog channels that are configured for the selected bus
and sets the threshold for digitization of analog signals for each channel.
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Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

BUS<b>:I2S:WLENgth <WordLength>

Defines the number of bits in an audio data word (receiver length).

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<WordLength> Range: The minimum length is 1bit, the maximum length is

the channel length.
*RST: 8
Default unit: Bit

BUS<b>:I2S:BORDer <BitOrder>

Sets the bit order in the audio data words. Usually, the MSB is transmitted first.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<BitOrder> MSBFirst | LSBFirst

MSBFirst: most significant bit is transmitted first
LSBFirst: least significant bit is transmitted first
*RST: MSBF

BUS<b>:I2S:CHANnel:ORDer <ChannelOrder>

Defines if the left or the right channel is the first channel in the frame.

The setting is available for I²S standard, left and right justified audio signals.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<ChannelOrder> LFIRst | RFIRst

LFIRst: left channel first
RFIRst: right channel first
*RST: LFIR
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BUS<b>:I2S:CHANnel:TDMCount <ChannelCount>

Sets the number of channels transmitted on the TDM audio line.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<ChannelCount> Range: 1  to  8

*RST: 8

BUS<b>:I2S:CHANnel:LENGth <ChannelLength>

Sets the number of bits in a channel block for TDM audio signals (transmitter length).

The setting is available only for TDM signals.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<ChannelLength> *RST: 8

Default unit: Bit

BUS<b>:I2S:CHANnel:OFFSet <ChannelOffset>

Sets the number of bits between the channel start and the start of the audio word. The
setting is available for left justified data format and TDM audio signals.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<ChannelOffset> For TDM, possible values depend on the channel lenght and the

word length. The maximum offset is Channel length - Word
length. If you change the channel lenght or the word length, the
channel offset is adjusted automatically.
For left justified data format, the maximum offset is 31.
*RST: 1
Default unit: Bit

BUS<b>:I2S:FOFFset <FrameOffset>

Sets a delay of the channel blocks after the frame start (word select edge). Thus, all
channels are shifted.

The setting is available only for TDM signals.
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Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<FrameOffset> Range: 0  to  31

*RST: 0
Default unit: Bit

18.13.8.2 Audio Trigger

TRIGger:A:SOURce....................................................................................................... 621
TRIGger:A:I2S:TYPE......................................................................................................622
TRIGger:A:I2S:CHANnel:LEFT:CONDition....................................................................... 623
TRIGger:A:I2S:CHANnel:RIGHt:CONDition...................................................................... 623
TRIGger:A:I2S:CHANnel:TDM<n>:CONDition...................................................................623
TRIGger:A:I2S:CHANnel:LEFT:DMIN...............................................................................623
TRIGger:A:I2S:CHANnel:RIGHt:DMIN..............................................................................623
TRIGger:A:I2S:CHANnel:TDM<n>:DMIN..........................................................................623
TRIGger:A:I2S:CHANnel:LEFT:DMAX..............................................................................623
TRIGger:A:I2S:CHANnel:RIGHt:DMAX............................................................................ 623
TRIGger:A:I2S:CHANnel:TDM<n>:DMAX.........................................................................623
TRIGger:A:I2S:FUNCtion................................................................................................624
TRIGger:A:I2S:SOWords................................................................................................ 624
TRIGger:A:I2S:WINDow:LENGth.....................................................................................624
TRIGger:A:I2S:WSELect:SLOPe..................................................................................... 624
TRIGger:A:I2S:WSSLope................................................................................................624

TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.
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Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE |

SBUS1 .. SBUS4 | D0..D15
CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available chan-
nels depend on the instrument type.
EXTernanalog
External trigger input on the rear panel
LINE
AC line for the edge trigger
SBUS1 .. SBUS4
Serial buses 1 to 4
The UART, SPI, SSPI and audio protocols require two bus lines
(bus 1 and 2 or bus 3 and 4). Bus 2 and/or bus 4 is not available
if one of these protocols is selected.
D0..D15
If MSO option R&S RTM-B1 is installed, the digital channels D0
to D15 can be used as trigger sources for edge, width and pat-
tern trigger.

TRIGger:A:I2S:TYPE <TriggerMode>

Specifies the trigger mode for audio signals.

Parameters:
<TriggerMode> DATA | WINDow | WSELect | ERRCondition

DATA
Triggers on a data word or a data range that occurs on a speci-
fied channel. You can also trigger on an AND combination of
data conditions on different channels.
Use the TRIG:A:I2S:CHANnel... commands to define the data
condition.
To set the logical combination to trigger on data words on differ-
ent channels, use TRIGger:A:I2S:FUNCtion.

WINDow
Triggers if the data conditions are fulfilled at least for the given
number of subsequent frames. Ues the data trigger commands
to define the data condition. Use TRIGger:A:I2S:WINDow:
LENGth to set the time limit.

WSELect
Sets the edge of the word select signal as trigger condition. Use
TRIGger:A:I2S:WSSLope to set the edge.

ERRCondition
An error is detected when two consecutive frames have different
length. The instrument triggers on the first clock edge after error
detection.
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TRIGger:A:I2S:CHANnel:LEFT:CONDition <Comparison>
TRIGger:A:I2S:CHANnel:RIGHt:CONDition <Comparison>
TRIGger:A:I2S:CHANnel:TDM<n>:CONDition <Comparison>

Define the operators for comparison of the decoded data words with the specified data
words on the specified channel.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | LTHan | INRange | OORange

INRange: in range
OORange: out of range
OFF
No range is defined.
EQUal | NEQual | GTHan | LTHan
Equal, not equal, greater than, less than. These conditions
require one data word to be set with TRIGger:A:I2S:
CHANnel:LEFT:DMIN, TRIGger:A:I2S:CHANnel:RIGHt:
DMIN, or TRIGger:A:I2S:CHANnel:TDM<n>:DMIN.

INRange | OORange
In range / Out of range: Set the minimum and maximum value of
the range with TRIGger:A:I2S:CHANnel:LEFT:DMIN
TRIG:A:I2S:CHANnel:...:DMIN and TRIGger:A:I2S:
CHANnel:TDM<n>:DMAXTRIG:A:I2S:CHANnel:...:DMAX.

TRIGger:A:I2S:CHANnel:LEFT:DMIN <MinimumValue>
TRIGger:A:I2S:CHANnel:RIGHt:DMIN <MinimumValue>
TRIGger:A:I2S:CHANnel:TDM<n>:DMIN <MinimumValue>

Specifies the data word to be found, or the minimum value of a data range.

The meaning depends on TRIGger:A:I2S:CHANnel:TDM<n>:CONDition.

Parameters:
<MinimumValue> The data format is decimal. The maximum value is limited by the

word length. Consider that audio words are signed numbers in
2's complement format. For example, an 8-bit data word has a
value range from -128 to 127.

TRIGger:A:I2S:CHANnel:LEFT:DMAX <MaximumValue>
TRIGger:A:I2S:CHANnel:RIGHt:DMAX <MaximumValue>
TRIGger:A:I2S:CHANnel:TDM<n>:DMAX <MaximumValue>

Specifies the maximum data value to be found.

The settin gis valid if TRIGger:A:I2S:CHANnel:TDM<n>:CONDition is set to
INRange or OORange.
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Parameters:
<MaximumValue> The data format is decimal. The maximum value is limited by the

word length. Consider that audio words are signed numbers in
2's complement format. For example, an 8-bit data word has a
value range from -128 to 127.

TRIGger:A:I2S:FUNCtion <Function>

Sets the logical combination to trigger on data words on different channels. The instru-
ment triggers if all conditions are met inside one frame.

The setting is relevant for trigger types data and window.

Parameters:
<Function> AND | OR

AND: the instrument triggers if the data conditions on all
selected channels are fulfilled.
OR: The instrument triggers if one of the specified data condi-
tions is fulfilled.

TRIGger:A:I2S:SOWords <WindowLength>
TRIGger:A:I2S:WINDow:LENGth <WindowLength>

Sets the number of subsequent frames (audio samples) for which the data conditions
are fulfilled.

Parameters:
<WindowLength> Number of frames

TRIGger:A:I2S:WSELect:SLOPe <WordSelectSlope>
TRIGger:A:I2S:WSSLope <WordSelectSlope>

Sets the edge of the word select signal as trigger condition. Consider the polarity set-
ting of the word select line (BUS<b>:I2S:WSELect:POLarity).

Parameters:
<WordSelectSlope> POS | NEG

POS: rising edge of the WS signal
NEG: falling edge of the WS signal

18.13.8.3 Track of Audio Signals

BUS<b>:I2S:DISPlay......................................................................................................625
BUS<b>:I2S:TRACk:LEFT:POSition................................................................................ 625
BUS<b>:I2S:TRACk:LEFT:SCALe...................................................................................626
BUS<b>:I2S:TRACk:RIGHt:POSition............................................................................... 626
BUS<b>:I2S:TRACk:RIGHt:SCALe..................................................................................626
BUS<b>:I2S:TRACk:TDM<o>:STATe.............................................................................. 627
BUS<b>:I2S:TRACk:TDM<o>:POSition............................................................................627
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BUS<b>:I2S:TRACk:TDM<o>:SCALe.............................................................................. 627
BUS<b>:I2S:TRACk:SET:DEFault................................................................................... 628
BUS<b>:I2S:TRACk:SET:SCReen...................................................................................628

BUS<b>:I2S:DISPlay <DisplayMode>

Defines how the decoded bus, the bit lines of the channels, and the track waveforms
are displayed.

Suffix: 
<b>

.
1..4
Selects the bus.

Parameters:
<DisplayMode> SEQuential | PARallel | STRack | PTRack | TRACk | SDSignal

SEQuential
The decoded data words of the channels are shown in sequen-
tial, horizontal order.
PARallel
The decoded data words of the channels are arranged vertically.
STRack
Sequential order of data words, and tracks
PTRack
Parallel order of data words, and tracks
TRACk
Only tracks
SDSignal
Sequential order of data words, and bit lines of the channels

BUS<b>:I2S:TRACk:LEFT:POSition <Position>

Sets the vertical positiion of the track waveform for the left channel in divisions. The
command is relevant for I²S standard, left justified and right justified audio formats.

The virtual screen is available also for tracks. Thus, 20 divisions can be used to
arrange all lines.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1
Not relevant

Parameters:
<Position> Range: -10  to  10

Increment: 0.05
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BUS<b>:I2S:TRACk:LEFT:SCALe <Scale>

Sets the vertical scale of the track waveform for the left channel in bits per division.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1
Not relevant

Parameters:
<Scale> Non-negative integer

Range: 2  to  4294967296
Increment: 2^n

BUS<b>:I2S:TRACk:RIGHt:POSition <Position>

Sets the vertical positiion of the track waveform for the right channel in divisions. The
command is relevant for I²S standard, left justified and right justified audio formats.

The virtual screen is available also for tracks. Thus, 20 divisions can be used to
arrange all lines.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1
Not relevant

Parameters:
<Position> Range: -10  to  10

Increment: 0.05

BUS<b>:I2S:TRACk:RIGHt:SCALe <Scale>

Sets the vertical scale of the track waveform for the right channel in bits per division.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1
Not relevant

Parameters:
<Scale> Non-negative integer

Range: 2  to  4294967296
Increment: 2^n
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BUS<b>:I2S:TRACk:TDM<o>:STATe <VisibleState>

Defines if the indicated track waveform is visible on the display.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1..8
Selects the TDM channel to be tracked.

Parameters:
<VisibleState> ON | OFF

*RST: OFF

BUS<b>:I2S:TRACk:TDM<o>:POSition <Position>

Sets the vertical positiion of the selected track waveform in divisions.

The virtual screen is available also for tracks. Thus, 20 divisions can be used to
arrange all lines.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1..8
Selects the TDM channel to be tracked.

Parameters:
<Position> Range: -10  to  10

Increment: 0.05

BUS<b>:I2S:TRACk:TDM<o>:SCALe <Scale>

Sets the vertical scale of the indicated track waveform in count of decimal values per
division: Scale = Maximum data value / Number of used divisions.

For example, the maximum decimal value of an 8-bit data word is 256. If all 8 divisions
of the display are used, the scale is 256 / 8 = 32 /div. If you want to display the track in
1/4 of the display height (2 divisions), the scale is 256 / 2= 128 /div. If the word length
is 10 bit, and 4 division are used for the track, the scale is 1024 / 4 = 256/div.

The resulting zoom factor is Word length / Scale. In the first example, the zoom factor
is 32 /32 = 1. In the second example, the zoom factor is 32 / 128 = 0.25. In the third
example, it is 10 / 256 = 0.0390625.

Suffix: 
<b>

.
1..4
Selects the bus.

<o> 1..8
Selects the TDM channel to be tracked.
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Parameters:
<Scale> Non-negative integer

Range: 2  to  4294967296
Increment: 2^n

BUS<b>:I2S:TRACk:SET:DEFault

Sets all selected tracks to the middle of the display and scales them to full height of the
display (8 dovisions). The track waveforms overlap.

Usage: Event

BUS<b>:I2S:TRACk:SET:SCReen

Arranges the selected tracks vertically, one above the other. The track waveforms do
not overlap.

Usage: Event

18.13.8.4 Audio Decode Results

BUS<b>:I2S:FCOunt?.................................................................................................... 628
BUS<b>:I2S:FRAMe<n>:STATe?....................................................................................628
BUS<b>:I2S:FRAMe<n>:STARt?.....................................................................................629
BUS<b>:I2S:FRAMe<n>:STOP?..................................................................................... 629
BUS<b>:I2S:FRAMe<n>:LEFT:STATe?........................................................................... 630
BUS<b>:I2S:FRAMe<n>:RIGHt:STATe?.......................................................................... 630
BUS<b>:I2S:FRAMe<n>:LEFT:VALue?............................................................................630
BUS<b>:I2S:FRAMe<n>:RIGHt:VALue?.......................................................................... 630
BUS<b>:I2S:FRAMe<n>:TDM<o>:STATe?...................................................................... 630
BUS<b>:I2S:FRAMe<n>:TDM<o>:VALue?.......................................................................631

BUS<b>:I2S:FCOunt?

Returns the number of acquired frames.

Suffix: 
<b>

.
1..4
Selects the bus.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:I2S:FRAMe<n>:STATe?

Returns the overall state of the specified frame.
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Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<FrameState> ERRor | OK | INSufficient

ERRor: an error occured in the frame.
OK: frame is valid.
INSufficient: frame is not completely contained in the acquisition.
The acquired part of the frame is valid.

Usage: Query only

BUS<b>:I2S:FRAMe<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:I2S:FRAMe<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:I2S:FRAMe<n>:LEFT:STATe?
BUS<b>:I2S:FRAMe<n>:RIGHt:STATe?
Returns the state of the specified frame on the right or left audio channel.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<State> ERRor | OK | INSufficient

ERRor: an error occured in the frame.
OK: frame is valid.
INSufficient: frame is not completely contained in the acquisition.
The acquired part of the frame is valid.

Usage: Query only

BUS<b>:I2S:FRAMe<n>:LEFT:VALue?
BUS<b>:I2S:FRAMe<n>:RIGHt:VALue?
Returns the data word of the specified frame on the right or left audio channel.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

Return values: 
<Value> Signed decimal value

Usage: Query only

BUS<b>:I2S:FRAMe<n>:TDM<o>:STATe?

Returns the state of the specified TDM channel and frame.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

<o> 1..8
Selects the TDM channel
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Return values: 
<State> ERRor | OK | INSufficient

ERRor: an error occured in the frame.
OK: frame is valid.
INSufficient: frame is not completely contained in the acquisition.
The acquired part of the frame is valid.

Usage: Query only

BUS<b>:I2S:FRAMe<n>:TDM<o>:VALue?

Returns the data word of the specified frame on the selected TDM channel.

Suffix: 
<b>

.
1..4
Selects the bus.

<n> *
Selects the frame (1...n).

<o> 1..8
Selects the TDM channel

Return values: 
<Value> Signed decimal value

Usage: Query only

18.13.9 MIL_STD-1553 (Option R&S RTM-K6)

The MIL-STD-1553 defines the characteristics of a serial data bus originally designed
for the use in the millitary avionics. Nowadays it is also used in spacecraft on-board
data handling.

● MIL_STD-1553 Configuration............................................................................... 631
● MIL_STD-1553 Trigger......................................................................................... 633
● MIL_STD-1553 Decode Results........................................................................... 640
● MIL-STD-1553 Search.......................................................................................... 646

18.13.9.1 MIL_STD-1553 Configuration

BUS<b>:MILStd:POLarity............................................................................................... 631
BUS<b>:MILStd:RESPonsetime:MAXimum...................................................................... 632
BUS<b>:MILStd:SOURce............................................................................................... 632
BUS<b>:MILStd:THReshold:HIGH...................................................................................632
BUS<b>:MILStd:THReshold:LOW................................................................................... 632

BUS<b>:MILStd:POLarity <Polarity>

Sets the polarity of the bus.
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Suffix: 
<b>

.
1..4

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

BUS<b>:MILStd:RESPonsetime:MAXimum <MaximumTime>

Sets a value for the maximum response time.

Suffix: 
<b>

.
1..4

Parameters:
<MaximumTime>

BUS<b>:MILStd:SOURce <Source>

Sets the channel for the signal source.

Suffix: 
<b>

.
1..4

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

BUS<b>:MILStd:THReshold:HIGH <UpperLevel>

Sets the upper threshold level of the signal.

Suffix: 
<b>

.
1..4

Parameters:
<UpperLevel>

BUS<b>:MILStd:THReshold:LOW <LowerLevel>

Sets the lower threshold level of the signal.

Suffix: 
<b>

.
1..4

Parameters:
<LowerLevel>
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18.13.9.2 MIL_STD-1553 Trigger

● General commands...............................................................................................633
● Error Trigger..........................................................................................................633
● Command Word Trigger........................................................................................634
● Satus Word Trigger...............................................................................................637
● Data Word Triggger...............................................................................................638
● Command and Data Trigger..................................................................................639

General commands

TRIGger:A:MILStd:SYNC <SyncMode>

Triggers on a sync impulse. You can select to trigger on comando/status, on data or on
either syncs.

Parameters:
<SyncMode> CSTatus | DATA | EITHer

*RST: CST

TRIGger:A:MILStd:TYPE <TriggerMode>

Selects the type of trigger.

Parameters:
<TriggerMode> SYNChronization | FRAME | ERRor | COMMand | STATus |

DATA
*RST: SYNC

TRIGger:A:MILStd:WORD <WordTyoe>

Selects the word type to be triggered on.

Parameters:
<WordTyoe> COMMand | STATus | DATA | ALL

*RST: CST

Error Trigger

TRIGger:A:MILStd:ERRor:MANChester <ErrorEnable>

Enables/disables triggering if there is an error in the Manchester coding of the signal.

Parameters:
<ErrorEnable> ON | OFF

*RST: ON

TRIGger:A:MILStd:ERRor:PARity <ErrorEnable>

Enables/disables triggering when the parity is even.
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Parameters:
<ErrorEnable> ON | OFF

*RST: ON

TRIGger:A:MILStd:ERRor:SYNC <ErrorEnable>

Enables/disables triggering when a sync impulse doesn't fulfil the technical require-
ments or when the transmission is not valid.

Parameters:
<ErrorEnable> ON | OFF

*RST: ON

TRIGger:A:MILStd:ERRor:TIMeout <ErrorEnable>

Enables/ disables triggering when the timeout is out of the set range.

Parameters:
<ErrorEnable> ON | OFF

*RST: ON

Command Word Trigger

TRIGger:A:MILStd:COMMand:TYPE <CommandType>

Triggers on a command type.

Parameters:
<CommandType> AWORd | MCODe

AWORd
Triggers on an address or word count
MCODe
Triggers on a mode code
*RST: AWOR

TRIGger:A:MILStd:MCODe:CODE <ModeCode>

Sets a function for the mode code to be triggered on.
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Parameters:
<ModeCode> DBControl | TSYNchronize | TSTatus | ISELftest | TSHutdown |

OTSHutdown | ITERminal | OITerminal | RESet | VECTor |
RSYNchronize | TLAStcmmand | BITWord | STSHutdown |
OSTShutdown | ANY
DBControl: dynamic bus control
TSYNchronize: synchronize without data
TSTatus: transmit status word
ISELftest: initiate self test
TSHutdown: transmitter shutdown
OTSHutdown: override transmitter shutdown
ITERminal: inhibit terminal flag
OITerminal: override inhibit terminal flag
RESet: reset remote terminal
VECTor: transmit vector word
RSYNchronize: synchronize with data
TLAStcmmand: transmit last command word
BITWord: transmit bit word
STSHutdown: selected transmitter shutdown
OSTShutdown: override selected transmitter shutdown
*RST: ANY

TRIGger:A:MILStd:MCODe:VALue <ModeCode>

Sets the value of the mode code to be triggered on.

Parameters:
<ModeCode>

TRIGger:A:MILStd:RTADdress:CONDition <Compare>

For the RT address, sets the triggering condition for the comparison of the decoded
value to the defined range.

Parameters:
<Compare> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide
*RST: OFF

TRIGger:A:MILStd:RTADdress:MAXimum <AddressMaximum>

Sets the maximum RT address.

Parameters:
<AddressMaximum> 01X-string

TRIGger:A:MILStd:RTADdress:MINimum <AddressMinimum>

Sets the minimum RT address.
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Parameters:
<AddressMinimum> 01X-string

TRIGger:A:MILStd:SADDress:CONDition <Compare>

For the subaddress, sets the triggering condition for the comparison of the decoded
value to the defined range.

Parameters:
<Compare> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide
*RST: OFF

TRIGger:A:MILStd:SADDress:MAXimum <AddressMaximum>

Sets the maximum subaddress.

Parameters:
<AddressMaximum> 01X-string

TRIGger:A:MILStd:SADDress:MCADdress <ModeCodeAddress>

Triggers on the value of the subaddress, if TRIGger:A:MILStd:COMMand:TYPE is
set to mode code.

Parameters:
<ModeCodeAddress> A0 | A31 | EITHer

*RST: EITH

TRIGger:A:MILStd:SADDress:MINimum <AddressMinimum>

Sets the minimum subaddress.

Parameters:
<AddressMinimum> 01X-string

TRIGger:A:MILStd:TRMode <DataDirection>

Triggers on a transmission mode.

Parameters:
<DataDirection> TRANsmit | RECeive | EITHer

*RST: EITH

TRIGger:A:MILStd:WCOunt:CONDition <Compare>

For a command word, triggers on a word comparison condition.
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Parameters:
<Compare> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide
*RST: OFF

TRIGger:A:MILStd:WCOunt:MAXimum <WordCountMaximum>

For a command word, triggers on a maximum word count.

Parameters:
<WordCountMaximum>

TRIGger:A:MILStd:WCOunt:MINimum <WordCountMinimum>

For a command word, triggers on a minimum word count.

Parameters:
<WordCountMinimum>

Satus Word Trigger

TRIGger:A:MILStd:STATus:BCReceived <StatusBit>

Triggers on the state of the broadcast command received bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:BUSY <StatusBit>

Triggers on the state of the busy bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:DBCaccept <StatusBit>

Triggers on the state of the dynamic bus control accept bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:INSTrument <StatusBit>

Triggers on the state of the instrumentation bit of the status word.
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Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:MERRor <StatusBit>

Triggers on the state of the message error bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:SREQuest <StatusBit>

Triggers on the state of the service request bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:SUBSystem <StatusBit>

Triggers on the state of the subsystem flag bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

TRIGger:A:MILStd:STATus:TERMinal <StatusBit>

Triggers on the state of the terminal flag bit of the status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

Data Word Triggger

TRIGger:A:MILStd:DATA:CONDition <Compare>

For a data word, sets the triggering condition for the comparison of the decoded value
to the defined range.

Parameters:
<Compare> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide
*RST: OFF
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TRIGger:A:MILStd:DATA:MAXimum <DataMinimum>

For a data word, sets the maximum data value.

Parameters:
<DataMinimum> 01X-string

TRIGger:A:MILStd:DATA:MINimum <DataMinimum>

For a data word, sets the minimum data value.

Parameters:
<DataMinimum> 01X-string

TRIGger:A:MILStd:DATA:OFFSet <DataOffset>

For a data word sets the word offset to be triggered on.

Parameters:
<DataOffset> *RST: 0

TRIGger:A:MILStd:DATA:OFFSet:CONDition <DataOffset>

For a data offset, sets the triggering condition for the comparison of the decoded value
to the defined range.

Parameters:
<DataOffset> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan

*RST: 0

TRIGger:A:MILStd:DATA:WORDs <DataWords>

For a data word sets the number of words to be triggered on.

Parameters:
<DataWords> *RST: 1

Command and Data Trigger

TRIGger:A:MILStd:TTYPe <TransmissionType>

Sets the transmission type to be triggered on.
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Parameters:
<TransmissionType> BCRT | RTBC | RTRT | MCData

BCRT
bus controller to remote terminal transmission
RTBC
remote terminal to bus controller transmission
RTRT
remote terminal to remote terminal transmission
MCData
mode code data
*RST: BCRT

18.13.9.3 MIL_STD-1553 Decode Results

BUS<b>:MILStd:WCOunt?..............................................................................................640
BUS<b>:MILStd:WORD<n>:COMMand:MCODe:CODE?...................................................641
BUS<b>:MILStd:WORD<n>:COMMand:MCODe:VALue?...................................................641
BUS<b>:MILStd:WORD<n>:COMMand:RTADdress?........................................................ 641
BUS<b>:MILStd:WORD<n>:COMMand:SADDress?..........................................................641
BUS<b>:MILStd:WORD<n>:COMMand:WCOunt?............................................................ 642
BUS<b>:MILStd:WORD<n>:DATA?.................................................................................642
BUS<b>:MILStd:WORD<n>:IMGTime?............................................................................ 642
BUS<b>:MILStd:WORD<n>:PARity?................................................................................642
BUS<b>:MILStd:WORD<n>:RTIMe?................................................................................643
BUS<b>:MILStd:WORD<n>:STARt?................................................................................643
BUS<b>:MILStd:WORD<n>:STATus?..............................................................................643
BUS<b>:MILStd:WORD<n>:STATus:BCReceived?...........................................................643
BUS<b>:MILStd:WORD<n>:STATus:BUSY?....................................................................644
BUS<b>:MILStd:WORD<n>:STATus:DBCaccept?............................................................ 644
BUS<b>:MILStd:WORD<n>:STATus:INSTrument?........................................................... 644
BUS<b>:MILStd:WORD<n>:STATus:MERRor?................................................................ 644
BUS<b>:MILStd:WORD<n>:STATus:RTADdress?............................................................ 645
BUS<b>:MILStd:WORD<n>:STATus:SREQuest?............................................................. 645
BUS<b>:MILStd:WORD<n>:STATus:SUBSystem?........................................................... 645
BUS<b>:MILStd:WORD<n>:STATus:TERMinal?...............................................................645
BUS<b>:MILStd:WORD<n>:STOP?.................................................................................646
BUS<b>:MILStd:WORD<n>:TRMode?.............................................................................646
BUS<b>:MILStd:WORD<n>:TYPE?.................................................................................646

BUS<b>:MILStd:WCOunt?

Returns the number of received words.

Suffix: 
<b>

.
1..4

Return values: 
<WordCount>

Usage: Query only
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BUS<b>:MILStd:WORD<n>:COMMand:MCODe:CODE?

For the sepcified command word, returns the type of mode code.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<ModeCode> DBControl | TSYNchronize | TSTatus | ISELftest | TSHutdown |

OTSHutdown | ITERminal | OITerminal | RESet | VECTor |
RSYNchronize | TLAStcmmand | BITWord | STSHutdown |
OSTShutdown
*RST: ANY

Usage: Query only

BUS<b>:MILStd:WORD<n>:COMMand:MCODe:VALue?

For the specified command word, returns the value of the mode code.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<ModeCodeValue>

Usage: Query only

BUS<b>:MILStd:WORD<n>:COMMand:RTADdress?

Returns the RT address of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<RTAddress>

Usage: Query only

BUS<b>:MILStd:WORD<n>:COMMand:SADDress?

For a command word, returns the subaddress of the specified word.

Suffix: 
<b>

.
1..4

<n> *
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Return values: 
<SubAddress>

Usage: Query only

BUS<b>:MILStd:WORD<n>:COMMand:WCOunt?

For a command word, returns the word count.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<WordCount>

Usage: Query only

BUS<b>:MILStd:WORD<n>:DATA?

Returns the value of the specified data word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<DataValue>

Usage: Query only

BUS<b>:MILStd:WORD<n>:IMGTime?

Returns the intermessage gate time of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<InterMessageGapTime>

Usage: Query only

BUS<b>:MILStd:WORD<n>:PARity?

Returns the parity of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Protocol Analysis



Remote Commands ReferenceR&S®RTM2000

643User Manual 1317.4726.02 ─ 10

Return values: 
<ParityValue>

Usage: Query only

BUS<b>:MILStd:WORD<n>:RTIMe?

Return the response time of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<ResponseTime>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STARt?

Returns the start time of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<StartTime>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus?

For a status word returns the value and if there are errors.

Suffix: 
<b>

.
1..4

<n> *

Parameters:
<WordState> OK | INSufficient | PERRor | MERRor | TERRor | SERRor

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:BCReceived?

Returns the state of the broadcast command received bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *
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Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:BUSY?

Returns the state of the busy bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:DBCaccept?

Returns the state of the dynamic bus control bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:INSTrument?

Returns the state of the instrumentation bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:MERRor?

Returns the state of the message error bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *
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Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:RTADdress?

Returns the RT address of the specified status word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<RTAddress>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:SREQuest?

Returns the state of the service request bit of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:SUBSystem?

Returns the state of the subsystem bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STATus:TERMinal?

Returns the state of the terminal flag bit of the specified status word.

Suffix: 
<b>

.
1..4

<n> *
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Return values: 
<BitState>

Usage: Query only

BUS<b>:MILStd:WORD<n>:STOP?

Returns the stop time of the word of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<StopTime>

Usage: Query only

BUS<b>:MILStd:WORD<n>:TRMode?

Returns the transmission direction of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<DataDirection> TRANsmit | RECeive

Usage: Query only

BUS<b>:MILStd:WORD<n>:TYPE?

Returns the type of word of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Return values: 
<WordType> COMMand | STATus | DATA | CMCode

Usage: Query only

18.13.9.4 MIL-STD-1553 Search

SEARch:PROTocol:MILStd:CONDition.............................................................................647
SEARch:PROTocol:MILStd:DATA:COMPare.................................................................... 647
SEARch:PROTocol:MILStd:DATA:CONDition................................................................... 648
SEARch:PROTocol:MILStd:DATA:MAXimum....................................................................648
SEARch:PROTocol:MILStd:DATA:MINimum.....................................................................648
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SEARch:PROTocol:MILStd:DATA:OFFSet....................................................................... 648
SEARch:PROTocol:MILStd:DATA:WORDs.......................................................................648
SEARch:PROTocol:MILStd:ERRor.................................................................................. 648
SEARch:PROTocol:MILStd:MCODe................................................................................ 648
SEARch:PROTocol:MILStd:RTADdress:COMPare............................................................ 649
SEARch:PROTocol:MILStd:RTADdress:CONDition........................................................... 649
SEARch:PROTocol:MILStd:RTADdress:MAXimum............................................................649
SEARch:PROTocol:MILStd:RTADdress:MINimum.............................................................649
SEARch:PROTocol:MILStd:SADDress:COMPare..............................................................649
SEARch:PROTocol:MILStd:SADDress:CONDition.............................................................650
SEARch:PROTocol:MILStd:SADDress:MAXimum............................................................. 650
SEARch:PROTocol:MILStd:SADDress:MCADdress...........................................................650
SEARch:PROTocol:MILStd:SADDress:MINimum.............................................................. 650
SEARch:PROTocol:MILStd:STATus:BCReceived..............................................................650
SEARch:PROTocol:MILStd:STATus:BUSY.......................................................................650
SEARch:PROTocol:MILStd:STATus:DBCaccept............................................................... 651
SEARch:PROTocol:MILStd:STATus:INSTrument.............................................................. 651
SEARch:PROTocol:MILStd:STATus:MERRor................................................................... 651
SEARch:PROTocol:MILStd:STATus:SREQuest................................................................ 651
SEARch:PROTocol:MILStd:STATus:SUBSystem.............................................................. 651
SEARch:PROTocol:MILStd:STATus:TERMinal................................................................. 651
SEARch:PROTocol:MILStd:TRMode................................................................................652
SEARch:PROTocol:MILStd:TTYPe.................................................................................. 652
SEARch:PROTocol:MILStd:WSTart................................................................................. 652
SEARch:PROTocol:MILStd:WCOunt:COMPare................................................................ 652
SEARch:PROTocol:MILStd:WCOunt:CONDition............................................................... 652
SEARch:PROTocol:MILStd:WCOunt:MAXimum................................................................653
SEARch:PROTocol:MILStd:WCOunt:MINimum.................................................................653

SEARch:PROTocol:MILStd:CONDition <SearchCondition>

Selects the condition to be searched for.

Parameters:
<SearchCondition> WSTart | ERRor | STATus | DATA | COMMand | MCODe |

CDATa
*RST: WST

SEARch:PROTocol:MILStd:DATA:COMPare <Comparison>

For a data word, searches for a comparison condition.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF
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SEARch:PROTocol:MILStd:DATA:CONDition <Comparison>

For a data word, searches for a comparison condition.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF

SEARch:PROTocol:MILStd:DATA:MAXimum <DataMaximum>

For a data word, searches for a maximum value.

Parameters:
<DataMaximum> 01X-string

SEARch:PROTocol:MILStd:DATA:MINimum <DataMinimum>

For a data word, searches for a minimum value.

Parameters:
<DataMinimum> 01X-string

SEARch:PROTocol:MILStd:DATA:OFFSet <DataOffset>

For a data word, searches for a data offset.

Parameters:
<DataOffset> *RST: 0

SEARch:PROTocol:MILStd:DATA:WORDs <DataWords>

For a data word, searches for a number of words.

Parameters:
<DataWords> *RST: 1

SEARch:PROTocol:MILStd:ERRor <ErrorType>

Selects the error type to be searched for.

Parameters:
<ErrorType> SYNChronization | PARity | TIMeout | MANChester | ANY

SEARch:PROTocol:MILStd:MCODe <ModeCode>

Searches for a mode code type.
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Parameters:
<ModeCode> DBControl | TSYNchronize | TSTatus | ISELftest | TSHutdown |

OTSHutdown | ITERminal | OITerminal | RESet | VECTor |
RSYNchronize | TLAStcmmand | BITWord | STSHutdown |
OSTShutdown | ANY
*RST: ANY

SEARch:PROTocol:MILStd:RTADdress:COMPare <Comparison>

For an RT address, searches for a comparison condition.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF

SEARch:PROTocol:MILStd:RTADdress:CONDition <Comparison>

For an RT address, searches for a comparison condition.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF

SEARch:PROTocol:MILStd:RTADdress:MAXimum <AddressMaximum>

For an RT address, searches for the maximum address.

Parameters:
<AddressMaximum> 01X-string

SEARch:PROTocol:MILStd:RTADdress:MINimum <AddressMinimum>

For an RT address, searches for the minimum address.

Parameters:
<AddressMinimum> 01X-string

SEARch:PROTocol:MILStd:SADDress:COMPare <Comparison>

For a subaddress, searches for a comparison condition.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF
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SEARch:PROTocol:MILStd:SADDress:CONDition <Comparison>

For a subaddress, searches for a comparison condition.

Parameters:
<Comparison> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF

SEARch:PROTocol:MILStd:SADDress:MAXimum <AddressMaximum>

For a subaddress, searches for the maximum address.

Parameters:
<AddressMaximum> 01X-string

SEARch:PROTocol:MILStd:SADDress:MCADdress <ModeCodeAddress>

Searches for a mode code address.

Parameters:
<ModeCodeAddress> A0 | A31 | EITHer

*RST: EITH

SEARch:PROTocol:MILStd:SADDress:MINimum <AddressMinimum>

For a subaddress, searches for the minimum address.

Parameters:
<AddressMinimum> 01X-string

SEARch:PROTocol:MILStd:STATus:BCReceived <StatusBit>

Searches for a broadcast received bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

SEARch:PROTocol:MILStd:STATus:BUSY <StatusBit>

Searches for a busy bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X
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SEARch:PROTocol:MILStd:STATus:DBCaccept <StatusBit>

Searches for a dynamic bus control accept bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

SEARch:PROTocol:MILStd:STATus:INSTrument <StatusBit>

Searches for an instrument bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

SEARch:PROTocol:MILStd:STATus:MERRor <StatusBit>

Searches for a message error bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

SEARch:PROTocol:MILStd:STATus:SREQuest <StatusBit>

Searches for a service request bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

SEARch:PROTocol:MILStd:STATus:SUBSystem <StatusBit>

Searches for a subsystem bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X

SEARch:PROTocol:MILStd:STATus:TERMinal <StatusBit>

Searches for a terminal bit of a status word.

Parameters:
<StatusBit> 0 | 1 | X

*RST: X
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SEARch:PROTocol:MILStd:TRMode <DataDirection>

Selects the transmission mode to be searched for.

Parameters:
<DataDirection> TRANsmit | RECeive | EITHer

*RST: EITH

SEARch:PROTocol:MILStd:TTYPe <TransmissionType>

Selects the transmission type to be searched for.

Parameters:
<TransmissionType> BCRT | RTBC | RTRT | MCData

BCRT
bus controller to remote terminal transmission
RTBC
remote terminal to bus controller transmission
RTRT
remote terminal to remote terminal transmission
MCData
mde code with data
*RST: BCRT

SEARch:PROTocol:MILStd:WSTart <WordStart>

Selects a word start to be searched for.

Parameters:
<WordStart> COMMand | STATus | DATA

*RST: COMM

SEARch:PROTocol:MILStd:WCOunt:COMPare <Compare>

Searches for a comparison condition of the word count.

Parameters:
<Compare> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF

SEARch:PROTocol:MILStd:WCOunt:CONDition <Compare>

Searches for a comparison condition of the word count.
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Parameters:
<Compare> OFF | EQUal | NEQual | GTHan | GEQual | LEQual | LTHan |

WITHin | OUTSide
*RST: OFF

SEARch:PROTocol:MILStd:WCOunt:MAXimum <WordCountMaximum>

Searches for the maximum word count.

Parameters:
<WordCountMaximum>

SEARch:PROTocol:MILStd:WCOunt:MINimum <WordCountMinimum>

Searches for the minimum word count.

Parameters:
<WordCountMinimum>

18.13.10 ARINC 429 (Option R&S RTM-K7)

18.13.10.1 ARINC 429 - Configuration

BUS<b>:ARINc:BRMode................................................................................................ 653
BUS<b>:ARINc:BRValue................................................................................................ 653
BUS<b>:ARINc:POLarity................................................................................................ 654
BUS<b>:ARINc:SOURce................................................................................................ 654
BUS<b>:ARINc:THReshold:HIGH....................................................................................654
BUS<b>:ARINc:THReshold:LOW.................................................................................... 654

BUS<b>:ARINc:BRMode <BitRateMode>

Sets the bit rate mode to high speed, low speed or a user defined mode.

If USER mode is selected, you can set the bit rate value with BUS<b>:ARINc:
BRValue.

Parameters:
<BitRateMode> HIGH | LOW | USER

BUS<b>:ARINc:BRValue <BitRateValue>

Sets the number of transmitted bits per second.

If you set a value with this command, the mode of BUS<b>:ARINc:BRMode will be
automatically set to USER.
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Parameters:
<BitRateValue>

BUS<b>:ARINc:POLarity <Polarity>

Sets the wire on which the bus signal is measured.

Parameters:
<Polarity> ALEG | BLEG | NORMal | INVerted

*RST: ALEG

BUS<b>:ARINc:SOURce <Source>

Sets the channel for the signal source.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

BUS<b>:ARINc:THReshold:HIGH <ThresholdHigh>

Sets the high threshold level of the signal.

Parameters:
<ThresholdHigh>

BUS<b>:ARINc:THReshold:LOW <ThresholdLow>

Sets the low threshold level of the signal.

Parameters:
<ThresholdLow>

18.13.10.2 ARINC 429 - Trigger

TRIGger:A:ARINc:DATA:CONDition.................................................................................655
TRIGger:A:ARINc:DATA:MAXimum................................................................................. 655
TRIGger:A:ARINc:DATA:MINimum.................................................................................. 655
TRIGger:A:ARINc:DATA:OFFSet.....................................................................................655
TRIGger:A:ARINc:DATA:SIZE.........................................................................................656
TRIGger:A:ARINc:ERRor:CODing................................................................................... 656
TRIGger:A:ARINc:ERRor:GAP........................................................................................ 656
TRIGger:A:ARINc:ERRor:PARity..................................................................................... 656
TRIGger:A:ARINc:FORMat............................................................................................. 656
TRIGger:A:ARINc:LABel:CONDition.................................................................................656
TRIGger:A:ARINc:LABel:MAXimum................................................................................. 657
TRIGger:A:ARINc:LABel:MINimum.................................................................................. 657
TRIGger:A:ARINc:SDI.................................................................................................... 657
TRIGger:A:ARINc:SSM...................................................................................................657
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TRIGger:A:ARINc:TTIMe:CONDition................................................................................658
TRIGger:A:ARINc:TTIMe:MAXimum................................................................................ 658
TRIGger:A:ARINc:TTIMe:MINimum................................................................................. 658
TRIGger:A:ARINc:TYPE................................................................................................. 658
TRIGger:A:ARINc:WORD:TYPE......................................................................................658

TRIGger:A:ARINc:DATA:CONDition <Compare>

Define the operators for comparison of the decoded data condition with the specified
data.

Parameters:
<Compare> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide
INRange: in range
OORange: out of range
OFF
No range is defined.
EQUal | NEQual | GTHan | LTHan
Equal, not equal, greater than, less than. These conditions
require one data word to be set with TRIGger:A:ARINc:
DATA:MINimum.

INRange | OORange
In range / Out of range: Set the minimum and maximum value of
the range with TRIGger:A:ARINc:DATA:MINimum and
TRIGger:A:ARINc:DATA:MAXimum.

TRIGger:A:ARINc:DATA:MAXimum <DataMaximum>

Specifies the maximum value of the data if TRIGger:A:ARINc:DATA:CONDition is
set to INRange or OORange.

Parameters:
<DataMaximum> 01X-string

TRIGger:A:ARINc:DATA:MINimum <DataMinimum>

Sets the minimum condition for the data.

Parameters:
<DataMinimum> 01X-string

TRIGger:A:ARINc:DATA:OFFSet <DataOffset>

Sets a data offset.

Parameters:
<DataOffset>
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TRIGger:A:ARINc:DATA:SIZE <DataSize>

Sets the data size.

Parameters:
<DataSize>

TRIGger:A:ARINc:ERRor:CODing <ErrorEnable>

Enables triggering when a coding error occurs.

Parameters:
<ErrorEnable> ON | OFF

*RST: ON

TRIGger:A:ARINc:ERRor:GAP <ErrorEnable>

Enables triggering when a gap error occurs.

Parameters:
<ErrorEnable> ON | OFF

*RST: ON

TRIGger:A:ARINc:ERRor:PARity <ErrorEnable>

Enables triggering when a parity error occurs.

Parameters:
<ErrorEnable> ON | OFF

*RST: ON

TRIGger:A:ARINc:FORMat <DataFormat>

Sets the the transmission format to be triggered on.

Parameters:
<DataFormat> DATA | DSSM | DSDI | DSSSm

DSSM: SSM+Data
DSDI: SDI+Data
DSSSm: SSM+Data +SDI

TRIGger:A:ARINc:LABel:CONDition <Compare>

Define the operators for comparison of the decoded label condition with the specified
label.

Protocol Analysis



Remote Commands ReferenceR&S®RTM2000

657User Manual 1317.4726.02 ─ 10

Parameters:
<Compare> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide
INRange: in range
OORange: out of range

OFF
No range is defined.
EQUal | NEQual | GTHan | LTHan
Equal, not equal, greater than, less than. These conditions
require one label to be set with TRIGger:A:ARINc:LABel:
MINimum.

INRange | OORange
In range / Out of range: Set the minimum and maximum value of
the range with TRIGger:A:ARINc:LABel:MINimum and
TRIGger:A:ARINc:LABel:MAXimum.

TRIGger:A:ARINc:LABel:MAXimum <LabelMaximum>

Specifies the maximum value of the label if TRIGger:A:ARINc:LABel:CONDition
is set to INRange or OORange.

Parameters:
<LabelMaximum> 01X-string

TRIGger:A:ARINc:LABel:MINimum <LabelMinimum>

Sets the minimum value of the label to be triggerd on.

Parameters:
<LabelMinimum> 01X-string

TRIGger:A:ARINc:SDI <SDIvalue>

Sets the source/destination identifier (SDI) bits to be triggered on.

Parameters:
<SDIvalue> ANY | S00 | S01 | S10 | S11

TRIGger:A:ARINc:SSM <SSMvalue>

Sets the sign/status matrix (SSM) bits to be triggered on.

Parameters:
<SSMvalue> ANY | S00 | S01 | S10 | S11
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TRIGger:A:ARINc:TTIMe:CONDition <Compare>

Define the operators for comparison of the decoded transmission time condition with
the specified data.

Parameters:
<Compare> GTHan | LTHan | WITHin | OUTSide

*RST: GTH

TRIGger:A:ARINc:TTIMe:MAXimum <TransmissionTimeMax>

Sets the maximum value of the transmission time.

Parameters:
<TransmissionTimeMax>

TRIGger:A:ARINc:TTIMe:MINimum <TransmissionTimeMin>

Sets the minimum value of the transmission time.

Parameters:
<TransmissionTimeMin>

TRIGger:A:ARINc:TYPE <TriggerType>

Selects the type of trigger.

Parameters:
<TriggerType> WORD | ERRor | LABel | LDATa | TTIMe

TRIGger:A:ARINc:WORD:TYPE <WordType>

Sets the word type to be triggered on.

Parameters:
<WordType> STARt | STOP

18.13.10.3 ARINC 429 - Decode Results

BUS<b>:ARINc:WCOunt?...............................................................................................659
BUS<b>:ARINc:DATA:FORMat....................................................................................... 659
BUS<b>:ARINc:WORD<n>:DATA?..................................................................................659
BUS<b>:ARINc:WORD<n>:DATA[:VALue]?..................................................................... 659
BUS<b>:ARINc:WORD<n>:FORMat?.............................................................................. 659
BUS<b>:ARINc:WORD<n>:LABel?..................................................................................660
BUS<b>:ARINc:WORD<n>:LABel[:VALue]?..................................................................... 660
BUS<b>:ARINc:WORD<n>:PARity?................................................................................ 660
BUS<b>:ARINc:WORD<n>:PATTern?............................................................................. 660
BUS<b>:ARINc:WORD<n>:SDI?.....................................................................................660
BUS<b>:ARINc:WORD<n>:SSM?................................................................................... 661
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BUS<b>:ARINc:WORD<n>:STARt?.................................................................................661
BUS<b>:ARINc:WORD<n>:STOP?................................................................................. 661
BUS<b>:ARINc:WORD<n>:STATus?...............................................................................661

BUS<b>:ARINc:WCOunt?

Returns the number of decoded words.

Return values: 
<WordCount>

Usage: Query only

BUS<b>:ARINc:DATA:FORMat <StandardDecodeFormat>

Sets the decoding data format for the specified ARINC 429 bus.

Parameters:
<StandardDecodeFormat>DATA | DSSM | DSDI | DSSSm

SSMData: SSM+Data
SDIData: SDI+Data
SSData: SSM+Data +SDI

BUS<b>:ARINc:WORD<n>:DATA?

Returns the data bytes of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Usage: Query only

BUS<b>:ARINc:WORD<n>:DATA[:VALue]?

Returns the decimal value of the data of the specified word.

Return values: 
<DataValue>

Usage: Query only

BUS<b>:ARINc:WORD<n>:FORMat?

Returns the format of the sepcified word.

Return values: 
<DataFormat> DATA | DSSM | DSDI | DSSSm

SSMData: SSM+Data
SDIData: SDI+Data
SSData: SSM+Data +SDI
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Usage: Query only

BUS<b>:ARINc:WORD<n>:LABel?

Returns the label of the specified word.

Suffix: 
<b>

.
1..4

<n> *

Usage: Query only

BUS<b>:ARINc:WORD<n>:LABel[:VALue]?

Returns the decimal value of the label of the specified word.

Return values: 
<LabelValue>

Usage: Query only

BUS<b>:ARINc:WORD<n>:PARity?

Returns the parity of the specified word.

Return values: 
<Parity>

Usage: Query only

BUS<b>:ARINc:WORD<n>:PATTern?

Returns all 32 bits of a data word as decimal value.

Return values: 
<PatternValue> Integer value

Range: 0  to  232-1

Usage: Query only

BUS<b>:ARINc:WORD<n>:SDI?

Returns the source/destination identifier (SDI) bits of the specified word.

Return values: 
<SDI>

Usage: Query only
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BUS<b>:ARINc:WORD<n>:SSM?

Returns the sign/status matrix(SSM) bits of the specified word.

Return values: 
<SSM>

Usage: Query only

BUS<b>:ARINc:WORD<n>:STARt?

Returns the start time of the specified word.

Return values: 
<StartTime>

Usage: Query only

BUS<b>:ARINc:WORD<n>:STOP?

Returns the end time of the specified word.

Return values: 
<StopTime>

Usage: Query only

BUS<b>:ARINc:WORD<n>:STATus?

Returns the status of the specified word.

Return values: 
<WordStatus> OK | INSufficient | INComplete | PRERror | GERRor | CERRor

Usage: Query only

18.13.10.4 ARINC 429 - Search

SEARch:PROTocol:ARINc:CONDition..............................................................................662
SEARch:PROTocol:ARINc:DATA:CONDition....................................................................662
SEARch:PROTocol:ARINc:DATA:MAXimum.....................................................................662
SEARch:PROTocol:ARINc:DATA:MINimum......................................................................663
SEARch:PROTocol:ARINc:DATA:OFFSet........................................................................ 663
SEARch:PROTocol:ARINc:DATA:SIZE............................................................................ 663
SEARch:PROTocol:ARINc:ERRor................................................................................... 663
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SEARch:PROTocol:ARINc:LABel:CONDition....................................................................664
SEARch:PROTocol:ARINc:LABel:MAXimum.....................................................................664
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SEARch:PROTocol:ARINc:CONDition

Sets the event or combination of events to be searched for. Depending on the selected
event, further settings are required.

Parameters:
<SearchCondition> WORD | ERRor | LABel | LDATa

WORD
Search for a word type.
Set the word type with SEARch:PROTocol:ARINc:WORD[:
TYPE].

ERROr
Search for errors of one or more error types.
Set the error types with SEARch:PROTocol:ARINc:ERRor
LABel
Searches for label.
Set the label with SEARch:PROTocol:ARINc:LABel:
CONDition, SEARch:PROTocol:ARINc:LABel:MAXimum
and SEARch:PROTocol:ARINc:LABel:MINimum
LDATa
Searches for label and data.
Set the label withSEARch:PROTocol:ARINc:LABel:
CONDition, SEARch:PROTocol:ARINc:LABel:MAXimum
and SEARch:PROTocol:ARINc:LABel:MINimum.
Set the data with SEARch:PROTocol:ARINc:DATA:
CONDition, SEARch:PROTocol:ARINc:DATA:MAXimum,
SEARch:PROTocol:ARINc:DATA:MINimum, SEARch:
PROTocol:ARINc:DATA:OFFSet, SEARch:PROTocol:
ARINc:DATA:SIZE, SEARch:PROTocol:ARINc:SDI and
SEARch:PROTocol:ARINc:SSM

SEARch:PROTocol:ARINc:DATA:CONDition

Sets the comparison condition for data: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide

SEARch:PROTocol:ARINc:DATA:MAXimum

Searches for a maximum value of the data if SEARch:PROTocol:ARINc:DATA:
CONDition is set to INRange or OORange.
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The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<DataMaximum> 01X-string

SEARch:PROTocol:ARINc:DATA:MINimum

Searches for a minimum value of the data.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<DataMinimum> 01X-string

SEARch:PROTocol:ARINc:DATA:OFFSet

Searches for specified data offset.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<DataOffset>

SEARch:PROTocol:ARINc:DATA:SIZE

Searches for specified data size.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<DataSize>

SEARch:PROTocol:ARINc:ERRor

Searches for an error condition.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to ERRor.

Parameters:
<ErrorCondition> ANY | PARity | GAP | CODing

SEARch:PROTocol:ARINc:FORMat

Searches for a data format.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<DataFormat> DATA | DSSM | DSDI | DSSSm

SSMData: SSM+Data
SDIData: SDI+Data
SSData: SSM+Data +SDI
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SEARch:PROTocol:ARINc:LABel:CONDition

Sets the comparison condition for label: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LABel
or LDAta.

Parameters:
<LabelCondition> EQUal | NEQual | GTHan | GEQual | LEQual | LTHan | WITHin |

OUTSide

SEARch:PROTocol:ARINc:LABel:MAXimum

Searches for a maximum value of the label if SEARch:PROTocol:ARINc:LABel:
CONDition is set to INRange or OORange.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LABel
or LDATa.

Parameters:
<LabelMaximum> 01X-string

SEARch:PROTocol:ARINc:LABel:MINimum

Searches for a minimum value of the label.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LABel
or LDATa.

Parameters:
<LabelMinimum> 01X-string

SEARch:PROTocol:ARINc:SDI

Searches for the specified source/destination identifier (SDI) bits.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<SDIvalue> ANY | S00 | S01 | S10 | S11

SEARch:PROTocol:ARINc:SSM

Searches for specified sign/status matrix (SSM) bits.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to LDATa.

Parameters:
<SSMvalue> ANY | S00 | S01 | S10 | S11
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SEARch:PROTocol:ARINc:WORD[:TYPE]

Selects the word type to be searched for.

The command is relevant if SEARch:PROTocol:ARINc:CONDition is set to WORD.

Parameters:
<WordType> STARt | STOP

18.14 Power Analysis (Option R&S RTM-K31)
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18.14.1 Measurement Selection and General Settings

POWer:ATYPe.............................................................................................................. 665
POWer:ENABle............................................................................................................. 666
POWer:SOURce:CURRent<n>........................................................................................666
POWer:SOURce:VOLTage<n>........................................................................................666
POWer:RESult:TABLe....................................................................................................666
POWer:STATistics:RESet...............................................................................................667
POWer:STATistics:VISible.............................................................................................. 667

POWer:ATYPe

Sets the type of power analysis measurement.
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Parameters:
<AnalysisType> OFF | QUALity | CONSumption | HARMonicsINRushcurrent |

RIPPle | SPECtrumSWITchingloss | SLEWrateMODulation |
DONResistance | EFFiciencySWITchingloss | TURNonoff |
TRANsient
*RST: OFF

POWer:ENABle

Enables/disables the power analysis measurements.

Parameters:
<State> ON | OFF

*RST: OFF

POWer:SOURce:CURRent<n>

Sets the channel for the current source. Connect the current probe in flow direction of
the current.

Suffix: 
<n>

.
1..2
Only relevant if two current sources are used: 1 = In, 2 = Out

Parameters:
<CurrentSource> CH1 | CH2 | CH3 | CH4 | RE1 | RE2 | RE3 | RE4

POWer:SOURce:VOLTage<n>

Sets the channel for the voltage source input. .

Suffix: 
<n>

.
1..4
Only relevant if several current sources are used: 1 = In, 2 =
Out, 3 and 4 = Out for Turn ON/OFF measurement

Parameters:
<VoltageSource> CH1 | CH2 | CH3 | CH4 | RE1 | RE2 | RE3 | RE4

POWer:RESult:TABLe

Displays or hides the result table.

Tha command is available for harmonic and spectrum power measurements.

Parameters:
<Visible> ON | OFF

*RST: OFF
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POWer:STATistics:RESet

Deletes the statistical results for the current measurement or all measurements,
respectivley, and starts a new statistical evaluation.

Usage: Event

POWer:STATistics:VISible

Shows/ hides the statistical evaluation of the measurement.

Parameters:
<Visible> ON | OFF

*RST: OFF

18.14.2 Probe Adjustment

POWer:DESKew[:EXECute]

Starts the automatic deskew procedure to align the waveforms of all visible channels. It
is necessary to deskew if a current and a voltage probe is used in the measurment.
Use the R&S RT-ZF20 power deskew fixture to deskew the probes.

Usage: Event

POWer:ZOFFset[:EXECute]

Executes a zero offset for all visible channels.

Usage: Event

18.14.3 Report

POWer:REPort:ADD.......................................................................................................667
POWer:REPort:DESCription............................................................................................668
POWer:REPort:DUT.......................................................................................................668
POWer:REPort:OUTPut..................................................................................................668
POWer:REPort:SITE...................................................................................................... 668
POWer:REPort:TEMPerature.......................................................................................... 668
POWer:REPort:USER.................................................................................................... 668

POWer:REPort:ADD

Adds a power report.

Usage: Event
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POWer:REPort:DESCription

Sets a description that can be shown at the titel page of a report.

Parameters:
<DescriptionString> String parameter

POWer:REPort:DUT

Sets a device under test (DUT) value that can be shown at the titel page of a report.

Parameters:
<DeviceString> String parameter

POWer:REPort:OUTPut

Sets the directory for the output folder, where the reports are stored.

Parameters:
<OutputFolderPath> String parameter

POWer:REPort:SITE

Sets a site value that can be shown at the titel page of a report.

Parameters:
<SiteString> String parameter

POWer:REPort:TEMPerature <Temperature>

Sets a temperature value that can be shown at the titel page of a report.

Parameters:
<Temperature> Range: -273  to  32767

Increment: 1
*RST: 20

POWer:REPort:USER

Sets a user value that can be shown at the titel page of a report.

Parameters:
<UserString> String parameter

18.14.4 Statistical Results

Some power measurements deliver also statistical results, which can be exported to
CSV files.
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Power measurements use the measurement places ≥ 5. The number of the measure-
ment places are shown in the result table on the display, and they are listed in the
result files of EXPort:MEASurement<m>:STATistics:ALL commands.

EXPort:MEASurement<m>:STATistics:NAME...................................................................669
EXPort:MEASurement<m>:STATistics:SAVE....................................................................669
EXPort:MEASurement<m>:STATistics:ALL:NAME............................................................ 669
EXPort:MEASurement<m>:STATistics:ALL:SAVE.............................................................669

EXPort:MEASurement<m>:STATistics:NAME

Defines the path and filename of the statistics file. The file format is CSV. If the file
already exists, it will be overwritten.

Suffix: 
<m>

.
1..15
1..4: measurement places of automatic measurements
5..15: measurement places for power measurements.

Parameters:
<FileName> String parameter

EXPort:MEASurement<m>:STATistics:SAVE

Saves statistical results of the indicated measurement place to the file that is defined
by the EXPort:MEASurement<m>:STATistics:NAME command.

Suffix: 
<m>

.
1..15
1..4: measurement places of automatic measurements
5..15: measurement places for power measurements.

Usage: Event

See also: EXPort:MEASurement<m>:STATistics:ALL:SAVE on page 494.

EXPort:MEASurement<m>:STATistics:ALL:NAME

Defines the path and filename of the statistics file. The file format is CSV. If the file
already exists, it will be overwritten.

Suffix: 
<m>

.
1..4
The suffix is irrelevant, all results are returned.

Parameters:
<FileName> String parameter

EXPort:MEASurement<m>:STATistics:ALL:SAVE

Saves statistical results of all measurement places to the file that is defined by the
EXPort:MEASurement<m>:STATistics:ALL:NAME command.
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Suffix: 
<m>

.
1..4
The suffix is irrelevant, all results are returned.

Example: The file contains general information, statistical results, long
term statistics, and the individual values that are used to calcu-
late the statistics. The number of values is "Average No."
"Vendor","Rohde&Schwarz",
"Device/Mat.-No.","RTM2022 / 5710.0999k22",
"Serial No.","900001",
"Firmware Version","Beta 05.601",
"Date","2014-11-18 / 16:40:27",

"Meas. Place",,"1",,"2",,"3",,
"Type",,"Frequency",,"Mean Value",,"Frequency",,
"Source 1",,"CH1",,"CH1",,"CH2",,
"Source 2",,,,,,,,,,
"Wave count",,42,,39,,37,,
"Current",,4.998250e+05,,5.648727e-01,,4.998250e+05,,
"Average No.",,1.000000e+03,,1.000000e+03,,1.000000e+03,,
"Minimum",,4.997501e+05,,5.633875e-01,,4.997501e+05,,
"Maximum",,4.998250e+05,,5.650349e-01,,4.998250e+05,,
"Mean",,4.998179e+05,,5.642045e-01,,4.998169e+05,,
"σ-Deviation",,2.199706e+01,,3.677224e-04,,2.326898e+01,,
"Time of first value",,,,,,,,,,
"Time of last value",,,,,,,,,,
"Long term Minimum",,4.997501e+05,,5.633875e-01,,4.997501e+05,,
"Long term Maximum",,4.998250e+05,,5.650349e-01,,4.998250e+05,,
"Long term Mittelwert",,4.998179e+05,,5.642045e-01,,4.998169e+05,,
"Long term σ-Deviation",,2.226370e+01,,3.725295e-04,,2.358995e+01,,
"Long term start time",,,,,,,,,,
"Long term end Time",,,,,,,,,,

"Index","Time Offset","Value","Time Offset","Value",
"Time Offset","Value",
1,,4.998250e+05,,5.649274e-01,,4.997501e+05,
2,,4.998250e+05,,5.649072e-01,,4.998250e+05,
3,,4.998250e+05,,5.650349e-01,,4.998250e+05,
4,,4.998250e+05,,5.641094e-01,,4.998250e+05,
5,,4.998250e+05,,5.640586e-01,,4.998250e+05,
6,,4.997501e+05,,5.642784e-01,,4.998250e+05,
7,,4.998250e+05,,5.637245e-01,,4.998250e+05,...

Usage: Event

18.14.5 Power Quality

POWer:QUALity:EXECute.............................................................................................. 672
POWer:QUALity:REPort:ADD..........................................................................................672
POWer:QUALity:RESult:VOLTage:RMS[:ACTual]?............................................................672
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POWer:QUALity:RESult:VOLTage:CREStfactor[:ACTual]?.................................................672
POWer:QUALity:RESult:VOLTage:FREQuency[:ACTual]?................................................. 672
POWer:QUALity:RESult:CURRent:RMS[:ACTual]?............................................................672
POWer:QUALity:RESult:CURRent:CREStfactor[:ACTual]?.................................................672
POWer:QUALity:RESult:CURRent:FREQuency[:ACTual]?................................................. 672
POWer:QUALity:RESult:VOLTage:RMS:AVG?................................................................. 672
POWer:QUALity:RESult:VOLTage:CREStfactor:AVG?...................................................... 672
POWer:QUALity:RESult:VOLTage:FREQuency:AVG?.......................................................672
POWer:QUALity:RESult:CURRent:RMS:AVG?................................................................. 672
POWer:QUALity:RESult:CURRent:CREStfactor:AVG?...................................................... 672
POWer:QUALity:RESult:CURRent:FREQuency:AVG?.......................................................672
POWer:QUALity:RESult:VOLTage:RMS:NPEak?.............................................................. 673
POWer:QUALity:RESult:VOLTage:CREStfactor:NPEak?................................................... 673
POWer:QUALity:RESult:VOLTage:FREQuency:NPEak?....................................................673
POWer:QUALity:RESult:CURRent:RMS:NPEak?.............................................................. 673
POWer:QUALity:RESult:CURRent:CREStfactor:NPEak?................................................... 673
POWer:QUALity:RESult:CURRent:FREQuency:NPEak?....................................................673
POWer:QUALity:RESult:VOLTage:RMS:PPEak?.............................................................. 673
POWer:QUALity:RESult:VOLTage:CREStfactor:PPEak?................................................... 673
POWer:QUALity:RESult:VOLTage:FREQuency:PPEak?....................................................673
POWer:QUALity:RESult:CURRent:RMS:PPEak?.............................................................. 673
POWer:QUALity:RESult:CURRent:CREStfactor:PPEak?................................................... 673
POWer:QUALity:RESult:CURRent:FREQuency:PPEak?....................................................673
POWer:QUALity:RESult:VOLTage:RMS:STDDev?............................................................673
POWer:QUALity:RESult:VOLTage:CREStfactor:STDDev?................................................. 673
POWer:QUALity:RESult:VOLTage:FREQuency:STDDev?................................................. 673
POWer:QUALity:RESult:CURRent:RMS:STDDev?............................................................673
POWer:QUALity:RESult:CURRent:CREStfactor:STDDev?................................................. 673
POWer:QUALity:RESult:CURRent:FREQuency:STDDev?................................................. 673
POWer:QUALity:RESult:VOLTage:RMS:WFMCount?........................................................673
POWer:QUALity:RESult:VOLTage:CREStfactor:WFMCount?.............................................673
POWer:QUALity:RESult:VOLTage:FREQuency:WFMCount?............................................. 673
POWer:QUALity:RESult:CURRent:RMS:WFMCount?........................................................673
POWer:QUALity:RESult:CURRent:CREStfactor:WFMCount?.............................................674
POWer:QUALity:RESult:CURRent:FREQuency:WFMCount?............................................. 674
POWer:QUALity:RESult:POWer:REALpower[:ACTual]?.....................................................674
POWer:QUALity:RESult:POWer:REACtive[:ACTual]?........................................................674
POWer:QUALity:RESult:POWer:APParent[:ACTual]?........................................................ 674
POWer:QUALity:RESult:POWer:PFACtor[:ACTual]?..........................................................674
POWer:QUALity:RESult:POWer:PHASe[:ACTual]?........................................................... 674
POWer:QUALity:RESult:POWer:REALpower:AVG?.......................................................... 674
POWer:QUALity:RESult:POWer:REACtive:AVG?..............................................................674
POWer:QUALity:RESult:POWer:APParent:AVG?..............................................................674
POWer:QUALity:RESult:POWer:PFACtor:AVG?............................................................... 674
POWer:QUALity:RESult:POWer:PHASe:AVG?................................................................. 674
POWer:QUALity:RESult:POWer:REALpower:NPEak?....................................................... 674
POWer:QUALity:RESult:POWer:REACtive:NPEak?.......................................................... 674
POWer:QUALity:RESult:POWer:APParent:NPEak?...........................................................674
POWer:QUALity:RESult:POWer:PFACtor:NPEak?............................................................ 674
POWer:QUALity:RESult:POWer:PHASe:NPEak?..............................................................674
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POWer:QUALity:RESult:POWer:REALpower:PPEak?....................................................... 674
POWer:QUALity:RESult:POWer:REACtive:PPEak?...........................................................674
POWer:QUALity:RESult:POWer:APParent:PPEak?...........................................................674
POWer:QUALity:RESult:POWer:PFACtor:PPEak?............................................................ 675
POWer:QUALity:RESult:POWer:PHASe:PPEak?.............................................................. 675
POWer:QUALity:RESult:POWer:REALpower:STDDev?..................................................... 675
POWer:QUALity:RESult:POWer:REACtive:STDDev?........................................................ 675
POWer:QUALity:RESult:POWer:APParent:STDDev?........................................................ 675
POWer:QUALity:RESult:POWer:PFACtor:STDDev?..........................................................675
POWer:QUALity:RESult:POWer:PHASe:STDDev?............................................................675
POWer:QUALity:RESult:POWer:REALpower:WFMCount?.................................................675
POWer:QUALity:RESult:POWer:REACtive:WFMCount?.................................................... 675
POWer:QUALity:RESult:POWer:APParent:WFMCount?.................................................... 675
POWer:QUALity:RESult:POWer:PFACtor:WFMCount?......................................................675
POWer:QUALity:RESult:POWer:PHASe:WFMCount?........................................................675

POWer:QUALity:EXECute

Starts the power quality measurement.

Usage: Event

POWer:QUALity:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:QUALity:RESult:VOLTage:RMS[:ACTual]?
POWer:QUALity:RESult:VOLTage:CREStfactor[:ACTual]?
POWer:QUALity:RESult:VOLTage:FREQuency[:ACTual]?
POWer:QUALity:RESult:CURRent:RMS[:ACTual]?
POWer:QUALity:RESult:CURRent:CREStfactor[:ACTual]?
POWer:QUALity:RESult:CURRent:FREQuency[:ACTual]?
Returns the instantenious result of the specified measurement.

Return values: 
<ActualValue> Measurement result. If no measurement was executed, no value

(NAN) is returned.

Usage: Query only

POWer:QUALity:RESult:VOLTage:RMS:AVG?
POWer:QUALity:RESult:VOLTage:CREStfactor:AVG?
POWer:QUALity:RESult:VOLTage:FREQuency:AVG?
POWer:QUALity:RESult:CURRent:RMS:AVG?
POWer:QUALity:RESult:CURRent:CREStfactor:AVG?
POWer:QUALity:RESult:CURRent:FREQuency:AVG?
Returns the average value of the specified measurement series.
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Return values: 
<AverageValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:VOLTage:RMS:NPEak?
POWer:QUALity:RESult:VOLTage:CREStfactor:NPEak?
POWer:QUALity:RESult:VOLTage:FREQuency:NPEak?
POWer:QUALity:RESult:CURRent:RMS:NPEak?
POWer:QUALity:RESult:CURRent:CREStfactor:NPEak?
POWer:QUALity:RESult:CURRent:FREQuency:NPEak?
Returns the minimum value of the specified measurement series.

Return values: 
<MinimumValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:VOLTage:RMS:PPEak?
POWer:QUALity:RESult:VOLTage:CREStfactor:PPEak?
POWer:QUALity:RESult:VOLTage:FREQuency:PPEak?
POWer:QUALity:RESult:CURRent:RMS:PPEak?
POWer:QUALity:RESult:CURRent:CREStfactor:PPEak?
POWer:QUALity:RESult:CURRent:FREQuency:PPEak?
Returns the maximum value of the specified measurement series.

Return values: 
<MaximumValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:VOLTage:RMS:STDDev?
POWer:QUALity:RESult:VOLTage:CREStfactor:STDDev?
POWer:QUALity:RESult:VOLTage:FREQuency:STDDev?
POWer:QUALity:RESult:CURRent:RMS:STDDev?
POWer:QUALity:RESult:CURRent:CREStfactor:STDDev?
POWer:QUALity:RESult:CURRent:FREQuency:STDDev?
Returns the statistical standard deviation of the specified measurement series.

Return values: 
<DeviationValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:VOLTage:RMS:WFMCount?
POWer:QUALity:RESult:VOLTage:CREStfactor:WFMCount?
POWer:QUALity:RESult:VOLTage:FREQuency:WFMCount?
POWer:QUALity:RESult:CURRent:RMS:WFMCount?
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POWer:QUALity:RESult:CURRent:CREStfactor:WFMCount?
POWer:QUALity:RESult:CURRent:FREQuency:WFMCount?
Returns the current number of measured waveforms.

Return values: 
<WaveformCount> Statistic value

Usage: Query only

POWer:QUALity:RESult:POWer:REALpower[:ACTual]?
POWer:QUALity:RESult:POWer:REACtive[:ACTual]?
POWer:QUALity:RESult:POWer:APParent[:ACTual]?
POWer:QUALity:RESult:POWer:PFACtor[:ACTual]?
POWer:QUALity:RESult:POWer:PHASe[:ACTual]?
Returns the instantenious result of the specified measurement.

Return values: 
<ActualValue> Measurement result. If no measurement was executed, no value

(NAN) is returned.

Usage: Query only

POWer:QUALity:RESult:POWer:REALpower:AVG?
POWer:QUALity:RESult:POWer:REACtive:AVG?
POWer:QUALity:RESult:POWer:APParent:AVG?
POWer:QUALity:RESult:POWer:PFACtor:AVG?
POWer:QUALity:RESult:POWer:PHASe:AVG?
Returns the average value of the specified measurement series.

Return values: 
<AverageValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:POWer:REALpower:NPEak?
POWer:QUALity:RESult:POWer:REACtive:NPEak?
POWer:QUALity:RESult:POWer:APParent:NPEak?
POWer:QUALity:RESult:POWer:PFACtor:NPEak?
POWer:QUALity:RESult:POWer:PHASe:NPEak?
Returns the minimum value of the specified measurement series.

Return values: 
<MinimumValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:POWer:REALpower:PPEak?
POWer:QUALity:RESult:POWer:REACtive:PPEak?
POWer:QUALity:RESult:POWer:APParent:PPEak?
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POWer:QUALity:RESult:POWer:PFACtor:PPEak?
POWer:QUALity:RESult:POWer:PHASe:PPEak?
Returns the maximum value of the specified measurement series.

Return values: 
<MaximumValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:POWer:REALpower:STDDev?
POWer:QUALity:RESult:POWer:REACtive:STDDev?
POWer:QUALity:RESult:POWer:APParent:STDDev?
POWer:QUALity:RESult:POWer:PFACtor:STDDev?
POWer:QUALity:RESult:POWer:PHASe:STDDev?
Returns the statistical standard deviation of the specified measurement series.

Return values: 
<DeviationValue> Statistic value

Usage: Query only

POWer:QUALity:RESult:POWer:REALpower:WFMCount?
POWer:QUALity:RESult:POWer:REACtive:WFMCount?
POWer:QUALity:RESult:POWer:APParent:WFMCount?
POWer:QUALity:RESult:POWer:PFACtor:WFMCount?
POWer:QUALity:RESult:POWer:PHASe:WFMCount?
Returns the current number of measured waveforms.

Return values: 
<WaveformCount> Statistic value

Usage: Query only

18.14.6 Consumption

POWer:CONSumption:EXECute......................................................................................675
POWer:CONSumption:REPort:ADD.................................................................................676
POWer:CONSumption:RESTart.......................................................................................676
POWer:CONSumption:RESult:DURation?........................................................................ 676
POWer:CONSumption:RESult:ENERgy?..........................................................................676
POWer:CONSumption:RESult:REALpower?.....................................................................676

POWer:CONSumption:EXECute <State>

Starts the consumption measurement.

Parameters:
<State> ON | OFF

Usage: Event
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POWer:CONSumption:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:CONSumption:RESTart

Restarts the measurement.

Usage: Event

POWer:CONSumption:RESult:DURation?

Queries the duration of the measurement. The result is displayed in seconds.

Return values: 
<Duration>

Usage: Query only

POWer:CONSumption:RESult:ENERgy?

Queries the energy.

Return values: 
<Energy>

Usage: Query only

POWer:CONSumption:RESult:REALpower?

Queries the real power.

Return values: 
<RealPower>

Usage: Query only

18.14.7 Current Harmonics

18.14.7.1 Current Harmonics - Settings

POWer:HARMonics:ENFRequency..................................................................................677
POWer:HARMonics:DOFRequency................................................................................. 677
POWer:HARMonics:MIFRequency...................................................................................677
POWer:HARMonics:STANdard........................................................................................677
POWer:HARMonics:EXECute......................................................................................... 677
POWer:HARMonics:REPort:ADD.....................................................................................677
POWer:HARMonics:RESult<n>:RESet.............................................................................677
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POWer:HARMonics:ENFRequency <ENFrequency>

Selects the frequency of the input signal when POWer:HARMonics:STANdard
on page 677 is set to ENA/ENB/ENC/END.

Parameters:
<ENFrequency> AUTO | F50 | F60

POWer:HARMonics:DOFRequency <DoFrequency>

Selects the frequency of the input signal when POWer:HARMonics:STANdard is set
to RTC.

Parameters:
<DoFrequency> F400 | NVF | WVF

POWer:HARMonics:MIFRequency <MILFrequency>

Selects the frequency of the input signal when POWer:HARMonics:STANdard is set
to MIL.

Parameters:
<MILFrequency> F60 | F400

POWer:HARMonics:STANdard <Standard>

Sets a standard for the current harmonic measurement.

Parameters:
<Standard> ENA | ENB | ENC | END | MIL | RTC

POWer:HARMonics:EXECute

Starts the current harmonics measurement.

Usage: Event

POWer:HARMonics:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:HARMonics:RESult<n>:RESet

Resets the count of the measurements.

Suffix: 
<n>

.
1..40

Usage: Event
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18.14.7.2 Current Harmonics - Results

POWer:HARMonics:AVAilable?.......................................................................................678
POWer:HARMonics:MEASurement:DURation?.................................................................678
POWer:HARMonics:MEASurement:FREQuency:AVG?......................................................678
POWer:HARMonics:MEASurement:FREQuency:NPEak?.................................................. 679
POWer:HARMonics:MEASurement:FREQuency:PPeak?...................................................679
POWer:HARMonics:MEASurement:FREQuency:STDDev?................................................ 679
POWer:HARMonics:MEASurement:FREQuency[:ACTual]?................................................679
POWer:HARMonics:MEASurement:REALpower[:ACTual]?................................................ 679
POWer:HARMonics:MEASurement:THDistortion:AVG?..................................................... 679
POWer:HARMonics:MEASurement:THDistortion:NPEak?.................................................. 680
POWer:HARMonics:MEASurement:THDistortion:PPeak?...................................................680
POWer:HARMonics:MEASurement:THDistortion:STDDev?................................................680
POWer:HARMonics:MEASurement:THDistortion[:ACTual]?............................................... 680
POWer:HARMonics:RESult<n>:FREQency?.....................................................................680
POWer:HARMonics:RESult<n>:LEVel:LIMit?....................................................................680
POWer:HARMonics:RESult<n>:LEVel[:VALue]?............................................................... 681
POWer:HARMonics:RESult<n>:MAXimum?..................................................................... 681
POWer:HARMonics:RESult<n>:MEAN?........................................................................... 681
POWer:HARMonics:RESult<n>:MINimum?.......................................................................681
POWer:HARMonics:RESult<n>:VALid?............................................................................682
POWer:HARMonics:RESult<n>:VCOunt?.........................................................................682
POWer:HARMonics:RESult<n>:WFMCount?....................................................................682
EXPort:POWer:NAME.................................................................................................... 682
EXPort:POWer:SAVE.....................................................................................................682

POWer:HARMonics:AVAilable?

Returns the number of measured harmonics.

Return values: 
<HarmonicsCount> Number of harmonics

Usage: Query only

POWer:HARMonics:MEASurement:DURation?

Returns the time duration of the measurement.

Return values: 
<Duration> Default unit: s

Usage: Query only

POWer:HARMonics:MEASurement:FREQuency:AVG?

Returns the average frequency of the measured signal.

Return values: 
<AverageValue>
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Usage: Query only

POWer:HARMonics:MEASurement:FREQuency:NPEak?

Returns the minimum frequency of the measured signal.

Return values: 
<MinimumValue>

Usage: Query only

POWer:HARMonics:MEASurement:FREQuency:PPeak?

Returns the maximum frequency of the measured signal.

Return values: 
<MaximumValue>

Usage: Query only

POWer:HARMonics:MEASurement:FREQuency:STDDev?

Returns the standard deviation of frequencies of the measured signal.

Return values: 
<DeviationValue> Standard deviation

Usage: Query only

POWer:HARMonics:MEASurement:FREQuency[:ACTual]?

Returns the current frequency value.

Return values: 
<ActualValue>

Usage: Query only

POWer:HARMonics:MEASurement:REALpower[:ACTual]?

Returns the measured total power, which is used for dynamic calculation of the limits.

Return values: 
<RealPower>

Usage: Query only

POWer:HARMonics:MEASurement:THDistortion:AVG?

Returns the average total harmonic disortion of the measured signal.

Return values: 
<AverageValue>
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Usage: Query only

POWer:HARMonics:MEASurement:THDistortion:NPEak?

Returns the minimum total harmonic disortion of the measured signal.

Return values: 
<MinimumValue>

Usage: Query only

POWer:HARMonics:MEASurement:THDistortion:PPeak?

Returns the maximum total harmonic disortion of the measured signal.

Return values: 
<MaximumValue>

Usage: Query only

POWer:HARMonics:MEASurement:THDistortion:STDDev?

Returns the standard deviation of total harmonic disortions of the measured signal.

Return values: 
<DeviationValue>

Usage: Query only

POWer:HARMonics:MEASurement:THDistortion[:ACTual]?

Returns the current total harmonic disortion value.

Return values: 
<ActualValue>

Usage: Query only

POWer:HARMonics:RESult<n>:FREQency?

Queries the frequency of the n-th harmonic.

Suffix: 
<n>

.
1..40

Return values: 
<Frequency>

Usage: Query only

POWer:HARMonics:RESult<n>:LEVel:LIMit?

Queries the limit for the level of the n-th harmonic.
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Suffix: 
<n>

.
1..40

Return values: 
<LevelLimit>

Usage: Query only

POWer:HARMonics:RESult<n>:LEVel[:VALue]?

Queries the level of the n-th harmonic.

Suffix: 
<n>

.
1..40

Return values: 
<Level>

Usage: Query only

POWer:HARMonics:RESult<n>:MAXimum?

Queries the maximum level of the n-th harmonic.

Suffix: 
<n>

.
1..40

Return values: 
<LevelMaximum>

Usage: Query only

POWer:HARMonics:RESult<n>:MEAN?

Queries the average level of the n-th harmonic.

Suffix: 
<n>

.
1..40

Return values: 
<LevelAverage>

Usage: Query only

POWer:HARMonics:RESult<n>:MINimum?

Queries the minimum level of the n-th harmonic.

Suffix: 
<n>

.
1..40

Return values: 
<LevelMinimum>

Usage: Query only
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POWer:HARMonics:RESult<n>:VALid?

Queries whether the value of n-th harmonic is within the limit for the current measur-
ment.

Suffix: 
<n>

.
1..40

Return values: 
<Valid> PASS | FAIL

Usage: Query only

POWer:HARMonics:RESult<n>:VCOunt?

Queries the number of waveforms, for which the limit value of at least one harmonic
was violated.

Suffix: 
<n>

.
1..40

Parameters:
<ViolateCount>

Usage: Query only

POWer:HARMonics:RESult<n>:WFMCount?

Queries the number of waveforms, for which the harmonics were measured.

Suffix: 
<n>

.
1..40

Return values: 
<WaveformCount>

Usage: Query only

EXPort:POWer:NAME <ExportPath>

Defines the path and filename of the results file, available for current harmonics and
spectrum power measurements. The file format is CSV. If the file already exists, it will
be overwritten.

Parameters:
<ExportPath> string

String parameter

EXPort:POWer:SAVE

Saves statistical results of the indicated measurement place to the file that is defined
by the EXPort:POWer:NAME command.
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Example: Current harmonics measurement:
EXPort:POWer:NAME "/USB_FRONT/POWER/HARMONIC"
EXPort:POWer:SAVE

The file contains the following data:
"Power Analysis Results: Harmonics (CH2), 50 Hz, EN61000-3-2 A"
"Current: Fail (1 / 40)"
"Total Pass: 0; Total Fail: 2"
Order,Frequency[Hz],Level[V],Minimum[V],Maximum[V],Average[V],
Limit[V],State
1,5.0049E+01,8.06691E+00,8.06691E+00,2.43617E+01,1.62143E+01,
1.60000E+01,Fail
2,1.0010E+02,9.52154E-03,7.72160E-03,9.52154E-03,8.62157E-03,
1.08000E+00,Pass
3,1.5015E+02,3.51324E-03,3.51324E-03,5.07817E-02,2.71475E-02,
2.30000E+00,Pass
4,1.9958E+02,2.47575E-03,2.47575E-03,3.74720E-03,3.11148E-03,
4.30000E-01,Pass
5,2.5024E+02,5.88447E-03,5.88447E-03,3.02487E-02,1.80666E-02,
1.14000E+00,Pass
6,2.9968E+02,7.02598E-03,1.27264E-03,7.02598E-03,4.14931E-03,
3.00000E-01,Pass
...

Example: Spectrum measurement:
EXPort:POWer:NAME "/USB_FRONT/POWER/SPECTRUM"
EXPort:POWer:SAVE

The file contains the following data:
"Power Analysis Results: Spectrum (CH1), 100kHz"
"Total: 67"
Order,Frequency[Hz],Level[dBV],Minimum[dBV],Maximum[dBV],Average[dBV]
1,1.0009766E+05,-1.11840E+02,-1.19960E+02,-8.39799E+01,-1.03205E+02
2,1.9897461E+05,-1.03860E+02,-1.21000E+02,-8.97199E+01,-1.03222E+02
3,2.9907227E+05,-1.02660E+02,-1.22520E+02,-9.12399E+01,-1.03858E+02
4,4.0039062E+05,-1.08660E+02,-1.17400E+02,-9.24199E+01,-1.04547E+02
5,4.9926758E+05,-1.00340E+02,-1.11500E+02,-7.78199E+01,-9.44799E+01
6,6.0058594E+05,-1.10040E+02,-1.16040E+02,-9.39199E+01,-1.03913E+02
...

Usage: Event

18.14.8 Inrush Current

POWer:INRushcurrent:EXECute......................................................................................684
POWer:INRushcurrent:GATE<n>:STARt.......................................................................... 684
POWer:INRushcurrent:GATE<n>:STOP...........................................................................684
POWer:INRushcurrent:GCOunt....................................................................................... 684
POWer:INRushcurrent:REPort:ADD.................................................................................684
POWer:INRushcurrent:RESult<n>:AREA?........................................................................684
POWer:INRushcurrent:RESult<n>:MAXCurrent?...............................................................685
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POWer:INRushcurrent:EXECute

Starts the inrush current measurement.

Usage: Event

POWer:INRushcurrent:GATE<n>:STARt <StartTime>

Sets the start measuring time for the selected gate.

Suffix: 
<n>

.
1..3

Parameters:
<StartTime>

POWer:INRushcurrent:GATE<n>:STOP <StopTime>

Sets the stop measuring time for the selected gate.

Suffix: 
<n>

.
1..3

Parameters:
<StopTime>

POWer:INRushcurrent:GCOunt <GateCount>

Sets the number of inrush current gates.

Parameters:
<GateCount> *RST: 1

POWer:INRushcurrent:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:INRushcurrent:RESult<n>:AREA?

Queries the area of the corresponding gate.

Suffix: 
<n>

.
1..3

Return values: 
<AreaValue>

Usage: Query only

Power Analysis (Option R&S RTM-K31)



Remote Commands ReferenceR&S®RTM2000

685User Manual 1317.4726.02 ─ 10

POWer:INRushcurrent:RESult<n>:MAXCurrent?

Queires the maximum current for the corresponding gate.

Suffix: 
<n>

.
1..3

Return values: 
<MaxCurrentValue>

Usage: Query only

18.14.9 Ripple

POWer:RIPPle:EXECute................................................................................................ 686
POWer:RIPPle:REPort:ADD............................................................................................686
POWer:RIPPle:RESult:FREQuency[:ACTual]?..................................................................686
POWer:RIPPle:RESult:FREQuency:AVG?........................................................................686
POWer:RIPPle:RESult:FREQuency:NPEak?.................................................................... 686
POWer:RIPPle:RESult:FREQuency:PPEak?.....................................................................686
POWer:RIPPle:RESult:FREQuency:STDDev?.................................................................. 686
POWer:RIPPle:RESult:FREQuency:WFMCount?.............................................................. 686
POWer:RIPPle:RESult:LPEak[:ACTual]?..........................................................................687
POWer:RIPPle:RESult:LPEak:AVG?................................................................................687
POWer:RIPPle:RESult:LPEak:NPEak?............................................................................ 687
POWer:RIPPle:RESult:LPEak:PPEak?.............................................................................687
POWer:RIPPle:RESult:LPEak:STDDev?.......................................................................... 687
POWer:RIPPle:RESult:LPEak:WFMCount?...................................................................... 687
POWer:RIPPle:RESult:MEAN[:ACTual]?.......................................................................... 687
POWer:RIPPle:RESult:MEAN:AVG?................................................................................687
POWer:RIPPle:RESult:MEAN:NPEak?.............................................................................687
POWer:RIPPle:RESult:MEAN:PPEak?.............................................................................687
POWer:RIPPle:RESult:MEAN:STDDev?.......................................................................... 687
POWer:RIPPle:RESult:MEAN:WFMCount?...................................................................... 687
POWer:RIPPle:RESult:NDCYcle[:ACTual]?...................................................................... 687
POWer:RIPPle:RESult:NDCYcle:AVG?............................................................................687
POWer:RIPPle:RESult:NDCYcle:NPEak?.........................................................................688
POWer:RIPPle:RESult:NDCYcle:PPEak?.........................................................................688
POWer:RIPPle:RESult:NDCYcle:STDDev?.......................................................................688
POWer:RIPPle:RESult:NDCYcle:WFMCount?.................................................................. 688
POWer:RIPPle:RESult:PDCYcle[:ACTual]?...................................................................... 688
POWer:RIPPle:RESult:PDCYcle:AVG?............................................................................ 688
POWer:RIPPle:RESult:PDCYcle:NPEak?.........................................................................688
POWer:RIPPle:RESult:PDCYcle:PPEak?......................................................................... 688
POWer:RIPPle:RESult:PDCYcle:STDDev?.......................................................................688
POWer:RIPPle:RESult:PDCYcle:WFMCount?...................................................................688
POWer:RIPPle:RESult:PEAK[:ACTual]?...........................................................................688
POWer:RIPPle:RESult:PEAK:AVG?.................................................................................688
POWer:RIPPle:RESult:PEAK:NPEak?............................................................................. 688
POWer:RIPPle:RESult:PEAK:PPEak?..............................................................................688
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POWer:RIPPle:RESult:PEAK:STDDev?........................................................................... 688
POWer:RIPPle:RESult:PEAK:WFMCount?....................................................................... 688
POWer:RIPPle:RESult:PERiod[:ACTual]?........................................................................ 689
POWer:RIPPle:RESult:PERiod:AVG?.............................................................................. 689
POWer:RIPPle:RESult:PERiod:NPEak?........................................................................... 689
POWer:RIPPle:RESult:PERiod:PPEak?........................................................................... 689
POWer:RIPPle:RESult:PERiod:STDDev?.........................................................................689
POWer:RIPPle:RESult:PERiod:WFMCount?.....................................................................689
POWer:RIPPle:RESult:STDDev[:ACTual]?....................................................................... 689
POWer:RIPPle:RESult:STDDev:AVG?.............................................................................689
POWer:RIPPle:RESult:STDDev:NPEak?..........................................................................689
POWer:RIPPle:RESult:STDDev:PPEak?..........................................................................689
POWer:RIPPle:RESult:STDDev:STDDev?........................................................................689
POWer:RIPPle:RESult:STDDev:WFMCount?................................................................... 689
POWer:RIPPle:RESult:UPEak[:ACTual]?......................................................................... 689
POWer:RIPPle:RESult:UPEak:AVG?............................................................................... 689
POWer:RIPPle:RESult:UPEak:NPEak?............................................................................689
POWer:RIPPle:RESult:UPEak:PPEak?............................................................................ 689
POWer:RIPPle:RESult:UPEak:STDDev?..........................................................................690
POWer:RIPPle:RESult:UPEak:WFMCount?......................................................................690

POWer:RIPPle:EXECute

Starts the ripple measurement.

Usage: Event

POWer:RIPPle:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:RIPPle:RESult:FREQuency[:ACTual]?
POWer:RIPPle:RESult:FREQuency:AVG?
POWer:RIPPle:RESult:FREQuency:NPEak?
POWer:RIPPle:RESult:FREQuency:PPEak?
POWer:RIPPle:RESult:FREQuency:STDDev?
POWer:RIPPle:RESult:FREQuency:WFMCount?
Returns the corresponding statistic result for the frequency.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results
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Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:LPEak[:ACTual]?
POWer:RIPPle:RESult:LPEak:AVG?
POWer:RIPPle:RESult:LPEak:NPEak?
POWer:RIPPle:RESult:LPEak:PPEak?
POWer:RIPPle:RESult:LPEak:STDDev?
POWer:RIPPle:RESult:LPEak:WFMCount?
Returns the corresponding statistic result for "Vp-".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:MEAN[:ACTual]?
POWer:RIPPle:RESult:MEAN:AVG?
POWer:RIPPle:RESult:MEAN:NPEak?
POWer:RIPPle:RESult:MEAN:PPEak?
POWer:RIPPle:RESult:MEAN:STDDev?
POWer:RIPPle:RESult:MEAN:WFMCount?
Returns the corresponding statistic result for "Mean".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:NDCYcle[:ACTual]?
POWer:RIPPle:RESult:NDCYcle:AVG?
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POWer:RIPPle:RESult:NDCYcle:NPEak?
POWer:RIPPle:RESult:NDCYcle:PPEak?
POWer:RIPPle:RESult:NDCYcle:STDDev?
POWer:RIPPle:RESult:NDCYcle:WFMCount?
Returns the corresponding statistic result for the negative duty cycle.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:PDCYcle[:ACTual]?
POWer:RIPPle:RESult:PDCYcle:AVG?
POWer:RIPPle:RESult:PDCYcle:NPEak?
POWer:RIPPle:RESult:PDCYcle:PPEak?
POWer:RIPPle:RESult:PDCYcle:STDDev?
POWer:RIPPle:RESult:PDCYcle:WFMCount?
Returns the corresponding statistic result for the positive duty cycle.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:PEAK[:ACTual]?
POWer:RIPPle:RESult:PEAK:AVG?
POWer:RIPPle:RESult:PEAK:NPEak?
POWer:RIPPle:RESult:PEAK:PPEak?
POWer:RIPPle:RESult:PEAK:STDDev?
POWer:RIPPle:RESult:PEAK:WFMCount?
Returns the corresponding statistic result for "Vpp".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
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● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:PERiod[:ACTual]?
POWer:RIPPle:RESult:PERiod:AVG?
POWer:RIPPle:RESult:PERiod:NPEak?
POWer:RIPPle:RESult:PERiod:PPEak?
POWer:RIPPle:RESult:PERiod:STDDev?
POWer:RIPPle:RESult:PERiod:WFMCount?
Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:STDDev[:ACTual]?
POWer:RIPPle:RESult:STDDev:AVG?
POWer:RIPPle:RESult:STDDev:NPEak?
POWer:RIPPle:RESult:STDDev:PPEak?
POWer:RIPPle:RESult:STDDev:STDDev?
POWer:RIPPle:RESult:STDDev:WFMCount?
Returns the corresponding statistic result for the standard deviation.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:RIPPle:RESult:UPEak[:ACTual]?
POWer:RIPPle:RESult:UPEak:AVG?
POWer:RIPPle:RESult:UPEak:NPEak?
POWer:RIPPle:RESult:UPEak:PPEak?
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POWer:RIPPle:RESult:UPEak:STDDev?
POWer:RIPPle:RESult:UPEak:WFMCount?
Returns the corresponding statistic result for "Vp+".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

18.14.10 Spectrum

POWer:SPECtrum:EXECute........................................................................................... 690
POWer:SPECtrum:FREQuency.......................................................................................690
POWer:SPECtrum:REPort:ADD...................................................................................... 690
POWer:SPECtrum:RESult<n>:FREQuency?.....................................................................691
POWer:SPECtrum:RESult<n>:LEVel[:VALue]?................................................................. 691
POWer:SPECtrum:RESult<n>:MAXimum?....................................................................... 691
POWer:SPECtrum:RESult<n>:MEAN?.............................................................................691
POWer:SPECtrum:RESult<n>:MINimum?........................................................................ 691
POWer:SPECtrum:RESult<n>:RESet...............................................................................692
POWer:SPECtrum:RESult<n>:WFMCount?......................................................................692
EXPort:POWer:NAME.................................................................................................... 692
EXPort:POWer:SAVE.....................................................................................................692

POWer:SPECtrum:EXECute

Starts the spectrum measurement.

Usage: Event

POWer:SPECtrum:FREQuency <SwitchingFrequency>

Sets the frequency of the input signal.

Parameters:
<SwitchingFrequency>

POWer:SPECtrum:REPort:ADD

Adds the result to the report list.

Usage: Event
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POWer:SPECtrum:RESult<n>:FREQuency?

Queries the frequency of the n-th order.

Suffix: 
<n>

.
1..40

Return values: 
<FrequencyValue>

Usage: Query only

POWer:SPECtrum:RESult<n>:LEVel[:VALue]?

Queries the level of the n-th order.

Suffix: 
<n>

.
1..40

Return values: 
<LevelValue>

Usage: Query only

POWer:SPECtrum:RESult<n>:MAXimum?

Queries the maximum level of the n-th order.

Suffix: 
<n>

.
1..40

Return values: 
<LevelMaximum>

Usage: Query only

POWer:SPECtrum:RESult<n>:MEAN?

Queries the average level of the n-th order.

Suffix: 
<n>

.
1..40

Return values: 
<LevelAverage>

Usage: Query only

POWer:SPECtrum:RESult<n>:MINimum?

Queries the minimum level of the n-th order.

Suffix: 
<n>

.
1..40
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Return values: 
<LevelMinimum>

Usage: Query only

POWer:SPECtrum:RESult<n>:RESet

Resets the count of the measurements.

Suffix: 
<n>

.
1..40

Usage: Event

POWer:SPECtrum:RESult<n>:WFMCount?

Queries the number of waveforms, for which the spectrum was measured.

Suffix: 
<n>

.
1..40

Return values: 
<VaveformCount>

Usage: Query only

EXPort:POWer:NAME <ExportPath>

Defines the path and filename of the results file, available for current harmonics and
spectrum power measurements. The file format is CSV. If the file already exists, it will
be overwritten.

Parameters:
<ExportPath> string

String parameter

EXPort:POWer:SAVE

Saves statistical results of the indicated measurement place to the file that is defined
by the EXPort:POWer:NAME command.
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Example: Current harmonics measurement:
EXPort:POWer:NAME "/USB_FRONT/POWER/HARMONIC"
EXPort:POWer:SAVE

The file contains the following data:
"Power Analysis Results: Harmonics (CH2), 50 Hz, EN61000-3-2 A"
"Current: Fail (1 / 40)"
"Total Pass: 0; Total Fail: 2"
Order,Frequency[Hz],Level[V],Minimum[V],Maximum[V],Average[V],
Limit[V],State
1,5.0049E+01,8.06691E+00,8.06691E+00,2.43617E+01,1.62143E+01,
1.60000E+01,Fail
2,1.0010E+02,9.52154E-03,7.72160E-03,9.52154E-03,8.62157E-03,
1.08000E+00,Pass
3,1.5015E+02,3.51324E-03,3.51324E-03,5.07817E-02,2.71475E-02,
2.30000E+00,Pass
4,1.9958E+02,2.47575E-03,2.47575E-03,3.74720E-03,3.11148E-03,
4.30000E-01,Pass
5,2.5024E+02,5.88447E-03,5.88447E-03,3.02487E-02,1.80666E-02,
1.14000E+00,Pass
6,2.9968E+02,7.02598E-03,1.27264E-03,7.02598E-03,4.14931E-03,
3.00000E-01,Pass
...

Example: Spectrum measurement:
EXPort:POWer:NAME "/USB_FRONT/POWER/SPECTRUM"
EXPort:POWer:SAVE

The file contains the following data:
"Power Analysis Results: Spectrum (CH1), 100kHz"
"Total: 67"
Order,Frequency[Hz],Level[dBV],Minimum[dBV],Maximum[dBV],Average[dBV]
1,1.0009766E+05,-1.11840E+02,-1.19960E+02,-8.39799E+01,-1.03205E+02
2,1.9897461E+05,-1.03860E+02,-1.21000E+02,-8.97199E+01,-1.03222E+02
3,2.9907227E+05,-1.02660E+02,-1.22520E+02,-9.12399E+01,-1.03858E+02
4,4.0039062E+05,-1.08660E+02,-1.17400E+02,-9.24199E+01,-1.04547E+02
5,4.9926758E+05,-1.00340E+02,-1.11500E+02,-7.78199E+01,-9.44799E+01
6,6.0058594E+05,-1.10040E+02,-1.16040E+02,-9.39199E+01,-1.03913E+02
...

Usage: Event

18.14.11 Transient Response

POWer:TRANsient:EXECute...........................................................................................694
POWer:TRANsient:REPort:ADD......................................................................................694
POWer:TRANsient:RESult:DELay?..................................................................................694
POWer:TRANsient:RESult:OVERshoot?.......................................................................... 694
POWer:TRANsient:RESult:PEAK:TIME?.......................................................................... 694
POWer:TRANsient:RESult:PEAK:VALue?........................................................................ 694
POWer:TRANsient:RESult:RTIMe?..................................................................................695
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POWer:TRANsient:RESult:SETTlingtime?........................................................................695
POWer:TRANsient:SIGHigh............................................................................................695
POWer:TRANsient:SIGLow.............................................................................................695
POWer:TRANsient:STARt...............................................................................................695
POWer:TRANsient:STOP............................................................................................... 695

POWer:TRANsient:EXECute

Starts the transient response measurement.

Usage: Event

POWer:TRANsient:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:TRANsient:RESult:DELay?

Queries the delay time.

Return values: 
<DeleayTime>

Usage: Query only

POWer:TRANsient:RESult:OVERshoot?

Queries the overshoot.

Return values: 
<Overshoot>

Usage: Query only

POWer:TRANsient:RESult:PEAK:TIME?

Queries the peak time.

Return values: 
<PeakTime>

Usage: Query only

POWer:TRANsient:RESult:PEAK:VALue?

Queries the peak value.

Return values: 
<PeakValue>

Usage: Query only
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POWer:TRANsient:RESult:RTIMe?

Queries the rise time.

Return values: 
<RiseTime>

Usage: Query only

POWer:TRANsient:RESult:SETTlingtime?

Queries the settling time.

Return values: 
<SettlingTime>

Usage: Query only

POWer:TRANsient:SIGHigh <SignalHigh>

Sets the expected signal high voltage value.

Parameters:
<SignalHigh>

POWer:TRANsient:SIGLow <SignalLow>

Sets the expected signal low voltage value.

Parameters:
<SignalLow>

POWer:TRANsient:STARt <StartTime>

Sets the start time.

Parameters:
<StartTime>

POWer:TRANsient:STOP <StopTime>

Sets the stop time.

Parameters:
<StopTime>

18.14.12 Slew Rate

POWer:SLEWrate:DSAMple........................................................................................... 696
POWer:SLEWrate:DTIMe............................................................................................... 696
POWer:SLEWrate:EXECute............................................................................................696
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POWer:SLEWrate:REPort:ADD.......................................................................................696
POWer:SLEWrate:RESult:LPEak[:ACTual]?..................................................................... 696
POWer:SLEWrate:RESult:LPEak:AVG?........................................................................... 696
POWer:SLEWrate:RESult:LPEak:NPEak?........................................................................696
POWer:SLEWrate:RESult:LPEak:PPEak?........................................................................696
POWer:SLEWrate:RESult:LPEak:STDDev?......................................................................696
POWer:SLEWrate:RESult:LPEak:WFMCount?................................................................. 696
POWer:SLEWrate:RESult:UPEak[:ACTual]?.....................................................................697
POWer:SLEWrate:RESult:UPEak:AVG?.......................................................................... 697
POWer:SLEWrate:RESult:UPEak:NPEak?....................................................................... 697
POWer:SLEWrate:RESult:UPEak:PPEak?....................................................................... 697
POWer:SLEWrate:RESult:UPEak:STDDev?..................................................................... 697
POWer:SLEWrate:RESult:UPEak:WFMCount?.................................................................697

POWer:SLEWrate:DSAMple <DeltaSample>

Sets the number of samples that are used for the calculation of the slope.

Parameters:
<DeltaSample>

POWer:SLEWrate:DTIMe <DeltaTime>

Sets the delta time.

Parameters:
<DeltaTime>

POWer:SLEWrate:EXECute

Starts the slew rate measurement.

Usage: Event

POWer:SLEWrate:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:SLEWrate:RESult:LPEak[:ACTual]?
POWer:SLEWrate:RESult:LPEak:AVG?
POWer:SLEWrate:RESult:LPEak:NPEak?
POWer:SLEWrate:RESult:LPEak:PPEak?
POWer:SLEWrate:RESult:LPEak:STDDev?
POWer:SLEWrate:RESult:LPEak:WFMCount?
Returns the corresponding statistic result for "Vp-".

● [:ACTual]: current measurement result
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● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:SLEWrate:RESult:UPEak[:ACTual]?
POWer:SLEWrate:RESult:UPEak:AVG?
POWer:SLEWrate:RESult:UPEak:NPEak?
POWer:SLEWrate:RESult:UPEak:PPEak?
POWer:SLEWrate:RESult:UPEak:STDDev?
POWer:SLEWrate:RESult:UPEak:WFMCount?
Returns the corresponding statistic result for "Vp+".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

18.14.13 Modulation Analysis

POWer:MODulation:TYPE.............................................................................................. 698
POWer:MODulation:EXECute......................................................................................... 698
POWer:MODulation:REPort:ADD.....................................................................................698
POWer:MODulation:RESult:LPEak[:ACTual]?...................................................................698
POWer:MODulation:RESult:LPEak:AVG?.........................................................................698
POWer:MODulation:RESult:LPEak:NPEak?..................................................................... 698
POWer:MODulation:RESult:LPEak:PPEak?......................................................................698
POWer:MODulation:RESult:LPEak:STDDev?................................................................... 698
POWer:MODulation:RESult:LPEak:WFMCount?............................................................... 698
POWer:MODulation:RESult:MEAN[:ACTual]?................................................................... 699
POWer:MODulation:RESult:MEAN:AVG?.........................................................................699
POWer:MODulation:RESult:MEAN:NPEak?......................................................................699
POWer:MODulation:RESult:MEAN:PPEak?......................................................................699
POWer:MODulation:RESult:MEAN:STDDev?................................................................... 699
POWer:MODulation:RESult:MEAN:WFMCount?............................................................... 699
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POWer:MODulation:RESult:RMS[:ACTual]?..................................................................... 699
POWer:MODulation:RESult:RMS:AVG?........................................................................... 699
POWer:MODulation:RESult:RMS:NPEak?........................................................................699
POWer:MODulation:RESult:RMS:PPEak?........................................................................699
POWer:MODulation:RESult:RMS:STDDev?......................................................................699
POWer:MODulation:RESult:RMS:WFMCount?................................................................. 699
POWer:MODulation:RESult:STDDev[:ACTual]?................................................................ 700
POWer:MODulation:RESult:STDDev:AVG?......................................................................700
POWer:MODulation:RESult:STDDev:NPEak?...................................................................700
POWer:MODulation:RESult:STDDev:PPEak?...................................................................700
POWer:MODulation:RESult:STDDev:STDDev?.................................................................700
POWer:MODulation:RESult:STDDev:WFMCount?............................................................ 700
POWer:MODulation:RESult:UPEak[:ACTual]?.................................................................. 700
POWer:MODulation:RESult:UPEak:AVG?........................................................................ 700
POWer:MODulation:RESult:UPEak:NPEak?.....................................................................700
POWer:MODulation:RESult:UPEak:PPEak?..................................................................... 700
POWer:MODulation:RESult:UPEak:STDDev?...................................................................700
POWer:MODulation:RESult:UPEakWFMCount?............................................................... 700

POWer:MODulation:TYPE <ModulationType>

Sets the modulation type.

Parameters:
<ModulationType> PERiod | FREQuencyPDCYcle | NDCYclePPWidth | NPWidth

POWer:MODulation:EXECute

Starts the modulation analysis measurement.

Usage: Event

POWer:MODulation:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:MODulation:RESult:LPEak[:ACTual]?
POWer:MODulation:RESult:LPEak:AVG?
POWer:MODulation:RESult:LPEak:NPEak?
POWer:MODulation:RESult:LPEak:PPEak?
POWer:MODulation:RESult:LPEak:STDDev?
POWer:MODulation:RESult:LPEak:WFMCount?
Returns the corresponding statistic result for "Vp-".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
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● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:MODulation:RESult:MEAN[:ACTual]?
POWer:MODulation:RESult:MEAN:AVG?
POWer:MODulation:RESult:MEAN:NPEak?
POWer:MODulation:RESult:MEAN:PPEak?
POWer:MODulation:RESult:MEAN:STDDev?
POWer:MODulation:RESult:MEAN:WFMCount?
Returns the corresponding statistic result for "Mean".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:MODulation:RESult:RMS[:ACTual]?
POWer:MODulation:RESult:RMS:AVG?
POWer:MODulation:RESult:RMS:NPEak?
POWer:MODulation:RESult:RMS:PPEak?
POWer:MODulation:RESult:RMS:STDDev?
POWer:MODulation:RESult:RMS:WFMCount?
Returns the corresponding statistic result for RMS.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only
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POWer:MODulation:RESult:STDDev[:ACTual]?
POWer:MODulation:RESult:STDDev:AVG?
POWer:MODulation:RESult:STDDev:NPEak?
POWer:MODulation:RESult:STDDev:PPEak?
POWer:MODulation:RESult:STDDev:STDDev?
POWer:MODulation:RESult:STDDev:WFMCount?
Returns the corresponding statistic result for the standard deviation.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:MODulation:RESult:UPEak[:ACTual]?
POWer:MODulation:RESult:UPEak:AVG?
POWer:MODulation:RESult:UPEak:NPEak?
POWer:MODulation:RESult:UPEak:PPEak?
POWer:MODulation:RESult:UPEak:STDDev?
POWer:MODulation:RESult:UPEakWFMCount?
Returns the corresponding statistic result for "Vp+".

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

18.14.14 Dynamic ON Resistance

POWer:DONResistance:EXECute................................................................................... 701
POWer:DONResistance:GATE<n>:START.......................................................................701
POWer:DONResistance:GATE<n>STOP......................................................................... 701
POWer:DONResistance:RESult:DONResistance?.............................................................701
POWer:DONResistance:REPort:ADD.............................................................................. 701
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POWer:DONResistance:EXECute

Starts the dynamic ON resistance measurement.

Usage: Event

POWer:DONResistance:GATE<n>:START

Sets the start time for the corresponding gate.

Suffix: 
<n>

.
1..2

Return values: 
<StartTime>

POWer:DONResistance:GATE<n>STOP

Sets the stop time for the corresponding gate.

Suffix: 
<n>

.
1..2

Return values: 
<StopTime>

POWer:DONResistance:RESult:DONResistance?

Queries the dynamic ON resistance value.

Return values: 
<Value>

Usage: Query only

POWer:DONResistance:REPort:ADD

Adds the result to the report list.

Usage: Event

18.14.15 Efficiency

POWer:EFFiciency:EXECute.......................................................................................... 702
POWer:EFFiciency:REPort:ADD......................................................................................702
POWer:EFFiciency:RESult:EFFiciency[:ACTual]?..............................................................702
POWer:EFFiciency:RESult:EFFiciency:AVG?................................................................... 702
POWer:EFFiciency:RESult:EFFiciency:NPEak?................................................................ 702
POWer:EFFiciency:RESult:EFFiciency:PPEak?................................................................ 702
POWer:EFFiciency:RESult:EFFiciency:STDDev?..............................................................702
POWer:EFFiciency:RESult:EFFiciency:WFMCount?..........................................................702
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POWer:EFFiciency:RESult:INPut:REALpower[:ACTual]?................................................... 702
POWer:EFFiciency:RESult:INPut:REALpower:AVG?......................................................... 702
POWer:EFFiciency:RESult:INPut:REALpower:NPEak?......................................................702
POWer:EFFiciency:RESult:INPut:REALpower:PPEak?......................................................703
POWer:EFFiciency:RESult:INPut:REALpower:STDDev?....................................................703
POWer:EFFiciency:RESult:INPut:REALpower:WFMCount?............................................... 703
POWer:EFFiciency:RESult:OUTPut:REALpower[:ACTual]?................................................703
POWer:EFFiciency:RESult:OUTPut:REALpower:AVG?..................................................... 703
POWer:EFFiciency:RESult:OUTPut:REALpower:NPEak?.................................................. 703
POWer:EFFiciency:RESult:OUTPut:REALpower:PPEak?.................................................. 703
POWer:EFFiciency:RESult:OUTPut:REALpower:STDDev?................................................ 703
POWer:EFFiciency:RESult:OUTPut:REALpower:WFMCount?............................................703

POWer:EFFiciency:EXECute

Starts the efficiency measurement.

Usage: Event

POWer:EFFiciency:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:EFFiciency:RESult:EFFiciency[:ACTual]?
POWer:EFFiciency:RESult:EFFiciency:AVG?
POWer:EFFiciency:RESult:EFFiciency:NPEak?
POWer:EFFiciency:RESult:EFFiciency:PPEak?
POWer:EFFiciency:RESult:EFFiciency:STDDev?
POWer:EFFiciency:RESult:EFFiciency:WFMCount?
Returns the corresponding statistic result for the efficiency.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:EFFiciency:RESult:INPut:REALpower[:ACTual]?
POWer:EFFiciency:RESult:INPut:REALpower:AVG?
POWer:EFFiciency:RESult:INPut:REALpower:NPEak?
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POWer:EFFiciency:RESult:INPut:REALpower:PPEak?
POWer:EFFiciency:RESult:INPut:REALpower:STDDev?
POWer:EFFiciency:RESult:INPut:REALpower:WFMCount?
Returns the corresponding statistic result for the input real power.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

POWer:EFFiciency:RESult:OUTPut:REALpower[:ACTual]?
POWer:EFFiciency:RESult:OUTPut:REALpower:AVG?
POWer:EFFiciency:RESult:OUTPut:REALpower:NPEak?
POWer:EFFiciency:RESult:OUTPut:REALpower:PPEak?
POWer:EFFiciency:RESult:OUTPut:REALpower:STDDev?
POWer:EFFiciency:RESult:OUTPut:REALpower:WFMCount?
Returns the corresponding statistic result for the output real power.

● [:ACTual]: current measurement result
● AVG: average of the long-term measurement results
● NPEak: negative peak value of the long-term measurement results
● PPEak: positive peak value of the long-term measurement results
● STDDev: standard deviation of the long-term measurement results
● WFMCount: the number of waveforms used for the displayed results

Return values: 
<WaveformCount>

Usage: Query only

18.14.16 Switching Loss

POWer:SWITching:TYPE................................................................................................704
POWer:SWITching:EXECute...........................................................................................704
POWer:SWITching:GATE:CONDuction:STARt..................................................................704
POWer:SWITching:GATE:CONDuction:STOP.................................................................. 704
POWer:SWITching:GATE:NCONduction:STARt................................................................704
POWer:SWITching:GATE:NCONduction:STOP.................................................................705
POWer:SWITching:GATE:SWAVe...................................................................................705
POWer:SWITching:GATE:TOFF:STARt........................................................................... 705
POWer:SWITching:GATE:TOFF:STOP............................................................................ 705
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POWer:SWITching:GATE:TON:STARt.............................................................................705
POWer:SWITching:GATE:TON:STOP..............................................................................705
POWer:SWITching:REPort:ADD......................................................................................705
POWer:SWITching:RESult:CONDuction:ENERgy?............................................................706
POWer:SWITching:RESult:CONDuction:POWer?..............................................................706
POWer:SWITching:RESult:NCONduction:ENERgy?..........................................................706
POWer:SWITching:RESult:NCONduction:POWer?............................................................706
POWer:SWITching:RESult:TOFF:ENERgy?..................................................................... 706
POWer:SWITching:RESult:TOFF:POWer?....................................................................... 706
POWer:SWITching:RESult:TON:ENERgy?....................................................................... 707
POWer:SWITching:RESult:TON:POWer?.........................................................................707
POWer:SWITching:RESult:TOTal:ENERgy?.....................................................................707
POWer:SWITching:RESult:TOTal:POWer?.......................................................................707

POWer:SWITching:TYPE <MeasureType>

Sets the measurement type for the switching loss maesurment.

Parameters:
<MeasureType> ENERgy | POWer

POWer:SWITching:EXECute

Starts the switching loss measurement.

Usage: Event

POWer:SWITching:GATE:CONDuction:STARt <StartTime>

Sets the start time for the conduction gate. This value is simultaneously the stop time
for the turn on gate.

Parameters:
<StartTime>

POWer:SWITching:GATE:CONDuction:STOP <StopTime>

Sets the stop time for the conduction gate. This value is simultaneously the start time
for the turn off gate.

Parameters:
<StopTime>

POWer:SWITching:GATE:NCONduction:STARt <StartTime>

Sets the start time for the non conduction gate. This value is simultaneously the stop
time for the turn off gate.

Parameters:
<StartTime>
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POWer:SWITching:GATE:NCONduction:STOP <StopTime>

Sets the stop time for the non conduction gate.

Parameters:
<StopTime>

POWer:SWITching:GATE:SWAVe

Sets the cursor on the waveform.

Usage: Event

POWer:SWITching:GATE:TOFF:STARt <StartTime>

Sets the start time for the turn off gate. This value is simultaneously the stop time for
the conduction gate.

Parameters:
<StartTime>

POWer:SWITching:GATE:TOFF:STOP <StopTime>

Sets the stop time for the turn off gate.

Parameters:
<StopTime>

POWer:SWITching:GATE:TON:STARt <StartTime>

Sets the start time for the turn on gate.

Parameters:
<StartTime>

POWer:SWITching:GATE:TON:STOP <StopTime>

Sets the stop time for the turn on gate.

Parameters:
<StopTime>

POWer:SWITching:REPort:ADD

Adds the result to the report list.

Usage: Event
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POWer:SWITching:RESult:CONDuction:ENERgy?

Queries the conduction energy.

Return values: 
<ConductionEnergy>

Usage: Query only

POWer:SWITching:RESult:CONDuction:POWer?

Queries the conduction power.

Return values: 
<ConductionPower>

Usage: Query only

POWer:SWITching:RESult:NCONduction:ENERgy?

Queries the non conduction energy.

Return values: 
<NonConductionEnergy>

Usage: Query only

POWer:SWITching:RESult:NCONduction:POWer?

Queries the non conduction power.

Return values: 
<NonConductionPower>

Usage: Query only

POWer:SWITching:RESult:TOFF:ENERgy?

Queries the turn off energy.

Return values: 
<TurnOffEnergy>

Usage: Query only

POWer:SWITching:RESult:TOFF:POWer?

Queries the turn off power.

Return values: 
<TurnOffPower>

Usage: Query only
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POWer:SWITching:RESult:TON:ENERgy?

Queries the turn on energy.

Return values: 
<TurnOnEnergy>

Usage: Query only

POWer:SWITching:RESult:TON:POWer?

Queries the turn on power.

Return values: 
<TurnOnPower>

Usage: Query only

POWer:SWITching:RESult:TOTal:ENERgy?

Queries the total energy.

Return values: 
<TotalEnergy>

Usage: Query only

POWer:SWITching:RESult:TOTal:POWer?

Queries the total power.

Return values: 
<TotalPower>

Usage: Query only

18.14.17 Turn ON/OFF

POWer:ONOFf:EXECute................................................................................................ 707
POWer:ONOFf:MEASurement.........................................................................................707
POWer:ONOFf:REPort:ADD........................................................................................... 708
POWer:ONOFf:RESult<n>:TIME?................................................................................... 708

POWer:ONOFf:EXECute

Starts the turn on/off measurement.

Usage: Event

POWer:ONOFf:MEASurement <MeasureType>

Selects the turn on or the turn off measurement.
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Parameters:
<MeasureType> TON | TOFF

*RST: TON

POWer:ONOFf:REPort:ADD

Adds the result to the report list.

Usage: Event

POWer:ONOFf:RESult<n>:TIME?

Queries the turn on/ turn off time.

Suffix: 
<n>

.
1..3

Return values: 
<Value>

Usage: Query only

18.14.18 Safe Operating Area (S.O.A.)

18.14.18.1 S.O.A. Settings

POWer:SOA:EXECute....................................................................................................708
POWer:SOA:RESTart.....................................................................................................709
POWer:SOA:SCALe:MASK.............................................................................................709
POWer:SOA:SCALe:DISPlay.......................................................................................... 709
POWer:SOA:LINear:ADD................................................................................................709
POWer:SOA:LOGarithmic:ADD....................................................................................... 709
POWer:SOA:LINear:INSert............................................................................................. 709
POWer:SOA:LOGarithmic:INSert.....................................................................................709
POWer:SOA:LINear:POINt<m>:CURRent........................................................................ 709
POWer:SOA:LOGarithmic:POINt<m>:CURRent................................................................709
POWer:SOA:LINear:POINt<m>:CURRent:MAXimum........................................................ 710
POWer:SOA:LOGarithmic:POINt<m>:CURRent:MAXimum................................................ 710
POWer:SOA:LINear:POINt<m>:CURRent:MINimum..........................................................710
POWer:SOA:LOGarithmic:POINt<m>:CURRent:MINimum................................................. 710
POWer:SOA:LINear:POINt<m>:VOLTage........................................................................ 710
POWer:SOA:LOGarithmic:POINt<m>:VOLTage................................................................710
POWer:SOA:LINear:REMove..........................................................................................710
POWer:SOA:LOGarithmic:REMove................................................................................. 710

POWer:SOA:EXECute

Starts the safe operating area (S.O.A.) measurement.
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Usage: Event

POWer:SOA:RESTart

Restarts the measurement.

Usage: Event

POWer:SOA:SCALe:MASK <>

Sets the scale for the mask, linear or logarithmic.

POWer:SOA:SCALe:DISPlay <>

Sets a linear or a logarithmic scaled for the displayed results.

POWer:SOA:LINear:ADD
POWer:SOA:LOGarithmic:ADD
Adds a point to the safe operation area definition list.

Usage: Event

POWer:SOA:LINear:INSert <InsertIndex>
POWer:SOA:LOGarithmic:INSert <InsertIndex>

Inserts a point with the selected insert index in the list of the safe operating area mask
definition.

Setting parameters: 
<InsertIndex>

Usage: Setting only

POWer:SOA:LINear:POINt<m>:CURRent <Current>
POWer:SOA:LOGarithmic:POINt<m>:CURRent <Current>

Sets the maximum current for the indicated mask point. The minimum current is set to
0.

Suffix: 
<m>

.
*
Index of the mask point

Parameters:
<Current> Imax value
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POWer:SOA:LINear:POINt<m>:CURRent:MAXimum <MinimumCurrent>
POWer:SOA:LOGarithmic:POINt<m>:CURRent:MAXimum <MinimumCurrent>

Sets the maximum current for the corresponding point.

Suffix: 
<m>

.
*

Parameters:
<MinimumCurrent>

POWer:SOA:LINear:POINt<m>:CURRent:MINimum <MaximumCurrent>
POWer:SOA:LOGarithmic:POINt<m>:CURRent:MINimum <MaximumCurrent>

Sets the minimum current for the corresponding point.

Suffix: 
<m>

.
*

Parameters:
<MaximumCurrent>

POWer:SOA:LINear:POINt<m>:VOLTage <Voltage>
POWer:SOA:LOGarithmic:POINt<m>:VOLTage <Voltage>

Sets the voltage for the corresponding point.

Suffix: 
<m>

.
*

Parameters:
<Voltage>

POWer:SOA:LINear:REMove <RemoveIndex>
POWer:SOA:LOGarithmic:REMove <RemoveIndex>

Removes the point with the selcted index from the list of the safe operating area mask
definition.

Setting parameters: 
<RemoveIndex>

Usage: Setting only

18.14.19 S.O.A. Results

POWer:SOA:RESult:ACQuisition:TOLerance....................................................................711
POWer:SOA:RESult:TOTal:TOLerance............................................................................711
POWer:SOA:LINear:COUNt?.......................................................................................... 712
POWer:SOA:LOGarithmic:COUNt?..................................................................................712
POWer:SOA:RESult:ACQuisition:FAILed?........................................................................712
POWer:SOA:RESult:ACQuisition:FRATe?........................................................................712
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POWer:SOA:RESult:ACQuisition:PASSed?......................................................................712
POWer:SOA:RESult:ACQuisition:POINts?........................................................................712
POWer:SOA:RESult:ACQuisition:STATe?........................................................................ 712
POWer:SOA:RESult:ACQuisition:VCOunt?.......................................................................713
POWer:SOA:RESult:ACQuisition:VIOLation<n>?.............................................................. 713
POWer:SOA:RESult:ACQuisition:VIOLation<n>:VOLTage?............................................... 713
POWer:SOA:RESult:ACQuisition:VIOLation<n>:CURRent?............................................... 713
POWer:SOA:RESult:TOTal:SAMPle:COUNt?................................................................... 713
POWer:SOA:RESult:TOTal:SAMPle:FAILed?................................................................... 714
POWer:SOA:RESult:TOTal:SAMPle:PASSed?................................................................. 714
POWer:SOA:RESult:TOTal:COUNt?................................................................................714
POWer:SOA:RESult:TOTal:FAILed?................................................................................714
POWer:SOA:RESult:TOTal:FRATe?................................................................................ 714
POWer:SOA:RESult:TOTal:PASSed?.............................................................................. 714
POWer:SOA:RESult:TOTal:STATe?................................................................................ 715
POWer:SOA:RESult:TOTal:VCOunt?...............................................................................715
POWer:SOA:RESult:TOTal:VIOLation<n>?...................................................................... 715
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent?........................................................715
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage?........................................................715
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA?.............................................. 716
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA?.............................................. 716
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:HEADer?................................. 716
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:HEADer?................................. 716
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:XINCrement?........................... 716
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:XINCrement?........................... 716
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:XORigin?................................. 716
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:XORigin?................................. 716
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YINCrement?........................... 716
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YINCrement?........................... 716
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YORigin?................................. 717
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YORigin?................................. 717
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YRESolution?...........................717
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YRESolution?...........................717

POWer:SOA:RESult:ACQuisition:TOLerance <Tolerance>

Sets acquisition tolerance in percent.

Parameters:
<Tolerance>

POWer:SOA:RESult:TOTal:TOLerance <Tolerance>

Sets total tolerance in percent.

Parameters:
<Tolerance>
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POWer:SOA:LINear:COUNt?
POWer:SOA:LOGarithmic:COUNt?
Queries the number of points that included in the safe operating area mask description.

Return values: 
<PointsCount>

Usage: Query only

POWer:SOA:RESult:ACQuisition:FAILed?

Returns the number of points that failed, i.e they are not within the defined safe operat-
ing area.

Return values: 
<FailedPoints>

Usage: Query only

POWer:SOA:RESult:ACQuisition:FRATe?

Returns the total point fail rate, i.e the ratio of point hits to the number of tested points
for the current acquisition.

Return values: 
<FailRate>

Usage: Query only

POWer:SOA:RESult:ACQuisition:PASSed?

Returns the number of passed points, i.e they are within the defined safe operating
area.

Return values: 
<PassedPoints>

Usage: Query only

POWer:SOA:RESult:ACQuisition:POINts?

Returns the number of points, considered for the current acquisition.

Return values: 
<Points>

Usage: Query only

POWer:SOA:RESult:ACQuisition:STATe?

Returns the result, passed or failed, of the current aqcuisition measurement.
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Return values: 
<AcquisitionState> 0 | 1

Usage: Query only

POWer:SOA:RESult:ACQuisition:VCOunt?

Returns the acquisition violation count.

Return values: 
<ViolationCount>

Usage: Query only

POWer:SOA:RESult:ACQuisition:VIOLation<n>?

Returns the current and voltage value for the corresponding acquisition violation.

Return values: 
<Current>

<Voltage>

Usage: Query only

POWer:SOA:RESult:ACQuisition:VIOLation<n>:VOLTage?

Returns the voltage value for the corresponding acquisition violation point.

Suffix: 
<n>

.
*

Return values: 
<Voltage>

Usage: Query only

POWer:SOA:RESult:ACQuisition:VIOLation<n>:CURRent?

Returns the current value for the corresponding acquisition violation point.

Suffix: 
<n>

.
*

Return values: 
<Current>

Usage: Query only

POWer:SOA:RESult:TOTal:SAMPle:COUNt?

Returns the total number of samples used to determine the total result.

Usage: Query only

Power Analysis (Option R&S RTM-K31)
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POWer:SOA:RESult:TOTal:SAMPle:FAILed?

Returns the total number of failed samples, i.e they are not within the defined safe
operating area.

Usage: Query only

POWer:SOA:RESult:TOTal:SAMPle:PASSed?

Returns the number of passed samples, i.e they are within the defined safe operating
area.

Usage: Query only

POWer:SOA:RESult:TOTal:COUNt?

Returns the total number of acquisitions used to determine the total result.

Return values: 
<AcquisitionCount>

Usage: Query only

POWer:SOA:RESult:TOTal:FAILed?

Returns the total number of failed acquisitions, i.e they are not within the defined safe
operating area.

Return values: 
<FailedAcquisitions>

Usage: Query only

POWer:SOA:RESult:TOTal:FRATe?

Returns the total acquisition fail rate, i.e the ratio of acquisition hits to the number of
tested acquisitions.

Return values: 
<FailRate>

Usage: Query only

POWer:SOA:RESult:TOTal:PASSed?

Returns the number of passed acquisitions, i.e they are within the defined safe operat-
ing area.

Return values: 
<PassedAcquisitions>

Usage: Query only
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POWer:SOA:RESult:TOTal:STATe?

Returns the result, passed or failed, of the total measurement.

Return values: 
<TotalState> 0 | 1

Usage: Query only

POWer:SOA:RESult:TOTal:VCOunt?

Returns the total violation count.

Return values: 
<ViolationCount>

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>?

Returns the current and voltage value for the corresponding total violation.

Return values: 
<Current>

<Voltage>

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent?

Returns the current of the total violation.

Suffix: 
<n>

.
*

Return values: 
<Current>

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage?

Returns the voltage of the total violation.

Suffix: 
<n>

.
*

Return values: 
<Voltage>

Usage: Query only
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POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA?
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA?
Returns the data of the total voltage violation waveform in the same way as
CHANnel<m>:DATA?.

Return values: 
<Header> StringData

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:HEADer?
POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:HEADer?
Returns information on the total violation current.

Return values: 
<Header> StringData

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:XINCrement?
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.

Return values: 
<Xincrement>

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:XORigin?
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:XORigin?
Return the time of the first sample of the indicated waveform.

Return values: 
<Xorigin>

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YINCrement?
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform.

Return values: 
<Yincrement>

Usage: Query only
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POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YORigin?
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated waveform.

Return values: 
<Yorigin>

Usage: Query only

POWer:SOA:RESult:TOTal:VIOLation<n>:CURRent:DATA:YRESolution?
POWer:SOA:RESult:TOTal:VIOLation<n>:VOLTage:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.

Return values: 
<Yresolution>

Usage: Query only

18.15 Mixed Signal Option (MSO, R&S RTM-B1)

● Digital Channels - Activity Display.........................................................................717
● Digital Channels - Configuration........................................................................... 718
● Waveform Data..................................................................................................... 721
● Parallel Buses....................................................................................................... 723

18.15.1 Digital Channels - Activity Display

DIGital<m>:CURRent:STATe:MAXimum?
DIGital<m>:CURRent:STATe:MINimum?
Both commands together return the current status of the indicated digital channel
regardless of the trigger settings, and even without any acquisition.

DIG:CURR:STAT:MIN returns DIG:CURR:STAT:MAX returns Signal

0 0 Low

1 1 High

0 1 Toggle

Suffix: 
<m>

.
0..15
Selects the digital channel

Return values: 
<CurrentState> Range: 0 | 1

Usage: Query only
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18.15.2 Digital Channels - Configuration

DIGital<m>:DISPlay....................................................................................................... 718
DIGital<m>:TECHnology.................................................................................................718
DIGital<m>:THReshold...................................................................................................718
DIGital<m>:THCoupling..................................................................................................719
DIGital<m>:Hysteresis....................................................................................................719
DIGital<m>:DESKew......................................................................................................719
DIGital<m>:SIZE............................................................................................................719
DIGital<m>:POSition...................................................................................................... 720
DIGital<m>:LABel.......................................................................................................... 720
DIGital<m>:LABel:STATe............................................................................................... 720

DIGital<m>:DISPlay <State>

Enables and displays the indicated digital channel, or disables it.

Suffix: 
<m>

.
0..15
Number of the digital channel

Parameters:
<State> ON | OFF

*RST: OFF

DIGital<m>:TECHnology <ThresholdMode>

Selects the threshold voltage for various types of integrated circuits and applies it to
the channel group to which the indicated digital channel belongs.

Suffix: 
<m>

.
0..15
Number of the digital channel.
Channel groups: 0..3; 4..7; 8..11; 12..15

Parameters:
<ThresholdMode> TTL | ECL | CMOS | MANual

TTL: 1.4 V
ECL: -1.3 V
CMOS: 2.5 V
MANual: Set a user-defined threshold value with DIGital<m>:
THReshold
*RST: MAN

DIGital<m>:THReshold <ThresholdLevel>

Sets the logical threshold for the channel group to which the indicated digital channel
belongs.
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Suffix: 
<m>

.
0..15
Number of the digital channel.
Channel groups: 0..3; 4..7; 8..11; 12..15

Parameters:
<ThresholdLevel> *RST: 1.4

Default unit: V

DIGital<m>:THCoupling <ThresholdCoupling>

Applies the last defined threshold and hysteresis values to all digital channels.

Suffix: 
<m>

.
0..15
Number of the digital channel

Parameters:
<ThresholdCoupling> ON | OFF

DIGital<m>:Hysteresis

Defines the size of the hysteresis to avoid the change of signal states due to noise.
The setting applied to the channel group to which the indicated digital channel belongs.

Suffix: 
<m>

.
0..15
Number of the digital channel.
Channel groups: 0..3; 4..7; 8..11; 12..15

Parameters:
<Hysteresis> MAXimum | ROBust | NORMal

DIGital<m>:DESKew <Deskew>

Sets the deskew value for the specified logic channel. The deskew value compensates
delays that are known from the circuit specifics or caused by the different length of
cables. The skew between the probe boxes of the digital channels and the probe con-
nectors of the analog channels is automatically aligned by the instrument.

Suffix: 
<m>

.
0..15
Selects the digital channel

Parameters:
<Deskew> *RST: 0

Default unit: s

DIGital<m>:SIZE <Size>

Sets the size of the indicated vertical channel.
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Suffix: 
<m>

.
0..15
Number of the digital channel

Parameters:
<Size> SMALl | MEDium | LARGe | DIV1 | DIV2 | DIV4 | DIV8

DIV1 | DIV2 | DIV4 | DIV8
1, 2, 4, or 8 divisions per digital channel
SMALl | MEDium | LARGe
Size of the indicated digital channel is smaller than 1 div, about
1/4, 1/3, or 1/2 division, respectively.
*RST: SMAL

DIGital<m>:POSition <Position>

Sets the vertical position of the indicated vertical channel.

Suffix: 
<m>

.
0..15
Number of the digital channel

Parameters:
<Position> Vertical position in divisions

Default unit: DIV

DIGital<m>:LABel <Label>

Defines a label for the indicated digital channel.

Suffix: 
<m>

.
0..15
Number of the digital channel

Parameters:
<Label> String value

String parameter

Example: DIGital4:LABel "Data"
Defines the label "Data" dor digital channel D4.

DIGital<m>:LABel:STATe <State>

Displays or hides the label of the indicated digital channel.

Suffix: 
<m>

.
0..15
Number of the digital channel

Parameters:
<State> ON | OFF

*RST: OFF
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18.15.3 Waveform Data

For data queries and conversion, consider also the following commands:
● FORMat[:DATA] on page 731
● DIGital<m>:DATA:XINCrement? on page 742
● DIGital<m>:DATA:XORigin? on page 742
● DIGital<m>:DATA:YINCrement? on page 743
● DIGital<m>:DATA:YORigin? on page 743
● DIGital<m>:DATA:YRESolution? on page 743

DIGital<m>:DATA?.........................................................................................................721
DIGital<m>:DATA:HEADer?............................................................................................721
DIGital<m>:DATA:POINts...............................................................................................722

DIGital<m>:DATA?

Returns the data of the specified digital channel for transmission from the instrument to
the controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

To set the range of samples to be returned, use DIGital<m>:DATA:POINts.

Suffix: 
<m>

.
0..15
Selects the digital channel

Parameters:
<WaveformData> List of values according to the format settings.

Example: FORM ASC,0
DIG1:DATA?
1,1,1,1,1,1,0,0,0,0,0,0,...

Usage: Query only

DIGital<m>:DATA:HEADer?

Returns information on the specified digital channel waveform.

Table 18-8: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1
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Suffix: 
<m>

.
0..15
Selects the digital channel

Parameters:
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

DIGital<m>:DATA:POINts <PointSelection>

As a setting, the command selects a range of samples that will be returned with
DIGital<m>:DATA?. As a query, it returns the number of returned samples for the
selected range.

If ACQuire:WRATe is set to MSAMples (maximum sample rate), the memory usually
contains more data samples than the screen can display. In this case, you can decide
which data will be saved: samples stored in the memory or only the displayed samples.

Note: The sample range can be changed only in STOP mode. If the acquisition is run-
ning, DEF is always used automatically. If the acquisition has been stopped, data can
be read from the memory, and all settings are available.

Suffix: 
<m>

.
0..15
Selects the digital channel

Setting parameters: 
<PointSelection> DEFault | MAXimum | DMAXimum

Sets the range for data queries.
DEFault
Waveform samples that are visible as waveform points on the
screen.
MAXimum
All waveform samples that are stored in the memory. Only avail-
able if acquisition is stopped.
DMAXimum
Display maximum: Waveform samples stored in the current
waveform record but only for the displayed time range. At maxi-
mum waveform rate, the instrument stores more samples than
visible on the screen, and DMAX returns more values than DEF.
Only available if acquisition is stopped.
*RST: DEFault

Return values: 
<Points> Number of data points in the selected range.

Default unit: Samples

See also: CHANnel<m>:DATA:POINts
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18.15.4 Parallel Buses

● Parallel Bus - Line Configuration...........................................................................723
● Parallel Clocked Bus - Control Wires Configuration..............................................724
● Parallel Buses - Decode Results...........................................................................725

18.15.4.1 Parallel Bus - Line Configuration

BUS<b>:PARallel:WIDTh <BusWidth>

Sets the number of lines to be analyzed.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<BusWidth> Range: 1  to  16

Increment: 1
*RST: 8
Default unit: Bit

BUS<b>:CPARallel:WIDTh <BusWidth>

Sets the number of lines to be analyzed.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<BusWidth> Range: 1  to  15 (clock only) or 14 (clock and CS)

Increment: 1
*RST: 4
Default unit: Bit

BUS<b>:PARallel:DATA<m>:SOURce <DataSource>
BUS<b>:CPARallel:DATA<m>:SOURce <DataSource>

Defines the digital channel that is assigned to the selected bit.

Use the command for each bit of the bus.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

<m> Sets the bit number.

Parameters:
<DataSource> D0..D15
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Example: BUS:PARallel:Width 4
BUS:PARallel:DATA0:SOURce D8
BUS:PARallel:DATA1:SOURce D9
BUS:PARallel:DATA2:SOURce D10
BUS:PARallel:DATA3:SOURce D11

18.15.4.2 Parallel Clocked Bus - Control Wires Configuration

BUS<b>:CPARallel:CLOCk:SOURce............................................................................... 724
BUS<b>:CPARallel:CLOCK:SLOPe.................................................................................724
BUS<b>:CPARallel:CS:ENABle.......................................................................................724
BUS<b>:CPARallel:CS:SOURce..................................................................................... 725
BUS<b>:CPARallel:CS:POLarity..................................................................................... 725

BUS<b>:CPARallel:CLOCk:SOURce <ClockSource>

Selects the digital channel that is used as clock line.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<ClockSource> D0..D15

*RST: D0

BUS<b>:CPARallel:CLOCK:SLOPe <ClockSlope>

Selects if the data is sampled on the rising or falling slope of the clock, or on both
edges (EITHer). The clock slope marks the begin of a new bit.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<ClockSlope> POSitive | NEGative | EITHer

BUS<b>:CPARallel:CS:ENABle <ChipSelectEnable>

Enables and disables the chip select line.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<ChipSelectEnable> ON | OFF

*RST: ON
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BUS<b>:CPARallel:CS:SOURce <ChipSelectSource>

Selects the digital channel that is used as chip select line.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<ChipSelectSource> D0..D15

*RST: D1

BUS<b>:CPARallel:CS:POLarity <Polarity>

Selects wether the chip select signal is high active (high = 1) or low active (low = 1).

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active

18.15.4.3 Parallel Buses - Decode Results

The commands to query results of decoded parallel clocked and unclocked buses are
similar and described together in this chapter..

BUS<b>:PARallel:FCOunt?.............................................................................................725
BUS<b>:CPARallel:FCOunt?.......................................................................................... 725
BUS<b>:PARallel:FRAMe<n>:DATA?..............................................................................726
BUS<b>:CPARallel:FRAMe<n>:DATA?............................................................................726
BUS<b>:PARallel:FRAMe<n>:STATe?............................................................................ 726
BUS<b>:CPARallel:FRAMe<n>:STATe?.......................................................................... 726
BUS<b>:PARallel:FRAMe<n>:STARt?.............................................................................726
BUS<b>:CPARallel:FRAMe<n>:STARt?...........................................................................726
BUS<b>:PARallel:FRAMe<n>:STOP?..............................................................................727
BUS<b>:CPARallel:FRAMe<n>:STOP?........................................................................... 727

BUS<b>:PARallel:FCOunt?
BUS<b>:CPARallel:FCOunt?
Returns the number of decoded frames.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

Return values: 
<FrameCount> Total number of decoded frames.
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Usage: Query only

BUS<b>:PARallel:FRAMe<n>:DATA?
BUS<b>:CPARallel:FRAMe<n>:DATA?
Returns the data words of the specified frame.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

<n> *
Selects the frame.

Return values: 
<FrameData> List of decimal values of data words

Usage: Query only

BUS<b>:PARallel:FRAMe<n>:STATe?
BUS<b>:CPARallel:FRAMe<n>:STATe?
Returns the overall state of the specified frame.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

<n> *
Selects the frame.

Return values: 
<FrameStatus> OK | ERRor | INSufficient

Usage: Query only

BUS<b>:PARallel:FRAMe<n>:STARt?
BUS<b>:CPARallel:FRAMe<n>:STARt?
Returns the start time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

<n> *
Selects the frame.

Return values: 
<StartTime> Default unit: s

Usage: Query only
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BUS<b>:PARallel:FRAMe<n>:STOP?
BUS<b>:CPARallel:FRAMe<n>:STOP?
Returns the end time of the specified frame.

Suffix: 
<b>

.
1..4
Selects the parallel bus.

<n> *
Selects the frame.

Return values: 
<StopTime> Default unit: s

Usage: Query only

18.16 Digital Voltmeter and Counter (Option R&S RTM-K32)

18.16.1 Counter Settings and Results

TCOunter<t>:ENAB........................................................................................................727
TCOunter<t>:RESult[:ACTual]:FREQuency?.....................................................................727
TCOunter<t>:RESult[:ACTual]:PERiod?........................................................................... 728

TCOunter<t>:ENAB <Enable>

Enables or disables the trigger counter measurements.

Suffix: 
<t>

.
1..2
The suffix is irrelevant.

Parameters:
<Enable> ON | OFF

*RST: OFF

TCOunter<t>:RESult[:ACTual]:FREQuency?

Returns the frequency of the trigger source.

Suffix: 
<t>

.
1..2
1 = A-trigger source, 2 = B-trigger source

Return values: 
<FrequencyValue> Default unit: Hz

Usage: Query only
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TCOunter<t>:RESult[:ACTual]:PERiod?

Returns the period of the trigger source.

Suffix: 
<t>

.
1..2
1 = A-trigger source, 2 = B-trigger source

Return values: 
<PeriodValue> Default unit: s

Usage: Query only

18.16.2 Digital Voltmeter Settings and Results

The DVM suffix <m> sets the number of the DVM measurement (measurement place).

DVM<m>:ENABle.......................................................................................................... 728
DVM<m>:SOURce.........................................................................................................728
DVM<m>:TYPE............................................................................................................. 728
DVM<m>:POSition.........................................................................................................729
DVM<m>:RESult[:ACTual]?............................................................................................ 729
DVM<m>:RESult[:ACTual]:STATus?................................................................................729

DVM<m>:ENABle <VoltmeterEnable>

Enables and disables all configured voltmeter measurements.

Parameters:
<VoltmeterEnable> ON | OFF

*RST: OFF

DVM<m>:SOURce <Source>

Sets the measurement source for the indicated DVM measurement.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel instruments.

DVM<m>:TYPE <MeasurementType>

Sets the measurement type for the indicated DVM measurement.

Set OFF to disable the measurement.
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Parameters:
<MeasurementType> DC | ACDCrms | ACRMs | UPEakvalue | LPEakvalue | PEAK |

CRESt | OFF
DC: mean value of the signal
ACDCrms: RMS value of the signal
ACRMs: RMS value of the signal's AC component
UPEakvalue: maximum value
LPEakvalue: minimum value
PEAK: peak-to-peak value (maximum - minimum)
CRESt: crest factor (|X|max/XRMS)
OFF - disables the measurement.
*RST: DC for <m> = 1; for other measurements OFF

DVM<m>:POSition <Position>

Sets the corner of the screen in which the measurement results are displayed.

Parameters:
<Position> TLEFt | TRIGht | BLEFt | BRIGht

TLEFt - top left corner
TRIGht - top right corner
BLEFt - bottom left corner
BRIGht - bottom right corner
*RST: TLEF

DVM<m>:RESult[:ACTual]?

Returns the current value of the indicated measurement.

Return values: 
<CurrentValue> Numeric value

Example: DVM2:SOUR CH2
DVM2:TYPE DCRMs
DVM2:RES?
<-- 7.089E-01
An RMS measurement is performed on measurement place 2,
on channel 2. The result is 708,9 mV.

Usage: Query only

DVM<m>:RESult[:ACTual]:STATus?

Returns the result value and the status of the result.

The status is the decimal representation of a 4-bit register value:
● Bit 0 = 1: result is valid
● Bit 1 = 1: no result available
● Bit 2 = 1: clipping occurs
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● Bit 3 = 1: no period found

Return values: 
<ResultAndStatus> <Value>,Status

Example: DVM:SOUR CH1
DVM:TYPE MEAN
DVM:RES:STAT?
<-- 4.968E-01,5
The result value of the mean measurement on channel 1 is
496.1 mV. The result status is 5 (decimal) = 0101 (binary). That
means, the result is valid (bit 0 = 1), and the signal is clipped by
the limits of the ADC range (bit 3 = 1).

Usage: Query only

18.17 Data and File Management

This chapter describes commands on how to transfer data from the instrument to a
computer, how to print and save screenshots, and how to manage measurement set-
tings.

● Waveform Data Transfer.......................................................................................730
● Waveform Data Export to File...............................................................................744
● Instrument Settings............................................................................................... 745
● Screenshots.......................................................................................................... 751

18.17.1 Waveform Data Transfer

This chapter describes data transfer commands that have effect on other commands in
different applications of the instrument, and transfer commands that work in the same
way.

FORMat[:DATA].............................................................................................................731
FORMat:BORDer...........................................................................................................733
CHANnel<m>:DATA?.....................................................................................................733
CHANnel<m>:DATA:HEADer?........................................................................................ 734
CHANnel<m>:DATA:POINts........................................................................................... 734
CHANnel<m>:DATA:ENVelope?..................................................................................... 735
CHANnel<m>:DATA:ENVelope:HEADer?.........................................................................736
CALCulate:MATH<m>:DATA?.........................................................................................736
CALCulate:MATH<m>:DATA:HEADer?............................................................................737
CALCulate:MATH<m>:DATA:POINts?............................................................................. 737
CALCulate:MATH<m>:DATA:ENVelope?......................................................................... 737
CALCulate:MATH<m>:DATA:ENVelope:HEADer?............................................................ 738
CALCulate:MATH<m>:DATA:ENVelope:POINts?..............................................................738
DIGital<m>:DATA?.........................................................................................................738
DIGital<m>:DATA:HEADer?............................................................................................739
DIGital<m>:DATA:POINts...............................................................................................739
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MASK:DATA?................................................................................................................740
MASK:DATA:HEADer?...................................................................................................740
REFCurve<m>:DATA?................................................................................................... 741
REFCurve<m>:DATA:HEADer?.......................................................................................741
REFCurve<m>:DATA:POINts?........................................................................................742
CHANnel<m>:DATA:XORigin?........................................................................................742
CHANnel<m>:DATA:ENVelope:XORigin?........................................................................ 742
CALCulate:MATH<m>:DATA:XORigin?............................................................................742
CALCulate:MATH<m>:DATA:ENVelope:XORigin?............................................................ 742
MASK:DATA:XORigin?...................................................................................................742
DIGital<m>:DATA:XORigin?............................................................................................742
REFCurve<m>:DATA:XORigin?...................................................................................... 742
CHANnel<m>:DATA:XINCrement?.................................................................................. 742
CHANnel<m>:DATA:ENVelope:XINCrement?...................................................................742
CALCulate:MATH<m>:DATA:XINCrement?......................................................................742
CALCulate:MATH<m>:DATA:ENVelope:XINCrement?...................................................... 742
MASK:DATA:XINCrement?............................................................................................. 742
DIGital<m>:DATA:XINCrement?......................................................................................742
REFCurve<m>:DATA:XINCrement?.................................................................................742
CHANnel<m>:DATA:YORigin?........................................................................................743
CHANnel<m>:DATA:ENVelope:YORigin?........................................................................ 743
CALCulate:MATH<m>:DATA:YORigin?............................................................................743
CALCulate:MATH<m>:DATA:ENVelope:YORigin?............................................................ 743
MASK:DATA:YORigin?...................................................................................................743
DIGital<m>:DATA:YORigin?............................................................................................743
REFCurve<m>:DATA:YORigin?...................................................................................... 743
CHANnel<m>:DATA:YINCrement?.................................................................................. 743
CHANnel<m>:DATA:ENVelope:YINCrement?...................................................................743
CALCulate:MATH<m>:DATA:YINCrement?......................................................................743
CALCulate:MATH<m>:DATA:ENVelope:YINCrement?...................................................... 743
MASK:DATA:YINCrement?............................................................................................. 743
DIGital<m>:DATA:YINCrement?......................................................................................743
REFCurve<m>:DATA:YINCrement?.................................................................................743
CHANnel<m>:DATA:YRESolution?..................................................................................743
CHANnel<m>:DATA:ENVelope:YRESolution?.................................................................. 743
CALCulate:MATH<m>:DATA:YRESolution?..................................................................... 743
CALCulate:MATH<m>:DATA:ENVelope:YRESolution?......................................................743
MASK:DATA:YRESolution?............................................................................................ 743
DIGital<m>:DATA:YRESolution?..................................................................................... 743
REFCurve<m>:DATA:YRESolution?................................................................................ 743

FORMat[:DATA] <DataFormat>,<Accuracy>

Defines the format for data export with
● CHANnel<m>:DATA? on page 428
● CHANnel<m>:DATA:ENVelope? on page 429
● CALCulate:MATH<m>:DATA? on page 499
● REFCurve<m>:DATA? on page 474
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● MASK:DATA? on page 529

Parameters:
<DataFormat> ASCii | REAL | UINTeger

ASCii
List of values, for example, 1.23,1.22,1.24,..
<Accuracy> is 0 which means that the instrument selects the
number of digits to be returned. The query returns ASC,0.
REAL
Binary format. <Accuracy> is 32. The query returns REAL,32.
The data is stored as binary data (Definite Length Block Data
according to IEEE 488.2). Each waveform value is formatted in
32 Bit IEEE 754 Floating-Point-Format.
The schema of the result string is as follows:
#41024<value1><value2>…<value n> with:
#4 = number of digits of the following number (= 4 in the exam-
ple)
1024 = number of following data bytes (= 1024 in the example)
<value> = 4-byte floating point values

UINTeger
Unsigned integer format, binary values with length 8 bit (1 byte
per sample), 16 bit (2 bytes per sample) or 32 bit (4 bytes per
sample): UINT,8 or UINT,16 or UINT,32.
The data range for UINT,8 is 0 to 255, the data range for
UINT,16 is 0 to 65.535 and for UINT,32 is 232 - 1.
The schema of the result string is the same as for REAL format.
For data conversion, you need the results of following com-
mands:
...:DATA:XORigin?; ...:DATA:XINCrement?; ..:DATA:
Yorigin?; ...:DATA:YINCrement?; ...:DATA:
YRESolution?. They are described below in this chapter. The
way of data conversion is described in Chapter 18.2.1.2, "Read-
ing Waveform Data in Unsigned Integer Format", on page 406.
32 bit data is relevant for average waveforms if averaging 512 or
1024 waveforms. The resulting data is 17 bits long (512 wave-
forms) or 18 bit (1024 waveforms).
*RST: ASC

<Accuracy> 0 | 8 | 16 | 32
Length of a data value in bit
0 - for ASC only
32 - for REAL
8 | 16 | 32 - for UINT
*RST: 0

Example: Set the ASCII data format:
FORM ASC
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Example: Query for data format:
FORM?
-> ASC,0

Example: Set the unsigned integer format, 16 bit data length:
FORM UINT,16

FORMat:BORDer <ByteOrder>

Defines the byte order for binary data export if FORMat[:DATA] is set to REAL or
UINT,16|32.

Parameters:
<ByteOrder> MSBFirst | LSBFirst

MSBFirst
Big endian, most significant byte first
LSBFirst
Little endian, least significant byte first
*RST: MSBF

Example: See Chapter 18.2.1.1, "Reading Waveform Data in Real For-
mat", on page 405

ByteOrder 8 bit 16 bit 32 bit

MSBF 0xab 0xAB CD 0xAB CD 00 00

LSBF not relevant 0xCD AB 0x00 00 CD AB

CHANnel<m>:DATA?

Returns the data of the analog channel waveform for transmission from the instrument
to the controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

To set the range of samples to be returned, use CHANnel<m>:DATA:POINts.

For envelope waveforms, use the CHANnel<m>:DATA:ENVelope? command.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Data> List of values according to the format settings - the voltages of

recorded waveform samples.

Example: FORM ASC
CHAN1:DATA?
-0.125000,-0.123016,-0.123016,-0.123016,
-0.123016,-0.123016,...
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Example: See Chapter 18.2.1, "Data Export", on page 405

Usage: Query only

CHANnel<m>:DATA:HEADer?

Returns information on the channel waveform. For envelope waveforms, use the
CHANnel<m>:DATA:ENVelope:HEADer? command.

Table 18-9: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

CHANnel<m>:DATA:POINts <Points>

As a setting, the command selects a range of samples that will be returned with
CHANnel<m>:DATA? and CHANnel<m>:DATA:ENVelope?. As a query, it returns the
number of returned samples for the selected range.

If ACQuire:WRATe is set to MSAMples (maximum sample rate), the memory usually
contains more data samples than the screen can display. In this case, you can decide
which data will be saved: samples stored in the memory or only the displayed samples.

Note: The sample range can only be changed in STOP mode. If the acquisition is run-
ning, DEF is always used automatically. If the acquisition has been stopped, data can
be read from the memory, and all settings are available.

Suffix: 
<m>

.
1..4
The command affects all channels, and the suffix is irrelevant.
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Setting parameters: 
<Points> DEFault | MAXimum | DMAXimum

Sets the range for data queries.
DEFault
Waveform points that are visible on the screen. At maximum
waveform rate, the instrument stores more samples than visible
on the screen, and DEF returns less values than acquired.
MAXimum
All waveform samples that are stored in the memory. Only avail-
able if acquisition is stopped.
DMAXimum
Display maximum: Waveform samples stored in the current
waveform record but only for the displayed time range. At maxi-
mum waveform rate, the instrument stores more samples than
visible on the screen, and DMAX returns more values than DEF.
Only available if acquisition is stopped.
*RST: DEFault

Return values: 
<Points> Number of data points in the selected range.

Default unit: Samples

Example: CHAN:DATA:POIN DEF
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 10416;10416
CHAN:DATA:POIN DMAX
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 124992;124992
CHAN:DATA:POIN MAX
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 4194302;4194302

Example: See Chapter 18.2.1.1, "Reading Waveform Data in Real For-
mat", on page 405

CHANnel<m>:DATA:ENVelope?

Returns the data of the envelope. The envelope consists of two waveforms. The wave-
forms data can be used in MATLAB, for example.

Use this command only for envelope waveforms. For other channel waveforms use
CHANnel<m>:DATA?.

To set the export format, use FORMat[:DATA] on page 731.

To set the range of samples to be returned, use CHANnel<m>:DATA:POINts.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.
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Return values: 
<Data> List of values according to the format settings - the voltages of

the envelope points. The list contains two values for each sam-
ple interval.

Usage: Query only

CHANnel<m>:DATA:ENVelope:HEADer?

Returns information on the envelope waveform.

Use this command only for envelope waveforms. for all other channel waveforms use
CHANnel<m>:DATA:HEADer?.

Table 18-10: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Number of samples 200000

4 Number of values per sample interval. For envelope
waveforms the value is 2.

2

Suffix: 
<m>

.
1..4

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

CALCulate:MATH<m>:DATA?

Returns the data of the math waveform points for transmission from the instrument to
the controlling computer. The waveforms data can be used in MATHLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Data> List of values according to the format settings - voltages, or

magnitudes of a spectrum.

Usage: Query only
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CALCulate:MATH<m>:DATA:HEADer?

Returns information on the math waveform.

Table 18-11: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

CALCulate:MATH<m>:DATA:POINts?

Returns the number of data samples that are returned with CALCulate:MATH<m>:
DATA?.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope?

Returns the data of FFT envelope waveforms (CALCulate:MATH<m>:ARIThmetics
is set to ENV). The envelope consists of two waveforms. The data of the two wave-
forms is written into one data stream in interleaved order.

Use this command only for envelope waveforms. For other FFT and math waveforms,
use CALCulate:MATH<m>:DATA? on page 499.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.
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Return values: 
<Data> List of values according to the format settings - the voltages of

the envelope points. The list contains two values for each sam-
ple interval.

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:HEADer?

Returns information on the envelope waveform.

Use this command only for envelope waveforms. For all other FFT waveforms, use
CALCulate:MATH<m>:DATA:HEADer?.

Table 18-12: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Number of samples 200000

4 Number of values per sample interval. For envelope
waveforms the value is 2.

2

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Return values: 
<Header> Comma-separated value list, string data

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:POINts?

Returns the number of data samples that are returned with CALCulate:MATH<m>:
DATA:ENVelope?.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

DIGital<m>:DATA?

Returns the data of the specified digital channel for transmission from the instrument to
the controlling computer. The waveforms data can be used in MATLAB, for example.
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To set the export format, use FORMat[:DATA] on page 731.

To set the range of samples to be returned, use DIGital<m>:DATA:POINts.

Suffix: 
<m>

.
0..15
Selects the digital channel

Parameters:
<WaveformData> List of values according to the format settings.

Example: FORM ASC,0
DIG1:DATA?
1,1,1,1,1,1,0,0,0,0,0,0,...

Usage: Query only

DIGital<m>:DATA:HEADer?

Returns information on the specified digital channel waveform.

Table 18-13: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
0..15
Selects the digital channel

Parameters:
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

DIGital<m>:DATA:POINts <PointSelection>

As a setting, the command selects a range of samples that will be returned with
DIGital<m>:DATA?. As a query, it returns the number of returned samples for the
selected range.

If ACQuire:WRATe is set to MSAMples (maximum sample rate), the memory usually
contains more data samples than the screen can display. In this case, you can decide
which data will be saved: samples stored in the memory or only the displayed samples.

Note: The sample range can be changed only in STOP mode. If the acquisition is run-
ning, DEF is always used automatically. If the acquisition has been stopped, data can
be read from the memory, and all settings are available.
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Suffix: 
<m>

.
0..15
Selects the digital channel

Setting parameters: 
<PointSelection> DEFault | MAXimum | DMAXimum

Sets the range for data queries.
DEFault
Waveform samples that are visible as waveform points on the
screen.
MAXimum
All waveform samples that are stored in the memory. Only avail-
able if acquisition is stopped.
DMAXimum
Display maximum: Waveform samples stored in the current
waveform record but only for the displayed time range. At maxi-
mum waveform rate, the instrument stores more samples than
visible on the screen, and DMAX returns more values than DEF.
Only available if acquisition is stopped.
*RST: DEFault

Return values: 
<Points> Number of data points in the selected range.

Default unit: Samples

See also: CHANnel<m>:DATA:POINts

MASK:DATA?

Returns the data of the mask. The mask consists of two limit curves.

To set the export format, use FORMat[:DATA] on page 731.

Return values: 
<Data> List of values according to the format settings - the y-values of

the mask points. The list contains two values for each sample
interval.

Usage: Query only

MASK:DATA:HEADer?

Returns information on the mask data that is delivered with MASK:DATA?.

Table 18-14: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns
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Position Meaning Example

3 Number of samples 200000

4 Number of values per sample interval. For masks
the value is 2.

2

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

REFCurve<m>:DATA?

Returns the data of the reference waveform for transmission from the instrument to the
controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use FORMat[:DATA] on page 731.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Return values: 
<Data> List of values according to the format settings.

Usage: Query only

REFCurve<m>:DATA:HEADer?

Returns information on the reference waveform.

Table 18-15: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only
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REFCurve<m>:DATA:POINts?

Returns the number of data samples that are returned with REFCurve<m>:DATA?.

Suffix: 
<m>

.
1..4
Selects the reference waveform.

Return values: 
<DataPoints> Amount of data points

Usage: Query only

CHANnel<m>:DATA:XORigin?
CHANnel<m>:DATA:ENVelope:XORigin?
CALCulate:MATH<m>:DATA:XORigin?
CALCulate:MATH<m>:DATA:ENVelope:XORigin?
MASK:DATA:XORigin?
DIGital<m>:DATA:XORigin?
REFCurve<m>:DATA:XORigin?
Return the time of the first sample of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
(FORM UINT, 8|16|32).

Return values: 
<Xorigin> Time in s

Example: See Chapter 18.2.1.2, "Reading Waveform Data in Unsigned
Integer Format", on page 406

Usage: Query only

CHANnel<m>:DATA:XINCrement?
CHANnel<m>:DATA:ENVelope:XINCrement?
CALCulate:MATH<m>:DATA:XINCrement?
CALCulate:MATH<m>:DATA:ENVelope:XINCrement?
MASK:DATA:XINCrement?
DIGital<m>:DATA:XINCrement?
REFCurve<m>:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
(FORM UINT, 8|16|32).

Return values: 
<Xincrement> Time in s

Example: See Chapter 18.2.1.2, "Reading Waveform Data in Unsigned
Integer Format", on page 406

Usage: Query only
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CHANnel<m>:DATA:YORigin?
CHANnel<m>:DATA:ENVelope:YORigin?
CALCulate:MATH<m>:DATA:YORigin?
CALCulate:MATH<m>:DATA:ENVelope:YORigin?
MASK:DATA:YORigin?
DIGital<m>:DATA:YORigin?
REFCurve<m>:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
(FORM UINT, 8|16|32).

Return values: 
<Yorigin> Voltage in V

Example: See Chapter 18.2.1.2, "Reading Waveform Data in Unsigned
Integer Format", on page 406

Usage: Query only

CHANnel<m>:DATA:YINCrement?
CHANnel<m>:DATA:ENVelope:YINCrement?
CALCulate:MATH<m>:DATA:YINCrement?
CALCulate:MATH<m>:DATA:ENVelope:YINCrement?
MASK:DATA:YINCrement?
DIGital<m>:DATA:YINCrement?
REFCurve<m>:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
(FORM UINT, 8|16|32).

Return values: 
<Yincrement> Voltage in V

Example: See Chapter 18.2.1.2, "Reading Waveform Data in Unsigned
Integer Format", on page 406

Usage: Query only

CHANnel<m>:DATA:YRESolution?
CHANnel<m>:DATA:ENVelope:YRESolution?
CALCulate:MATH<m>:DATA:YRESolution?
CALCulate:MATH<m>:DATA:ENVelope:YRESolution?
MASK:DATA:YRESolution?
DIGital<m>:DATA:YRESolution?
REFCurve<m>:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
(FORM UINT, 8|16|32).
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Return values: 
<Yresolution> For default waveforms, the resolution is 8 bit.

If high resolution, average or filter are set for the waveform, the
resolution is 16 bit.

Example: See Chapter 18.2.1.2, "Reading Waveform Data in Unsigned
Integer Format", on page 406

Usage: Query only

18.17.2 Waveform Data Export to File

EXPort:WAVeform:SOURce............................................................................................744
EXPort:WAVeform:NAME............................................................................................... 744
EXPort:WAVeform:SAVE................................................................................................745

EXPort:WAVeform:SOURce <WaveformSource>

Defines the waveform to be exported.

Parameters:
<WaveformSource> CH1..4 | D70 | D158 | MA1..5 | RE1..4

CH1..4
Analog channels CH1 | CH2 | CH3 | CH4
D70
Pod 1, digital channels D0 to D7 are exported together
D158
Pod 2, digital channels D8 to D15 are exported together.
MA1..5
Mathematic waveforms MA1 | MA2 | MA3 | MA4 | MA5
RE1..4
Reference waveforms RE1 | RE2 | RE3 | RE4

EXPort:WAVeform:NAME <FileName>

Defines the path and filename for a waveform data file that will be saved with EXPort:
WAVeform:SAVE. The data format and file extension is defined using FORMat[:
DATA].

Existing files will be overwritten.

You can change the storage location, file name and/or file format manually in the FILE
> "Waveforms" menu. Remote control uses the recent settings.

Parameters:
<FileName> String parameter
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Example: FORMAT CSV
EXPort:WAVeform:NAME "/USB_FRONT/WAVEFORMS/WFM01"
EXPort:WAVeform:SAVE

The waveform data is saved to WFM01.CSV.

EXPort:WAVeform:SAVE

Usage: Event

18.17.3 Instrument Settings

The Mass MEMomory subsystem provides commands to access the storage media
and to save and reload instrument settings and data.

The R&S RTM has three storage devices indicated as drives:
● /INT: internal storage with default directories for each data type
● /USB_FRONT: USB connector on the front panel
● /USB_REAR: USB connector on the rear panel

Common computer and network drives like C:, D:, \\server\share are not availa-
ble.

Name conventions

The names of files and directories have to meet the following rules:
● Only the 8.3 format with ASCI characters is supported.
● No special characters are allowed.
● Use / (slash) instead of \ (backslash).

MMEMory:DRIVes?........................................................................................................745
MMEMory:MSIS.............................................................................................................746
MMEMory:CDIRectory....................................................................................................746
MMEMory:MDIRectory................................................................................................... 746
MMEMory:RDIRectory....................................................................................................747
MMEMory:DCATalog?....................................................................................................747
MMEMory:DCATalog:LENGth?....................................................................................... 748
MMEMory:CATalog?...................................................................................................... 748
MMEMory:CATalog:LENGth?..........................................................................................749
MMEMory:COPY........................................................................................................... 749
MMEMory:MOVE........................................................................................................... 749
MMEMory:DELete..........................................................................................................750
MMEMory:DATA............................................................................................................750
MMEMory:STORe:STATe...............................................................................................751
MMEMory:LOAD:STATe.................................................................................................751

MMEMory:DRIVes?

Returns the storage devices available on the R&S RTM.
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Return values: 
<Drive> List of strings, for example, ""/INT"",""/USB_FRONT"",""/

USB_REAR""
/INT: internal storage
/USB_FRONT: USB connector on the front panel
/USB_REAR: USB connector on the rear panel

Usage: Query only

MMEMory:MSIS [<MassStorageIS>]

Changes the storage device (drive).

Parameters:
<MassStorageIS> One of the available drives: /INT, /USB_FRONT, or /USB_REAR

Example: MMEM:MSIS '/USB_FRONT'
Sets the USB flash drive connected to the front panel as storage
device to be used.

MMEMory:CDIRectory [<DirectoryName>]

Specifies the current directory for file access.

Setting parameters: 
<DirectoryName> String parameter to specify the directory, including the storage

device.

Example: MMEM:CDIR "/USB_FRONT/DATA"
Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",

on page 408

MMEMory:MDIRectory <DirectoryName>

Creates a new directory with the specified name.

Setting parameters: 
<DirectoryName> String parameter

Absolute path including the storage device, or relative to the cur-
rent directory.

Example: Create directory DATA on the front USB flash device, with abso-
lute path:
MMEM:MDIR "/USB_FRONT/DATA"

Example: Create directory JANUARY in the DATA directory, with relative
path:
MMEM:CDIR "/USB_FRONT/DATA/"
MMEM:MDIR "JANUARY"

Usage: Setting only
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MMEMory:RDIRectory <DirectoryName>

Deletes the specified directory.

Note: All subdirectories and all files in the specified directory and in the subdirectories
will be deleted!

You cannot delete the current directory or a superior directory. In this case, the instru-
ment returns an execution error.

Setting parameters: 
<DirectoryName> String parameter, absolute path or relative to the current direc-

tory

Example: MMEM:RDIR "/INT/TEST"
Deletes the directory TEST in the internal storage device, and all
files and subdirectories in the directory.

Usage: Setting only

MMEMory:DCATalog? <PathName>

Returns the subdirectories of the specified directory. The result corresponds to the
number of strings returned by the MMEMory:DCATalog:LENgth? command.

Query parameters: 
<PathName> String parameter

Specifies the directory.

Return values: 
<FileEntry> String parameter

List of subdirectory strings separated by commas. If the speci-
fied directory does not have any subdirectory, the current and
the parent directories are returned (".,,0","..,,0")

Example: Query for directories with absolute path:
MMEM:DCAT? "/USB_FRONT/*"
received ".,,0","..,,0","DATA,,0","DATA_NEW,,
0","SCREENSHOTS,,0"
MMEM:DCAT:LENG? "/USB_FRONT/*"
received 5

Example: Query for directories in the current directory:
MMEM:CDIR "/USB_FRONT/DATA/"
MMEM:DCAT? "*"
received ".,,0","..,,0","JANUARY,,0",
"FEBRUARY,,0"
MMEM:DCAT:LENG? "*"
received 4
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Example: Query with filter:
MMEM:DCAT? "/USB_FRONT/DA*"
received "DATA,,0","DATA_NEW,,0"
MMEM:DCAT:LENG? "/USB_FRONT/DA*"
received 2

Usage: Query only

MMEMory:DCATalog:LENGth? <PathName>

Returns the number of directories in specified directory. The result corresponds to the
number of strings returned by the MMEMory:DCATalog? command.

Query parameters: 
<PathName> String parameter

Specifies the directory.

Return values: 
<FileEntryCount> Number of directories.

Example: see MMEMory:DCATalog?
Usage: Query only

MMEMory:CATalog? <PathName>[,<Format>]

Returns the a list of files contained in the specified directory. The result corresponds to
the number of files returned by the MMEMory:CATalog:LENgth? command.

Query parameters: 
<PathName> String parameter

Specifies the directory. A filter can be used to list, for example,
only files of a given file type.

<Format> ALL | WTIMe
ALL: Extended result including file, date, time and attributes
WTIMe: Result including file, date, time

Return values: 
<UsedMemory> Total amount of storage currently used in the directory, in bytes.

<FreeMemory> Total amount of storage available in the directory, in bytes.

<FileEntry> String parameter
All files of the directory are listed with their file name, format and
size in bytes.

Example: Query for files in the DATA directory, with absolute path:
MMEM:CAT? "/USB_FRONT/DATA/*.*"
received: 511104,8633856,"MONDAY.TXT,,8",
"TUESDAY.CSV,,8"
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Example: Query for TXT files in the DATA directory, with relative path:
MMEM:CDIR "/USB_FRONT/DATA"'
MMEM:CAT? "*.TXT"
received: 511104,8633856,"MONDAY.TXT,,8"
MMEM:CAT:LENGTH? "*.TXT"
received 1

Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",
on page 408

Usage: Query only

MMEMory:CATalog:LENGth? <PathName>

Returns the number of files in the specified directory. The result corresponds to the
number of files returned by the MMEMory:CATalog? command.

Query parameters: 
<PathName> String parameter

Directory to be queried, absolute or relative path

Return values: 
<Count> Number of files.

Example: see MMEMory:CATalog?
Usage: Query only

MMEMory:COPY <FileSource>,<FileDestination>

Copies data to another directory on the same or different storage device. The file name
can be changed, too.

Setting parameters: 
<FileSource> String parameter

Name and path of the file to be copied

<FileDestination> String parameter
Name and path of the new file. If the file already exists, it is over-
written without notice.

Example: MMEM:COPY "/INT/SETTINGS/SET001.SET",
"/USB_FRONT/SETTINGS/TESTSET1.SET"

Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",
on page 408

Usage: Setting only

MMEMory:MOVE <FileSource>,<FileDestination>

Moves an existing file to a new location.
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Setting parameters: 
<FileSource> String parameter

Path and name of the file to be moved

<FileDestination> String parameter
Path and name of the new file

Example: MMEM:MOVE "/INT/SETTINGS/SET001.SET",
"/USB_FRONT/SETTINGS/SET001.SET"

Usage: Setting only

MMEMory:DELete <FileSource>

Removes a file from the specified directory.

Setting parameters: 
<FileSource> String parameter

File name and path of the file to be removed. If the path is omit-
ted, the specified file will be deleted in the current directory. Fil-
ters are not allowed.

Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",
on page 408

Usage: Setting only

MMEMory:DATA <FileName>,<Data>

Writes data to the specified file in the current directory MMEMory:CDIRectory, or
reads the data.

Parameters:
<Data> 488.2 block data

The block begins with character '#'. The next digit is the length of
the length information, followed by this given number of digits
providing the number of bytes in the binary data attached.

Parameters for setting and query: 
<FileName> String parameter containing the file name

Example: MMEM:DATA "abc.txt", #216This is the file
#2: the length infomation has two digits
16: the binary data has 16 bytes.
MMEM:DATA? "abc.txt"
received: This is the file

Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",
on page 408
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MMEMory:STORe:STATe <StateNumber>,<FileName>

Saves the current device settings to the specified file in the current directory.

Setting parameters: 
<StateNumber> Range: 1  to  1

Increment: 0
*RST: 1

<FileName> String parameter
File name, with or without file extension

Example: MMEM:CDIR "/USB_FRONT/DATA"'
MMEM:STOR:STAT 1,"MORNING.SET"

Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",
on page 408

Usage: Setting only

MMEMory:LOAD:STATe <StateNumber>,<FileName>

Loads the device settings from the specified file in the current directory.

Setting parameters: 
<StateNumber> Range: 1  to  1

Increment: 0
*RST: 1

<FileName> String parameter
File name, with or without file extension

Example: MMEM:CDIR "/USB_FRONT/DATA"'
MMEM:LOAD:STAT 1,"MORNING"

Example: Chapter 18.2.3.2, "Saving, Copying, and Loading Setup Data",
on page 408

Usage: Setting only

18.17.4 Screenshots

This chapter describes remote commands used to print and save screenshots.

HCOPy:DESTination...................................................................................................... 752
MMEMory:NAME........................................................................................................... 752
HCOPy[:IMMediate]....................................................................................................... 752
HCOPy:DATA?..............................................................................................................753
HCOPy:LANGuage........................................................................................................ 753
HCOpy:MENU[:ENABle]................................................................................................. 753
HCOPy:PAGE:SIZE....................................................................................................... 753
HCOPy:PAGE:ORIentation............................................................................................. 753
HCOPy:COLor:SCHeme.................................................................................................753
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SYSTem:COMMunicate:PRINter:SELect..........................................................................754
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?........................................................ 754
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?...................................................... 754
SYSTem:COMMunicate:PRINter:CSET............................................................................754

HCOPy:DESTination <Medium>

Defines whether the screenshot is saved or printed.

Parameters:
<Medium> MMEM | SYST:COMM:PRIN

String parameter
MMEM
Saves the screenshot to a file. Specify the file name and location
with MMEMory:NAME.

SYST:COMM:PRIN
Prints on the printer specified with SYSTem:COMMunicate:
PRINter:SELect. The printer must be specified before the
HCOPy:DESTination is sent.

*RST: MMEM

Example: HCOP:DEST "MMEM"
Chapter 18.2.3.1, "Saving Screenshots to File", on page 408

MMEMory:NAME <FileName>

Defines the file name to store an image of the display with HCOPy[:IMMediate].

Parameters:
<FileName> String parameter

Example: Chapter 18.2.3.1, "Saving Screenshots to File", on page 408

HCOPy[:IMMediate]

Prints an image of the display to the printer or saves an image to a file or the clipboard,
depending on the HCOPy:DESTination setting.

Before starting the printout, make sure that:
● The printer is defined by SYSTem:COMMunicate:PRINter:SELect.
● The path for storage is defined correctly by MMEMory:CDIRectory
● The file name for storage is defined by MMEMory:NAME.

Example: Chapter 18.2.3.1, "Saving Screenshots to File", on page 408

Usage: Event
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HCOPy:DATA?

Returns the data of the image file. The file format is defined using HCOPy:LANGuage
(BMP | PNG)

Return values: 
<ScreenData> Block data

Usage: Query only

HCOPy:LANGuage <Format>

Defines the format of the printed or saved screenshot.

Parameters:
<Format> GDI | BMP | PNG

GDI
For output on printer
BMP | PNG
File formats for saved screenshots.
Set also HCOpy:MENU[:ENABle].

*RST: PNG

Example: Chapter 18.2.3.1, "Saving Screenshots to File", on page 408

HCOpy:MENU[:ENABle]

Includes the menu in the screenshot. If OFF (no menu), the menu is clipped off, and
date and time are shown instead of the menu name.

Parameters:
<MenuEnable> ON | OFF

HCOPy:PAGE:SIZE <Size>

Defines the page size to be used.

Parameters:
<Size> A4 | A5 | B5 | B6 | EXECutive

HCOPy:PAGE:ORIentation <Orientation>

Defines the page orientation.

Parameters:
<Orientation> LANDscape | PORTrait

HCOPy:COLor:SCHeme <ColorScheme>

Defines the color mode for saved and printed screenshots.
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Parameters:
<ColorScheme> COLor | GRAYscale | INVerted

INVerted inverts the colors of the output, i.e. a dark waveform is
printed on a white background.
*RST: COLor

Example: Chapter 18.2.3.1, "Saving Screenshots to File", on page 408

SYSTem:COMMunicate:PRINter:SELect <PrinterName>

Selects a configured printer.

Parameters:
<PrinterName> String parameter

Enter the string as it is returned with SYSTem:COMMunicate:
PRINter:ENUMerate:FIRSt? or SYSTem:COMMunicate:
PRINter:ENUMerate[:NEXT]?.

SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?

Queries the name of the first printer in the list of printers. The names of other installed
printers can be queried with the SYSTem:COMMunicate:PRINter:ENUMerate[:
NEXT]? command.

Return values: 
<PrinterName> String parameter

If no printer is configured an empty string is returned.

Usage: Query only

SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?

Queries the name of the next printer installed. The SYSTem:COMMunicate:
PRINter:ENUMerate:FIRSt? command should be sent previously to return to the
beginning of the printer list and query the name of the first printer.

Return values: 
<PrinterName> String parameter

After all available printer names have been returned, an empty
string enclosed by quotation marks (") is returned for the next
query. Further queries are answered by a query error.

Usage: Query only

SYSTem:COMMunicate:PRINter:CSET <CommandSet>

Sets the printer language that is supported by the printer.
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Parameters:
<CommandSet> PCL5 | PCLXl | PS | DESKjet

PCLXl = PCL XL
PS = Postscript
DESKjet = PCL3 for HP Deskjet

18.18 General Instrument Setup

DISPlay:LANGuage........................................................................................................755
CALibration................................................................................................................... 755
CALibration:STATe?.......................................................................................................756
TRIGger:OUT:MODE..................................................................................................... 756
TRIGger:OUT:PLENgth.................................................................................................. 756
TRIGger:OUT:POLarity...................................................................................................756
SYSTem:NAME............................................................................................................. 756
SYSTem:DATE..............................................................................................................757
SYSTem:TIME...............................................................................................................757
SYSTem:BEEPer:CONTrol:STATe.................................................................................. 757
SYSTem:BEEPer:ERRor:STATe..................................................................................... 757
SYSTem:BEEPer:TRIG:STATe....................................................................................... 758
SYSTem:BEEPer[:IMMediate]......................................................................................... 758
SYSTem:SET................................................................................................................ 758
SYSTem:ERRor:[NEXT]?................................................................................................758
SYSTem:ERRor:ALL?.................................................................................................... 758
SYST:PRESet............................................................................................................... 759
SYSTem:EDUCation:PRESet..........................................................................................759

DISPlay:LANGuage <Language>

Sets the language in which the softkey labels, help and other screen information can
be displayed.

Parameters:
<Language> ENGLish | GERMan | FRENch | SPANishRUSSian | SCHinese |

TCHinese | JAPanese | ENGLish | GERMan | FRENch |
SPANish | RUSSian | SCHinese | TCHinese | JAPanese |
KORean
Supported languages are listed in the "Specifications" data
sheet.
*RST: Reset does not change the language

CALibration

Calibration starts the self-alignment process. It can take several minutes. Consider
your timeout settings.

Calibration? returns information on the state of the self-alignment. Return values ≠
0 indicate an error.
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Same as *CAL?.

Return values: 
<SelfAlignment> Numeric status indicator

CALibration:STATe?

Returns the overall state of the self-alignment.

Return values: 
<SelfAlignmentState> NOALignment | RUN | ERRor | OK | ABORt

NOALignment: no self-aligment was performed. Relevant for
service operations.
RUN: self-aligment is running
ERRor: an error occured.
OK: self-aligment has been performed successfully
ABORt: self-aligment has been cancelled

Usage: Query only

TRIGger:OUT:MODE <OutputMode>

Defines wether and when a trigger out pulse is generated: never, on trigger event, or
on mask violation.

Parameters:
<OutputMode> OFF | TRIGger | MASK

*RST: OFF

TRIGger:OUT:PLENgth <PulseLength>

Defines the pulse width of the trigger out pulse.

Parameters:
<PulseLength> *RST: 1E-6

Default unit: s

TRIGger:OUT:POLarity <Polarity>

Sets the polarity of the trigger out pulse.

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

SYSTem:NAME <Name>

Defines an instrument name.
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Parameters:
<Name> String with max. 20 characters

SYSTem:DATE <Year>,<Month>,<Day>

Specifies the internal date for the instrument.

Parameters:
<Year> Increment: 1

Default unit: a

<Month> Range: 1  to  12
Increment: 1

<Day> Range: 1  to  31
Increment: 1
Default unit: d

Usage: SCPI confirmed

SYSTem:TIME <Hour>,<Minute>,<Second>

Specifies the internal time for the instrument.

Parameters:
<Hour> Range: 0  to  23

Increment: 1
Default unit: h

<Minute> Range: 0  to  59
Increment: 1
Default unit: min

<Second> Range: 0  to  59
Increment: 1
Default unit: s

Usage: SCPI confirmed

SYSTem:BEEPer:CONTrol:STATe <ControlBeep>

Enables or diables a sound for general control events, e.g. reaching the rotary encoder
end or changing the measuring mode in the "Automeasure" menu.

Parameters:
<ControlBeep> ON | OFF

SYSTem:BEEPer:ERRor:STATe <ErrorBeep>

Enables or disables the beep if an error occurs.

Parameters:
<ErrorBeep> ON | OFF
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SYSTem:BEEPer:TRIG:STATe <TriggerBeep>

Enables or disables the beep if a trigger occurs.

Parameters:
<TriggerBeep> ON | OFF

SYSTem:BEEPer[:IMMediate]

Generates an immediate beep.

Usage: Event

SYSTem:SET <Setup>

Defines or queries the device settings that can be saved and load manually with FILE >
"Device Settings".

Parameters:
<Setup> 488.2 block data

Usage: SCPI confirmed

SYSTem:ERRor:[NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue. The
response consists of an error number and a short description of the error.

Positive error numbers are instrument-dependent. Negative error numbers are
reserved by the SCPI standard.

Return values: 
<Error> Error/event_number,"Error/event_description>[;Device-depend-

ent info]"
If the queue is empty, the response is 0,"No error"

Usage: Query only
SCPI confirmed

SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.
The response is a comma separated list of error number and a short description of the
error in FIFO order.

Positive error numbers are instrument-dependent. Negative error numbers are
reserved by the SCPI standard.

Return values: 
<Error> List of: Error/event_number,"Error/event_description>[;Device-

dependent info]"
If the queue is empty, the response is 0,"No error"
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Usage: Query only
SCPI confirmed

SYST:PRESet

Resets the instrument to the default state, has the same effect as *RST.

Usage: Event

SYSTem:EDUCation:PRESet

Deletes the password of the education mode.

Usage: Event

18.19 Status Reporting

18.19.1 STATus:OPERation Register

The commands of the STATus:OPERation subsystem control the status reporting
structures of the STATus:OPERation register:

See also:
● Chapter B.1, "Structure of a SCPI Status Register", on page 780
● Chapter B.3.3, "STATus:OPERation Register", on page 785

The following commands are available:

STATus:OPERation:CONDition?..................................................................................... 759
STATus:OPERation:ENABle........................................................................................... 760
STATus:OPERation:NTRansition.....................................................................................760
STATus:OPERation:PTRansition.....................................................................................760
STATus:OPERation[:EVENt]?......................................................................................... 760

STATus:OPERation:CONDition?

Returns the of the CONDition part of the operational status register.

Return values: 
<Condition> Condition bits in decimal representation. ALIGnment (bit 0) ,

SELFtest (bit 1) , AUToset (bit 2), WTRigger (bit 3).
Range: 1  to  65535
Increment: 1

Usage: Query only
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STATus:OPERation:ENABle <Enable>

Parameters:
<Enable> Range: 1  to  65535

Increment: 1

STATus:OPERation:NTRansition <NegativeTransition>

Parameters:
<NegativeTransition> Range: 1  to  65535

Increment: 1

STATus:OPERation:PTRansition <PositiveTransition>

Parameters:
<PositiveTransition> Range: 1  to  65535

Increment: 1

STATus:OPERation[:EVENt]?

Return values: 
<Event> Range: 1  to  65535

Increment: 1

Usage: Query only

18.19.2 STATus:QUEStionable Registers

The commands of the STATus:QUEStionable subsystem control the status reporting
structures of the STATus:QUEStionable registers:
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Figure 18-1: Structure of the STATus:QUEStionable register

See also:
● Chapter B.1, "Structure of a SCPI Status Register", on page 780
● Chapter B.3.4, "STATus:QUEStionable Register", on page 785

The following commands are available:

STATus:PRESet............................................................................................................ 762
STATus:QUEStionable:CONDition?.................................................................................762
STATus:QUEStionable:COVerload:CONDition?................................................................ 762
STATus:QUEStionable:LIMit:CONDition?......................................................................... 762
STATus:QUEStionable:MASK:CONDition?.......................................................................762
STATus:QUEStionable:ENABle.......................................................................................762
STATus:QUEStionable:COVerload:ENABle......................................................................762
STATus:QUEStionable:LIMit:ENABle...............................................................................762
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STATus:QUEStionable:MASK:ENABle.............................................................................762
STATus:QUEStionable[:EVENt]?.....................................................................................763
STATus:QUEStionable:COVerload[:EVENt]?....................................................................763
STATus:QUEStionable:LIMit[:EVENt]?.............................................................................763
STATus:QUEStionable:MASK[:EVENt]?...........................................................................763
STATus:QUEStionable:NTRansition................................................................................ 763
STATus:QUEStionable:COVerload:NTRansition............................................................... 763
STATus:QUEStionable:LIMit:NTRansition........................................................................ 763
STATus:QUEStionable:MASK:NTRansition...................................................................... 763
STATus:QUEStionable:PTRansition.................................................................................763
STATus:QUEStionable:COVerload:PTRansition................................................................763
STATus:QUEStionable:LIMit:PTRansition.........................................................................763
STATus:QUEStionable:MASK:PTRansition...................................................................... 763

STATus:PRESet

Resets all STATUS:QUESTIONALBLE registers.

Usage: Event

STATus:QUEStionable:CONDition?
STATus:QUEStionable:COVerload:CONDition?
STATus:QUEStionable:LIMit:CONDition?
STATus:QUEStionable:MASK:CONDition?
Returns the contents of the CONDition part of the status register to check for question-
able instrument or measurement states. Reading the CONDition registers does not
delete the contents.

Return values: 
<Condition> Condition bits in decimal representation

Range: 1  to  65535
Increment: 1

Usage: Query only

STATus:QUEStionable:ENABle <Enable>
STATus:QUEStionable:COVerload:ENABle <Enable>
STATus:QUEStionable:LIMit:ENABle <Enable>
STATus:QUEStionable:MASK:ENABle <Enable>

Sets the ENABle part that allows true conditions in the EVENt part to be reported in the
summary bit. If a bit is set to 1 in the enable part and its associated event bit transitions
to true, a positive transition occurs in the summary bit and is reported to the next
higher level.

Parameters:
<Enable> Bit mask in decimal representation

Range: 1  to  65535
Increment: 1

Status Reporting



Remote Commands ReferenceR&S®RTM2000

763User Manual 1317.4726.02 ─ 10

Example: STATus:QUEStionable:MASK:ENABle 24
Set bits no. 3 and 4 of the STATus:QUEStiona-
ble:MASK:ENABle register part: 24 = 8 + 16 = 23 + 24

STATus:QUEStionable[:EVENt]?
STATus:QUEStionable:COVerload[:EVENt]?
STATus:QUEStionable:LIMit[:EVENt]?
STATus:QUEStionable:MASK[:EVENt]?
Returns the contents of the EVENt part of the status register to check whether an
event has occurred since the last reading. Reading an EVENt register deletes its con-
tents.

Return values: 
<Event> Event bits in decimal representation

Range: 1  to  65535
Increment: 1

Usage: Query only

STATus:QUEStionable:NTRansition <NegativeTransition>
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition>
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition>
STATus:QUEStionable:MASK:NTRansition <NegativeTransition>

Sets the negative transition filter. If a bit is set, a 1 to 0 transition in the corresponding
bit of the condition register causes a 1 to be written in the corresponding bit of the
event register.

Parameters:
<NegativeTransition> Bit mask in decimal representation

Range: 1  to  65535
Increment: 1

Example: STATus:QUEStionable:MASK:NTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStiona-
ble:MASK:NTRansition register part: 24 = 8 + 16 = 23 + 24

STATus:QUEStionable:PTRansition <PositiveTransition>
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition>
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition>
STATus:QUEStionable:MASK:PTRansition <PositiveTransition>

Sets the positive transition filter. If a bit is set, a 0 to 1 transition in the corresponding
bit of the condition register causes a 1 to be written in the corresponding bit of the
event register.

Parameters:
<PositiveTransition> Bit mask in decimal representation

Range: 1  to  65535
Increment: 1

Status Reporting
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Example: STATus:QUEStionable:MASK:PTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStiona-
ble:MASK:PTRansition register part: 24 = 8 + 16 = 23 + 24

Status Reporting
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Annex
A Remote Control Basics

This chapter provides basic information on operating an instrument via remote control.

A.1 Messages

Instrument messages are employed in the same way for all interfaces, if not indicated
otherwise in the description.

See also:
● Structure and syntax of the instrument messages: Chapter A.2, "SCPI Command

Structure", on page 767
● Detailed description of all messages: Chapter 18, "Remote Commands Reference",

on page 404

There are different types of instrument messages, depending on the direction they are
sent:
● Commands
● Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are
subdivided according to two criteria:
● According to the effect they have on the instrument:

– Setting commands cause instrument settings such as a reset of the instru-
ment or setting the frequency.

– Queries cause data to be provided for remote control, e.g. for identification of
the instrument or polling a parameter value. Queries are formed by directly
appending a question mark to the command header.

● According to their definition in standards:
– Common commands: their function and syntax are precisely defined in stan-

dard IEEE 488.2. They are employed identically on all instruments (if imple-
mented). They refer to functions such as management of the standardized sta-
tus registers, reset and self test.

– Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI compliant" in the command reference chapters. Commands without this
SCPI label are device-specific, however, their syntax follows SCPI rules as per-
mitted by the standard.
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Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement
results, instrument settings and information on the instrument status.

A.1.1 LAN Interface Messages

In the LAN connection, the interface messages are called low–level control messages.
These messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument

&ABO Abort Aborts processing of the commands just received.

&DCL Device Clear Aborts processing of the commands just received and
sets the command processing software to a defined initial
state. Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control). (The
instrument automatically returns to remote state when a
remote command is sent UNLESS &NREN was sent
before.)

&GTR Go to Remote Enables automatic transition from local state to remote
state by a subsequent remote command (after &NREN
was sent).

&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a
sweep). The effect of the command is the same as with
that of a pulse at the external trigger signal input.

&LLO Local Lockout Disables transition from remote control to manual control
by means of the front panel keys.

&NREN Not Remote Enable Disables automatic transition from local state to remote
state by a subsequent remote command. (To re-activate
automatic transition use &GTR.)

&POL Serial Poll Starts a serial poll.

A.1.2 GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the atten-
tion line (ATN) being active (LOW). They are used for communication between the
controller and the instrument and can only be sent by a computer which has the func-
tion of a GPIB bus controller. GPIB interface messages can be further subdivided into:

● Universal commands: act on all instruments connected to the GPIB bus without
previous addressing

● Addressed commands: only act on instruments previously addressed as listeners
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A.1.2.1 Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all
instruments connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the com-
mand processing software to a defined initial state. Does not change the
instrument settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.

LLO (Local Lockout) The LOC/IEC ADDR key is disabled.

SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfig-
ure)

End of the parallel-poll state.

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments
connected to the bus and does not require addressing

A.1.2.2 Addressed Commands

Addressed commands are encoded in the range 00 through 0F hex. They only affect
instruments addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep).
The effect of the command is the same as with that of a pulse at
the external trigger signal input.

GTL (Go to Local) Transition to the "local" state (manual control).

GTR (Go to Remote) Transition to the "remote" state (remote control).

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the
command processing software to a defined initial state. Does not
change the instrument setting.

A.2 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics
(keywords). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.
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A.2.1 Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an aster-
isk (*) and possibly one or more parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.

A.2.2 Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.
For demonstration purposes only, assume the existence of the following commands for
this section:
● DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
● FORMat:READings:DATA <type>[,<length>]
● HCOPy:DEVice:COLor <Boolean>
● HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
● HCOPy[:IMMediate]
● HCOPy:ITEM:ALL
● HCOPy:ITEM:LABel <string>
● HCOPy:PAGE:DIMensions:QUADrant[<N>]
● HCOPy:PAGE:ORIentation LANDscape | PORTrait
● HCOPy:PAGE:SCALe <numeric value>
● MMEMory:COPY <file_source>,<file_destination>
● SENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
● SENSe:FREQuency:STOP <numeric value>
● SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by
upper case letters, the long form corresponds to the complete word. Either the short
form or the long form can be entered; other abbreviations are not permitted.
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Example: 
HCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels
or sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.

Example: 
Definition: HCOPy:PAGE:DIMensions:QUADrant[<N>]
Command: HCOP:PAGE:DIM:QUAD2
This command refers to the quadrant 2.

Different numbering in remote control
For remote control, the suffix may differ from the number of the corresponding selec-
tion used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix
1 is the default state and used when no specific suffix is specified.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The
instrument must recognize the long command to comply with the SCPI standard. Some
commands are considerably shortened by these optional mnemonics.

Example: 
Definition: HCOPy[:IMMediate]
Command: HCOP:IMM is equivalent to HCOP

SCPI Command Structure
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Optional mnemonics with numeric suffixes
Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.
Example:
Definition:DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow
parameter with the suffix for the required window.
DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a "white space". If several parame-
ters are specified in a command, they are separated by a comma (,). For a description
of the parameter types, refer to Chapter A.2.3, "SCPI Parameters", on page 771.

Example: 
Definition:HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
Command:HCOP:DEV:CMAP:COL:RGB 3,32,44

SCPI Command Structure
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Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The
effect of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy:PAGE:ORIentation LANDscape | PORTrait
Command HCOP:PAGE:ORI LAND specifies landscape orientation

Command HCOP:PAGE:ORI PORT specifies portrait orientation

Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics
needs to be included in the header of the command. The effect of the command is independent of
which of the mnemonics is used.

Example:

DefinitionSENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
The two following commands with identical meaning can be created:

SENS:BAND:RES 1
SENS:BWID:RES 1

[ ] Mnemonics in square brackets are optional and may be inserted into the header or omitted.

Example: HCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

{ } Parameters in curly brackets are optional and can be inserted once or several times, or omitted.

Example: SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}
The following are valid commands:

SENS:LIST:FREQ 10
SENS:LIST:FREQ 10,20
SENS:LIST:FREQ 10,20,30,40

A.2.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The
parameters must be separated from the header by a "white space" (ASCII code 0 to 9,
11 to 32 decimal, e.g. blank). Allowed parameters are:

● Numeric values
● Special numeric values
● Boolean parameters
● Text
● Character strings
● Block data

The parameters required for each command and the allowed range of values are
specified in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The man-
tissa may comprise up to 255 characters, the exponent must lie inside the value range
-32000 to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent
alone is not allowed. In the case of physical quantities, the unit can be entered.
Allowed unit prefixes are G (giga), MA (mega), MOHM and MHZ are also allowed), K
(kilo), M (milli), U (micro) and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

● G (giga)
● MA (mega), MOHM, MHZ
● K (kilo)
● M (milli)
● U (micro)
● N (nano)

If the unit is missing, the basic unit is used.

Example: 
SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example: 
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a
query, the numeric value is provided.

● MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

Example: 
Setting command: SENSe:LIST:FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

SCPI Command Structure
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Queries for special numeric values
The numeric values associated to MAXimum/MINimum can be queried by adding the
corresponding mnemonics to the command. They must be entered following the quota-
tion mark.
Example: SENSe:LIST:FREQ? MAXimum
Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represen-
ted by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a
query.

Example: 
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the
header by a white space. In the case of a query, the short form of the text is provided.

Example: 
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").

Example: 
HCOP:ITEM:LABel "Test1" or HCOP:ITEM:LABel 'Test1'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

SCPI Command Structure
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Example: 
FORMat:READings:DATA #45168xxxxxxxx
The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 follow-
ing digits indicate the length to be 5168 bytes. The data bytes follow. During the trans-
mission of these data bytes all end or other control signs are ignored until all bytes are
transmitted.
#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL^END message to terminate the data block. This format is useful when the length of
the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

A.2.4 Overview of Syntax Elements

The following table provides an overview of the syntax elements:

: The colon separates the mnemonics of a command. In a command line the separating semico-
lon marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

' '

"

Quotation marks introduce a string and terminate it. Both single and double quotation marks
are possible.

# The hash symbol introduces binary, octal, hexadecimal and block data.
● Binary: #B10110
● Octal: #O7612
● Hexa: #HF3A7
● Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from
the parameters.

A.2.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of
the following:

● a <New Line>
● a <New Line> with EOI
● an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the
next command belongs to a different command system, the semicolon is followed by a
colon.
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Example: 
MMEM:COPY "Test1","MeasurementXY";:HCOP:ITEM ALL
This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels
in common, the command line can be abbreviated. To this end, the second command
after the semicolon starts with the level that lies below the common levels. The colon
following the semicolon must be omitted in this case.

Example: 
HCOP:ITEM ALL;:HCOP:IMM
This command line contains two commands. Both commands are part of the HCOP
command system, i.e. they have one level in common.
When abbreviating the command line, the second command begins with the level
below HCOP. The colon after the semicolon is omitted. The abbreviated form of the
command line reads as follows:
HCOP:ITEM ALL;IMM

A new command line always begins with the complete path.

Example: 
HCOP:ITEM ALL
HCOP:IMM

A.2.6 Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard
IEEE 488.2.

● The requested parameter is transmitted without a header.
Example: HCOP:PAGE:ORI?, Response: LAND

● Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe:FREQuency:STOP? MAX, Response: 3.5E9

● Numeric values are output without a unit. Physical quantities are referred to the
basic units or to the units set using the Unit command. The response 3.5E9 in
the previous example stands for 3.5 GHz.

● Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

● Text (character data) is returned in a short form.
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Example:
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

A.3 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

● A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented
as sequential commands.

● An overlapping command is one which does not automatically finish executing
before the next command starts executing. Usually, overlapping commands take
longer to process and allow the program to do other tasks while being executed. If
overlapping commands do have to be executed in a defined order, e.g. in order to
avoid wrong measurement results, they must be serviced sequentially. This is
called synchronization between the controller and the instrument.

Setting commands within one command line, even though they may be implemented
as sequential commands, are not necessarily serviced in the order in which they have
been received. In order to make sure that commands are actually carried out in a cer-
tain order, each command must be sent in a separate command line.

Example: Commands and queries in one message
The response to a query combined in a program message with commands that affect
the queried value is not predictable.
The following commands always return the specified result:
:FREQ:STAR 1GHZ;SPAN 100 :FREQ:STAR?
Result:
1000000000 (1 GHz)

Whereas the result for the following commands is not specified by SCPI:
:FREQ:STAR 1GHz;STAR?;SPAN 1000000
The result could be the value of STARt before the command was sent since the instru-
ment might defer executing the individual commands until a program message termi-
nator is received. The result could also be 1 GHz if the instrument executes commands
as they are received.

As a general rule, send commands and queries in different program messages.
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Example: Overlapping command with *OPC
The instrument implements SINGle as an overlapped (asynchronous) command.
Assuming that SINGle takes longer to execute than *OPC, sending the following com-
mand sequence results in initiating a sweep and, after some time, setting the OPC bit in
the ESR:
SINGle; *OPC.
Sending the following commands still initiates a sweep:
SINGle; *OPC; *CLS
However, since the operation is still pending when the instrument executes *CLS, forc-
ing it into the "Operation Complete Command Idle" State (OCIS), *OPC is effectively
skipped. The OPC bit is not set until the instrument executes another *OPC command.

A.3.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC,
*OPC? or *WAI can be used. All three commands cause a certain action only to be
carried out after the hardware has been set. By suitable programming, the controller
can be forced to wait for the corresponding action to occur.

Table A-1: Synchronization using *OPC, *OPC? and *WAI

Com-
mand

Action Programming the controller

*OPC Sets the Operation Complete bit in the ESR
after all previous commands have been exe-
cuted.

● Setting bit 0 in the ESE
● Setting bit 5 in the SRE
● Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is
returned. This is only the case after the Oper-
ation Complete bit has been set in the ESR.
This bit indicates that the previous setting has
been completed.

Sending *OPC? directly after the command
whose processing should be terminated
before other commands can be executed.

*WAI Stops further command processing until all
commands sent before *WAI have been exe-
cuted.

Sending *WAI directly after the command
whose processing should be terminated
before other commands are executed.

Command synchronization using *WAI or *OPC? is a good choice if the overlapped
command takes only little time to process. The two synchronization commands simply
block overlapped execution of the command. Append the synchronization command to
the overlapping command, for example:

SINGle; *OPC?
For time consuming overlapped commands you can allow the controller or the instru-
ment to do other useful work while waiting for command execution. Use one of the fol-
lowing methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.
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3. Send the overlapped command with *OPC

4. Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

2. Send the overlapped command with *OPC?

3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

A.4 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In con-
trast, the priority of remote control is the "predictability" of the instrument status. Thus,
when a command attempts to define incompatible settings, the command is ignored
and the instrument status remains unchanged, i.e. other settings are not automatically
adapted. Therefore, control programs should always define an initial instrument status
(e.g. using the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its
own. Each controller program should instruct the instrument to initiate a service
request in case of malfunction. The program should react appropriately to the service
request.

 

General Programming Recommendations



Remote Control BasicsR&S®RTM2000

779User Manual 1317.4726.02 ─ 10

Error queues

The error queue should be queried after every service request in the controller pro-
gram as the entries describe the cause of an error more precisely than the status regis-
ters. Especially in the test phase of a controller program the error queue should be
queried regularly since faulty commands from the controller to the instrument are
recorded there as well.
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B Status Reporting System
The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue. Both can be queried via GPIB bus or LAN interface
(STATus... commands).

B.1 Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus the contents of the register parts
can be processed by the controller as positive integers.

Figure B-1: The status-register model

Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

● CONDition
The CONDition part is written into directly by the hardware or the sum bit of the
next lower register. Its contents reflect the current instrument status. This register
part can only be read, but not written into or cleared. Its contents are not affected
by reading.

● PTRansition / NTRansition
The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.
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– PTR bit =1: the EVENt bit is set.

– PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.

– NTR bit =1: the EVENt bit is set.

– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

B.2 Hierarchy of status registers

As shown in the following figure, the status information is of hierarchical structure.
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Figure B-2: Overview of the status registers hierarchy

● STB, SRE
The STatus Byte (STB) register and its associated mask register Service Request
Enable (SRE) form the highest level of the status reporting system. The STB pro-
vides a rough overview of the instrument status, collecting the information of the
lower-level registers.

● ESR, SCPI registers
The STB receives its information from the following registers:
– The Event Status Register (ESR) with the associated mask register standard

Event Status Enable (ESE).

– The STATus:OPERation and STATus:QUEStionable registers which are
defined by SCPI and contain detailed information on the instrument.

● Output buffer

Hierarchy of status registers
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The output buffer contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

B.3 Contents of the Status Registers

In the following sections, the contents of the status registers are described in more
detail.

B.3.1 Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB can thus be compared with the CONDition part of an SCPI register and
assumes the highest level within the SCPI hierarchy.

The STB is read using the command *STB? or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *SRE and read
using the command *SRE?.

Table B-1: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus:QUEStionable status register.
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Bit No. Meaning

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABle bit is set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus:OPERation status register.

B.3.2 Event Status Register (ESR) and Event Status Enable Register
(ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *ESE and read using the command
*ESE?.

Table B-2: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

 

Contents of the Status Registers



Status Reporting SystemR&S®RTM2000

785User Manual 1317.4726.02 ─ 10

Bit No. Meaning

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

B.3.3 STATus:OPERation Register

In the CONDition part, this register contains information on which actions the instru-
ment is being executing. In the EVENt part, it contains information on which actions the
instrument has executed since the last reading. It can be read using the commands
STATus:OPERation:CONDition? or STATus:OPERation[:EVENt]?.

See also: Figure B-2

The remote commands for the STATus:OPERation register are described in Chap-
ter 18.19.1, "STATus:OPERation Register", on page 759.

Table B-3: Bits in the STATus:OPERation register

Bit No. Meaning

0 ALIGnment
This bit is set as long as the instrument is performing a self alignment.

1 SELFtest
This bit is set while the selftest is running.

2 AUToset
This bit is set while the instrument is performing an auto setup.

3 WTRIgger
This bit is set while the instrument is waiting for the trigger.

4 to 14 Not used

15 This bit is always 0.

B.3.4 STATus:QUEStionable Register

This register contains information about indefinite states which may occur if the unit is
operated without meeting the specifications. It can be read using the commands
STATus:QUEStionable:CONDition? on page 762 and STATus:
QUEStionable[:EVENt]? on page 763
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Figure B-3: Overview of the STATus:QUEStionable register

Table B-4: Bits in the STATus:QUEStionable register

Bit No. Meaning

0 to 2 not used

3 COVerload
This bit is set if a questionable channel overload occurs (see Chapter B.3.4.1, "STATus:QUES-
tionable:COVerload register", on page 787).

4 TEMPerature
This bit is set if a questionable temperature occurs (see Chapter B.3.4.2, "STATus:QUEStiona-
ble:TEMPerature register", on page 787).

5 to 7 Not used

Contents of the Status Registers
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Bit No. Meaning

8 NOALigndata
This bit is set if no alignment data is available - the instrument is uncalibrated.

9 LIMit
This bit is set if a limit value is violated (see Chapter B.3.4.3, "STATus:QUEStionable:LIMit reg-
ister", on page 787).

10 to 11 Not used

12 MASK
This bit is set if a mask value is violated (see Chapter B.3.4.4, "STATus:QUEStionable:MASK
register", on page 788

13 to 14 Not used

15 This bit is always 0.

B.3.4.1 STATus:QUEStionable:COVerload register

This register contains all information about overload of the channels. The bit is set if
the assigned channel is overloaded.

Table B-5: Bits in the STATus:QUEStionable:COVerload register

Bit No. Meaning

0 CHANnel1

1 CHANnel2

2 CHANnel3

3 CHANnel4

B.3.4.2 STATus:QUEStionable:TEMPerature register

This register contains information about the instrument's temperature.

Table B-6: Bits in the STATus:QUEStionable:TEMPerature register

Bit No. Meaning

0 TEMP WARN
This bit is set if a temperature warning on channel 1, 2, 3 or 4 occured.

1 TEMP ERRor
This bit is set if a temperature error on channel 1, 2, 3 or 4 occured.

B.3.4.3 STATus:QUEStionable:LIMit register

This register contains information about the observance of the limits of measurements.
This bit is set if the limits of the main or additional measurement of the assigned mea-
surement are violated.
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Table B-7: Bits in the STATus:QUEStionable:LIMit register

Bit No. Meaning

0 MEAS1

1 MEAS2

2 MEAS3

3 MEAS4

B.3.4.4 STATus:QUEStionable:MASK register

This register contains information about the violation of masks. This bit is set if the
assigned mask is violated.

Table B-8: Bits in the STATus:QUEStionable:MASK register

Bit No. Meaning

0 MASK1

B.4 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods
are used:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller in order to

find out who sent a SRQ and why
● Parallel poll of all devices
● Query of a specific instrument status by means of commands
● Query of the error queue

B.4.1 Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which
the control program can react appropriately. As evident from Figure B-2, an SRQ is
always initiated if one or several of bits 2, 3, 4, 5 or 7 of the status byte are set and
enabled in the SRE. Each of these bits combines the information of a further register,
the error queue or the output buffer. The ENABle parts of the status registers can be
set such that arbitrary bits in an arbitrary status register initiate an SRQ. In order to
make use of the possibilities of the service request effectively, all bits should be set to
"1" in enable registers SRE and ESE.
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The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should cause the instrument to initiate a service request if errors
occur. The program should react appropriately to the service request.

B.4.2 Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

B.4.3 Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

B.4.3.1 Decimal representation of a bit pattern

The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of
a status register are specified and transferred as a single decimal number. To make
this possible, each bit is assigned a weighted value. The decimal number is calculated
as the sum of the weighted values of all bits in the register that are set to 1.
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Example: 
The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g.
the QUEStionable status summary bit and the ESB bit in the STatus Byte ) are set.

B.4.4 Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem:ERRor[:NEXT]?. Each call of
SYSTem:ERRor[:NEXT]? provides one entry from the error queue. If no error mes-
sages are stored there any more, the instrument responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
larly since faulty commands from the controller to the instrument are recorded there as
well.

B.5 Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except *RST and
SYSTem:PRESet, influence the functional instrument settings. In particular, DCL does
not change the instrument settings.

Table B-9: Resest of the status reporting system

Event Switching on supply
voltage

Power-On-Status-
Clear

DCL,
SDC

(Device
Clear,
Selected
Device
Clear)

*RST or
SYS-
Tem:PRE-
Set

STA-
Tus:PRE-
Set

*CLS

Effect 0 1

Clear STB, ESR - yes - - - yes

Clear SRE, ESE - yes - - - -

Clear EVENt parts of the regis-
ters

- yes - - - yes

Clear ENABle parts of all
OPERation and QUEStionable
registers;

Fill ENABle parts of all other
registers with "1".

- yes - - yes -

Fill PTRansition parts with "1";

Clear NTRansition parts

- yes - - yes -

Clear error queue yes yes - - - yes
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Event Switching on supply
voltage

Power-On-Status-
Clear

DCL,
SDC

(Device
Clear,
Selected
Device
Clear)

*RST or
SYS-
Tem:PRE-
Set

STA-
Tus:PRE-
Set

*CLS

Effect 0 1

Clear output buffer yes yes yes 1) 1) 1)

Clear command processing
and input buffer

yes yes yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

Reset Values of the Status Reporting System
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